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In accordance with IEC 60417, this machine uses the following symbols for the main power switch:

aaaa means POWER ON.

bbbb means POWER OFF.

cccc means STAND BY.

Introduction

This manual contains detailed instructions on the operation and maintenance of this machine. To get
maximum versatility from this machine all operators should carefully read and follow the instructions in
this manual. Please keep this manual in a handy place near the machine.

Notes

Some illustrations may be slightly different from your machine.

Certain options may not be available in some countries. For details, please contact your local dealer.

Laser Safety

This machine is considered a class 1 laser device, safe for office/EDP use. The machine contains two
AlGalnP laser diodes, 7-milliwatt,645-660 nanometer wavelength for each emitter. Direct (or indirect
reflected) eye contact with the laser beam might cause serious eye damage. Safety precautions and
interlock mechanisms have been designed to prevent any possible laser beam exposure to the opera-
tor.

Warning:

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Notes:

The model names of the machines do not appear in the following pages. Check the type of your ma-
chine before reading this manual. (For details, see P.15 “Machine Types”.)

• Type 1: 24 copies/minute (81/2" × 11"K)

• Type 2: 32 copies/minute (81/2" × 11"K)

Certain types might not be available in some countries. For details, please contact your local dealer. 

Two kinds of size notation are employed in this manual. With this machine refer to the inch version.

For good copy quality, the supplier recommends that you use genuine toner from the supplier.

The supplier shall not be responsible for any damage or expense that might result from the use of parts
other than genuine parts from the supplier with your office products. 

Power Source

120V, 60Hz, 12A or more

Please be sure to connect the power cord to a power source as above. For details about power source,
see P.141 “Power Connection”.
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Notice

Important

Do not make copies of any item for which copying is prohibited by law.
Copying the following items is normally prohibited by local law:
Bank bills, revenue stamps, bonds, stock certificates, bank drafts, checks, pass-
ports, driver's licenses.
The color copy samples in this book may differ slightly from the actual copies
due to printing effects.
The color on each Color key may differ slightly from that of the actual copy.
This machine is equipped with a function that prevents making counterfeit bank
bills. Due to this function the original images similar to bank bills may not be
copied properly.

Notice To Wireless LAN Interface (option) Users

Notes to users in the United States of America

Notice:
This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential in-
stallation. This equipment generates, uses and can radiate radio frequency ener-
gy and, if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no guarantee
that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be deter-
mined by turning the equipment off and on, the user is encouraged to try to cor-
rect the interference by one more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which

the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
 
This device complies with part 15 of the FCC Rules.
Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must ac-
cept any interference received, including interference that may cause undesired
operation.
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Warning
Changes or modifications not expressly approved by the party responsible for
compliance could void the user's authority to operate the equipment.
 
Note to users in Canada
Note:

This Class B digital apparatus complies with Canadian ICES-003.
Operation is subject to the following two conditions:
(1) This device may not cause interference, and (2) this device must accept any
interference, including interference that may cause undesired operation of the
device.
 
IEEE 802.11b Interface Kit Type B:
This device complies with RSS-210 of Industry Canada.
The term “IC:” before the certification/registration number only signifies that
the Industry Canada technical specifications were met.
To prevent radio interference to the licensed service, this device is intended to
be operated indoors and away from windows to provide maximum shielding.
Equipment (or its transmit antenna) that is installed outdoors is subject to licens-
ing.
To reduce potential radio interference to other users, the antenna type and its
gain should be so chosen that the equivalent isotropically radiated power (EIRP)
is not more than that required for successful communication.
This device has been designed to operate with an antenna having a maximum
gain of [0.45] dBi. Antenna having a higher gain is strictly prohibited per regu-
lations of Industry Canada. The required antenna impedance is [50] ohms.
 
Remarque concernant les utilisateurs au Canada

Avertissement:
Cet appareil numérique de la classe B est conforme á la norme NMB-003 du Can-
ada.
L'utilisation de ce dispositif est autorisée seulement aux conditions suivantes: (1)
il ne doit pas produire de brouillage et (2) l'utilisateur du dispositif doit être prêt
á accepter tout brouillage radioélectrique reçu, même si ce brouillage est suscep-
tible de compromettre le fonctionnement du dispositif.
 
IEEE 802.11b Interface Kit Type B:
Ce dispositif est conforme á la norme CNR-210 d'Industrie Canada.
L'expression «IC:» avant le numéro d'homologation/enregistrement signifie
seulement que les spécifications techniques d'Industrie Canada ont été re-
spectées.
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Pour empêcher que cet appareil cause du brouillage au service faisant l'objet
d'une licence, il doit être utilisé á l'intérieur et devrait être placé loin des fenêtres
afin de fournir un écran de blindage maximal.
Si le matériel (ou son antenne d'emission) est installe á l'extérieur, il doit faire
l'objet d'une licence.
Afin de réduire le risque d'interférence aux autres utilisateurs, le type d'antenne
et son gain doivent être choisis de façon á ce que la puissance isotrope rayonnée
équivalente (p.i.r.e.) ne soit pas supérieure au niveau requis pour obtenir une
communication satisfaisante.
Ce dispositif a été conçu pour fonctionner avec une antenne ayant un gain max-
imal de [0.45] dBi.Une antenne ayant un gain plus élevé est strictement interdite
par les réglements d'Industrie Canada.L'impédance d'antenne requise est [50]
ohms.
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Copyrights and Trademarks

Trademarks

Ethernet® is a registered trademark of Xerox Corporation.
PostScript® and Acrobat® are registered trademarks of Adobe Systems Incorpo-
rated.
Apple Talk, Apple, Macintosh are registered trademarks of Apple Computer, In-
corporated.
Novell, and Netware are registered trademarks of Novell, Inc.
Microsoft®, Windows® and Windows NT® are registered trademarks of Micro-
soft Corporation in the United States and/or other countries.

Note
❒ The proper names of the Windows operating systems are as follows:

• Microsoft® Windows® 95 operating system
• Microsoft® Windows® 98 operating system
• Microsoft® Windows® Millennium Edition (Windows Me)
• Microsoft® Windows® 2000 Professional
• Microsoft® Windows® XP Professional
• Microsoft® Windows® XP Home Edition
• Microsoft® Windows® 2000 Server
• Microsoft® Windows NT® Server operating system Version 4.0
• Microsoft® Windows NT® Workstation operating system Version 4.0

Information about Installed Software

expat

• The software including controller, etc. (hereinafter "software") installed on
this product uses the expat Version 1.95.2 (hereinafter "expat") under the con-
ditions mentioned below.

• The product manufacturer provides warranty and support to the software of
the product including the expat, and the product manufacturer makes the in-
itial developer and copyright holder of the expat, free from these obligations.

• Information relating to the expat is available at:
http://expat.sourceforge.net/

Copyright (c) 1998, 1999, 2000 Thai Open Source Software Centre, Ltd. and Clark
Cooper.
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Permission is hereby granted, free of charge, to any person obtaining a copy of
this software and associated documentation files (the "Software"), to deal in the
Software without restriction, including without limitation the rights to use,
copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the
Software, and to permit persons to whom the Software is furnished to do so, sub-
ject to the following conditions:
The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY
KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AU-
THORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAG-
ES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFT-
WARE.

NetBSD

Copyright Notice of NetBSD
For all users to use this product:
This product contains NetBSD operating system:
For the most part, the software constituting the NetBSD operating system is not
in the public domain; its authors retain their copyright.
The following text shows the copyright notice used for many of the NetBSD
source code. For exact copyright notice applicable for each of the files/binaries,
the source code tree must be consulted.
A full source code can be found at http://www.netbsd.org/.
Copyright © 1999, 2000 The NetBSD Foundation, Inc.
All rights reserved.
Redistribution and use in source and binary forms, with or without modifica-
tion, are permitted provided that the following conditions are met:
A Redistributions of source code must retain the above copyright notice, this list

of conditions and the following disclaimer.
B Redistributions in binary form must reproduce the above copyright notice,

this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

C All advertising materials mentioning features or use of this software must
display the following acknowledgement:
This product includes software developed by the NetBSD Foundation, Inc.
and its contributors.
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D Neither the name of The NetBSD Foundation nor the names of its contribu-
tors may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND
CONTRIBUTORS ''AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MER-
CHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DIS-
CLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEM-
PLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMIT-
ED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CON-
TRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTH-
ERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Authors Name List

All product names mentioned herein are trademarks of their respective owners.
The following notices are required to satisfy the license terms of the software
that we have mentioned in this document:
• This product includes software developed by the University of California,

Berkeley and its contributors.
• This product includes software developed by Jonathan R. Stone for the NetB-

SD Project.
• This product includes software developed by the NetBSD Foundation, Inc.

and its contributors.
• This product includes software developed by Manuel Bouyer.
• This product includes software developed by Charles Hannum.
• This product includes software developed by Charles M. Hannum.
• This product includes software developed by Christopher G. Demetriou.
• This product includes software developed by TooLs GmbH.
• This product includes software developed by Terrence R. Lambert.
• This product includes software developed by Adam Glass and Charles Han-

num.
• This product includes software developed by Theo de Raadt.
• This product includes software developed by Jonathan Stone and Jason R.

Thorpe for the NetBSD Project.
• This product includes software developed by the University of California,

Lawrence Berkeley Laboratory and its contributors.
• This product includes software developed by Christos Zoulas.
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• This product includes software developed by Christopher G. Demetriou for
the NetBSD Project.

• This product includes software developed by Paul Kranenburg.
• This product includes software developed by Adam Glass.
• This product includes software developed by Jonathan Stone.
• This product includes software developed by Jonathan Stone for the NetBSD

Project.
• This product includes software developed by Winning Strategies, Inc.
• This product includes software developed by Frank van der Linden for the

NetBSD Project.
• This product includes software developed for the NetBSD Project by Frank

van der Linden
• This product includes software developed for the NetBSD Project by Jason R.

Thorpe.
• The software was developed by the University of California, Berkeley.
• This product includes software developed by Chris Provenzano, the Univer-

sity of California, Berkeley, and contributors.

JPEG LIBRARY

• The software installed on this product is based in part on the work of the In-
dependent JPEG Group.
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How to Read this Manual

Symbols

In this manual, the following symbols are used:

R WARNING:
This symbol indicates a potentially hazardous situation that might result in
death or serious injury when you misuse the machine without following the in-
structions under this symbol. Be sure to read the instructions, all of which are in-
cluded in the Safety Information section.

R CAUTION:
This symbol indicates a potentially hazardous situation that might result in mi-
nor or moderate injury or property damage that does not involve personal injury
when you misuse the machine without following the instructions under this
symbol. Be sure to read the instructions, all of which are included in the Safety
Information section.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might be misfeed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates the prior knowledge or preparations required before op-
erating.

Note
This symbol indicates precautions for operation or actions to take after misoper-
ation.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys that appear on the machine's display panel.

{ }
Keys built into the machine's control panel.

Notice

• B4 JISKL, B5 JISKL, B6 JISL are referred to as B4KL, B5KL, B6L in
this manual.
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Safety Information

When using this machine, the following safety precautions should always be fol-
lowed.

Safety During Operation

In this manual, the following important symbols are used: 

R WARNING:

 

R WARNING:
Indicates a potentially hazardous situation which, if instructions 
are not followed, could result in death or serious injury.

R CAUTION:
Indicates a potentially hazardous situation which, if instructions are not 
followed, may result in minor or moderate injury or damage to property.

• Connect the power cord directly into a wall outlet and never use an ex-
tension cord.

• Disconnect the power plug (by pulling the plug, not the cable) if the 
power cable or plug becomes frayed or otherwise damaged.

• To avoid hazardous electric shock or laser radiation exposure, do not 
remove any covers or screws other than those specified in this manu-
al.

• Turn off the power and disconnect the power plug (by pulling the plug, 
not the cable) if any of the following occurs:

• You spill something into the machine.

• You suspect that your machine needs service or repair.

• The external housing of your machine has been damaged.

• Do not incinerate spilled toner or used toner. Toner dust might ignite 
when exposed to an open flame.

• Disposal can take place at our authorized dealer.

• Dispose of the used toner bottle in accordance with the local regula-
tions.
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R CAUTION:

 
• Protect the machine from dampness or wet weather, such as rain and snow.

• Unplug the power cord from the wall outlet before you move the machine. 
While moving the machine, you should take care that the power cord will not 
be damaged under the machine.

• When you disconnect the power plug from the wall outlet, always pull the 
plug (not the cable).

• Do not allow paper clips, staples, or other small metallic objects to fall inside 
the machine.

• Keep toner (used or unused) and toner bottle out of the reach of children.

• For environmental reasons, do not dispose of the machine or expended 
supply waste at household waste collection points. Disposal can take place 
at an authorized dealer.

• The inside of the machine could be very hot. Do not touch the parts with a 
label indicating the “hot surface”. Otherwise, an injury might occur.
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Positions of Labels and Hallmarks for 
RRRRWARNING and RRRRCAUTION

This machine has labels and hallmarks for RWARNING,RCAUTION at the
positions shown below. For safety, please follow the instructions and handle  the
machine as indicated.

ZGJS836E
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ENERGY STAR Program

The machine model which meets the Guidelines is Type 2.

• Low Power Mode
This product automatically lowers its power consumption 15 minutes after
the last copy or print job has finished. Printing is still possible in Low Power
Mode, but if you wish to make copies press the {{{{Energy Saver}}}} key first.

Reference
For details about how to change the default interval, see ⇒ p.79 “Energy
Saver Timer”.

• Off Mode(Copier only)
To conserve energy, this product automatically turns off 60 minutes after the
last copying or printing job has been completed. This function is called “Auto
Off”. Printing is available in this mode, but if you use the copier, press the op-
eration switch.

Reference
For details about how to change the default interval, see ⇒ p.79 “Auto Off
Timer”.

• Duplex Priority
The ENERGY STAR Program recommends use of the Duplex function. By
conserving paper, this function helps the environment. For applicable ma-
chines, duplex function (one-sided original → two-sided copies) is selected
for when the operation switch or the main power switch is turned on, the {{{{En-
ergy Saver}}}} key is pressed, or when the machine resets automatically.

Reference
To change the settings of the Duplex Priority mode, see “Duplex Mode Pri-
ority” in the Copy Reference.

As an ENERGY STAR Partner, we have determined 
that this machine model meets the ENERGY STAR 
Guidelines for energy efficiency.

The ENERGY STAR Guidelines intend to establish an international energy-saving system for 
developing and introducing energy-efficient office equipment to deal with environmental is-
sues, such as global warming.

When a product meets the ENERGY STAR Guidelines for energy efficiency, the Partner shall 
place the ENERGY STAR logo onto the machine model.

This product was designed to reduce the environmental impact associated with office equip-
ment by means of energy-saving features, such as Low-power mode.
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Specification

❖❖❖❖ Recycled Paper
In accordance with the ENERGY STAR Program, we recommend use of recy-
cled paper which is environmentally friendly. Please contact your sales rep-
resentative for recommended paper.

Copier only

Low Power Mode Power consumption 128.2W or less

Default interval 15 minutes

Recovery Time 30 sec. or less

Off Mode Power consumption 15 W or less

Default interval 60 minutes

Duplex Priority 1 Sided → 2 Sided
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Manuals for this Machine

This is a multi-functional machine combining copier, facsimile, printer and scan-
ner functions. This manual describes procedures common to these functions.
Each function's reference describes the operational procedures for that func-
tions. Please consult the relevant parts of manual.

❖❖❖❖ General Settings Guide (this manual)
Provides an overview of the machine. This manual introduces the functions
of the machine. It also introduces the options that allow you to use additional
functions and describes how to access the system user tools to make the ma-
chine easier to use.

❖❖❖❖ When using as a copier
• Copy Reference

Describes the various copying functions from basic copying to more ad-
vanced functions such as reducing/enlarging copies or combining origi-
nals onto one sheet.

❖❖❖❖ When using as a facsimile
• Facsimile Reference (option)

Describes the operational procedures and functions to use the machine as
a facsimile.

❖❖❖❖ When using as a printer
• Printer Reference (option)

Describes the system settings, procedures and functions for using the ma-
chine as a printer.

❖❖❖❖ When using as a scanner
• Scanner Reference (option)

Describes the system settings, procedures and functions for using the ma-
chine as a scanner.

UranosC1-ENzen_F2_FM.book  Page 14  Friday, August 2, 2002  1:32 PM



15

Machine Types

This machine comes in two models which vary in copy speed. To ascertain
which model you have, see the inside front cover of this manual.

Type 1 Type 2

Copy speed/Single Color 24 copies/minute 

(A4K, 81/2" × 11"K)

32 copies/minutes

(A4K, 81/2" × 11"K)

Copy speed/Full Color 8 copies/minute

(A4K, 81/2" × 11"K)

10 copies/minutes

(A4K, 81/2" × 11"K)
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1. What You Can Do With This
Machine

Additional Functions Provided by Internal 
Options

You can expand the capabilities of this machine to include fax functions. When
you want to add a function, contact your sales or service representative.

Copy Mode

In copy mode you can make basic copies and also copy using more sophisticated
techniques, such as reduction/enlargement or combining several originals onto
one copy. You can install optional expansion memory for storage of document
images, thereby making the best use of memory with various copy functions.

Facsimile Mode (Option)

You can send and receive fax messages in facsimile mode. Installation of option-
al expansion memory allows more functions to be used and more data to be
stored.

Printer Mode (Option)

You can print documents in color under various environments. Installation of
optional expansion memory allows more data to be stored, enabling automatic
copy stapling.

Scanning originals
Copy, Facsimile transmission

Facsimile 
Transmission

Facsimile 
reception

Printer

Print
Copy, Facsimile reception

Printer

ZGJS837E
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Scanner Mode (Option)

You can use this machine as a scanner.
It is also possible to E-mail scanned image as attached files via a LAN, or the In-
ternet.
You can also E-mail to ScanRouter V2 Lite/Professional.

Document Server Mode

You can save documents from copy functions, facsimile transactions, the printer,
and the scanner to the hard disk. Documents can be printed later *1 , sent later *2 ,
or you can transfer the document data to a PC *3 . The machine can be controlled
from a PC.
*1 You cannot print documents saved with the scanner.
*2 Only documents stored in facsimile mode can to be sent as faxes.
*3 To transfer documents to a PC, DeskTopBinder V2 Professional/Lite must be in-

stalled. ⇒ p.19 “Operation from a Computer”

Printer

Scanner

Facsimile
Transmission

Copy Printing
(Except Scanner)

Sending
stored

facsimile
documents

Transferring Document
data for PC

ZGJS833E

1.Prepare Documents 2.Save 3.Print/Send/Transfer
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Note
❒ You can save the following:

• Data from documents scanned using the document feeder
• Data from documents scanned using the exposure glass
• Data sent from a computer

Important
❒ Do not turn off the main power switch when the Operation Switch is on or the

On indicator is lit or blinking. If you turn it off during an operation, the mem-
ory or hard disk might be damaged.

❒ Avoid any strong shocks to the machine. This could damage the hard drive
or delete stored files. For precautionary reasons, files should be copied to an-
other local computer.

❒ Unauthorized access is possible to the Document Server when the network is
connected to the Internet. To prevent the revelation of stored confidential
documents, set a firewall between the network and the Internet.

❖❖❖❖ On Demand Printing
If you save your document in the Document Server, you can print it out at any
time with print settings such as duplex and stapling.

❖❖❖❖ File Merge Printing
You can merge documents created with different applications or created sep-
arately on different computers.
You can merge documents sent from a computer with scanned paper origi-
nals.

❖❖❖❖ Facsimile Resend
You can send data stored in memory when necessary. You can merge and
send data stored from previous faxes with additional scanned originals.

Reference
For details, see the “Facsimile Reference.”

❖❖❖❖ Operation from a Computer
If you install DeskTopBinder V2 Professional or DeskTopBinder V2 Lite on
your computer you can check the contents of stored documents, print copies
for confirmation and perform other operations. 
You can also perform tasks on data stored in the Document Server from your
computer, rather than from the machine. These functions are available when
the printer or the scanner function is installed.

Reference
For more detailed information, refer to DeskTopBinder V2 Profession-
al/Lite manuals.
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User Management

You can limit the users of the machine, and restrict their use of certain functions
using user codes.

Using the User Code

The user is requested to enter a registered user code to operate the machine. You
can check the use of the machine by each user.

❖❖❖❖ Managing items
• You can set allowed functions for each user as shown below.
• You can output a list of usage amounts for each user.

The functions you can limit are as follows:

*1 The counter shows the number of copies when you print a document for transmis-
sion that is stored in the document server.

*2 When you print documents by pressing the {{{{Document Server}}}} key, the copy counter
shows the number of copies for documents stored in copy mode, and for documents
stored in facsimile mode or printer mode.

Reference
⇒ p.88 “User Code Management”⇒ p.94 “User Code”

Function Mode Functions available to set 
the usage limit

Functions which the usage 
amounts can be managed

Copy Black & White ❍ ❍

Single Color ❍ ❍

Two-color ❍ ❍

Full Color ❍ ❍

Facsimile Facsimile transmission ❍ ❍

Printing (when the 
document server is 
used) *2 

-- ❍ *1 

Printer Black & White ❍ ❍

Color ❍ ❍

Scanner Scanner mode ❍ ❍

Document 
server

Document server 
mode

❍ (depending on the mode to 
store the document) *2 
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2. Basics

Guide To Components

1. Exposure glass cover (option) or
Document feeder (ADF) (option)
Lower the exposure glass cover over
originals placed on the exposure glass for
copying. If you have the document feed-
er, load a stack of originals here. They
will be fed automatically, one by one.
(The illustration shows the document
feeder.)

2. Exposure glass
Place originals face down here for copy-
ing.

3. Internal tray
Copied, printed paper or fax messages
are delivered here.

4. Main power switch
If the machine does not operate after
turning on the operation switch, check
the main power switch is turned on. ⇒
p.32 “Turning On the Power”

5. Operation switch
Press this switch to turn the power on
(the On indicator lights up). To turn the
power off, press this switch again (the On
indicator goes off). ⇒ p.32 “Turning On
the Power”

6. Control panel
⇒ p.24 “Control Panel”

7. Remove Paper Indicator
The indicator is lit when paper is output
to the internal tray 2 (1 bin tray). If the in-
ternal tray 2 has not been installed, the in-
dicator does not light.

ZGJS100N
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8. Internal tray 2 (1 bin tray) (option)

9. Duplex unit (Unit for two-sided
copies) (option)

10. Front cover
Open to access the inside of the machine.

11. Paper tray (upper: tray 1, lower:
tray 2)
Load paper here.

12. Paper tray unit (option <upper:
tray 3, lower: tray 4>)
Load paper here.

1. Ventilation holes
Prevent overheating. Do not obstruct the
ventilation holes by placing objects near
it or leaning things against it. If the ma-
chine overheats, a fault might occur.

2. Interface for network connections 
⇒ p.27 “Connecting the Machine (Net-
work Connections)”

3. Paper tray cover
Open this cover to remove jammed pa-
per.

4. Bypass tray (option)
Use when copying onto OHP transparen-
cies, label paper (adhesive labels), trans-
lucent paper, postcards, envelopes and
non-standard size paper.
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External Options

1. 500-Sheet Finisher
Sorts, stacks and staples copies.

2. Bridge unit
Relays copies to the finisher.

3. Handset
Use as a telephone receiver when a fac-
simile unit is installed.

4. Exposure glass cover
Lower this over originals for copying.

5. Document feeder (ADF)
Load a stack of originals here. They will
be fed automatically.

6. Internal tray 2 (1 bin tray)
If you select this as the output tray, cop-
ied paper will be delivered here face
down.

7. 1000-Sheet Finisher
Sorts, stacks and staples copies.
*1 : Finisher proof tray
*2 : Finisher shift tray

Note
❒ When you use the 1000-sheet Finisher,

the adjustment table is required.

8. Shift sort tray
Sorts and stacks copies.

9. Paper tray unit
Consists of two paper trays.

10. Large Capacity Tray (LCT)
Holds 2000 sheets of paper.

11. Bypass tray
Use when copying onto OHP transparen-
cies, label paper (adhesive labels), trans-
lucent  paper,  envelopes and non-
standard size paper.

12. Duplex unit
Use to make two-sided copies and prints.

13. Interchange unit
Required when installing the internal
tray 2 (1 bin tray) and duplex unit.

ZGJS000N
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Control Panel

Note
❒ This illustration shows the Control Panel of the machine with options fully in-

stalled.

1. Screen contrast knob
Adjusts the brightness of the display pan-
el.

2. {{{{User Tools/Counter}}}} key
• User Tools

Press to change the default settings
and conditions to meet your require-
ments. ⇒ p.72 “Accessing User Tools
(System Settings)”

• Counter
Press to check or print the counter val-
ue.

• Inquiry
Press to check where to contact for
machine repairs and ordering toner.

3. Indicators
Show errors and machine status.

4. {{{{Adjust/Program Color}}}} key (copy
mode)
Use to control the color balance and con-
trast for printing.

5. Color circle
Use as reference for color control.
⇒ “Color Adjustment” in the Copy Ref-
erence

6. Display panel
Shows operation status, error messages,
and function menues.

7. {{{{On Hook Dial}}}} key (facsimile
mode)
Press when the manual facsimile recep-
tion is set, or when using the facsimile in-
formation services.

8. {{{{Start Manual RX}}}} key (facsimile
mode)
Press to start manual facsimile reception.

9. {{{{Check Modes}}}} key
Press this key to check settings.

10. {{{{Program}}}} key
Press to register frequently used settings,
or to recall registered settings.

11. {{{{Clear Modes}}}} key
Press to clear previously entered copy job
settings.

12. {{{{Energy Saver}}}} key
Press to switch to and from Energy Saver
mode.
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13. {{{{Interrupt}}}} key (copy mode)
Press to make interrupt copies during a
copy run.

14. Main power indicator and pow-
er indicator
The main power indicator goes on when
you turn on the main power switch.
The power indicator lights when the
power is on.

Important
❒ Do not turn off the power while

the power indicator is blinking.
Doing so may damage the hard
disk.

15. Operation switch
Press this switch to turn the power on
(the On indicator goes on). To turn the
power off, press this switch again (the On
indicator goes off).

16. {{{{Sample Copy}}}} key
Press to make a single set of copies or
prints to check for poor copying or print-
ing before making multiple sets of copies
or prints.

17. {{{{Start}}}} key
Press to start copying, scanning, or print-
ing documents stored on the Document
Server.

18. {{{{Clear/Stop}}}} key
• Clear

Press to delete a number entered.
• Stop

Press to stop a job such as scanning
facsimile, or printing in progress.

19. {{{{#}}}} key
Press to enter a value.

20. Number keys
Use to enter the desired number of copies
and data for selected modes.

21. {{{{Tone}}}} key (facsimile mode)
Press to send tonal signals down a pulse
dialing line.

22. {{{{Pause/Redial}}}} key (facsimile
mode)
• Pause

Insert a pause when you are dialing or
storing a fax number. A pause cannot
be inserted as the first digit.

• Redial
Press to redial the last numbers.

23. Color function keys (copy mode)
Press to select color for copying.

24. Function keys/Function Status
indicator
Press to select the following functions:
• Copy
• Document Server
• Facsimile
• Printer
• Scanner
The followings show the status of the
above functions:
• Yellow: the function is selected.
• Green: the function is active.
• Red: the function has been interrupt-

ed.

25. mmmm indicator
The data indicator shows the status of
data reception from a personal computer.
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Display Panel

The display panel shows machine status, error messages and function menus.

Important
❒ A force or impact of more than 30 N (about 3kgf) might damage the display

panel.
The copying screen is displayed as default following power on.

The function items displayed serve as selector keys. You can select or specify an
item by lightly pressing them.
When you select or specify an item on the display panel, it is highlighted like

. Keys appearing as  cannot be used.

Common Key Operations

The following keys are common for all screens.

❖❖❖❖ Key list

[OK] Acknowledges a selected function or entered values, and then returns 
to the previous screen.

[Cancel] Deletes a selected function or entered values, and then returns to the 
previous screen.

[UUUUPrevious],[TTTTNext] Moves to the previous page or the next page when all the functions 
cannot be displayed on one page.

[OK] [Yes] Closes the message screens.

[Clear] Clears entered values and does not change the screen.

[Exit] Returns to the previous screen.

OK
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Connecting the Machine (Network 
Connections)

1. Parallel port

2. IEEE 1394 ports (option)

3. 10BASE-T/100BASE-TX

4. Wireless LAN port (option)

ZGJS831E

Wireless LAN board 
installed

IEEE 1394 board 
installed
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Requirements

Requirements

Before using this machine, make sure that all appropriate environmental and
electrical requirements are satisfied. Connect the machine to the host computer
using the parallel port, Network Interface Board, or both.
Make sure you have all the cables, connectors, and electrical outlets necessary to
attach the machine to the host computer or network.

Important
❒ The interface cable is not supplied. User is required to provide an interface ca-

ble suitable for the computer being used.

Network cable requirements

The Network Interface Board can be installed to allow direct connection to an
Ethernet network.
The Network Interface Board supports 10BASE-T or 100BASE-TX connections. 
The IEEE 1394 Board (option) supports the IEEE 1394 interface cable.
You can use the machine in the following network environments: 
• Using the appropriate network management software and printer driver
• Attaching the machine to a network computer set up as a server

*1 Under Windows NT 4.0, only × 86 CPU is supported.
*2 For information about usable versions of the Mac OS, see the "PostScript Supple-

ment".
*3 Under Windows 95/98/Me, Windows 2000 and Windows NT 4.0 only. Only for

Peer-Peer Printing. The SmartNetMonitor for Client is required to use this protocol.
*4 Concerning UNIX printing information, please visit our web site or consult your au-

thorized dealer.
In a mixed network environment, the protocols switch automatically.

Reference
For more information about network connection settings, see p.67 “User
Tools (System Settings)”.

Client Windows 95/98/Me, Windows 2000, Windows NT 4.0 *1 , Mac OS *2  
(optional PostScript 3 Board Type 1232 is required ), UNIX *4 

Driver PCL 5c, RPCS™, PostScript 3 

File Server NetWare 3.x, NetWare 4.x, NetWare 5/5.1

Protocol TCP/IP, IPX/SPX, NetBEUI *3  , AppleTalk
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Note
❒ Consult your network administrator before connecting the machine to a net-

work.
❒ Make sure to use a properly shielded and grounded cable (UTP, STP, Catego-

ry/Type5) for the connection to the host computer (and/or HUB) in order to
meet FCC and EMC Directive 89/336/EEC emission guidelines.

When the Wireless LAN Board (option) is installed

When using the Wireless LAN Interface on the network, keep the following
points in mind:

❖❖❖❖ Attach both antennas as a unit.
 

❖❖❖❖ When moving the machine
Detach the antennas when relocating the machine locally.
After moving the machine, reattach the antennas, ensuring that: 
• The antennas are positioned clear of obstacles.
• There is 40 to 60 mm between the antennas, so they do not touch.
• The exposure glass cover and Document Feeder (ADF) do not knock the

antennas.

❖❖❖❖ If the network area provides poor radio environment
Where radio wave conditions are bad, the network may not function due to
interrupted or failed connections. When checking the Wireless LAN Signal
and the access point, follow these steps to improve the situation:
• Position the access point nearer to the machine.
• Clear the space between access point and machine of obstructions.
• Move radio wave generating appliances, such as microwaves, away from

the machine and access point.

Reference
To check the machine's radio wave status, press [Wireless LAN Signal] in Sys-
tem Settings. See p.86 “Wireless LAN Signal”.
For more information about access point radio wave conditions, refer to the
access point manual.
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Connecting the Network Cable to the Network

Limitation
❒ The IEEE 1394 Board (option) and the Wireless LAN Board (option) cannot be

installed at the same time.

Note
❒ Connect the machine to the computer. Set the network connection settings,

then install any necessary software such as the printer driver. For details, see
the Printer Reference.

Connecting to the Ethernet Interface

AAAA Turn off the main power switch.

BBBB Loop the cable approximately 5 cm (2") and 35 cm (14") from the machine
end connector.

House the loops using the supplied cores.

1. About 5 cm (2")

2. About 35 cm (14")

CCCC Attach the Ethernet interface cable to the jack on the board.

ZGJS112E

ZGJS832E
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DDDD Turn on the main power switch.

❖❖❖❖ Indicators on Network Interface Board

1. Indicator (green)
Remains green when the machine
is connected to the network cor-
rectly.

2. Indicator (yellow)
Turns yellow when 100 BASE-TX is
operating.
Turns off when 10 BASE-T is oper-
ating.

Connecting to the IEEE 1394 Interface (option)

Important
❒ Before making the connection, touch the metallic part to dissipate static elec-

tricity.

Note
❒ Use the interface cable supplied with the IEEE 1394 Board.
❒ The interface cable should not be looped.

AAAA Attach the IEEE 1394 cable to the jack on the board.

ZGJS834E

ZGJS863E
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Turning On the Power

This machine has two power switch-
es.

❖❖❖❖ Operation switch (right side of the
control panel)
Press this switch to activate the
machine. When the machine has
warmed up, you can make copies.

❖❖❖❖ Main power switch (left side of the ma-
chine)
When the machine is not to be used
for an extended period of time,
turn off the main power switch.

Note
❒ This machine automatically enters

Energy Saver mode or turns itself
off if you do not use the machine
for a while. See p.79 “Auto Off
Timer” and p.79 “Energy Saver
Timer”.

Turning On the Main Power

AAAA Make sure that the power cord is
firmly plugged into the wall out-
let.

BBBB Open the switch cover and turn
on the main power switch (make
sure that the Main Power indica-
tor goes on).

Important
❒ Do not switch off the main pow-

er immediately after it has been
switched on. Failure to observe
this may result in damage to the
hard disk or memory, leading to
malfunctions.

Turning On the Power

AAAA Press the operation switch to
make the On indicator go on.

Note
❒ If the power is not turned on

when the operation switch is
pressed, check if the main pow-
er switch is on. If off, turn it on.

ZGJS090N

ZGJS070N
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Turning Off the Power

AAAA Make sure that the exposure glass
cover or the document feeder is in
the right position.

BBBB Press the operation switch to
make the On indicator go off.

Note
❒ Even if you press the operation

switch, the indicator does not
go off and blinks in the follow-
ing cases:
• When the exposure glass or

the document feeder is open
• When communication is in

p r o g r e s s  w i t h  e x t e r n a l
equipment

• When the hard disk is oper-
ating

Turning Off the Main Power

Important
❒ Do not turn off the main power

switch when the On indicator is on
or blinking. Failure to observe this
may result in damage to the hard
disk or memory.

❒ Pull out the power plug after you
turn off the main power switch.
Failure to observe this may result
in damage to the hard disk or
memory.

AAAA Make sure that the On indicator is
off.

BBBB Open the switch cover, and turn
off the main power switch to
make the Main Power indicator
go off.

----When a facsimile unit (option) 
is installed

When the main power switch is
turned off while using the fax func-
tion, waiting fax jobs and print jobs
may be canceled, and incoming fax
documents cannot be received. When
you have to turn off this switch for
some reason, follow the procedure
below.

Important
❒ Make sure that 100% is shown on

the display before you turn the
main power switch is off or unplug
the power cord. Fax files pro-
grammed in memory will be delet-
ed an hour after you turn the main
power switch off or unplug the
power cord.

❒ The On indicator does not go off
and blinks in dial-in mode even if
you press the operation switch. In
such a case, check the items below,
and turn the main power switch
off.
• When the exposure glass cover

or the document feeder is open
• When the computer is control-

ling the machine
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Configuring the Network

Configuring the Network

Preparation
This section describes the network settings using the System Settings menu.
Required setting items depend on the mode to be used.

Mode Network

Environment

Network Settings Reference

Distribute re-
ceived fax doc-
uments *1 

TCP/IP IP Address, Sub-net 
Mask, Gateway Address, 
Network Boot, Effective 
Protocol, Interface Select, 
Fax RX File Transmission

⇒ p.38 “When using TCP/IP”, 
p.38 “Acquiring the IP Address 
from the DHCP Server”, p.43 
“File Transfer Settings”

IEEE 1394 *6 IP Address, Sub-net 
Mask, Gateway Address, 
Effective Protocol 
(TCP/IP) IP over 1394, 
Fax RX File Transmission

⇒ p.38 “When using TCP/IP”, 
p.39 “When using the IEEE 1394 
Interface (option)”, p.43 “File 
Transfer Settings”

Wireless LAN 
*7 

IP Address, Sub-net 
Mask, Gateway Address, 
Network Boot, Effective 
Protocol, Interface Select, 
Communication Mode, 
Channel *9  WEP, SSID *8 , 
Fax RX File Transmission

⇒ p.38 “When using TCP/IP”, 
p.41 “When using the Wireless 
LAN Interface (option) in Ad 
hoc Mode”, p.42 “When using 
the Wireless LAN Interface (op-
tion) in Infrastructure Mode”, 
p.43 “File Transfer Settings”

Scanner (Net-
work Twain 
Scanner) *2 

TCP/IP IP Address, Sub-net 
Mask, Gateway Address, 
Network Boot, Effective 
Protocol, Interface Select

⇒ p.38 “When using TCP/IP”, 
p.38 “Acquiring the IP Address 
from the DHCP Server”

IEEE 1394 *6 IP Address, Sub-net 
Mask, Gateway Address, 
Effective Protocol 
(TCP/IP), IP over 1394

⇒ p.38 “When using TCP/IP”, 
p.39 “When using the IEEE 1394 
Interface (option)”

Wireless LAN 
*7 

IP Address, Sub-net 
Mask, Gateway Address, 
Network Boot, Effective 
Protocol, Interface Select, 
Communication Mode, 
Channel *9 , WEP, SSID *8  

⇒ p.38 “When using TCP/IP”, 
p.41 “When using the Wireless 
LAN Interface (option) in Ad 
hoc Mode”, p.42 “When using 
the Wireless LAN Interface (op-
tion) in Infrastructure Mode”
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*1 To use this function, you'll need ScanRouter V2 Lite (packaged with optional Print-
er/Scanner Controller or ScanRouter V2 Professional). In addition to the network
settings, you must set the "Delivery Server IP Address" and "Fax RX File Transmis-
sion" for file transfer.

*2 You will need to specify the settings for a network TWAIN scanner and network de-
livery scanner when using the scanner function.

*3 When you use this function, you need to have an optional 128MB or 256MB memory,
or ScanRouter V2 Lite which is bundled with the optional Printer/Scanner Control-
ler. If you need to have ScanRouter V2 Professional, see the Scanner Reference.

*4 Make necessary settings for your network environment. For details about settings,
see the Printer Reference.

Scanner (Net-
work Delivery 
Scanner) *3 

TCP/IP IP Address, Sub-net 
Mask, Gateway Address, 
Network Boot, Effective 
Protocol, Interface Select, 
Delivery Option 

⇒ p.38 “When using TCP/IP”, 
p.38 “Acquiring the IP Address 
from the DHCP Server”

IEEE 1394 *6 IP Address, Sub-net 
Mask, Gateway Address, 
Effective Protocol 
(TCP/IP), IP over 1394, 
Delivery Option

⇒ p.38 “When using TCP/IP”, 
p.39 “When using the IEEE 1394 
Interface (option)”

Wireless LAN 
*7 

IP Address, Sub-net 
Mask, Gateway Address, 
Network Boot, Effective 
Protocol, Interface Select, 
Communication Mode, 
Channel *8 , WEP, SSID *9 , 
Delivery Option

⇒ p.38 “When using TCP/IP”, 
p.41 “When using the Wireless 
LAN Interface (option) in Ad 
hoc Mode”, p.42 “When using 
the Wireless LAN Interface (op-
tion) in Infrastructure Mode”

Printer TCP/IP *4 IP Address, Sub-net 
Mask, Gateway Address, 
Network Boot, Effective 
Protocol, Interface Select

⇒ p.38 “When using TCP/IP”, 
p.38 “Acquiring the IP Address 
from the DHCP Server”

NetWare *4  *5 Effective Protocol, NW 
Frame Type

⇒ p.38 “When using NetWare”

IEEE 1394 *6 IP Address, Sub-net 
Mask, Gateway Address, 
Effective Protocol 
(TCP/IP), IP over 1394

⇒ p.38 “When using TCP/IP”, 
p.39 “When using the IEEE 1394 
Interface (option)”

Wireless LAN 
*7 

IP Address, Sub-net 
Mask, Gateway Address, 
Network Boot, Effective 
Protocol, Interface Select, 
Communication Mode, 
Channel *9 , WEP, SSID *8  

⇒ p.38 “When using TCP/IP”, 
p.41 “When using the Wireless 
LAN Interface (option) in Ad 
hoc Mode”, p.42 “When using 
the Wireless LAN Interface (op-
tion) in Infrastructure Mode”, 
p.40 “When using the Wireless 
LAN Interface (option) in 802.11 
Ad hoc Mode”

Mode Network

Environment

Network Settings Reference
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*5 Configure the TCP/IP when you use pure IP of NetWare 5/5.1.
*6 You will need the IEEE 1394 Interface Board (option).
*7 You will need the IEEE 802.11b Interface Kit (option).
*8 Make the necessary settings when the communication mode is infrastructure mode

or 802.11b Ad hoc mode.
*9 Make necessary settings when the communication mode is in 802.11b Ad hoc mode

or Ad hoc mode.

Note
❒ For a network environment that uses TCP/IP, you can use SmartNetMonitor

to configure IP addresses for Admin and the web browser packaged with the
Printer/Scanner Controller. For details about Smart Net Monitor, see the Net-
work Printing Guide.

❒ For details on the setting values, see p.73 “Settings You Can Change with the
User Tools”.

Configuring the Network with the Operation Panel

This section describes the basic procedures. Please make the settings appropriate
for the network you are using.

Important
❒ These settings should be made by your systems administrator or after con-

sulting your systems administrator.

Note
❒ In this manual, minimum settings for network connections are described. For

more details, see the Network Printing Guide.
For default settings, see p.73 “Settings You Can Change with the User Tools”.

❖❖❖❖ “Interface Settings/Network” ⇒⇒⇒⇒ p.81

❖❖❖❖ “Interface Settings/IEEE 1394 (Option)” ⇒⇒⇒⇒ p.84

❖❖❖❖ “Interface Settings/IEEE 802.11b (Option)” ⇒⇒⇒⇒ p.85

❖❖❖❖ “File Transfer” ⇒⇒⇒⇒ p.86
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Network Settings

The following describes the settings required to use the machine in a network.
For more information about the settings, see p.81 “Interface Settings/Network”.

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [System Settings].

CCCC Press [Interface Settings].

DDDD Make [Effective Protocol] settings.

Note
❒ You must configure the IP Address for using TCP/IP protocol. Consult the

network administrator for help with the Address. You don't have to con-
figure it if Network Boot is DHCP.

❒ Press [Invalid] for redundant protocols.
❒ Press [Effective] for TCP/IP protocol when you use pure IP of NetWare

5/5.1.
A Press [Effective Protocol].

B Press [Invalid] or [Effective] for each protocol.
C Press [OK].

The following operation will be different, according to each protocol.

ZGJS002N
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When using TCP/IP

A Make sure that [Network] is pressed, and then press [IP Address].

B Use the number keys to enter the IP address.

C Press [OK].

D Make the [Sub-net Mask] and [Gateway Address] settings. For each item,
press the corresponding button on the screen shown in step AAAA, and then
perform the same procedure as described in steps BBBB and CCCC.

Acquiring the IP Address from the DHCP Server

To use the DHCP server to acquire the IP address, select [DHCP] from [Network
Boot].

Note
❒ You need to make the settings when you use DHCP. See "Using DHCP" in

the Network Printing Guide.
❒ To always assign the same IP address to the machine, reserve the IP ad-

dress for the machine on the DHCP server. See "Using DHCP" in the Net-
work Printing Guide.

❒ Use the default IP address.
A Make sure that [Network] is selected, and then press [Network Boot].

B Press [DHCP] and then press [OK].

When using NetWare

To use the machine on NetWare, be sure to select the type of [NW Frame Type].
You can select the following frame types:
• Auto select (Default)
• Ethernet II
• Ethernet 802.2
• Ethernet 802.3
• Ethernet SNAP
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Note
❒ Select a file server and a frame type with the same connection.
❒ When you select Auto select, the frame type detected upon startup is auto-

matically set. Therefore, your desired frame type may not be selected by the
system, which supports multiple frame types. Select the desired frame type.

❒ To use the machine in a pure IP environment on NetWare 5/5.1, select [Ef-
fective] for TCP/IP in step D.

A Make sure that [Network] is selected, and then press [NW Frame Type].

B Select the Frame Type, and then press [OK].

When using the IEEE 1394 Interface (option)

Note
❒ When you use the IEEE 1394 Interface, you cannot use the DHCP. You

must set the fixed IP address.
❒ Be sure to set the IP over 1394 to "Active". The factory default is set to "Ac-

tive".
A Make sure that [Network] is selected, and then press [IEEE 1394].

B Press [IP Address].

C Use the number keys to enter the IP address, and then press [OK].
D Press [Sub-net Mask].

E Use the number keys to enter the Sub-net Mask, and then press [OK].

F Press [IP over 1394].

G Make sure that [Active] is selected, and then press [OK].

Note
❒ If [Active] is not selected, press [Active], and then press [OK].
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When using the Wireless LAN Interface (option) in 802.11 Ad hoc Mode

Note
❒ You can set the 802.11 Ad hoc Mode from your computer when setting

SSID (Network Name).
❒ The network administrator must check the environment and set the Com-

munication mode, WEP key and SSID correctly. For details on settings, see
"Using the IEEE 802.11b (Wireless LAN)" in the Network Printing Guide.

❒ Characters used for setting SSID are <ASCII 0x20 to 0x7e> which are case-
sensitive. You can enter up to 32 characters.

❒ You can also set the 802.11 Ad hoc mode from the Web browser. For details
on settings, see the Network Printing Guide.

A Make sure that [Network] is selected, and then press [LAN Type].

B Press [IEEE 802.11b], and then press [OK].

C Press [IEEE 802.11b].

D Press [Communication Mode].

E Press [802.11 Ad hoc], and then press [OK].

F Press [SSID Setting].

G Press [Enter SSID] and enter the SSID, and then press [OK].

H Press [Channel].
I Use the number keys to enter the channel to be used, and then press [OK].

J Press [WEP (Encryption) Setting], if setting is required.

K Press [Active].

L Press [Enter WEP Key] and enter the WEP key, and then press [OK].
M Press [OK].
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When using the Wireless LAN Interface (option) in Ad hoc Mode

Note
❒ You can set the Ad hoc Mode when you do not set SSID (Network Name)

from your computer. In this case, setting SSID from this machine is ineffec-
tual.

❒ The network administrator must check the environment and set the Com-
munication mode and Channel correctly. For details on settings, see "Us-
ing the IEEE 802.11b (Wireless LAN)" in the Network Printing Guide.

❒ You can set the Ad hoc mode from the control panel or using the Web
browser. For details on settings, see the Network Printing Guide.

A Make sure that [Network] is selected, and press [LAN Type].

B Press [IEEE 802.11b], and then press [OK].

C Press [IEEE 802.11b].

D Press [Communication Mode].

E Press [Ad hoc], and then press [OK].
F Press [Channel].

G Use the number keys to enter the channel to be used, and press [OK].
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When using the Wireless LAN Interface (option) in Infrastructure Mode

Note
❒ The network administrator must check the environment and set the Com-

munication mode, WEP key, and SSID correctly. For details on settings, see
"Using the IEEE 802.11b (Wireless LAN)" in the Network Printing Guide.

❒ Enter the WEP key in hexadecimal. You can enter 10 digits for 64-bit data
or 26 digits for 128-bit data.

❒ Characters used for setting SSID are <ASCII 0×20 to 0×7e> which are case
-sensitive. You can enter up to 32 characters.

❒ You can also set the Infrastructure mode from the Web browser. For details
on settings, see the Network Printing Guide.

A Make sure that [Network] is selected, and then press [LAN Type].

B Press [IEEE 802.11b], and then press [OK].

C Press [IEEE 802.11b].

D Press [Communication Mode].

E Press [Infrastructure], and then press [OK].

F Press [SSID Setting].

G Press [Enter SSID].

H Enter the SSID, and then press [OK].
I Press [WEP (Encryption) Setting] if setting is required.

J Press [Active].

K Press [Enter WEP Key] and enter the WEP key.

L Press [OK].
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EEEE Press [Exit].

FFFF Print out the list of the entered settings if necessary.

Reference
For details about List/Test Print, see "Printer Features Menu" in the Printer
Reference.

A Press [Printer Features].

B Press [Config. Page].

GGGG Press the {{{{User Tools/Counter}}}} key.

The new settings become effective and the display returns to the main func-
tion menu.

File Transfer Settings

The following describes the file transfer settings required for sending received
facsimile files and the scanner function. For more information about the settings,
see p.86 “File Transfer”.

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [System Settings].

ZGJS002N
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CCCC Press [File Transfer].

When using a delivery server

Note
❒ You must set the delivery server IP address from the ScanRouter V2

Lite/Professional. You cannot set the address from the machine.
A Press [Delivery Option].

B Press [ON].
C Press [OK].

Note
❒ The delivery server IP address set from the ScanRouter V2 Lite/Profes-

sional will be displayed on the machine.

Making settings to transmit received facsimile files

A Press [Fax RX File Transmission].

B Make the following settings as required:

• Setting per Line
• Print at Delivery
• File to Deliver
• Dlvry Failure File

C Press [OK].

UranosC1-ENzen_F2_FM.book  Page 44  Friday, August 2, 2002  1:32 PM



Configuring the Network

45

2

Setting the recall interval time

A Press [Scanner Recall Interval Time].

B Use the number keys to enter the recall interval time, and then press
[OK].

Setting the number of recalls

A Press [Number of Scanner Recalls].

B To resend files to the delivery server, press [ON].

C Use the number keys to enter the number of recalls, and then press [OK].

DDDD Press [Exit].

EEEE Press the {{{{User Tools/Counter}}}} key.
The new settings become effective and the display returns to the main func-
tion menu.
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3. Combined Function
Operations

Changing Modes

Note
❒ You cannot switch modes in any of the following situations:

• When scanning in a fax message for transmission
• During immediate transmission
• When accessing the user tools
• During interrupt copying
• During On hook dialing for fax transmission
• While scanning an original ⇒ p.73 “Function Priority”

❒ The copying screen is displayed as default following power on.

ZGJS835N
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Saving Energy

----Energy Saver Mode
If you do not operate the machine for a certain period after an operation or when
you press the {{{{Energy Saver}}}} key, the display disappears and the machine enters
Energy Saver mode. When you press the {{{{Energy Saver}}}} key again, the machine
returns to the ready condition. In Energy Saver mode, the machine uses less elec-
tricity.

Note
❒ You can set the power consumption in Energy Saver mode and the time to re-

turn to ready status from Energy Saver mode in three steps. ⇒ p.89 “Panel Off
Level”

❒ You can also change the setting of the Panel Off Timer. ⇒ p.79 “Panel Off
Timer”

----System Reset
The machine returns to its initial condition automatically when your job is fin-
ished, after a certain period of time. This function is called "System Reset".

Note
❒ You can change the System Reset time. ⇒ p.79 “System Reset Timer”

----Auto Off
The machine turns itself off automatically after your job is finished, after a cer-
tain period of time. This function is called "Auto Off".

Note
❒ You can change the Auto Off time. ⇒ p.79 “Auto Off Timer”
❒ Auto Off Timer function will not operate in the following cases:

• When a warning message is displayed
• When the service call message is displayed
• When paper is jammed
• When the cover is open
• When "Add Toner" message is displayed
• When the toner is being replenished
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• When the User Tools/Counter screen is displayed
• When fixed warm-up is in progress
• When the facsimile, printer or other functions are operating
• When operations have been suspended during printing
• When the handset is in use
• When the On-hook dialing function is in use
• When a recipient is being registered in the address list or group dial list
• When the Data In indicator is on or blinking
• When the sample print or confidential print screen is displayed
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Multi-Access

You can carry out another job using a different function while the current job is
being performed. Performing multiple functions simultaneously like this is
called Multi-accessing.
This allows you to handle your jobs efficiently, regardless of how the machine is
being used. For example:
• While making copies, you can scan documents to store in the Document Serv-

er.
• While printing documents saved in the Document Server, the machine can re-

ceive print data.
• You can make copies while receiving fax data.
• While printing print data, you can make operations for copying.

Note
❒ You can set the priority of functions on p.73 “Print Priority”. As default, the

display function is set to first priority.
❒ When the optional Internal Tray, Shift Sort Tray, 500-Sheet Finisher, or 1000-

Sheet Finisher is installed on the machine, you can specify the output tray to
which documents are to be delivered. For more information about how to
specify the output tray for each function, see the following descriptions:
• p.74 “Output: Copier (Copy mode)”
• p.75 “Output: Document Server (Document server)”
• p.75 “Output: Facsimile (Facsimile)”
• p.75 “Output: Printer”

❖❖❖❖ What you can do with the Multi-Access Function
The multi-access function enables you to do the operations below.
• Copying during fax transmission

You can copy originals while sending documents by fax.
A Set documents for sending by fax, enter the fax number, and press the

{{{{Start}}}} key.
B Press the {{{{Copy}}}} key.

The copy screen appears. At the top of the screen, the destination name
and fax number appears.

C Set originals, and then press the {{{{Start}}}} key.
• Receiving printer data while printing a document saved in the Document

Server
The machine can receive printer data while copying or printing a docu-
ment saved in the Document Server. Received data will be printed when
the printer function is enabled.
A Select the document to be printed on the Document Server screen, and

then press the {{{{Start}}}} key.
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B When the machine receives the printer data, the data-in indicator blinks.
When printing the document is finished, the machine starts printing the
printer data.

----Sample operations
The chart below shows the sample operations of when the "Print priority" is set
to "Interleave". ⇒ p.73 “Print Priority”
|: Simultaneous operations are available.
$: Operation is enabled when the relevant function key is pressed and remote
switching (of the scanner) is done.
❍: Operation is enabled when the {{{{Interrupt}}}} key is pressed to interrupt the pre-
ceding operation.
→: Operation is performed automatically once the preceding operation ends.
×: The operation must be started once the preceding operation ends. (Simultane-
ous operations are not possible.)
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*1 Simultaneous operations are only possible once the preceding job documents are all
scanned and [Next Job] appears.

*2 You can scan a document once the preceding job documents are all scanned.
*3 Simultaneous operations are only possible with an additional line installed and

when the facsimile function is not using the line given line priority in the facsimile
settings.

*4 During stapling, printing automatically starts after the current job.
*5 Stapling is not available.
*6 Simultaneous operations become available after you press [Next Job].
*7 During parallel reception, any subsequent job is suspended until reception is com-

pleted.

Limitation
❒ Stapling cannot be used at the same time for multiple functions.

Note
❒ A machine with the 500-Sheet Finisher installed cannot accept other jobs

while printing with the stapling operation.
❒ A machine with the 1000-Sheet Finisher installed, that is printing with the sta-

pling operation on paper larger than A4 size starts the subsequent job (for
which Internal Shift Tray is specified as the output tray) only after the current
print job finishes.

❒ While printing is in progress, scanning a document using another function
may take more time.
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4. Document Server

Relationship between the Document 
Server and Other Functions

The following table describes the relationship between the Document Server
and other machine functions.

*1 See the “Facsimile Reference (option) <Advanced Features>”.
*2 You can display the stored documents from the Scanner Mode.
*3 See the “Scanner Reference”.

Document Server Display

❖❖❖❖ Document Server Main Display

1. Operating status and messages
appear.

2. The title of the currently selected
screen appear.

3. The numbers of originals, copies,
and printed pages appears.

4. The operation keys appear.

5. The modes in which the docu-
ments were stored are displayed.

Function name
From where to 

store documents
Displaying a list

Printing saved 
documents

Sending 
documents

Copy
Copy/Document 
Server

Enabled Enabled Disabled

Printer
Personal compu-
ter Enabled Enabled Disabled

Facsimile Facsimile Enabled Enabled Enabled *1 

Scanner Scanner Disabled *2 Disabled Enabled *3 

ZGJS842N
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The icons below show the operation mode when documents have been stored
in the Document Server.

Function Copier Facsimile Printer Scanner

Icon --
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Using the Document Server

Scanning and Saving 
Originals

❖❖❖❖ File name
The saved documents will auto-
matically be named as "COPY001",
"COPY002". You can change as-
signed file names.

❖❖❖❖ User name
You can register a user name to
distinguish the person or depart-
ment that saved the documents. To
assign it, you can register the user
name by using the name assigned
to the user code or by entering the
name.

Reference
For more information about the
user codes, see ⇒ p.94 “User
Code”.

❖❖❖❖ Password
You can set a password for the
saved documents, and use the
password to prevent others from
printing the saved documents.
When a password is set for the
documents,  is added to the doc-
uments.

Reference
To store documents in a mode oth-
er than Document Server mode,
see References for the respective
functions.

Important
❒ Data stored in the machine might

be lost if some kind of failure oc-
curs. The supplier shall not be re-
sponsible for any damage that
might result from the loss of data.

Note
❒ Data stored in the Document Serv-

er is set to be deleted after 3 days
(72 hours) by the factory default
value. You can specify the period
after which the stored data is delet-
ed automatically. ⇒ p.93 “Auto
Delete File”

AAAA Press the {{{{Document Server}}}} key.

BBBB Press [Scan Original].

CCCC Enter a file name, user name, or
password if necessary.

Note
❒ If you do not register a file

name, one is automatically as-
signed.

Reference
⇒ p.58 “To register or change
the user name”
⇒  p.59 “To change the file
name”
⇒ p.59 “To set or change the
password”

ZGJS776N
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DDDD Place your originals either on the
exposure glass or in the document
feeder.

Reference
For more information about
how to place the types of origi-
nals that can be placed, see the
Copy Reference.

EEEE Make any desired settings.

Reference
For details, see the Copy Refer-
ence.

FFFF Press the {{{{Start}}}} key.

The document is saved in the Doc-
ument Server.

Note
❒ To stop scanning, press the

{{{{Clear/Stop}}}} key. To resume the
paused scanning job, press [Con-
tinue] in the confirmation dialog
box. To delete the saved images
and cancel the job, press [Stop].

❒ When a password is stored, 
appears on the left side of the
file name.

❒ The saved documents are dis-
played on the “Select Files to
Print” display.

To register or change the user name

AAAA Display the "Scan Original" dis-
play.

BBBB Press [User Name].

If user names have already been
registered,  the "Change User
Name" display appears.

If the user names registered are 
used

A To change your user name to a
registered user name, select a
registered user name from the
list, and then press [OK].

To change your user name to an
unregistered user name, go to
the next step.

Reference
⇒ p.95 “Registering the New
User Code”

B To enter an unregistered user
name, press [Non-programmed
Name].

C Enter the new user name, and
then press [OK].

Reference
⇒ p.108 “Entering Text”
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If user names have not been 
registered

A Enter the new user name, and
then press [OK].

Reference
⇒ p.108 “Entering Text”.

To change the file name

AAAA Display the "Scan Original" dis-
play.

BBBB Press [File Name].

The "Change File Name" display
appears.

CCCC Press [Delete All] to delete the old
file name.

Note
❒ You can also use [Backspace] to

delete unnecessary characters.

DDDD Enter a new file name, and then
press [OK].

Note
❒ A string of up to 10 characters

can be entered as a file name.
Note that only eight characters
of each file name are displayed
in the document list.

Reference
⇒ p.108 “Entering Text”

To set or change the password

AAAA Display the "Scan Original" dis-
play.

BBBB Press [Password].

CCCC Enter the password using the
number keys (4 digits), and then
press [OK] or the {{{{#}}}} key.

Changing the File Name, User 
Name, or Password

AAAA Press the {{{{Document Server}}}} key.

BBBB Select the document for which the
user name, file name, or password
is to be changed.

Note
❒ If a password has already been

set for the document, enter the
password, and then press [OK].

CCCC Press [File Management].

DDDD Press [Change File Name], [Change
User Name], or [Change Password].
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EEEE Enter the new file name, user
name, or password using the let-
ter keys or number keys, and then
press [OK].

Reference
⇒ p.58 “To register or change
the user name”
⇒  p.59 “To change the file
name”
⇒ p.59 “To set or change the
password”

FFFF Press [OK].

Selecting a Document

AAAA Press the {{{{Document Server}}}} key.

BBBB Select a document to be printed.

Note
❒ If a password has been set for

the document, enter the pass-
word, and then press [OK].

❒ You can search for the docu-
ment using [Search by User Name]
or [Search by File Name] at the left
top of the display.  ⇒  p.61
“Searching Saved Documents”

❒ You can sort document names
in the list by user name, file
name or date. To sort the docu-
ments, press [User Name], [File
Name] or [Date].

❒ If you cannot determine the
contents of a document by its
file name, you can print just the
first page of the document for
checking purposes. ⇒  p.64
“Print First Page”

❒ To cancel document selection,
press the highlighted line for
the selected document.

CCCC To print multiple documents, re-
peat step BBBB in the order of docu-
ments to be printed.

Note
❒ You can select up to 30 docu-

ments.
❒ If the sizes or resolution of the

selected documents are not the
same, the documents may not
be printed.

❒ If you wish to change the order
of printing, cancel the selection,
and select documents again in
the desired order.

❒ If you press the {{{{Clear Modes}}}}
key, selection of all documents
will be canceled.

❒ If you press [Printg Odr], the doc-
uments will be displayed in the
order of printing.

To Check the Details of Stored Documents

AAAA Select the document for which
you want detailed information.

Note
❒ If a password has been set for

the document, the password en-
try dialog box appears. Enter
the password and then press
[OK].

UranosC1-ENzen_F2_FM.book  Page 60  Friday, August 2, 2002  1:32 PM



Using the Document Server

61

4

BBBB Press [Detail].

Detailed information about the
document is displayed.

Note
❒ If you have selected several doc-

uments, use [UUUU] and [TTTT] to view
the details of each.

❒ Press [OK]. The "Select Files to
Print" display appears.

Searching Saved Documents

You can use either [Search by File
Name] or [Search by User Name] to
search for documents stored on the
Document Server. You can also list
the stored documents in the order
you prefer.

Note
❒ If you install DeskTopBinder V2

Professional or DeskTopBinder V2
Lite on your computer, you can
search and rearrange the docu-
ments from your computer.

Reference
For more detailed information re-
fer to DeskTopBinder V2 Profes-
sional/Lite manuals.

To Search by File Name

AAAA Press the {{{{Document Server}}}} key.

BBBB Press [Search by File Name].

CCCC Enter the file name using the let-
ter keys, and then press [OK].
Only the files beginning with the
name entered appear in the “Select
Files to Print” display.

Reference
⇒ p.108 “Entering Text”.

Note
❒ To display all the files saved in

the Document Server, press [File
List].

To Search by User Name

AAAA Press the {{{{Document Server}}}} key.

BBBB Press [Search by User Name].

CCCC To specify a registered user name,
select the user name from the dis-
played list, and then press [OK].

Note
❒ To specify an unregistered user

name, follow the procedure be-
low.

DDDD To specify an unregistered user
name, press [Non-programmed
Name]. The entry dialog box be-
low appears. Enter the unregis-
tered user name in the entry
dialog box, and then press [OK].

Reference
⇒ p.108 “Entering Text”
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EEEE Press [OK].

Only the files beginning with the
name entered appear in the “Select
Files to Print” display.

Note
❒ To display all the files saved in

the Document Server, press [File
List].

Printing Saved Documents

AAAA Press the line for the document
you want to print.

Note
❒ If a password has been set for

the document, the password en-
try dialog box appears. Enter
the password, and then press
[OK].

❒ You can print multiple docu-
ments. ⇒ p.60 “Selecting a Doc-
ument”

BBBB If you need to change any of the
print settings, press [Print Settings].
The “Print Settings” display ap-
pears. User names, file names, and
print order of documents appear.

Note
❒ Print settings made for printing

in copier or printer mode are
stored after printing and ap-
plied to the next printing. Print
sett ings  made in facsimile
mode, however, are not stored.

❒ If you select multiple docu-
ments, print settings remain in
the first document, but they do
not remain in the other docu-
ments.

❒ Print setting items are listed be-
low. For more information
about the print results accord-
ing to each setting, see the Copy
Reference.

❖❖❖❖ Binding format
• 2 Sided Copy Top to Top
• 2 Sided Copy Top to Bot-

tom

❖❖❖❖ Cover handling
• Cover/Slip Sheet
• Edit Image

❖❖❖❖ Finish
• Sort
• Stack
• Staple

❒ If you print more than one set
using the Sort function, you can
check the print result by print-
ing out only the first set. ⇒ p.63
“Sample Copy”.

❒ When multiple documents are
printed at the same time, the
print settings made for the doc-
ument printed first are applied
to all other documents.
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❒ If you select multiple files, you
can confirm the file names or
print order of the files selected
in step A by scrolling through
the list with [TTTT] and [UUUU].

❒ Press [Select File] to return to the
“Select Files to Print” display.

❒ "Stamp" cannot be set for docu-
ments saved in facsimile mode.

CCCC Enter the required number of
prints using the number keys.

Note
❒ Up to 99 can be entered.

DDDD Press the {{{{Start}}}} key.

The machine starts printing.

Stop printing

AAAA Press the {{{{Clear/Stop}}}} key.

BBBB Press [Stop].

Changing the number of copies 
during printing

Limitation
❒ The number of copies can only be

changed when the Sort function is
selected in the print settings.

AAAA Press the {{{{Clear/Stop}}}} key.

BBBB Press [Change Quantity].

CCCC Use the number keys to enter a
new number of copies.

DDDD Press the {{{{#}}}} key.

EEEE Press [Continue].

Printing restarts.

Sample Copy

If you print multiple sets using the
Sort function, you can check if the
print order or the print settings are
correct by printing out only the first
set using the {{{{Sample Copy}}}} key.

Limitation
❒ This function can be used only

when the Sort function is selected.

AAAA Select the document to be printed.

Note
❒ If a password has been set for

the document, the password en-
try dialog box appears. Enter
the password, and then press
[OK].

❒ You can search for a document
by user or f i le name using
[Search by User Name] or [Search
by File Name] respectively. ⇒
p.61 “Searching Saved Docu-
ments”

❒ You can sort document names
in the list by user name, file
name, or date. To sort docu-
ments, press [User Name], [File
Name], or [Date].

❒ To cancel a document selection,
press the highlighted line for
the selected document.

BBBB Press the {{{{Sample Copy}}}} key.

The first set is printed out.
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CCCC Press [Continue].

Printing restarts.

Note
❒ Press [Suspend] to cancel print-

ing and return to the “Print Set-
tings” menu to change settings.

Print First Page

You can print the first page of the doc-
ument selected in the “Select Files to
Print” display to check content.
If more than one document is select-
ed, the first page of each is printed.

AAAA Select the document to be printed.

Note
❒ If a password has been set for

the document, the password en-
try dialog box appears. Enter
the password, and then press
[OK].

Note
❒ You can search for a document

by user or file name, using
[Search by User Name] or [Search
by File Name] respectively. ⇒
p.61 “Searching Saved Docu-
ments”

❒ You can sort document names
in the list by user name, file
name, or date. To sort docu-
ments, press [User Name], [File
Name], or [Date].

❒ To cancel a document selection,
press the highlighted line for
the selected document.

BBBB Press [Print 1st Page].

CCCC Press the {{{{Start}}}} key.

Deleting Saved Documents

Important
❒ You can save up to 1,000 docu-

ments in the Document Server. No
more documents can be saved
when there are 1,000 documents in
the Document Server. You should
delete unnecessary documents.

Note
❒ You can delete all the saved docu-

ments at once with the User Tools.
⇒ p.93 “Delete All Files”

AAAA Press the {{{{Document Server}}}} key.

BBBB Select the document to be deleted.

Note
❒ If a password has been set for

the document, the password en-
try dialog box appears. Enter
the password, and then press
[OK].

Note
❒ You can delete multiple docu-

ments at once. ⇒ p.60 “Select-
ing a Document”

❒ You can search for a document
by user or file name, using
[Search by User Name] or [Search
by File Name] respectively. ⇒
p.61 “Searching Saved Docu-
ments”
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❒ You can sort document names
in the list by the user name, file
name, or date. To sort docu-
ments, press [User Name], [File
Name], or [Date].

❒ If you cannot find the document
using the name, you can print
the first page of a document to
check its contents. ⇒ p.64 “Print
First Page”

❒ Press the selected line again to
cancel the print job.

CCCC Press [Delete File].

DDDD Press [Delete] to delete the docu-
ment.
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Settings for the Document Server

❖❖❖❖ Copier/Document Server Features ⇒⇒⇒⇒ "General Features 4/5" in Copy Reference

❖❖❖❖ System Settings ⇒⇒⇒⇒ p.73 “General Features”, ⇒⇒⇒⇒ p.76 “Tray Paper Settings”, p.79
“Timer Setting”, p.88 “Key Operator Tools”

Items Default settings

Copy Settings Document Server Storage Key:F1 2 Sided Original Top to top

Document Server Storage Key:F2 1 Sided → 1 Sided Combine

Document Server Storage Key:F3 1 Sided → 1 Sided Combine:4 
originals

Document Server Storage Key:F4 1 Sided → 1 Sided Combine:8 
originals

Document Server Storage Key:F5 Create Margin

Items Default settings

General Features Warm Up Notice ON

Copy Counter Display Up

Output:Document Server Internal tray

Tray Paper Settings Paper Tray Priority: Document Server Tray 1

Cover Sheet Tray OFF

Slip Sheet Tray OFF

Timer Settings Copier/Document Server

Auto Reset Timer

60 seconds

Key Operator Tools Auto Delete File Yes After 3 day(s)

Delete All Files --

Display Password with Stored File OFF
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5. User Tools (System Settings)

User Tools Menu (System Settings)

$ These items must be set to use the function. Be sure to set them before using
the corresponding function.
❍ These items must be set if required.

❖❖❖❖ General Features ⇒⇒⇒⇒ p.73 “General Features”

❖❖❖❖ Tray Paper Settings ⇒⇒⇒⇒ p.76 “Tray Paper Settings”

Default Copier Facsimile Printer Scanner

Panel Tone ON ❍ ❍ ❍ ❍

Warm Up Notice ON ❍ ❍

Copy Count Display Up ❍

Function Priority Copier ❍ ❍ ❍ ❍

Print Priority Display mode ❍ ❍ ❍

Function Reset Timer 3 seconds ❍ ❍ ❍

Output: Copier Internal Tray 1 ❍

Output: Document 
Server

Internal Tray 1

Output: Facsimile Internal Tray 1 ❍

Output: Printer Internal Tray 1 ❍

Default Copier Facsimile Printer Scanner

Paper Tray Priority: 
Copier

Tray 1 ❍

Paper Tray Priority: 
Printer

Tray 1 ❍

Tray Paper Size: Tray 1 Auto Detect ❍ ❍ ❍

Tray Paper Size: Tray 2 Auto Detect ❍ ❍ ❍

Tray Paper Size: Tray 3 Auto Detect ❍ ❍ ❍

Tray Paper Size: Tray 4 Auto Detect ❍ ❍ ❍

Paper Type: Bypass tray No display ❍ ❍

Paper Type: Tray 1 No display/2 Sided 
Copy/Auto Paper 
Select

❍ ❍
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❖❖❖❖ Timer Setting ⇒⇒⇒⇒ p.79 “Timer Setting”

Paper Type: Tray 2 No display/2 Sided 
Copy/Auto Paper 
Select

❍ ❍

Paper Type: Tray 3 No display/2 Sided 
Copy/Auto Paper 
Select

❍ ❍

Paper Type: Tray 4 No display/2 Sided 
Copy/Auto Paper 
Select

❍ ❍

Cover Sheet Tray OFF ❍ ❍

Slip Sheet Tray OFF ❍ ❍

Default Copier Facsimile Printer Scanner

Auto Off Timer 60 minute(s) ❍ ❍

Energy Saver Timer 15 minute(s) ❍ ❍

Panel Off Timer 60 seconds ❍ ❍ ❍

System Reset Timer 60 seconds ❍ ❍ ❍ ❍

Copier/Document 
Server Auto Reset 
Timer

60 seconds ❍

Facsimile Auto Reset 
Timer

30 seconds ❍

Scanner Auto Reset 
Timer

60 seconds ❍

Set Date -- $ $

Set Time -- $ $

Default Copier Facsimile Printer Scanner
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❖❖❖❖ Interface Settings ⇒⇒⇒⇒ p.81 “Interface Settings/Network”, p.83 “Interface Settings/Par-
allel Interface”, p.84 “Interface Settings/IEEE 1394 (Option)”, p.85 “Interface Set-
tings/IEEE 802.11b (Option)”

Default Copier Facsimile Printer Scanner

Network IP Address 011.022.033.044 ❍ ❍ ❍ *3 

Sub-net Mask 000.000.000.000 ❍ ❍ ❍ *3 

Gateway 
Address

000.000.000.000 ❍ ❍ ❍ *3 

Network 
Boot

NONE ❍ ❍ ❍ *3 

Effective 
Protocol

(all effective) ❍ ❍ ❍ *3   *4 

NW Frame 
Type

Auto select ❍ ❍

LAN Type Ethernet ❍ ❍ ❍ *3 

Ethernet 
Speed

Auto select ❍ ❍ ❍ *3 

Parallel 
interface

Parallel 
Timing

ACK outside ❍ ❍

Parallel Com-
munication 
Speed

High speed ❍ ❍

Selection Sig-
nal Status

High ❍ ❍

Input Prime Invalid ❍ ❍

Bidirectional 
Communica-
tion

ON ❍ ❍

Signal 
Control

Job acceptance 
priority

❍ ❍

IEEE 1394 
*1 

IP address 000.000.000.000 ❍ ❍ ❍ *3 

Sub-net Mask 000.000.000.000 ❍ ❍ ❍ *3 

IP over 1394 Active ❍ ❍ ❍ *3 

SCSI Print 
(SBP-2)

Active ❍

Bidirectional 
SCSI print

ON ❍

UranosC1-ENzen_F2_FM.book  Page 69  Friday, August 2, 2002  1:32 PM



User Tools (System Settings)

70

5
*1 Displayed when the IEEE1394 board (option) is installed.
*2 Displayed when the Wireless LAN board (option) is installed.
*3 Settings are required when using the delivery, TWAIN, store file, or mail delivery

functions.
*4 Effective Protocol Setting is required when using TCP/IP.

❖❖❖❖ File Transfer

❖❖❖❖ Key Operator Tools

IEEE 
802.11b *2 

Communica-
tion Mode

802.11 Ad hoc ❍ ❍ ❍ *3 

SSID Setting ASSID ❍ ❍ ❍ *3 

Channel 11 ❍ ❍ ❍ *3 

WEP (En-
cryption) Set-
ting

Inactive ❍ ❍ ❍ *3 

Wireless 
LAN Signal

--

Transmis-
sion Speed

Auto ❍ ❍ ❍ *3 

Return to 
Defaults

--

Default Copier Facsimile Printer Scanner

Delivery Option OFF ❍ ❍

Fax RX File Transmission -- ❍

Scanner Recall Interval 
Time

300 seconds ❍

Number of Scanner 
Recalls

3 time(s) ❍

Default Copier Facsimile Printer Scanner

User Code Management OFF ❍ ❍ ❍ ❍

Key Counter Management All OFF ❍ ❍ ❍ ❍

External Charge Unit 
Management

-- ❍ ❍ ❍ ❍

Key Operator Code OFF ❍ ❍ ❍ ❍

Panel Off Level Level 1 ❍ ❍

Display/Print Counter -- ❍ ❍ ❍ ❍

Display/Clear/Print 
Counter per User Code

-- ❍ ❍ ❍ ❍

Default Copier Facsimile Printer Scanner
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Address Book 
Management

-- ❍ ❍ ❍ ❍

Address Book: Pro-
gram/Change/Delete 
Group

-- ❍

Address Book: Change 
Order

-- ❍

Address Book: Edit 
Title

-- ❍ ❍ ❍ ❍

Address Book: Select 
Title

Title 1 ❍ ❍ ❍ ❍

Auto Delete File Yes After 3 day(s) ❍ ❍ ❍ ❍

Delete All Files -- ❍ ❍ ❍ ❍

Display Password with 
Stored File

OFF ❍ ❍ ❍ ❍

Key Operator's E-mail 
Address

-- ❍

AOF (Always ON) ON

Default Copier Facsimile Printer Scanner
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Accessing User Tools (System Settings)

This section is the key operators in
charge of this machine. You can
change or set the machine's default
settings.

Note
❒ Operations for system settings are

different from normal operations.
After using User Tools, be sure to
exit.

❒ Any changes you make with User
Tools remain in effect even if the
main power switch or operation
switch is turned off, or the {{{{Energy
Saver}}}} or {{{{Clear Modes}}}} key is
pressed.

Changing Settings

Note
❒ If a key operator code has been set,

the key operator code entry dialog
box appears. Enter the key opera-
tor code, and then press [OK]. ⇒
p.88 “Key Operator Code”

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [System Settings].

CCCC Select the desired menu and press
the desired key.

DDDD Change settings by following in-
structions on the display panel.
Then press [OK].

Note
❒ To cancel changes made to set-

tings and return to the normal
function display, press the {{{{User
Tools/Counter}}}} key.

Exiting from User Tools

AAAA Press the {{{{User Tools/Counter}}}} key.

Changing the system setting is fin-
ished, and the machine returns to
Copy or Print mode.

Note
❒ You can also exit from User

Tools by pressing [Exit].

ZGJS002N
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Settings You Can Change with the User 
Tools

Reference
For how to access User Tools, see p.72 “Changing Settings”.

General Features

❖❖❖❖ Panel Tone
The beeper (key tone) sounds when a key is pressed.

Note
❒ Default: ON

❖❖❖❖ Warm Up Notice (Copier/Document Server)
Specify whether the beeper sounds when the machine becomes ready for cop-
ying after Energy Saver mode is deactivated or the power is turned on.

Note
❒ If the “Panel Tone”setting is “OFF”, the beeper does not sound, whatever

the “Warm Up Notice”setting.
❒ Default: ON

❖❖❖❖ Copy Count Display (Copier/Document Server)
The copy counter can be set to show the number of copies made (count up) or
the number of copies remaining to be made (count down).

Note
❒ Default: Up (count up)

❖❖❖❖ Function Priority
You can specify the mode to be displayed immediately after the operation
switch is turned on or System Reset mode is turned on.

Note
❒ Default: Copier

❖❖❖❖ Print Priority
Print priority is given to the mode selected.

Reference
⇒ p.50 “Multi-Access”
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Note
❒ Default: Display mode

❒ When “Interleave” is selected, the current print job will be interrupted af-
ter maximum of 5 sheets.

❒ When the optional Internal Tray, Shift Sort Tray, 500-Sheet Finisher, or
1000-Sheet Finisher is installed on the machine, you can specify an output
tray to which documents are delivered. For more information about how
to specify an output tray for each function, see the following descriptions:
• p.74 “Output: Copier (Copy mode)”
• p.75 “Output: Document Server (Document server)”
• p.75 “Output: Facsimile (Facsimile)”
• p.75 “Output: Printer”

❖❖❖❖ Function Reset Timer
You can set the length of time the machine waits before changing modes
when using the multi-access function (⇒ p.50 “Multi-Access”). This is useful
if you make many copies and you have to change the settings for each copy.
If you set a large value, you can prevent jobs from other functions interrupt-
ing the copy job.

Note
❒ Default: 3 Seconds

❒ The Function Reset Timer setting is ignored if "Interleave" is set for "Print
Priority" (⇒ p.73).

❒ When you select "Set Time", enter the time (3∼30 seconds by 1 second
steps) with the number keys.

❖❖❖❖ Output: Copier (Copy mode)
You can specify a tray to which documents are delivered.

Note
❒ Default: Internal Tray 1

ZFFH110E

Shift Sort Tray

Internal Tray 1

Finisher Shift Tray

Finisher Proof Tray

Finisher Shift Tray

Internal Tray 2
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❖❖❖❖ Output: Document Server (Document server)
You can specify a tray to which documents are delivered.

Note
❒ Default: Internal Tray 1
❒ For details about output trays, refer to p.74 “Output: Copier (Copy

mode)”.

❖❖❖❖ Output: Facsimile (Facsimile)
You can specify a tray to which documents are delivered.

Note
❒ Default: Internal Tray 1
❒ For details about output trays, refer to p.74 “Output: Copier (Copy

mode)”.

❖❖❖❖ Output: Printer
You can specify a tray to which documents are delivered.

Note
❒ Default: Internal Tray 1
❒ The output trays set on the Printer Driver have priority over the output

tray specified above.
❒ For details about output trays, refer to the illustration in p.74 “Output:

Copier (Copy mode)”.

Output tray settings

Limitation
❒ You cannot interrupt the current stapling job even when a stapling job is spec-

ified with a different function.
❒ When the 500-Sheet Finisher or 1000-Sheet Finisher is installed and stapling

or shift-sorting is specified for a job, the job will be delivered to the Finisher
Shift Tray regardless of the output tray specified.

❒ The output tray used can be changed, when a stapling job of a different func-
tion is interrupted by copying, as in the following cases:

❖❖❖❖ When the 500-Sheet Finisher is installed and the finisher tray is specified for the
output tray:
• The interrupting job will be delivered to Internal Tray 1.

❖❖❖❖ When the 1000-Sheet Finisher is installed and the finisher tray is specified for the
output tray:
• The interrupting job will be delivered to Finisher Proof Tray.
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Tray Paper Settings

❖❖❖❖ Paper Tray Priority:Copier (Copier/Document Server)
You can specify the tray to supply paper for output.

Note
❒ Default: Tray 1

❖❖❖❖ Paper Tray Priority:Printer (Printer)
You can specify the tray to supply paper for output.

Note
❒ Default: Tray 1

❖❖❖❖ Tray Paper Size:  (Tray 1–4)
Select the size of the copy paper set in the paper tray.
• The paper sizes you can set for trays 1 and 2 are as follows:

• Auto Detect, A3L, B4L, A4K, A4L, B5K, B5L, A5K, A5L, A6L,
8KL, 16KK, 16KL

• 11"×17"L, 81/2"×14"L, 81/2"×13"L, 81/2"×11"K, 81/2"×11"L,
81/4"×13"L, 8"×13"L, 71/4"×101/2"K, 71/4"×101/2"L, 51/2"×81/2"K,
51/2"×81/2"L, custom size (100.0-297.0 mm (3.94"-11.69") wide × 148.0-
432.0 mm (5.83"-17.00") long)

• The paper sizes you can set for trays 3 and 4 are as follows:
• Auto Detect, A3L, B4L, A4K, A4L, B5K, B5L, A5K, A5L, 8KL,

16KK, 16KL

• 11"×17"L, 81/2"×14"L, 81/2"×13"L, 81/2"×11"K, 81/2"×11"L,
81/4"×13"L, 8"×13"L, 71/4"×101/2"L, 51/2"×81/2"K, 51/2"×81/2"L,
custom size (148.0-297.0 mm (5.83"-11.69") wide × 148.0-432.0 mm
(5.83"-17.00") long)

Important
❒ If the specified paper size differs from the size of paper actually set in the

paper tray, a paper misfeed might occur because the paper size is not de-
tected correctly.

Note
❒ The tray fence for the optional large capacity tray (LCT) is fixed. If you

need to change the paper size, contact your service representative.
❒ Default: Auto Detect

Reference
⇒ p.126 “Changing the Paper Size”
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❖❖❖❖ Paper Type:Bypass Tray
Sets the display so you can see what type of paper is loaded in the bypass tray.
• The paper types you can set for the bypass tray are as follows:

• Thick Paper, Recycled Paper, Special Paper, Color Paper, Letterhead,
Preprinted Paper, OHP, Label Paper, Punched Paper, Bond Paper,
Cardstock, Plain: Dup. Back, Thick: Dup. Back

Note
❒ Paper size which can be detected automatically, will be detected in L di-

rection.
❒ Default: No display

❖❖❖❖ Paper Type:Tray1–4
Sets the display so you can see what type of paper is loaded in each of the pa-
per trays. This information is used by the print function to automatically se-
lect the paper tray.
• The paper types you can set for trays 1 and 2 are as follows:

• Recycled Paper, Special Paper, Color Paper, Letterhead, Preprinted Pa-
per, Punched Paper, Label Paper, Bond Paper, Cardstock, OHP, Thick
Paper

• The paper types you can set for trays 3 and 4 are as follows:
• Recycled Paper, Special Paper, Color Paper, Letterhead, Preprinted Pa-

per, Punched Paper, Bond Paper, Cardstock

Note
❒ Default:

• Paper Type: No display

• Copying Method: 2 Sided Copy

• Apply Auto Paper Select: Yes
❒ A  is displayed next to the paper tray if “No” is selected in “Auto Paper

Select”.

Limitation
❒ “Auto Paper Select” can only be selected for the Copy function if “No dis-

play” and “Recycled Paper” are selected. If “No” is selected, “Auto Paper
Select” will not be valid for the tray.
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❖❖❖❖ Cover Sheet Tray
Allows you to specify and display the paper tray to set cover sheets. After se-
lecting the paper tray, you can also specify the display timing and copy meth-
od for two-sided copying.

Note
❒ Default:

• Tray to program: NONE

❒ The functions that use the Cover Sheet Tray setting are the front cover
function and front/back cover function.

❒ When “At Mode Selected” is selected, the Cover Sheet Tray settings are
only displayed when the cover function is selected.

❒ When “Full Time” is selected, the Cover Sheet Tray is always displayed.
❒ You can set the Copying Method in Duplex setting only when “At Mode

Selected” is selected.

Reference
⇒ “Covers” in the Copy Reference

❖❖❖❖ Slip Sheet Tray
Allows you to specify and display the paper tray to set slip sheets. After se-
lecting the paper tray, you can also specify the display timing and copy meth-
od for two-sided copying.

Note
❒ Default: 

• Tray to program: NONE
❒ When “At Mode Selected” is selected, the Slip Sheet Tray settings are only

displayed when the cover function is selected.
❒ When “Full Time” is selected, the Slip Sheet Tray is always displayed.

Reference
"Slip Sheets" in the Copy Reference
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Timer Setting

❖❖❖❖ Auto Off Timer
The machine turns off automatically to conserve energy after a specified
amount of time has passed following job completion. This function is called
"Auto Off". 
The machine status after the Auto Off operation is called "Off mode" or "Sleep
mode". For the Auto Off Timer, specify the time to elapse before the Auto Off
function is activated.
The time can be set from 1 minute to 240 minutes using the number keys.

Note
❒ Default: 60 minute(s)
❒ When in “Off mode” or “Sleep mode”, the machine can be ready for use

within 99 seconds.
❒ Auto off may not work when errors are displayed.

❖❖❖❖ Energy Saver Timer
Set the amount of time the machine waits before switching to lower-power
mode after copying has finished or the last operation is performed.
The time can be set from 1 minute to 240 minutes using the number keys.

Note
❒ Default: 15 minute(s)

❖❖❖❖ Panel Off Timer
Set the amount of time the machine waits before switching the panel off after
copying has finished or the last operation is performed.

Note
❒ The warm up time for making a copy from standby mode is 3 seconds for

Panel off Level 1 and 10 seconds for Panel off Level 2.
❒ Default: 60 seconds
❒ Enter a time interval between 10 seconds and 999 seconds using the

number keys.

❖❖❖❖ System Reset Timer
The System Reset setting is a setting that automatically switches to the screen
for the function set in Function Priority. This happens if no operations are per-
formed or when an interruputed job is cleared. This setting sets the system re-
set interval. ⇒ p.73 “Function Priority”

Note
❒ Default: 60 seconds

❒ The time can be set from 10 to 999 seconds by 1 second steps using the
number keys.
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❖❖❖❖ Copier/Document Server Auto Reset Timer (Copier/Document Server)
Specifies the time to elapse before the copier and Document Server functions
reset.

Note
❒ If [No] is selected, the machine will not automatically switch to the user

code entry screen.
❒ Default: 60 seconds

❒ The time can be set from 10 to 999 seconds using the number keys.

❖❖❖❖ Facsimile Auto Reset Timer (Facsimile)
Specifies the time to elapse before the facsimile function is reset.

Note
❒ Default: 30 seconds

❒ The time can be set from 30 to 999 seconds using the number keys.

❖❖❖❖ Scanner Auto Reset Timer (Scanner)
Specifies the time to elapse before the scanner function resets.

Note
❒ If [No] is selected, the machine will not automatically switch to the user

code entry screen.
❒ Default: 60 seconds

❒ The time can be set from 10 to 999 seconds using the number keys.

❖❖❖❖ Set Date
Set the date for the copier's internal clock using the number keys.

Note
❒ To change between year, month and day, press [←←←←] and [→→→→].

❖❖❖❖ Set Time
Set the time for the copier's internal clock using the number keys.

Note
❒ To change between minutes and seconds, press [←←←←] and [→→→→].

UranosC1-ENzen_F2_FM.book  Page 80  Friday, August 2, 2002  1:32 PM



Settings You Can Change with the User Tools

81

5

Interface Settings/Network

❖❖❖❖ IP Address
Before using this machine with the network environment, you must config-
ure the IP address.

Note
❒ Default: 011.022.033.044

❒ Do not use an IP address that is used for another machine. To get the ad-
dresses, contact your network administrator.

❒ If you install the IEEE 1394 board (option) and use the IEEE 1394 interface,
you must set the address of the domain, different from the IP address of
[IEEE 1394]. If you intend to set the address for the same domain, set a dif-
ferent value for the Sub-net Mask.

❒ Press [←←←←] or [→→→→] to move between each group of three numbers.

❖❖❖❖ Sub-net Mask
This is a number used to mathematically "mask" or hide an IP address on the
network by eliminating those parts of the address that are alike for all the ma-
chines on the network.

Note
❒ Default: 000.000.000.000

❒ Press [←←←←] or [→→→→] to move between each group of three numbers.

❖❖❖❖ Gateway Address
A gateway is a connection or interchange point connecting two networks.
Configure the gateway address for the router or host computer used as a gate-
way.

Note
❒ Default: 000.000.000.000

❒ Press [←←←←] or [→→→→] to move between each group of three numbers.
❒ To get the address, contact your network administrator.

❖❖❖❖ Network Boot
Select how to set an IP address from a client.

Note
❒ Default: NONE

❒ For details about settings, consult your network administrator.

Reference
For details, see the Printer Reference
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❖❖❖❖ Effective Protocol
Select the protocol to use in the network.

Note
❒ Default: TCP/IP:Effective, NetWare:Effective, NetBEUI:Effective, AppleTalk:

Effective

❖❖❖❖ NW Frame Type
Select the frame type when you use NetWare.

Note
❒ Default: Auto Select

❖❖❖❖  LAN Type
When you have installed the Wireless LAN board (option), select the inter-
face, Wireless LAN (IEEE 802.11b) or Ethernet.

Note
❒ Default: Ethernet

❖❖❖❖ Ethernet Speed
Set the access speed for networks.
Select a speed that matches your network environment. "Auto Select" should
usually be specified.

Note
❒ Default: Auto Select
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Interface Settings/Parallel Interface

❖❖❖❖ Parallel Timing
Specifies the timing setting for the parallel interface. Under normal circum-
stances, you will not need to change this setting.

Note
❒ Default: ACK outside

❖❖❖❖ Parallel Communication Speed
Specifies the communication speed of the parallel interface. If the communi-
cation speed is set too fast, data transfer may not flow smoothly. If this occurs,
change the setting to “Standard”.

Note
❒ Default: High speed

❖❖❖❖ Selection Signal Status
Specifies the signal setting of the parallel interface.

Note
❒ Default: High

❖❖❖❖ Input Prime
Specifies whether the prime signal is active or inactive when an input prime
signal is sent. Under normal circumstances, you will not need to change this
setting.

Note
❒ Default: Invalid

❖❖❖❖ Bidirectional Communication
Specifies the printer's response mode and so forth for a status request when
using the parallel interface. If you experience problems when using other
manufacturers' printers, set this to “OFF”.

Limitation
❒ If this is set to “OFF”, asynchronous functions will not work.

Note
❒ Default: ON

❖❖❖❖ Signal Control
Specifies the error processing settings for when an error occurs when printing
from a computer or sending faxes. Under normal circumstances, you will not
need to change this setting.

Note
❒ Default: Job acceptance priority
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Interface Settings/IEEE 1394 (Option)

Preparation
You must install the IEEE 1394 board (option) into the machine.
The Wireless LAN board (option) cannot be installed at the same time.

❖❖❖❖ IP Address
When you connect this machine to a network using the IEEE 1394 board (op-
tion), you must configure the IP address.

Note
❒ Default: 000.000.000.000

❒ When you use the IEEE 1394 interface on a network, you cannot use the
Ethernet interface in the same domain. To use it in the same domain, set a
different value for the Sub-net Mask.

❖❖❖❖ Sub-net Mask
This is a number used to mathematically "mask" or hide an IP address on the
network by eliminating those parts of the address that are alike for all the ma-
chines on the network.

Note
❒ Default: 000.000.000.000

❒ When you use the IEEE 1394 interface on a network, you cannot use the
Ethernet interface in the same domain. To use it in the same domain, set
the different value for the Sub-net Mask.

❒ Press [←←←←] or [→→→→] to move between each group of three numbers.

❖❖❖❖ IP over 1394
When you use the IP over 1394 function of the IEEE 1394 interface to connect
the machine to the network, or you print using a personal computer with the
IP over 1394 driver, you must set the IP over 1394. This function is supported
by Windows Me or Windows XP.

Note
❒ Default: Active

❒ When using the IP over 1394 function, set the IP Address and the Sub-net
Mask.

Reference
For details, see the Printer Reference.
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❖❖❖❖ SCSI Print (SBP-2)
When you print using the SCSI Print client function supported by Windows
2000 or Windows XP, you must set SCSI Print. For details, see the Network
Reference.

Note
❒ Default: Active

❒ When using the SCSI Print (SBP-2), setting the IP Address and the Sub-net
Mask is not required.

❖❖❖❖ Bidirectional SCSI Print
Specifies the printer's response mode and so forth for a status request when
using the IEEE 1394 interface.

Note
❒ Default: ON

❒ If this is set to "OFF", asynchronous functions will not work.

Interface Settings/IEEE 802.11b (Option)

Preparation
You must install the Wireless LAN board (option) into the machine.
The IEEE 1394 board (option) cannot be installed at the same time.

Note
❒ Be sure to make all settings simultaneously.

❖❖❖❖ Communication Mode
Specifies the communication mode of the Wireless LAN.

Note
❒ Default: 802.11 Ad hoc

❖❖❖❖ SSID Setting
Specifies SSID to distinguish the access point in the Infrastructure mode.

Note
❒ Default: ASSID

❒ If SSID is left blank for the 802.11b Ad hoc Mode or Ad hoc Mode, “ASSID”
is displayed.

❖❖❖❖ Channel
Specifies a channel when you select 802.11b Ad hoc mode or Ad hoc mode.

Note
❒ The channel can be set from 1 - 11.
❒ Default: 11
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❖❖❖❖ Wireless LAN Signal
Shows the radio-wave status of the access point connected in Infrastructure
mode.
Radio wave status is shown when you press [Wireless LAN Signal].

❖❖❖❖ WEP (Encryption) Setting
Specifies encryption of the Wireless LAN. If this is set to effective, you must
enter the WEP key.

Note
❒ Default: Inactive

❖❖❖❖ Transmission Speed
Specifies the communication speed of the Wireless LAN.

Note
❒ Default: Auto

❖❖❖❖ Return to Defaults
You can return Wireless LAN settings to the factory default value.

File Transfer

Make these settings as required when using ScanRouter V2 Lite/Professional.

Note
❒ The optional ScanRouter V2 Professional is required for distributing received

fax documents.

❖❖❖❖ Delivery Option
If [ON] is selected, the delivery server IP address will be displayed.

Note
❒ Default: OFF

❒ The delivery server IP address can only be set from ScanRouter V2
Lite/Professional.

❖❖❖❖ Fax RX File Transmission
• Setting per Line

Specifies whether or not received fax documents should be sent to Scan-
Router V2 Professional for each of the fax lines.

Note
❒ Default: G3 Port 1/Do not Deliver, G3 Port 2/Do not Deliver, G3 Port 3/Do

not Deliver
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• Print at Delivery
Specifies whether or not received fax documents that are sent to ScanRout-
er V2 Professional should also be printed by the machine at the same time.

Note
❒ Default: No

• File to Deliver
Specifies whether all received fax documents or only received fax docu-
ments that include delivery codes (documents with an ID and F code)
should be sent to ScanRouter V2 Professional.

Note
❒ Default: File with Dlvry Code

• Delivery Failure File
If a received fax document cannot be sent to ScanRouter V2 Professional,
the document is stored in the machine's memory. To print this stored data,
select “Print File”; to delete the data, select “Delete File”.

Note
❒ If the machine can send data to ScanRouter V2 Professional, data is sent

automatically.
❒ If you delete the data, you will not be able to distribute or print the data.

❖❖❖❖ Delivery Server IP Address

Note
❒ Default: 000.000.000.000

❖❖❖❖ Scanner Recall Interval Time
Specifies the interval period waits before resending data or a document, if it
could not be sent to ScanRouter V2 Lite/Professional.

Note
❒ Default: 300 seconds

❒ Enter an interval within the range of “60-900 seconds” (in one second in-
tervals) with the number keys.

❒ This setting is for the Scanner function. Received faxes continue to be dis-
tributed.

❖❖❖❖ Number of Scanner Recalls

Note
❒ Default: 3 time(s)

❒ Enter the number of times within the range of “1 to 99” using the number
keys.

❒ This setting is for the Scanner function. The distribution of received fax
documents will still be performed.
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Key Operator Tools

The key operator must set the following items. For settings or more information,
contact the key operator.

❖❖❖❖ User Code Management
Allows you to control who uses the machine by setting codes for users.
User codes must be registered for user code management. ⇒ p.94 “User
Code”.

Note
❒ Default: Copier/OFF, Document Server/OFF, Facsimile/OFF, Scanner/OFF,

Printer/PC Control:ON
❒ By selecting “PC Control:ON” for the printer, you can keep a print log for

each user code entered from the driver.

❖❖❖❖ Key Counter Management
Use the key counter to specify whether users are limited or not.

Note
❒ Default: Copier/OFF, Document Server/OFF, Facsimile/OFF, Scanner/OFF,

Printer/OFF

❖❖❖❖ External Charge Unit Management
Use the external charge unit to limit the user's charge and to manage the use.

Note
❒ Default: Copier/OFF, Document Server/OFF, Facsimille/OFF, Scanner/OFF,

Printer/OFF

❖❖❖❖ Key Operator Code
This specifies whether or not to use passwords (max. 8 digits) to control use
of the “Key Operator Tools” settings for access codes.

Note
❒ Default: OFF

❒ If you select “ON”, enter the access code (max. 8 digits) with the number
keys, and then select “Partial” or “All Initial Settings” to set the access lim-
it.
• If you selected “Partial”

An access code is only required for the “Timer Setting”, “Key Operator
Tools” initial settings and for “Key Operator Tools” for the fax initial
settings. “MENU PROTECT” will be set for “CHANGE/CONTROL” in
the printer initial settings. If you set “MENU PROTECT”, you can set
the key operator code under of the printer initial settings. ⇒ "Printer
Features Parameters" in the Printer Reference
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• If you selected “All Initial Settings”
An access code will be required to access all the items in the System Set-
tings, Copier/Document Server Features, Facsimile Features, Printer
Features, and Scanner Features.

❒ If you select “All Initial Settings”, you will need to enter the access code to
access the Key Operator Code screen.

❖❖❖❖ Panel Off Level
Specifies the panel off level.

Note
❒ Default: Level 1

❖❖❖❖ Display/Print Counter
Allows you to view and print the number of prints.
• Display/Print Counter

Displays the number of prints for each functions (Total, Copier (Full
Color/Black & White/Single Color/Two-color), Facsimile (Single
Color/Black & White), and Printer (Color/Black & White), A3/DLT, Du-
plex, Staple).

• Print Counter List
Prints out a list of the number of prints for each functions.

• To print the counter list
A Press the {{{{User Tools/Counter}}}} key.
B Press [System Settings].
C Press [Key Operator Tools].
D Press [Display/Print Counter].
E Press [Print Counter List].

F Press the {{{{Start}}}} key.
G Press [Exit].

Level Warm-up time

Level 1 about 3 second

Level 2 about 10 seconds
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❖❖❖❖ Display/Clear/Print Counter per User Code
Allows you to view and print the number of prints accessed with user codes
and to set the values to 0.

Note
❒ Press [UUUU] and [TTTT] to show all the number of prints. 

• Print Counter per User Code
Prints the number of prints for each of the user codes.

• Clear Counter per User Code
Sets the number of prints for each of the user codes to 0.

• The number of prints may differ from the counter value of Total Coun-
ter in the User Tools.

Note
❒ Print List for Each User Code ⇒ p.98 “Printing the Number of Prints for

Each User Code”.
• Print Counter for All User Codes

Prints the number of prints for all the user codes.
• Clear Counter for All User Codes

Sets the number of prints for all the user codes to 0.

❖❖❖❖ Address Book Management
Adds, changes or deletes user codes (max 8 digits). For details on operations,
see p.94 “User Code”.

Note
❒ You can register up to 2000 user names.
❒ You can register up to 80 user codes. If you add the optional functions, you

can register up to 200 user codes.
❒ You can also register user codes from SmartNetMonitor for Admin (print-

er option required).
❒ Even if you change user codes, number of prints are not cleared.
❒ If you clear a user code, its number of prints associated with it are also au-

tomatically cleared.
• [Program/Change]

This registers new user codes. You can register and change user codes
and user names.

• User name
User (destination) name, key display, registeration number, title selection

• User code
User code, available functions

• By E-mail Address
E-mail address, sender's password, enter password

• [Delete]
Deletes a user.
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❖❖❖❖ Address Book: Program/Change/Delete Group
You can register multiple users in a group.
Then you can easily control the registered users for each group.
• [Program/Change]

This registers new groups, or changes the group name, key display, title se-
lection, or registration number.

• [Delete]
Deletes a group.

❖❖❖❖ Address Book: Change Order
Changes the order of the registered user (destination).

Note
❒ You can rearrange the order of items on the same page, but you cannot

move the items to another page. For example, you cannot move an item
from “PLANNING” ([OPQ]) to “DAILY” ([CD]).

A Press the {{{{User Tools/Counter}}}} key.
B Press [System Settings].
C Press [Key Operator Tools].
D Press [Address Book: Change Order].

E Press the user (destination) key to be moved.

Note
❒ You can select a user with the number keys.

F Press the user destination key which is in the place, you want to move to.
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The user (destination) selected in step E moves to the place selected in
step F, and the keys for the other users will shift.

Note
❒ You can select a user using the number keys.

❖❖❖❖ Address Book: Edit Title
You can edit the title to find a desired user easily.
A Press the {{{{User Tools/Counter}}}} key.
B Press [System Settings].
C Press [Key Operator Tools].
D Press [Address Book: Edit Title].

E Press the title key to be changed.

F Enter the new name, and then press [OK].
G Press [Exit].

❖❖❖❖ Address Book: Select Title
Specifies the title to select a user.

Note
❒ Default: Title 1
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❖❖❖❖ Auto Delete File
Specifies whether the documents stored in the document server are to be de-
leted or not after a specified period of time.

Note
❒ Default: Yes After 3 day(s)

❒ If you select Yes, the documents stored after this setting will be deleted.
❒ If you select No, documents will not be deleted automatically.
❒ If you select Yes, enter the number of days within the range of 1 - 180.
❒ The factory setting is 3 days, which means documents will be deleted 3

days (72 hours) after they are stored.

❖❖❖❖ Delete All Files
All documents stored in document server will be deleted.

Note
❒ Even if a password has been set, all documents will be deleted.
❒ A confirmation dialog box will appear. To delete all documents, select

[OK].

❖❖❖❖ Display Password with Stored File
Specifies whether the password for the documents stored in the document
server is temporarily displayed or not.

Note
❒ Default: OFF

❒ Only when you forget the password, select [Yes]. After you confirm the
password, be sure to return the setting to [No].

❖❖❖❖ Key Operator's E-mail Address
By registering the operator's E-mail Address, you can send an E-mail if prob-
lems arise. Specifies whether or not to use this function.
The default setting is blank, the E-mail address is not installed.

❖❖❖❖ AOF (Always ON)
Specifies to keep the Auto Off function ON.

Note
❒ Default: ON
❒ For details of this function, contact your service representative.
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User Code

By registering user codes, you can
limit users to particular functions and
check their use of each function. By
installing an optional external charge
unit in the machine, you can summa-
rize and manage data on each func-
tion and monitor function usage in
more detail. 

Reference
User codes can also be registered
using SmartNetMonitor for Ad-
min (printer option required).
⇒Network Printing Guide

The management and control items
for each function are as follows:

❖❖❖❖ Copier
When you set User Code Manage-
ment, entering the user code is re-
quested before using the Copy
function. This enables you to limit
users for each color settings.
The number of copies for each
color settings is counted for each
user code. So you can check the us-
age for each user.

Note
❒ Select the color in User Code

Management. ⇒ p.88

❖❖❖❖ Document Server
When you set User Code Manage-
ment, entering the user code is re-
q u e s t e d  be f o r e  u s i ng  t he
Document Server function. This
enables you to limit the users of the
Document Server.
The number of copies in Document
Server mode is counted for each
user code as the accumulated
printings.

Note
❒ Select the Document Server

function in User Code Manage-
ment. ⇒ p.88

❖❖❖❖ Facsimile
When you set User Code Manage-
ment, entering the user code is re-
quested before using the Facsimile
function. This enables you to limit the
users of the facsimile transmission.
The number of copies for the docu-
ment stored in the document serv-
er in facsimile mode is counted for
each user code. So you can check
the usage for each user.

Note
❒ Select the Facsimile function in

User Code Management. ⇒
p.88

❖❖❖❖ Printer
When you set User Code Manage-
ment, you can print documents
from the printer driver with the
user code registered.
Black & White documents are
counted as Black & White print,
and documents which includes
any of the colors are counted as
color print for each user code. You
can check usage for each user.

Note
❒ To register the user code of the

printer driver automatically, se-
lect PC Control:ON for the
printer in User Code Manage-
ment. If you use the user code
set in User Tools, select PC Con-
trol:OFF and set the user code
for each color. Set the user codes
registered in User Tools for the
printer driver ⇒ p.88.
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❖❖❖❖ Scanner
Limits users who can use the Scan-
ner function and manages the use
of each user code.

Note
❒ Select the Scanner function in

User Code Management set-
tings (⇒ p.88).

Important
❒ The functions associated with

each user code are the same. If
you change or delete user codes,
management data and limits of
that code will become invalid.

Registering the New User 
Code

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [System Settings].

CCCC Press [Key Operator Tools].

DDDD Press [Address Book Management].

EEEE Press [New Program].

Note
❒ To register a user code to a reg-

istered user, press the user key
whose user code is to be regis-
tered, or enter the registered
number using the number keys.

FFFF Set the user information.

Note
❒ To register a user code to a reg-

istered user, skip to step G.

To register the user name and 
key name

A Press [Change] on the right of
the user name or key name.

The user name or key name en-
try dialog box appears.

B Enter the user name or key
name, and then press [OK].

Note
❒ You can use the same user

name as that assigned to the
documents  in document
server mode. In this case, en-
try of the user code is not re-
quired. ⇒ p.55 “Document
Server”

Reference
⇒ p.108 “Entering Text”

ZGJS002N
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To select the title

A Press the key for the classifica-
tion you want to use from “Se-
lect Title”.

Note
❒ The keys you can select are as

follows:
• [Freq.]… Added to the

page that is displayed
first.

• [AB],[CD],[EF],[GH],[IJK],[LM
N],[OPQ],[RST],[UVW],[XYZ]
…  Added to the list of
items in the title selected.

❒ You can only select one page
for “Select Title”.

GGGG Press [User Code].

HHHH Enter the user code using the
number keys and then press [#].

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key,
and then enter the code again.

IIII Select the functions to be used
with the user code from “Availa-
ble Functions”.

JJJJ To continue registering user
codes, press [Continue to Program],
and then repeat the procedures
from step FFFF.

KKKK Press [OK].

LLLL Press [Exit].

MMMM Press the {{{{User Tools/Counter}}}} key.

Changing a User Code

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [System Settings].

CCCC Press [Key Operator Tools].

DDDD Press [Address Book Management].

EEEE Press [Program/Change].

FFFF Select the registered user code
you want to change.
You can also enter the registered
number using the number keys.

GGGG Enter the new information for the
item you want to change.

To change the user (destination) 
name or key name

A Press [Change] on the right of
the user (destination) name or
key name.

B Enter the user (destination)
name, and press [OK].

Reference
⇒ p.108 “Entering Text”
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To change the title

A Press the key for the classifica-
tion you want to use from “Se-
lect Title”.

Changing the user code

A Press [User Code].

B Press [Change], and then enter
the new user code using the
number keys.

C Press [#].

To change the available functions

A Press [User Code].

B Press the key to select the func-
tions to be enabled.

Note
❒ Press the key to make it high-

lighted, and the key will be
enabled.

HHHH Press [OK].

IIII Press [Exit].

JJJJ Press the {{{{User Tools/Counter}}}} key.

Clearing a User Code

Important
❒ This operation also deletes user

codes registered for multiple func-
tions. User control with the deleted
user code will be disabled.

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [System Settings].

CCCC Press [Key Operator Tools].

DDDD Press [Address Book Management].

To clear a user (destination)

A Press [Delete].

B Select the user (destination)
you want to delete.

Press the user (destination) key,
or enter the registered number
using the number keys.

C Press [Yes] in the confirmation
screen.

To delete the user code

A Select a user (destination) whose
user code is to be deleted.

Press the user (destination) key,
or enter the registered number
using the number key.

B Press [User Code].

C Press [Change] to delete the user
code, and then press [#].

D Press [OK].
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EEEE Press [Exit].

FFFF Press the {{{{User Tools/Counter}}}} key.

Displaying the Number of 
Prints for Each User Code

You can check the number of prints
for each function's user code.

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [System Settings].

CCCC Press [Key Operator Tools].

DDDD Press [Display/Clear/Print Counter per
User Code].

EEEE Press [Print Counter].

The individual function counters
for each user code are displayed.

Printing the Number of Prints 
for Each User Code

You can print out the number of
prints for each user code using [Copy
Counter] or [Print Counter]. Also, you
can print out by using both of them
together.

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [System Settings].

CCCC Press [Key Operator Tools].

DDDD Press [Display/Clear/Print Counter per
User Code].

To print the number of prints for 
each user code

A Select a User Code from the
left side of the display.

Note
❒ Press [Select all on the page] if

you want to select all user
codes on the page.

B Press [Print Counter List] of “Per
User Code”.

Note
❒ Enter the user code, and then

press [#] if the user code is
registered.

To print the number of prints for 
all user codes

A Press [Print Counter List] of “All
User Codes”.

Note
❒ Enter the user code, and then

press [#] if the user code is
registered.
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EEEE Press [Print Counter].

FFFF Press [Print].

Clearing the Number of Prints

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [System Settings].

CCCC Press [Key Operator Tools].

DDDD Press [Display/Clear/Print Counter per
User Code].

EEEE Select the User Code to clear.

To clear the number of prints for 
each user code

A Select a User Code from the
left side of the display.

Note
❒ Press [All on The Page] if you

want to select all user codes
on the page.

B Press [Clear] for “Per User
Codes”.

To clear the number of prints for 
all user codes

A Press [Clear] for “All User
Codes”.

FFFF Press [Print Counter].

GGGG Press [Print].
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E-mail Destination

By registering an E-mail destination,
you can send scanned documents by
E-mail.
• It is easy to select the E-mail desti-

nation if you register “User (Desti-
nation) Name” and “Key Display”
for the E-mail destination.

• You can register an E-mail destina-
tion as a group.

• You can use the E-mail destination
as the Sender's address. In this
case, you can set a password in or-
der to prevent the use of other peo-
ple.

Reference
E-mail destinations can also be
registered using SmartNetMonitor
for Admin (printer option re-
quired) . ⇒Network Printing
Guide

Registering an E-mail 
Destination

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [System Settings].

CCCC Press [Key Operator Tools].

DDDD Press [Address Book Management].

EEEE Press [New Program].

Note
❒ To register an E-mail address to

a registered user, press the user
key you want to register, or en-
ter the registered number using
the number keys.

FFFF Set the user's information.

Note
❒ To register an E-mail address to

a registered user, skip to step G.
❒ Registration No. will automati-

cally be set to the minimum
number which is not used.

To register the user (destination) 
name and key name

A Press [Change] on the right of
the user (destination) name or
key name.

The user (destination) name or
key name entry dialog box ap-
pears.

ZGJS002N
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B Enter the user (destination)
name or key name, and then
press [OK].

Note
❒ You can use the user name

when selecting an address to
send an E-mail to.

❒ You can register the user
code fol lowing  the user
name. For more details, refer
to “User Code” ⇒ p.94.

Reference
⇒ p.108 “Entering Text”

To select the title

A To classify the user with the ti-
tle, press the title key from “Se-
lect Title”.

Note
❒ The keys you can select are as

follows.
• [Freq.]… Added to the

page that is displayed
first.

• [AB], [CD], [EF], [GH], [IJK],
[LMN], [OPQ], [RST], [UVW],
[XYZ],… Added to the list
of items in the title select-
ed.

❒ You can only select one page
for “Select Title”.

GGGG Press [E-mail Address].

HHHH Press [Change] on the right of the
“E-mail Address”.

The E-mail address entry dialog
box appears.

IIII Enter the E-mail address.

Note
❒ You can use the E-mail address

as the Sender's address. In this
case, you can set a password in
order to prevent the use of other
people.

❒ E-mail address can be set in
"name" or "name@domain"
form. You can enter up to 128
characters for one address. En-
ter more than one character
from the followings:
• Numerals
• Alphabets (uppercase and

lowercase)
• Symbols (! # $ % & ' * + - / =

? ^ _ ` { | } ~)
• periods

You cannot enter periods continu-
ously, or as the first or the last
character.

Reference
⇒ p.108 “Entering Text”

Using as a sender

A Press [ON] on the right of “Reg-
ister as Sender”.

Setting a password

A Press [ON] on the right of
“Sender's Password”.

B Press [Change] on the right of
the “Enter Password”.

C Enter the password using the
number keys and then press
[#].
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JJJJ Press [OK].

Note
❒ When a group is registered, oth-

er E-mail destinations can be
added to the group. (⇒ p.105
“Registering the E-mail Desti-
nations to a Group”)

Changing a Registered E-mail 
Destination

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [System Settings].

CCCC Press [Key Operator Tools].

DDDD Press [Address Book Management].

The registered user list appears.

EEEE Select the user of the registered E-
mail address you want to change.
Press the user key you want to
change, or enter the registered
number using the number keys.

FFFF Press [E-mail Address].

GGGG Enter the items.

To change the E-mail address

A Press [Change] on the right of
the E-mail address.

B Enter the E-mail address, and
then press [OK].

Reference
⇒ p.108 “Entering Text”

To change the password

A Press [Change] on the right of
the password.

B Enter the new password us-
ing the number keys and
then press [#].

HHHH Press [OK].

Note
❒ To change the user name, refer

to ⇒ p.106 “Deleting a Group”.
❒ To clear the user name, refer to

⇒ p.106 “Deleting a Group”

ZGJS002N
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Clearing a Registered E-mail 
Address

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [System Settings].

CCCC Press [Key Operator Tools].

DDDD Press [Address Book Management].

To clear only the E-mail address

A Select the user of the E-mail
address you want to clear.

Press the user key you want to
clear or enter the registered
number using the number keys.

B Press [E-mail Address].

C Press [Change] on the right of
the “E-mail Address”.

D Press [Delete All], and then press
[OK].

To clear all user information

A Press [Delete].
B Select the user you want to

clear.

Press the user key you want to
clear or enter the registered
number using the number keys.

C Press [Yes].

EEEE Press [Exit].

ZGJS002N
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Registering E-mail Destinations to a Group

Registered groups can be used as fol-
lowings:
• To easily control registered E-mail

destinations for each group.
• To send the same messages to mul-

tiple addresses in a group.
To divide E-mail destinations into
groups, the groups must be registered
beforehand.

Reference
E-mail destinations can also be
registered into groups using
SmartNetMonitor for  Admin
(printer option required). ⇒Net-
work Printing Guide

Registering a New Group

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [System Settings].

CCCC Press [Key Operator Tools].

DDDD Press [Address Book: Program/Change
/Delete Group].

EEEE Press [New Program].

FFFF Press [Change] on the right of the
Group Name.

GGGG Enter the group name, and press
[OK].

HHHH When you want to change the key
name, press [Change] on the right
of the key name. Enter the key
name and then press [OK].
The Key Display name is automat-
ically set.

IIII Press the keys of “Select Title” to
classify the group. Go to step JJJJ if
you do not need to classify.

JJJJ Press [OK].

ZGJS002N
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Registering the E-mail 
Destinations to a Group

Note
❒ When registering new E-mail des-

tinations, you can also register
groups at the same time.

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [System Settings].

CCCC Press [Key Operator Tools].

DDDD Press [Address Book Management].

EEEE Press the user (destination) key
which you want to register in a
group.

FFFF Press [Group].

GGGG Select a group to which you want
to register the E-mail destina-
tions.

HHHH Press [OK].

Deleting an E-mail Destination 
from a Group

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [System Settings].

CCCC Press [Key Operator Tools].

DDDD Press [Address Book Management].

EEEE Select the user (destination) to de-
lete from a group.

Press the user (destination) key
which you want to delete or enter
the registered number using the
number keys.

FFFF Press [Group].

GGGG Press the highlighted group key.

The user is deleted.

HHHH Press [OK].

ZGJS002N
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Displaying the E-mail 
Destinations

You can confirm the user (destina-
tion) of each group.

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [System Settings].

CCCC Press [Key Operator Tools].

DDDD Press [Address Book: Program/Change
/Delete Group].

EEEE Select a group where the data you
want to confirm is registered.

FFFF Press [Programed Users].

All the user names (E-mail destina-
tions) are displayed.

Press [OK].

Deleting a Group

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [System Settings].

CCCC Press [Key Operator Tools].

DDDD Press [Address Book: Program/Change
/Delete Group].

EEEE Press [Delete].

FFFF Press the group key you want to
delete.

GGGG Press [Yes].

ZGJS002N
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Changing a Group Name

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [System Settings].

CCCC Press [Key Operator Tools].

DDDD Press [Address Book: Program/Change
/Delete Group].

EEEE Press the group key you want to
change.

FFFF Press [Change] on the right of the
group name.

GGGG Enter the new group name, and
then press [OK].

HHHH Press [OK].

The group name is changed.

ZGJS002N
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Entering Text

This section describes how to enter characters. When you enter a character, it is
shown at the position of the cursor. If there is a character at the cursor position,
the entered character is shown before that character.

Available Characters

• Alphabetic characters
ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz

• Symbols
• Numerals

0123456789

Keys

Note
❒ When entering uppercase or lowercase letters continuously, use [Shift Lock] to

lock the case.

ZGJS838N
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How to Enter Text

Entering letters

AAAA Press [Shift] to switch between uppercase and lowercase.

BBBB Press the letters you want to enter.

Deleting characters

AAAA Press [Backspace] or [Delete All] to delete characters.
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6. Troubleshooting

If Your Machine Does Not Operate as You 
Want

General

Machine Status Problem/Cause Action

Please wait. This message appears 
when you turn on the oper-
ation switch or change the 
toner bottle.

Wait for the machine to get ready.

The display panel is off. The screen contrast knob is 
turned to the dark position.

Set the screen contrast knob to the 
light position for proper viewing of 
the display panel.

The machine is in Panel Off 
mode or Energy Saver 
mode.

Press the {{{{Energy Saver}}}} key to can-
cel Energy Saver mode.

The operation switch is 
turned off.

Turn on the operation switch.

Nothing happens when the 
operation switch is turned 
on.

The main power switch is 
turned off.

Turn on the main power switch.

Memory is full. The number of scanned 
pages, the number of files, 
or capacity of the hard disk 
has exceeded.

Press [Delete File] to delete unneces-
sary documents.

The function status indica-
tor is red.

The function associated 
with the red indicator has 
been interrupted.

Press the function key correspond-
ing to the indicator. Follow the in-
structions displayed in the 
operation panel.

The user code entry dialog 
box is displayed.

Users are restricted by user 
management.

Enter the user code (up to 8 digits), 
and press [#].

“Self checking.”, “Color is 
being adjusted.” appears.

The machine is preforming 
image adjustment opera-
tions.

The machine may perform periodic 
maintenance during operations. The 
frequency and duration of mainte-
nance depends on the humidity, 
temperature, and printing factors 
such as number of prints, paper 
size, and paper type. Wait for the 
machine to get ready.
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Machine Status Problem/Cause Action

The main power indicator 
continues blinking and 
does not turn off when 
pressed.

This occurs in the follow-
ing cases:

• The exposure glass cov-
er or document feeder 
(ADF) is open.

• The machine is in com-
munication with exter-
nal equipment.

• The hard disk is in op-
eration.

Wait till the blinking stops, and then 
turn off the operation switch.

The original images are 
printed on the reverse side 
of the paper.

You may have loaded the 
paper incorrectly.

Load paper into trays 1, 2, 3, and 4, 
and the large capacity tray with the 
print side up, or into a bypass tray 
with the print side down. ⇒ p.115 
“B Loading Paper”

Misfeeds occur frequently. The tray's side guides may 
not be locked.

Check that the side guides are 
locked. ⇒ p.126 “Changing the Pa-
per Size”

The tray's end guide may 
not be locked.

Check that the end guide is locked. 
⇒ p.126 “Changing the Paper Size”

You may have loaded pa-
per whose size cannot be 
detected automatically.

When you use paper of a size that 
cannot be detected automatically, 
set the paper size. ⇒ p.76 “Tray Pa-
per Size:  (Tray 1–4)” ⇒ p.159 “Copy 
Paper”

An error message remains, 
even if misfed paper is re-
moved.

When a misfeed message 
appears, it remains until 
you open and close the cov-
er, as required.

Clear misfed paper and open and 
close the front cover. ⇒ p.120 “x 
Clearing Misfeeds”

Cannot print in duplex 
mode.

You cannot use the paper 
in the bypass tray for du-
plex printing.

For duplex printing, select Tray 1 - 4 
in Copier mode or with the printer 
driver.

If you select thick paper, 
thick dup. back paper, 
OHP or label paper as the 
paper type, duplex print-
ing is disabled.

Select another paper type. ⇒ p.76 
“Tray Paper Size:  (Tray 1–4)”

The setting for the Paper 
Type: Tray 1-4 is "1 Side 
copy".

Select "2 Sided copy" for Paper 
Type:Tray 1-4 ⇒ p.77 “Paper 
Type:Tray1–4”
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Printing Problems

Problem Action

Colors are missing in some parts. Perform [Clean / Adjust] in the Maintenance 
menu.

See ⇒ p.143 “Cleaning and Adjusting Internal 
Parts”.

White lines appear. Clean the dustproof glass.

See ⇒ p.143 “Cleaning the Dustproof Glass”.

Perform [Clean / Adjust] in the Maintenance 
menu.

See ⇒ p.143 “Cleaning and Adjusting Internal 
Parts”.

Color lines appear. Perform [Clean / Adjust] in the Maintenance 
menu.

See ⇒ p.143 “Cleaning and Adjusting Internal 
Parts”.
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Document Server

Problem Action

"Scanned pages exceeded max. number. Do 
you want to store the scanned pages as a file?" 
appears.

The number of scanned pages exceeds the ca-
pacity per file of the Document Server.

If you want to store scanned originals as a file, 
press [Store File]. The originals are stored as a 
file in the Document Server. If you don't want 
any scanned originals to be stored, press [No]. 
The scanning data will be cleared.

You forgot your password. You can confirm your password.

Press [ON] temporarily for "Display Password 
with Stored File" in the User Tools. You can 
check the password when you have selected 
the file. ⇒ p.93 “Display Password with 
Stored File”

You can delete all the saved documents at 
once with the User Tools. ⇒ p.93 “Delete All 
Files”

Make sure that no important documents are 
saved in the Document Server before deleting 
all saved documents.

You cannot find out what is saved in a file. Check the date or time column in the "Docu-
ment Server: Files" display.

Check the contents of the document by print-
ing the first page of it. Press the line for the de-
sired document in the "Document Server: 
Files" display, and press [Print 1st Page] fol-
lowed by the {{{{Start}}}} key.

Memory becomes full frequently. Press [Delete File] to delete selected documents, 
thereby increasing available memory.

You want to check print quality before making 
a large print run.

Check print quality by printing out only the 
first set using the {{{{Sample Copy}}}} key.

You want to save documents so they will not 
be deleted automatically.

Turn "Auto Delete File" off, and then save the 
documents in the Document Server. ⇒ p.93 
“Auto Delete File”

If you turn on “Auto Delete File” after, the 
function is only applied to subsequent docu-
ments.

"Cannot copy. Original is being scanned by 
other functions." appears.

The Copy function is in use. To cancel the job 
in process, first press [Exit]. and then press the 
{{{{Copy}}}} key. Next press the {{{{Clear/Stop}}}} key. 
When the message "[Stop] was pressed. Stop 
printing?" appears, press [Stop].
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BBBB Loading Paper

Reference
Regarding Paper types and sizes,
⇒ p.159 “Copy Paper”

Loading Paper in Tray 1 and 2

Note
❒ You can change the paper size ⇒

p.126 “Changing the Paper Size”

AAAA Pull out the paper tray slowly un-
til it stops.

BBBB Lower the base panel by pushing
“Push”. When paper is set in the
tray, push down on the paper.

CCCC Load paper into the tray with the
print side up.

Important
❒ Confirm that the top of the stack

is not higher than the limit mark
inside the tray.

DDDD Slide the paper tray into the print-
er carefully until it stops.

Loading Paper in Tray 3 and 4 
(option)

AAAA Pull out the paper tray slowly un-
til it stops.

ZGJS120E

ZGJS130E

ZGJS140E

ZGJS150E

UranosC1-ENzen_F2_FM.book  Page 115  Friday, August 2, 2002  1:32 PM



Troubleshooting

116

6

BBBB Load paper into the tray with the
print side up.

Important
❒ Check that the top of the stack is

not higher than the limit mark
inside the tray.

CCCC Slide the paper tray into the print-
er carefully until it stops.

Loading Paper in the Large 
Capacity Tray (option)

Note
❒ Load copy paper of the same size

and direction in both left and right
side trays.

AAAA Pull out the large capacity tray.

BBBB Align the paper and load it in the
tray with the print side up.

Important
❒ Align the right edge of the right

copy paper stack to the right
edge of the tray.

❒ Align the left edge of the left
copy paper stack to the left edge
of the tray.

❒ Do not stack paper over the lim-
it mark.

Note
❒ Shuffle the paper before loading

it in the tray.
❒ Straighten curled or warped pa-

per before placing it in the tray.

CCCC Push the paper tray in until it
stops.

ZGJS230E

ZGJS170E

ZGJS180E
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DDDD Adding Toner

When D is displayed, it is time to add toner.

R WARNING:

R CAUTION:

Important
❒ If you use toner other than that recommended, an error might occur.
❒ When adding toner, do not turn off the operation switch.
❒ Always add toner after the machine instructs you.
❒ Do not install and remove the toner cartridges over and over. This could re-

sult in a toner leak.
❒ Do not shake the removed toner cartridge. The remaining toner might scatter.

Note
❒ You can still make about 50 copies after the messages “D Toner is almost

empty.”, “Replace Toner Cartridge(s).”, and “Black, Yellow, Magenta, Cyan”
appear cyclically, but replace toner early to prevent poor copy quality.

❒ Change all four color-toner cartridges in the same way.
❒ If “Toner Cartridge is not set properly.” appears, slide the toner cartridge

back and forth twice, and push it until it stops.
❒ The consumption of toner depends on the humidity, temperature and print-

ing factors such as image size, density, number of prints, paper size, and pa-
per type. Moreover, to preserve print quality, this machine automatically
performs periodic maintenance using the toner.

Reference
Regarding toner storage, ⇒ p.139 “Toner Storage”.

• Do not incinerate used toner or toner containers. Toner dust might ig-
nite when exposed to an open flame. Dispose of used toner containers 
in accordance with local regulations.

• Keep toner (used or unused) and toner containers out of reach of children.
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Removing Toner

• 1: Open the front cover of the machine.

• 2: Pull the lever and open the green cover.

• 3: Gently pull out the toner cartridge.

ZGJS791E
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Inserting Toner

• 1: Hold a new cartridge and shake it 10∼12 
times.

Note
❒ Do not touch the “metal contact point” 

of the cartridge, or it may be damaged.

• 2: Insert the cartridge horizontally, and 
gently push it in completely.

• 3: Close the green cover.

• 4: Close the front cover of the machine.

ZGJS792E

ZGJS792E-02

ZGJS792E-03
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xxxx Clearing Misfeeds

R CAUTION:

Important
❒ When clearing misfeeds, do not turn off the operation switch. If you do, your

copy settings are lost.
❒ To prevent misfeeds, do not leave any torn scraps of paper inside the ma-

chine.
❒ If paper misfeeds occur repeatedly, contact your service representative.

Note
❒ More than one misfeed area may be indicated. In such cases, check every ap-

plicable area. See the following charts: A, B, C, D, P, R, Y, Z
❒ You can find a sticker explaining how to remove misfed paper inside the front

cover or inside the finisher.

Checking paper jams around the heating roller

Generally, the orange heating roller should be visible when you open the right
side cover. Check it once in a while, and if you find any misfed paper, call your
service representative.

• The fusing section of this machine might be very hot. Caution should be tak-
en when removing misfed paper.

• 1: Open the Duplex unit.

• 2: Open the right cover.

• 3: See if there is any misfed paper inside.
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Changing the Paper Size

Preparation
Be sure to select the paper size
with the user tools. Otherwise,
misfeeds might occur. ⇒  p.76
“Tray Paper Size:  (Tray 1–4)”

Important
❒ If you wish to change the paper

size set in the optional large capac-
ity tray (LCT), contact your service
representative.

❒ The procedures for changing the
paper size are different depending
on the tray (paper tray 1, paper
tray 2 or the optional paper tray
units). Check that you are follow-
ing the appropriate procedure be-
fore you start.

Reference
For paper sizes, and types ⇒ p.159
“Copy Paper”.

Changing the Paper Size of 
Tray 1 and 2

AAAA Pull out the paper tray slowly un-
til it stops.

BBBB Lower the base panel by pushing
"Push". When paper is set in the
tray, push down on the paper.

CCCC When paper is set in the tray, re-
move them.

DDDD Set the paper guide lock to the
"unlocked" position.

EEEE Pushing the green lever of the
side guide (AAAA), move the side
guide toward you to open it (BBBB).

ZGJS120E

ZGJS130E

ZGJS210E
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FFFF Pinching both sides of the end
guide (AAAA), move the end guide in
the direction of the arrow (BBBB) to
open it.

GGGG Load paper into the tray with the
print side up.

Important
❒ Confirm that the top of the stack

is not higher than the limit mark
inside the tray.

HHHH Pushing the green lever of the
side guide (AAAA), move the side
guide toward the paper stack un-
til it stops (BBBB).

IIII Confirm that the paper is fixed in
place, and then lock the side
guides.

JJJJ Pinching both sides of the end
guide (AAAA), move the end guide to-
ward the paper stack until it stops
(BBBB).

KKKK Slide the paper tray into the print-
er carefully until it stops.

ZGJS290E

ZGJS140E

ZGJS310E

ZGJS320E

ZGJS330E
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Changing the Paper Size of 
Tray 3 and 4 (option)

AAAA Pull out the paper tray slowly un-
til it stops.

BBBB When paper is set in the tray, re-
move them.

CCCC Set the paper guide lock to the
"unlocked" position.

DDDD Pushing the green lever of the
side guide (AAAA), move the side
guide toward you to open it (BBBB).

EEEE Pinching both sides of the end
guide (AAAA), move the end guide in
the direction of the arrow (BBBB) to
open it.

FFFF Load paper into the tray with the
print side up.

Important
❒ Confirm that the top of the stack

is not higher than the limit mark
inside the tray.

ZGJS150E

ZGJS200E

ZGJS211E

ZGJS220E

ZGJS230E
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GGGG Pushing the green lever of the
side guide (AAAA), move the side
guide toward the paper stack un-
til it stops (BBBB).

HHHH Confirm that the paper is fixed in
place, and then lock the side
guides.

IIII Pinching both sides of the end
guide (AAAA), move the end guide to-
ward the paper stack until it stops
(BBBB).

JJJJ Slide the paper tray into the print-
er carefully until it stops.

Specifying Custom Paper Size

To use paper of a custom size, follow
the procedure below to specify the
custom paper size.

AAAA Press the {{{{User Tools / Counter}}}} key.

BBBB Press [System Settings].

CCCC Press [Tray Paper Settings].

DDDD Select the tray to customize the
paper size.

EEEE Press [Custom Size] on the "Tray
Paper Size" display.

ZGGH240E

ZGJS479E

ZGJS250E

ZGJS002N

UranosC1-ENzen_F2_FM.book  Page 129  Friday, August 2, 2002  1:32 PM



Troubleshooting

130

6

FFFF Press [Vertical] or [Horizontal] to
specify the vertical or horizontal
size respectively. Then enter the
size with the number keys, and
then press [#].

Note
❒ To correct the entered value,

press [Clear], and then enter the
correct value.

GGGG Press [OK].

HHHH Press [EXIT].

IIII Press the {{{{User Tools / Counter}}}} key.
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dddd Adding Staples

Important
❒ If you use a staple cartridge other than that recommended, staple failure or

staple jams might occur.

Reference
For the type of finisher, refer to “External Options” ⇒ p.23

500-Sheet Finisher

• 1: Open the side cover.

• 2: Remove the cartridge.

• 3: Take out the empty refill in the direction 
of the arrow.

• 4: Push in the new refill until it clicks.
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1000-Sheet Finisher

• 5: Pull out the ribbon.

• 6: Reinstall the cartridge.

• 7: Close the side cover.

• 1: Open the front cover of the finisher and 
pull out the staple unit.

• 2: Hold the green lever and pull out the 
cartridge gently.

• 3: Hold both sides of the cartridge.

• 4: Pull up the upper unit of the cartridge.
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• 5: Take out the empty refill in the direction 
of the arrow.

• 6: Align the arrows on the new refill and 
the cartridge, and then push in the refill 
until it clicks.

• 7: Push down the upper unit into the car-
tridge gently.

• 8: Pull out the ribbon.

• 9: Hold the green lever and reinstall the 
cartridge until it clicks.

• 10: Push back the staple unit and close the 
front cover of the finisher.
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eeee Removing Jammed Staples

Note
❒ Staples might jam because of curled copy paper. In such a case, try turning

the copy paper over in the tray. If there is no improvement, change to a copy
paper with less curl.

❒ When the 500-Sheet Finisher is installed, after removing jammed staples, sta-
ples might not be ejected the first few times you try to use the stapler.

Reference
For the type of finisher, refer to “External Options” ⇒ p.23

500-Sheet Finisher

• 1: Open the side cover.

• 2: Remove the cartridge.

• 3: Open the face plate.

• 4: Remove jammed staples.
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1000-Sheet Finisher

• 5: Reinstall the cartridge.

• 6: Close the side cover.

• 1: Open the front cover of the finisher and 
pull out the staple unit.

• 2: Hold the green lever and pull out the 
cartridge gently.

• 3: Open the face plate of the cartridge.

• 4: Remove jammed staples.
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• 5: Pull down the face plate of the cartridge 
until it clicks.

• 6: Hold the green lever and reinstall the 
cartridge until it clicks.

• 7: Push back the staple unit and close the 
front cover of the finisher.
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Do's And Don'ts

R CAUTION:

Important
❒ If you want to unplug the power

cord or turn off the main power
switch, make sure that the remain-
ing memory space indicates 100%
on the display for facsimile mode.

❒ While the machine is unplugged,
you can neither send nor receive a
fax.

Reference
For details, see the Facsimile Refer-
ence.

• When you use this machine for a
long time in a confined space with-
out good ventilation, you may de-
tect an odd smell. To keep the
workplace comfortable, we recom-
mend that you keep it well venti-
lated.

• Do not touch areas on or around
the fusing unit. These areas get hot.

• After making copies continuously,
the exposure glass may become
warm—this is not a malfunction.

• The area around the ventilation
hole might feel warm. This is
caused by exhaust air and is not a
malfunction.

• Do not turn off the operation
switch while copying or printing.
Make sure that all copying or
printing has finished.

• The machine might fail to produce
good copy images if condensation
forms inside due to rapid tempera-
ture change.

• Do not open the covers of the ma-
chine while copying or printing. If
you do, misfeeds might occur.

• Do not move the machine while
copying or printing.

• If you operate the machine im-
properly or a failure occurs with
the machine, your machine set-
tings might be lost. Be sure to make
a note of your machine settings.

• The supplier shall not be liable for
any loss or damage resulting from
a failure with the machine, loss of
machine settings, or use of the ma-
chine.

• Unplug the power cord from the 
wall outlet before you move the 
machine. While moving the ma-
chine, you should take care that 
the power cord will not be dam-
aged under the machine.
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Saving Color Copies

• There is no difference between color prints and color copies in terms of fad-
ing. However, for long-term storage, make sure to store them in a binder
away from direct sunlight. 

• Toner may melt if a print and a half-dried print are put on top of each other.
• Toner may also melt when using solvent type adhesive agents for pasting

prints.
• When folding prints, toner in the folds will come off.
• Toner may melt if it is placed on mats made of chlorinated plastic in locations

of high temperature for long periods of time.
• Toner may melt if prints are placed in places of extremely high temperatures,

such as near heaters.
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Toner

Handling Toner

R WARNING:

R CAUTION:

Important
❒ If you use toner other than the recommended type, a fault might occur.

Reference
If you want to add toner. ⇒ p.117 “D Adding Toner”

Toner Storage

When storing toner, the following precautions should always be followed:
• Store toner containers in a cool, dry place free from direct sunlight.
• Store on a flat surface.

Used Toner

Note
❒ Toner cannot be re-used.

• Do not incinerate used toner or toner containers. Toner dust might ig-
nite when exposed to an open flame. Dispose of used toner containers 
in accordance with local regulations.

• Keep toner (used or unused) and toner containers out of reach of children.
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Where to Put Your Machine

Machine Environment

Your machine's location should be
carefully chosen because environ-
mental conditions greatly affect its
performance.

Optimum environmental conditions

R CAUTION:

R CAUTION:

• Temperature: 10 – 32°C (50 –
89.6°F)(humidity to be 54% at
32°C, 89.6°F)

• Humidity: 15 – 80% (temperature
to be 27°C, 80.6°F at 80%)

• A strong and level base.
• The machine must be level within

5mm, 0.2" both front to rear and
left to right.

• To avoid possible buildup of
ozone, be sure to locate this ma-
chine in a large well ventilated
room that has an air turnover of
more than 30 m3/hr/person.

Environments to avoid

• Locations exposed to direct sun-
light or strong light (more than
1,500 lux).

• Locations directly exposed to cool
air from an air conditioner or heat-
ed air from a heater. (Sudden tem-
perature changes might cause
condensation within the machine.)

• Locations close to machines gener-
ating ammonia such as a diazo
copy machine.

• Places where the machine might be
subjected to frequent strong vibra-
tion.

• Dusty areas.
• Areas with corrosive gases.

Moving

R CAUTION:

Important
❒ If you move the machine, you

must be careful. Keep the follow-
ing in mind:
• Turn off the main power
• Unplug the power cord from

the wall. When you pull out the
plug from the socket, grip the
plug to avoid damaging the
cord and causing fire or electric
shock.

• Keep the machine away from hu-
midity and dust. Otherwise a fire 
or an electric shock might occur.

• Do not place the machine on an 
unstable or tilted surface. If it top-
ples over, an injury might occur.

• If you use the machine in a con-
fined space, make sure there is a 
continuous air turnover.

• Unplug the power cord from the 
wall outlet before you move the 
machine. While moving the ma-
chine, you should take care that 
the power cord will not be dam-
aged under the machine.
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• Close all covers and trays in-
cluding the front cover and by-
pass tray.

Limitation
❒ Carefully move the machine. If

you do not, the machine might be
damaged or a stored file might be
deleted.

❒ Do not take off the holding stand.
❒ Protect the machine from strong

shock. This could damage the hard
disk and cause stored files to be de-
leted. As a precautionary measure,
files should be copied to another
computer.

Power Connection

R WARNING:

R CAUTION:

R CAUTION:

• When the main switch is in the
Stand-by position, the optional
anti-condensation heaters are on.
In case of emergency, unplug the
machine's power cord.

• When you unplug the power cord,
the anti-condensation heaters turn
off.

• Make sure that the plug is firmly
inserted in the outlet.

• Voltage must not fluctuate more
than 10%.

• The socket-outlet should be in-
stalled near the equipment and
should be easily accessible.

Access to the Machine

Place the machine near the power
source,  providing c learance as
shown.

1. Rear *1 : more than 10 cm (4")

2. Right: more than 55 cm (22")

3. Front: more than 75 cm (29.6")

4. Left: more than 10 cm (4")
*1 The space required at the rear is from

the outside of the ventilation holes to
the wall.

Note
❒ For the required space when op-

tions are installed, contact your
service representative.

• Connect the machine only to 
the power source described on 
the inside front cover of this 
manual. Connect the power 
cord directly into a wall outlet 
and do not use an extension 
cord.

• Do not damage, break or make 
any modifications to the power 
cord. Do not place heavy ob-
jects on it. Do not pull it hard 
nor bend it more than neces-
sary. These actions could 
cause an electric shock or fire.

• Unplug the power cord from the 
wall outlet before you move the 
machine. While moving the ma-
chine, you should take care that 
the power cord will not be dam-
aged under the machine.

• When you disconnect the power 
plug from the wall outlet, always 
pull the plug (not the cable).

1

2

3

4
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Maintenance

If the machine is dirty, you might not
be able to make clean copies and
prints. Clean the following parts
when you find them dirty.

❖❖❖❖ Cleaning the machine
Wipe the machine with a soft,
damp cloth. Then, wipe it with a
dry cloth to remove the water.

Important
❒ Do not use chemical cleaner or or-

ganic solvents, such as thinner or
benzene. If they get into the ma-
chine or melt plastic parts, a failure
might occur.

❒ Do not clean parts other than those
specified in this manual. Other
parts should be cleaned by your
service representative.

Cleaning the Exposure Glass

Clean 1 and 2.

Cleaning the Exposure Glass 
Cover

Cleaning the Document 
Feeder

Clean 1 and 2.ZGGH420E

ZGJS826E
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Cleaning and Adjusting 
Internal Parts

Perform the following procedure
when missing colors and lines appear
on copies and prints.

AAAA Press the {{{{User Tools/Counter}}}} key
and then [Maintenance].

BBBB Press [Clean / Adjust].

CCCC Press [Yes].

Note
❒ Cleaning may take a while.
❒ Do not open the cover or turn

off the power while the follow-
ing display is shown and the
machine is cleaning.

DDDD The display will return to [Mainte-
nance] automatically when clean-
ing is finished. Press the {{{{User
Tools/Counter}}}} key and exit User
Tools.

Cleaning the Dustproof Glass

The dustproof glass may require
cleaning if white lines appear on cop-
ies and prints.

AAAA Turn off the main power switch.

BBBB Open the front cover of the ma-
chine.

CCCC Slide the cleaning brush with the
blue handle in and out, slowly 8
to 10 times.

Important
❒ Do not insert the brush roughly,

or you might damage the ma-
chine.

DDDD Return the cleaning brush to its
original position.

EEEE Close the front cover of the ma-
chine.

FFFF Turn on the main power switch.
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Other Functions

Inquiry

The inquiry function lets you confirm
the telephone numbers to contact for
repairs or to order toner. Be sure to
contact your service engineer to veri-
fy the following:

❖❖❖❖ Consumables
• Telephone No. for ordering
• Toner

❖❖❖❖ Diagnostics
• Telephone No. for ordering
• Machine No.

❖❖❖❖ Service office
• Telephone No.

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [Inquiry].

Inquiry information is displayed.

Printing inquiry information

A Press [Print Inquiry List].

B Press the {{{{Start}}}} key.

Inquiry information is printed.

CCCC Press [Exit].

DDDD Press [Exit].

Changing the Display 
Language

You can change the language used on
the display. English is set as default.

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [Español].

The display language is changed to
Español.

ZGJS002N

ZGJS002N
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CCCC Press [Exit].

The menu appears in Español.

Changing Paper Thickness 
Settings

Select [Normal] or [Middle Thick/24-28lb]
for plain paper type, depending on
the thickness of the paper to be set.

Note
❒ Settings will be saved even when

the {{{{Clear Modes}}}} key is pressed or
the power is turned off.

❒ All trays are set to [Normal] as de-
fault.

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [Maintenance].

CCCC Press [Plain Paper Type].

DDDD Select the plain paper type for
each tray depending on the paper
to be set and press [OK].

Note
❒ When printing on paper more

than 90 g/m2 (24lb.), select [Mid-
dle Thick/24-28lb].

EEEE Press [OK].

FFFF Press [Exit].

ZGJS002N
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Counter

Displaying the Total Counter

You can display the total counter val-
ue used for all functions.

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [Counter].

CCCC To print a counter list, press [Print
Counter List].

DDDD Press the {{{{Start}}}} key.

A counter list is printed.
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8. Specification

Mainframe

❖❖❖❖ Configuration:
Desktop

❖❖❖❖ Photosensitivity type:
OPC belt

❖❖❖❖ Original scanning:
One-dimensional solid scanning system through CCD

❖❖❖❖ Copy process:
2 laser beam & dry electrostatic transfer system

❖❖❖❖ Development:
Mono component system

❖❖❖❖ Fusing:
Belt fusing system

❖❖❖❖ Resolution:
600 dpi

❖❖❖❖ Exposure glass:
Stationary original exposure type

❖❖❖❖ Original reference position:
Rear left corner

❖❖❖❖ Warm-up time:
• Main power switch: Less than 99 seconds (23°C, 73°F)
• Operation switch: Less than 99 seconds (23°C, 73°F)

❖❖❖❖ Originals:
Sheet/book/objects

❖❖❖❖ Maximum original size:
A3L, 11" × 17"L

❖❖❖❖ Copy paper size:
• Tray 1, 2: A3L – A6L, 11" × 17"L – 51/2" × 81/2"KL

• Bypass: A3L – A6L, 12" × 18"L – 51/2" × 81/2"KL

• Tray 1, 2 (custom size):
Vertical: 100 – 297mm, 3.94" – 11.69"
Horizontal: 148 – 432mm, 5.83" – 17.00"
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• Bypass (custom size):
Vertical: 90 – 305mm, 3.55" – 12.00"
Horizontal: 148 – 457.2mm, 5.83" – 18.00"

• Duplex: A3L – A5KL, 11" × 17"L – 51/2" × 81/2"L (impossible on 51/2"
× 81/2" K)

• LCT: A4K, 81/2" × 11"K

❖❖❖❖ Copy paper weight:
• Tray 1, 2: 64 – 163g/m2, 17 – 43.6 lb.
• Bypass tray: 64 – 163g/m2, 17 – 43.6 lb.
• Duplex: 64 – 105g/m2, 17 – 28 lb.

❖❖❖❖ Non-reproduction area:
• Leading edge: Less than 4 ± 2mm
• Trailing edge: Less than 2 ± 2mm/1.5mm
• Left edge: Less than 2 ± 2mm
• Right edge: Less than 2 ± 2mm

❖❖❖❖ First copy time:

(A4K, 81/2" × 11K" , when setting an original on the exposure glass and full
size copying fed from Tray 1.)
*1 When you use the bypass tray, it takes a few more seconds.

❖❖❖❖ Full Color (4 colors)

(When copying continuously in full size.)

Standard mode OHP/Thick mode *1 Auto Color Select 
mode *1 

Full Color (4 colors) 18 seconds or less 25 seconds or less 20 seconds or less

Black, Yellow,

Magenta, Cyan

7.8 seconds or less 16 seconds or less 9.5 seconds or less

Standard mode Thick mode OHP mode

A4K Type 1 8 copies/minute 4 copies/minute 2 copies/minute

Type 2 10 copies/minute

A3L Type 1 4 copies/minute 2 copies/minute 1 copies/minute

Type 2 5 copies/minute
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❖❖❖❖ Black, Yellow, Magenta, Cyan

(When copying continuously in full size.)

❖❖❖❖ Reproduction ratio:
Preset reproduction ratios:

Zoom: From 25 to 400% in 1% steps.

❖❖❖❖ Maximum continuous copy run:
100 sheets

❖❖❖❖ Copy paper capacity:
• Tray 1, 2: 250 sheets (80g/m2, 20 lb.)
• Bypass tray: 100 sheets (80g/m2, 20 lb.)

Standard mode Thick mode OHP mode

A4K Type 1 24 copies/minute 6.5 copies/minute 3.2 copies/minute

Type 2 32 copies/minute

A3L Type 1 12 copies/minute 3.2 copies/minute 1.6 copies/minute

Type 2 16 copies/minute

Metric version Inch version

Enlargement 400% 400%

200% 200%

141% 155%

122% 129%

115% 121%

Full Size 100% 100%

Reduction 93% 93%

82% 85%

75% 78%

71% 73%

61% 65%

50% 50%

25% 25%
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❖❖❖❖ Power consumption:
• Mainframe only

• Complete system *1 

*1 The Complete System consists of the mainframe, document feeder, 1000-sheet
finisher, duplex unit, internal tray 2, paper tray unit, fax unit, ISDN, extra G3
interface unit, expansion memory, JBIG function upgrade unit, printer unit,
and memory unit.

❖❖❖❖ Dimensions (W ×××× D ×××× H up to exposure glass):
Type 1, 2: 550 × 670 × 781mm, 21.7" × 26.4" × 30.8"

❖❖❖❖ Space for mainframe (W ×××× D):
Type 1, 2: 550 × 670mm, 21.7" × 26.4"

❖❖❖❖ Noise Emission *1 :
Sound Power Level: 
• Mainframe only

• Complete system *2 

*1 The above measurements made in accordance with ISO 7779 are actual value.
*2 The Complete System consists of the mainframe, document feeder, 1000-sheet

finisher, duplex unit, internal tray 2 and paper tray unit.

❖❖❖❖ Weight:
Type 1, 2: Approx. 85 kg, 188 lb.

Type 1/Type 2

Warm-up less than 1.5 kW

Stand-by less than 200 W

During copying less than 1.0 kW

Maximum less than 1.5 kW

Type 1/Type 2

Warm-up less than 1.5 kW

Stand-by less than 200 W

During copying less than 1.1 kW

Maximum less than 1.5 kW

Type 1/Type 2

Stand-by Less than 45 dB (A)

Copying Less than 67 dB (A)

Type 1/Type 2

Stand-by Less than 50 dB (A)

Copying Less than 70 dB (A)
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❖❖❖❖ HDD:
about 40 GB
• Capacity for Document Server

about 15 GB
• Capacity for Memory sorting

7.5-15 GB
• Capacity for others

5 GB or more
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Options

Document Feeder

❖❖❖❖ Mode:
ADF mode, Batch mode, SADF mode, Mixed Size mode, Custom Size origi-
nals mode

❖❖❖❖ Original size:
• A3L – A5KL

• 11" × 17"L – 51/2" × 81/2"KL

• Vertical: 105 – 297mm, 4.2" – 11.6"
• Horizontal: 128 – 1,200mm, 5.1" – 47.0"

(128 – 432mm, 5.1" – 17.0" for Copier and Scanner functions)

❖❖❖❖ Original weight:
• 1-sided originals: 40 – 128g/m2 (11 – 34 lb.)
• 2-sided originals: 52 – 105g/m2 (14 – 28 lb.) (Duplex)

❖❖❖❖ Maximum number of originals:
50 sheets (80g/m2, 20 lb.) or less than 11mm, 0.43"

❖❖❖❖ Maximum power consumption:
Less than 50W (power is supplied from the mainframe)

❖❖❖❖ Dimensions (W××××D××××H):
550 × 470 × 130mm, 21.7" × 18.5" × 5.1"

❖❖❖❖ Weight:
Approx. 10 kg, 22.1 lb.

Note
❒ Specifications are subject to change without notice.

UranosC1-ENzen_F2_FM.book  Page 152  Friday, August 2, 2002  1:32 PM



Options

153

8

500-Sheet Finisher

❖❖❖❖ Paper size:
A3L, B4L, A4KL, B5KL, A5K, 11" × 17"L, 81/2" × 14"L, 81/2" ×
11"KL, 81/2" × 13"L, 81/2" × 51/2"K, 81/4" × 13"L, 8" × 13"L, 71/4" ×
101/2"KL, 8KL, 16KKL

❖❖❖❖ Paper weight:
64 – 128g/m2, 17 – 34 lb.

❖❖❖❖ Stack capacity:
• 500 sheets (A4KL, 81/2" × 11"KL or smaller) (80g/m2, 20 lb.)
• 250 sheets (B4L, 8" × 13"L or larger) (80g/m2, 20 lb.)

❖❖❖❖ Staple capacity:
• 30 sheets (80g/m2, 20 lb.)

❖❖❖❖ Staple paper size:
A3L, B4L, A4KL, B5K, 11" × 17"L, 81/2" × 14"L, 81/2" × 13"L, 81/2" ×
11"KL, 8KL, 16KK

❖❖❖❖ Staple paper weight:
64 – 128g/m2, 17 – 34 lb.

❖❖❖❖ Staple position:
1 position (upper left)

❖❖❖❖ Power consumption:
40W (power is supplied from the mainframe)

❖❖❖❖ Dimensions (W ×××× D ×××× H):
350 × 490 × 230mm, 13.8" × 19.3" × 9.1"

❖❖❖❖ Weight:
Approx. 10kg, 22.1 lb.
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1000-Sheet Finisher

Finisher Tray 1:

❖❖❖❖ Paper size:
A3L, B4L, A4KL, B5KL, A5KL, B6L, A6L, 12" × 18"L, 11" × 17"L,
81/2" × 14"L, 101/2" × 71/4"KL, 81/2" × 13"L, 81/2" × 11"KL, 8" × 13"L,
81/4" × 13"L, 51/2" × 81/2"KL, 8KL, 16KK

❖❖❖❖ Paper weight:
64 – 163g/m2, 17.0 – 43.6 lb.

❖❖❖❖ Stack capacity:
• 250 sheets (A4KL, 81/2" × 11"KL or smaller) (80g/m2, 20 lb.)
• 50 sheets (B4L, 8" × 13"L or larger) (80g/m2, 20 lb.)

Finisher Tray 2:

❖❖❖❖ Paper size:
A3L, B4L, A4KL, B5KL, A5KL, 12" × 18"KL, 11" × 17"L, 81/2" ×
14"L, 101/2" × 71/4"L, 8" × 13L, 81/4" × 13"L, 51/2" × 81/2" KL, 8KL,
16KKL

❖❖❖❖ Paper weight:
64 – 163g/m2, 17.0 – 43.6 lb.

❖❖❖❖ Stack capacity:
• 1,000 sheets (A4KL, 81/2" × 11"KL or smaller) (80g/m2, 20 lb.)
• 500 sheets (B4L, 8" × 13"L or larger) (80g/m2, 20 lb.)

❖❖❖❖ Staple capacity:
• 50 sheets (A4KL, 81/2" × 11"KL or smaller) (80g/m2, 20 lb.)
• 30 sheets (B4L, 8" × 13"L or larger) (80g/m2, 20 lb.)

❖❖❖❖ Staple paper size:
A3L, B4L, A4KL, B5KL, 12" × 18"L, 11" × 17"L, 81/2" × 14"L, 81/2" ×
11"KL, 101/2" × 71/4"KL, 8" × 13"L, 81/2" × 13"L, 81/4" × 13"L, 8KL,
16KKL

❖❖❖❖ Staple paper weight:
64 – 90g/m2, 17 – 24 lb.

❖❖❖❖ Staple position:
• 1 staple – 2 positions
• 2 staples – 2 positions
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❖❖❖❖ Power consumption:
Less than 50W (power is supplied from the mainframe)

❖❖❖❖ Dimensions (W ×××× D ×××× H):
527 × 520 × 790mm, 20.7" × 20.5" × 31.1"

❖❖❖❖ Weight:
Approx. 25kg, 55.2 lb.

Bridge Unit

❖❖❖❖ Paper Size:
• Internal tray: A3L – A6L, 12" × 18"L – 51/2" × 81/2"L
• 500-Sheet Finisher: A3L – A5K, 11" × 17"L – 51/2" × 81/2"L
• 1000-Sheet Finisher: A3L – A5KL, 12" × 18"L – 51/2" × 81/2"KL

❖❖❖❖ Paper weight:
64 – 163g/m2, 17.0 – 43.6 lb.

❖❖❖❖ Stack Capacity:
250 sheets

❖❖❖❖ Dimentions:
418 × 446 × 128mm, 16.47" × 17.57" × 50.40"

❖❖❖❖ Weight:
3.3kg, 7.29 lb.

Shift Sort Tray

❖❖❖❖ Paper capacity:
250 sheets (A4KL, 81/2" × 11"KL or smaller) (80g/m2, 20 lb.)
125 sheets (B4L, 8" × 13"L or larger) (80g/m2, 20 lb.)

❖❖❖❖ Power consumption:
3.6 W (power is supplied from the mainframe)

❖❖❖❖ Dimensions (W ×××× D ×××× H)
430 × 372 × 148 mm, 17" × 15" × 6"

❖❖❖❖ Weight:
Approx. 1.6kg, 3.5 lb.
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Duplex Unit

❖❖❖❖ Paper size:
A3L, B4L, A4KL, B5KL, A5KL, 5 1/2" × 8 1/2"L, 7 1/4" × 10 1/2"L, 
8 1/2" × 11"KL, 8" × 13"L, 8 1/2" × 13"L, 81/2" × 14"L, 8 1/4" × 13"L, 11" ×
17"L, 8KL, 16KKL

❖❖❖❖ Paper weight:
64 – 105g/m2, 17 – 28 lb.

❖❖❖❖ Power consumption (Max):
35W (power is supplied from the mainframe)

❖❖❖❖ Dimensions (W ×××× D ×××× H):
121 × 479 × 510mm, 4.8" × 18.9" × 20.1"

❖❖❖❖ Weight:
Approx. 6kg, 13.3 lb.

Internal tray 2 (1 bin tray)

❖❖❖❖ Number of bins:
1

❖❖❖❖ Available paper size:
A3L, B4L, A4KL, B5KL, A5KL, B6L, A6L, 11" × 17"L, 81/2" × 14"L,
81/2" × 11"KL, 101/2" × 71/4" KL, 8" × 13"L, 81/2" × 13"L, 81/4" × 13"L,
51/2" × 81/2" L, 8KKL, 16KKL, 37/8" × 71/2"K, 41/8" × 91/2"K, C5 EnvK,
C6 EnvK, DL EnvK

❖❖❖❖ Paper capacity:
125 sheets (80g/m2, 20 lb.)

❖❖❖❖ Copy paper weight:
64 – 105g/m2 (17 – 28 lb.)

❖❖❖❖ Maximum power consumption:
Less than 0.5 W (power is supplied from the mainframe)

❖❖❖❖ Dimensions (W ×××× D ×××× H):
530 × 435 × 120mm, 20.9" × 17.1" × 4.7"

❖❖❖❖ Weight:
Approx. 1.1 kg, 2.5 lb.

Note
❒ Specifications are subject to change without notice.
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Bypass Tray

❖❖❖❖ Paper size:
• Standard size: A3L – A6L, 12" × 18"L – 51/2" × 81/2"KL

• Custom size: Vertical (90.0 – 305.0mm, 3.55" – 12.00"), Horizontal (148.0 –
457.2mm, 5.83" – 18.00")

❖❖❖❖ Copy paper weight:
64 – 163g/m2, 17 – 43.6 lb.

❖❖❖❖ Dimensions (W ×××× D ×××× H):
310 × 380 × 275mm, 12.4" × 15.2" × 11"

❖❖❖❖ Paper capacity:
• 64 – 90g/m2, 17 – 20 lb: 100 sheets

❖❖❖❖ Weight:
Approx. 3kg, 6.6 lb.

Large Capacity Tray (LCT)

❖❖❖❖ Paper size:
A4K, 81/2" × 11"K

❖❖❖❖ Paper weight:
64 – 105g/m2, 17 – 28 lb.

❖❖❖❖ Paper capacity:
2,000 sheets (80g/m2, 20 lb.)

❖❖❖❖ Power consumption
Maximum. 30 W (power is supplied from the mainframe)

❖❖❖❖ Dimensions (W ×××× D ×××× H, option unit):
540 × 600 × 270mm, 21.3" × 23.6" × 10.6"

❖❖❖❖ Weight:
Approx. 25 kg, 55 lb.

Note
❒ Specifications are subject to change without notice.
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Paper tray unit

❖❖❖❖ Copy paper weight:
64 – 128g/m2 (17 – 34 lb.)

❖❖❖❖ Available paper size:
A3L, B4L, A4KL, B5KL, A5KL, 11" × 17"L, 81/2" × 14"L, 81/2" ×
13"L, 81/2" × 11"KL, 81/4" × 13"L, 8" × 13"L, 71/4" × 101/2"L, 51/2" × 81/2"
L, 8KL, 16KKL

❖❖❖❖ Maximum power consumption:
Less than 30 W (power is supplied from the mainframe)

❖❖❖❖ Paper capacity:
500 sheets (80g/m2, 20 lb.) × 2 trays

❖❖❖❖ Dimensions (W ×××× D ×××× H):
540 × 600 × 270mm, 21.3" × 23.6" × 10.6"

❖❖❖❖ Weight:
Approx. 25 kg, 55.2 lb.

Note
❒ Specifications are subject to change without notice.
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Copy Paper

Recommended Paper Sizes and Types

The following limitations apply to each tray:

Tray 
Type

Paper Type and 
Weight

Metric Version Inch Version Paper 
Capacity

Tray 1, 2 64-105g/m2 
(17-28 lb.)

A3L, B4L, A4KL, 
B5KL, A5K, 81/2" × 
11"L

A4L, B5KL, 11" × 
17"L, 81/2" × 14"L, 
81/2" × 11"KL

250 sheets

 *1  A5L, A6L, 11" × 
17"L, 81/2" × 14"L, 
81/2" × 11"K, 51/2" × 
81/2"KL, 71/4" × 
101/2"KL, 8" × 13"L, 
81/2" × 13"L, 81/4" × 
13"L, 8KL, 16KKL

 *1  A3L, B4L, A4K, 
A5KL, A6L, 51/2" × 
81/2"KL, 71/4" × 
101/2"KL, 8" × 13"L, 
81/2" × 13"L, 81/4" × 
13"L, 8KL, 16KKL

 *2  Custom size

Vertical: 100.0-297.0 mm

Horizontal: 148.0-432.0 
mm

 *2  Custom size

Vertical: 3.94"-11.69"

Horizontal: 5.83"-17.00"

Thick paper *8 

106-163g/m2 
(28.3-43.6 lb.)

A3L, B4L, A4KL, 
B5KL, A5K, 81/2" × 
11"L

A4L, B5KL, 11" × 
17"L, 81/2" × 14"L, 
81/2" × 11"KL

50 sheets

 *1  A5L, A6L, 11" × 
17"L, 81/2" × 14"L, 
81/2" × 11"K, 51/2" × 
81/2"KL, 71/4" × 
101/2"KL, 8" × 13"L, 
81/2" × 13"L, 81/4" × 
13"L, 8KL, 16KKL

 *1  A3L, B4L, A4K, 
A5KL, A6L, 51/2" × 
81/2"KL, 71/4" × 
101/2"KL, 8" × 13"L, 
81/2" × 13"L, 81/4" × 
13"L, 8KL, 16KKL

 *2  Custom size

Vertical: 100.0-297.0 mm

Horizontal: 148.0-432.0 
mm

 *2  Custom size

Vertical: 3.94"-11.69"

Horizontal: 5.83"-17.00"

OHP transparen-
cies *8 

A4K *1 20 sheets
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Paper 
tray 
unit 
(op-
tion)

64 - 105g/m2 
(17-28 lb.)

A3L, B4L, A4KL, 
B5K, A5K, 11" × 17"L, 
11" × 81/2"K

A3L, A4K, 11" × 17"L, 
81/2" × 14"L, 81/2" × 
11"KL, 81/2" × 51/2"K

500 sheets 
× 2

 *1  B5L, A5L, 81/2" × 
14"L, 81/2" × 11"L, 
51/2" × 81/2"KL, 71/4" × 
101/2"L, 8" × 13"L, 
81/2" × 13"L, 81/4" × 
13"L, 8KL, 16KKL

 *1  B4L, A4L, B5KL, 
A5KL, 51/2" × 81/2"L, 
71/4" × 101/2"L, 8" × 
13"L, 81/2" × 13"L, 
81/4" × 13"L, 8KL, 
16KKL

 *2  Custom size

Vertical: 148.0 - 297.0 
mm

Horizontal: 148.0 - 432.0 
mm

 *2  Custom size

Vertical: 5.83" - 11.69"

Horizontal: 5.83" - 17.00"

Bypass 
Tray 
(op-
tion)

64-105g/m2 
(17-28 lb.)

A3L, A4L, 8" × 13"L, 
A5L

11" × 17"L, 81/2" × 
11"L, 51/2" × 81/2"L

100 sheets

 *3  B4L, A4K, B5KL, 
A5K, B6L, A6L, 11" × 
17"L, 81/2" × 14"L, 
81/2" × 11"KL, 51/2" × 
81/2"KL, 71/4" × 
101/2"KL, 81/2" × 
13"L, 81/4" × 13"L, 12" 
× 18"L, 8KL, 16KKL

 *3  A3L, B4L, A4KL, 
B5KL, A5KL, B6L, 
A6L, 81/2" × 14"L, 
81/2" × 11"K, 81/2" × 
51/2"K, 71/4" × 
101/2"KL, 8" × 13"L, 
81/2" × 13"L, 81/4" × 
13"L, 12" × 18"L, 8KL, 
16KKL

 *4  Custom size

Vertical: 90.0-305.0 mm

Horizontal: 148.0-457.2 
mm

 *4  Custom size

Vertical: 3.55"-12.00"

Horizontal: 5.83"-18.00"

Thick paper *9 

106-163g/m2 
(28.3-43.6 lb.)

A3L, A4L, 8" × 13"L, 
A5L

11" × 17"L, 81/2" × 
14"L, 81/2" × 11"L, 
51/2" × 81/2"L

30 sheets

 *3  B4L, A4K, B5KL, 
A5K, B6L, A6L, 11" × 
17"L, 81/2" × 14"L, 
81/2" × 11"KL, 51/2" × 
81/2"KL, 71/4" × 
101/2"KL, 81/2" × 
13"L, 81/4" × 13"L, 12" 
× 18"L, 8KL, 16KKL

 *3  A3L, B4L, A4KL, 
B5KL, A5KL, B6L, 
A6L, 81/2" × 14"L, 
81/2" × 11"K, 81/2" × 
51/2"K, 71/4" × 
101/2"KL, 8" × 13"L, 
81/2" × 13"L, 81/4" × 
13"L, 12" × 18"L, 8KL, 
16KKL

 *4  Custom size

Vertical: 90.0-305.0 mm

Horizontal: 148.0-457.2 
mm

 *4  Custom size

Vertical: 3.55"-12.00"

Horizontal: 5.83"-18.00"

Tray 
Type

Paper Type and 
Weight

Metric Version Inch Version Paper 
Capacity
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*1 Select the paper size in System Settings. ⇒ p.76 “Tray Paper Size:  (Tray 1–4)”
*2 Specify the paper size. ⇒ p.76 “Tray Paper Size:  (Tray 1–4)”
*3 Place the paper in the bypass tray, and select the paper size. ⇒ “Copying from the

Bypass Tray” in Copy Reference
*4 Place the paper in the bypass tray, and specify the paper size. ⇒ “Copying from the

Bypass Tray” in Copy Reference
With paper longer than 457mm, misfeeds, jams and creasing is more likely. Make
sure paper is placed correctly so that it is fed straight.

*5 It is recommended to place one sheet at a time.
*6 The paper tray fence is immovable. If you wish to change the size of paper placed in

this tray, contact your service representative.
*7 When loading translucent papers, set the paper direction along its recommendation.
*8 Select the paper type in System Settings. ⇒ p.77 “Paper Type:Tray1–4”
*9 Select the paper type in System Settings. ⇒ p.77 “Paper Type:Bypass Tray”, “Copy-

ing from the Bypass Tray” in Copy Reference

Important
❒ If you use damp or curled paper, a misfeed may occur.

Note
❒ When loading paper, make sure the stack height does not exceed the lower

limit mark of the paper tray. ⇒ p.115 “B Loading Paper”
❒ When loading copy paper in the paper tray 1-4 and the large capacity tray

(LCT), place the copy side of the paper face up.
❒ When printing on paper less than 90g/m2(24lb.), select [Normal] in the control

panel. When printing on paper between 90 to 105g/m2(24 to 28lb.), select [Mid-
dle Thick/24-28lb] in the control panel. ⇒ p.145 “Changing Paper Thickness Set-
tings”

❒ When using thick paper, the machine may produce a different sound.
❒ When loading copy paper in the bypass tray, place the copy side of the paper

face down.

Bypass 
Tray 
(op-
tion)

Translucent paper 
*7 

A3L, A4KL 50 sheets 
*5 

OHP transparen-
cies *9 

A4K *3 50 sheets 
*5 

Label paper 
(adhesive labels)

B4L, A4KL 1 sheet

Envelope *3 37/8" × 71/2"K, 41/8" × 91/2"K, C5 EnvK, C6 En-
vK, DL EnvK

–

Large 
Capaci-
ty Tray 
(LCT) 
(op-
tion)

64-105g/m2 
(17-28 lb.)

A4K, 81/2" × 11"K *6 2000 
(1000 + 
1000) 
sheets

Tray 
Type

Paper Type and 
Weight

Metric Version Inch Version Paper 
Capacity
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❒ When you use the bypass tray, it is recommended to set the copy paper direc-
tion to L.

❒ When you load the OHP transparencies, check the front and back of the
sheets, and place them correctly, or a misfeed might occur. When using OHP
transparencies with a taped edge, set them so the taped edge is fed last. Set
the paper direction to K and select A4K, 81/2"×11"K as paper size, ⇒ p.76
“Tray Paper Size:  (Tray 1–4)”, “Copying from the Bypass Tray” in Copy Ref-
erence.

❒ When you use OHP transparencies, shuffle them for each use. If you store the
sheets in the tray, they may adhere and may cause feeding problems.

❒ If multiple-sheet jams occur, load the paper sheet by sheet.
❒ Envelopes should be fed using the bypass tray.

❖❖❖❖ When copying onto envelopes
• Be sure to set the size of the envelope before copying. For details, see

“When Copying onto Envelopes” in the Copy Reference.
• If you are printing onto the envelope from the printer driver, set the size

of the envelope from the printer driver.
• When you are copying or printing on envelopes, select “Thick Paper”

for the paper type.
• The minimum vertical length of envelopes that can be loaded is 140

mm, including opened flap.
• Do not print on both sides.
• Do not stack more than 10 envelopes in the output tray.
• Do not use double-flapped envelopes.
• Do not use envelopes with released tabs attached to the sealed part.
• Some kinds of envelopes might wrinkle or the print quality may be af-

fected, especially on overlaps.
• Load envelopes bottom side first and flaps open.
• Before loading envelopes, flatten opened flaps.

❒ If you load paper of the same size in the same direction in two or more trays,
the machine automatically shifts to the other tray when the first tray in use
runs out of paper. This function is called Auto Tray Switching. (However, if
one tray has recycled or special paper, the settings of the other trays must be
the same for Auto Tray Switching.) This saves interrupting a copy run to re-
plenish paper when making a large number of copies.

❒ The paper types you can select in System Settings are only general classifica-
tions. The copy quality for every kind of paper in a classification is not guar-
anteed. See ⇒ p.163 “Non-recommended Paper” for more information.
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Non-recommended Paper

R CAUTION:

Important
❒ To prevent faults, do not use any of the following kinds of paper:

• Papers for inkjet printers
• Thermal fax paper
• Art paper
• Aluminum foil
• Carbon paper
• Conductive paper
• Paper with perforated lines
• Hemmed-edge paper

❒ Do not use paper that is meant for an inkjet printer or it may stick to the Fus-
ing Unit and cause a paper misfeed.

❒ Do not copy onto a side that already has copy on, or a fault might occur.

Note
❒ To prevent misfeeds, do not use the following kinds of paper:

• Bent, folded, or creased paper
• Torn paper
• Slippery paper
• Perforated paper
• Rough paper
• Thin paper with little stiffness
• Paper with a dusty surface

❒ If you copy onto rough grain paper, the image might be blurred.

• Do not use aluminum foil, carbon paper, or similar conductive paper to avoid 
a fire or machine failure.
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Paper Storage

Note
❒ When storing paper, the following precautions should always be followed:

• Do not store paper where it will be exposed to direct sunlight.
• Avoid storing paper in humid areas (humidity: 70% or less).
• Store on a flat surface.

❒ Do not store paper vertically.
❒ Under high temperature and humidity conditions, or low temperature and

humidity conditions, store paper in a vinyl bag.
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INDEX

1000-sheet finisher,   23
10BASE-T/100BASE-TX,   27
500-Sheet Finisher,   23

A

Access to the Machine,   141
Adding Staples,   131
Adding Toner,   117
Adjust/Program Color key (copy mode),   24
Auto Off,   48

B

Bridge unit,   23
Bypass tray,   22, 23, 157

C

Changing Paper
Tray 1 and 2,   126

Changing paper size
Tray3 or Tray4,   128

Changing the Display Language,   144
Changing the Paper Size,   126
Check Modes key,   24
Clearing Misfeeds,   120
Clear Modes key,   24
Clear/Stop key,   25
Color circle,   24
Color function keys (copy mode),   25
Combined Function Operations,   47
Common key operations,   26
Configuring the Network,   34
Control Panel,   24
Control panel,   21
Copy Mode,   14
Copy Paper,   159

D

Displaying the Total Counter,   146
Display panel,   24, 26
Document Feeder,   152
Document feeder,   21

Cleaning,   142
Document feeder (ADF),   23
Document Server,   55

Deleting,   64
Printing,   62
Using the Document Server,   57

Do's And Don'ts,   137
Duplex unit,   23, 156

E

Energy Saver key,   24
Environment,   140
Exposure glass,   21

Cleaning,   142
Exposure glass cover,   23
External Options,   23

F

Facsimile Mode,   14
Finisher

1000-Sheet Finisher,   23
500-Sheet Finisher,   23

Front cover,   22

H

Handset,   23

I

IEEE 1394 ports,   27
Iinterface,   22
Indicators,   24
Inquiry,   144
Internal tray,   21
Internal tray 2 (1 bin tray),   23
Interrupt key,   25
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L

Large Capacity Tray (LCT),   23, 157
Loading Paper,   115

Large Capacity Tray (option),   116
Tray 1 and 2,   115

M

Machine Environment,   140
Mainframe,   147
Main power indicator,   25
Main power switch,   21, 32
Messages,   111
Misfeeds,   120
Multi-Access,   50

N

Network Connections,   28
Number keys,   25

O

On Hook Dial key,   24
Operation switch,   25, 32
Options,   152

P

Paper
Changing,   126
Loading,   115

Paper tray,   22
Paper tray unit,   23
Parallel port,   27
Power Connection,   141
Power indicator,   25
Program key,   24

R

Remarks,   137
Remove Paper Indicator,   21
Removing Jammed Staples,   134

S

Safety information,   9
{Sample Copy}}}} key,   25
Saving Color Copies,   138
Saving Energy,   48
Screen contrast knob,   24
Specification,   147

Document Feeder,   152
Duplex unit,   156
Internal tray 2 (1 bin tray),   156
Large Capacity Tray (LCT),   157
Mainframe,   147
Paper tray unit,   158
Shift Sort Tray,   155

Staples,   131
Removing Jammed Staples,   134

{Start}}}} key,   25
Start Manual RX key (facsimile mode),   24
System Reset,   48

T

Tone keys,   25
Tone keys (facsimile mode),   25
Toner,   139
Toner Bottle

Storage,   139

U

User Code,   94
{User Tools/Counter}}}} key,   24
User Tools (System Settings),   67

V

Ventilation holes,   22

W

Wireless LAN port (option),   27
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Paper type: OK Prince Eco G100(55kg), Paper Thickness=80 µm // Pages in book=172 // Print scale=81%
Gap (when printed at 81% scale)  = Pages in book  ×  Paper thickness  /  2  = 6.880000 mm

In accordance with IEC 60417, this machine uses the following symbols for the main power switch:

aaaa means POWER ON.

bbbb means POWER OFF.

cccc means STAND BY.

Introduction

This manual contains detailed instructions on the operation and maintenance of this machine. To get
maximum versatility from this machine all operators should carefully read and follow the instructions in
this manual. Please keep this manual in a handy place near the machine.

Notes

Some illustrations may be slightly different from your machine.

Certain options may not be available in some countries. For details, please contact your local dealer.

Laser Safety

This machine is considered a class 1 laser device, safe for office/EDP use. The machine contains two
AlGalnP laser diodes, 7-milliwatt,645-660 nanometer wavelength for each emitter. Direct (or indirect
reflected) eye contact with the laser beam might cause serious eye damage. Safety precautions and
interlock mechanisms have been designed to prevent any possible laser beam exposure to the opera-
tor.

Warning:

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Notes:

The model names of the machines do not appear in the following pages. Check the type of your ma-
chine before reading this manual. (For details, see P.15 “Machine Types”.)

• Type 1: 24 copies/minute (81/2" × 11"K)

• Type 2: 32 copies/minute (81/2" × 11"K)

Certain types might not be available in some countries. For details, please contact your local dealer. 

Two kinds of size notation are employed in this manual. With this machine refer to the inch version.

For good copy quality, the supplier recommends that you use genuine toner from the supplier.

The supplier shall not be responsible for any damage or expense that might result from the use of parts
other than genuine parts from the supplier with your office products. 

Power Source

120V, 60Hz, 12A or more

Please be sure to connect the power cord to a power source as above. For details about power source,
see P.141 “Power Connection”.



Paper type: OK Prince Eco G100(55kg), Paper Thickness=80 µm // Pages in book=172 // Print scale=81%
Gap (when printed at 81% scale)  = Pages in book  ×  Paper thickness  /  2  = 6.880000 mm

B0516507A

Operating Instructions

General Settings Guide

For safe and correct use of this machine, please be sure to read the Safety Information be-
fore you use it.

What You Can Do With This Machine

Basics

Combined Function Operations

Document Server

User Tools (System Settings)

Troubleshooting

REMARKS
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Paper type: OK Prince Eco G100(55kg), Paper Thickness=80 µm // Pages in book=128 // Print scale=81%
Gap (when printed at 81% scale)  = Pages in book  ×  Paper thickness  /  2  = 5.120000 mm

B0516607A

Type for C2408/DSc224/LD024c/Aficio 1224C

Operating Instructions

Copy Reference

For safe and correct use of this machine, please be sure to read the Safety Information in the
General Settings Guide before you use it.

Placing Originals

Copying

Color Adjustment/Program

Troubleshooting

User Tools (Copier/Document Server Features)
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Paper type: OK Prince Eco G100(55kg), Paper Thickness=80 µm // Pages in book=128 // Print scale=81%
Gap (when printed at 81% scale)  = Pages in book  ×  Paper thickness  /  2  = 5.120000 mm

In accordance with IEC 60417, this machine uses the following symbols for the main power switch:

aaaa means POWER ON.

bbbb means POWER OFF.

cccc means STAND BY.

Introduction

This manual contains detailed instructions on the operation and maintenance of this machine. To get
maximum versatility from this machine all operators should carefully read and follow the instructions in
this manual. Please keep this manual in a handy place near the machine.

Notes

Some illustrations may be slightly different from your machine.

Certain options may not be available in some countries. For details, please contact your local dealer.

Warning:

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Notes:

The model names of the machines do not appear in the following pages. Check the type of your ma-
chine before reading this manual. (For details, ⇒ P.3 “Machine Types”.)

• Type 1: 24 copies/minute (81/2" × 11"K)

• Type 2: 32 copies/minute (81/2" × 11"K)

Certain types might not be available in some countries. For details, please contact your local dealer.

Two kinds of size notation are employed in this manual. With this machine refer to the inch version.

For good copy quality, the supplier recommends that you use genuine toner from the supplier.

The supplier shall not be responsible for any damage or expense that might result from the use of parts
other than genuine parts from the supplier with your office products. 

Power Source

120V, 60Hz, 12A or more

Please be sure to connect the power cord to a power source as above. For details about power source,
see “Power Connection” in the General Settings Guide.
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What You Can Do With This Machine 
<Color Functions/Color Adjustments>

You can switch the color copy mode depending on the type of originals used and the desired 
finish.

Copies using four colors: yellow, magenta, 
cyan and black.

Copies in black and white, even when the 
original is in color.

Copies in the designated color.

Color: Copies using 2 registered colors. Black/Red: Copies the red part of the 
original in red, and copies all other areas 
in black and white.

2-Color Copy (    p.25)

Single Color Copy (    p.25)

Full Color Copy (    p.25) Black/White Copy (    p.25)

Color Copying (      p.25)

Yellow Beige Orange Red Light green Cyan

Pink Magenta Green Marine blue Blue Purple Registered colour

GCMO022e
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Color Copying (      p.25)

Copies with the date, page numbers, etc. 
The stamp color can be yellow, red, cyan, 
magenta, green, blue, and black.

Printed inserts types:
• Preset Stamp (p.60)
• User Stamp (p.61)
• Date Stamp (p.64)
• Page Numbering (p.66)

Stamping on Copies (     p.60)

Copies by changing a specific color in the 
original to another color.

Convert Colors (     p.26)

Copies by deleting a specific color in the 
original.

Erase Specified Color (     p.27)

Copies by adding a color to the whole 
page.

Color Background (      p.27)

GCMO026e
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Primary Colors

Adjusting Colors (     p.73)

Colors can be created by combining the 3 primary colors:
yellow, magenta and cyan. Black can be made by combining 
yellow, magenta and cyan, however, as there might be some 
slight differences, "black" will be expressed using a black 
toner.

Adjusts the specific colors (yellow, red, 
magenta, blue, cyan and green) by mixing 
them with adjacent colors in the color 
circle.

Adjusts the overall color tone of copies.

Adjust Color (     p.73) Color Balance (     p.74)

Adjusting Images (     p.76)

Adjusts the outline of the image. Adjusts the background density of the image.

Sharp/Soft (     p.76) Background Density (     p.76)

Adjusts the shades of the image. Adjust U.C.R (     p.77)
Text/Photo Sensitivity (     p.77)
A.C.S. Sensitivity (     p.106)
Color Sensitivity  (     p.106)

Contrast (     p.76) Other Adjustments (     p.77)

Soft Sharp

Low High

Light Dark

Make yellow 
more green

Make yellow 
more red

Darker Lighter

Yellow Cyan

Magenta Black

Yellow

Red

Black

Magenta

Blue

Green

Cyan

Yellow

Red

Magenta

Blue

Green

Cyan

GCMO023e
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What You Can Do With This Machine

2-sided 2 Pages    2-sided 1 Page      p.49

Front

Front

Back

Back

Front

Back

Front Back

Types of Duplex Copies

1-sided 4 Pages    2-sided 1 Page     p.49

2-sided 4 Pages    2-sided 1 Page     p.501-sided 8 Pages    2-sided 1 Page     p.49

1-sided 16 Pages     2-sided 1 Page      p.49

The functions available may vary according to the options installed. For details   p.4 
"Functions that Require Options"

1-sided 2 Pages    2-sided 1 Page      p.46 2-sided 1 Page     2-sided 1 Page      p.46

2-sided 8 Pages     2-sided 1 Page      p.50

Front/Back Bound Originals     2-sided Pages      p.51Bound Originals      2-sided Pages     p.51

GCMO024e
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Combining Multiple Pages onto a Single Page (     p.48)
The functions available may vary according to the options installed. For details, see p.4 
"Functions that Require Options"

1-sided 2 Pages     1-sided 1 Page 2-sided 1 Page     1-sided 1 Page

1-sided 4 Pages     1-sided 1 Page 2-sided 2 Pages     1-sided 1 Page

1-sided 8 Pages     1-sided 1 Page 2-sided 4 Pages     1-sided 1 Page

2-sided Page     1-sided 2 Pages     p.46

Bound Originals     2-sided Pages     p.51

Bound Originals     1-sided Pages     p.51

Copying Originals Such as Books 

Copying onto Envelopes (    p.22)

Front/Back Bound Originals
     2-sided Pages     p.51

GCMO025e
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Notice

Do not make copies of any item for which copying is prohibited by law.
Copying the following items is normally prohibited by local law:
Bank bills, revenue stamps, bonds, stock certificates, bank drafts, checks, pass-
ports, driver's licenses.
The color copy samples in this book may differ slightly from the actual copies
due to printing effects.
The color on each Color key may differ slightly from that of the actual copy.
This machine is equipped with a function that prevents making counterfeit bank
bills. Due to this function the original images similar to bank bills may not be
copied properly.
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How to Read this Manual

Symbols

In this manual, the following symbols are used:

R WARNING:
This symbol indicates a potentially hazardous situation that might result in
death or serious injury when you misuse the machine without following the in-
structions under this symbol. Be sure to read the instructions, all of which are in-
cluded in the Safety Information section in the General Settings Guide.

R CAUTION:
This symbol indicates a potentially hazardous situation that might result in mi-
nor or moderate injury or property damage that does not involve personal injury
when you misuse the machine without following the instructions under this
symbol. Be sure to read the instructions, all of which are included in the Safety
Information section in the General Settings Guide.
• WARNINGS and CAUTIONS are notes for your safety.

Important
If this instruction is not followed, paper might be misfeed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates the prior knowledge or preparations required before op-
erating.

Note
This symbol indicates precautions for operation or actions to take after misoper-
ation.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys that appear on the machine's display panel.

{ }
Keys built into the machine's control panel.

Notice

B4 JISKL, B5 JISKL, B6 JISL are referred to as B4KL, B5KL, B6L in this
manual.
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Machine Types

This machine comes in two models which vary by copy speed. To make sure
which model you have, see the inside front cover of this manual.

Type 1 Type 2

Copy speed/Single Color 24 copies/minute  
(A4K, 81/2" × 11"K)

32 copies/minute  
(A4K, 81/2" × 11"K)

Copy speed/Full Color 8 copies/minute  
(A4K, 81/2" × 11"K)

10 copies/minute  
(A4K, 81/2" × 11"K)
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Functions that Require Options

The available functions depend on your machine configuration and which op-
tions you have. See the table below.
❍Required options

Functions
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Document Feeder (ADF) ❍ ❍ ❍ ❍ ❍ ❍

500-Sheet Finisher ❍ ❍ ❍

1000-Sheet Finisher ❍ ❍ ❍

Shift Sort Tray ❍ ❍

Duplex Unit ❍ ❍ ❍ ❍ ❍ ❍ ❍

Bypass Tray ❍

UranosC1-ENcopyA_F1_FM.book  Page 4  Friday, July 26, 2002  5:01 PM



5

Control Panel

Note
❒ This illustration shows the Control Panel of the machine with options fully in-

stalled.

1. Screen Contrast knob
Adjusts the brightness of the display pan-
el.

2. {{{{User Tools/Counter}}}} key
• User Tools

Press to change the default settings
and conditions to meet your require-
ments.

• Counter
Press to check or print the Counter
value.

• Inquiry
Shows where to order expendable
supplies and where to call when a
malfunction occurs. You can also print
these details.

3. Indicators
These indicators show the status of the
machine or indicate errors.

4. {{{{Adjust/Program Color}}}} key
Use this key to adjust and register colors.
⇒ p.73 “Color Adjustment/Program” 

Note
❒ When image quality is adjusted, the

lamp in the {{{{Adjust/Program Color}}}} key
is lit.

5. Color Circle
Refer to this when adjusting colors. ⇒
p.73 “Color Adjustment” 

6. Display panel
Shows operation status, error messages,
and function menus. 

7. {{{{Check Modes}}}} key
Press to check the entered copy job set-
tings.

8. {{{{Program}}}} key
Press to select the program mode. ⇒ p.82
“Programs” 

9. {{{{Clear Modes}}}} key
Press to clear the previously entered copy
job settings.

10. {{{{Energy Saver}}}} key
Press to switch to and from the Energy
Saver mode. ⇒ “General Settings Guide”

11. {{{{Interrupt}}}} key
Press to interrupt a long copy job to make
copies. ⇒ p.18 “Interrupt Copy” 

12. Main power indicator
This indicator goes on when the main
power switch is turned on and goes off
when the switch is turned off.
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Important
❒ Do not turn the main power off

while the main power indicator is
flashing. The hard disk may mal-
function.

13. Operation switch
Press this switch to turn the power on
(the On indicator goes on). To turn the
power off, press this switch again (the On
indicator goes off).

14. {{{{Sample Copy}}}} key
Use this key to make a single sample
copy before starting a long copy run. By
checking the sample copy and making
any necessary changes to the image qual-
ity settings before you make multiple
copies, you can save time and paper. ⇒
p.41 “Sample Copy” 

15. {{{{Start}}}} key
Press to start copying. Press to start scan-
ning and printing in Document Server
mode.

16. {{{{Clear/Stop}}}} key
• Clear

Press to delete a number entered.
• Stop

Press to stop a copy job in progress.

17. {{{{#}}}} key
Press to enter a value.

18. Number keys
Use to enter the desired number of copies
and data for selected modes.

19. Color Selection Key
Use these key to switch color functions:
⇒ p.25 “Color Functions” 
{{{{Auto Color Select}}}} 
{{{{Full Color}}}} 
{{{{B & W}}}} 
{{{{Single Color}}}} 
{{{{Two-color}}}} 

20. Function keys/Function Status
indicator
These keys switch display to the operat-
ing screen of each functions. Follow the
instructions displayed by switching be-
tween screen with the function keys.
These show the status of the above func-
tions:

• Yellow: the function is selected
• Green: the function is active
• Red: the function has been interrupted

Common Key Operations

The following keys are common to all screens.

 [Exit] Returns to the previous screen.

 [Cancel] Deletes a selected function or entered values, and then returns 
to the previous screen.

 [OK] Acknowledges a selected function or entered values, and then 
returns to the previous screen.

 [�Previous] [�Next] Moves to the previous or the next page when all the functions 
cannot be displayed on one page.
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1. Placing Originals

Originals

Sizes and Weights of Recommended Originals

❖❖❖❖ Metric version

❖❖❖❖ Inch version

Note
❒ The number of originals that can be placed in the document feeder is about 50.
❒ The weight range for originals in the Mixed Size mode is 52-81g/m2, 13.8-21.5

lb.

Non-recommended originals for the document feeder

Placing the following types of originals in the document feeder can cause paper
misfeeds or result in damage to the originals. Place these originals on the expo-
sure glass instead.
• Originals other than those specified in ⇒ p.7 “Sizes and Weights of Recom-

mended Originals” 
• Stapled or clipped originals
• Perforated or torn originals
• Curled, folded, or creased originals

Where Original Is 
Placed Original Size Original Weight

Exposure glass Up to A3 --

Document feeder 1-sided originals:

A3L – A5KL

40 – 128g/m2

2-sided originals:

A3L – A5KL

52 – 105g/m2

Where Original Is 
Placed Original Size Original Weight

Exposure glass Up to 11" × 17" --

Document feeder 1-sided originals:

11" × 17"L – 51/2" × 81/2"KL

11 – 34 lb.

2-sided originals:

11" × 17"L – 51/2" × 81/2"KL

14 – 28 lb.
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Placing Originals
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• Pasted originals
• Originals with any kind of coating, such as thermal fax paper, art paper, alu-

minum foil, carbon paper, or conductive paper
• Originals with perforated lines
• Originals with indexes, tags, or other projecting parts
• Sticky originals such as translucent paper
• Thin originals that have low stiffness
• Thick originals such as postcards
• Bound originals such as books
• Transparent originals such as OHP transparencies or translucent paper

Note
❒ The original might become dirty if it is written with a pencil or a similar

tool.

Sizes Detectable by the Auto Paper Select

❖❖❖❖ Metric version

❍ : Detectable size  × : Undetectable size

❖❖❖❖ Inch version

❍ : Detectable size  × : Undetectable size

Size A3LLLL B4LLLL A4KKKK
LLLL

B5KKKK
LLLL

A5KKKK
LLLL

11" ×××× 
17"LLLL

81/2" ×××× 
14"LLLL

81/2" ×××× 
11"KKKK
LLLL

51/2" ×××× 
81/2"
KKKKLLLL

81/2" ×××× 
13"LLLL

Location of 
the original

Exposure glass ❍ ❍ ❍ ❍ × × × × × ❍

Document 
feeder

❍ ❍ ❍ ❍ ❍ × × × × ❍

Size A3LLLL B4LLLL A4KKKK
LLLL

B5KKKK
LLLL

A5KKKK
LLLL

11" ×××× 
17"LLLL

81/2" ×××× 
14"LLLL

81/2" ×××× 
11"KKKK
LLLL

51/2" ×××× 
81/2"
KKKKLLLL

10" ×××× 
14"LLLLLocation of 

the original

Exposure glass × × × × × ❍ ❍ ❍ × ×

Document 
feeder

× × × × × ❍ ❍ ❍ ❍ ❍
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❖❖❖❖ Exposure glass

❖❖❖❖ Document feeder

Sizes difficult to detect

It is difficult for the machine to detect the sizes of the following originals, so se-
lect the paper size manually.
• Originals with indexes, tags, or other projecting parts
• Transparent originals such as OHP transparencies or translucent paper
• Dark originals with a lot of text and drawings
• Originals which partially contain a solid image
• Originals which have solid images at their edges

A3

A3A4

Horizontal size

V
ertical size

Reference
position

Maximum Scanning area
A3      (297x420mm)
11"x17"      (279x432mm)

CP01AEE
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Missing Image Area

Even if you correctly place originals in the document feeder or on the exposure
glass, margins of a few millimeters on all four sides of the original might not be
copied.

1. 0 - 4 mm, 0”- 0.16”

2. 0 - 4 mm, 0”- 0.16”

3. 0 - 4 mm, 0”- 0.16”

4. 2 - 6 mm, 0.08”- 0.24”
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Direction-fixed paper or 2-sided paper

Direction-fixed (top to bottom) or 2-sided paper (e.g., letterhead paper, punched
paper, or copied paper) might not be printed correctly depending on how the
originals and paper are placed. Set "Letterhead setting" in system settings, and
then place the original and paper as shown below. ⇒ p.106 “Letterhead Setting” 
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Placing Originals

Note
❒ Place originals after correction flu-

id and ink have completely dried.
Not taking this precaution could
dirty the exposure glass with
marks that will be copied.

Reference
For document sizes you can set. ⇒
p.7 “Originals”.

Original Orientation

You can set the original orientation in
the following ways.
This function is useful for copying
torn originals or large originals.

❖❖❖❖ Standard Orientation 
Select this function when the origi-
nal direction is the same as the
copy paper direction.

❖❖❖❖ 90°°°° Turn 
This function rotates the copy im-
age by 90°.
Use this function when you want
to copy onto A3K, B4K, 81/2" ×
14", 81/2" × 13" or 11" × 17"K pa-
per.

AAAA Press [Special Original].

BBBB Select the original orientation.

Standard Orientation

A Make sure that  is select-
ed.

90° Turn

When you want to copy A3K,
B4K, 81/2" × 14", 81/2" × 13" or 11"
× 17"K size originals, place your
original in the landscape orienta-
tion, and then press . The ma-
chine rotates the original image,
and you can make copies as you
wish. This is useful for copying
large originals with the Staple, Du-
plex, Combine or Stamp functions.

Note
❒ It is recommended to use this

function together with the Auto
Paper Select or the Auto Re-
duce/Enlarge function.

A Press .

CCCC Press [OK].

UranosC1-ENcopyA_F1_FM.book  Page 12  Friday, July 26, 2002  5:01 PM



Placing Originals

13

1

Placing Originals on the 
Exposure Glass

AAAA Lift the exposure glass cover or
the document feeder.

Important
❒ Do not open the exposure glass

cover or the document feeder
forcefully. Otherwise, the cover
of the document feeder might
open or be damaged.

Note
❒ Be sure to open the exposure

glass cover or the document
feeder by more than 30°. Other-
wise, the size of the original
might not be detected correctly.

BBBB Place the original face down on
the exposure glass. The original
should be aligned to the rear left
corner.

1. Reference mark

2. Left scale

Note
❒ Start with the first page to be

copied.

CCCC Lower the exposure glass cover or
document feeder.

Placing Originals in the 
Document Feeder

Settings should be made in the fol-
lowing situations:

❖❖❖❖ When placing originals one by one:
⇒ p.14 “SADF mode” 

❖❖❖❖ When placing originals consisting of
more than 50 pages:
⇒ p.14 “Batch mode” 

❖❖❖❖ When copying originals of various
sizes: 
⇒ p.15 “Mixed Size mode” 

❖❖❖❖ When placing custom size originals: 
⇒ p.16 “Placing Custom Size Orig-
inals” 

Note
❒ Do not stack originals beyond the

limit mark on the side fence of the
document feeder.

❒ The last page should be on the bot-
tom.

❒ Do not place any foreign objects on
the sensors or cover them with
your hands. This could cause the
size not to be detected properly.
Also, do not place anything on the
exposure glass cover as this could
cause a malfunction.

1. Sensors

UranosC1-ENcopyA_F1_FM.book  Page 13  Friday, July 26, 2002  5:01 PM



Placing Originals

14

1

AAAA Set the document guide to the
original size.

BBBB Align the edges of the original
and place it on the document
feeder (ADF) with the side to be
copied facing up.

1. Limit mark

2. Document guide

Note
❒ Straighten curls in the original

before placing it on the docu-
ment feeder (ADF).

❒ To prevent multiple sheets from
being fed at once, fan the origi-
nal before placing it on the doc-
ument feeder (ADF). 

❒ Set the original squarely.

Batch mode

In the batch mode, the machine copies
an original including more than 50 pag-
es as one document, even if it is placed
on the document feeder in parts.

AAAA Press [Special Original].

BBBB Select [Batch], and then press [OK].

Note
❒ When [Batch] is not displayed,

change the settings in ⇒ p.105
“Switch to Batch (SADF)” 

CCCC Place the first part of the original,
then press the {{{{Start}}}} key.

DDDD After the first part of the original
has been fed, place the next part
and then press the {{{{Start}}}} key.

Note
❒ Repeat step D when setting mul-

tiple sets of originals.
❒ When the Sort, Combine or 1

Sided → 2 Sided mode has been
set, press the {{{{#}}}} key after all
originals have been scanned.

SADF mode

In SADF mode, even when an origi-
nal is placed page by page in the doc-
ument feeder (ADF), each page is
automatically fed when placed.

Note
❒ To use the SADF function, you

should make a setting in "User
Tools (Copy/Document Server
Features)", so that [SADF] will be
displayed when you press [Special
Original]. ⇒ p.105 “Switch to Batch
(SADF)” 

Reference
Related Default Settings ⇒ p.105
“SADF Auto Reset” 

ZGHS060E
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AAAA Press [Special Original].

BBBB Press [SADF].

CCCC Press [OK].

DDDD Place one page of an original, and
then press the {{{{Start}}}} key.

The Auto Feed indicator is shown
on the display.

EEEE When the machine instructs you
to place another original, place
the next page.

The second and subsequent pages
will be fed automatically without
pressing the {{{{Start}}}} key.

Mixed Size mode

When you place different size origi-
nals which have the same width in
the document feeder at the same time,
the machine automatically checks the
size of the originals and makes cop-
ies.

Note
❒ When placing originals of different

sizes in the document feeder and
making copies without using the
Mixed Size mode, parts of the orig-
inal image might not be copied or
paper might become jammed.

❒ Copy speed and scanning speed
may be reduced.

❒ The sizes of the originals that can
be placed together with this func-
tion are as follows:

AAAA Press [Special Original].

Metric 
version

A3L • A4K, A4L • A5K

Inch 
version

11" × 17"L • 81/2" × 11"K, 
81/2" × 14"L • 81/2" × 11"K, 
81/2" × 11"L • 51/2" × 81/2K, 
81/2" × 14"L • 51/2" × 81/2"K
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BBBB Press [Mixed Size], and then press
[OK].

CCCC Align the rear and left edges of
the originals as shown in the il-
lustration.

1. Place into the document feeder

2. Vertical size

DDDD Adjust the guide to the widest
original size.

EEEE Place the aligned originals face
up into the document feeder.

FFFF Press the {{{{Start}}}} key.

Placing Custom Size Originals

When placing custom size originals in
the document feeder, specify the size
of the originals.

Note
❒ Paper that has a vertical length of

105-297 mm (4.2" – 11.6") and a
horizontal length of 128-432 mm
(5.1" – 17.0") can be placed with
this function.

AAAA Press [Special Original].

BBBB Press [Custm Size Origi.].

CCCC Enter the horizontal size of the
original with the Number keys,
and then press [#].

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key,
and then enter the value again.

DDDD Enter the vertical size of the origi-
nal with the Number keys, and
then press [#].

EEEE Press [OK].

FFFF Place your originals, and then
press the {{{{Start}}}} key.

A31
2

CP19AE

A4
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2. Copying

Basic Procedure

AAAA When the machine is set for user
codes, enter a user code (up to 8
digits) with the number keys, and
then press the {{{{#}}}} key.

The machine is ready to copy.

Reference
For Users Code, see ⇒ General
Settings Guide, “Key Operator
Tools”.

BBBB Make sure that "Ready" is dis-
played on the screen. 

If any other function is displayed,
press the {{{{Copy}}}} key.

❖❖❖❖ Initial copy display

CCCC Make sure that there are no previ-
ous settings remaining.

Note
❒ When there are previous set-

tings remaining, press the {{{{Re-
set}}}} key and enter again.

DDDD Place your originals.

Reference
⇒ p.12 “Placing Originals” 

EEEE Set your desired settings.

Reference
Please refer to each functions.

FFFF Enter the number of copies re-
quired with the number keys.

Note
❒ The maximum copy quantity

that can be set is 100.

GGGG Press the {{{{Start}}}} key.

The machine starts copying.

Note
❒ When you place originals on the

exposure glass, press the {{{{#}}}}
key  af ter  a l l  or ig inals  are
scanned.

❒ Copies are delivered face down.

----How to Operate

❖❖❖❖ To stop the machine during a multi-
copy run. 
⇒Press the {{{{Clear/Stop}}}} key.

❖❖❖❖ To return the machine to the initial
condition after copying. 
⇒Press the {{{{Clear Modes}}}} key.

❖❖❖❖ When clearing entered values.
⇒Press the {{{{Clear/Stop}}}} key or
[Clear] on the display.

❖❖❖❖ To confirm the settings. 
⇒Press the {{{{Check Modes}}}} key.
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Auto Start

Copy starts automatically when the
machine is ready for copy.

AAAA Set the copy contents while
“Please wait.” is displayed. 

BBBB Set the original. 

CCCC Press the {{{{Start}}}} key. 

The {{{{Start}}}} key lamp will flash.

Interrupt Copy

Use this function if you wish to inter-
rupt a long copy job to make urgently
needed copies.

Limitation
❒ You cannot use the Interrupt Copy

function when scanning fax origi-
nals.

AAAA Press the {{{{Interrupt}}}} key. 

The Interrupt indicator goes on.

When the originals stop scanning

A Remove the originals that were
being copied and place the
originals you wish to copy.

B Press the {{{{Start}}}} key.
The machine starts making your
copies.

C When your copy job is fin-
ished, remove your originals
and copies.

D Press the {{{{Interrupt}}}} key again.

The Interrupt indicator goes off.
E When the display prompts

you, set the remaining origi-
nals again before interrupting.

F Press the {{{{Start}}}} key.

Note
❒ The interrupt copy job set-

tings will be restored and the
machine will continue copy-
ing from where it left off.

When the machine keeps 
copying

A Place the originals you wish to
copy.

B Press the {{{{Start}}}} key.

The machine stops the previous
original job and starts copying
your original.

C When copying is complete, re-
move your originals and cop-
ies.

D Press the {{{{Interrupt}}}} key again.

The Interrupt indicator goes off.
The interrupt copy job settings
will be restored and the ma-
chine will continue copying
from where it left off.

Original Beeper

The beeper sounds and an error mes-
sage is displayed when you leave
your originals on the exposure glass
after copying.

Note
❒ ⇒ p.99 “Tone: Original remains” 
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Job Preset

You can set up the next copy content
during copy. 
If a long copy job is in progress and
you do not wish to wait for it to finish,
you can use this function to set up the
next copy job in advance. When the
current copy job is finished, your
copy job will be started automatically.

AAAA Press [Next Job] when "Copying" is
shown.

BBBB Set up the next copy job.

CCCC Place the originals in the docu-
ment feeder, and then press the
{{{{Start}}}} key.
All originals are scanned.

DDDD Press [To "Printing"].
Returns to the initial copy display. 
After the current copy job, the next
job starts automatically.

Note
❒ You can switch the display to

the current copy job by pressing
[To "Printing"]. You can switch
the display to the preset job by
pressing [To "Reserving"].

UranosC1-ENcopyA_F1_FM.book  Page 19  Friday, July 26, 2002  5:01 PM



Copying

20

2

Copying from the Bypass Tray

The optional bypass tray is required to use this function.

Use the bypass tray to copy onto spe-
cial paper (OHP transparencies, label
paper (adhesive labels), thick paper
(for example: postcards and enve-
lopes), thin paper), and copy paper
that cannot be loaded in the paper
trays.

Preparation
When the Duplex unit is attached,
the default setting is [1 Sided→→→→2
Sided].
When copying from the bypass
tray, select [1 Sided] for copying in
[Dup./Combine/Series] (for example
[1 Sided ]→[1 Sided] or [2 Sided]→[1
Sided]). You can change the initial
settings. ⇒ p.99 “Duplex Mode
Priority” 

Important
❒ It is not possible to use inkjet pa-

per. For details about paper sizes
and paper types, see ⇒ General
Settings Guide, “Paper Type”.

❒ When paper larger than 457.3 mm in
size is used, the paper may become
wrinkled, may not be fed into the
machine, or may cause paper jams.

Note
❒ If you do not use the standard size

copy paper or if you use special pa-
per, you should input vertical and
horizontal dimensions. ⇒ p.16
“Placing Custom Size Originals”
The sizes that you can input are as
follows.

❒ The machine can automatically de-
tect the following sizes as standard
size copy paper.

❒ When copying on OHP transpar-
encies or paper heavier than 128
g/m2 (about 34 lb.), you need to
specify the paper type. ⇒ General
Settings Guide,“Paper Type”

❒ The maximum number of sheets
you can load at the same time de-
pends on the paper type. The max-
imum number of sheets should not
exceed the upper limit.

AAAA Open the bypass tray.

Metric 
version

• Vertical: 90.0 – 305.0mm

• Horizontal: 148.0 – 
457.2mm

Inch 
version

• Vertical: 3.55" – 12.00"

• Horizontal: 5.83" – 18.00”

Metric 
version

A3L, A4L, 8" × 13"L, A5L

Inch 
version

11" × 17"L, 81/2" × 11"L, 
51/2" × 81/2"L
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BBBB Insert the paper with the side you
want to copy facing down until
you hear the beep, and align the
paper guide to the paper size.

1. Extender

Note
❒ If the guides are not flush with

the copy paper, images might
be skewed or paper misfeed
might occur.

❒ Do not stack paper over the lim-
it  mark,  o therwise images
might be skewed or paper mis-
feed might occur.

❒ When you load the OHP trans-
parencies, check the front and
back of the sheets, and place
them correctly, or a misfeed
might occur. Set the paper di-
rection to K and select A4K,
81/2" × 11"K as paper size in
step C.

❒ Swing out the extender to sup-
port paper sizes larger than
A4L, 81/2" × 11"L.

❒ Fan paper to get air between the
sheets and avoid a multi-sheet
feed.

❒ When copying onto envelopes:
⇒ p.22 “When copying onto en-
velopes”.

CCCC Select the type and size of the pa-
per.

When copying onto standard size 
paper

A Press the {{{{#}}}} key.
B Press [Select Size].

C Select the paper size.

D Press [OK].

When copying onto custom size 
paper

Note
❒ Paper will be automatically de-

livered to the internal tray.
A Press the {{{{#}}}} key.

B Press [Custom Size].

C Press [Vertical inch], enter the
vertical size of the paper with
the number keys, and then
press [#].

D Enter the horizontal size of the
paper with the number keys,
and then press [#].

Note
❒ If [Horiz inch] is not highlight-

ed, press [Horiz inch].
❒ When vertical size more than

297.1mm (11.70"), horizontal
size more than 432.1mm
(17.01") is entered, the image
will be copied in the center of
the paper.
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❒ To register the custom size
entered, press [Program] and
then press [Exit].

E Press [OK].

When copying onto special paper

A Press the {{{{#}}}} key.

B Select paper type in "Special
paper".

C Press [OK].

When copying onto envelopes

Note
❒ When placing an original on the

exposure glass, place the origi-
nal with the bottom line aligned
to the left scale.

❒ When placing originals in the
document feeder, place the orig-
inals with the bottom line insert-
ed in the document feeder. 

❒ When loading envelopes, be
sure to unfold the flaps and po-
sition them opposite to the pa-
per feed direction.

Reference
For more information about
supported size of envelop, see
⇒  General Settings Guide,
“Recommended Paper Sizes
and Types”.

A Press the {{{{#}}}} key.

B Select the paper size, and then
select [Thick Paper] for the paper
type.

C Press [OK].

DDDD Place your originals, and then
press the {{{{Start}}}} key.

EEEE When your copy job is finished,
press the {{{{Clear Modes}}}} key to
clear the settings.
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When Copying on the Back 
Side of Paper

Using the Bypass Tray, you can make
copies on the back side of pages that
have already been copied on the front
side.

Note
❒ Do not use paper that has been

used in other copying machines or
printers. 

❒ Copies made on the back side of
paper should be originals that
have a low image area ratio, such
as text originals.

Copying and Placement Orientation of 
Originals and Paper

Pay close attention to the placement
orientation of paper and originals.

❖❖❖❖ Top to top

❖❖❖❖ Top to Bottom

AAAA Open the Bypass Tray, and then
adjust the guides to the paper
size.

BBBB Gently insert the copied paper
with the copied side face down
(the non-copied side face up) un-
til the beeper sounds.

CCCC Press the {{{{#}}}} key, and then select
the paper size.

DDDD In Special Paper, select [Plain:
Dup.Back] or [Thick: Dup.Back], and
then press [OK].

EEEE Place your originals, and then
press the {{{{Start}}}} key.

GGH33E

GGH44E

UranosC1-ENcopyA_F1_FM.book  Page 23  Friday, July 26, 2002  5:01 PM



Copying

24

2

Making A3, 11" ×××× 17" Full Bleed Copies

You can make A3, 11" × 17" full bleed copies with 12" × 18" paper. This is useful
for making A3, 11" × 17" size copies with a colored background (e.g. catalogues).

1. A3, 11" ×××× 17" size Original

2. In standard copy mode, margins
appear on copies

3. 12" ×××× 18" Full Bleed Copy

4. Cut around the margins to pro-
duce a full image

Note
❒ This function can be used with 12" × 18" paper.
❒ When A3, 11" × 17" full bleed copying is made, the original image is copied

onto the center.
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Color Functions

Selecting a Color Mode

Select a Color mode that best suits
your originals and copying require-
ments.

Reference
For color images ⇒ p.i “What You
Can Do With This Machine <Color
Functions/Color Adjustments>” 

The following basic functions are ex-
plained in this section.

❖❖❖❖ Auto Color Select
Judges the color of the original au-
tomatically, and copies either in
full color or black/white.

❖❖❖❖ Full Color Copy
Copies by overlaying yellow, ma-
genta, cyan and black.

❖❖❖❖ Black/White Copy
Copies in black regardless of the
color of the original.

❖❖❖❖ Single Color Copy
Copies in one designated color.

Note
❒ Yellow, magenta and cyan will

be copied with one toner color,
but beige, orange, red, light
green, pink, green, marine blue,
blue and purple uses 2 toner
colors to copy.

❖❖❖❖ Two Color Copy
• Two Color Copy (Normal)

Copies black and other parts in
two specified colors.

Note
❒ You can select from basic

colors, registered colors.

• Two Color Copy (Red & black)
Copies the red part in red, and all
the other parts in black or white.

Note
❒ When the width of the color

is set to “Wider”, colors close
to orange and purple will be
recognized as red. This ad-
justment will be valid in
“Erasing Designated Colors”
and “Color Change” .  ⇒
p.106 “Color Sensitivity” 

AAAA Select the type of color, then press
the key.

When the {{{{Single Color}}}} key is 
selected

AAAA Select designation method of
color ( [Basic Color], [User Color] ).

BBBB Select the color, and then press
[OK].

Note
❒ When copied using the regis-

tered color, the original will be
copied lighter than the regis-
tered color.

❒ Press [Lighter] or [Darker], and you
can adjust the density in 4 steps.
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When the {{{{Two-color}}}} key is 
selected

AAAA Select either [Two Color] or [Red &
Black].

When [Red & Black] is pressed

A Press [OK].

When [Two Color] is pressed

A Press [Change Color Setting].

B Press [Black Portion], and then
select the color to be replaced
by black.

Note
❒ When selecting a color from

the user colors, press [User
Color].

C Press [Non-black Portion], and
then select the color to replace
the black color of the original.

D Press [OK].

Convert Colors

Copies by changing the color in the
original to a different color.

Note
❒ It is possible to specify up to 4

colors.
❒ The width of the color to be con-

verted can be adjusted in 5 levels.
If the color width is set to “Wider”
and red has been specified, colors,
which are close to magenta or or-
ange, will also be converted. The
color width can be adjusted in the
“User Tools”. ⇒ p.106 “Color Sen-
sitivity” 

AAAA Press the {{{{Full Color}}}} key.

BBBB Press [Edit/Color Creation].

CCCC Press [Color Creation].

DDDD Press [Convert Color].

EEEE Select the color to be converted.

FFFF Select the new color to be converted.

Note
❒ You can adjust the density of

each color in 4 levels, excluding
white. 

❒ When you want to change the
converted color, press from
[Conversion 1] to [Conversion 4]
and make the selection again. 

❒ When changing between more than
two colors, repeat steps D and E.
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Selecting from [User Color] 

A Press [User Color].
B Select from the registered

colors, then press [OK].

GGGG After selecting all the colors to be
converted, press [OK].

HHHH Set the original, and then press
the {{{{Start}}}} key.

Erase Color

You can copy by erasing a certain
color in the image of the original.

Note
❒ It is possible to select up to 4 colors.
❒ You can adjust the range of the

color to be deleted in 5 levels. If the
color range is set to “Wider” and
red is specified, magenta and or-
ange may also be deleted. The
color range can be adjusted in the
“User Tools”. ⇒ p.106 “Color Sen-
sitivity” 

AAAA Press [Edit/Color Creation]. 

BBBB Press [Color Creation]. 

CCCC Press [Erase Color].

DDDD Select the color to be erased.

Note
❒ You can cancel the selection by

pressing the selected (highlight-
ed) key.

❒ You can erase 4 colors at once.

EEEE Press [OK] after selecting all the
colors to be deleted.

FFFF Set the originals, and then press
the {{{{Start}}}} key.

Color Background

Copies by adding a color in the whole
page.

Note
❒ Since the Color Background func-

tion overprints the entire original,
the color of the image may change.

AAAA Press [Edit/Color Creation].

BBBB Press [Color Creation].

CCCC Press [Color Background].

DDDD Select the background color, then
press [OK].

Note
❒ You can adjust the density of

each color in 4 levels. 
❒ You can cancel the selection by

pressing the selected (highlight-
ed) key. 
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Selecting from the [User Color] 

A Press [User Color].
B Select a registered color, and

then press [OK].

EEEE Set the original, and then press
the {{{{Start}}}} key.
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Copy Functions

Adjusting Copy Image Density

There are three types of adjustment
available:

❖❖❖❖  Auto Image Density 
The machine automatically adjusts
the image density.

❖❖❖❖ Manual image density
You can adjust the density of the
overall original in 9 steps.

❖❖❖❖ Combined auto and manual image
density
Use when copying originals with a
dirty background (such as news-
papers). You can adjust the fore-
ground density while leaving the
background unchanged.

Auto image density

AAAA Make sure that [Auto Image Density]
is selected.

Manual image density

AAAA Press [Auto Image Density] to cancel
it.

BBBB Press [Lighter] or [Darker] to adjust
the image density.

Combined auto and manual image 
density

AAAA Make sure that [Auto Image Density]
is selected.

BBBB Press [Lighter] or [Darker] to adjust
the density.
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Selecting Original Type 
Setting

Select one of the following 6 types to
match your originals:

❖❖❖❖ Text 
Select this mode when your origi-
nals contain only text (no pictures).

❖❖❖❖ Text/Photo 
Select Text/Photo when your orig-
inals contain photographs or pic-
tures with text.

❖❖❖❖ Photo 
Delicate tones of photographs and
pictures can be reproduced with
this mode.

Note
❒ If you select "Text/Photo" or

"Photo" as the original type, se-
lect the photo type from among
the three options below:
• Glossy Photo

Use when copying devel-
oped photographs.

• Printed Photo
Use when copying photo-
graphs or pictures that are
printed on paper (e.g. maga-
zines).

• Copied Photo
Use when copying copies or
originals generated by print-
ers.

❖❖❖❖ Map
Scanning with settings suitable for
Map originals. "Others" is dis-
played when "Original Type Dis-
play" (copy/document server box
initial settings) has been set to
"Display".

❖❖❖❖ Pale 
Select this mode for originals that
have lighter lines written in pencil,
or for faint copied slips. The faint
lines will be clearly copied.

❖❖❖❖ Generation Copy 
If your originals are copies (gener-
ation copies), the copy image can
be reproduced sharply and clearly.

Reference
⇒ p.9 “Sizes difficult to detect” 

AAAA Press the appropriate key to select
the original type.

When the original type keys are 
not displayed

A Press [Original Type].

B Select the original type, and
then press [OK].
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Selecting Copy Paper

There are two ways to select copy paper:

❖❖❖❖ Auto Paper Select 
The machine selects a suitable size of copy paper automatically based on the
original size and the reproduction ratio.

❖❖❖❖ Manual Paper Select
Choose the tray containing the paper you wish to copy onto: a paper tray, by-
pass tray or large capacity tray (LCT).

Reference
⇒ p.9 “Sizes difficult to detect” 

Note
❒ See the following table for copy paper sizes and directions that can be used

with Auto Paper Select (when copying at a ratio of 100%).

❖❖❖❖ Metric version

❖❖❖❖ Inch version

❒ Only the paper trays set to "No display" or "Recycled paper" in "Paper Type"
and also set to "Yes" in "Apply Auto Paper Select" can be selected in Auto Pa-
per Select mode.⇒ "Paper Size Settings" in the General Settings Guide

Where Original Is Placed Paper Size and Direction

Exposure glass A3L, B4L, A4KL, B5KL, 81/2" × 13"L 

Document feeder A3L, B4L, A4KL, B5KL, A5KL, 81/2" × 13"L

Where Original Is Placed Paper Size and Direction

Exposure glass 11" × 17"L, 81/2" × 14"L, 81/2" × 11"KL

Document feeder 11" × 17"L, 81/2" × 14"L, 81/2" × 11"KL, 10" × 14"L, 
51/2" × 81/2"KL
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Auto Paper Select

AAAA Make sure that [Auto Paper Select] is selected.

Note
❒ Trays with a key mark will not be automatically selected. ⇒ "Paper Size

Settings" in the General Settings Guide

Manual Paper Select

AAAA Select the paper tray, bypass tray or large capacity tray (LCT).
The indicator corresponding to the selected paper tray is highlighted.

Reference
⇒ p.20 “Copying from the Bypass Tray” 

When the paper type keys are not displayed

A Press [Auto Paper Select].
B Select the type of paper.
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----Rotated copy
If the direction in which your original is placed (L or K) is different from that
of the paper you are copying onto, this function rotates the original image by 90°
and fits it on the copy paper. This function works when Auto Paper Select or
Auto Reduce/Enlarge is selected. ⇒ p.31 “Auto Paper Select” 

Note
❒ The default setting for "Auto Tray Switching" is "With image rotation". You

cannot use the Rotated Copy function if this setting is changed to "Without
image rotation" or "Off". ⇒ p.31 “Selecting Copy Paper”, ⇒ p.36 “Auto Re-
duce/Enlarge” 

❒ You cannot use the Rotated Copy function when enlarging onto A3, B4 or 11"
× 17", 81/2" × 14" size paper. In this case, place your original in the L direc-
tion.

❒ You cannot use the Rotated Copy function when "Left 2" or "Top 2" is selected
for stapling when using the 1000-sheet finisher. ⇒ p.43 “Staple” 

❒ You cannot use the Rotate Copy function if the Staple function is selected
when using the 500-sheet finisher.

Original Size and Direction Copy Paper Size and Direc-
tion

You cannot 
rotate:

A4, 
B5, or 
A5

K

When enlarg-
ing to →

B4, A3

However, you 
can use:

A4, 
B5, or 
A5

L

When enlarg-
ing to →

B4, A3

R

R

GCROTA1E

R

GCROTA2E

R

GCROTA3E

R
GCROTA4E

R
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Preset Reduce/Enlarge

You can select a preset ratio for copy-
ing.

❖❖❖❖ Base Point
The base point of Reduce/Enlarge
differs depending on how the orig-
inal is scanned. When the Original
is set on the exposure glass, the up-
per left corner will be the base
point. When it is set to the docu-
ment feeder, the bottom left corner
of the original will be the base
point.

1. Base point when setting on the ex-
posure glass.

2. Base point when setting on the
document feeder.

Reference
Related Initial Settings
⇒ p.99 “Copy Function Key: F1-
F5” 
⇒ p.100 “R/E Priority” 

Note
❒ When making reduced copies from

A3 or B4 originals to A4 OHP trans-
parencies, set the OHP transparen-
cies in tray 1 in the K direction and
use the Auto Reduce/Enlarge
funct ion.  ⇒  p .36  “Au to  Re -
duce/Enlarge” 

AAAA Press [Reduce/Enlarge].

Note
❒ To select a preset ratio on the in-

itial display, press the shortcut
reduce/enlarge key and go to
step D.

BBBB Press [Enlarge] or [Reduce].

CCCC Select a ratio, and then press [OK].

DDDD Place your originals, and then
press the {{{{Start}}}} key.
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----Create Margin Mode
Use "Create Margin" to reduce the im-
age to 93% of its original size with the
center as reference. You can register
this function in a shortcut key on the
initial display. By combining it with
the Reduce/Enlarge function, you
can also provide the Reduce/Enlarge
copy with a margin.

Reference
Related Initial Settings
⇒ p.99 “Copy Function Key: F1-
F5” 
⇒ p.100 “Ratio for Create Margin” 

A Press [Create Margin] displayed on
the initial display.

B If you do not wish to combine it
with the Reduce/Enlarge function,
place your originals, and then
press the {{{{Start}}}} key.

Zoom

You can change the reproduction ra-
tio in 1% steps.

Note
❒ You can select a preset ratio which

is near the desired ratio, then ad-
just the ratio with [nnnn] or [oooo].

AAAA Press [Reduce/Enlarge].

BBBB Enter the ratio.

To select the ratio with [nnnn] and 
[oooo] 

A Select a preset ratio which is
close to the desired ratio by us-
ing [Reduce] or [Enlarge].

B Adjust the ratios with [nnnn] or
[oooo].
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Note
❒ To change the ratio in 1%

steps, just press [nnnn] or [oooo].
To change the ratio in 10%
steps, press and hold down
[nnnn] or [oooo].

❒ If you have incorrectly en-
tered the ratio, readjust the
ratio with [nnnn] or [oooo].

To enter the ratio with the number 
keys

A Press [Mag. Ratio].
B Enter the desired ratio with the

number keys.

C Press [#].

D Press [OK].

CCCC Place your originals, and then
press the {{{{Start}}}} key.

Auto Reduce/Enlarge

The machine can choose an appropri-
ate reproduction ratio based on the
paper and original sizes you select.

Note
❒ You cannot use the bypass tray

with this function.
❒ When using Auto Reduce/En-

large, see the following table for
the original sizes and directions
you can use.

❖❖❖❖ Metric version

❖❖❖❖ Inch version

Reference
⇒ p.9 “Sizes difficult to detect” 

AAAA Press [Auto Reduce/Enlarge].

BBBB Select the paper tray.

CCCC Set the original, then press the
{{{{Start}}}} key.

Where Original Is 
Placed

Original Size and 
Direction

Exposure glass A3L, B4L, 
A4KL, B5KL, 
81/2" × 13"L

Document feeder A3L, B4L, 
A4KL, B5KL, 
A5KL, 81/2" × 
13"L

Where Original Is 
Placed

Original Size and 
Direction

Exposure glass 11" × 17"L, 81/2" × 
14"L, 81/2" × 11

Document feeder 11" × 17"L, 81/2" × 
14"L, 81/2" × 
11"KL, 10" × 
14"L, 51/2" × 
81/2"KL
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Size Magnification

This function calculates an enlarge-
ment or reduction ratio based upon
the lengths of the original and copy.

Note
❒ Measure and specify the lengths of

the original and copy by compar-
ing "A" with "a".

AAAA Press [Reduce/Enlarge].

BBBB Press [Specifd. Ratio].

CCCC Make sure that [Specifd. Ratio] is
highlighted.

DDDD Enter the length of the original
with the number keys, and then
press [#].

Note
❒ You can enter sizes within the

following ranges.

EEEE Enter the length of the copy with
the number keys, and then press
[#].

Note
❒ To change the length after

pressing [#], select [Original] or
[Copy] and enter the desired
length.

FFFF Press [OK].

GGGG Press [OK].

HHHH Place your original, and then
press the {{{{Start}}}} key.

Directional Magnification (%)

Copies can be reduced or enlarged at
different reproduction ratios horizon-
tally and vertically.

a. Horizontal ratio
b. Vertical ratio

Note
❒ You can also select a preset ratio

which is close to the desired ratio
by using [Reduce] or [Enlarge], then
adjust the ratio with [nnnn] or [oooo].

Metric 
version

1 – 999mm (in 1mm steps)

Inch 
version

0.1" – 99.9" (in 0.1" steps)

Ainch ainch

a%

b%
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AAAA Press [Reduce/Enlarge].

BBBB Press [Specifd. Ratio].

CCCC Press [Direct. Mag.%].

To enter the ratio with the number 
keys

A Press [Horizontal].
B Enter the desired ratio with the

number keys, followed by [#].

C Press [Vertical].

D Enter the desired ratio with the
number keys, followed by [#].

E Press [OK].

To specify a ratio with [nnnn] and 
[oooo] 

A Press [With nnnnoooo].

B Press [Horizontal].
C Adjust the ratio using [nnnn] or

[oooo].

Note
❒ Pressing [nnnn] or [oooo] changes

the ratio in 1% steps. Press-
ing and holding down [nnnn] or
[oooo] changes it in 10% steps.

❒ If you have incorrectly en-
tered the ratio, readjust the
ratio with [nnnn] or [oooo].

D Press [Vertical].

E Adjust the ratio with [nnnn] or
[oooo].

F Press [OK].

DDDD Press [OK].

EEEE Place your originals, and then
press the {{{{Start}}}} key.

Directional Size Magnification 
(inch)

The suitable reproduction ratios will
be automatically selected when you
enter the horizontal and vertical
lengths of the original and copy im-
age you require.

1. Horizontal original size

2. Vertical original size

3. Horizontal copy size

4. Vertical copy size

Note
❒ Specify the vertical and horizontal

sizes of the original and those of
the copy, as shown in the illustra-
tion.

❒ You can enter sizes within the fol-
lowing ranges.

Metric 
version

Vertical: 1 – 999mm (in 1mm 
steps) 

Horizontal: 1 – 9999 (in 1mm 
steps) 

Inch 
version

0.1" – 99.9" (in 0.1" steps)
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AAAA Press [Reduce/Enlarge].

BBBB Press [Specifd. Ratio].

CCCC Press [Dirc.Size Mag.In].

DDDD Enter the horizontal size of the
original with the number keys,
and then press [#].

EEEE Enter the horizontal size of the
copy with the number keys, and
then press [#].

FFFF Enter the vertical size of the origi-
nal with the number keys, and
then press [#].

GGGG Enter the vertical size of the copy
with the number keys, and then
press [#].

Note
❒ To change a length, press the

key you wish to change and en-
ter the new value.

HHHH Press [OK].

IIII Press [OK].

JJJJ Place your originals, and then
press the {{{{Start}}}} key.

Sort

The machine can scan your originals
into memory and automatically sort
the copies.

Reference
Related Initial Settings
⇒ p.106 “Select Stack Function” 
⇒ p.105 “Memory Full Auto Scan
Restart”
⇒ p.105 “Rotate Sort: Auto Paper
Continue” 
⇒ p.98 “Auto Tray Switching” 

❖❖❖❖ Sort 
Copies are assembled as sets in se-
quential order.

Note
❒ To confirm the paper sizes that

can be used in the Sort function
⇒  p.110 “Sort, Rotate Sort,
Stack”. 

❖❖❖❖ Rotate Sort 
Every other copy set is rotated by
90°KL and delivered to the copy
tray.

2
1

3 2
1

3 2
1

3 2
1

3

2
1

3 2
1

3 2
1

32
1

3
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Note
❒ The paper sizes that can be used

in the Rotate Sort function are as
follows.

❒ To use the Rotate Sort function,
two paper trays with paper
identical in size and different in
direction (KL) are required.

❒ This function can be used only
when optional finisher is not in-
stalled.

❖❖❖❖ Shift Sort
• The optional 500-Sheet Finisher,

1000-Sheet Finisher or Shift Sort
Tray is required to use this func-
tion.
Each time the copies of one set
or those of each job are deliv-
ered, the next copy is shifted
when delivered so that you can
differentiate each set or job. If
the shift sort tray is installed, it
provides this function by slid-
ing from side to side.

AAAA Press [Sort] or [Rotate Sort].

❖❖❖❖ When a finisher is not installed

❖❖❖❖ When the 500-Sheet Finisher is 
installed

❖❖❖❖ When the 1000-Sheet Finisher is 
installed

Note
❒ When the optional finisher is in-

stalled, use the User Tools to
display [Rotate Sort]. ⇒ p.106
“Select Stack Function” 

BBBB Enter the number of copy sets
with the number keys.

Note
❒ The maximum number of sets is

100.
❒ To confirm the type of finishing,

press the {{{{Sample Copy}}}} key. ⇒
p.41 “Sample Copy” 

Metric version A4, B5

Inch version 81/2" × 11", 51/2" 
× 81/2"

2
1

3

32
1

32
1

32
1
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CCCC Place your originals.

Note
❒ When placing an original on the

exposure glass, start with the
first page to be copied. When
placing an original in the docu-
ment feeder (ADF), set so that
the first page is on the top.

❒ After scanning the entire origi-
nal from the exposure glass or
through the document feeder,
press [#]. 

DDDD Press the {{{{Start}}}} key.

Sample Copy

Use this function to check the copy
settings before making a long copy
run.

Note
❒ This function can be used only

when the Sort function has been
turned on.

AAAA Select Sort and any other func-
tions, and then place the origi-
nals.

BBBB Press the {{{{Sample Copy}}}} key. 

One copy set is delivered as a sample.

CCCC If the sample is acceptable, press
[Print]. 

The number of copies made is the
number you specified, minus one
for the proof copy.

Note
❒ If you press [Suspend] after

checking the results, return to
step A to adjust the copy set-
tings as necessary. You can
change the settings for Staple,
Duplex, Copy Orientation,
Stamp, Margin Adjust., and
Cover/Slip Sheet. However, de-
pending on the combination of
functions, you may not be able
to change some settings.

Changing the Number of Sets

You can change the number of copy
sets during copying.

Note
❒ This function can only be used

when the Sort function has been
turned on.

AAAA While "Copying" is displayed,
press the {{{{Clear/Stop}}}} key.

BBBB Press [Change Quantity].

CCCC Enter the number of copy sets
with the number keys, and then
press the {{{{#}}}} key.

Note
❒ The number of sets you can en-

ter differs depending on when
the {{{{Clear/Stop}}}} key is pressed.

DDDD Press [Continue].

Copying starts again.
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Stack

Copies can be assembled with each
page placed.

❖❖❖❖ Shift Stack
• The optional 500-Sheet finisher,

1000-Sheet Finisher or Shift Sort
Tray is required to use this func-
tion.
This function groups copies of
each page in a multi-page origi-
nal together. Every other page
stack is shifted for ease of sepa-
ration. If shift sort tray is in-
stalled, it provides this function
by sliding from side to side.

AAAA Press [Stack].

BBBB Enter the number of copies with
the number keys.

CCCC Place your originals, then press
the {{{{Start}}}} key.

Note
❒ When placing an original on the

exposure glass, start with the
first page to be copied. When
placing an original in the docu-
ment feeder (ADF), set so that
the last page is on the bottom.

❒ When placing an original on the
exposure glass or in the docu-
ment feeder (ADF) using batch
mode, press the {{{{#}}}} key after all
t h e  o r ig in a l s  ha ve  b e e n
scanned.

2
1

3

33
3

22
2

11
1
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Staple

An optional finisher and the bridge unit are required to use this function.

Each copy set can be stapled together.

Note
❒ You cannot use the Bypass Tray with this function.

Stapling position and original setting

Place all the originals in the automatic document feeder (ADF) in the orientation
in which they can be read normally. When placing the original on the exposure
glass, keep the same orientation, but set the original facing downwards. When
there is copy paper that is identical in size and orientation to your original, the
staple positions are as follows.

❖❖❖❖ 500-Sheet Finisher

Note
❒ Original images are not rotated.

Original location Stapling 
position

Exposure 
glass

Document 
Feeder

T
op

K

L
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❖❖❖❖ 1000-Sheet Finisher

*1 Not available for paper size larger than A4.

Original location Stapling 
position

Exposure 
glass

Document 
Feeder

T
op

K

L

B
ot

to
m

K

L

L
ef

t 2

K  *1 

L

T
op

 2

K

L  *1 
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AAAA Select one of the stapling positions.

❖❖❖❖ 500-Sheet Finisher

Note
❒ The stapling position will be fixed to “Top”.

❖❖❖❖ 1000-Sheet Finisher

Note
❒ When you select the stapling position, Sort mode is automatically selected.

Reference
⇒ p.43 “Stapling position and original setting” 

BBBB Enter the number of copy sets with the number keys.

CCCC Place your originals, then press the {{{{Start}}}} key.

Note
❒ When placing an original on the exposure glass, start with the first page to

be copied. When placing an original in the document feeder (ADF), set so
that the last page is on the bottom.

❒ When placing an original on the exposure glass or in the document feeder
(ADF) using batch mode, press the {{{{#}}}} key after all the originals have been
scanned.
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Duplex

There are two types of duplex.

❖❖❖❖ 1 Sided →→→→ 2 Sided
Copies two 1–side pages on one 2–
sided page.

❖❖❖❖ 2 Sided →→→→ 2 Sided
Copies one 2–sided page on one 2–
sided page.

❖❖❖❖ 2 Sided →→→→ 1 Sided
Copies each side of a 2–sided orig-
inal onto two separate pages.

Note
❒ You cannot use the bypass tray

with this function.
❒ The paper weight that can be used

with duplex copying is 64~105g/m2

(17~28 lb).

Original Direction and Completed Copies

The resulting copy image will differ
according to the direction in which
you place your original (widthwise
K or lengthwise L ).

*1 The table shows the orientation of im-
ages on the front and back of copies,
not the direction of delivery.

Reference
Related Initial Settings
⇒ p.101 “Front Margin: Left/Right” 
⇒ p.101 “Back Margin: Left/Right” 
⇒ p.101 “Front Margin: Top/Bot-
tom” 
⇒ p.101 “Back Margin: Top/Bot-
tom” 

1 2

2

1

1

2

1

2

GCRYOU1E
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AAAA Press [Dup./Combine/Series].

BBBB Select ([1 Sided]/[2 Sided]) for "Orig-
inal", and then press ([1 Sided]/[2
Sided]) for "Copy".

Note
❒ To change the copy orientation,

press [Orientation]. ⇒ p.47 “Orig-
inals and Copy Direction” 

CCCC Press [OK].

DDDD Place your originals, and then
press the {{{{Start}}}} key.

Note
❒ When placing an original on the

exposure glass, start with the
first page to be copied. When
placing an original in the docu-
ment feeder (ADF), set so that
the last page should be on the
bottom. 

❒ When placing an original on the
exposure glass or in the docu-
ment feeder (ADF) using batch
mode, press the {{{{#}}}} key after all
th e  o r ig in a l s  h a ve  b e en
scanned.

Originals and Copy Direction

You can select the orientation.
• Top to Top 

• Top to Bottom 

Note
❒ You can change the default orien-

tation with the User Tools. ⇒ p.99
“Copy Orientation in Duplex
Mode”, ⇒ p.99 “Original Orienta-
tion in Duplex Mode”, ⇒ p.99
“General Features 2/5” 

AAAA Press [Orientation] and then select
the orientation (Original/Copy).
Then press [OK].

Duplex1

Duplex2
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1 Sided Combine

Combine several pages on one side of
a sheet.

❖❖❖❖ 1 Sided 2 Pages →→→→ Combine 1 Side 
Copies two 1-sided originals to
one side of a sheet.

❖❖❖❖ 1 Sided 4 Pages →→→→ Combine 1 Side 
Copies four 1-sided originals to
one side of a sheet.

❖❖❖❖ 1 Sided 8 Pages →→→→ Combine 1 Side 
Copies eight 1-sided originals to
one side of a sheet.

❖❖❖❖ 2 Sided 1 Page →→→→ Combine 1 Side 
Copies one 2-sided original to one
side of a sheet.

❖❖❖❖ 2 Sided 2 Pages →→→→ Combine 1 Side 
Copies two 2-sided originals to
one side of a sheet.

❖❖❖❖ 2 Sided 4 Pages →→→→ Combine 1 Side 
Copies four 2–sided originals to
one side of a sheet.

❖❖❖❖ Orientation of the Original and Image
Position of Combine
Open to Left R Originals

Open to Top S Originals

❖❖❖❖ Placing Originals (Originals Placed in
the Document Feeder)
Originals read from left to right

Originals read from top to bottom

Reference
Related Initial Settings 
⇒ p.101 “Erase Original Shadow
in Combine” 
⇒ p.101 “Copy Order in Combine” 
⇒ p.103 “Separation Line in Com-
bine” 

AAAA Press [Dup./Combine/Series].

1 2 1 2

Combine5

3 4
1 2

4321

Combine6

34
124321
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BBBB Press ([1 Sided]/[2 Sided]) for "Orig-
inal", and then press [Combine 1
Side] for "Copy".

Reference
⇒ p.47 “Originals and Copy Di-
rection” 

CCCC Select the number of originals to
combine, and then press [OK].

DDDD Select the paper.

EEEE Press [OK].

FFFF Place your originals, and then
press the {{{{Start}}}} key.

2 Sided Combine

Combines various pages of originals
into one sheet with two sides.

❖❖❖❖ 1 Sided 4 Pages →→→→ Combine 2 Side 
Copies four 1-sided originals to
one sheet with two pages per side.

❖❖❖❖ 1 Sided 8 Pages →→→→ Combine 2 Side 
Copies eight 1-sided originals to
one sheet with four pages per side.

1. Front

2. Back

❖❖❖❖ 1 Sided 16 Pages →→→→ Combine 2 Side 
Copies sixteen 1-sided originals to
one sheet with eight pages per
side.

1. Front

2. Back

❖❖❖❖ 2 Sided 4 Pages →→→→ Combine 2 Side 
Copies two 2-sided originals to
one sheet with two pages per side.

4

3
2

1

3

21

4

1 2

3 4

GCSHVYAE

1 2
8

7

2

1

5 6

7 8

GCSHVY5E

1 2 3 4

5 6 7 8

2

1

2

1

16

15

9 10 11 12

13 14 15 16

4

3

2

1

3

21

4

UranosC1-ENcopyA_F1_FM.book  Page 49  Friday, July 26, 2002  5:01 PM



Copying

50

2

❖❖❖❖ 2 Sided 8 Pages →→→→ Combine 2 Side 
Copies four 2-sided originals to
one sheet with four pages per side.

1. Front

2. Back

❖❖❖❖ 2 Sided 16 Pages →→→→ Combine 2 Side 
Copies eight 2-sided originals to
one sheet with eight pages per
side.

1. Front

2. Back

Reference
Related initial settings
⇒ p.48 “Orientation of the Orig-
inal and Image Position of Com-
bine” 
⇒ p.101 “Erase Original Shad-
ow in Combine” 
⇒ p.101 “Copy Order in Com-
bine” 
⇒ p.103 “Separation Line in
Combine” 

AAAA Press [Dup./Combine/Series].

BBBB Press ([1 Sided]/[2 Sided]) for "Orig-
inal", and then press [Combine 2
Side] for "Copy".

Reference
⇒ p.47 “Originals and Copy Di-
rection” 

CCCC Select the number of originals to
combine, and then press [OK].

DDDD Select the paper.

EEEE Press [OK].

FFFF Place your originals, and then
press the {{{{Start}}}} key.

GCSHVY2E

1 2
8

7

6

5

4

3

2

1

5 6

7 8

1 2

3 4

GCSHVY6E

1 2 3 4

5 6 7 8

2

1

9 10 11 12

13 14 15 16

4

3

2

1

16

15

14

13
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Series Copies

You can use this function only when
you are making a copy from the Ex-
posure Glass.
Separately copies the front and back
of a 2–sided original or the two facing
pages of a bound original onto two
sheets.

❖❖❖❖ Book→→→→1 Sided 
You can make one-sided copies
from two facing pages of a bound
original (book).

❖❖❖❖ Book→→→→2 Sided 
Copies a two-page spread original
onto one sheet with one page per
side.

❖❖❖❖ Front&Back→→→→2 Sided 
Copies each two-page spread orig-
inal as it is onto both sides of a
sheet.

Note
❒ See the following table for orig-

inal and copy paper sizes when
using a 100% ratio.

❒ You can use this function only
when you are making a copy
from the Exposure Glass.

❖❖❖❖ Metric version

❖❖❖❖ Inch version

1 21 2

1 2 1

2

Original
Paper for 1–
sided copy

Paper for 2–
sided copy

A3L A4K × 2 
sheets

A4K × 1 
sheets 
(2–sided)

B4L B5K × 2 
sheets

B5K × 1 
sheets 
(2–sided)

A4L A5K × 2 
sheets

A5K × 1 
sheets 
(2–sided)

Original
Paper for 1–
sided copy

Paper for 2–
side copy

11" × 17"L 81/2" × 
11"K × 2 
sheets

81/2" × 
11"K × 1 
sheets 
(2 sided)

81/2" × 
11"L

51/2" × 
81/2"K × 2 
sheets

51/2" × 
11"K × 1 
sheets 
(2–sided)

1 2

3

1 2

3
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AAAA Press [Dup./Combine/Series].

BBBB Press [Series].

CCCC Select ([Book→→→→1 Sided]/[Book→→→→2
Sided]/[Front&Back→→→→2 Sided]) and
press [OK].

DDDD Press [OK].

EEEE Make sure that [Auto Paper Select]
is selected.

FFFF Place your originals on the expo-
sure glass, and then press the
{{{{Start}}}} key.

Note
❒ Press the {{{{#}}}} key after all origi-

nals have been scanned.

Image Repeat

The original image is copied repeat-
edly.

There are two types of designation
methods for Image Repeat.

❖❖❖❖ Whole Area Repeat
Repeatedly copies the entire im-
age.

❖❖❖❖ Specified Area Repeat
Repeatedly copies a specified por-
tion of the image. Decide the base
point of the area, specify the length
and the width, and then specify the
location of the area.

Reference
Related Initial Settings
⇒ p.102 “Double Copies Sepa-
ration Line” 

Whole Area Repeat

Note
❒ The number of repeated images

depends on the original size, copy
paper size, and reproduction ratio.
See the following table.

❖❖❖❖ Original: A5KKKK/Copy paper: A4KKKK 
or Original: A5LLLL/Copy paper 
A4LLLL

❖❖❖❖ Original: A5KKKK/Copy paper: A4LLLL 
or Original: A5LLLL/Copy paper 
A4KKKK

4 repeats (71%) 16 repeats (35%)

2 repeats 
(100%)

8 repeats 
(50%)

32 repeats 
(25%)

Repeat1 Repeat2

Repeat3 Repeat4 Repeat5
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AAAA Select the size of the copy paper
and the reproduction ratio.

BBBB Press [Edit/Color Creation].

CCCC Press [Edit Image].

DDDD Press [Image Repeat].

EEEE Confirm that [Whole Area] is select-
ed, then press [OK].

FFFF Press [OK].

GGGG Place your original, and then
press the {{{{Start}}}} key.

Specified Area Repeat

You can use this function only when
you are making a copy from the Ex-
posure Glass.

Note
❒ The base point X1, Y1, and the

length set by point X2, Y2 deter-
mines the area of an image repeat-
edly copied.

1. Set on the exposure glass

AAAA Specify the location of the area's
base point (X1, Y1), and its length
and width (X2, Y2).

Note
❒ You can set any value in the range

of X1: 0~412mm (0.8”~16.2”),
X2: 20~432mm (0.8”~17”), Y1:
0~277mm (0.8”~10.8”), and Y2:
20~297mm (0.8”~11.6”).

BBBB Select the size of the copy paper
and the reproduction ratio.

CCCC Press [Edit/Color Creation].

DDDD Press [Edit Image].

EEEE Press [Image Repeat].

FFFF Press [Specified Area].

GGGG Enter the length of [X1] with the
number keys, then press [#].

HHHH Enter the length of [Y1] with the
number keys, then press [#].

IIII Enter the length of [X2] with the
number keys, then press [#].

JJJJ Enter the length of the [Y2] by
number keys, then press [#].

KKKK Press [OK].

LLLL Press [OK].

MMMM Press [OK].

NNNN Place the original on the exposure
glass, and then press the {{{{Start}}}}
key.

UranosC1-ENcopyA_F1_FM.book  Page 53  Friday, July 26, 2002  5:01 PM



Copying

54

2

Double Copies

One original image is copied twice on
one copy as shown in the illustration.

Note
❒ You cannot use the bypass tray

with this function.
❒ See the following table for original

and copy paper sizes when using a
100% ratio.

❖❖❖❖ Metric version

❖❖❖❖ Inch version

❒ The originals of size A5L (51/2" ×
81/2"L) cannot be detected prop-
erly on the exposure glass. Be sure
to select the copy paper manually
or set the originals in the document
feeder.

Reference
Related Initial Settings
⇒ p.102 “Double Copies Separa-
tion Line” 

AAAA Press [Edit/Color Creation].

BBBB Press [Edit Image].

CCCC Press [Double Copies].

DDDD Press [OK].

EEEE Press [OK].

FFFF Select the paper.

GGGG Place your originals, and then
press the {{{{Start}}}} key.

Centering

You can make copies with the image
moved to the center of the copy paper.

Note
❒ You cannot use the bypass tray

with this function.
❒ The original sizes and directions

for centering are listed below.

❖❖❖❖ Metric version

Original Size and 
Direction

Copy Paper Size 
and Direction

A5L A4K

A4K A3L

A5K A4L

B5K B4L

Original Size and 
Direction

Copy Paper Size 
and Direction

51/2" × 81/2"L 81/2" × 11"K

51/2" × 81/2"K 81/2" × 11"L

81/2" × 11"K 11" × 17"L

Original 
placed on:

Original size and direction

Exposure 
glass

A3L, B4L, A4KL, 
B5KL, 81/2" × 13"L

Document 
feeder

A3L, B4L, A4KL, B5KL, 
A5KL, 81/2" × 13"L
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❖❖❖❖ Inch version

AAAA Select the paper.

BBBB Press [Edit/Color Creation].

CCCC Press [Edit Image].

DDDD Press [Centring].

EEEE Press [OK].

FFFF Press [OK].

GGGG Place your originals, and then
press the {{{{Start}}}} key.

Positive/Negative

If your original is black and white,
copy images are inverted.

Note
❒ If your original is black and white,

copy images are inverted. If your
original is color, the density, dark-
ness and brightness of each color
will be reversed and inverted to
complimentary colors. 

❒ If the {{{{Single Color}}}} key is selected,
copy images are copied in white
and specified colors. 

❒ If [Two Color] (normal) is selected,
the white part of the original be-
comes black and the black part be-
comes white, and the colored part
is copied with the specified color. 

❒ If [Red & Black] is selected, the
white part of the original becomes
black, and the black part becomes
white, but the red part is copied as
red color.

Original 
placed on:

Original size and direction

Exposure 
glass

11" × 17"L, 81/2" × 14"L, 
81/2" × 11"KL

Document 
feeder

11" × 17"L, 81/2" × 14"L, 
81/2" × 11"KL, 10" × 14"L, 
51/2" × 81/2"KL

GCHATN1E

R R
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AAAA Press [Edit/Color Creation].

BBBB Press [Edit Image].

CCCC Press [Positive/Negative].

DDDD Press [OK].

EEEE Press [OK].

FFFF Select the paper.

GGGG Place your originals, and then
press the {{{{Start}}}} key.

Mirror

Copies by reversing the image from
left to right, as reflected in a mirror.

Note
❒ Copy results may differ depending

on the set orientation of the origi-
nals. 

AAAA Press [Edit/Color Creation]. 

BBBB Press [Edit Image]. 

CCCC Press [Mirror Image]. 

DDDD Press [OK]. 

EEEE Place the original, then press the
{{{{Start}}}} key.

Margin Adjustment

You can shift the image to the left,
right, top or bottom to make a bind-
ing margin.

Reference
Related Initial Settings 
⇒ p.101 “Front Margin: Left/Right” 
⇒ p.101 “Back Margin: Left/Right” 
⇒ p.101 “Front Margin: Top/Bot-
tom” 
⇒ p.101 “Back Margin: Top/Bot-
tom” 
⇒ p.101 “1 Sided→2 Sided Auto
Margin: TtoT” 

Note
❒ You can change the width of the

binding margin as follows.

Metric 
version

0 – 30mm (in 1mm steps)

Inch 
version

0" – 1.2" (in 0.1" steps)

A A
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AAAA Press [Edit/Color Creation].

BBBB Press [Erase/Margin Adj.].

CCCC Press [Margin Adjustment].

DDDD Set a binding margin for a front
page. Press [←←←←] and [→→→→] when set-
ting the left and right margins,
and [↓↓↓↓] and [↑↑↑↑] when setting the
top and bottom margins.

Note
❒ To change the value entered,

press [←←←←], [→→→→], [↓↓↓↓], [↑↑↑↑] to set the
new value.

❒ If you do not need to specify the
margins for the back side pages,
press [OK] and go to step F.

EEEE Set a binding margin for the back
side pages. Press [←←←←] and [→→→→]
when setting the left and right
margins, and [↓↓↓↓] and [↑↑↑↑] when
setting the top and bottom mar-
gins. Then press [OK].

Note
❒ Margin on the back side of the

page is valid only when [Duplex]
or [Duplex] of Combine is select-
ed.

FFFF Press [OK].

GGGG Press [OK].

HHHH Place your originals, and then
press the {{{{Start}}}} key.

Erase

This function erases the center
and/or all four sides of the original
image.
This function has the following three
types:

❖❖❖❖ Border 
This mode erases the edge margin
of the original image.

❖❖❖❖ Center 
This mode erases the center mar-
gin of the original image.
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❖❖❖❖ Center/Border 
This mode erases both the center
and edge margins of the original
image.

Reference
The erase width is set to 10mm
(0.4”) at default settings. You
can change this settings with the
User Tools. 
⇒ p.101 “Erase Center Width” 
⇒ p.101 “Erase Border Width” 

Note
❒ The relationship between the orig-

inal orientation and the erased part
is as follows:

1: Erased part
2: 2–99mm

Border Erase

AAAA Press [Edit/Color Creation].

BBBB Press [Erase/Margin Adj.].

CCCC Press [Erase].

DDDD Set the erase border width.

Selecting [Same Width] 

A Press [Same Width].

B Set an erase border width with
[nnnn] and [oooo].

Note
❒ To change the value entered,

press [nnnn] and [oooo] to set the
new value.

C Press [OK].

L original K original

1

1

2
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Selecting [Diff. Width] 

A Press [Diff. Width].

B Press the key for the border
you wish to change and set an
erase border width with [nnnn]
and [oooo].

C Press [OK].

EEEE Press [OK].

FFFF Place your originals, and then
press the {{{{Start}}}} key.

Center Erase

AAAA Press [Edit/Color Creation].

BBBB Press [Erase/Margin Adj.].

CCCC Press [Erase].

DDDD Press [Center].

EEEE Set the erase center width with
[nnnn] and [oooo], and then press [OK].

FFFF Press [OK].

GGGG Place your originals, and then
press the {{{{Start}}}} key.

Center/Border Erase

AAAA Press [Edit/Color Creation].

BBBB Press [Erase/Margin Adj.].

CCCC Press [Erase].

DDDD Press [Center/Border].

EEEE Set the border to be erased.

Selecting [Same Width] 

A Press [Same Width].
B Press [Center], and then set the

erase center width with [nnnn]
and [oooo].

C Press [Border], and then set the
erase border width with [nnnn]
and [oooo].

D Press [OK].

Selecting [Diff. Width] 

A Press [Diff. Width].

B Press the key for the part you wish
to change, and then set an erase
margin width with [nnnn] and [oooo].

C Press [OK].
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FFFF Press [OK].

GGGG Place your originals, and then
press the {{{{Start}}}} key.

Preset Stamp

Messages that you use frequently can
be stored in the machine's memory
and stamped on copies.

One of the following eight messages
can be stamped on copies with a
frame around it: "COPY", "URGENT",
"PRIORITY", "For Your Info.", "PRE-
LIMINARY", "For Internal Use Only",
"CONFIDENTIAL", "DRAFT".

Stamp Position and Original Direction

Note
❒ You cannot use the bypass tray

with this function.
❒ Only one message can be stamped

at a time.
❒ When you select Full Color, the

Full Color counter starts from “1”.
❒ The default stamp color is red.

Reference
⇒ p.103 “Stamp Language” 
⇒ p.103 “Stamp Position” 
⇒ p.103 “Stamp Format :” 
⇒ p.103 “Stamp Color” 

AAAA Press [Edit/Color Creation].

GCSTMP5E
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BBBB Press [Stamp].

CCCC Press [Preset Stamp].

DDDD Select the desired message.

EEEE Press [All Pages] or [1st Page only] to
select the print page.

Note
❒ You can change the color, posi-

tion, size, and density of the
stamp. ⇒ p.61 “Changing the
stamp color” ⇒ p.61 “Changing
the stamp position, size and
density” 

FFFF After you specify all the desired
settings, press [OK].

GGGG Press [OK].

HHHH Place your originals, and then
press the {{{{Start}}}} key.

Changing the stamp color

AAAA Press [Stamp Color]. 

BBBB Select the stamp color, then press
[OK].

Changing the stamp position, size and 
density

AAAA Press [Change].

BBBB Select the position for print, size
and density, then press [OK].

User Stamp

Copies with the registered stamp.

Note
❒ Full color originals can only be

read in single color.

Stamp position and original orientation

Note
❒ You cannot use the bypass tray

with this function.
❒ Only one message can be stamped

at a time.
❒ The default stamp color is black.

GCSTMP6E
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Reference
Related Initial Settings
⇒ p.104 “Stamp Position 1 - 4” 
⇒ p.104 “Stamp Format 1 - 4” 
⇒ p.104 “Stamp Color : 1 - 4” 

AAAA Register a user stamp.

Reference
⇒ p.62 “To program the user
stamp” 

BBBB Press [Edit/Color Creation].

CCCC Press [Stamp].

DDDD Press [User Stamp].

EEEE Select the stamp you require.

FFFF Press [All Pages] or [1st Page only] to
select the print page.

Note
❒ You can change the stamp color

and position. ⇒ p.62 “Changing
the stamp color” ⇒ p.62 “To
change the stamp position” 

GGGG After making all settings, press
[OK]. 

HHHH Press [OK]. 

IIII Set the original, then press the
{{{{Start}}}} key.

Changing the stamp color

AAAA Press [Stamp Color]. 

BBBB Select the stamp color, then press
[OK].

To change the stamp position

AAAA Press [Change]. 

BBBB Select the desired position, and
then press [OK]. 

To program the user stamp

Note
❒ The range of stamp images for

readability is 10-297mm high (0.4"-
11.7") and 10-432mm (0.4"-17")
wide.

❒ Up to four images that you use fre-
quently can be stored in the ma-
chine's memory.

AAAA Make sure that the machine is in
Copy mode.
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BBBB Press the {{{{User Tools/Counter}}}} key.

CCCC Press [Copier/Document Server Fea-
tures].
The main menu of  the Copi-
er/Document Server Features ap-
pears.

DDDD Press [Stamp].

EEEE Press [User Stamp].

FFFF Press [Program/Delete Stamp].

GGGG Press [Program] and press the
stamp number (1–4) you want to
program.

Note
❒ Stamp numbers with m already

have settings in them.
❒ If the stamp number is already

being used, the machine will
ask you if you wish to overwrite
it — Press [Yes] or [No].

HHHH Enter the user stamp name with
the letter keys on the display pan-
el. You can register up to 10 char-
acters.

IIII Press [OK].

Reference
⇒“Entering Text Characters” in
the General Settings Guide

JJJJ Enter the horizontal size of the
stamp with the number keys, and
then press [#].

Note
❒ You can enter sizes within the

horizontal range of 10 – 432mm,
1.0" – 17.0", and the vertical
range of 10 – 297mm, 1.0" –
11.7". However, if the area ex-
ceeds the maximum value
(5,000mm2, 7.75 inch2), it is cor-
rected to within the acceptable
range automatically.

KKKK Press [Vertical], and then enter the
vertical size in the same way as
step JJJJ.

LLLL Place the user stamp on the expo-
sure glass, and then press [Start
Scanning].
The original will be scanned, and
the stamp will be registered. 

Note
❒ Originals cannot be scanned

from the document feeder when
programming the user stamp.

MMMM Press [Exit].

NNNN Press [Exit]. 

The display returns to the main
menu of the Copier/Document
Server Features.

OOOO Press [Exit].

Exits the settings and will become
ready to copy.
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To delete the user stamp

Important
❒ You cannot restore a deleted

stamp.

AAAA Make sure that the machine is in
Copy mode.

BBBB Press the {{{{User Tools/Counter}}}} key.

CCCC Press [Copier/Document Server].

DDDD Press [Stamp].

EEEE Press [User Stamp].

FFFF Press [Program/Delete Stamp].

GGGG Press [Delete], then press the
stamp number (1–4) you want to
delete.

HHHH Select [Delete].

IIII Press [Exit].

The display returns to the main
menu of the Copier/Document
Server Features.

JJJJ Press [Exit].
Exits the settings and will become
ready to copy.

Date Stamp

You can select from the following
styles.

You can select from the following
styles.
• MM/DD/YYYY
• MM.DD.YYYY
• DD/MM/YYYY
• DD.MM.YYYY
• YYYY.MM.DD

Stamp position and original orientation

GCSTMP7E
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Note
❒ You cannot use the bypass tray

with this function.

Reference
Related Initial Settings
⇒ p.104 “Font” 
⇒ p.104 “Size” 
⇒ p.104 “Superimpose” 
⇒ p.104 “Stamp Position” 
⇒ p.104 “Stamp Color” 
⇒ General Settings Guide “Timer
Setting”

AAAA Press [Edit/Color Creation].

BBBB Press [Stamp].

CCCC Press [Date Stamp].

DDDD Press [All Pages] or [1st Page only] to
select the print page.

Note
❒ You can change the color, font

and position of the date to be
stamped. ⇒ p.65 “Changing the
stamp color” ⇒ p.65 “To change
the style of date” 

EEEE After all the settings are complete,
press [OK].

FFFF Press [OK].

GGGG Set the original, then press the
{{{{Start}}}} key.

Changing the stamp color

AAAA Press [Stamp Color].

BBBB Select the stamp color, then press
[OK].

To change the style of date

AAAA Press [Change Format].

BBBB Select the date format, and then
press [OK].

To change the stamp position

AAAA Press [Change].

BBBB Select the desired Date Stamp po-
sition, and then press [OK]. 
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Page Numbering

Use this function to print page num-
bers on your copies.

There are six types of Page Number-
ing (n is the total number of pages in
your original):
• P1,P2,…Pn
• 1/n,2/n,...n/n
• -1-,-2-,...-n-
• P.1,P.2,...P.n
• 1, 2…n
• 1-1,1-2,..1-n

Stamp position and original orientation

Note
❒ You cannot use the bypass tray

with this function.
❒ The default stamp color is black.

Reference
Related Initial Settings 
⇒ p.104 “Font” 
⇒ p.104 “Size” 
⇒ p.105 “Superimpose” 
⇒ p.104 “Stamp Format” 
⇒  p .104  “Duplex Back Page
Stamping Position” 
⇒ p.105 “Stamp Position” 
⇒ p.105 “Stamp on Designated
Slip Sheet” 
⇒ p.105 “Stamp Color” 

GCSTMP8E
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AAAA Press [Edit/Color Creation].

BBBB Press [Stamp].

CCCC Press [Page Numbering].

DDDD Select the format.

Note
❒ You can specify the stamp color,

stamp position, pages to be
stamped, and numbering. ⇒
p.67 “Changing the stamp
color” ⇒ p.67 “Changing the
stamp position” ⇒ p.67 “Speci-
fy the first printing page and
start number” 

EEEE After you specify all the desired
settings, press [OK].

FFFF Press [OK].

GGGG Set the originals, then press the
{{{{Start}}}} key.

Changing the stamp color

AAAA Press [Stamp Color].

BBBB Select the stamp color, then press
[OK].

Changing the stamp position

AAAA Press [Change].

BBBB Select the desired position, and
then press [OK].

Specify the first printing page and start 
number

If you selected (P1,P2…, -1-,-2-…, 
P.1, P.2…, 1, 2…, )

Note
❒ Below explains the example when

(P1, P2...) is selected. The steps are
the same for /other cases.

AAAA Press the right [Change].

BBBB Press [First Printing Page], and then
enter the original sheet number
from which to start numbering
with the number keys.

Note
❒ To change the number entered,

press [Clear] or the {{{{Clear/Stop}}}}
key,  and then enter  a  new
number.

CCCC Press the {{{{#}}}} key.

DDDD Press [Numbering from/to], and then
enter the number from which to
start numbering with the number
keys, then press the {{{{#}}}} key.
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EEEE Press [Last Number], and then enter
the page number at which to stop
numbering with the number
keys, then press the {{{{#}}}} key.

Note
❒ If you wish to print onto the last

page, press [to the end].

FFFF When all the page designation is
complete, press [OK].

GGGG Press [OK].

If you selected (1/5, 2/5…)

AAAA Press the right [Change].

BBBB Press [First Printing Page], and then
enter the original sheet number
from which to start numbering
with the number keys.

Note
❒ To change the number entered,

press [Clear] or the {{{{Clear/Stop}}}}
key,  and then enter a  new
number.

CCCC Press the {{{{#}}}} key.

DDDD Press [Numbering from/to], and then
enter the page number from
which to start numbering with
the number keys, and then press
the {{{{#}}}} key.

EEEE Press [Last Number], and then enter
the page number at which to stop
numbering with the number
keys, then press the {{{{#}}}} key.

Proceed to step F when not chang-
ing.

Note
❒ If you wish to print onto the last

page, press [to the end]. 
❒ The last number is the last page

number to print. For example, if
the [Total Pages] is 10 pages, if
you wish to print up to 7 pages
and do not wish to print from
page 8 on, enter [7] for [Last
Number]. Normally, you do not
need to enter the number. 

FFFF Press [Total Pages], and then enter
the total number of original pages
with the number keys, then press
the {{{{#}}}} key.

GGGG Press [OK].

Note
❒ To change the settings after

pressing [OK], press [Change],
and then enter the numbers
again.
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If you selected (1-1, 1-2,…)

AAAA Press the right [Change].

BBBB Press [First Printing Page], and then
enter the original sheet number
from which to start numbering
with the number keys.

Note
❒ To change the number entered,

press [Clear] or the {{{{Clear/Stop}}}}
key,  and then enter a  new
number.

CCCC Press the {{{{#}}}} key.

DDDD Press [First Chapter No.], and then
enter the chapter number from
which to start numbering with
the number keys, then press the
{{{{#}}}} key.

EEEE Press [Numbering from/to], and then
enter the page number from
which to start numbering with
the number keys, then press the
{{{{#}}}} key.

FFFF If all the page designation is com-
plete, press [OK].

GGGG Press [OK].

Covers

Using this function, you can add cov-
er sheets or designate certain pages to
be copied on slip sheets.

Preparation
Before selecting this function, set
the tray for the front cover paper.
⇒ General Settings Guide, “Cover
Sheet Tray”

Note
❒ The cover sheet should be the same

size and direction as the copy pa-
per.

❒ You cannot set the copy paper in
the bypass tray. Only set the cover
sheets in the bypass tray.

❒ When selecting [Copy], select
whether the front and back covers
are copied 1 Sided or 2 Sided.
⇒General Settings Guide, “Cover
Sheet Tray”

❖❖❖❖ Front Cover
The first page of your originals is
copied on specific paper sheet for
covers, or a cover sheet is inserted
before the first copy.
• Copy 

3
2

1
3

2
1
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• Blank 

❖❖❖❖ Front/Back Covers
The first and last pages of your
original are copied on separate pa-
per for use as covers.
• Copy 

• Blank 

Note
❒ If Blank mode is selected, the

cover will not be counted as a
copy.

Reference
⇒ p.101 “Front Cover Copy in
Combine” 

AAAA Press [Cover/Slip Sheet].

BBBB Press ([Front Cover]/[Front/Back Cov-
er]).

CCCC Select [Copy] or [Blank] for the cov-
er sheet.

DDDD Select the paper tray which con-
tains the sheet paper to copy the
originals, and then press [OK].

EEEE Place your originals in the docu-
ment feeder, and then press the
{{{{Start}}}} key.

Slip Sheets

Every time the originals' page chang-
es, a slip sheet is inserted. This func-
tion can be used to insert a slip sheet
automatically between each OHP
transparency copied or used as a
stack function. You can also copy
onto the inserted slip sheets.

Preparation
Before selecting this function,
specify the paper tray for slip
sheets. ⇒ "Slip Sheet Tray" in the
General Settings Guide

Note
❒ Load the slip sheets in the same

size and orientation as the copy pa-
per or the OHP transparency.

3
2

1
3

2
1

1
2
3

1

2

3
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❖❖❖❖ When using OHP transparencies set
on the bypass tray
• Copy 

• Blank 

Note
❒ When not copying onto slip

sheets, the sheets will not be
counted as copies.

AAAA Press [Cover/Slip Sheet].

BBBB Press [Slip Sheet].

CCCC Select [Copy] or [Blank], and then
press [OK].

DDDD Select the paper tray which con-
tains the sheet paper to copy the
originals.

EEEE Place your originals, and then
press the {{{{Start}}}} key.

222121 11

2221 11

UranosC1-ENcopyA_F1_FM.book  Page 71  Friday, July 26, 2002  5:01 PM



Copying

72

2

Storing Originals in the Document Server

The Document Server enables you to
save documents in the machine mem-
ory and then print them as you want.

Important
❒ Data stored in the machine might

be lost if some kind of failure oc-
curs. The supplier shall not be re-
sponsible for any damage that
might result from the loss of data.

Note
❒ Data stored in the Document Serv-

er is set to be deleted after 3 days
by the factory default value. You
can specify the period after which
the stored data is deleted automat-
ically. (“Auto Delete File” in the
System Settings manual under
“Key Operator Tools”). For more
information about settings and
changes, see the General Settings
Guide.

Reference
Refer to the General Settings
Guide.

AAAA Press [Store File].

BBBB Enter a file name, user name, or
password if necessary.

CCCC Place your originals.

Reference
For more information on the
types of originals that can be
placed and how to place them,
⇒ p.12 “Placing Originals”.

DDDD Make the scanning settings for
the original.

EEEE Press the {{{{Start}}}} key.
Originals are scanned.

Note
❒ To stop scanning, press the

{{{{Clear/Stop}}}} key. To resume a
paused scanning job, press [Con-
tinue] in the confirmation dialog
box. To delete the saved images
and cancel the job, press [Stop].

❒ To check if the document has
been stored, press the {{{{Docu-
ment Server}}}} key to display the
document selection screen.
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Color Adjustment

This function lets you alter up to three
single colors by mixing them with ad-
jacent colors in the color circle. 

Reference
For types and examples of the im-
age adjustment functions. ⇒ p.i
“What You Can Do With This Ma-
chine <Color Functions/Color Ad-
justments>” 

Note
❒ You can set up to 3 colors from yel-

low, red, magenta, blue, cyan, or
green.

❒ This function is only available in
Full Color mode.

AAAA Press the {{{{Adjust/Program Color}}}}
key.

BBBB Press [Adjust Color].
The color circle is displayed.

CCCC Select the colors you want to ad-
just. 

You can select up to 3 colors.

DDDD Adjust the color tastes using [←←←←]
or [→→→→].

Note
❒ Refer to the color circle on the

control panel.

EEEE Press [OK].

Note
❒ The indicator of the {{{{Adjust/Pro-

gram Color}}}} key will light up,
when adjusting the color.

❒ The adjusted settings will be de-
leted and the initial values will
be reset, when Auto Clear has
been performed, when the
{{{{Clear Modes}}}} key has been
pressed or when the power has
been turned off.
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Color Balance

Adjusts the overall color tone when
the overall copy is reddish or bluish.

Reference
For types and examples of the im-
age adjustment functions. ⇒ p.i
“What You Can Do With This Ma-
chine <Color Functions/Color Ad-
justments>” 

AAAA Press the {{{{Adjust/Program Color}}}}
key.

BBBB Make sure that [Color Balance] is
selected.

CCCC Adjust by pressing [Lighter] or
[Darker].

Note
❒ You can also register the adjust-

ed contents. ⇒ p.74 “Color Bal-
ance Program” 

DDDD Press [OK].

Note
❒ The indicator of the {{{{Adjust/Pro-

gram Color}}}} key will light up,
when adjusting the color bal-
ance.

❒ The adjusted settings will be de-
leted and the initial values will
be reset, when Auto Clear has
been performed,  when the
{{{{Clear Modes}}}} key has been
pressed or when the power has
been turned off.

Color Balance Program

You can also store the color balance
setting in memory and recall it when
you want to use it.

Note
❒ You can store up to 3 contents.
❒ If you want to change the regis-

tered settings, register them one
more time. In this case, the previ-
ously registered contents will be
changed.

Storing the adjusted color balance

AAAA Change the color balance.

Reference
⇒ p.74 “Color Balance” 

BBBB Press [Program Color Balance].

CCCC Press [Program].

DDDD Select a number (1–3) for this set-
ting.

The color balance setting will be
registered in the selected number.

Note
❒ If you select the program

number key where the m is dis-
played, the previously regis-
tered settings will change. 

EEEE Press [OK].
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Changing the registered contents

AAAA Press the {{{{Adjust/Program Color}}}}
key.

BBBB Confirm that [Color Balance] is se-
lected, and press [Program Color
Balance].

CCCC Select the program number (1–3)
to be changed.
The programmed color balance ap-
pears.

DDDD Change the registered contents.

EEEE After the programmed contents
are changed, press [Program Color
Balance].

FFFF Press [Program], and then press the
program number key to be over-
written.

GGGG Press [Register].

The program is changed.

HHHH Press [OK].

Copying with the registered contents

AAAA Press the {{{{Adjust/Program Color}}}}
key.

BBBB Make sure that [Color Balance] is
selected, and then press [Program
Color Balance].

CCCC Make sure that [Recall] has been
selected, and then select the pro-
gram number registered by the
color balance to be used.

DDDD Press [OK].

EEEE Place your originals, and then
press the {{{{Start}}}} key.

Note
❒ After copying has been com-

pleted, either performing the
Auto Clear function or pressing
the {{{{Clear Modes}}}} key deletes the
recalled contents.

Deleting the registered contents

AAAA Press the {{{{Adjust/Program Color}}}}
key.

BBBB Make sure that [Color Balance] has
been selected, and then press [Pro-
gram Color Balance].

CCCC Press [Delete], and then select the
program number registered by
the color balance to delete.

DDDD Press [Yes].

EEEE Press [OK].
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Image Adjustment

Reference
For types and examples of the im-
age adjustment functions. ⇒ p.i
“What You Can Do With This Ma-
chine <Color Functions/Color Ad-
justments>” 

The followings are types of image ad-
justments you can make.

❖❖❖❖ Sharp/Soft
For adjusting the outline of an im-
age.

❖❖❖❖ Contrast
For adjusting the shades of an im-
age.

❖❖❖❖ Background Density
For adjusting the background den-
sity of an image.

❖❖❖❖ Adjust U.C.R
For expressing vividly the black
areas in an image by adjusting the
amount of black toner.

❖❖❖❖ Text/Photo Sensitivity
For adjusting the standard level in
judging the image in the text and
t h e  p h ot o  p a r t ,  w he n u s i ng
“Text/Photo”.

Note
❒ “Sharp/Soft” “Contrast” “Back-

ground Density” can each be ad-
justed, however, their adjustments
can affect the level of other adjust-
ment functions.

❒ When adjusting the image qual-
ity, the indicator of the {{{{Ad-
just/Program Color}}}} key will light
up. 

❒ The adjusted settings will be de-
leted and the initial values will
be reset, when Auto Clear has
been performed, when the
{{{{Clear Modes}}}} key has been
pressed or when the power has
been turned off.

AAAA Press the {{{{Adjust/Program Color}}}}
key.

BBBB Press [Copy Quality].

CCCC Adjust the settings.

Adjusting the Sharp/Soft

A Adjust by pressing [Soft] or
[Sharp]. 

B Press [OK].

Adjusting the contrast

A Adjust by pressing [Low] or
[High].

B Press [OK].

Adjusting the background density

A Adjust by pressing [Lighter] or
[Darker].

Note
❒ Adjustments should be made

lightly when copying dark
textured originals, such as
newspaper or recycled pa-
per.
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❒ Adjustments should be made
darker when darkening the
color of markers or highlight-
ers. However, as the color of
highlighters is difficult to re-
produce, the copy might not
come out depending on the
color or a different color
might be copied.

B Press [OK].

Adjusting the U.C.R.

A Adjust by pressing [Lighter] or
[Darker].

B Press [OK].

Adjusting the Text/Photo 
Sensitivity

A Press [TTTTNext].

B Adjust by pressing [Text] or
[Photo].

Note
❒ Make sure to set to “Text”

when parts of the texts are
faded or are not clear. Set to
“Photo” when the outline of
photos becomes dark.

C Press [OK].

Auto Color Calibration

If a certain color is strong or the color
of the copy differs from the original,
adjust the yellow, magenta, cyan and
black balance.

Note
❒ If “D Toner is almost empty” is

shown on the display panel, the
test pattern cannot be printed.

AAAA Press the {{{{User Tools/Counter}}}} key.

BBBB Press [Maintenance].

CCCC Press [Auto Color Calibration].

DDDD Press [Start] on the “Copier Func-
tion”.

EEEE Press [Start Printing] and a test pat-
tern will be printed.

Note
❒ The test pattern will be printed

on an A4K, 81/2”× 11”K size
page (If A4K is not available
then A3 L, B4L will be used.).
Make sure to check the paper
set in the paper tray.

❒ The counter will not proceed
when the test pattern is printed.

FFFF Place the test pattern on the expo-
sure glass and press [Start Scanning].

The image will be corrected after
“Please wait.” disappears.
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Note
❒ The test pattern will not be read

if it is set in the optional docu-
ment feeder (ADF).

❒ Set the test pattern in the follow-
ing way:

❒ When the optional document
feeder (ADF) is installed, make
sure to set the test pattern on the
exposure glass, and then 2 or 3
white sheets, same size as the
test pattern, above the test pat-
tern.

Returning to the previous setting

Note
❒ “Previous Setting” means to re-

turn to the previous status be-
fore any changes.

A Press [Previous Setting] in the
“Auto Color Calibration (Copi-
er Function)”.

B Press [Yes].

The settings return to the previ-
ous contents.
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User Color

You can register colors made by ad-
justing the density of yellow, magen-
ta, cyan, and black. You can also give
a name to the colors you register, and
print out registered colors.

Reference
For types and examples of the im-
age adjustment functions ⇒ p.i
“What You Can Do With This Ma-
chine <Color Functions/Color Ad-
justments>” 
The following show you how to
create colors:

• Adjusting the density of each
color, by using the density of a cho-
sen basic color.

• Directly specifying the density of
each color using the number keys.

Note
❒ Adjust the colors to be registered

so that the total of yellow, magen-
ta, cyan and black is under 255%. 

❒ When the total density of a regis-
tered color is over 256%, it will be
corrected to 255%.

❒ When copying using user colors,
the fine shades might vary de-
pending on the condition of the
machine.

❒ In order to correctly reproduce
originals, the values, which have
been input, are corrected inside the
machine, and copies are made us-
ing the best suitable values. There-
fore, there might be slight color
differences when copying using
“Text” and when using “Photo”.

❒ Up to 15 colors can be registered.
❒ Sample prints of user colors can

also be made on an A4K size page
or on an A3L size page. 

❒ When printing a user color list, the
full color counter will advance to
“1”.

Adjusting Colors Based on the 
Selected Color

AAAA Press the {{{{Adjust/Program Color}}}}
key.

BBBB Press [User Color].

CCCC Select the number (1–15) you
want to store the user color in.

Note
❒ The contents of the user color

will change when selecting the
number already displayed by
the color name.

DDDD Select the color to be used as a
base for registration from [Basic
Color].

The density of each color for the se-
lected color is displayed.

Note
❒ Press [Custom Setting] if you are

directly specifying the density
of each color with the number
keys. ⇒ p.81 “Mixing Colors
Manually with the Number
Keys” 
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Selecting from registered colors

A Press [User Color].
B Select from the registered

colors.

EEEE Specify the color density.

Using [nnnn] [oooo] 

A Specify the density in percent-
ages (%) using [nnnn] or [oooo].

Using [With Number keys] 

A Press [With Number keys].

B Input the density in percentag-
es (%) using the number keys,
and then press [#].

Note
❒ If you want to use [nnnn] or

[oooo], press [With nnnn oooo].
❒ If you enter the wrong densi-

ty ,  press  [Clear ]  or  the
{{{{Clear/Stop}}}} key, and then re-
enter the correct density.

❒ Repeat step B if you want to
specify the density of multi-
ple colors.

When renaming a color

A Press [Change Name].
B Enter the name of the color (up

to 16 characters), and then
press [OK].

Reference
⇒ General Settings Guide
“How to Enter Characters”

FFFF Check densities and names of
each color, and then press [OK].

GGGG Press [Exit].
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Mixing Colors Manually with 
the Number Keys

AAAA Press the {{{{Adjust/Program Color}}}}
key.

BBBB Press [User Color].

CCCC Select the number (1–15) that you
want to store the user color in.

Note
❒ The contents of the user color

will change when selecting the
number already displayed by
the color name.

DDDD Press [Custom Setting].

EEEE Select the color that you want to
adjust.

FFFF Enter the density (%) with the
number keys, and then press [#].

When renaming a color

A Press [Change Name].

B Enter the name of the color (up
to 16 characters), then press
[OK].

Reference
⇒ General Settings Guide
“How to Enter Characters”

GGGG Check the names of each color,
and then press [OK].

Note
❒ Repeat steps E to G if you want

to specify the density of multi-
ple colors.

HHHH Press [Exit].

Deleting User Colors

Note
❒ You can not delete colors regis-

tered in the program or registered
colors that are currently being
used.

AAAA Press the {{{{Adjust/Program Color}}}}
key.

BBBB Press [User Color].

CCCC Press [Delete].

DDDD Select the number of the user
color you want to delete.

EEEE Press [Delete].

FFFF Press [Exit].

Sampling the User Colors

AAAA Press the {{{{Adjust/Program Color}}}}
key.

BBBB Press [User Color].

CCCC Confirm the copy paper, and then
press [Print Sample of User Color].

The sample of user colors is output
in the internal tray.

Note
❒ The sample will be copied on a

A4K, 81/2" × 11"K sheet or a
A3L, 11" × 17"L sheet.

UranosC1-ENcopyA_F1_FM.book  Page 81  Friday, July 26, 2002  5:01 PM



Color Adjustment/Program

82

3

Programs

You can store the frequently used
copy job settings in the machine
memory and recall them for future
use.

Storing a Program

Note
❒ You can store up to 10 programs.
❒ You can select the standard mode

or program No. 10 as the mode to
be set when modes are cleared or
reset, or immediately after the op-
eration switch is turned. ⇒ p.99
“Change Initial Mode” 

❒ Paper settings are stored based on
paper size. So if you place more
than one paper tray of the same
size, the paper tray prioritized
with the User Tools (System Set-
tings) will be selected first. ⇒“Pa-
per Settings” General Settings
Guide

❒ Programs are not cleared by turn-
ing the power off or by pressing
the {{{{Clear Modes}}}} key. They are
canceled only when you delete or
overwrite them with another pro-
gram.

AAAA Edit the copy settings so that all
functions you want to store in this
program are selected.

BBBB Press the {{{{Program}}}} key.

CCCC Press [Register].

DDDD Press the program number you
want to store.

Note
❒ Program numbers with m al-

ready have settings in them.

Reference
⇒ p.83 “Changing a stored pro-
gram” 

EEEE Enter the program name with the
letter keys on the display panel.

You can enter up to 40 characters.

Reference
For details on entering charac-
ters, see “Entering Text Charac-
ters”, General Settings Guide

Note
❒ If you do not wish to enter the

program name, go to step F.
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FFFF Press [OK].

When the settings are successfully
stored, the mmmm  indicator goes
on.The screen returns to the initial
copy display for a while.

Changing a stored program

AAAA Check the program settings.

Note
❒ When you want to check the

contents of a program, recall the
program. ⇒ p.83 “Recalling a
Program” 

BBBB Repeat steps AAAA to DDDD of “Storing a
Program”.

CCCC Press [Register].

Repeat steps E, F of ”Storing a Pro-
gram”.

Note
❒ When it is overwritten, the pre-

vious program is erased.

Deleting a Program

AAAA Press the {{{{Program}}}} key.

BBBB Press [Delete].

CCCC Press the program number you
want to delete.

DDDD Press [Yes].

The program is deleted, and the
screen returns to the initial copy
display.

Recalling a Program

AAAA Press the {{{{Program}}}} key.

BBBB Press [Recall].

CCCC Press the program number you
want to recall.

The stored settings are displayed.

Note
❒ Only programs with m contain

a program.

DDDD Place your originals, and then
press the {{{{Start}}}} key.
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4. Troubleshooting

If Your Machine Does Not Operate as You 
Want

When a Message is Displayed

The following chart contains explanations for the common messages. If other
messages appear, follow the instructions as they are displayed.

Problem Cause Action

Cannot detect original size. Improper original is 
placed. ⇒ p.9 “Sizes diffi-
cult to detect” 

Place a custom size original on the 
exposure glass. ⇒ p.13 “Placing 
Originals on the Exposure Glass” 

Input the horizontal and vertical 
size of the custom original. ⇒ p.16 
“Placing Custom Size Originals” 

Do not use Auto Reduce/Enlarge 
mode.

Original is not placed. Place your originals.

Check original orientation. There is no copy paper that 
is in the same direction as 
the originals.

Place the original in the same direc-
tion as the copy paper.

Check paper size. Improper paper size is set. If you press the {{{{Start}}}} key, copy 
will start onto the selected paper.

Rotate Sort is not available 
with this image size. 

A size of paper for which 
Rotate Sort is not available 
is selected.

Select the proper paper size. ⇒ p.39 
“Sort” 

It is over stapling capacity. The number of sheets per 
set is over the staple capac-
ity.

Check the stapler capacity. ⇒ p.108 
“Supplementary Informations” 

Cannot staple paper of this 
size. 

The Staple function cannot 
be used with paper size se-
lected.

Select a paper size that can be used 
in Staple mode. ⇒ p.108 “Supple-
mentary Informations” 

Duplex is not avilable with 
this paper size. 

A paper size not available 
in Duplex mode has been 
selected.

Select the proper paper size. 

Maximum number of sets 
is *. 

The number of copies ex-
ceeds the maximum copy 
quantity.

You can change the maximum copy 
quantity. ⇒ p.99 “Max. Copy Quan-
tity” 
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Cannot copy. Original is 
being scanned by other 
functions.

The Document Server func-
tion is in use.

To cancel the job in process, press 
[Exit], and then press the {{{{Document 
Server}}}} key. Next, press the 
{{{{Clear/Stop}}}} key. When the message 
”[Stop] was pressed. Stop storing?” 
appears, press [Stop].

Problem Cause Action
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If You Cannot Make Clear Copies

Problem Cause Action

Copies appear dirty. The image density is too 
dark.

Adjust the copy density. ⇒ p.29 
“Adjusting Copy Image Density” 

Auto Image Density is not 
selected.

Adjust the auto density. ⇒ p.29 
“Adjusting Copy Image Density” 

The reverse side of an orig-
inal image is copied.

The image density is too 
dark.

Adjust the copy density. ⇒ p.29 
“Adjusting Copy Image Density” 

Auto Image Density is not 
selected.

Adjust the auto density. ⇒ p.29 
“Adjusting Copy Image Density” 

A shadow appears on cop-
ies if you use pasted origi-
nals.

The image density is too 
dark.

Adjust the copy density. ⇒ p.29 
“Adjusting Copy Image Density” 

 Change the direction of the original.

Put mending tape on the pasted 
part.

The same copy area is dirty 
whenever making copies.

The exposure glass or doc-
ument feeder is dirty.

Clean them. ⇒ General Settings 
Guide

Copies are too light. The image density is too 
light.

Adjust the copy density. ⇒ p.29 
“Adjusting Copy Image Density” 

The paper size is not ap-
propriate.

Use the recommended paper.

Note
❒ A light copy may result when 

you use damp or rough grain pa-
per.

Toner cartridge is almost 
empty.

Add toner. ⇒ General Settings 
Guide

Parts of the image are not 
copied.

The original is not set cor-
rectly.

Set originals correctly. ⇒ p.12 “Plac-
ing Originals” 

An improper paper size is 
selected.

Select the proper paper size.

Copies are blank. The original is not set cor-
rectly.

When using the exposure glass, face 
the originals down. When using the 
document feeder, face them up. ⇒ 
p.12 “Placing Originals” 

A moiré pattern is pro-
duced on copies.

Your original has a dot pat-
tern image or many lines.

Place the original on the exposure 
glass at a slight angle.
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If You Cannot Make Copies as You Want

This section explains causes and remedies when copy results are not as expect-
ed.

Problem Cause Action

Copies are not stapled. There are jammed staples 
in the stapler.

Remove jammed staples. ⇒ General 
Settings Guide

Note
❒ After removing jammed staples, 

staples might not be ejected the 
first few times you try to use the 
stapler.

The number of copies ex-
ceeds the capacity of the 
stapler.

Check the stapler capacity. ⇒ p.108 
“Supplementary Informations” 

Copy paper is curled. Turn the copy paper over in the 
tray.

Staples are wrongly posi-
tioned.

Originals are not set cor-
rectly.

Check the correct position to place 
the originals. ⇒ p.43 “Staple” 

You cannot combine sever-
al functions.

Selected functions cannot 
be used together.

Check the combination of functions 
and make the settings again. 

Reference
⇒ p.107 “Combination Chart” 

When sorting, the pages 
are divided into two 
blocks.

The memory became full in 
the middle of sorting and 
the pages were delivered in 
two blocks.

You can interrupt copying when the 
memory becomes full. ⇒ p.105 
“Memory Full Auto Scan Restart” 

In Double Copies mode, 
parts of the original image 
are not copied.

Combination of original 
and copy paper is not cor-
rect.

Select A3L for A4 K originals and 
A4 for A5 originals.

In Border, Center, or Cent-
er/Border mode, parts of 
the original image are not 
copied.

You set a wide erased mar-
gin.

Make the margin width narrower. 
You can adjust it between 2-99mm. 
⇒ p.101 “Erase Border Width” and 
⇒ p.101 “Erase Center Width” 

Originals are not scanned 
correctly.

Set the originals correctly.

In Margin Adjustment 
mode, parts of the original 
image are not copied.

You set a wide erased mar-
gin.

Set a narrower margin with the User 
Tools. ⇒ p.101 “Front Margin: 
Left/Right”, ⇒ p.101 “Front Mar-
gin: Top/Bottom”, ⇒ p.101 “Back 
Margin: Left/Right”, ⇒ p.101 “Back 
Margin: Top/Bottom” 

There is a lack of margin 
space on the opposite side 
of the binding position.
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In Image Repeat mode, the 
original image is not cop-
ied repeatedly.

You selected copy paper 
the same size as the origi-
nals, or you did not select 
the proper reproduction 
ratio.

Select copy paper larger than the 
originals.

Select the proper reproduction ratio.

The stamp position is 
wrong.

The paper orientation is 
wrong.

Check the paper orientation and 
stamp position.

When Combine, parts of 
the image are not copied.

You specified a reproduc-
tion ratio that does not 
match the sizes of your 
originals and copy paper.

When you specify a reproduction 
ratio using Manual Paper Select 
mode, make sure that the ratio 
matches your originals and the copy 
paper.

Note
❒ Select the correct reproduction 

ratio before using Combine 
mode.

Order of copies is not cor-
rect.

You placed the originals in 
the incorrect order.

When placing a stack of originals in 
the document feeder, the last page 
should be on the bottom.

If you place an original on the expo-
sure glass, start with the first page to 
be copied.

When Duplex, copy is 
made Top/Bottom even 
though Left/Right is se-
lected.

You placed the originals in 
the wrong direction.

Place the originals in the correct ori-
entation. ⇒ p.12 “Original Orienta-
tion” 

Paper does not output dur-
ing printing with stapling.

When you stop printing 
while using the staple func-
tion, papers not stapled 
during printing may be left 
in the staple unit.

Press the {{{{Reset}}}} key and cancel 
copy settings, including stapling.

Colors changed even 
though they were not se-
lected.

If color range is set to 
“Wider” and if red is select-
ed, colors such as magenta 
and orange may change.

Adjust the color range by setting the 
color width. ⇒ p.106 “Adjust Color 
Image” 

Colors not selected will be 
erased when using Erase 
mode.

If color range is set to 
“Wider” and if red is select-
ed, colors such as magenta 
and orange may change.

Adjust the color range by setting the 
color width. ⇒ p.106 “Adjust Color 
Image” 

Problem Cause Action
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When Memory is Full

Note
❒ If you set "Memory Full Auto Scan Restart" of the User Tools ( ⇒ p.105 ) to

"Yes", the memory overflow message will not be displayed, but make Con-
nect Copy for the scanned originals automatically. Connect Copy continues
scanning and copying until finishing the job. Note that copy sets will be print-
ed out separately by scanning at this time.

Message Cause Solution & Reference

Memory is full. ## originals 
have been scanned.

Press [Print] to copy scanned 
originals.

Do not remove remaining 
originals.

Note
❒ Copying will stop and this 

message will be displayed 
when the memory is full.

The scanned original exceeds 
the number of pages that can 
be stored in memory.

Press [Print] to copy scanned 
originals and clear the scan-
ning data. Press [Clear Memory] 
to clear the scanning data and 
not copy.

Press [Resume] to scan and 
copy remaining originals.

[Stop] [Resume] 

The machine checks if the re-
maining original should be 
copied, after the scanned orig-
inal has been printed.

To continue copying, remove 
all copies then press [Resume]. 
To stop copying, press [Stop].
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5. User Tools (Copier/Document
Server Features)

User Tools Menu (Copier/Document 
Server Features)

User Tools Item Names Default Settings

General Features 1/5 ⇒ p.98 “General Features 1/5” 

Auto Paper Select Priority ON 

Paper Display Display 

Original Type Display Display 

Original Type Priority Full Color/Two-color: 
Text/Photo

B&W/Single Color: 
Text/Photo

Original Photo Type Priority •Text/Photo : Printed Photo

•Photo : Printed Photo

Auto Tray Switching Without image rotation 

General Features 2/5 ⇒ p.99 “General Features 2/5” 

Duplex Mode Priority 1 Sided → 1 Sided (metric)

1 Sided → 2 Sided (inch)

Copy Orientation in Duplex Mode Top to Top 

Original Orientation in Duplex Mode Top to Top 

Change Initial Mode Standard 

Max. Copy Quantity 100 Sheets

Tone: Original remains ON 

Job End Call ON 
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General Features 3/5 ⇒ p.99 “General Features 3/5” 

Copy Function Key: F1~F5 When 2 Sided is available

• F1: 1 Sided → 2 Sided : T to T

• F2: 2 Sided : T to T → 2 Sid-
ed : T to T 

• F3: 1 Sided → 1 Sided Com-
bine 

• F4: 1 Sided → 1 Sided Com-
bine: 4 originals 

• F5: Create Margin 

When 2 Sided is not available

• F1: 1 Sided → 1 Sided Com-
bine 

• F2: 1 Sided → 1 Sided Com-
bine: 4 originals 

• F3: 1 Sided → 1 Sided Com-
bine: 8 originals 

• F4: Off 

• F5: Create Margin 

General Features  4/5 ⇒ p.99 “General Features 4/5” 

Document Server Storage Key: F1~F5 • F1: 2 Sided Original Top to 
Top 

• F2: 1 Sided → 1 Sided Com-
bine 

• F3: 1 Sided → 1 Sided Com-
bine: 4 originals 

• F4: 1 Sided → 1 Sided Com-
bine: 8 originals 

• F5: Create Margin 

General Features 5/5 ⇒ p.100 “General Features 5/5” 

Clear Bypass Mode Clear 

Color Mode Priority Black & White

Two-Color Mode Priority Red & Black

Auto Image Density Priority Full Color/Two-color: OFF

B & W/Single Color: ON

User Tools Item Names Default Settings
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Reproduction Ratio  1/2 ⇒ p.100 “Reproduction Ratio 1/2” 

Shortcut R/E Metric version 

• Shortcut R/E 1: 71% 

• Shortcut R/E 2: 141% 

• Shortcut R/E 3: 93% 

Inch version

• Shortcut R/E 1: 73% 

• Shortcut R/E 2: 155% 

• Shortcut R/E 3: 93% 

Enlarge 1~5 Metric version 

• Enlarge 1: 115% 

• Enlarge 2: 122% 

• Enlarge 3: 141% 

• Enlarge 4: 200% 

• Enlarge 5: 400% 

Inch version 

• Enlarge 1: 121% 

• Enlarge 2: 129% 

• Enlarge 3: 155% 

• Enlarge 4: 200% 

• Enlarge 5: 400% 

Priority Setting: Enlarge Metric version 141% 

Inch version 155% 

Reproduction Ratio  2/2 ⇒ p.100 “Reproduction Ratio 2/2” 

Reduce 1~6 Metric version 

• Reduce 1: 25% 

• Reduce 2: 50% 

• Reduce 3: 65% 

• Reduce 4: 71% 

• Reduce 5: 75% 

• Reduce 6: 82% 

Inch version 

• Reduce 1: 25% 

• Reduce 2: 50% 

• Reduce 3: 65% 

• Reduce 4: 73% 

• Reduce 5: 78% 

• Reduce 6: 85% 

Priority Setting: Reduce Metric version: 71% 

Inch version: 73% 

Ratio for Create Margin 93%

R/E Priority  Reduce 

User Tools Item Names Default Settings
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Edit  1/2 ⇒ p.101 “Edit 1/2” 

Front Margin: Left/Right Metric version: Left 5mm 
Inch version: Left 0.2”

Back Margin: Left/Right Metric version: Right 5mm 
Inch version: Right 0.2”

Front Margin: Top/Bottom Metric version: T/B 0mm 
Inch version: T/B 0”

Back Margin: Top/Bottom Metric version: T/B 0mm 
Inch version: T/B 0”

1 Sided→2 Sided Auto Margin: TtoT Metric version: Right 5mm 
Inch version: Right 0.2”

1 Sided→2 Sided Auto Margin: TtoB Metric version: T/B 0mm 
Inch version: T/B 0”

Erase Border Width Metric version: 10mm Inch 
version: 0.4”

Erase Original Shadow in Combine Yes

Erase Center Width Metric version: 10mm

Inch version: 0.4”

Edit 2/2 ⇒ p.101 “Edit 2/2” 

Front Cover Copy in Combine Combine 

Copy Order in Combine From left to right 

Image Repeat Separation Line None 

Double Copies Separation Line None 

Separation Line in Combine None 

Stamp ⇒ p.103 “Stamp” 

Preset Stamp Stamp Priority Copy 

Stamp Language English

Stamp Position Metric version 

• Position: Top right 

• Top Margin: 24mm 

• Right Margin: 24mm 

Inch version

• Position: Top right 

• Top Margin: 1.0" 

• Right Margin: 1.0" 

Stamp Format : Size : 1×

Density: Normal 

Stamp Color : Black

User Tools Item Names Default Settings
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User Stamp Program/Delete Stamp 

Stamp Position : 1~4 Metric version 

• Position: Top right 

• Top Margin: 24mm 

• Right Margin: 24mm 

Inch version

• Position: Top right 

• Top Margin: 1.0" 

• Right Margin: 1.0" 

Stamp Format : 1~4 All Pages 

Stamp Colors: 1~4 Black

Date Stamp Format MM/DD/YYYY

Font Font 1 

Stamp Position Metric version 

• Position: Top left 

• Top Margin: 8mm 

• Right Margin: 32mm 

Inch version

• Position: Top left 

• Top Margin: 0.3" 

• Right Margin: 0.8" 

Stamp Setting All Pages 

Size Auto 

Superimpose No 

Stamp Color Black

User Tools Item Names Default Settings
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Page Numbering Stamp Format P1, P2... 

Font Font 1 

Size Auto 

Duplex Back Page Stamping 
Position 

Opposite Position 

Page Numbering in Combine Per original 

Stamp on Designated Slip 
Sheet 

No 

Stamp Position : Metric version

• Position 
P1, 1/5, P.1, 1: Top right 
-1-, 1-1: Bottom center 

• Top/Bottom Margin
P1, 1/5, P.1, 1: 12mm
-1-, 1-1: 8mm

• Left/Right Margin
P1, 1/5, P.1, 1: 12mm
-1-, 1-1: 0mm

Inch version

• Position
P1, 1/5, P.1, 1: Top right 
-1-, 1-1: Bottom center 

• Top/Bottom Margin
P1, 1/5, P.1, 1: 0.5"
-1-, 1-1: 0.3"

• Left/Right Margin
P1, 1/5, P.1, 1: 0.5"
-1-, 1-1: 0.0"

Superimpose No 

Stamp Color Black

Input/Output  ⇒ p.105 “Input/Output” 

Switch to Batch Batch 

SADF Auto Reset 5 seconds 

Rotate Sort: Auto Paper Continue No 

Auto Sort No 

Memory Full Auto Scan Restart No 

Select Stack Function Stack 

Letterhead Setting No 

Adjust Color Image ⇒ p.106 “Adjust Color Image” 

Background Density of ADS (Full Color/Two-color) Center of the 5 level adjustment

Color Sensitivity Center of the 5 level adjustment

A.C.S. Sensitivity Center of the 5 level adjustment

A.C.S. Priority Full color

User Tools Item Names Default Settings
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Accessing the User Tools 
(Copier/Document Server Features)

This section is for the key operators in
charge of this machine. You can
change or set the machine's default
settings.

Note
❒ Be sure to exit from the User Tools

after all the settings are finished.
❒ The selected key is highlighted.
❒ Any changes you make with the

User Tools remain in effect even if
the main power switch or opera-
tion switch is turned off, or the
{{{{Clear Modes}}}} key is pressed.

Reference
For details, ⇒ "User Tools (System
Settings)" in the General Settings
Guide.

AAAA Press the {{{{User Tools/Counter}}}} key.
The User Tools Main Menu ap-
pears.

Note
❒ When the access code is set, the

access code input screen is dis-
played when changing the ini-
t i a l  se t t i n g s .  Op er a t e  by
entering the registered access
code beforehand. For access
code, see ⇒  “Key Operator
Tools” in the General Settings
Guide.

BBBB Press [Copier/Document Server Fea-
tures].

The Copier/Document Server Fea-
tures menu appears.

CCCC Select the menu you want to set.

Setting screen for each menu will
be displayed.

Reference
⇒ p.91 “User Tools Menu (Cop-
ier/Document Server  Fea-
tures)” 

DDDD Change the settings by following
the instructions on the display
panel, and then press [OK].

Exiting From the User Tools

AAAA After changing the User Tools set-
tings, press [Exit] on the User
Tools Main Menu.
Changing the User Tools is com-
pleted, and the machine is ready
for copying.

Note
❒ You can also exit from the User

Tools by pressing the {{{{User
Tools/Counter}}}} key.
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General Features 1/5

❖❖❖❖ Auto Paper Select Priority 
As a default setting, Auto Paper
Select is selected. You can cancel
this setting. ⇒ p.31 “Selecting
Copy Paper” 

❖❖❖❖ Paper Display 
You can choose whether the avail-
able paper trays/sizes are shown
on the initial display.

Note
❒ If you choose "Hide", the dis-

play is shown as below. When
[Auto Paper Select] is pressed, pa-
per sizes appear on the display.

❖❖❖❖ Original Type Display 
You can choose whether the origi-
nal types are shown on the initial
display.

Note
❒ If you choose "Hide", the dis-

play is shown as below.

❖❖❖❖ Original Type Priority 
You can select the type of originals
to be effective when the power is
turned on, reset or modes are
cleared.

❖❖❖❖ Original Photo Type Priority
When you select “Text/Photo” or
“Photo” in “Original Type Priori-
ty”, you can change the settings of
the selected original type.

❖❖❖❖ Auto Tray Switching 
If you load paper of the same size
in two or more trays, the machine
automatically shifts to the other
tray when the first tray in use runs
out of paper (When Auto Paper Se-
lect Priority is“ON”). This function
is called "Auto Tray Switching".
This setting specifies whether to
use "Auto Tray Switching" or not.

Note
❒ [With image rotation] Use this to

copy with Auto Tray Switching.
❒ [Without image rotation] Only cop-

ies with Auto Tray Switching if
you load paper of the same size
and in the same direction in two
or more trays. If the paper is not
the same size or in the same di-
rection, copying is interrupted
and the message "Load paper."
is displayed. 

❒ [OFF] When a paper tray runs
out of paper, copying is inter-
rupted and the message "Load
paper." is displayed.
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General Features 2/5

❖❖❖❖ Duplex Mode Priority 
You can select the type of Duplex
function effective when the ma-
chine is turned on, reset, or modes
are cleared.

❖❖❖❖ Copy Orientation in Duplex Mode 
You can set the copy orientation
when making two-sided copies.

❖❖❖❖ Original Orientation in Duplex Mode 
You can set the original orientation
when making two-sided copies.

❖❖❖❖ Change Initial Mode 
You can select the initial mode or
Program No. 10 as the mode effec-
tive when the machine is turned
on, reset, or modes are cleared.

❖❖❖❖ Max. Copy Quantity 
The maximum copy quantity can
be set between 1 and 100.

❖❖❖❖ Tone: Original remains
The beeper (key tone) sounds
when you forgot to remove origi-
nals after copying.

Note
❒ If the "Panel Tone" of the User

Tools (System Settings) setting
is "OFF", the beeper does not
sound irrespective of the "Tone:
Original  remains" sett ing.
⇒"Panel Tone" in the General
Settings Guide

❖❖❖❖ Job End Call 
You can choose whether or not the
beeper sounds when copying is
complete. 

Note
❒ If the "Panel Tone" of the User

Tools (System Settings) settings
is "ON", the machine beeps to
notify you that the machine did
not complete a job for reasons
such as copying was interrupt-
ed, the paper tray ran out of pa-
per or a paper jam occurred.

General Features 3/5

❖❖❖❖ Copy Function Key: F1-F5
You can register frequently used
functions in function keys F1 to F5.

General Features 4/5

❖❖❖❖ Document Server Storage Key: F1-F5
You can register frequently used
functions in function keys F1 to F5.
You can also change the registered
functions.
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General Features 5/5

❖❖❖❖ Clear Bypass Mode
Set this function to whether or not
the settings of the Bypass Tray are
cleared, when the machine is
turned on, reset, or modes are
cleared.

❖❖❖❖ Color Mode Priority
You can select the priority of the
color mode.

❖❖❖❖ Two-Color Mode Priority
Set this function to whether or not
to prioritize “Red & Black” or
“Two-color”  when using the
“Two-color” modes.

❖❖❖❖ Auto Image Density Priority
Set this function to whether or not
use Automatic Density, when the
machine is turned on, reset, or
modes are cleared.

Note
❒ When using the Auto Color Select

function, the settings of Full
Color/Two-color will be effective.

Reproduction Ratio 1/2

❖❖❖❖ Shortcut R/E 
You can register up to three fre-
quently used Reduce/Enlarge ra-
t i o s  o t he r  t h an  t he  f i xe d
Reduce/Enlarge ratio and have
them shown on the initial display.
You can also change the registered
Reduce/Enlarge ratios.
If no Reduce/Enlarge ratio has
been set when selecting [Shortcut
R/E 1], [Shortcut R/E 2], or [Shortcut
R/E  3] ,  enter the desired Re-
duce/Enlarge ratio using the
number keys.

❖❖❖❖ Enlarge 1-5
You can customize the enlarge-
ment ratios available when you
press [Reduce/Enlarge] followed by
[Enlarge].

❖❖❖❖ Priority Setting: Enlarge 
You can set the ratio with priority
when [Reduce/Enlarge] is pressed,
followed by [Enlarge].

Reproduction Ratio 2/2

❖❖❖❖ Reduce 1-6
You can customize the reduction
ratios available when you press
[Reduce/Enlarge] followed by [Re-
duce].

❖❖❖❖ Priority Setting: Reduce 
You can set the ratio with priority
when [Reduce/Enlarge] is pressed,
followed by [Reduce].

❖❖❖❖ Ratio for Create Margin 
You can set a Reduce/Enlarge ra-
tio when registering "Create Mar-
gin" in a Shortcut Key.

❖❖❖❖ R/E Priority 
Specifies which tab is given priori-
ty on the display panel when [Re-
duce/Enlarge] is pressed.

Enlarge1 Enlarge2 Enlarge3 Enlarge4 Enlarge5

Reduce1 Reduce2 Reduce3 Reduce4 Reduce5 Reduce6
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Edit 1/2

❖❖❖❖ Front Margin: Left/Right 
You can specify left and right mar-
gins on the front side of copies in
Margin Adjust mode.

❖❖❖❖ Back Margin: Left/Right 
You can specify left and right mar-
gins on the back side of copies in
Margin Adjust mode.

❖❖❖❖ Front Margin: Top/Bottom 
You can specify top and bottom
margins on the front side of copies
in Margin Adjust mode.

❖❖❖❖ Back Margin: Top/Bottom 
You can specify top and bottom
margins on the back side of copies
in Margin Adjust mode.

❖❖❖❖ 1 Sided→→→→2 Sided Auto Margin: TtoT 
In 1 sided → 2 sided Duplex mode,
you can specify the margins on the
back side.

❖❖❖❖ 1 Sided→→→→2 Sided Auto Margin: TtoB 
In 1 sided → 2 sided Duplex mode,
you can specify the margins on the
back side.

❖❖❖❖ Erase Border Width 
You can specify the width of the
erased border margins in this func-
tion.

❖❖❖❖ Erase Original Shadow in Combine 
In Combine Copy mode, you can
specify whether to erase a 3mm,
0.1" bounding margin around all
four edges of each original.

❖❖❖❖ Erase Center Width 
You can specify the width of the
erased center margins this func-
tion.

Edit 2/2

❖❖❖❖ Front Cover Copy in Combine 
You can specify whether to make a
combined copy on the front cover
sheet when you select Front cover
copy mode.

❖❖❖❖ Copy Order in Combine 
You can set the copy order in Com-
bine mode to "Left to Right" or
"Top to Bottom".

GCST019E

Combine Not Combined
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❖❖❖❖ Image Repeat Separation Line 
You can select a separation line in
Image Repeat mode from None,
Solid, Broken A, Broken B or Crop
Marks. 
• None 

• Solid 

• Broken A 

• Broken B 

• Crop Marks 

Note
❒ Separation lines cannot be spec-

ified when [None] is selected.
❒ In “Black & White”, printing

will be done in black; in “Single
Color”, printing will be done in
the specified color; in “Two-
color” ( Normal ), printing will
be done in the specified color of
the black area; and in “Two-
color” (Red & Black), printing
will be done in black.

❒ An image of approximately
1.5mm (0.06”) will not be dis-
played as the width of the sepa-
ration line, when specifying
solid or broken lines.

❖❖❖❖ Double Copies Separation Line 
You can select a separation line in
Double Copy mode from None,
Solid, Broken A, Broken B or Crop
Marks.
• None 

• Solid 

• Broken A 

• Broken B 

• Crop Marks 

Note
❒ Separation lines cannot be spec-

ified when [None] is selected.
❒ In “Black & White”, printing

will be done in black; in “Single
Color”, printing will be done in
the specified color; in “Two-
color” ( Normal ), printing will
be done in the specified color of
the black area; and in “Two-
color” (Red & Black), printing
will be done in black.

❒ An image of approximately
1.5mm (0.06”) will not be dis-
played as the width of the sepa-
ration line, when specifying
solid or broken lines.
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❖❖❖❖ Separation Line in Combine 
You can select a separation line in
Combine mode from None, Solid,
Broken A, Broken B or Crop
Marks.
• None 

• Solid 

• Broken A 

• Broken B 

• Crop Marks 

Note
❒ Separation lines cannot be spec-

ified when [None] is selected.
❒ In “Black & White”, printing

will be done in black; in “Single
Color”, printing will be done in
the specified color; in “Two-
color” ( Normal ), printing will
be done in the specified color of
the black area; and in “Two-
color” (Red & Black), printing
will be done in black.

❒ An image of approximately
1.5mm (0.06”) will not be dis-
played as the width of the sepa-
ration line, when specifying
solid or broken lines.

Stamp 

Preset Stamp 1/4-4/4

❖❖❖❖ Stamp Priority 
You can select the stamp type that
is given priority when [Preset
Stamp] is pressed.

❖❖❖❖ Stamp Language 
You can select the language of the
message that is printed in Stamp
mode.

❖❖❖❖ Stamp Position 
You can set the position at which
the stamp is printed.
Press the arrow keys to adjust the
position.

❖❖❖❖ Stamp Format :
You can adjust the size, density
and print page for the stamp.
• Size 

You can set the size of the
stamp.

• Density 
You can set the pattern used to
print the stamp.

Note
❒ Normal : The stamp is print-

ed on the image. You cannot
confirm which parts overlap
the image.

❒ Lighter : The image can be
seen through the stamp.

❒ Light : You can see the image
even clearer than in the
"Lighter" setting.

• Page to Stamp
You can select whether the
stamp is printed on the first
page or all pages.

❖❖❖❖ Stamp Color
Sets the stamp print color.
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User Stamp 1/2-2/2

❖❖❖❖ Program/Delete Stamp
You can register/change/delete
these designs as user stamps.

Note
❒ You can register up to 4 custom

stamps with your favorite de-
signs.

Reference
For how to Program/Delete
Stamp, see ⇒ p.62 “To program
the user stamp” 

❖❖❖❖ Stamp Position 1 - 4
You can set the position at which
the stamp is printed.
Press the arrow keys to adjust the
position.

❖❖❖❖ Stamp Format 1 - 4
You can adjust the print page for
User Stamps 1 to 4 that you regis-
tered.
• Page to Stamp

Sets whether to print the stamp
on all pages or only on the first
page.

❖❖❖❖ Stamp Color : 1 - 4
Sets the color registered in User
Stamp color (1 to 4).

Date Stamp 

❖❖❖❖ Format 
You can select the date format for
Date Stamp mode.

❖❖❖❖ Font 
You can select the Date Stamp font.

❖❖❖❖ Stamp Position 
You can set the position at which
the stamp is printed.
Press the arrow keys to adjust the
position.

❖❖❖❖ Stamp Setting 
You can select whether the date is
printed on the first page or all pag-
es.

❖❖❖❖ Size 
You can set the Date Stamp size.

❖❖❖❖ Superimpose 
You can select whether the Date
Stamp is printed in white when it
overlaps black parts of the image.
This function is valid when in
Black & White mode.

❖❖❖❖ Stamp Color
You can set the selected priority
color when printing the date.

Page Numbering 1/3-2/3

❖❖❖❖ Stamp Format 
You can select the page number
format that is given priority when
[Page Numbering] is pressed.

❖❖❖❖ Font 
You can select the font of the page
number that is printed in Page
Numbering mode.

❖❖❖❖ Size 
You can set the size of the stamp
that is printed in Page Numbering
mode.

❖❖❖❖ Duplex Back Page Stamping Position 
You can set the position of the du-
plex back page number that is
printed in Duplex mode.
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❖❖❖❖ Page Numbering in Combine 
You can set how the pages are
numbered when you use the Com-
bine function and Page Number-
ing function together.

❖❖❖❖ Stamp on Designated Slip Sheet 
You can select whether to print the
page number onto slip sheets
when you use the Designate func-
tion set to "Copy" and Page Num-
bering function together.

❖❖❖❖ Stamp Position 
P1, P2... Stamp Position: 1/5, 2/5...
Stamp Position: –1–, –2–... Stamp
Position: P.1, P.2... Stamp Position:
1, 2... Stamp Position: 1–1, 1–2...
You can set the position at which
the stamp is printed.
Press the arrow keys to adjust the
position.

❖❖❖❖ Superimpose 
You can select whether page num-
bers are printed in white when
they overlap black parts of the im-
age.
This function is valid when in
Black & White mode.

❖❖❖❖ Stamp Color
You can set the selected priority
color when printing pages.

Input/Output 

❖❖❖❖ Switch to Batch (SADF) 
You can select whether Batch
mode or SADF mode is displayed
when you press the Special Origi-
nal key. ⇒ p.14 “Batch mode” 

❖❖❖❖ SADF Auto Reset 
When you set one original at a time
in the document feeder, the Auto
Feed indicator lights for a selected
time after an original is fed to show
that the document feeder is ready
for another original. You can ad-
just this time from 3 seconds to 99
in 1 second increments.

❖❖❖❖ Rotate Sort: Auto Paper Continue 
You can specify whether to contin-
ue copying when the paper of the
required orientation has run out
during rotate-sorting. ⇒ p.39 “Ro-
tate Sort” 

Note
❒ If you select [No] : 

• When paper of the required
orientation runs out, the ma-
chine stops copying and
prompts you to supply copy
paper. When you load paper,
the machine will continue
copying.

❒ If you select [Yes] : 
• Copying continues using

copy paper of a different ori-
entation. The copy job will
finish even if you have left
the machine.

❖❖❖❖ Auto Sort 
You can specify whether Sort
mode is selected when the ma-
chine is turned on or the mode is
cleared.

❖❖❖❖ Memory Full Auto Scan Restart
When the memory becomes full
while scanning originals, the ma-
chine can make copies of the
scanned originals first, and then
automatically proceed scanning
the remaining originals.
You can enable or disable this
function.
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Note
❒ If you select [No] :

• When the memory becomes
full, the machine stops oper-
ation allowing you to remove
the copy pages delivered on
the output tray.

❒ If you select [Yes] :
• You can leave the machine

unattended to make all the
copies, but the resulting sort-
ed pages will not be sequen-
tial.

❖❖❖❖ Select Stack Function 
Specify whether Stack or Rotate
Sort has priority to be shown on
the initial display.

Note
❒ An optional finisher is required

to use this function.

❖❖❖❖ Letterhead Setting 
If you select "Yes" in this function,
the machine rotates the image cor-
rectly.

Note
❒ Direction-fixed (top to bottom)

or 2-sided paper might not be
printed correctly depending on
how the originals and paper are
placed. 

Reference
When using letterhead paper,
be careful of the paper orienta-
tion. ⇒ p.11 “Direction-fixed
paper or 2-sided paper” 

Adjust Color Image

❖❖❖❖ Background Density of ADS (Full
Color/Two-color)
The background density is adjust-
ed to skip the texture and copy.
You can adjust the background
density up to 5 levels when in Full
Color or Two-color.

❖❖❖❖ Color Sensitivity
You can adjust the tone of red in
“Two color (Red & Black)”, the
color specified to convert in “Color
Convert” and the color specified
for “Erase Color”, in 5 levels.

Note
❒ When the color width has been

set to “Wider”, and the color to
be deleted, for example is red,
all the colors that are close to
magenta and orange are delet-
ed. If it's set to “Narrower” the
color red will be deleted.

❖❖❖❖ A.C.S. Sensitivity
This 5-step setting determines the
level of the standard used for dis-
criminating between black & white
originals and full color originals
when “Auto Color Select” is select-
ed.

❖❖❖❖ A.C.S. Priority
This setting determines the copy
priority between “Black & White”
and “Full Color” when “Auto
Color Select” is selected.
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6. Specifications

Combination Chart

The combination chart given below shows which modes can be used together.
When you read the chart, see the following table.

The following shows the combinations of functions.

❍ means that these modes can be used together.

$ means that these modes cannot be used together. The second 
mode selected will be the mode you're working in.

× means that these modes cannot be used together. The first mode 
selected will be the mode you're working in.
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Supplementary Informations

❖❖❖❖ Bypass Tray Copy
• The following paper sizes can be selected as the standard sizes.
A3L, A4KL, A5KL, A6L, B4L, B5KL, B6L, 11" × 17"L, 81/2" × 14"L,
81/2" × 11"KL, 51/2" × 81/2"KL, 71/4" × 101/2"KL, 8" × 13"L, 81/2" ×
13"L, 81/4" × 13", 12" × 18"L, 8KL, 16KKL, 37/8" × 71/2"K, 41/8" × 91/2"K,
C5 EnvK, C6 EnvL, DL EnvK

❖❖❖❖ Preset Enlarge/Reduce

Note
❒ The reproduction ratios you can specify are 25-400%.
❒ You can select one of 12 preset ratios (5 enlargement ratios, 7 reduction ra-

tios).
❒ You can select a ratio regardless of the size of an original or copy paper.

With some ratios, parts of the image might not be copied or margins will
appear on copies.

❒ Copies can be reduced or enlarged as follows.

❖❖❖❖ Metric version

Ratio (%) Original →→→→ Copy paper size

400 (enlarge area by 16) --

200 (enlarge area by 4) A5→A3

141 (enlarge area by 2) A4→A3, A5→A4

122 F→A3, A4→B4

115 B4→A3

93 --

82 F→A4, B4→A4

75 B4→F4, B4→F

71 (reduce area by 1/2) A3→A4, A4→A5

65 A3→F

50 (reduce area by 1/4) A3→A5, F→A5

25 --
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❖❖❖❖ Inch version

❖❖❖❖ Zoom
• The reproduction ratio that you can specify are 25-400%.
• You can select a ratio regardless of the size of an original or copy paper.

With some ratios, parts of the image might not be copied or margins will
appear on copies.

❖❖❖❖ Auto Reduce/Enlarge 
• The reproduction ratios you can specify are 25-400%.

❖❖❖❖ Size Magnificatn 
• If the calculated ratio is over the maximum or under the minimum ratio, it

is adjusted to within the available range of ratios automatically. However,
with some ratios, parts of the image might not be copied or margins will
appear on copies. 

• The reproduction ratios you can specify are 25-400%.

❖❖❖❖ Directional Size Magnification
• The reproduction ratio that you can specify are 25-400%.
• When entering a percentage ratio, you can specify any value in the permit-

ted range, regardless of the size of the original or copy paper. However, de-
pending on the setting and other conditions, part of the image may not be
copied, or margins will appear on copies.

• When entering a size in mm, if the calculated ratio is over the maximum or
under the minimum ratio, it is adjusted to within the available range of ra-
tios automatically. However, with some ratios, parts of the image might
not be copied or margins will appear on copies.

Ratio (%) Original →→→→ Copy paper size

400 (enlarge area by 16) --

200 (enlarge area by 4) 51/2" × 81/2"→11" × 17"

155 (enlarge area by 2) 51/2" × 81/2"→81/2" × 14"

129 81/2" × 11"→11" × 17"

121 81/2" × 14"→11" × 17"

93 --

85 F→81/2" × 11"

78 81/2" × 14"→81/2" × 11"

73 11" × 15"→81/2" × 11"

65 11" × 17"→81/2" × 11"

50 (reduce area by 1/4) 11" × 17"→51/2" × 81/2"

25 --
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❖❖❖❖ Sort, Rotate Sort, Stack 
Paper sizes and orientations that can be used in the Sort function are as fol-
lows.

*1 To place paper of size 12" × 18"L use the optional bypass tray.
 
The number of copies that can be placed on the tray is as follows. When the
number of copies exceeds the capacity, remove copies from the tray. 

500-Sheet Finisher 1000-Sheet Finisher

Pa
p

er
 S

iz
e 

an
d

 D
ir

ec
ti

on A3L, B4L, A4KL, B5K, 11" × 
17"L, 81/2" × 14"L, 81/2" × 13"L, 
81/2" × 11"KL, 8KL, 16KK

A3L, B4L, A4KL, B5KL, A5KL, 
51/2" × 81/2"KL, 11" × 17"L, 81/2" × 14"L, 
81/4" × 13"L, 8" × 13"L, 81/2" × 11"KL, 
71/4" × 101/2"KL, 12" × 18"L  *1 , 8KL, 
16KK

Paper Size and Direction Paper Ca-
pacity and 
Weight

In
te

rn
al

 tr
ay

A4KL, B5KL, A5KL, B6L, A6L, 81/2" × 11"KL, 71/4" × 
101/2"KL, 51/2" × 81/2"KL, 16KKL

500 sheets 
*1  (80g/m2) 
(20 lb.)

A3L, B4L, 11" × 17"L, 81/2" × 14"L, 8" × 13"L, 81/2" × 13"L, 81/4" 
× 13"L, 12" × 18"L, 8KL

250 sheets 
*2  (80g/m2) 
(20 lb.)

37/8" × 71/2"K, 41/8" × 91/2"K, C5 EnvK, C6 EnvL, DL EnvK –

In
te

rn
al

 tr
ay

 2
 (1

 b
in

 tr
ay

) A3L, B4L, A4KL, B5KL, A5KL, B6L, A6L, 11" × 17"L, 81/2" 
× 14"L, 81/2" × 11"KL, 71/4" × 101/2"KL, 51/2" × 81/2"L, 8" × 
13"L, 81/2" × 13"L, 81/4" × 13"L, 8KKL, 16KKL

125 sheets 
(80g/m2) 
(20 lb.)

37/8" × 71/2"K, 41/8" × 91/2"K, C5 EnvK, C6 EnvL, DL EnvK —

Sh
if

t s
or

t t
ra

y

A4KL, B5KL, A5KL, B6L, A6L, 81/2" × 11"KL, 71/4" × 
101/2"KL, 51/2" × 81/2"L, 16KKL

250 sheets 
(80g/m2) 
(20 lb.)

A3L, B4L, 11" × 17"L, 81/2" × 14"L, 8" × 13"L, 81/2" × 13"L, 81/4" 
× 13"L, 12" × 18"L, 8KL

125 sheets 
(80g/m2) 
(20 lb.)

UranosC1-ENcopyA_F1_FM.book  Page 110  Friday, July 26, 2002  5:01 PM



Supplementary Informations

111

6
*1 250 sheets when the optional bridge unit is installed.
*2 125 sheets when the optional bridge unit is installed.
*3 B5KL, A5K, 51/2" × 81/2"K, 71/4" × 101/2"KL, 16KKL cannot be shifted.
*4 To place paper of size 12" × 18"L use the optional bypass tray.

Note
❒ When using the Rotate Sort or Staple functions, the capacity may be re-

duced.
❒ When using the Duplex and the Rotate Sort functions together, copying

speed may be reduced.

❖❖❖❖ Staple 
The following type of paper cannot be stapled.
• Translucent paper
• OHP transparencies
• Label paper (adhesive labels)
• Thick paper
• Curled paper
• Paper of low stiffness
• Paper of mixed sizes
In the following cases, the copies will be delivered to the shift tray without
stapling.
• When the number of sheets for one set is over the stapler capacity.
• When memory reaches 0% during copying.

50
0-

Sh
ee

t F
in

is
he

r A4KL, B5KL *3 , A5K *3 , 81/2" × 11"KL, 51/2" × 81/2"K *3 , 71/4" 
× 101/2"KL *3 , 16KKL *3 

500 sheets 
(80g/m2) 
(20 lb.)

A3L, B4L, 11" × 17"L, 81/2" × 14"L, 8" × 13"L, 81/4" × 13"L, 81/2" 
× 13"L, 8KL

250 sheets 
(80g/m2) 
(20 lb.)

10
00

-S
he

et
 F

in
is

he
r

Finisher proof tray

A4KL, B5KL, A5KL, B6L, A6L, 81/2" × 11"KL, 71/4" × 
101/2"KL, 51/2" × 81/2"KL, 16KKL

250 sheets 
(80g/m2) 
(20 lb.)

A3L, B4L, 11" × 17"L, 81/2" × 14"L, 8" × 13"L, 81/2" × 13"L, 81/4" 
× 13"L, 12" × 18"L *4 , 8KL

50 sheets 
(80g/m2) 
(20 lb.)

Finisher shift tray

A4KL, B5KL, A5KL, 71/4" × 101/2"L, 51/2" × 81/2"KL, 
16KKL

1000 sheets 
(80g/m2) 
(20 lb.)

A3L, B4L, 12" × 18"KL, 11" × 17"L, 81/2" × 14"L, 8" × 13"L, 81/4" 
× 13"L, 8KL

500 sheets 
(80g/m2) 
(20 lb.)

Paper Size and Direction Paper Ca-
pacity and 
Weight
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• When paper types is selected to [Thick Paper], [Thick: Dup.Back], [Plain:
Dup.Back], [Label Paper], or [OHP] in the System Settings, stapling cannot be
done.

• 500-Sheet Finisher can staple papers of 64-128g/m2 (17-34lbs) in the paper
weight.

• 1000-Sheet Finisher can staple papers of 64-96g/m2 (17-24lbs) in the paper
weight.

When using Double copies, or "1 Sided 2 Pages→ 1 Sided Combine" and "1
Sided 4 Pages→ 2 Sided Combine" in Combine mode, select K paper for L
original and L paper for K original.
When using "Left 2" or "Top 2" with Double copies, or "1 Sided → 1 Sided", "1
Sided → 2 Sided", "2 Sided → 1 Sided", or "2 Sided → 2 Sided" in Combine
mode, select K paper for L original and L paper for K original.
When the number of copies exceeds the tray capacity, copying stops. In this
case, remove the copies from the shift tray, and then resume copying.

• When the original image is rotated, the staple orientation changes by 90°.
• The maximum original image size that can be rotated is as follows. 

When "Left 2" or "Top 2" is selected, the following settings are useful to rotate
images appropriately:
• "Auto Reduce/Enlarge" or "Auto Paper Select"
• "With image rotation" in "Auto Tray Switching" of User Tools

❖❖❖❖ Duplex 
The following paper sizes can be duplexed: A3L, B4L, A4KL, B5KL,
A5KL, 51/2" × 81/2L, 71/4" × 101/2"L, 81/2" × 11"KL, 8" × 13"L, 81/2" ×
13"L, 81/2" × 14"L, 81/4" × 13"L, 11" × 17"L, 8KL, 16KKL
You cannot use the following copy paper with this function: 
• Paper thicker than 105g/m2, 28 lb.
• Paper thinner than 64g/m2, 17 lb.
• Translucent paper

Paper size Stapler capacity

500-Sheet Finisher A3L, B4L, A4KL, B5K, 11" 
× 17"L, 81/2" × 14"L, 81/2" × 
13"L, 81/2" × 11"KL, 8KL, 
16KK

30 sheets (80g/m2)

1000-Sheet Finisher A3L, B4L, 12" × 18"L, 11" × 
17"L, 81/2" × 14"L, 81/2" × 
13"L, 81/4" × 13"L, 8" × 13"L, 
8KL

30 sheets (80g/m2)

A4KL, B5KL, 81/2" × 
11"KL, 71/4" × 101/2"KL, 
16KKL

50 sheets (80g/m2)

Metric version A4

Inch version 81/2" × 11"
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• Label paper (adhesive labels)
• OHP transparencies
• Envelopes
When an odd number of originals is set in the optional document feeder, the
back of the last page of copied paper is blank. During copying, the image is
shifted to allow for the binding margin.
• When an odd number of originals is set in the optional document feeder,

the back of the last page of copied paper is blank. During copying, the im-
age is shifted to allow for the binding margin.

❖❖❖❖ Combine 
• You cannot use the bypass tray with this function.
• If the calculated ratio is under the minimum ratio, it is adjusted to within

the available range of ratios automatically. However, with some ratios,
parts of the image might not be copied.

• You cannot use custom size paper.
• In this mode, the machine selects the reproduction ratio automatically.

This reproduction ratio depends on the copy paper sizes and the number
of originals.

• The reproduction ratios you can specify are 25-400%.
• A separation line between originals can be printed with the User Tools. ⇒

p.103 “Separation Line in Combine” 
• If the direction of originals is different from that of the copy paper, the ma-

chine will automatically rotate the image by 90° to make copies properly.
• If the number of originals placed is less than the number specified for com-

bining, the last page is left blank as shown in the illustration.

❖❖❖❖ Repeat
Depending on the paper size, ratio, and orientation of the paper, parts of re-
peated images may not be copied.

❖❖❖❖ Centering 
Though the original is set to a different orientation than the paper, the ma-
chine will not rotate the image by 90° (Rotate copy).

❖❖❖❖ Margin Adjustment 
If you set a binding margin that is too wide, part of the image may not be cop-
ied. When making copies in Combine mode, the binding margin is added to
the copies after the combination is finished.
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❖❖❖❖ Erase 
The width of the erased margin varies depending on the reproduction ratio.
This function is available for the following paper sizes.
• Metric version

• Inch version

❖❖❖❖ Preset Stamp 
You can change the size and density of the stamp with the User Tools. De-
pending on the setting, color density may change. 
Depending on the paper size, if you change the stamp size, parts of the stamp
might not be printed.

❖❖❖❖ Date Stamp 
When using the Combine mode, the date stamp is printed as follows.

Where Original Is Set Paper Size and Orientation

Exposure glass A3L, B4L, A4KL, B5KL, 81/2" × 13"L

Document feeder A3L, B4L, A4KL, B5KL, A5KL, 81/2" × 13"L

Where Original Is Set Paper Size and Orientation

Exposure glass 11" × 17"L, 81/2" × 14"L, 81/2" × 11"KL

Document feeder 11" × 17"L, 81/2" × 14"L, 81/2" × 11"KL, 10" × 
14"L, 51/2" × 81/2"KL
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❖❖❖❖ Page Numbering 
When page numbering is used with Combine mode, page numbers are print-
ed as follows.
• Page Numbering per original:

Combined with 1 Sided/2 Sided in the Combine function

• Page Numbering per copy:
Combined with 1 Sided/2 Sided in the Combine function

If you combine this function with the Duplex ( Top to Top ) function and se-
lect the "P1, P2" or "1/n, 2/n" style, the page numbers on the back of the copy
paper are printed as follows.

1. Front

2. Back

❖❖❖❖ Front Cover, Front/Back Cover 
• Front and back covers are 2-sided copied depending on the settings made

in the "Display Time" in the "Cover Sheet Tray" of the User Tools (System
Settings). If the "Display Time" is selected to the "At Mode selected", set-
tings made in the "Cover Sheet Tray" has the priority. If the "Display Time"
is selected to the "Full Time Selected", settings made in the "Paper Type"
has the priority.

GCSTMPBE

1 2
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1 sided → 2 sided,   46
1 sided combine

1 sided 2 pages → combine 1 side,   48
1 sided 4 pages → combine 1 side,   48
1 sided 8 pages → combine 1 side,   48
2 sided 1 page → combine 1 side,   48
2 sided 2 pages → combine 1 side,   48
2 sided 4 pages → combine 1 side,   48

2 Sided → 1 Sided,   46
2 sided → 2 sided,   46
2 sided combine

1 sided 16 pages → combine 2 side,   49
1 sided 4 Pages → combine 2 side,   49
1 sided 8 pages → combine 2 side,   49
2 sided 16 pages → combine 2 side,   50
2 sided 4 pages → combine 2 side,   49
2 sided 8 pages → combine 2 side,   50

2-sided paper,   11
90° turn,   12

A

Accessing user tools
copy/document server features,   97

A.C.S.
priority,   106
sensitivity,   106

Adjust Color Image,   106
Adjusting

background density,   76
colors based on selected color,   79
contrast,   76
copy image density,   29
sharp/soft,   76
text/photo sensitivity,   77
U.C.R.,   77

Adjust/Program Color key,   5
Auto

color select,   25
image density,   29
image density priority,   92
paper select,   31
paper select priority,   91
reduce/enlarge,   36
start,   18
tray switching,   98

Auto color calibration,   77
Auto paper select,   32

B

Background density of ADS 
(Full Color/Two-color),   106

Basic procedure,   17
Batch mode,   14
Black/white copy,   25
Border erase,   58

C

Center/border erase,   59
Center erase,   59
Change

stamp position,   62, 65
style of date,   65

Changing
number of sets,   41
registered contents,   75
stamp color,   61, 62, 65, 67
stamp density,   61
stamp position,   67
stamp position, size and density,   61
stamp size,   61
stored program,   83

Check Modes key,   5
Clear Modes key,   5
Clear/Stop key,   6
Color

adjustment,   73
adjustment/program,   73
background,   27
balance,   74
balance program,   74
circle,   5
functions,   25
mode priority,   100
selection key,   6

Color Adjustment,   i, 73
Color functions

convert colors,   26
erase color,   27
selecting a color mode,   25

Color image setting
color sensitivity,   106

Colors
mixing manually with number keys,   81

Combination chart,   107
Combined auto and manual image 

density,   29
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Control panel,   5
Copy/document server features,   91
Copy functions,   29

1 sided combine,   48
2 sided combine,   49
adjusting copy image density,   29
auto reduce/enlarge,   36
centering,   54
covers,   69
date stamp,   64
directional magnification (%),   37
directional size magnification (mm),   38
double copies,   54
duplex,   46
image repeat,   52
margin adjustment,   56
mirror,   56
page numbering,   66
positive/negative,   55
preset reduce/enlarge,   34
preset stamp,   60
selecting copy paper,   31
selecting original type setting,   30
series copies,   51
size magnification,   37
slip sheets,   70
sort,   39
specified area repeat,   53
stack,   42
staple,   43
user stamp,   61
zoom,   35

Copying,   17
auto start,   18
interrupt copy,   18
job preset,   19
original beeper,   18
with registered contents,   75

Copying from bypass tray
on the back side of paper,   23
onto custom size paper,   20, 21
onto envelopes,   22
onto special paper,   22
onto standard size paper,   21

Covers
Front,   69
front/back,   70

Create margin mode,   35

D

Date stamp,   104
change position,   65
change style,   65
changing color,   65
color,   105
font,   104
position,   105
position and original orientation,   64
size,   104
stamp format,   104
superimpose,   105

Deleting
program,   83
registered contents,   75
user colors,   81
user stamp,   64

Direction-fixed paper,   11
Display panel,   5
Document server,   72

E

Edit,   94, 101
1 sided→2 sided auto margin − T to B,   101
1 sided→2 sided auto margin − T to T,   101
back margin − left/right,   101
back margin − top/bottom,   101
copy order in combine,   101
double copies separation line,   102
erase border width,   101
erase center width,   101
erase original shadow in combine,   101
front cover copy in combine,   101
front margin − left/right,   101
front margin − top/bottom,   101
image repeat separation line,   102
separation line in combine,   103

Energy Saver key,   5
Erase,   57

border,   57
border width,   101
center,   57
center/border,   58
center width,   101
color,   27
original shadow in combine,   101

Exiting from user tools,   97
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F

Font,   104
Format,   104
Full color copy,   25
Function keys,   6
Function Status indicator,   6

G

General features,   91, 92, 98, 99, 100
auto image density priority,   100
auto paper select priority,   98
auto tray switching,   98
change initial mode,   99
clear bypass mode,   100
color mode priority,   100
copy function key,   99
copy orientation in duplex mode,   99
document server storage key,   99
duplex mode priority,   99
job end call,   99
max. copy quantity,   99
original orientation in duplex mode,   99
original photo type priority,   98
original type display,   98
original type priority,   98
paper display,   98
tone − original remains,   99
two-color mode priority,   100

Generation copy,   30

I

Image adjustment,   76
background density,   76
contrast,   76
sharp/soft,   76
text/photo sensitivity,   77
U.C.R.,   77

Image repeat
specified area repeat,   53
whole area repeat,   52

Indicators,   5
Input/Output,   96, 105

auto sort,   105
letterhead setting,   106
memory full auto scan restart,   105
rotate sort − auto paper continue,   105
SADF auto reset,   105
select stack function,   106
switch to batch (SADF),   105

Interrupt key,   5

K

Key
adjust/program color,   5
check modes,   5
clear modes,   5
clear/stop,   6
energy saver,   5
interrupt,   5
program,   5
sample copy,   6
# (sharp),   6
start,   6
user tools/counter,   5

M

Main power indicator,   5
Manual image density,   29
Manual paper select,   32
Map,   30
Messages,   85
Missing image area,   10
Mixed size mode,   15

N

Non-recommended originals for 
document feeder,   7

Number keys,   6

O

OHP transparencies,   71
Operation switch,   6
Original

beeper,   18
combine,   48
copy direction,   47
direction and completed copies,   46
orientation,   12
orientation in duplex mode,   99
photo type priority,   98
type display,   98
type priority,   98

Originals,   7
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P

Page numbering,   104
color,   67
duplex back page stamping position,   104
first printing page,   67
font,   104
page numbering in combine,   105
position,   67
position and original orientation,   61
size,   104
stamp color,   105
stamp format,   104
stamp on designated slip sheet,   105
stamp position,   105
start number,   67
superimpose,   105

Pale,   30
Photo,   30
Placing

custom size originals,   16
originals,   7, 12, 13, 16
originals in document feeder,   13
originals on exposure glass,   13

Preset stamp,   103
changing color,   61
changing density,   61
changing position,   61
changing size,   61
color,   103
format,   103
language,   103
position,   103
position and original direction,   60
priority,   103

Program key,   5
Programs,   82

R

Recalling a program,   83
Renaming a color,   80, 81
Reproduction ratio,   93, 100

enlarge,   100
priority setting − enlarge,   100
priority setting − reduce,   100
ratio for create margin,   100
reduce,   100
R/E priority,   100
shortcut R/E,   100

Rotated copy,   33

S

SADF mode,   14
Sample copy,   41
Sample copy key,   6
Sampling user colors,   81
Screen contrast knob,   5
Selecting

color mode,   25
copy paper,   31
original type setting,   30

Series copies
book → 1 sided,   51
book → 2 sided,   51
front & back → 2 sided,   51

# (sharp) key,   6
Single color copy,   25
Size,   104
Sizes

detectable by auto paper select,   8
difficult to detect,   9
of recommended originals,   7

Sort,   39
rotate sort,   39
shift sort,   40

Specifications,   107
Stack,   42

stack,   42
Stamp,   103

color,   103
colors,   104
date stamp,   64
format,   103, 104
language,   103
page numbering,   66
position,   103, 104
position and original orientation,   61, 

64, 66
preset stamp,   60
priority,   103
setting,   104
user stamp,   61

Standard orientation,   12
Stapling position and original setting,   43
Start key,   6
Storing

adjusted color balance,   74
originals,   72
program,   82

Superimpose,   104
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Supplementary specifications,   108
auto reduce/enlarge,   109
bypass tray copy,   108
centering,   113
combine,   113
date stamp,   114
directional size magnification,   109
duplex,   112
erase,   114
front/back cover,   115
front cover,   115
margin adjustment,   113
page numbering,   115
preset enlarge/reduce,   108
preset stamp,   114
repeat,   113
rotate sort,   110
size magnification,   109
sort,   110
stack,   110
staple,   111
zoom,   109

T

Text,   30
Text/Photo,   30
Tone − original remains,   99
Troubleshooting,   85

memory is full,   90
you cannot make clear copies,   87
you cannot make copies as you want,   88
your machine does not operate as you 

want,   85
Two color copy,   25
Types of duplex copies,   iv

U

User color,   79
User stamp,   104

changing color,   62
changing position,   62
colors,   104
delete,   64
format,   104
position,   104
position and original orientation,   61
program,   62
program/delete,   104

User tools,   91
User Tools/Counter key,   5

W

Weights of recommended originals,   7
What you can do with this machine,   i, iv
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In accordance with IEC 60417, this machine uses the following symbols for the main power switch:

aaaa means POWER ON.

bbbb means POWER OFF.

cccc means STAND BY.

Introduction

This manual contains detailed instructions on the operation and maintenance of this machine. To get
maximum versatility from this machine all operators should carefully read and follow the instructions in
this manual. Please keep this manual in a handy place near the machine.

Notes

Some illustrations may be slightly different from your machine.

Certain options may not be available in some countries. For details, please contact your local dealer.

Warning:

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Notes:

The model names of the machines do not appear in the following pages. Check the type of your ma-
chine before reading this manual. (For details, ⇒ P.3 “Machine Types”.)

• Type 1: 24 copies/minute (81/2" × 11"K)

• Type 2: 32 copies/minute (81/2" × 11"K)

Certain types might not be available in some countries. For details, please contact your local dealer.

Two kinds of size notation are employed in this manual. With this machine refer to the inch version.

For good copy quality, the supplier recommends that you use genuine toner from the supplier.

The supplier shall not be responsible for any damage or expense that might result from the use of parts
other than genuine parts from the supplier with your office products. 

Power Source

120V, 60Hz, 12A or more

Please be sure to connect the power cord to a power source as above. For details about power source,
see “Power Connection” in the General Settings Guide.



Paper type: OK Prince Eco G100(55kg), Paper Thickness=80 µm // Pages in book=128 // Print scale=81%
Gap (when printed at 81% scale)  = Pages in book  ×  Paper thickness  /  2  = 5.120000 mm

B0516607A

Type for C2408/DSc224/LD024c/Aficio 1224C

Operating Instructions

Copy Reference

For safe and correct use of this machine, please be sure to read the Safety Information in the
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Printer/Scanner Kit
Type 1232

Operating Instructions

Printer Reference 1

Getting Started

Installing the Printer Driver and Software

1

2

For safe and correct use of this machine, please be sure to read the Safety Information in the
“General Settings Guide” before you use it.



Introduction

This manual describes detailed instructions on the operation and notes about the use of this machine.
To get maximum versatility from this machine all operators are requested to read this manual carefully
and follow the instructions. Please keep this manual in a handy place near the machine.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Warning:

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe®, PostScript®, Acrobat® and PageMaker® are registered trademarks of Adobe Systems Incor-
porated.

PCL® is a registered trademark of Hewlett-Packard Company.

AppleTalk, Apple, Macintosh, Mac and TrueType are registered trademarks of Apple Computer, Incor-
porated.

IPS-PRINT™ Printer Language Emulation Copyright© 2000, Oak Technology, Inc., All Rights Re-
served.

Ethernet® is a registered trademark of Xerox Corporation.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

The proper names of the Windows operating systems are as follows:

• The product name of Windows® 95 is Microsoft® Windows® 95

• The product name of Windows® 98 is Microsoft® Windows® 98

• The product name of Windows® Me is Microsoft® Windows®  Millennium Edition (Windows Me)

• The product name of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

• The product name of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

• The product name of Windows® NT are as follows:
Microsoft® Windows NT® Server 4.0
Microsoft® Windows NT® Workstation 4.0

Notes:

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.
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Manuals for This Machine

The following manuals describe the operational procedures and maintenance of
this machine.
To enhance safe and efficient operation of this machine, all users should read
and follow the instructions carefully.

❖❖❖❖ General Settings Guide
Provides an overview of the machine. This manual introduces the functions
of the machine. It also introduces the options that allow you to use additional
functions and describes how to access the system user tools to make the ma-
chine easier to use.

❖❖❖❖ Copy Reference
Describes procedures and functions for using this machine as a copier.

❖❖❖❖ Printer/Scanner Kit Type 1232 Printer Reference 1
Describes system settings, procedures and functions for using this machine as
a printer (this manual).

❖❖❖❖ Printer/Scanner Kit Type 1232 Printer Reference 2
Describes procedures and provides information about using this machine as
a printer. This manual is included as a PDF file on the CD-ROM labeled “Op-
erating Instructions”.

❖❖❖❖ Network Printing Guide Operating Instructions
Describes procedures and provides information about setting up and using
the machine as a printer in a network environment. We recommend you read
this manual first. It is included as a PDF file on the CD-ROM labeled “Oper-
ating Instructions” .

❖❖❖❖ PostScript 3 Board Type 1232 Operating Instructions Supplement
Describes menus and features you can set using the PostScript 3 printer driv-
er. This manual is provided as a PDF file on the CD-ROM labeled “Operating
Instructions”.

Note
❒ Printing with the PostScript 3 printer driver is available when the Post-

Script 3 board option is installed on your machine.

❖❖❖❖ UNIX Supplement
Provides information about setting up and using the machine as a printer in
a UNIX environment. For UNIX printing information, please visit our web
site or consult your authorized dealer.

❖❖❖❖ Scanner Reference
Describes system settings, procedures and functions for using this machine as
a scanner.

Note
❒ Scanner function is available when the Printer/Scanner option is installed

on your machine.



2

How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

R CAUTION:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates the prior knowledge or preparations required before op-
erating.

Note
This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys and buttons that appear on the computer's display.
Keys that appear on the machine's panel display.

{ }
Keys built into the machine's control panel.
Keys on the computer's keyboard.



1. Getting Started
Features of This Machine

This machine is designed especially for office workgroups, both for shared us-
age within a network environment, and for one-to-one usage connected directly
to a computer.

❖❖❖❖ Standard compatibility with Windows 95/98/Me, Windows 2000, Windows XP and
Windows NT 4.0
As the printer drivers for the above operating systems are included, it is pos-
sible to print to maximum capacity by using the special features of this ma-
chine.

❖❖❖❖ Network Connectivity
This machine can be used as a network printer.
It can print from any environment as it supports at the same time NetWare
(TCP/IP, IPX/SPX), Windows 95/98/Me (TCP/IP, NetBEUI), Windows 2000
(TCP/IP, NetBEUI), Windows XP (TCP/IP), Windows NT 4.0 (TCP/IP, Net-
BEUI), UNIX (TCP/IP), and Macintosh (AppleTalk).
If you register the user code by using the client, you can keep track of printing
jobs done under each code.

❖❖❖❖ Use the Network Utilities included at your own convenience.
When you use “SmartNetMonitor for Client” and “SmartNetMonitor for Ad-
min” network utilities, you can parallel print, allowing you to scatter large
amounts of print sets across multiple printers; or alternative print, which al-
lows you to use another printer when you can not access the network printer
you are trying to use. Also, while at your workstation, the machine will notify
you when the print job is completed. 

❖❖❖❖ Complete Paper Handling Option
When the optional finisher is connected, you can collate and staple.

❖❖❖❖ Using the Document Server
The document server stores files sent from the computer on the hard disk of
the machine. Later, the printer settings can be configured and the files print-
ed. Even when this machine is used as a network printer, passwords can be
assigned to each file, providing a high level of security. Also, you can com-
bine and print files scanned by this machine.
3
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Printer Drivers for This Machine

Printing requires installation of a printer driver for your operating system. The
following drivers are included on the CD-ROM labeled “Printer Drivers and
Utilities” that comes with the printer/scanner option of this machine.

*1 Microsoft Windows 95 operating system
*2 Microsoft Windows 98 operating system
*3 Microsoft Windows Millennium Edition
*4 Microsoft Windows 2000 Advanced Server

Microsoft Windows 2000 Server
Microsoft Windows 2000 Professional

*5 Microsoft Windows XP Professional
Microsoft Windows XP Home Edition

*6 Microsoft Windows NT Server operating system version 4.0, Microsoft Windows NT
Workstation operating system version 4.0 in a computer using x86 processors.

*7 Versions 8.6 to 9.2 of the Mac OS (Mac OS X Classic mode is supported.)
*8 Mac OS X 10.1 or later (Native mode)
*9 Requires Service Pack 4 or later.
*10 Requires Service Pack 6 or later.
*11 The Adobe PostScript 3 printer drivers and PostScript Printer Description (PPD) files

are included on the CD-ROM labeled “Printer Drivers and Utilities”.
*12 The PostScript Printer Description (PPD) files are included on the CD-ROM labeled

“Printer Drivers and Utilities”.
*13 The Adobe PostScript Printer Description (PPD) installer is included on the CD-

ROM labeled “Printer Drivers and Utilities”.

❖❖❖❖ PCL 5c printer drivers
The PCL 5c printer drivers are included on the CD-ROM that comes with this
machine. This printer driver allows the computer to communicate with the
machine via a printer language.
⇒ p.27 “Installing the PCL 5c/RPCS™ Printer Driver” 

Printer Language  PCL 5c  RPCS™  PostScript 3 

Operating system 

Windows 95 *1 √ √ √ *11 

Windows 98 *2 √ √ √ *11 

Windows Me *3 √ √ √ *11 

Windows 2000 *4 √ √ √ *12 

Windows XP *5 √ √ √ *12 

Windows NT 4.0 *6 √ *9 √ *9 √ *10  *11 

Mac OS *7 √ *11 

Mac OS X *8 √ *13 



Printer Drivers for This Machine

1

❖❖❖❖ RPCS™ printer driver
The RPCS™ printer drivers are included on the CD-ROM that comes with
this machine. This printer driver allows the computer to communicate with
the machine via a printer language. The preset type user interface is provided
in addition to the conventional one.
⇒ p.27 “Installing the PCL 5c/RPCS™ Printer Driver” 

❖❖❖❖ Adobe PostScript 3 Printer Drivers and PPD files
The Adobe PostScript 3 printer drivers and the PPD files are included on the
CD-ROM that comes with this machine. This printer driver allows the com-
puter to communicate with the printer via a printer language. The PPD files
allow the printer driver to enable the printer specific functions.
⇒ p.31 “Installing the PostScript 3 Printer Driver” 
5
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Software and Utilities Included on the CD-
ROM

There are three CD-ROMs that come with the printer/scanner option of this ma-
chine.

Note
❒ The Printer/Scanner Kit Type 1232 package contains the following CD-

ROMs:
• Printer Drivers and Utilities
• Scanner Driver and Document Management Utilities
• Operating Instructions

The CD-ROM labeled “Printer Drivers and Utilities” is mainly used for machine
printer functions. In this manual, “CD-ROM” refers to the “Printer Drivers and
Utilities” CD-ROM unless specified otherwise.

❖❖❖❖ SmartNetMonitor for Admin 
This utility is for the system administrator to manage printers on the network.

Reference
See SmartNetMonitor for Admin online Help for more information about
using the SmartNetMonitor for Admin.

❖❖❖❖ SmartNetMonitor for Client 
This utility is for users to manage their own print status on the network.

Reference
See SmartNetMonitor for Client online Help for more information about
using the SmartNetMonitor for Client.

❖❖❖❖ LAN-Fax Driver
This utility enables you to fax documents directly from your computer.

❖❖❖❖ Address Book
This utility enables you to easily store and recall names and numbers for use
with the LAN-Fax utility.

❖❖❖❖ Agfa Monotype Font Manager 2000
This utility helps you to install new screen fonts, or organize and manage
fonts already installed on the system.

❖❖❖❖ 1394 Utility
This utility is for the IEEE 1394 Interface Unit. For more information, see the
Readme file or the manual that comes with the IEEE 1394 Interface Unit op-
tion.
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❖❖❖❖ Acrobat Reader
This utility allows you to read PDF (Portable Document Format).

Note
❒ Documentation about using the machine is included on the CD-ROM in

PDF format. See Acrobat Reader online Help for more information about
using Acrobat Reader.

❖❖❖❖ Printer Utility for Mac
This utility allows users to download and manage a variety of fonts as well as
to manage their printers. For more information about this utility, see the Post-
Script 3 Board Type 1232 Operating Instructions Supplement which is provided
as a PDF file on the CD-ROM labeled “Operating Instructions”.

Important
❒ Software and utilities must be uninstalled before installing newer versions of

Windows. Reinstall software and utilities after upgrading Windows.
7
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Guide to This Machine

Control Panel

1. {{{{User Tools/Counter/Inquiry}}}} key
• User Tools

Press to change the default settings
and conditions to meet your require-
ments.

• Counter
Press to display or print the total num-
ber of copies made.

• Inquiry
Press to check where to contact to
have the machine repaired or to order
toner.

2. Display panel
Shows operation status, error messages,
and function menus. ⇒ p.9 “Display Pan-
el” 

3. {{{{Energy Saver}}}} key
Press to switch to and from the Energy
Saver mode. See “ENERGY STAR Pro-
gram”, General Settings Guide .

Note
❒ This key is ineffective during system

setting (User Tools) operations.

4. Main power indicator 
This indicator goes on when the main
power switch is turned on.

Important
❒ Do not turn off the main power

while the On indicator is blinking.
Doing so may damage the hard
disk.

5. On indicator
This indicator goes on when the opera-
tion switch is turned on.

6. Operation switch
Press this switch to turn the power on
(the On indicator goes on). To turn the
power off, press this switch again (the On
indicator goes off).

7. {{{{Clear/Stop}}}} key
• Clear

Deletes one character or digit.
• Stop

Interrupts the current print job in
progress.

8. {{{{#}}}} key
Press to enter a value.

ZGJS800E
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9. Number keys
Use to enter the desired number of copies
and data for selected modes.

10. Function keys
Press the appropriate key to choose any
of the following functions:

• Copy
• Document Server
• Facsimile
• Printer
• Scanner

11. Function status indicator
These show the status of the above func-
tions:

• Yellow: the function is selected.
• Green: the function is active.
• Red: the function has been interrupt-

ed.

12. mmmmData In indicator
The Data In indicator shows the status of
data reception from a computer.

• This indicator blinks when data is be-
ing received.

• This indicator goes on when there is
data remaining to be printed.

Display Panel

The display panel shows the status of the machine, error messages and function
menus.

Important
❒ Do not apply a strong shock or force of about 30 N *1  (about 3 kgf *2 ) or more

to the display panel. Otherwise, the display can get damaged.
*1  N = Newton
*2  kgf = Kilogram force (1kgf  9.8N)

Note
❒ The function items displayed serve as selector keys. You can select or specify

an item by lightly pressing on it.
❒ When you select or specify an item on the display panel, it becomes highlight-

ed.
❒ Keys dimmed (ex. ) cannot be used.OK
9
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Displays and Key Operations

Note
❒ The screen displayed when the power is turned on is the copier screen which

is the factory set default. This initial setting can be changed. See “User Tools
(System Settings)”, General Settings Guide.

❒ The following illustrations are examples for the machine with the options in-
stalled. See “External Options”, General Settings Guide.

❖❖❖❖ Initial print display

1. Operational status or messages 2. The current settings as well as the
functions which can be selected are
displayed.

Note
❒ The item which is currently selected

or specified is highlighted.

Common Key Operation

The following keys can be used in all screens.

❖❖❖❖ Key explanations

1

2

[OK] Acknowledges a selected function or entered values, and then re-
turns to the previous screen.

[Cancel] Deletes a selected function or entered values, and then returns to 
the previous screen. 

[UUUUPrev.]   [TTTTNext] Moves to the previous page or the next page when all the func-
tions cannot be displayed on one page.

[OK] [Yes] Closes message screens.

[Clear] Clears entered values and does not change the screen.

[Exit] Returns to the previous screen.
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Online

When the machine is online, it can receive data from the computer.

1. [Online] key
Press this key to switch the machine on-
line. The preceding illustration shows the
online status. 

2. [Job Reset] key
Press this key to cancel the current print
job.

Offline

When the machine is offline, it cannot receive data from the computer.

1. [Offline] key
Press this key to switch the machine of-
fline. The preceding illustration shows
the offline status. 

Note
❒ If the machine cannot be switched to offline status, change the system setting

of [Signal Control] to “Printer priority”. For details about the setting, see “User
Tools (System Settings)”, General Settings Guide.

❒ When “Job acceptance priority” is set for the system setting of [Signal Control],
the machine accepts print jobs and facsimile transmissions from computers
even when the offline status is indicated. For details about the setting, see
“User Tools (System Settings)”, General Settings Guide.

1

2

1
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Connecting the Machine

This section gives instructions for connecting the machine and computer using
the parallel port.

Reference
For Ethernet and IEEE 1394 interface connections, see “Connecting to the Ma-
chine (Network Connections)”, General Settings Guide.

Requirements

Before using this machine, make sure that all the environmental and electrical
requirements have been met. Connect the machine to the host computer using
the parallel port, network interface unit, or both.
Make sure that all the cables, connectors, and electrical outlets necessary to at-
tach the machine to the host computer or network are present.

Parallel cable requirements

Connect the machine to the host computer using a parallel port. This machine
does not provide the parallel cable to connect the machine to the host computer.
The machine's parallel interface is a standard bidirectional interface. It requires
a standard IEEE 1284 compliant 36-pin parallel cable and a parallel port on the
host computer. Make sure to purchase the appropriate cable for the machine and
your computer.

Note
❒ Do not use a parallel cable that is longer than 3 meters (10 feet).
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Connecting the Machine to the Host Using the Parallel Cable

Connect the machine to the host computer using a parallel cable compliant with
IEEE 1284 (supplied by you).
Follow the procedure below to connect the machine to the host computer.

Important
❒ Before connecting an interface cable between the machine and a computer,

make sure that the machine is not operating, and then turn off the main power
switch of the machine and computer.

❒ Be sure to use the designated interface cable. Using another cable may cause
radio interference.

AAAA Turn off the main power switch.

Important
❒ Before turning off the main power switch, see “Turning Off the Power”,

General Settings Guide.

BBBB Plug the 36-pin end of the parallel cable into the parallel port at the right
side of the back cover of the machine.

CCCC Squeeze the wire clips on each side of the connector together until they
snap into place. The clips hold the cable securely in place. 

DDDD Plug the other end of the parallel cable into the computer's parallel port.

ZGPH090E
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Setting Paper on the Bypass Tray

This section gives instructions for setting paper on the optional bypass tray. Use
the bypass tray to print onto OHP transparencies, labels, and envelopes that can-
not be loaded in the paper tray.

Reference
For setting paper into the regular paper tray, see the General Settings Guide.

Note
❒ The paper size that can be set in the bypass tray: 

• Vertical: 90 - 297 mm (3.5 in. - 11.7 in.) 
• Horizontal: 148 - 432 mm (5.8 in. - 17 in.)

❒ Make sure to set the paper in landscape orientation L in the bypass tray.

Important
❒ When printing using the printer function, original images are always rotated

by 180 degrees (the orientation of images to be printed is opposite to that of
the copier function). When printing onto paper with specific orientation re-
quirements, such as envelopes and letterheads, make sure to rotate the paper
feed direction to 180 degrees.

❒ The following functions are disabled when printing from the bypass tray: 
• Duplex Printing
• Auto Tray Select
• Auto Tray Switching

❒ Make sure to set the paper size using the printer driver when printing data
from the computer. The paper size set using the printer driver has priority
over the one set using the display panel.

❒ Make sure to set the paper to landscape orientation L in the printer driver
when printing data from the computer.

AAAA Open the bypass tray.

ZGPH100E
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BBBB Adjust the paper guides to the paper size.

Important
❒ If the paper guides are not flush against the paper, skewed images or paper

misfeeds might occur.

CCCC Gently insert the paper face down in the bypass tray until the beeper sounds.

1. Extender

2. Paper guides

Note
❒ The beeper will not sound if it is turned off. Gently insert the paper until it

stops.
❒ Do not stack paper over the limit mark, otherwise a skewed image or paper

misfeeds might occur.
❒ Open out the extender to support paper sizes larger than A4 L, 81/2"×11" L.
❒ Fan the paper to get air between the sheets to avoid a multi-sheet feed.
❒ When setting an OHP transparency, make sure that its front and back sides

are properly positioned.
❒ Select the paper type when printing on OHP transparencies or thick paper

(over 105g/m2). For details, see p.18 “Setting thick paper or OHP transpar-
encies”.

DDDD Select the paper size.

Note
❒ You can set paper size using the printer driver. The following procedures

are not necessary when setting paper size using the printer driver.
❒ The paper size set using the printer driver has priority over that set using

the display panel.
❒ When the printer driver is not used, make settings using the display panel.

Reference
For printer driver settings, see the printer driver's Help.
For setting custom sizes, see p.17 “Setting custom size paper”

ZGPH110E
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Setting the Paper Size on the Display Panel

AAAA  Press the {{{{User Tools/Counter/Inquiry}}}} key on the control panel.

BBBB Press [Printer Features].

CCCC Press the [Paper Input] tab.

DDDD Press [Bypass Paper Size].

EEEE Select the paper size.

Note
❒ Press [UUUUPrev.] or [TTTTNext] to scroll through the list.
❒ When printing onto thick paper or OHP transparencies, select the paper

type. For details, see p.18 “Setting thick paper or OHP transparencies”.

FFFF Press [OK].

GGGG  Press the {{{{User Tools/Counter/Inquiry}}}} key.

ZFFH801E
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Setting custom size paper

Note
❒ Custom sizes can also be set using the printer driver. The following proce-

dures are not necessary when setting custom sizes using the printer driver.
❒ Custom size settings set using the printer driver have priority over those in

the display panel on the machine.
❒ When the printer driver is not used, make settings using the display panel.

Reference
For printer driver settings, see the printer driver's Help. 

AAAA Press the {{{{User Tools/Counter/Inquiry}}}} key on the control panel.

BBBB Press [Printer Features].

CCCC Press the [Paper Input] tab.

DDDD Press [Bypass Paper Size].

EEEE Press [Custom Size].

FFFF Enter the vertical size of the paper with the number keys, and then press [#].

GGGG Enter the horizontal size of the paper with the number keys, and then press [#].

HHHH Press [OK].

The paper sizes you entered are displayed.

IIII Press the {{{{User Tools/Counter/Inquiry}}}} key.

ZFFH801E
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Setting thick paper or OHP transparencies

Note
❒ Paper settings can also be set using the printer driver. The following proce-

dures are not necessary when setting paper sizes using the printer driver.
❒ Paper size settings set using the printer driver have priority over those in the

display panel on the machine.
❒ When the printer driver is not used, make settings using the display panel.

Reference
For printer driver settings, see the printer driver's Help.

AAAA Press the {{{{User Tools/Counter/Inquiry}}}} key on the control panel.

BBBB Press [System Settings].

CCCC Press the [Tray Paper Settings] tab.

DDDD Press [TTTTNext] to scroll the list.

EEEE Press [Paper Type : Bypass tray].

ZFFH801E
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FFFF Select [OHP] or [Thick Paper.]

GGGG Press [OK].
The paper type you selected is displayed.

HHHH Press the {{{{User Tools/Counter/Inquiry}}}} key.

Note
❒ The settings made will remain valid until they are reset again. After print-

ing on OHP transparencies or thick paper, make sure to reset the settings
for the next person.
19
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2. Installing the Printer Driver
and Software
This manual assumes that you are familiar with general Windows procedures
and practices. If you are not, see the documentation that comes with Windows
for details.

Installation Method

❖❖❖❖ Installing using Auto Run
Inserting the CD-ROM into the CD-ROM drive starts the installer automati-
cally. The installer helps you install the following printer drivers and soft-
ware easily.
The following table shows the printer drivers and software that can be in-
stalled using Auto Run.

*1 Available operating systems are as follows: Windows 95/98/Me, Windows
2000/XP, Windows NT 4.0. Auto Run is unavailable with Macintosh.

Reference
When the machine is connected to the computer using the IEEE 1394 inter-
face, see p.43 “Installing the Printer Driver Using IEEE 1394” .

Auto Run *1 

Quick Install Add Printer and 
Utility Wizard

Network connection 
with TCP/IP

Parallel connection

PCL 5c printer driver ❍ ❍ ❍

RPCS™ printer driver ❍ ❍ ❍

PostScript 3 printer 
driver

❍

Agfa Monotype Font 
Manager 2000

❍

SmartNetMonitor for 
Admin

❍

SmartNetMonitor for 
Client

❍ ❍

LAN-Fax Driver ❍

Address Book ❍
21
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❖❖❖❖ Installing manually
The following printer drivers and software cannot be installed using Auto
Run.
For Macintosh

• PostScript 3 Printer Driver for Macintosh
⇒ p.38 “Mac OS - Installing the PostScript 3 Printer Driver and Utilities”

• PostScript Printer Descriptions Files (PPD)
The PPD files for Mac OS 8.6 to 9.2, and Mac OS X are different.
⇒ p.38 “Mac OS - Installing the PostScript 3 Printer Driver and Utilities”
⇒ p.42 “Mac OS X - Installing the PostScript 3 Printer Driver”

• Adode Type Manager (ATM)
⇒ p.40 “Installing Adobe Type Manager (ATM)”

• Screen Fonts
⇒ p.41 “Installing screen fonts”

• ColorSync™ Profiles
⇒ p.40 “Installing the ColorSync™ profile”

• Printer Utility for Mac
For installing the software, see the PostScript 3 Board Type 1232 Operating
Instructions Supplement.

For Windows
• 1394 Utility 

For installing the utility, see the Readme file or the manual that comes with
the IEEE1394 Interface Unit option. 

Important
❒ Before starting the installation, close all documents and applications. In a net-

work environment, make sure that users who are logged on are disconnected. 
❒ After installing a printer driver, you must restart the computer. 

Note
❒ If “plug and play” is started, click [Cancel] in the [New Hardware Found], [Device

Driver Wizard] or [Found New Hardware Wizard] dialog box, and then insert the
CD-ROM. The [New Hardware Found], [Device Driver Wizard] or [Found New Hard-
ware Wizard] dialog box appears depending on the system version of the Win-
dows 95/98/Me, Windows 2000/XP. 
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----User Codes
User codes are eight digit codes that allow you to keep track of printing done un-
der each code. To use this feature, the network administrator should assign user
codes and inform users of them before they install the printer driver.
Use the following methods to enter a user code for registration:
• For the PCL 5c or PostScript3 printer driver, enter the user code on the [Statis-

tics] tab in the Printer Properties dialog box.
• For the RPCS™ printer driver, click the [Printer Configuration] button on the

[Print Settings] tab in the Printer Properties dialog box. A window opens. Click
the [User Code] button in the opened window. A dialog box appears. Enter the
user code in the dialog box.

Note
❒ When using the RPCS™ printer driver, the user code cannot be changed

once entered. To change an entered user code, uninstall the printer driver,
reinstall it, and then enter a new user code.

Reference
For more information about user codes, see “User Code”, General Settings
Guide.

----Additional Drivers (Alternate Drivers)
If you want to share the machine on a Windows 2000/XP, Windows NT 4.0 plat-
form, install the printer drivers of other versions of Windows as additional driv-
ers, so that users running different versions of Windows can download them
automatically when they connect.

Note
❒ When using the “additional driver” function in the PostScript 3 printer driver

with the Windows NT 4.0, Windows NT 4.0 Service Pack 6 or later is required.
For the PCL 5c and RPCS™ printer drivers with Windows NT 4.0, Service
Pack 4 or later is required.

For more information about installing the printer driver as an additional driver,
see p.27 “Installing the PCL 5c/RPCS™ Printer Driver”, p.33 “Windows
2000/XP - Installing the PostScript 3 Printer Driver”, p.35 “Windows NT 4.0 - In-
stalling the PostScript 3 Printer Driver”
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Quick Install

Auto Run will start the installer automatically when you load the CD-ROM in
the CD-ROM drive. By selecting Quick Install, you can easily install the PCL 5c
printer driver and the RPCS™ printer driver. The SmartNetMonitor for Client
can also be installed provided the machine and the computer are connected via
the network.
The following conditions are required: 
• Windows 95/98/Me, Windows 2000/XP or Windows NT 4.0
For Ethernet connections:
• The machine must be connected to the network using an Ethernet cable.
• TCP/IP protocol must be configured.
• The IP address must be assigned to both machine and computer.
For parallel connections:
• The machine must be connected to the computer using a parallel cable.
• Bidirectional transmission must be enabled.

Limitation
❒ If your operating system is Windows 2000/XP or Windows NT 4.0, installing

a printer driver using Auto Run requires Administrators permission. When
you install a printer driver using Auto Run, log on using an account that has
Administrators permission.

❒ When the machine is connected to the computer using the IEEE 1394 inter-
face, Quick Install cannot be used. See p.43 “Installing the Printer Driver Us-
ing IEEE 1394”.

Important
❒ If your system is Windows NT 4.0, we recommend that you upgrade the Win-

dows NT 4.0 operating system to Service Pack 4 or later before installing the
PCL 5c or RPCS™ printer drivers. Contact your Windows retailer for more in-
formation about the latest version available.

Note
❒ If you want to cancel Auto Run, hold down the {{{{SHIFT}}}} key (when your op-

erating system is Windows 2000/XP, hold down the left {{{{SHIFT}}}} key) while
inserting the CD-ROM. Keep the {{{{SHIFT}}}} key held down until the computer
has finished accessing the CD-ROM.
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AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

CCCC Select a language for the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish),
Deutsch (German), English (English), Espanol (Spanish), Francais (French),
Italiano (Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwe-
gian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska
(Swedish)
The default interface language is English.

DDDD Click [Quick Install].

The software license agreement appears in the [License Agreement] dialog box.

EEEE After reading through all of the contents, click [I accept the agreement] to
agree with the license agreement, and then click [Next].

FFFF Click a model name of the machine you are using when the [Select Printer]
dialog box appears.

Note
❒ For a network connection with TCP/IP, select the machine whose IP ad-

dress is displayed in [Connect To].
❒ For parallel connection, select the machine whose printer port is displayed

in [Connect To].

GGGG Click [Install].

HHHH Follow the instructions on the screen.

Note
❒ During installation in Windows 2000, the [Digital Signature Not Found] dialog

box may appear. In this case, click [Yes] to continue the installation.
❒ During installation in Windows XP, the [Hardware Installation] dialog box

may appear. In this case, click [Continue Anyway] to continue the installa-
tion.

A message prompting you to restart your computer may appear. To complete
the installation, restart your computer.

Important
❒ If the machine is installed with the certain options, you should set the op-

tions using the printer driver. See p.29 “Setting Up Options”
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Note
❒ When you want to change the printer name, follow the procedure below.

• Windows 95/98/Me, Windows 2000, Windows NT 4.0
Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The Printer window appears. Right-click the machine icon, and then se-
lect [Rename].

• Windows XP Professional
Click [Start] on the taskbar, and then [Printers and Faxes]. The Printers
and Faxes window appears. Right-click the machine icon, and then se-
lect [Rename].

• Windows XP Home Edition
Click [Start] on the taskbar, and then [Control Panel]. Click [Printers and
Other Hardware], and then [Printers and Faxes]. The Printers and Faxes
window appears. Right-click the machine icon, and then select [Re-
name].
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Installing the PCL 5c/RPCS™ Printer Driver

This section describes basic instructions for installing the PCL 5c printer driver
and RPCS™ printer driver without using Quick Install. Also, procedures are de-
scribed for setting up options installed on the machine using the printer driver.
Follow the procedures below as appropriate.

Reference
See p.24 “Quick Install” for installing the PCL 5c printer driver or RPCS™
printer driver using Quick Install.

Installing the PCL 5c/RPCS™ Printer Driver

Limitation
❒ If your system is Windows 2000/XP or Windows NT 4.0, installing a printer

driver using Auto Run requires Administrators permission. When you install
a printer driver using Auto Run, log on using an account that has Adminis-
trators permission.

Important
❒ When updating to the latest version of the printer driver, you should unin-

stall former version, if any. See “Uninstalling the Printer Driver”, Printer Ref-
erence 2.

❒ If your system is Windows NT 4.0, we recommend that you upgrade the Win-
dows NT 4.0 operating system to Service Pack 4 or later before installing the
printer drivers. Contact your Windows retailer for more information about
the latest version available.

Note
❒ If you want to share the machine on a Windows 2000/XP or Windows NT 4.0

platform, use the [Sharing] tab in the Printer Properties to specify the addition-
al driver (alternate driver). For details, see the documentation that comes
with Windows 2000/XP, or Windows NT 4.0.

❒ When prompted for the additional driver (alternate driver) location, select the
following folders on the CD-ROM:
• Windows 95/98/Me

PCL 5c: \DRIVERS\PCL5C\WIN9X_ME\(Language)\DISK1\
RPCS™: \DRIVERS\RPCS\WIN9X_ME\(Language)\DISK1\

• Windows 2000/XP
PCL 5c: \DRIVERS\PCL5C\WIN2K_XP\(Language)\DISK1\
RPCS™: \DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1\

• Windows NT 4.0
PCL 5c: \DRIVERS\PCL5C\NT4\(Language)\DISK1\
RPCS™: \DRIVERS\RPCS\NT4\(Language)\DISK1\
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AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

CCCC Select a language for the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish),
Deutsch (German), English (English), Espanol (Spanish), Francais (French),
Italiano (Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwe-
gian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska
(Swedish)
The default interface language is English.

DDDD Click [PCL/RPCS Printer Drivers].

The software license agreement appears in the [License Agreement] dialog box.

EEEE After reading through all of the contents, click [I accept the agreement] to
agree with the license agreement, and then click [Next].

FFFF Select the printer drivers you want to install when the [Select Program] dia-
log box appears, and then click [Next].

GGGG Select the model of the machine you are using.
To change the printer name, change it in the [Change settings for 'Printer Name']
box.

HHHH Double-click the machine name to display the printer settings.

Note
❒ The details shown for [Comment:], [Driver:] and [Port:] vary depending on

the operating system being used, the model of machine selected, and the
port being used.

❒ Confirm that [LPT1:] is selected for [Port:].
❒ Check [Default Printer] if you want to set the machine as the default printer.
❒ Check [Shared] if you want to share the machine. See the Network Printing

Guide for information about setting up and using the machine in a network
environment.

IIII Click [Continue] to start printer driver installation.

JJJJ Follow the instructions on the screen.

Note
❒ During installation in Windows 2000, the [Digital Signature Not Found] dialog

box may appear. In this case, click [Yes] to continue the installation.
❒ During installation in Windows XP, the [Hardware Installation] dialog box

may appear. In this case, click [Continue Anyway] to continue the installation.
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Setting Up Options

If the machine is installed with certain options, you should set the options using
the printer driver.

Limitation
❒ In Windows 2000/XP, changing the printer settings requires Manage Printers

permission. Members of the Administrators and Power Users groups have
Manage Printers permission by default. When you set up options, log on us-
ing an account that has Manage Printers permission.

❒ In Windows NT 4.0, changing the setting of the printer requires Full Control
permission. Members of the Administrators, Server Operators, Print Opera-
tors, and Power Users groups have Full Control permission by default. When
you set up options, log on using an account that has Full Control permission.

When setting up options, you should access the Printer Properties dialog box
from Windows. You cannot set up options by accessing the Printer Properties di-
alog box from an application.

PCL 5c Printer Driver

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note
❒ In Windows XP Professional, access the [Printers and Faxes] window from

[Start] on the taskbar.
❒ In Windows XP Home Edition, access the [Printers and Faxes] window by

clicking [Start] on the taskbar. Then click [Control Panel], [Printers and Other
Hardware] and then [Printers and Faxes].

BBBB Click the icon of the machine you want to use.

CCCC On the [File] menu, click [Properties]. 

The Printer Properties window appears.

DDDD Click the [Accessories] tab.

EEEE Select the options you have installed from the [Options] group.

FFFF Click [OK] .
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RPCS™ Printer Driver

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

Note
❒ In Windows XP Professional, access the [Printers and Faxes] window from

[Start] on the taskbar.
❒ In Windows XP Home Edition, access the [Printers and Faxes] window by

clicking [Start] on the taskbar. Then click [Control Panel], [Printers and Other
Hardware] and then [Printers and Faxes].

BBBB Click the icon of the machine you want to use.

CCCC On the [File] menu, click [Properties]. 
The Printer Properties window appears.

Note
❒ If the following messege appears “Configure installed accessories in the

[Accessories] tab of [Printer Configuration], which will open next.”, click [OK]
and then go to step E.

DDDD Click the [Change Accessories] tab.

Note
❒ In Windows 95/98/Me, click [Printer Configuration] on the [Print Settings] tab,

and then [Change Accessories].

EEEE Select the options you have installed from the [Select printer options] group.

FFFF Click [OK] .
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Installing the PostScript 3 Printer Driver

This section describes basic instructions for installing the PostScript 3 printer
driver. Actual procedure may differ depending on the operating system. Follow
the procedures below as appropriate.

Reference
To use the PostScript 3 printer driver, the optional PostScript 3 board must be
installed on the machine. See the PostScript 3 Board Type 1232 Operating In-
structions Supplement for details.

Important
❒ When updating to the latest version of the printer driver, you should unin-

stall any earlier versions. See “Uninstalling the Printer Driver”, Printer Refer-
ence 2.

Windows 95/98/Me - Installing the PostScript 3 Printer Driver

Installing the printer driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

CCCC Select a language for the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish),
Deutsch (German), English (English), Espanol (Spanish), Francais (French),
Italiano (Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwe-
gian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska
(Swedish) 
The default interface language is English.

Note
❒ The printer driver with the selected language will be installed.
❒ The printer driver will be installed in English if you select the following

languages: Cestina, Magyar, Polski, Portugues and Suomi.

DDDD Select [PostScript 3 Printer Driver].
[Add Printer Wizard] starts.

EEEE Click [Next].
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FFFF Check [Local Printer], and then click [Next].

A dialog box for selecting the printer appears.

GGGG Select the model of the machine you are using, and then click [Next].

HHHH In the [Available ports:] box, click [Printer Port], and then click [Next].

IIII Change the name of the machine if you wish to, and then click [Next].

Note
❒ Check [Yes] if you want to set the machine as the default printer.

JJJJ Follow the instructions on the screen.

Setting up options

If the machine is installed with certain options, you should set the options using
the printer driver.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the machine you want to use.

CCCC On the [File] menu, click [Properties].

The Printer Properties window appears.

DDDD Click the [Accessories] tab.

EEEE Select the options you have installed from the [Options] group.

FFFF Click [OK].
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Windows 2000/XP - Installing the PostScript 3 Printer Driver

Installing the printer driver

Limitation
❒ Installing a printer driver requires Administrators permission. When you install

a printer driver, log on using an account that has Administrators permission.

Note
❒ If you want to share the machine on a Windows 2000/XP platform, use the

[Sharing] tab in the Printer Properties to specify the additional driver (alternate
driver). For details, see the documentation that comes with Windows 2000/XP.

❒ When prompted for the additional driver (alternate driver) location, select the
following folders on the CD-ROM:
• Windows 95/98/Me: \DRIVERS\PS\WIN9X_ME\(Language)\DISK1\
• Windows NT 4.0: \DRIVERS\PS\NT4\(Language)\DISK1\

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

CCCC Select a language for the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deut-
sch (German), English (English), Espanol (Spanish), Francais (French), Italiano
(Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwegian), Pol-
ski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska (Swedish) 
The default interface language is English.

Note
❒ The printer driver with the selected language will be installed.
❒ The printer driver will be installed in English if you select the following

languages: Cestina, Magyar, Polski, Portugues and Suomi.

DDDD Select [PostScript 3 Printer Driver].

[Add Printer Wizard] starts.

EEEE Click [Next].

FFFF Check [Local Printer], and then click [Next].

Note
❒ In Windows XP, check [Local printer attached to this computer], and then click

[Next].
A dialog box for selecting the printer port appears.
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GGGG Select the check box of the port you want to use, and then click [Next].

A dialog box for selecting the printer appears.

HHHH Select the model of the machine you are using, and then click [Next].

IIII Change the name of the machine if you wish to, and then click [Next].

Note
❒ Check [Yes] if you want to set the machine as the default printer.

JJJJ Select whether or not you want to share the machine, and then click [Next].

Reference
See the Network Printing Guide for information about setting up and using
the machine in a network environment.

KKKK Follow the instructions on the screen.

Note
❒ During installation, the [Digital Signature Not Found] dialog box may appear.

In this case, click [Yes] to continue the installation.
❒ During installation in Windows XP, the [Hardware Installation] dialog box

may appear. In this case, click [Continue Anyway] to continue the installation.

Setting up options

If the machine is installed with certain options, you should set the options using
the printer driver.

Limitation
❒ Changing the printer settings requires Manage Printers permission. Members

of the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you set up options, log on using an account that has
Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

Note
❒ In Windows XP Professional, access the [Printers and Faxes] window from

[Start] on the taskbar.
❒ In Windows XP Home Edition, access the [Printers and Faxes] window by

clicking [Start] on the taskbar. Then click [Control Panel], [Printers and Other
Hardware] and then [Printers and Faxes].

BBBB Click the icon of the machine you want to use.

CCCC On the [File] menu, click [Properties].

The Printer Properties window appears.
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DDDD Click the [Device Settings] tab.

EEEE Select the options you have installed from the [Installable Options] group.

FFFF Click [OK].

Windows NT 4.0 - Installing the PostScript 3 Printer Driver

Installing the printer driver

Limitation
❒ Installing a printer driver requires Administrators permission. When you install

a printer driver, log on using an account that has Administrators permission.

Important
❒ The CD-ROM containing the Windows NT Server operating system version

4.0, or the Windows NT Workstation operating system is required for install-
ing the printer driver.

❒ We recommend that you upgrade the Windows NT 4.0 operating system to
Service Pack 6 or later before installing the printer driver. Contact your Win-
dows retailer for more information about the latest version available.

Note
❒ If you want to share the machine on Windows NT 4.0, use the [Sharing] tab in

the Printer Properties to specify the additional driver (alternate driver). For
details, see the documentation that comes with Windows NT 4.0.

❒ When prompted for the additional driver (alternate driver) location, select the
following folders on the CD-ROM:
• Windows 95/98/Me: \DRIVERS\PS\WIN9X_ME\(Language)\DISK1\

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

CCCC Select a language for the interface language, and then click [OK].
The following languages are available: Cestina (Czech), Dansk (Danish), Deut-
sch (German), English (English), Espanol (Spanish), Francais (French), Italiano
(Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwegian), Pol-
ski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska (Swedish) 
The default interface language is English.

Note
❒ The printer driver with the selected language will be installed.
❒ The printer driver will be installed in English if you select the following

languages: Cestina, Magyar, Polski, Portugues and Suomi.
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DDDD Select [PostScript 3 Printer Driver].

[Add Printer Wizard] starts.

EEEE After confirming that the [My Computer] option is selected, click [Next].

A dialog box for selecting the printer port appears.

FFFF Select the check box of the port you want to use, and then click [Next].
A dialog box for selecting the printer appears.

GGGG Select the model of the machine you are using, and then click [Next].

HHHH Change the name of the machine if you wish to, and then click [Next].

Note
❒ Check [Yes] if you want to set the machine as the default printer.

IIII Select whether or not you want to share the machine, and then click [Next].

Reference
See the Network Printing Guide for information about setting up and using
the machine in a network environment.

JJJJ Follow the instructions on the screen.

Setting up options

If the machine is installed with certain options, you should set the options using
the printer driver.

Limitation
❒ Changing the printer settings requires Manage Printers permission. Members

of the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you set up options, log on using an account that has
Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the machine you want to use.

CCCC On the [File] menu, click [Properties].

The Printer Properties window appears.

DDDD Click the [Device Settings] tab.

EEEE Select the options you have installed from the [Installable Options] group.

FFFF Click [OK].
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----Bidirectional transmission
When bidirectional transmission is enabled, information such as paper size and
feed direction is automatically sent to the computer. You can also check the ma-
chine's status from your computer.
• Bidirectional transmissions are supported by Windows 95/98/Me, Windows

2000/XP and Windows NT 4.0.
• When bidirectional transmission is running, the machine status and informa-

tion can be viewed by opening the printer driver screen.
To support bidirectional transmission, the following conditions are required:

❖❖❖❖ When connecting with a parallel cable
• The computer must support bidirectional transmission.
• The machine must be set to bidirectional transmission.
• The machine parallel port and computer parallel port are connected using

a parallel interface cable that supports bidirectional transmission.

Note
❒ In Windows 95/98/Me, [Enable bi-directional support for this printer] must be

selected in [Spool Settings] on the [Details] tab in RPCS™ printer driver.
❒ In Windows 2000/XP, or Windows NT 4.0, [Enable bidirectional support]

must be selected, and [Enable printer pooling] must not be selected on the
[Port] tab in RPCS™ printer driver.

❖❖❖❖ When connecting with the network
• The machine must be set to bidirectional transmission.
• SmartNetMonitor for Client included on the CD-ROM must be installed.
One of the following conditions must also be satisfied besides the two re-
quirements mentioned above.
• The port for SmartNetMonitor for Client and TCP/IP protocol must be used.
• The standard TCP/IP port is used without changing the port name (Win-

dows 2000/XP).
• The IP address specified in the Microsoft TCP/IP Print is used (Windows NT 4.0).
• The IP address is included in port name when using IPP protocol.

Note
❒ In Windows 95/98/Me, [Enable bi-directional support for this printer] must be

selected in [Spool Settings] on the [Details] tab in RPCS™ printer driver.
❒ In Windows 2000/XP, or Windows NT 4.0, [Enable bidirectional support]

must be selected, and [Enable printer pooling] must not be selected on the
[Port] tab in RPCS™ printer driver.
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❖❖❖❖ When connecting with IEEE 1394
• The port on the optional IEEE 1394 Interface Unit and the IEEE 1394 port

on the computer are connected using an interface cable (Windows Me,
Windows 2000/XP).

Note
❒ [SCSI print (SBP-2)] must be set to “Active” and [Bidirectional SCSI print] must

be set to “On” in [IEEE 1394] on the [Interface Settings] tab in the machine's
System Settings.

❒ In Windows Me, [Enable bi-directional support for this printer] must be selected
in [Spool Settings] on the [Details] tab in RPCS™ printer driver.

❒ In Windows 2000/XP, or Windows NT 4.0, [Enable bidirectional support]
must be selected, and [Enable printer pooling] must not be selected on the
[Port] tab in RPCS™ printer driver.

Mac OS - Installing the PostScript 3 Printer Driver and Utilities

It is necessary to install a printer driver and a PPD file to print from a Macintosh.
Follow the procedures to install a printer driver and a PPD file on Macintosh
running OS 8.6 or later version up to 9.2, and Mac OS X Classic mode.

Note
❒ For installing the PostScript 3 printer driver in Mac OS X, see p.42 “Mac OS X

- Installing the PostScript 3 Printer Driver”

AAAA Insert the CD-ROM into the CD-ROM drive.

BBBB Double-click the CD-ROM icon.

CCCC Double-click the [Mac OS 8 and 9] folder.

DDDD Double-click the [PS Driver] folder.

EEEE Double-click the folder of the language you use.

FFFF Open [Disk 1] and double-click the installer icon.

The PostScript 3 printer driver installer window appears.

GGGG Follow the instructions on the screen.

HHHH Double-click [Extensions] in [System Folder].

IIII Double-click [Printer Descriptions].

JJJJ Double-click the CD-ROM icon on the desktop.

KKKK Double-click the [Printer Descriptions] folder in the [Mac OS 8 and 9] folder.
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LLLL Double-click [Disk 1] in the folder of the language you use.

MMMM Drag the PPD file into [Printer Descriptions] in [Extensions] in [System Folder].

NNNN Drag the plugin file into [Printer Descriptions] in [Extensions] in [System Folder].

OOOO Restart the Macintosh.

Setting up the PPD File

Preparation
Make sure that the machine is connected to an AppleTalk network before per-
forming the following procedure.

AAAA On the Apple menu, select [Chooser].

BBBB Click the [Adobe PS] icon.

CCCC In the [Select a PostScript Printer:] list, click the name of the machine you want
to use.

DDDD Click [Setup].

EEEE Click the printer description file you want to use, and then click [Select].

The PPD file is set up, and the [Adobe PS] icon appears at the left of the ma-
chine name in the list. Next, follow the procedure on p.39 “Setting up op-
tions” to make the option settings, or close the [Chooser] dialog box.

Setting up options

AAAA On the Apple menu, select [Chooser].

BBBB Click the [Adobe PS] icon.

CCCC In the [Select the PostScript Printer:] list, click the name of the machine you
want to use, and then click [Setup].

DDDD Click [Configure].

A list of options appears.

EEEE Select the options you want to set up and select the appropriate setting for it.

Note
❒ If the option you want to set up is not displayed, the PPD file might not be

set up correctly. Check the name of the PPD file shown in the dialog box.

FFFF Click [OK].

The list of options closes.
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GGGG Click [OK].

The [Chooser] dialog box appears.

HHHH Close the [Chooser] dialog box.

Installing the ColorSync™ profile

ColorSync profile makes it possible for the printer to print colors of similar in-
tensity to those on the computer display. Follow the procedures below to install
ColorSync profile.

Note
❒ ColorSync profile complies to color standards as defined by the International

Color Consortium (ICC).
❒ Some computer displays may require particular settings to be compatible

with ColorSync. See the documentation that comes with your display for
more information.

AAAA Start the Macintosh.

BBBB Double-click the hard disk icon, and then open the appropriate folder for
installing the ColorSync profile.

Note
❒ The location of the appropriate folder may differ depending on the version

of the operating system. These are examples:
• System\Preferences\ColorSync profiles
• System\ColorSync profiles

CCCC Insert the CD-ROM into the CD-ROM drive.

DDDD Double-click the CD-ROM icon.

EEEE Double-click the [Mac OS 8 and 9] folder.

FFFF Double-click the [ColorSync Profiles] folder.

GGGG Drag the file to the [ColorSync Profiles] folder on the hard disk.

The ColorSync profile is installed.

Installing Adobe Type Manager (ATM)

Note
❒ Close all applications that are running before installation. Install after restarting.

AAAA Start the Macintosh.
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BBBB Insert the CD-ROM into the CD-ROM drive.

CCCC Double-click the CD-ROM icon.

DDDD Double-click the [Mac OS 8 and 9] folder.

EEEE Double-click the [ATM] folder.

FFFF Double-click the [ATM 4.6.2 installer] icon.

GGGG Follow the instructions on screen.

HHHH Restart the Macintosh.

Note
❒ Make sure to restart the computer. ATM will be completely installed only

after restarting.

IIII Select [Control Panel] from the Apple menu, and then select [ATM].

JJJJ Open the ATM control panel.

Note
❒ For more information about installation, see the User's Guide in the ATM

folder.

Installing screen fonts

AAAA Start the Macintosh.

BBBB Insert the CD-ROM into the CD-ROM drive.

CCCC Double-click the CD-ROM icon.

DDDD Double-click the [Mac OS 8 and 9] folder.

EEEE Double-click the [Fonts] folder.

FFFF Copy the fonts you want to install into the [System] folder.

A confirmation dialog box appears.

GGGG Click [OK].

The fonts are installed.

HHHH Restart the Macintosh.

Reference
For information about installing the Printer Utility for Mac, see the Post-
Script 3 Board Type 1232 Operating Instructions Supplement.
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Mac OS X - Installing the PostScript 3 Printer Driver

It is necessary to install a PPD file to print from a Macintosh. Follow the proce-
dures to install a PPD file on Macintosh running Mac OS X.

Preparation
You need an administrator name and a password (phrase). For more informa-
tion, consult your administrator.

AAAA Insert the CD-ROM into the CD-ROM drive.

BBBB Double-click the CD-ROM icon.

CCCC Double-click the [Mac OS X] folder.

DDDD Double-click the [PPD Installer] folder, and then double-click the installer
icon.

EEEE Follow the instructions on screen.

Setting Up the PPD File

AAAA Run Print Center.

BBBB Click [Add Printer].

Note
❒ Select [AppleTalk] in the first pop-up menu.
❒ If the zone has been set, select the zone in the second pop-up menu.

CCCC Select the PPD file for the model you are using from the “Printer Model:”
pop-up menu.

DDDD Click [Add].

Setting Up Options

Limitation
❒ You cannot make printer option settings in Mac OS X. Do not make settings

for options that have not been installed.



Installing the Printer Driver Using IEEE 1394

2

Installing the Printer Driver Using IEEE 1394

This section gives basic instructions for installing printer drivers using IEEE
1394. SCSI print and IP over 1394 are available when printing via IEEE 1394. The
printer drivers can be installed from the CD-ROM that comes with this machine.

Preparation
Be sure that all other applications are closed and the computer is not printing
before installation.

Important
❒ Do not connect new IEEE 1394 devices to the machine or turn on the machine

while installing the printer driver.
❒ Before uninstalling the printer driver, be sure to disconnect the IEEE 1394 in-

terface cable from the computer.
❒ The optional IEEE 1394 Interface Unit is not supported by Windows 95/98 or

Windows NT 4.0. If the “plug and play” function starts, click [Cancel] in the
[New Hardware Found] or [Device Driver Wizard] dialog box.

Printing with SCSI Print

Printing using a SCSI print device with the optional 1394 Interface Unit is possi-
ble under Windows 2000 or Windows XP.

Preparation
“SCSI print” must be enabled and “IP over 1394” must be disabled from the
machine's display panel. For more information about how to make machine
settings, see “Interface Settings/IEEE 1394 (Option)”, General Settings Guide.

Note
❒ If [Found New Hardware Wizard] appears every time the computer is started or

the cable is connected with Windows 2000 or Windows XP when the print
function that uses SCSI print is not installed, disable the device. See p.46 “Dis-
abling the Device” for more information.

Installing the Printer Driver

Note
❒ If you send data from your computer when data is being received from an-

other client computer, your data will be printed after completing the print job
from the other client computer.

❒ When the machine is connected to the computer properly via the 1394 inter-
face, the appearance of the icon in the printer window changes.
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Windows 2000

Important
❒ In Windows 2000, the optional IEEE 1394 Interface Unit can only be used with Ser-

vice Pack 1 or later. If the Service Pack is not installed, the connectable number of
devices in a IEEE 1394 bus is only one, and the client cannot access the IEEE 1394
Interface Unit without using an account that has Administrators permission.

AAAA Connect the machine and the computer using the IEEE 1394 interface cable.
The [Found New Hardware Wizard] dialog box appears.

BBBB  Click [Next].

The massage [This wizard will complete the installation for this Device: Unknown] ap-
pears.

CCCC  Select [Optional search locations:], and then click [Next].

DDDD When the [Locate Driver Files] message appears, check the [Optional search lo-
cations.] checkbox and the [Specify a location] checkbox, and then click [Next].

EEEE Hold down the left {{{{SHIFT}}}} key on the keyboard and insert the CD-ROM
into the CD-ROM drive.

Keep the left {{{{SHIFT}}}} key held down until the computer has finished access-
ing the CD-ROM.
If the Auto Run program starts, click [Cancel], and then [Exit].

FFFF Click [Browse].

GGGG Select the printer driver you want to install. Each printer driver is stored in
the following folders:

• RPCS™: \DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1
• PCL 5c: \DRIVERS\PCL5C\WIN2K_XP\(Language)\DISK1
• PostScript 3: \DRIVERS\PS\WIN2K_XP\(Language)\DISK1

HHHH Click [Open].

IIII Click [OK].
A printer model selection dialog box appears.

JJJJ Follow the instructions on the screen.

Note
❒ During installation, the [Digital Signature Not Found] dialog box may appear.

In this case, click [Yes] to continue the installation.
❒ When the installation is complete, the printer with its port directed to

“1394_00n” appears on the [Printers] folder. (“n” is the number of printers
connected.)
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Windows XP

AAAA Connect the machine and the computer using the IEEE 1394 interface cable.
The [Found New Hardware Wizard] dialog box appears.

BBBB Confirm that [This wizard helps you install software for: (printer name)] is dis-
played, and select [Install from a list on specific location (Advanced)], and then
click [Next].
The message [Please choose your search and installation option.] appears.

CCCC Check the [Search for the best driver in these locations.] check box, and the [In-
clude this location in the search:] check box.

DDDD Install the printer driver following the same procedures as steps EEEE-JJJJ in
Windows 2000.

Note
❒ During installation in Windows XP, the [Hardware Installation] dialog box

may appear. In this case, click [Continue Anyway] to continue the installa-
tion.

❒ When the installation is complete, the printer with its port directed to
“1394_00n” appears on the [Printers and Faxes] folder. (“n” is the number of
printers connected.)

Printing with IP over 1394

You can print by setting the IP address for this machine and the computer on
which Windows Me (SmartNetMonitor for Client) or Windows XP (SmartNet-
Monitor for Client or Standard TCP/IP Port) is installed.

Preparation
“IP over 1394” must be enabled on the machine's display panel and an IP ad-
dress for the IEEE 1394 must be configured. For more information about how
to make machine settings, see“Interface Settings/IEEE 1394 (Option)”, Gener-
al Settings Guide.

Limitation
❒ When using the IEEE 1394 (IP over 1394) interface in a network, the Ethernet

interface cannot be used in the same network.

Note
❒ Make sure that the IEEE 1394 interface and Ethernet interface subnet mask

range do not overlap.
❒ In Windows Me, if [Found New Hardware Wizard] appears every time the com-

puter is started or the cable is connected, disable the device. See p.46 “Dis-
abling the Device” for more information.
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----Disabling the Device

❖❖❖❖ If [Add New Hardware Wizard] appears every time you restart the computer with an
operating system that does not support SCSI print, or plug in/take out the cable, dis-
able the device by the following procedures.
• Windows Me

A In the [Add New Hardware Wizard] dialog box, confirm that [Windows has
found the following new Hardware: IEEE SBP-2 Device] is displayed, and se-
lect [Recommended search for a better driver [Recommended]], and then click
[Next].

B When the [Windows was unable to locate the software for this device.] mes-
sage appears, click [Finish].

❖❖❖❖ If you do not want to install the printer when [Found New Hardware Wizard] starts
with an operating system that supports SCSI print, disable the device by the follow-
ing procedures.
• Windows XP

A In the [Found New Hardware Wizard] dialog box, confirm that [This wizard
helps you install software for: Unknown] is displayed, and select [Install from
a list on specific location (Advanced)], and then click [Next].

B When the [Please choose your search and installation option.] message ap-
pears, remove all the selections from [Search for the best driver in these lo-
cations.], and then click [Next].

C When the [The wizard could not find the software on your computer for..] mes-
sage appears, click [OK].

D When the [Cannot Install this Hardware] message appears, select the [Don't
prompt again to install the software] check box, and then click [Finish].

• Windows 2000
A In the [Found New Hardware Wizard] dialog box, click [Next].
B When the [This wizard will complete the installation for this Device: Unknown]

message appears, select [Search for a suitable driver for my device [recom-
mended]], and then click [Next].

C When the [Locate Driver Files] message appears, remove all the selections
from [Optional search locations.], and then click [Next].

D When the [Driver Files Search Results] message appears, select the [Disable
the device. The Add/Remove Hardware Wizard in the control Panel can be able to
complete the driver installations.] check box, and then click [Finish].
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❖❖❖❖ If [Found New Hardware Wizard] appears every time you restart the computer with
an operating system that does not support IP over 1394 or plug in/take out the cable,
disable the device with the following procedure.
• Windows 2000

A In [Found New Hardware Wizard] dialog box, click [Next].
B When the [This wizard will complete the installation for this Device:] message

and “IP over 1394” appear, select [Search for a suitable driver for my device
[recommended]], and then click [Next].

C When the [Locate Driver Files] message appears, remove all the selections
from [Optional search locations.], and then click [Next].

D When the [Driver Files Search Results] message appears, select the [Disable
the device. The Add/Remove Hardware Wizard in the Control Panel can be able to
complete the driver installations.] check box, and then click [Finish].
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Installing the SmartNetMonitor for 
Client/Admin

Limitation
❒ If your operating system is Windows 2000/XP or Windows NT 4.0, installing

software using Auto Run requires Administrators permission. When you in-
stall a printer driver using Auto Run, log on using an account that has Admin-
istrators permission.

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

CCCC Select a language for the interface language, and then click [OK].
The following languages are available: Cestina (Czech), Dansk (Danish),
Deutsch (German), English (English), Espanol (Spanish), Francais (French),
Italiano (Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwe-
gian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska
(Swedish)
The default interface language is English.

DDDD Click [SmartNetMonitor for Client/Admin].

The software license agreement appears in the [License Agreement] dialog box.

EEEE After reading through all of the contents, click [I accept the agreement] to
agree with the license agreement, and then click [Next].

FFFF Select the program you want to install when the [Select Program] dialog box
appears.

GGGG Follow the instructions on the screen.
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Installing the Agfa Monotype Font 
Manager 2000

Limitation
❒ If your operating system is Windows 2000/XP or Windows NT 4.0, installing

software using Auto Run requires Administrators permission. When you in-
stall a printer driver using Auto Run, log on using an account that has Admin-
istrators permission.

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

CCCC Select a language for the interface language, and then click [OK].
The following languages are available: Cestina (Czech), Dansk (Danish),
Deutsch (German), English (English), Espanol (Spanish), Francais (French),
Italiano (Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwe-
gian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska
(Swedish)
The default interface language is English.

DDDD Select [Agfa Monotype Font Manager 2000].

EEEE Follow the instructions on the screen.
49



Installing the Printer Driver and Software

50

2

Using Adobe PageMaker Version 6.0, 6.5 
or 7.0

If you use the machine under Windows 95/98/Me, Windows 2000/XP or Win-
dows NT 4.0 with Adobe PageMaker, you need to copy the PPD file to the Page-
Maker folder. 
The PPD file is the file with extension “.ppd” in the folder “DRIVERS\PS\
WIN9X_ME \(Language)\ DISK1 \” on the CD-ROM. 
The “WIN9X_ME” folder, inside the “PS” folder is for Windows 95/98/Me. Use
the folder at this level that is appropriate for the operating system you are cur-
rently using.
The third folder, “(Language)” may be substituted by an appropriate language
name. 
Copy the file with extension “.ppd” to the PageMaker folder.
• For PageMaker 6.0 default installation

The directory is “C:\PM6\RSRC\PPD4”.
• For PageMaker 6.5 default installation

The directory is “C:\PM65\RSRC\USENGLISH\PPD4”.
The “USENGLISH” may vary depending on your language selection.

• For PageMaker 7.0 default installation
The directory is “C:\PM7\RSRC\USENGLISH\PPD4”.
The “USENGLISH” may vary depending on your language selection.
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Note to users in the United States of America

Notice:
This equipment has been tested and found to comply with the limits for a Class B digital device, pursu-
ant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equip-
ment does cause harmful interference to radio or television reception, which can be determined by turn-
ing the equipment off and on, the user is encouraged to try to correct the interference by one more of
the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.
Consult the dealer or an experienced radio/TV technician for help.

Caution (in case of IEEE1284 environment) :
Properly shielded and grounded cables and connectors must be used for connections to host computer
(and/or peripheral) in order to meet FCC emission limits.

Caution (in case of 100BaseTX environment):
Network interface cable with ferrite core must be used for RF interference suppression.

Declaration of Conformity
Product Name: Printer Controller
Model Number: Printer Kit Type 1232, Printer/Scanner Kit Type 1232
Responsible party: Ricoh Corporation
Address: 5 Dedrick Place, West Caldwell, NJ 07006
Telephone number: 973-882-2000
This device complies with part 15 of FCC Rules.
Operation is subject to the following two conditions:
1. This device may not cause harmful interference, and
2. this device must accept any interference received,
including interference that may cause undesired operation.

Note to users in Canada

Note:
This Class B digital apparatus complies with Canadian ICES-003.

Remarque concernant les utilisateurs au Canada

Avertissement:
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
Copyright © 2002
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For safe and correct use of this machine, please be sure to read the Safety Information in the
“General Settings Guide” before you use it.



Introduction

This manual describes detailed instructions on the operation and notes about the use of this machine.
To get maximum versatility from this machine all operators are requested to read this manual carefully
and follow the instructions. Please keep this manual in a handy place near the machine.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Warning:

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe®, PostScript®, Acrobat® and PageMaker® are registered trademarks of Adobe Systems Incor-
porated.

PCL® is a registered trademark of Hewlett-Packard Company.

AppleTalk, Apple, Macintosh, Mac and TrueType are registered trademarks of Apple Computer, Incor-
porated.

IPS-PRINT™ Printer Language Emulation Copyright©2000, Oak Technology, Inc., All Rights Re-
served.

Ethernet® is a registered trademark of Xerox Corporation.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

The proper names of the Windows operating systems are as follows:

• The product name of Windows® 95 is Microsoft®Windows® 95

• The product name of Windows® 98 is Microsoft®Windows® 98

• The product name of Windows® Me is Microsoft®Windows®Millennium Edition (Windows Me)

• The product name of Windows® XP are as follows:
Microsoft®Windows® XP Professional
Microsoft®Windows® XP Home Edition

• The product name of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

• The product name of Windows® NT are as follows:
Microsoft® Windows NT® Server 4.0
Microsoft® Windows NT® Workstation 4.0

• Microsoft® Windows NT® Workstation operating system Version 4.0

Notes:

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.
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Manuals for This Machine

The following manuals describe the operational procedures and maintenance of
this machine.
To enhance safe and efficient operation of this machine, all users should read
and follow the instructions carefully.

❖❖❖❖ General Settings Guide
Provides an overview of the machine. This manual introduces the functions
of the machine. It also introduces the options that allow you to use additional
functions and describes how to access the system user tools to make the ma-
chine easier to use.

❖❖❖❖ Copy Reference
Describes procedures and functions for using this machine as a copier.

❖❖❖❖ Printer/Scanner Kit Type 1232 Printer Reference 1
Describes system settings, procedures and functions for using this machine as
a printer.

❖❖❖❖ Printer/Scanner Kit Type 1232 Printer Reference 2
Describes procedures and provides information about using this machine as
a printer. This manual is included as a PDF file on the CD-ROM labeled “Op-
erating Instructions”(this manual).

❖❖❖❖ Network Printing Guide Operating Instructions
Describes procedures and provides information about setting up and using
the machine as a printer in a network environment. We recommend you read
this manual first. It is included as a PDF file on the CD-ROM labeled “Oper-
ating Instructions” .

❖❖❖❖ PostScript 3 Board Type 1232 Operating Instructions Supplement
Describes menus and features you can set using the PostScript 3 printer driv-
er. This manual is provided as a PDF file on the CD-ROM labeled “Operating
Instructions”.

Note
❒ Printing with the PostScript 3 printer driver is available when the Post-

Script 3 board option is installed on your machine.

❖❖❖❖ UNIX Supplement
Provides information about setting up and using the machine as a printer in
a UNIX environment. For UNIX printing information, please visit our web
site or consult your authorized dealer.

❖❖❖❖ Scanner Reference
Describes system settings, procedures and functions for using this machine as
a scanner.

Note
❒ Scanner function is available when the Printer/Scanner option is installed

on your machine.
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

R CAUTION:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates the prior knowledge or preparations required before op-
erating.

Note
This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys and buttons that appear on the computer's display.
Keys that appear on the machine's panel display.

{ }
Keys built into the machine's control panel.
Keys on the computer's keyboard.
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Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

Changing the default machine settings

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the machine whose default settings you want to change.

CCCC On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

DDDD Make any settings you require, and then click [OK].

Note
❒ With some applications, the printer driver's settings are not used, and the

application's own default settings are applied.

Making machine settings from an application

To make the machine settings for a specific application, open the [Printer Proper-
ties] dialog box from that application. The following example describes how to
make settings for the WordPad application that comes with Windows 95/98/Me.

Note
❒ The actual procedures you should follow to open the [Printer Properties] dialog

box may vary depending on the application. For more information, see the
documentation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print].

The [Print] dialog box appears.

BBBB Select the machine you want to use in the [Name] list box, and then click
[Properties].

The [Printer Properties] dialog box appears.

CCCC Make any settings you require, and then click [OK].

DDDD Click [OK] to start printing.
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Windows 2000/XP - Accessing the Printer Properties

Changing the default machine settings - Printer Properties

Limitation
❒ Changing the setting of the machine requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options, log on using an account
that has Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note
❒ In Windows XP Professional, access the [Printers and Faxes] window from

[Start] on the taskbar.
❒ In Windows XP Home Edition, access the [Printers and Faxes] window by

clicking [Control Panel] from [Start] on the taskbar. Then click [Printers and
Other Hardware], and then [Printers and Faxes].

BBBB Click the icon of the machine whose default settings you want to change.

CCCC On the [File] menu, click [Properties].
The [Printer Properties] dialog box appears.

DDDD Make any settings you require, and then click [OK].

Note
❒ You normally do not have to change the “Form to Tray Assignment” set-

tings on the [Device Settings] tab in the PostScript 3 printer driver.
❒ Settings you make here are used as the default settings for all applications.

Changing the default machine settings - Printing Preferences Properties

Limitation
❒ Changing the setting of the machine requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options, log on using an account
that has Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.
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Note
❒ In Windows XP Professional, access the [Printers and Faxes] window from

[Start] on the taskbar.
❒ In Windows XP Home Edition, access the [Printers and Faxes] window by

clicking [Control Panel] from [Start] on the taskbar. Then click [Printers and
Other Hardware], and then [Printers and Faxes].

BBBB Click the icon of the machine whose default settings you want to change.

CCCC On the [File] menu, click [Printing Preferences...].

The [Printing Preferences Properties] dialog box appears.

DDDD Make any settings you require, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Making machine settings from an application

To make the machine settings for a specific application, open the [Print] dialog
box from that application. The following example describes how to make set-
tings for the WordPad application that comes with Windows 2000/XP.

Note
❒ The actual procedures you should follow to open the [Print] dialog box may

vary depending on the application. For more information, see the documen-
tation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print...].

The [Print] dialog box appears.

BBBB Select the machine you want to use in the [Select Printer] box.
Click the tab that you want to change its print settings.

Note
❒ In Windows XP, click [Preference] to open the Printing Preference window.

CCCC Make any settings you require, and then click [OK].

DDDD Click [OK] to start printing.

Note
❒ In Windows XP, click [Print] to start printing.
5
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Windows NT 4.0 - Accessing the Printer Properties

Changing the default machine settings - Printer Properties

Limitation
❒ Changing the setting of the machine requires Full Control access permission.

Members of Administrators, Server Operators, Print Operators, and Power
Users groups have Full Control permission by default. When you set up op-
tions, log on using an account that has Full Control permission. 

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the machine whose default settings you want to change.

CCCC On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

DDDD Make any settings you require, and then click [OK].

Note
❒ You normally do not have to change the “Form to Tray Assignment” set-

tings on the [Device Settings] tab in the PostScript 3 printer driver.
❒ Settings you make here are used as the default settings for all applications.

Changing the default machine settings - Default Document Properties

Limitation
❒ Changing the setting of the machine requires Full Control access permission.

Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default. When you set up
options, log on using an account that has Full Control permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the machine whose default settings you want to change.

CCCC On the [File] menu, click [Document Defaults].

The [Default Document Properties] dialog box appears.

DDDD Make any settings you require, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
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Making machine settings from an application

To make the machine settings for a specific application, open the [Printer Proper-
ties] dialog box from that application. The following example describes how to
make settings for the WordPad application that comes with Windows NT 4.0.

Note
❒ The actual procedures you should follow to open the [Printer Properties] dialog

box may vary depending on the application. For more information, see the
documentation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print].

The [Print] dialog box appears.

BBBB Select the machine you want to use in the [Name] list box, and then click
[Properties].
The [Printer Properties] dialog box appears.

CCCC Make any settings you require, and then click [OK].

DDDD Click [OK] to start printing.

Macintosh - Setting Up for Printing

Making paper settings from an application

AAAA Open the file you want to print.

BBBB On the [File] menu, click [Page Setup].
The [AdobePS Page Setup] dialog box appears.

CCCC Make sure that the machine you want to use is shown in the [Format for:]
box.

Note
❒ In Mac OS X, this is called [Paper Size].
❒ If the machine is not shown in the [Format for:] box, use the pop-up menu

to display a list of available machines.

Reference
The actual appearance of the Page Setup depends on the application you
are using. See the documentation that comes with the Macintosh for more
information.
7
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DDDD From the [Paper:] box, select the paper size.

EEEE Make any settings you require, and then click [OK].

Setting up for printing from an application

AAAA Open the file you want to print.

BBBB On the [File] menu, click [Print].
The [Printer Features] dialog box appears.

CCCC Make sure that the machine is selected in the [Printer:] box.

DDDD Make any settings you require, and then click [Print] to start printing.
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Canceling a Print Job

Windows - Canceling a Print Job 

AAAA Double-click the printer icon on the Windows taskbar.

A window appears, showing all the print jobs that are currently queuing to
be printed. Check the current status of the job you want to cancel.

BBBB Select the name of the job you want to cancel.

CCCC On the [Document] menu, click [Cancel Printing]. 

Note
❒ In Windows XP, click [Cancel] on the [Document] menu.
❒ In Windows 95/98/Me, 2000 or NT 4.0, you can also open the print job

queue window by double-clicking the machine icon in the [Printers] win-
dow, and in Windows XP, the [Printers and Faxes] window.

DDDD Press the {{{{Printer}}}} key on the machine's control panel.

EEEE Press [Job Reset] on the display panel.

A message appears on the display panel indicating that the print job is being
canceled. 

Important
❒ This procedure cancels the print job that is being processed by the ma-

chine. In some cases, the machine may already be processing data for the
next print job following the one currently being output. In this case, the
next print job is also canceled when you press [Job Reset].

❒ When the machine is being shared by multiple computers, be careful not
to accidentally cancel someone else's print job.

Note
❒ You cannot stop printing data that has already been processed internally

by the machine. Because of this, printing may continue for a few pages af-
ter you press [Job Reset].

❒ A print job that contains a large volume of data may take considerable time
to stop.
9
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Macintosh - Canceling a Print Job

AAAA Double-click the printer icon on the desktop.
A window appears, showing all the print jobs that are currently queuing to
be printed. Check the current status of the job you want to cancel.

Note
❒ In Mac OS X, start Print Center.

BBBB Select the name of the job you want to cancel.

CCCC Click the pause icon, and then click the trash icon.

DDDD Press the {{{{Printer}}}} key on the machine's control panel.

EEEE Press [Job Reset] on the display panel.

A message appears on the display panel indicating that the print job is being
canceled.

Important
❒ This procedure cancels the print job that is being processed by the ma-

chine. In some case, the machine may already be processing data for the
next print job following the one currently being output. In this case, the
next print job is also canceled when you press [Job Reset].

❒ When the machine is being shared by multiple computers, be careful not
to accidentally cancel someone else's print job.

Note
❒ You cannot stop printing data that has already been processed internally

by the machine. Because of this, printing may continue for a few pages af-
ter you press [Job Reset].

❒ A print job that contains a large volume of data may take considerable time
to stop.



2. Uninstalling the Printer
Driver
Uninstalling the Printer Driver

This section describes how to uninstall the printer drivers. Actual procedures
may vary depending on the operating system.
Follow the procedures below as appropriate.

Windows 95/98/Me - Uninstalling the Printer Driver

AAAA Close all the applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

CCCC Click the icon of the machine you want to remove.

DDDD On the [File] menu, click [Delete]. 

A confirmation dialog box appears.

EEEE Click [Yes] to uninstall the printer driver.

Windows 2000/XP - Uninstalling the Printer Driver

Limitation
❒ Uninstalling a printer driver requires Manage Printers permission. Members

of the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you uninstall a printer driver, log on using an account
that has Manage Printers permission.

AAAA Close all the applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note
❒ In Windows XP Professional, access the [Printers and Faxes] window from

[Start] on the taskbar.
❒ In Windows XP Home Edition, access the [Printers and Faxes] window by

clicking [Control Panel] from [Start] on the taskbar. Then click [Printers and
Other Hardware], and then [Printers and Faxes].

CCCC Click the icon of the machine you want to remove.
11
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DDDD On the [File] menu, click [Delete].

A confirmation dialog box appears. 

EEEE Click [Yes] to uninstall the printer driver.

Note
❒ You can also uninstall the printer driver using the following procedure.

• Windows 2000
A In the [Printers] window, click [Server Properties] on the [File] menu to

display the [Print Server Properties] window.
B On the [Drivers] tab, click the driver you want to remove, and then

click [Remove].
C Click [Yes].
D Click [OK].

• Windows XP
A In the [Printers and Faxes] window, click [Server Properties] on the [File]

menu to display the [Print Server Properties] window.
B On the [Drivers] tab, click the driver you want to remove, and then

click [Remove].
C Click [Yes].
D Click [OK].

Windows NT 4.0 - Uninstalling the Printer Driver

Limitation
❒ Uninstalling a printer driver requires Full Control access permission. Mem-

bers of the Administrators, Server Operators, Print Operators, and Power Us-
ers groups have Full Control Permission by default. When you uninstall a
printer driver, log on using an account that has Full Control permission.

AAAA Close all applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

CCCC Click the icon of the machine you want to remove.

DDDD On the [File] menu, click [Delete]. 

A confirmation dialog box appears.

EEEE Click [Yes] to uninstall the printer driver.
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Mac OS - Uninstalling the PostScript 3 Printer Driver

AAAA Drag the “AdobePS” file from the [Extensions] folder in [System Folder] to
[Trash].

BBBB Drag the PPD file and plug-in file from the [Printer Descriptions] folder in the
[Extensions] folder in [System Folder] to [Trash].

Mac OS X - Uninstalling the PostScript 3 Printer Driver

AAAA Run Print Center.

BBBB Select the printer driver you want to uninstall in the Printer List window,
and then click [Delete].
13
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Sample Print

Use this function to print only the first set of a multiple-set print job. After you
have checked the result, the remaining sets can be printed or canceled from the
machine's control panel. This can help in avoiding large amounts of misprints in
case of mistakes in the content or in the print settings.

Note
❒ If the application has a collate option, make sure that it is not selected before

sending a print job. By default, sample print jobs are automatically collated
by the printer driver. If a collate option is selected from the application print
dialog box, more prints than intended may be printed.

❒ You can identify the file you want to print by the User ID and the date and
time when the job was stored.

❒ The number of pages the machine can save depends on the contents of the
print image. For example, the machine can save up to 30 jobs or 1,000 pages
including locked print files depending on data volume.

❒ If the first set of the sample print files is not as you expected and you do not
want to print the remaining sets, delete the sample print file using the display
panel. If you print the remaining sets of the sample print file, the job in the
machine is deleted automatically.

Printing a Sample Print File

The following procedure describes how to print a sample print file with the PCL
5c printer driver. For information about how to print a sample print file with the
PostScript 3 printer driver, see the PostScript3 Board Type 1232 Operating Instruc-
tions Supplement included as a PDF file on the CD-ROM.

Limitation
❒ Applications, like PageMaker, which use their own drivers do not work with

this function.

AAAA Configure the sample print in the properties of the printer driver.

Reference
For details on configuring the PCL 5c or RPCS™ printer driver, see the cor-
responding Help files.

BBBB Click [OK] in the application's print dialog box to start printing.

Note
❒ Make sure to set more than 2 copies.
The sample print job is sent to the machine and the first set is printed.
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CCCC On the machine's control panel, press the {{{{Printer}}}} key to display the Print-
er Screen.

DDDD Press [View Sample Print jobs].

A list of the sample print files stored in the machine is displayed.

The following will also be displayed:
• User ID: The User ID set up by the printer driver.
• Date/Time : The date and time when the job was sent from the computer.
• Qty.: The number of remaining sets.

EEEE Select the file you want to print by pressing on it.

Note
❒ Press [UUUUPrev.] or [TTTTNext] to scroll through the list.
❒ Only one file can be selected at a time.

FFFF Press [Change Set Qty.] to change the number of sets to be printed.

If you do not want to change the set quantity, proceed to step H.

ZFFH371E
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GGGG Enter the new number of sets using the number keys and press [OK].

The screen returns to the file list screen.

Note
❒ You can enter up to 999 sets.
❒ Press [Clear] to correct any entry mistakes.
❒ If you want to cancel changing the set quantity, press [Cancel].

HHHH Press [Print].
The print confirmation screen is displayed.

IIII Press [Yes].

The remaining sets are printed.

Note
❒ Press [No] to cancel printing.
❒ When printing is completed, the stored file will be deleted.
❒ If printing is stopped by pressing [Job Reset] after printing has started, the

file will be deleted.

ZFFH361E
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Deleting a Sample Print File

If you are not satisfied with the sample printout, you can delete the sample print
file, revise it and print it again until the settings are fine.

AAAA Press the {{{{Printer}}}} key to display the Printer Screen.

BBBB Press [View Sample Print jobs].

A list of the sample print files stored in the machine is displayed.

CCCC Select the file you want to delete by pressing on it.

Note
❒ Press [UUUUPrev.] or [TTTTNext] to scroll through the list.
❒ Only one file can be selected at a time.

DDDD Press [Delete].

The delete confirmation screen will be displayed.

EEEE Press [Yes] to delete the file.

After the file has been deleted the screen will return to the file list screen.

Note
❒ If you do not want to delete the file, press [No].

ZFFH371E
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Checking the Error Log

If a file could not be stored in the machine, you can check the error log on the
control panel.

Limitation
❒ The error log displays only the 20 most recent entries. If the power is turned

off, the log will be deleted.

AAAA Press the {{{{Printer}}}} key to display the Printer Screen.

BBBB Press [View Sample Print jobs].

CCCC Press [Show Error Log].

DDDD Press [UUUUPrev.] or [TTTTNext] to scroll the error files.

Press [Exit] after checking the log.
You will then return to the file list screen.

Note
❒ For printing files that appear in the error log, resend them after stored files

in the machine have been printed or deleted.

ZFFH371E
19
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Locked Print

Use this function to maintain privacy when printing confidential documents on
the machine over a shared network. Usually, it is possible to print data by using
the control panel once the data is stored in this machine. When using Locked
Print, it will not be possible to print unless a password is entered on the ma-
chine's control panel. Your confidential documents will be safe from viewing by
other people.

Note
❒ If the application has a collate option, make sure that it is not selected before

sending a print job. By default, locked print jobs are automatically collated by
the printer driver. If a collate option is selected from the application print di-
alog box, more sets than intended may be printed.

❒ You can identify the file you want to print by the User ID and the date and
time when the job was stored.

❒ The number of pages the machine can save depends on the contents of the
print image. For example, the machine can save up to 30 jobs or 1,000 pages
including sample print files depending on data volume.

❒ After the locked print file is printed, the job in the machine is deleted auto-
matically.

❒ Turning off the main power switch of the machine deletes the locked print
file.

Printing a Locked Print File

The following procedure describes how to print a locked print file with the PCL
5c printer driver. For information about how to print a locked print file with the
PostScript 3 printer driver, see the PostScript 3 Board Type 1232 Operating Instruc-
tions Supplement included as a PDF file on the CD-ROM.

Limitation
❒ Applications, like PageMaker, which use their own drivers do not work with

this function.

AAAA Configure the locked print in the properties of the printer driver.

Reference
For details on configuring the PCL 5c or RPCS™ printer driver, see the cor-
responding Help files.

BBBB Click [OK] in the application's print dialog box to start printing.
The locked print job is sent to the machine.
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CCCC On the machine's control panel, press the {{{{Printer}}}} key to display the Print-
er Screen.

DDDD Press [View Locked Print jobs].

A list of the locked print files stored in the machine is displayed.

The following will be also be displayed:
• User ID: The User ID set up by the printer driver.
• Date/Time: The date and time when the job was sent from the computer.
• Qty: The number of remaining sets.

EEEE Select the file you want to print by pressing on it.

Note
❒ Press [UUUUPrev.] or [TTTTNext] to scroll through the list.
❒ Only one file can be selected at a time.

FFFF Press [Print].

The password screen is displayed.

ZFFH371E
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GGGG Enter the password using the number keys and press [OK].

The print confirmation screen is displayed.

Note
❒ A confirmation screen will appear when the password has not been en-

tered correctly. Press [OK] to enter the password again.

HHHH Press [Yes].
The locked file is printed.

Note
❒ Press [No] to cancel printing.
❒ If printing is stopped by pressing [Job Reset] after printing has started, the

file will be deleted.

Deleting Locked Print Files

AAAA Press the {{{{Printer}}}} key to display the Printer Screen.

BBBB Press [View Locked Print jobs].

A list of the locked files stored in the machine is displayed.

CCCC Select the file you want to delete by pressing on it.

Note
❒ Press [UUUUPrev.] or [TTTTNext] to scroll through the list.
❒ Only one file can be selected at a time.

ZFFH371E
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DDDD Press [Delete].

The password screen is displayed.

EEEE Enter the password using the number keys and press [OK].

The delete confirmation screen is displayed.

FFFF Press [Yes].
After the file has been deleted, the screen returns to the file list screen.

Note
❒ If you do not want to delete the file, press [No].
❒ If you forget your password, set [Display Password with Stored File] to “ON”

on the [Key Operator Tools] tab of the System Settings screen. With this set-
ting, the password screen is not displayed in the procedure above. For
more information about [Display Password with Stored File], see the General
Settings Guide.

Checking the Error Log

If a file could not be stored in this machine, you can check the error log on the
control panel.

Limitation
❒ The error log displays only the 20 most recent entries. If the power is turned

off, the log will be deleted.

AAAA Press the {{{{Printer}}}} key to display the Printer Screen.

ZFFH371E
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BBBB Select [View Locked Print jobs].

CCCC Press [Show Error Log].

DDDD Press [UUUUPrev.] or [TTTTNext] to scroll the error files.

Press [Exit] after checking the log.
You will then return to the file list screen.

Note
❒ For printing files that appear in the error log, resend them after stored files

in the machine have been printed or deleted.
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Accessing the Document Server

The Document Server enables you to save documents in the machine's built-in
hard disk to edit and print as you want.

Reference
For more information about Document Server functions, see the General Set-
tings Guide.
For information about how to access to Document Server from a client, see the
printer driver's Help.

Note
❒ When you use the Document Server, the following can be selected using the

machine's control panel:
• Copies
• Collate
• Duplex
• Staple
• Paper Source
• Output Tray

❒ The above items are dimmed, so you cannot set them from the [Printer Proper-
ties] dialog box when the Document Server is selected.

❒ You must enter a User ID of up to eight alphanumeric characters.
❒ You had better enter “Password” and “File Name” to distinguish the job from

others.
❒ Up to 1,000 files can be saved on the Document Server. No new files can be

saved once 1,000 files are saved. Even if less than 1,000 files are saved, new
files cannot be saved when
• a file to be saved contains more than 1,000 pages,
• the total number of pages contained in files saved exceeds 2,000,
• the hard disk is full.

❒ The Document Server also saves files scanned via Automatic Document Feed-
er (ADF) or exposure glass. You should delete unnecessary saved files once
in a while so as not to exceed the capacity of the hard disk. For how to delete
saved files, see the General Settings Guide.

❒ When using the hard disk for functions other than Document Server func-
tions, you may be unable to save new files on the Document Server even if
there are less than 1,000 files saved.
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4. Troubleshooting
Error & Status Messages on the Display 
Panel

❖❖❖❖ Status Messages

❖❖❖❖ Alert Messages

Messages/Second messages Status

Hex Dump Mode The machine receives data in hexadecimal numbers in Hex 
Dump mode. Turn off the machine after printing, and then 
turn back on.

Offline The machine is offline. Set the machine online by pressing 
[Online] on the display panel to start printing.

Please Wait The machine is initializing the development unit. Wait for a 
while.

Printing... The machine is making prints. Wait for a while.

Ready The default ready message. The machine is ready for use. No 
action is required.

Resetting Job... The machine is resetting the print job. Wait until “Ready” ap-
pears on the display panel.

Waiting... The machine is waiting for the next data to print. Wait for a 
while.

Messages/Second messages Description Solution

Close duplex unit cover. The cover of the duplex unit is 
open.

Close the cover of the duplex 
unit.

Close ### cover The cover of the indicated pa-
per tray is open.

Note
❒ “###” in the message rep-

resents a paper feed tray.

Close the cover of a paper feed 
tray.

Collate has been cancelled. The collate print function has 
been canceled.

Increase memory capacity. 
When adding a memory mod-
ule to the machine, contact 
your sales or service represen-
tative.

DIMM has a problem. An error has occurred in the 
DIMM inside the machine.

Contact your sales or service 
representative.
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Driver setting error. 
(Memory) 

There is an error in the down-
loaded font(s).

Reset the parameter for down-
loading fonts.

Insufficient memory or memo-
ry settings for the printer driv-
er may not match memory 
actually installed.

Specify correct memory capac-
ity in the [Change Accessories...] 
option in the RPCS™ printer 
driver's print settings tab.

To print the image correctly, 
increase memory capacity, or 
reduce resolution image.

Duplex has been cancelled. Duplex printing has been can-
celed.

Confirm that the paper used is 
suitable for duplex printing. 
Or, increase memory capacity. 
When adding a memory mod-
ule to the machine, contact 
your sales or service represen-
tative.

Ethernet board has a prob-
lem.

An error has occurred in the 
Ethernet board.

Turn off the main power 
switch, and on. If the message 
appears again, contact your 
sales or service representative.

Exceeded max capacity of 
document server. Cannot 
stored.

Hard disk drive capacity ex-
ceeded storing to the docu-
ment server.

Delete files stored in the docu-
ment server or decrease the 
file size to be downloaded.

Exceeded max number of 
files of document server. Can-
not stored.

The maximum number of files 
stored in the document server 
has been exceeded.

Delete files stored in the docu-
ment server.

Exceeded max number of 
pages of document server. 
Cannot stored.

The maximum number of pag-
es stored in the document 
server has been exceeded.

Delete pages stored in the doc-
ument server or decrease the 
number of pages to be down-
loaded.

Exceeded Max. stored files in 
sample print and locked 
print.

The maximum number of 
stored files has been exceeded 
during Sample Print or 
Locked Print.

Delete stored files or reduce 
file sizes.

Exceeded Max. stored pages 
in sample print and locked 
print.

The maximum number of 
stored pages has been exceed-
ed during Sample Print or 
Locked Print.

Reduce the number of pages 
to be printed.

Exceeded max. pages. Collate 
is incomplete.

The maximum number of pag-
es has been exceeded for colla-
tion.

Increase memory capacity. 
When adding a memory mod-
ule to the machine, contact 
your sales or service represen-
tative.

Finisher is in use for another 
function. Please wait.

The finisher is in use by anoth-
er function such as the copier 
function.

Wait until the other function 
has finished using the finisher.

Messages/Second messages Description Solution



Error & Status Messages on the Display Panel

29

4

Following output tray is full. 
###

The indicated output tray is full.

Note
❒ “###” in the message rep-

resents a output tray.

Remove the paper.

HDD has a problem. An error has occurred in the 
hard disk drive.

Turn off the main power 
switch, and on. If the message 
appears again, contact your 
sales or service representative.

HDD has not been installed. The Locked Print was per-
formed without the hard disk 
installed, or the hard disk is 
damaged.

Install the hard disk if not in-
stalled. If the message appears 
again after the hard disk is in-
stalled, contact your sales or 
service representative.

HDD is full. The maximum hard disk area 
size for form/font has been ex-
ceeded.

Delete unused form/font 
types.

An HDD overflow error oc-
curred during Sample Print or 
Locked Print.

Delete stored files or reduce 
the file to be downloaded.

IEEE 802.11b (Wireless LAN) 
has a problem.

IEEE 802.11b card was not in-
serted when the machine was 
turned on, or it was pulled out 
after the machine turned on.

Turn off the machine and 
check the IEEE 802.11b card is 
inserted correctly. Then, turn 
on the machine again. If the 
message appears again, call 
your service center.

I/O buffer overflow. The maximum size of the I/O 
buffer has been exceeded.

Increase the size of the I/O 
buffer.

LCT has a problem. Turn 
Main Power Switch off then 
on. If the error appears again, 
call service representative.

An error occurred in the large 
capacity tray.

Turn off the main power 
switch, wait five minutes, and 
on again. If the message ap-
pears again, call your sales or 
service representative.

dLower Staple is almost 
empty.

There are a few staples re-
maining in the lower stapler.

Load in more staples.

NV-RAM has a problem. An error has occurred in the 
optional memory unit.

Turn off the main power 
switch, and on. If the message 
appears again, call your sales 
or service representative.

Output tray has been 
changed.

The output tray has been 
changed automatically.

Select the proper output tray.

Paper in duplex unit. Open 
cover and remove paper.

There is a misfeed in the du-
plex unit.

Open the cover of the duplex 
unit, and remove the misfed 
paper.

Paper in staple tray. Open fin-
isher cover and remove paper.

There is paper remaining in-
side the finisher.

Open the cover of finisher, and 
remove the paper.

Messages/Second messages Description Solution
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Paper size and type are mis-
matched.

Specified paper size and paper 
type are not loaded in the pa-
per feed tray.

Change the settings to contin-
ue the current job, or press 
[Reset] to cancel the job.

Parallel I/F board has a prob-
lem.

An error has occurred in the 
parallel interface board.

Contact your sales or service 
representative.

Print overrun. The image data has been 
thinned out due to image com-
pression.

Increase memory capacity. 
When adding a memory mod-
ule to the machine, contact 
your sales or service represen-
tative.

Reset duplex unit correctly. If 
the error appears again, call 
service representative.

The duplex unit is not set cor-
rectly, or an error has occurred 
in the duplex unit.

Set the duplex unit correctly. If 
the message appears again, 
call your sales or service repre-
sentative.

RPCS graphic error. There is insufficient graphics 
memory to print the data.

Specify the correct memory 
capacity in the [Change Acces-
sories..] option in the RPCS™ 
printer driver's print settings 
tab.

To print the image correctly, 
add memory to the machine, 
or reduce the resolution of the 
image.

RPCS memory overflow. A memory overflow occurred 
during the print job. After part 
of the data is printed, the print 
job is suspended.

To print the image correctly, 
add memory to the machine, 
or reduce resolution.

RPCS syntax error. Bidirectional transmission 
may not be working properly 
or the RPCS™ printer driver 
settings may not be correct.

Confirm the option settings 
for the printer driver match 
the options installed on the 
machine.

Selected paper tray is in use 
for another function. Please 
wait.

The specified paper tray is in 
use by another function such 
as copier function.

Wait until the other function 
has finished using the speci-
fied paper tray.

Shift tray has a problem. Call 
service representative.

A malfunction occurs when 
using the shift function.

Contact your sales or service 
representative.

Staple has been cancelled. Staple printing has been can-
celed.

Confirm paper feed direction, 
paper orientation and stapling 
position.

dStaple is almost empty. There are a few staples re-
maining.

Load in more staples.

Staple unit is in use for anoth-
er function. Please wait.

The staple unit is in use by an-
other function such as copier 
function.

Wait until the other function 
has finished using the staple 
unit.

Messages/Second messages Description Solution
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Machine Configuration

You can check the machine configuration using telnet or UNIX.

❖❖❖❖ telnet
Use the info command.

❖❖❖❖ UNIX
Use the lpr or lpstat command or stat parameter of rsh, rcp, or ftp.

Reference
For more information, see “Remote Maintenance by Telnet (mshell)”, the
Network Printing Guide provided as a PDF file on the CD-ROM labeled
“Operating Instructions”.

Note
❒ “*” (asterisk) is displayed with the current setting.
❒ Regarding *1–*5, see table below.

*** No toner. Replace Toner 
Cartridge.

The indicated color toner has 
almost run out.

Note
❒ “***” in the message repre-

sents the color: Black, Yel-
low, Magenta, or Cyan.

Replace the toner cartridge 
with a new one.

DToner is almost empty. The toner has almost run out. Replace the toner cartridge 
with a new one.

Tray ### has a problem. Turn 
Main Power Switch off then 
on. If the error appears again, 
call service representative.

An error has occurred in the 
indicated paper feed tray.

Note
❒ “###” in the message rep-

resents a paper feed tray.

Turn off the main power 
switch, wait five minutes, and 
on again. If the message ap-
pears again, call your sales or 
service representative.

Unauthorized user access. 
Print job has been cancelled.

Print job canceled due to user 
restrictions.

Check the User Code permis-
sion condition.

Item Description

Input Tray

No.

Name

PaperSize

Status

ID number of the paper tray

Name of the paper tray*1

Paper size loaded in the paper tray*2

Current status of the paper tray*3

Output Tray

No.

Name

Status

ID number of the output tray

Name of the output tray*4

Current status of the output tray*5

Messages/Second messages Description Solution
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❖❖❖❖ *1 Input Tray: Name

❖❖❖❖ *2 Input Tray: Paper Size

Name Description

Tray X Name of installed paper tray 
(X is the number of tray.)

Tray 3 (LCT) Large Capacity Tray (LCT)

Bypass Tray Bypass tray

Paper Size Description

A3 (297 × 420) A3L

B4JIS (257 × 364) B4L

A4 (297 × 210) A4L

A4 (210 × 297) A4K

B5JIS (257 × 182) B5L

B5JIS (182 × 257) B5K

A5 (210 × 148) A5L

A5 (148 × 210) A5K

A6 (105 × 148) A6L

11 × 17 DLTK

81/2 × 14 LGL

81/2 × 11 LTK

11 × 81/2 LTL

51/2 × 81/2 HLTK

 81/2 × 51/2 HLTL

Custom Size Custom Size

101/2 × 71/4 ExecutiveK

71/4 × 101/2 ExecutiveL

81/4 × 13 FolioL

81/2 × 13 FoolscapL

41/8 × 91/2 Com10K

37/8 × 71/2 MonarchK

DL Env (110 × 220) DL EnvK

C5 Env(162 × 229) C5 EnvK

C6 Env(114 × 162) C6 EnvK

8 × 13 8"×13"L

8K (267 × 390) 8KL

16K (195 × 267) 16KK

16K (267 × 195) 16KL
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❖❖❖❖ *3 Input Tray: Status

❖❖❖❖ *4 Output Tray: Name

❖❖❖❖ *5 Output Tray: Status

Status Description

Normal 

NoTray There is no paper tray

PaperEnd There is no paper in the paper tray

Name Description

Internal Tray 1 Internal Tray 1

Internal Tray 2 Internal Tray 2

Shift Tray Shift Tray

Finisher Tray Finisher Tray (Finisher 500)

Finisher Proof Tray Finisher Proof Tray (Finisher 1000)

Finisher Shift Tray Finisher Shift Tray (Finisher 1000)

Status Description

Normal ----

PaperExist There is paper in the output tray

OverFlow Output tray is full of paper

Error Other error
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Machine Does Not Print

Possible Cause Solutions

Is the power on? Confirm the cable is securely plugged into the power outlet and 
the machine. 

Turn on the main power switch.

Is the machine online? If not, press [Online] on the display panel.

Does the printer function 
status indicator stay red?

If so, check the error message on the display panel and take the re-
quired action.

Is there a warning status or 
error message on the dis-
play panel?

If so, check the error message or warning status on the display 
panel and take the required action.

Can you print a configura-
tion page?

If you cannot print a configuration page, there maybe a machine 
malfunction. Contact your sales or service representative.

See p.52 “Machine Condition” for printing a configuration page.

Is the interface cable con-
nected securely to the ma-
chine and the computer?

Connect the interface cable securely. If it has a fastener, fasten that 
securely as well.

See “Connecting the Machine”, Printer Reference 1.

Are you using the correct 
interface cable?

The type of interface cable you should use depends on the com-
puter. Be sure to use the correct one. If the cable is damaged or 
worn, replace it.

See “Connecting the Machine”, Printer Reference 1.

Was the interface cable 
connected after the ma-
chine was turned on?

Connect the interface cable before turning on the machine.

Is the signal status satisfac-
tory when using wireless 
LAN in Infrastructure 
mode ?

To check the signal status, press {{{{User Tools/Counter/Inquiry}}}} on the 
control panel, and then [System Settings] on the display panel. On 
the [Interface Settings] tab, select [IEEE 802.11b] and then press [Wire-
less LAN Signal]. If signal quality is bad, move the machine to a lo-
cation where signals pass or remove any objects that block signals.

When using Wireless LAN, 
is the SSID correctly set?

Confirm the machine's display panel that the SSID is correctly set.

See “Interface Settings/IEEE 802.11b (Option)”, General Settings Guide.

When using a Wireless 
LAN, is the access point 
correctly set?

Confirm the access point settings when in Infrastructure mode. 
Depending on the access point, client access may be limited by the 
MAC address.

Also, confirm there are no problems in transmission between ac-
cess point and wired clients, and between access point and wire-
less clients.

When using Wireless LAN, 
is the LED on the Wireless 
LAN card lit or blinking?

Confirm the orange LED is lit, and the green LED is lit or blinks 
during transmission.

Is the Wireless LAN being 
used in Ad Hoc mode?

In that case, turn the main power switch off and on. Also, chang-
ing some of the settings in [Network] on the [Interface Settings] tab in 
[System Settings] on the display panel may solve the problem.
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Possible Cause Solutions

Is the Data In indicator 
blinking or lit after starting 
the print job?

If not, the data is not being sent to the machine. 

❖❖❖❖ When the machine is connected to the computer using 
the interface cable
Confirm that the machine port settings are correct. For a paral-
lel port connection, port LPT1 or LPT2 should be set. 

• Windows 95/98/Me

A Click [Start], point to [Settings], and then click [Printers].

B Click the icon of the machine. On the [File] menu, click 
[Properties].

C Click the [Details] tab.

D Check the [Print to the following port] box to confirm that 
the correct port is selected.

• Windows 2000

A Click [Start], point to [Settings], and then click [Printers].

B Click the icon of the machine. On the [File] menu, click 
[Properties].

C Click the [Port] tab.

D Check the [Print to the following port] box to confirm that 
the correct port is selected.

• Windows XP Professional

A Click [Start], and then click [Printers and Faxes].

B Click the icon of the machine. On the [File] menu, click 
[Properties].

C Click the [Ports] tab.

D Check the [Point to the following port(s)] box to confirm 
that the correct port is selected.

• Windows XP Home Edition

A Click [Start], [Control Panel], [Printers and Other Hardware], 
and then [Printers and Faxes].

B Click the icon of the machine. On the [File] menu, click 
[Properties].

C Click the [Ports] tab.

D Check the [Point to the following port(s)] box to confirm 
that the correct port is selected.

• Windows NT 4.0

A Click [Start], point to [Settings], and then click [Printers].

B Click the icon of the machine. On the [File] menu, click 
[Properties].

C Click the [Port] tab.

D Check the [Print to the following port] box to confirm that 
the correct port is selected.

❖❖❖❖ Network Connection
Contact your network administrator.
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Other Printing Problems

Status Possible Causes, Descriptions, and Solutions

The print on the 
entire page is fad-
ed.

If “Toner Saver” is selected in the [Print Quality] tab on the printer driver tab, 
the entire page will be faded when printed.

See the printer driver's Help.

The print smudges. The settings have not been set to thick paper when printing on thick paper.

• PCL 5c/PostScript 3
Select “Thick” for [Type] on the printer driver's [Paper] tab.

• RPCS™
Select “Thick Paper” for [Paper Type] on the printer driver's [Print Set-
tings] tab.

The color of the 
printout is differ-
ent from the color 
specified.

If a specific color is missing, turn the main power switch off and on. If this 
does not solve the problem, contact your sales or service representative.

See the printer driver's Help.

When printing 
graphic data, the 
output and the 
screen are differ-
ent.

If the printer driver is configured to use the graphics command, the graph-
ics command from the machine is used to print.

If you want to print accurately, set the printer driver to print without using 
the graphics command.

See the printer driver's Help.

Page layout is not 
as expected.

Print areas differ depending on the machine used. Information that fits on 
a single page on one machine may not fit on a single page of another ma-
chine.

Adjust the [Print Area] settings in the printer driver.

See the printer driver's Help.

Duplex printing is 
malfunctioning.

• Duplex printing cannot be done with paper set in the optional bypass 
tray. When using duplex printing, make settings to use paper from a 
tray other than the optional bypass tray.

• Duplex printing cannot be done with thick paper, OHP transparencies, 
labels, or thin paper specified as the paper type. Specify another paper 
type.

• Duplex printing cannot be done with a tray for which [1-Sided Copy] has 
been specified as “Paper Type” on the System Settings menu. Change 
the “Paper Type” setting for the tray to [2-Sided Copy] on the System Set-
tings menu. See the General Settings Guide.
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When using Win-
dows 95/98/Me, 
Windows 
2000/XP, or Win-
dows NT4.0, ei-
ther combined 
printing or book-
bind print does 
not come out as 
expected.

Make sure the application's paper size and orientation settings match those 
of the printer driver.

If a different paper size and orientation are set, select the same size and ori-
entation.

When using Win-
dows 95/98/Me, 
Windows 
2000/XP, or Win-
dows NT 4.0, 
Auto Reduce/En-
large print does 
not come out as 
expected.

A print instruc-
tion was issued 
from the comput-
er, but printing 
did not start.

User code management may have been set. Ask the administrator about 
valid user codes. To print, the user code must be entered from the printer 
driver.

The print job is not 
canceled even 
when the machine 
is switched to of-
fline status.

Even when the machine is offline, printing is performed when [Job Receive] 
has been set in “Signal Control” in the System Settings menu. Change the 
system setting of “Signal Control” to “Printer priority”.

See “User Tools (System Settings)”, General Settings Guide.

Color changes are 
extreme when ad-
justed using the 
printer driver. 

• PCL 5c/PostScript 3
Do not make extreme settings for color balance in the [Advanced] dialog 
box on the [Print Quality] tab in the printer driver's dialog box. 

• RPCS™
Do not make extreme settings for color balance on the [Image Adjust-
ments] tab in the [Change User Settings] dialog box on the [Print Quality] 
tab in the printer driver's dialog box. The color sample does not show 
the color of the printout.

See the printer driver's Help.

Photo images are 
coarse.

Some applications lower print resolution.

Black gradation is 
not natural.

• PCL 5c/PostScript 3
Select “CMY+K” for [Gray Reproduction] in the printer driver's 
[Advanced] dialog box on the [Print Quality] tab.

• RPCS™
Select “CMY+K” for [Gray Reproduction] on the [Image Adjustments] tab in 
the printer driver's [Change User Setting] dialog box on the [Print Quality] 
tab.

Status Possible Causes, Descriptions, and Solutions
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Color documents 
are printed in 
black and white.

The printer driver is not set up for color printing.

• PCL 5c/PostScript 3
Select “Color” for [Color/Black and White] on the printer driver's [Setup] 
tab. 

• RPCS™
Select “Color” for [Color/Black and White] on the printer driver's [Print Set-
tings] tab. 

See the printer driver's Help.

Some applications print color files in black and white.

Fine dot pattern 
does not print.

• PCL 5c/PostScript 3
Change the [Dithering] setting in the [Advanced] dialog box on the printer 
driver's [Print Quality] tab. 

• RPCS™ 
Change the [Dithering] setting on the [Image Adjustments] tab in the 
[Change User Settings] dialog box on the [Print Quality] tab in the printer 
driver's dialog box. 

See the printer driver's Help.

Images are cut off, 
or excess is print-
ed.

You may be using paper smaller than the size selected in the application. 
Use the same size paper as that selected in the application. If you cannot 
load paper of the correct size, use the reduction function to reduce the im-
age, and then print.

See the printer driver's Help.

It takes too much 
time to complete 
the print job.

Photographs and other data intensive pages take a long time for the ma-
chine to process, so simply wait when printing such data.

Changing the following settings with the printer driver may help to speed 
up printing.

• PCL 5c 
Select “600 dpi”, and then select “Fast” for [Gradation] on the [Print Qual-
ity] tab in the printer driver's dialog box.

• PostScript 3
Select “Fast” for [Gradation] on the [Print Quality] tab in the printer driv-
er's dialog box. 
Select “Post Script (optimize for speed)” for PostScript output format 
on the [PostScript] tab in the printer driver's dialog box. 

• RPCS™ 
Select “600 × 600 dpi” for [Resolution] on the [Image Adjustments] tab in 
the [Change User Settings] dialog box on the [Print Quality] tab in the print-
er driver's dialog box. 
Select “Speed” for [Print priority] on [Print Quality] tab in the printer driv-
er's dialog box. 

See the printer driver's Help.

The data is so large or complex that it takes time to process. If the Data In 
indicator is blinking, data is being processed. Just wait until printing re-
sumes.

If "Warming Up..." appears on the display panel, the machine is warming 
up. Wait for a while.

Status Possible Causes, Descriptions, and Solutions
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It takes too much 
time to resume 
printing.

The data is so large or complex that it takes time to process. If the Data In 
indicator is blinking, data is being processed. Just wait until printing re-
sumes.

The machine was in Energy Saver mode. To resume from Energy Saver 
mode, it has to warm up, and this takes time. To disable Energy Saver 
mode, select "Off" for "Energy Saver 1" in the System Settings menu. See 
the General Settings Guide.

Paper is not fed 
from the selected 
tray.

When using a Windows operating system, printer driver settings override 
those set using the display panel. Set the desired input tray using the print-
er driver.

See the printer driver's Help.

Solid areas, lines 
or text are shiny or 
glossy when creat-
ed as a mixture of 
cyan, magenta, 
yellow.

Make the following settings with the printer driver.

• PCL 5c
Select “K(Black)” for [Gray Reproduction] in the printer driver's 
[Advanced] dialog box on the [Print Quality] tab. 

• PostScript 3
Select “Pure Black Text” for [Gray Reproduction] in the printer driver's 
[Advanced] dialog box on the [Print Quality] tab. 

• RPCS™ 
Select “K(Black)” for [Gray Reproduction] on the [Image Adjustments] tab 
in the printer driver's [Change User Settings] dialog box on the [Print Qual-
ity] tab.

Solid lines are 
printed as broken 
lines.

Make the following settings with the printer driver.

• PCL 5c/PostScript 3
Change the [Dithering] setting in the [Advanced] dialog box under the 
printer driver's [Print Quality] tab. 

• RPCS™ 
Change the [Dithering] setting under the [Image Adjustments] tab in the 
[Change User Settings] dialog box, under the [Print Quality] tab in the 
printer driver's dialog box. 

See the printer driver's Help.

Optional compo-
nents connected to 
the machine are 
not recognized 
when using Win-
dows 95/98/Me, 
Windows 
2000/XP, and 
Windows NT 4.0.

You have to configure the optional component in printer properties when 
bidirectional transmission is not enabled.

See the printer driver's Help.

The color of the 
printout is differ-
ent from the color 
on the computer's 
display.

The colors made using color toner are different from colors on the display.

When “Toner Saving” is checked on the [Print Quality] tab in the printer 
driver's dialog box, the color gradation may appear differently.

See the printer driver's Help.

Status Possible Causes, Descriptions, and Solutions
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Note
❒ If the problem cannot be solved, contact your sales or service representative.

Images are print-
ed in the wrong 
orientation.

The feed direction you selected and the feed direction selected in the print-
er driver's Option Setup of the printer driver might not be the same. Make 
the proper settings.

See the printer driver's Help.

The printed image 
is different the im-
age on the com-
puter's display.

With certain functions, such as enlargement and reduction, the layout of 
the image might be different to that on the computer display.

You might have selected to replace True Type fonts with machine fonts in 
the printing process.

To print an image similar to the image on the computer display, make set-
tings to print True Type fonts as an image.

See the printer driver's Help.

No transmission 
when you use 
1394 interface con-
nection

Check using the following procedure.

A Confirm the IEEE 1394 interface cable is connected securely.

B Restart the computer.
If the error occurs even after executing the above operation, go to the 
following steps.

C Unplug the IEEE 1394 interface cable that is connected to the computer.

D Execute the utility tool for 1394 Interface Unit, which is stored in the fol-
lowing path in the CD-ROM labeled “Printer Drivers and Utilities”.
\UTILITY\1394\

Important
❒ For more information about using the utility tool for IEEE 1394, see 

the README file in the same directory on the CD-ROM.

E Restart the computer.

Printing stops and 
a paper error is 
displayed if the 
custom size paper 
in the paper feed 
tray is specified 
when printing 
with the Post-
Script 3 printer 
driver.

Follow the one of the procedures below.

• Press [Job Reset] on the display panel to stop printing. Set the custom 
size paper in the bypass tray, and then start printing.

• Select the paper feed tray with custom size paper, and then press 
[Continue] to force printing.

Status Possible Causes, Descriptions, and Solutions
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Auto Color Calibration

This function is used for adjusting the balance of yellow, magenta (red), cyan
(blue), and black when certain colors are too strong or when the color of the print
is different from the screen.

Note
❒ If “D Toner is almost empty.” is shown on the display panel, the test pattern

cannot be printed.

AAAA Press the {{{{User Tools/Counter/Inquiry}}}} key on the control panel.

BBBB Press [Maintenance].

CCCC Press [Auto Color Calibration].

DDDD Press [Start] in “Printer Function”.

EEEE Select the item you want to calibrate.

Note
❒ When using 600 × 600 dpi, be sure to calibrate [Test Pattern 1 (600 ×××× 600 dpi)].
❒ When using 1800 × 600 dpi, be sure to calibrate both [Test Pattern 2 (1800 ××××

600 dpi) ] and [Test Pattern 3 (1800 ×××× 600 dpi) ].

ZFFH801E
41



Troubleshooting

42

4

FFFF Press [Start Printing].

A test pattern will be printed, and the message “Place Test Pattern on expo-
sure glass correctly, then press [Start Scanning]” appears.

Note
❒ The test pattern will be printed on A4K, B4JISL, A3L, 11”x17”L or

8/”x11”K. One of the above paper sizes should be loaded on the paper
feed tray.

❒ Printing the test pattern does not advance the counter.

GGGG  Place the test pattern on the exposure glass, and press [Start Scanning].

Note
❒ The Auto Document Feeder (ADF) cannot be used to scan the test pattern.

Make sure to place it on the exposure glass.
❒ When the Auto Document Feeder (ADF) is installed on the machine, place

the test pattern on the exposure glass with two or three white sheets of the
same size on it.

HHHH Press [Exit] three times.

Returning to the Previous Setting

AAAA Press [Previous Setting] in the screen shown on step DDDD above.

BBBB Select the item you want to reset.

CCCC Press [Yes], and then [Exit] three times. .



5. Using the Control Panel
Though the factory default settings of the machine are suitable for most printing
jobs, the “Printer Features” gives you access to a number of settings that control
basic printer operations. “Printer Features” settings you make are retained even
when you turn off the machine.

Reference
For more information about the copier features and the system settings, see
the Copy Reference and the General Settings Guide.

Adjusting Printer Features 

Printer Features Menu

There are six menu items in the “Printer Features” menu.
• Paper Input
• List/Test Print
• Maintenance
• System
• Host Interface
• PCL Menu
You can select functions in the following table.

 Category  Function menu 

Paper Input ⇒ p.46 Bypass Paper Size

List/Test Print ⇒ p.46 Config. Page

Menu List

PS Config./Font Page

PCL Config./Font Page

Hex Dump

Maintenance ⇒ p.46 Menu Protect
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Accessing the Printer Features

AAAA Press the {{{{User Tools/Counter/Inquiry}}}} key on the control panel.

BBBB Press [Printer Features].

CCCC Select the desired item by pressing the tab, and then change the settings.

Note
❒ [OK] : Press to set the new settings and return to the previous menu.
❒ [Cancel] : Press to return to the previous menu without changing any set-

ting.

System⇒ p.47 Print Error Report

Auto Continue

Memory Overflow

Sub Paper Size

Page Size

Duplex 

Job Separation

Resolution PCL

PS

Toner Saving

Host Interface ⇒ p.50 I/O Buffer

I/O Timeout

PCL Menu⇒ p.50 Orientation

Form Lines

Font Source

Font Number

Point Size

Font Pitch

Symbol Set

Extend A4 Width

 Category  Function menu 
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Exiting from the Printer Features

AAAA After changing the Printer Features, press [Exit] to return to the User
Tools/Counter/Inquiry menu.

BBBB Press [Exit].

Note
❒ You can also exit from the User Tools/Counter/Inquiry menu by pressing

the {{{{User Tools/Counter/Inquiry}}}} key.
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Printer Features Parameters

Paper Input

List/Test Print

Maintenance

 Menu  Description 

Bypass Paper Size The paper size for the bypass tray.

For more information about paper sizes that can be set in the by-
pass tray, see the General Settings Guide.

Note
❒ Default: A4 (Metric version), 11 × 8/ (Inch version)

 Menu  Description 

Config. Page You can print the current configuration of the machine. 

Reference
See p.52 “Machine Condition” for printing a configuration 
page.

Menu List You can print the Menu List which shows the function menus of 
the machine.

PS Config./Font Page You can print the current configuration of the installed PostScript 
fonts.

PCL Config./Font Page You can print the current configuration of the installed PCL fonts

Hex Dump You can print the Hex Dump.

Menu Description

Menu Protect This procedure lets you protect menu settings against accidental 
changes. It makes it impossible to change the menu settings you 
make with the normal procedure unless you perform the required 
key operation. In a network environment, protecting settings re-
stricts changes to menu settings to network administrators.

• Level 1

• Level 2

• Off 

Note
❒ Default: Off
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The table below lists the menus that can be protected at level 1 or 2.

❍: Protected
×: Not protected

Note
❒ You can also use SmartNetMonitor for Admin to protect menus. To do so,

you must set an access code on the machine beforehand.

System

Menu Level 1 Level 2

Paper Size Settings × ❍

Adjustment/Management ❍ ❍

System Settings ❍ ❍

Interface Settings ❍ ❍

Program × ❍

PCL Menu ❍ ❍

Language ❍ ❍

Menu Description

Print Error Report You can select whether or not to have an error report printed 
when a printer error or memory error occurs.

• Off

• On

Note
❒ Default: Off

Auto Continue You can select whether or not to enable Auto Continue. When it 
is “On”, printing continues after a system error occurs.

• Off

• 0 minute

• 1 minute

• 5 minutes

• 10 minutes

• 15 minutes

Note
❒ Default: Off
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Memory Overflow You can select whether the memory overflow error report should 
be printed.

• Not Print

• Error Report

Note
❒ Default: Not Print 

Sub Paper Size You can enable the “Auto Substitute Paper Size (A4↔LT)” fea-
ture.

• Off

• Auto

Note
❒ Default: Off

Page Size You can select the default paper size.

• 11 × 17

• 8/ × 14

• 8/ × 11

• 5/ × 8/
• 71/4×10/
• 8×13

• 8/×13

• 81/4×13

• 12×18

• A3

• B4JIS

• A4

• B5JIS

• A5

• A6

• 8K

• 16K

• 4 1/8 × 9 1/2

• 3 7/8 × 7 1/2

• C5 Env

• C6 Env

• DL Env

• Custom Size

Note
❒ Default: A4 (Metric version), 8/ × 11(Inch version)

Menu Description
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Duplex You can select whether you want to print on both sides of each 
page.

• Off

• Short Edge Bind

• Long Edge Bind

Note
❒ Default: Off

❒ This menu appears only when the optional Duplex unit is in-
stalled.

Job Separation You can enable “Job Separation”.

• Off

• On

Note
❒ Default: Off

❒ This menu appears only when the optional shift sort tray is in-
stalled.

Resolution You can set the print resolution in dots per inch.

❖❖❖❖ PCL
300 dpi, 600 dpi, 600 × 600 dpi 2 bit

❖❖❖❖ PS
300 dpi, 600 dpi, 600 × 600 dpi 2 bit

Note
❒ Default: 600 × 600 dpi 2 bit 

❒ 600 × 600 dpi 2bit: 1800 × 600 dpi equivalent

❒ 300 dpi for PCL 5c: monochrome only

Toner Saving You can select whether or not to enable “Toner Saving”.

• Off

• On

Note
❒ Default: Off

Menu Description
49



Using the Control Panel

50

5

Host Interface

PCL Menu

Menu Description 

I/O Buffer You can set the size of the I/O Buffer. Normally it is not necessary 
to change this setting.

• 128 KB

• 256 KB

• 512 KB

Note
❒ Default: 128 KB 

I/O Timeout You can set how many seconds the machine should wait before 
ending a print job. If data from another port often arrives in the 
middle of the print job, you should increase the timeout value.

• 10 seconds

• 15 seconds

• 20 seconds

• 25 seconds

• 60 seconds

Note
❒ Default: 15 seconds

Menu Description

Orientation You can set the page orientation.

• Portrait

• Landscape

Note
❒ Default: Portrait 

Form Lines You can set the number of lines per page.

• 5 to 128 by 1

Note
❒ Default: 64 (Metric version), 60 (Inch version)

Font Source You can set the location of the default font.

• Internal

• Download

• HDD

Note
❒ Default: Internal
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Font Number You can set the ID of the default font you want to use.

• 0 to 50 by 1

Note
❒ Default: 0

Point Size You can set the point size you want to use for the selected font. 

• 4.00 to 999.75 by 0.25

Note
❒ Default: 12.00

❒ This setting is effective only for a variable-space font.

Font Pitch You can set the number of characters per inch you want to use for 
the selected font. 

• 0.44 to 99.99 by 0.01

Note
❒ Default: 10.00

❒ This setting is effective only for a fixed-space font.

Symbol Set You can specify the set of print characters for the selected font. The 
available options are as follows.

Roman-8, ISO L1, ISO L2, ISO L5, PC-8, PC-8 D/N, PC-850, PC-
852, PC8-TK, Win L1, Win L2, Win L5, Desktop, PS Text, VN Intl, 
VN US, MS Publ, Math-8, PS Math, VN Math, Pifont, Legal, ISO 4, 
ISO 6, ISO 11, ISO 15, ISO 17, ISO 21, ISO 60, ISO 69, Win 3.0

Note
❒ Default: Roman-8 

Extend A4 Width You can extend printing area width, when printing on A4 sheet 
with PCL.

• Off

• On

Note
❒ Default: Off

❒ When the setting is “On”, the width will be 8/ inches.

Menu Description
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Machine Condition

We recommend that you print the configuration page and check the machine's
settings before changing them.

Printing the Configuration Page

AAAA Press the {{{{User Tools/Counter/Inquiry}}}} key on the control panel.

The User Tools/Counter/Inquiry menu appears.

BBBB Press [Printer Features].

The Printer Features menu appears.

CCCC Press the [List/Test Print] tab.
The following screen appears on the display panel.

DDDD Press [Config. Page].
 The configuration page is printed.



6. Appendix
Staple

The following table shows the staple positions.

Note
❒ Stapling depends on paper size, paper type, number of pages and feed direc-

tion.

Reference
• For paper sizes and maximum numbers of sheets available for stapling, see

“Staple”, Copy Reference.
• For printing method, see the printer driver's Help.
• The stapling position will change when using PostScript 3 . For more infor-

mation, see the PostScript 3 printer driver's Help.

Limitation
❒ Stapling can be done only with the optional finisher installed on the machine.
❒ Stapling cannot be done when paper is fed from the optional bypass tray.
❒ Thick paper, OHP transparencies, and labeled paper cannot be stapled.
❒ You cannot interrupt the current job with a job for another function requiring

stapling or sorting.

Paper orientation
on the machine

Print data
direction

Staple position

Vertical

Horizontal

Finisher 500 Finisher 1000 

Vertical

Horizontal

ZFFH999E
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Note
❒ When the finisher is installed and stapling is specified for a job, the job will be

delivered to the Finisher Shift Tray regardless of the output tray specified.
❒ If you cannot make staple settings even with the finisher installed, options

may not be set up correctly on the printer driver. Correct option settings in
the printer driver. For details, see the Help of the printer driver.

❒ When duplex printing is specified, adjust staple positions to the binding di-
rection.

❒ When the finisher is being used for another function's job (for example, a copy
job), printing will start after the current job ends.

❒ When setting “Staple” in the printer driver settings, make sure that the “Col-
late” check box is cleared in the application's print settings. If “Collate” is en-
abled in the application, printing will not occur as intended.

❒ Be sure to set the paper size and orientation in the printer driver when sta-
pling.

❒ Depending on the application software you are using, print settings may not
be saved and the printed result may not be as expected.

❒ Do not pull out paper until stapling has completed as this may cause a paper
jam. When paper jams occur, check the error message on the display panel of
the machine and remove the paper. If a paper jam occurs, see the General Set-
tings Guide. 

❒ When printing restarts after removing the jammed paper, the printing posi-
tion may be different depending on the location of the paper jam.
• If the paper jam occurred in the optional finisher, printing will restart from

the top page of the data currently being printed, or from the page on which
the paper jam occurred. 

• If the paper jam occurred in the machine, printing will restart from the
page on which the paper jam occurred.

❒ Even if the paper jam occurred in the machine, the error will not be cleared
unless the cover of the finisher is opened and closed.

❒ “Staple has been canceled” is displayed on the machine's display panel when
staple printing has been canceled. Staple printing will be canceled under the
following conditions:
• If the number of staple jobs exceeds maximum. For information about the

maximum number, see “Specification”, General Settings Guide.
• If a paper size that cannot be stapled is selected. For information about pa-

per sizes that can be stapled, see “Specification”, General Settings Guide.
• If a paper type that cannot be stapled is selected.

The paper types that can be stapled are plain and recycled. Labels, thick
paper and OHP transparencies cannot be stapled.

• If positions other than those fixed for stapling are specified.
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• If there are inconsistencies between the duplex folding direction and the
staple printing folding location during duplex printing.

• If paper sizes are mixed when a different paper size is specified during a
print job.

• When staples have run out.
• When feeding paper from the optional bypass tray.
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Spool Printing

Spool Printing allows print jobs transferred from a computer to be temporarily
stored, and then prints them after they are transferred. This shortens printing
time as it maximizes printer efficiency.

Important
❒ During Spool Printing, the hard disk is accessed and the Data-In indicator

blinks. Turning off the computer or machine during Spool Printing can dam-
age the hard disk. Also, if the computer or machine is turned off during Spool
Printing, spooled jobs will be deleted. Do not turn the power off to the com-
puter or machine during Spool Printing.

Limitation
❒ If data is sent to the machine using other protocols besides “LPD” or “IPP”,

spool printing cannot be performed.
❒ Up to a maximum of 50 jobs at once can be spool printed.

Note
❒ Printing the first page using Spool Printing will be slow. 
❒ The computer will be released quicker from print processing, when large

amounts of data are spooled. 
❒ Spool jobs stored in the machine can be viewed or deleted using a Web

browser. 

----Viewing/Deleting spool jobs in a Web browser
Launch the web browser and enter the machine's IP address in the address bar.
This displays the top page.
Example : http://192.168.155.160
(In this example, the IP address of the machine is 192.168.155.160)
Click “Admin Info”, and then “Spool Printing Job List (Printer)” to display the
spool jobs. To delete, check the box next to the name of the file you want to de-
lete. Enter the password *1 , and then click [Delete]. For more information, see the
Network Printing Guide.
*1 The default password is “password”.
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----Setting Spool Printing
Spool Printing can be set using telnet or a web browser.
• Using a web browser

Click ”Configuration”, and then “General”. Set “Spool Printing”to “Enable”.
See Network Printing Guide or Help for more information.

• Using telnet
Enter “spoolsw spool on” to set Spool Printing.
See Network Printing Guide for more information about telnet.
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Specifications

This section contains the electrical and hardware specifications for the machine
including information about the options.

Component Specification 

Resolution 1800 × 600 dpi equivalent (600 × 600 dpi 2bit)

Printing Speed Type 1:

• Full color : 8 ppm

• Monochrome : 24 ppm

Type 2:

• Full color : 10 ppm

• Monochrome : 32 ppm

(A4K, 8/" × 11"K plain paper)

Note
❒ The printing speed depends on the machine. Check which type 

of machine you have. See the General Settings Guide.

Interface Standard:

• IEEE 1284 Parallel Interface

Note
❒ Use a standard 36-pin printer cable that is not longer than 3 

meters (10 feet).

• Ethernet Interface (100 BASE-TX/10BASE-T)

Option:

• IEEE 1394 Interface

• IEEE 802.11b Wireless LAN Interface

Network Protocol TCP/IP, IPX/SPX, NetBEUI *1 , AppleTalk

Printer Language Standard: PCL 5c, RPCS™ 

Option: PostScript 3

Fonts PCL 5c :

Afga Monotype Font Manager 35 Intellifonts, 10 TrueType fonts, 
and 1 Bitmap font Font Manager available.

PostScript 3 :

136 fonts (Type 2:24, Type 14:112)

Memory Resident : 128 MB (Max.: 384 MB)

Optional SDRAM : 128 MB, 256 MB

Note
❒ A minimum of 256 MB is necessary to use the printer feature 

(printer option).

Hard Disk Storage capacity : 40 GB
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*1 To use NetBEUI, use the SmartNetMonitor for Client port.

Options

Limitation
❒ The optional IEEE 1394 Interface Unit and the optional 802.11b Interface Kit

(Wireless LAN board) cannot be installed in the machine at the same time.

IEEE 1394 Interface Unit Type 4510

❖❖❖❖ Transmission Spec.:
IEEE 1394

❖❖❖❖ Interface:
IEEE std 1394-1995 compliant
IEEE std 1394a-2000 compliant

❖❖❖❖ Device Class:
SCSI print (Windows 2000, Windows XP)
IP over 1394 (Windows Me, Windows XP)

❖❖❖❖ Protocol:
SBP-2 (SCSI print)
TCP/IP (IP over 1394)

❖❖❖❖ Interface Connector:
IEEE 1394 (6 pin × 2)

❖❖❖❖ Required cable:
1394 interface cable (6 pin x 4 pin, 6 pin x 6 pin)

Important
❒ You cannot plug devices together so as to create loops.
❒ Do not use a cable more than 4.5 meters long.

❖❖❖❖ Data Transfer Speed:
Maximum 400 Mbps

Operating Systems sup-
ported by this machine

Windows 95/98/Me

Windows 2000

Windows XP

Windows NT 4.0

Mac OS 8.6 to 9.2

Mac OS X

Component Specification 
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❖❖❖❖ Connectable number of devices on a bus:
Maximum 63

❖❖❖❖ Allowed cable hops on a bus:
Maximum 16

❖❖❖❖ Power supply:
Non power supply
Cable Power repeated (IEEE 1394a-2000 compliant)

PostScript 3 Board Type 1232

Reference
See the PostScript 3 Board Type 1232 Operating Instructions Supplement for in-
formation.

IEEE 802.11b Interface Kit Type B

❖❖❖❖ Transmission Spec.:
Based on IEEE 802.11b (Wireless LAN)

❖❖❖❖ Protocol:
TCP/IP, NetBEUI, IPX/SPX, AppleTalk

Note
❒ SmartNetMonitor and WebStatusMonitor are supported.

❖❖❖❖ Data Transfer Speed:
Auto select from below speed
1Mbps, 2Mbps, 5.5Mbps, 11Mbps

❖❖❖❖ Frequency Range:
• Inch version:

2400-2497 MHz (1-11 channels)
• Metric version:

2400-2497 MHz (1-13 channels)

❖❖❖❖ Transmittable Distance:
1Mbps 400m *1 

2Mbps 270m *1 

5.5Mbps 200m *1 

11Mbps 140m *1 

*1 These figures are a guideline for outdoor use. In general, the transmittable dis-
tance indoors is 10-100 m, depending on the environment.

❖❖❖❖ Transmission Mode:
Ad hoc mode and Infrastructure mode
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Memory Unit Type C 128MB/256MB

❖❖❖❖ Module Type:
SO-DIMM (Small Outline Dual-in-line Memory Module)

❖❖❖❖ Memory Type:
SDRAM (Synchronous Dynamic RAM)

❖❖❖❖ Number of Pins:
144 pins
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For safe and correct use of this machine, please be sure to read the Safety Information in the
General Settings Guide before your use it.



Introduction

This manual contains detailed instructions on the operation and maintenance of this machine. To get
maximum versatility from this machine all operators should carefully read and follow the instructions in
this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information in the Copy Reference before using this machine. It contains im-
portant information related to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Scanner function is available when Printer/Scanner option is installed to your machine.

Warning:

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Two kinds of size notation are employed in this manual. With this machine refer to the inch version.

Trademarks

Adobe and Acrobat are trademarks of Adobe Systems Incorporated.

Ethernet is a registered trademark of Fuji Xerox Corporation.

Pentium is a registered trademark of Intel Corporation.

MS, Microsoft and Windows are registered trademarks of Microsoft Corporation.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all right in those marks.

• The product name of Windows®95 is Microsoft® Windows® 95.

• The product name of Windows®98 is Microsoft® Windows® 98.

• The product name of Windows® Me is Microsoft® Windows® Millennium Edition (Windows Me).

• The product names of Windows XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

• The product names of Windows® 2000 are as follows.
Microsoft® Windows® 2000 Professional
Microsoft® Windows® 2000 Server

• The product names of Windows NT® are as follows.
Microsoft® Windows NT® Server 4.0
Microsoft® Windows NT® Workstation 4.0
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates the prior knowledge or preparations required before op-
erating.

Note
This symbol indicates precautions for operation or actions to take after misoper-
ation.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys that appear on the machine's panel display.

[ ]
Keys and buttons that appear on the computer's display.

{ }
Keys built into the operation panel of the machine.

{ }
Keys on the computer's keyboard.
1
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Names of Major Options

Major options of this machine are referred to as follows in this documentation.
• Printer/Scanner Kit Type 1232 → printer/scanner controller
For other options, see the respective documentation.

The following software products are referred to using a general name.
• DeskTopBinder V2 Lite and DeskTopBinder V2 Professional → DeskTop-

Binder V2 Lite/Professional
• ScanRouter V2 Lite and ScanRouter V2 Professional → ScanRouter V2

Lite/Professional



Manuals for This Machine

The following manuals describe the operational procedures and maintenance of
this machine.

Note
❒ Adobe Acrobat Reader is necessary to view the manuals in PDF format. Ac-

robat Reader can be installed from the Setup screen of DeskTopBinder V2 Lite
or ScanRouter V2 Lite.

❖❖❖❖ General Settings Guide
Describes the settings of basic items to use this machine by connecting to a
network. The machine must be connected to a network to use scanner func-
tions. See this manual to set up necessary items.

❖❖❖❖ Copy Reference
Describes the procedures and functions for using this machine as a copier.
The type of originals that can be used in this machine refer to this manual.

❖❖❖❖ Scanner Reference (this manual)
Describes basic settings for using scanner functions, installing necessary soft-
ware, and operations for using the scanner functions.

❖❖❖❖ Manuals for DeskTopBinder V2 Lite
DeskTopBinder V2 Lite is software included on the CD-ROM labeled “Scan-
ner Driver & Document Management Utilities” for this machine. For informa-
tion about the functions of DeskTopBinder V2 Lite, see p.39 “DeskTopBinder
V2 Lite”.
• DeskTopBinder V2 Lite Setup Guide (PDF)

Describes the operating environment for DeskTopBinder V2 Lite in detail
and installation. This guide is displayed from the Setup screen when Desk-
TopBinder V2 Lite is installed.

• DeskTopBinder V2 Lite Introduction Guide (PDF)
Describes the outlined functions and use of DeskTopBinder V2 Lite. This
guide is added to the Start menu when DeskTopBinder V2 Lite is installed.

• Auto Document Link Guide (PDF)
Describes the functions and operations of “Auto Document Link” installed
with DeskTopBinder V2 Lite. This guide is added to the Start menu when
DeskTopBinder V2 Lite is installed.
3
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❖❖❖❖ Manuals for ScanRouter V2 Lite

Note
❒ ScanRouter V2 Lite is software included on the CD-ROM labeled “Scanner

Driver & Document Management Utilities” for this machine. For informa-
tion about ScanRouter V2 Lite, see p.8 “Network Delivery Scanner”, p.40
“ScanRouter V2 Lite”.

• ScanRouter V2 Lite Setup Guide (PDF)
Describes the operating environment for ScanRouter V2 Lite in detail, in-
stallation, and settings. This guide is displayed from the Setup screen
when ScanRouter V2 Lite is installed.

• ScanRouter V2 Lite Management Guide (PDF)
Describes the outlined functions of ScanRouter V2 Lite and the manage-
ment and operation of a delivery server. This guide is added to the Start
menu when ScanRouter V2 Lite is installed.



Important

When the machine is connected to a network, observe the following points when
setting up the machine or changing settings.
For more details, see the documentation and Help for ScanRouter V2 Lite/Pro-
fessional and DeskTopBinder V2 Lite/Professional.

❖❖❖❖ When a dial-up router is connected in a network environment
The settings for the delivery server to be connected must be made appropri-
ately for the machine with DeskTopBinder V2 Lite/Professional, Auto Docu-
ment Link, or DeskTopBinder V2 Lite/Professional. In addition,
appropriately set up connected devices with the I/O settings of ScanRouter
V2 Administration Utility.
If the network environment changes, make the necessary changes for the de-
livery server with the machine, administration utility of client computers,
Auto Document Link, and DeskTopBinder V2 Lite/Professional. Also, set the
correct information for the connected device with the I/O settings of Admin-
istration Utility.

Important
❒ When the software is set up to connect to the delivery server via a dial-up

router, the router will dial and go online whenever connection to the deliv-
ery server is initiated. Telephone charges may be incurred.

❖❖❖❖ When connected to a computer that uses dial-up access
• Do not install ScanRouter V2 Lite/Professional on a computer which uses

dial-up access.
• When using ScanRouter V2 Lite/Professional, DeskTopBinder V2

Lite/Professional, Auto Document Link, or TWAIN driver on a computer
with dial-up access, dial-up may be performed when connecting to the de-
livery server and other equipment, depending on the setup. If the compu-
ter is set up to connect to the Internet automatically, the confirmation
dialog box will not appear, and telephone charges may be incurred with-
out the user being aware of it. To prevent unnecessary dial-ups, the com-
puter should be set up so that the confirmation dialog box is always
displayed before establishing a connection. Do not make unnecessary dial-
ups when using the above listed software.

❖❖❖❖ When connected to an e-mail server
When the machine is connected to an SMTP server managed by an Internet
service provider (hereafter called “Provider(s)”), the SMTP or POP identity
(POP before SMTP) may be required by the Provider.
5
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1. Network Scanner
Outline

By installing the printer/scanner controller, the machine can be used as a net-
work scanner.
The network scanner offers four functions: operating as a network TWAIN scan-
ner, operating as a network delivery scanner, sending e-mail or storing scan data
in the document server.

Network TWAIN Scanner

The scanner of this machine is used from the computer via a network Ethernet
(TCP/IP) or IEEE 1394(option) or Wireless LAN(option). The originals can be
read in the same operation as for SCSI and USB-connected scanners. For more
information, see p.51 “Scanning Originals Using Network TWAIN Scanner”.

1. This machine
The scanner of the machine is used from
the computer via a network.

2. Computer
Originals are scanned by TWAIN driver
for the machine from an application.

ZHFX020N
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Network Delivery Scanner

The machine is used as the delivery scanner with ScanRouter V2 Lite/Profes-
sional. The original scanned by the machine is stored in the delivery server and
delivered to the folder of the computer on the same network. For more informa-
tion, see p.55 “Delivering Stored Scan Data by the Network Delivery Scanner”.

Note
❒ Using optional ScanRouter V2 Professional, the machine can deliver scan

data as mail, and view the document from the client computer using the Web
browser.

1. This machine
The original scanned by the scanner is
sent to the delivery server.
Together with the document server, mul-
tiple documents are stored and then de-
livered. ⇒ p.65 “Using the Network
Delivery Scanner with the Document
Server”

2. Delivery server
ScanRouter V2 Lite/Professional is in-
stalled and used as a delivery server.
The sent data is delivered to an in-tray
(A in the figure) of a specified destina-
tion. The delivered document is stored in
an in-tray or Windows folder (B in the
figure).

3. Client computer
The contents of the stored document are
checked in the following way.

• View the document in an in-tray of
DeskTopBinder V2 Lite to check the
contents. (C in the figure)

• Use Auto Document Link to receive
the document in an in-tray, and check
the contents with an application corre-
sponding to the file format. (D in the
figure)

• Connect to a Windows folder via a
network, and check the contents with
an application corresponding to the
file format. (E in the figure)

Reference
For more information about ScanRouter V2 Lite, DeskTopBinder V2 Lite, or
Auto Document Link, see the respective documentation. ⇒ p.3 “Manuals for
This Machine”



Outline

1

E-mail

A scanned image that is attached to an e-mail can be delivered using the e-mail
system through a LAN or the Internet.
See p.67 “Sending Stored Scan Data by E-mail” for detailed information.

1. This machine
A scanned image that is attached to an e-
mail can be delivered to a mail server. In
combination with the document storage
function, scanned images and a number
of documents that have been temporarily
stored can be delivered all at once.

2. Mail server
A mail server is the SMTP server used for
an e-mail system. It transfers a recieved e-
mail to a designated destination through
a LAN or the Internet.

3. Client computer
An e-mail with images attached from e-
mail server is received, using mail soft-
ware.

ZHFX021N
9



Network Scanner

10

1

Document Server

The scanned original is stored as a document on the hard disk of the machine,
and can be viewed, copied, or deleted using DeskTopBinder V2 Lite/Profession-
al from a client computer via a network. Documents can be searched by the user
name or the document name. Also, others can be kept from viewing the docu-
ment by setting a password for the document. For more information, see p.79
“Using the Document Server”.

1. This machine
The originals scanned by the scanner are
stored.

2. Computer
The stored document can be viewed or
deleted by connecting to the machine us-
ing DeskTopBinder V2 Lite/Profession-
al.

Reference
For more information about DeskTopBinder V2 Lite, see the DeskTopBinder
V2 Lite manual. ⇒ p.3 “Manuals for This Machine”

ZHFX030N



Names and Functions of Components
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Names and Functions of Components

This section explains the names and functions of various controls used to oper-
ate the scanner.

Control Panel

This illustration shows the product with options installed.

1. The {{{{User Tools/Counter}}}} key
Use to change default values or operation
parameters according to the operating
conditions.

2. Display
Shows operation status and various mes-
sages.

3. The {{{{Check Modes}}}} key
Press to check the current settings.

4. The {{{{Clear Modes}}}} key
Press to clear the current settings.

5. The {{{{Energy Saver}}}} key
Press this key for about one second to be-
gin warm-up.
Pressing this key again while in warm-up
mode cancels warm-up.

Note
❒ This key is inactive while scanning or

setting scanner default values.

6. Main power indicator, power in-
dicator
The main power indicator lights up when
the main power switch is set to On. The
power indicator lights up when this ma-
chine is on.

Important
❒ Do not turn off the main power

while the power indicator is blink-
ing. Doing so may cause a failure
of the hard disk.

7. Operation switch
Press this switch to turn the machine on.
The power indicator lights up. To turn
the machine off, press this switch again.

Note
❒ This key is inactive while setting scan-

ner default values.

ZHFS010N
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8. Status indicators
Show the status of the selected function.

• When lit yellow, the corresponding
function is selected.

• When lit green, the corresponding
function is active.

• When lit red, the corresponding func-
tion is interrupted. Press the respec-
tive key and follow the instructions
that appear on the screen.

9. Function keys
Press the {{{{Copy}}}}, {{{{Document Server}}}}, {{{{PC
Facsimile}}}}, {{{{Printer}}}}, or {{{{Scanner}}}} key to
activate the respective function. The dis-
play content changes accordingly.
The indicator for the selected function
lights up.

10. Number keys
Use to enter numeric values.

11. The {{{{#}}}} key (Enter key)
Use to enter a numeric value.

12. The {{{{Clear/Stop}}}} key
• Clear: Clears an entered numeric val-

ue.
• Stop: Stops scanning.

13. The {{{{Start}}}} key
Use to begin scanning, file storing, or de-
livery.

Display Contents

The normal screen configuration is as follows:
The display’s contents differ depending on the mode.

Important
❒ Protect the display from shocks and strong pressure to prevent the possibility

of damage. The maximum allowable is 30 N *1 (3 kgf *2 ). 
*1 :N: Newton
*2 :kgf: kilogram-force (1kgf = approx. 9.8N)

Note
❒ The “Copy” screen is set as the default screen when the machine is turned on.

You can change this setting under the “Priority Function” of the [Basic Set-
tings] tab in System Settings. ⇒General Settings Guide

❒ Selected or specified items are highlighted like 
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Using as a network TWAIN scanner

When using the machine as a network TWAIN scanner, it is not necessary to
press the {{{{Scanner}}}} key on the control panel. When the TWAIN driver becomes
active on a client computer, the display automatically switches to the following
screen.

Press [Cancel] to use functions other than Network TWAIN Scanner.

Using as a network delivery scanner

Press the {{{{Scanner}}}} key to display the network delivery scanner screen (when
delivery server has been selected in Destination List Priority). If the network
TWAIN scanner screen is displayed, press [Cancel].

Reference
⇒ p.24 “Making Scanner Settings” for Destination List Priority.

Using e-mail

Press the {{{{Scanner}}}} key to display the E-mail screen. If the network TWAIN
scanner screen is displayed, press [Cancel].
The e-mail screen differs depending on whether the machine is connected to the
delivery scanner.

Reference
⇒ p.24 “Making Scanner Settings” for Destination List Priority.
13
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2. Preparations for Use as a
Network Scanner
To use the machine as a network scanner, you must make settings required for
use as a scanner, as well as basic settings for use in a network.
First, see the General Settings Guide for details about how to make basic set-
tings, and then make scanner settings.

Preparation Sequence

The preparation sequence is different depending on whether the machine is to
be used as a network TWAIN scanner or network delivery scanner, or the Doc-
ument Server is used. 

Using as a Network TWAIN Scanner

Connect the machine to the network with an Ethernet cable, 
IEEE 1394(option) cable or Wireless LAN(option).

⇒General Settings Guide

Check the network settings in System Settings, and change if re-
quired.

⇒General Settings Guide

On the client computers, install the software required for using 
the network TWAIN scanner functions, such as TWAIN driver 
and DeskTopBinder V2 Lite.

⇒ p.35 “Software for using a Network TWAIN Scanner func-
tion”

Connect to Network
1

Make System Settings
2

3
Install Software
15
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Using as a Network Delivery Scanner

Connect the machine to the network with an Ethernet cable, 
IEEE 1394(option) cable or Wireless LAN(option).

⇒General Settings Guide

Check the network settings in System Settings, and change if re-
quired. 

⇒General Settings Guide

Make settings for the network delivery scanner, such as the set-
tings of the scanning feature and subject information.

⇒ p.18 “Initial Scanner Setup”

Install the software required for using the network delivery 
scanner functions, such as ScanRouter V2 Lite on the delivery 
server. Then, make the required settings for server maintenance 
and delivery service.

⇒ p.36 “Software for using a Network Delivery Scanner func-
tion”

Reference
For information about ScanRouter V2 Lite, see the ScanRout-
er V2 Lite manual. ⇒ p.3 “Manuals for This Machine”

Use ScanRouter V2 Administration Utility to set the destination 
and sender information.

On the client computers, install the software required for view-
ing or auto-receiving documents by connecting to the delivery 
server, such as DeskTopBinder V2 Lite. 

⇒ p.37 “DeskTopBinder V2 Lite”

Connect to Network
1

Make System Settings
2

3
Make Scanner 
Settings

4
Install Delivery 
Software

Set Destination and 
Sender Information

5

6
Install Client Computer 
Software
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Using E-mail

Connect the machine to the network with an Ethernet cable or 
IEEE 1394(option) cable or Wireless LAN(option).

⇒General Settings Guide

Check the network or the destination settings in System Settings, 
and change if required.

⇒General Settings Guide

Make settings for sending e-mail such as mail information lan-
guage and file type priority.

⇒ p.18 “Initial Scanner Setup”

Make settings for sending e-mail for the SMTP server using the 
computer’s Web browser.

⇒ p.31 “Making E-mail Settings”.

Set up a mail server as necessary.

For information about setting up, refer to the instruction manu-
als of the e-mail server to be used and the software to be in-
stalled.

Connect to Network
1

Make System Settings
2

3
Make Scanner 
Settings

4
Make E-mail Settings

5
Install Software
17
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Initial Scanner Setup

This section explains all required settings and procedures for using the machine
as a network scanner.

Default Settings

Settings to use the functions of the machine as a network scanner are listed be-
low. Make correct setting of necessary items.

Important
❒ Items marked ✩ are the minimum required settings for using the machine as

a network scanner. Be sure to set these items before use.
❒ Items marked ❍ should be set if required.

❖❖❖❖ System settings
For information about the settings, see the General Settings Guide.

*1 Settings for use as network TWAIN scanner
*2 Settings for use as network delivery scanner
*3 Settings for e-mail
*4 Settings for use as document server
*5 Do not change this setting. It must be left at the factory default value.
*6 When delivery option sets “On”, make sure that IP address is set.

Settings TWAIN 
*1 

Deliv-
ery *2 

E-mail 
*3 

Store 
*4 

Timer Settings Scanner Auto Reset Timer ❍ ❍ ❍

Interface settings

[Network]

IP Address ✩ ✩ ✩ ✩

Sub-net Mask ❍ ❍ ❍ ❍

Gateway Address ❍ ❍ ❍ ❍

Network Boot ❍ ❍ ❍

Effective Protocol *5  ❍ ❍ ❍ ❍

NW Frame Type ❍ ❍ ❍

LAN Type ❍ ❍ ❍

Ethernet Speed ❍ ❍ ❍

File transfer settings Delivery Option *6 ❍

Scanner Recall Interval time ❍ ❍

Number of Scanner Recalls ❍ ❍

Key Operator Tools Address Book Management ❍

Address Book: Pro-
gram/Change/Delete Group

❍

Address Book: Change Order ❍

Address Book: Edit Title ❍

Address Book: Select Title ❍
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❖❖❖❖ Scanner settings
Explanation of scanner settings is provided in this manual.

*1 Settings for use as network TWAIN scanner
*2 Settings for use as network delivery scanner
*3 Setting items for e-mail
*4 Settings for use as document server

Settings Factory default 
value

TWAIN 
*1 

Deliv-
ery *2 

E-mail 
*3 

Store *4 

Scanner 
Features

⇒ p.20

Scan Type Text (Print) ❍ ❍ ❍

Resolution 200dpi ❍ ❍ ❍

Image Density Auto Image Den-
sity (Medium)

❍ ❍ ❍

Scan Size Auto Detect ❍ ❍ ❍

Scanner 
Settings

⇒ p.24

Send/Store Con-
nection Timeout

10 sec. ❍ ❍ ❍ ❍

Compression 
(Black & White)

On ❍ ❍ ❍

Compression 
(Gray Scale/Full 
Color)

Standard ❍ ❍ ❍

Destination List 
Priority

E-mail ❍ ❍

Update Delivery 
Server Destination

-- ❍

Sender’s Name De-
fault

No ❍

Max. E-mail Size 2048KB ❍

Divide & Send E-mail Yes 
(per max. size)

❍

E-mail Informa-
tion Language

British English ❍

Job Reset Time in 
Adding Original

Off ❍ ❍ ❍

Original Setting 1 Sided Original ❍ ❍ ❍

Original Orienta-
tion Priority

❍ ❍ ❍

Mixed Original Siz-
es Priority

Off ❍ ❍ ❍

Switch to Batch SADF ❍ ❍ ❍

File Type Priority Multi-Page: 
TIFF 

❍

Print & Delete 
Scanner Journal

Delete all after-
printing

❍ ❍

Select Title Title 1 ❍ ❍

Subject Settings

⇒ p.28

Not 
Programed

❍ ❍
19
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❖❖❖❖ E-mail Settings
Make settings for sending e-mail using the computer’s Web browser. For in-
formation about the settings. ⇒ p.31 “Making E-mail Settings”.

Setting Scanner Features

Various Scanner Features (resolution,
scan size, scan type, image density)
can be set here. When using the same
type of original repeatedly, storing
the optimum settings in advance
makes them easy to select whenever
you deliver or store scan data.

Note
❒ Ten sets of scan settings named

“Initial Setup” and “Program 1” -
“Program 9” can be stored for
quick recall. The settings stored as
“Initial Setup” are the scanning de-
faults. If the Scanner Features are
not selected during delivery, the
originals are scanned with the
Scanner Features stored in the “In-
itial Setup”.

❒ “Program 1” - “Program 9” can be
changed to any name of up to 20
characters.

The Scanner Features consist of the
following items.

❖❖❖❖ Scan Type
The scan method suitable for the
original is set.
For black & white or gray scale
scans, select from the following
types.
• Text (Print)

For standard originals contain-
ing mainly text (Print)

• Text (OCR)
For originals containing mainly
text (for OCR)

• Text/Photo
For originals containing a mix-
ture of text and photographs

• Photo
For originals containing photo-
graphs and other pic tures
(white & black)

• Gray Scale
For originals containing photo-
graphs and other pictures (gray
scale/full color)

When the original is scanned in
full color, the following items
should be set.
• Text/Photo

For standard originals contain-
ing mainly text

• Glossy Photo
For originals containing photo-
graphs or other pictures

• sRGB *1 

When scanning the original as a
sRGB(international standard of
color space) image, select [On].
This function is available when
“Text/Photo” is selected.
*1 File Format Converter Type A

(optional) is required to use this
function.

Settings Factory default 
value

TWAIN Delivery E-mail Store

TCP/IP DNS Server 1 0.0.0.0 ❍

SMTP SMTP Server 
Name

(Empty) ✩

SMTP Port No. 25 ❍
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Note
❒ Printer printing is best done

with Text (Print). Text (OCR) is
suitable for higher OCR accura-
cy.

❒ An image is scanned with black
& white in “Photo”, and with
gray scale/full color in “Gray
Scale”. As a general rule, scan-
ning for the purpose of printing
is best done with “Photo”, and
scanning for viewing on the
computer screen with “Gray
Scale”.

❖❖❖❖ Resolution
Set the resolution to 100 dpi, 200
dpi, 300 dpi, 400 dpi, or 600 dpi.

❖❖❖❖ Image Density
Set the image density for Black &
White/Gray Scale scanning. The
setting can be made in Auto Image
Density or seven steps, from
“Lighter” (1) to “Darker” (7).
For full color scans, set the image
density. It can be set in seven steps
from “Lighter” (1) to “Darker” (7).

❖❖❖❖ Scan Size
Select the size of the original to be
scanned.
• When [Auto Detect] is selected,

the auto detect function of the
machine is used to set the origi-
nal size.

• When the size is specified, scan-
ning is performed for that size,
regardless of the actual size of
the original. The following size
can be selected.
A3S,A4R,A4S,A5R,A5S,1
1x17S,81/2x14S,81/2x13S,81

/2x11R,81/2x11S,51/2x81/2R,
5 1 / 2 x8 1 / 2S ,B4  J ISS ,B5
JISS,B5 JISR,Custom Size

Note
❒ When [Custom size] is select-

ed, the dimensions of the
scan area (width and height)
can be specified.

Setting Procedure

AAAA Press the {{{{User Tools/Counter}}}} key.

The User Tools/Counter/Inquiry
screen is displayed.

BBBB Press [Scanner Features].

The Scanner Features screen is dis-
played.

CCCC Verify that the [Basic Settings] tab
is shown.

DDDD Verify that [Program/Change] is se-
lected, and then select the scan
setting you want to program.

The screen for entering a scan set-
ting name is displayed.

ZGJS002N



Preparations for Use as a Network Scanner

22

2

EEEE Enter the desired name and press
[OK].

Reference
For information about entering
characters, see the General Set-
tings Guide.

The screen for the basic settings is
displayed.

FFFF Select the item to be set.
To select an item, touch its key on
the screen. The item is highlighted.
Example: resolution setting

Example: image density setting

Note
❒ When selecting [Custom size] for

[Scan Size], see p.22 “Selecting a
custom size”.

GGGG When all settings have been
made, press [OK].

The scan type setting is stored.

HHHH To program other scan settings,
repeat the procedure from step DDDD.

IIII When all settings have been
made, press [Exit].

The screen returns to the User
Tools/Counter/Inquiry.

JJJJ Press [Exit].
The main menu is shown again.

Selecting a custom size

When [Custom size] is selected as the
scan size, follow the procedure be-
low.

AAAA Press [Custom size] on the Scan
Size setting screen.

BBBB Enter the original size with the
number keys.

Select and enter values for [X1] and
[Y1].



Initial Scanner Setup

23

2

CCCC Enter the scan starting point in re-
ration to the standard scan start-
ing point.
Select and enter values for [X2] and
[Y2].

DDDD Enter the scan size (area) with the
number keys.

Select and enter values for [X3] and
[Y3].

Depending on how the original is
positioned, the scan area will be as
shown.

The range of possible original sizes
and scan sizes is as follows:
• Original Size

X1: 140 mm - 432 mm (5.6” - 17”)
Y1: 140 mm - 297 mm (5.6” -
11.7”)

• Scan Size
X3: 10 mm - 432 mm (0.4” - 17”)
Y3: 10 mm - 297 mm (0.4”  -
11.7”)

Keep the scan area settings within
these range.

EEEE When all dimensions have been
entered, press [OK].

FFFF Verify that the area set in step DDDD
(X3 and Y3) is shown next to the
[Custom size] field, then press [OK].

GGGG Press [Exit].

The User Tools/Counter/Inquiry
screen is shown.

HHHH Press [Exit].

The main menu is shown again.

X3X2

X1

Y2

Y1
Y3

X3X2

X1

Y2

Y1
Y3

X3X2

X1

Y2

Y1
Y3

X3 X2

X1

Y2

Y1
Y3

W
hen placed on the exposure glass

W
hen placed on the A

D
F

ZHSY055E

Original orientation Original orientation
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Deleting programmed scan settings

AAAA Press the {{{{User Tools/Counter}}}} key.

The User Tools/Counter/Inquiry
screen is displayed.

BBBB Press [Scanner Features].

The Scanner Features screen ap-
pears.

CCCC Verify that the [Basic Settings] tab
is shown.

DDDD Press [Delete].

EEEE Select the set of settings you want
to delete.

A confirmation message is dis-
played.

FFFF Press [Yes].

The selected scan setting is delet-
ed.

GGGG Press [Exit].

The screen returns to the User
Tools/Counter/Inquiry .

HHHH Press [Exit].

The main menu is shown again.

Making Scanner Settings

This section explains how to switch
from network TWAIN scanner mode
to network delivery scanner or docu-
ment server mode, and how to set the
compression of image data and initial
values for setting originals.
The scanner settings consist of the fol-
lowing. For the list about settings and
factory defaults, see p.19 “Scanner
settings”.

❖❖❖❖ Send/Store Connection Timeout
When using the machine as a net-
work delivery scanner or docu-
ment server, scanning request to
the machine as a TWAIN scanner
will switch the machine to the net-
work TWAIN scanner mode. This
setting determines the delay until
the machine switches to network
TWAIN scanner mode.
• Selecting [Immediate] causes the

network TWAIN scanner mode
to be activated at once.

ZGJS002N
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• When you select [Set Time], you
can enter the delay time with
the number keys (3 - 30 sec-
onds). When the TWAIN scan-
ner mode is activated, only the
time specified here passes from
the last key operation.

❖❖❖❖ Compression (Black & White)
This setting determines whether
image data read with the black &
white setting is to be compressed.

Note
❒ The actual time required for

data transfer will vary, depend-
ing on the data size and net-
work load.

❖❖❖❖ Compression (Gray Scale/Full Color)
This setting determines to which
extent image data read with the
gray scale/full color setting is to be
compressed. You can select [Stand-
ard], [High], [Low], or [Off].

Note
❒ Compression ratio decreases in

the order [High], [Standard],
[Low], [Off], and the time re-
quired for data transfer increas-
es accordingly.

❒ The actual time required for
data transfer will vary, depend-
ing on the data size and net-
work load.

❖❖❖❖ Destination List Priority
Select a Destination List to be dis-
played when the machine is in the
initial state. Press either [Delivery
Server] or [E-mail].

❖❖❖❖ Update Delivery Server Destination
List
To update Delivery Server Desti-
nation List, press [Update Delivery
Server Destination List].

Ordinarily, Delivery Server Desti-
nation List is automatically updat-
ed. This function allows updating
at any time.

❖❖❖❖ Sender's Name Default
Select whether a key operator is
registered as a sender or a sender is
designated each time a mail is sent.
• Select [No] when a sender is to

be designated each time.
• Select [Yes] when an adminis-

trator is to be the sender.

Important
❒ It is recommended that a pass-

word be set to prevent the send-
er’s name from being misused.

❖❖❖❖ Max. E-mail Size
Select whether the size of an image
attached to an e-mail is limited or
not.
When [On] is selected, enter the
size limit (64 to 102400KB) using
the number keys.

Note
❒ When the SMTP limits the size,

match that setting.

❖❖❖❖ Divide & Send E-mail
This function is effective only
when [Yes (per max size)] is selected.
Select whether or not an image ex-
ceeding the size specified in [Max.
E-mail Size] should be divided and
sent using more than one e-mail.
Select either [No], [Yes (per page)], or
[Yes (per max. size)].

Note
❒ When [Multi-page: TIFF] or [Multi-

page: PDF] has been selected for
File Type Priority, the image
will not be divided even if [Yes
(per page)] is selected.
25
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❒ When [Yes (per max. size)] is se-
lected, some received files may
not be able to be restored, de-
pending on the type of mail
software.

❒ When [No] is selected, the e-mail
is not sent if its size exceeds the
limit, and an error message is
displayed. The scanned data is
lost.

❒ Set the Max. E-mail Size within
the capacity of the SMTP server.

❖❖❖❖ E-mail Information Language
Select a language for E-mail Infor-
mation Language with which Title,
Document name, Sender’s name
and others are sent.
Select one of 18 languages.
British English, American English,
German, French, Italian, Spanish,
Dutch, Portuguese, Polish, Czech,
Swedish, Finnish, Hungarian,
Norwegian, Danish, Japanese,
Simplified Chinese, Traditional
Chinese

Note
❒ The e-mail text is a template and

cannot be changed.

❖❖❖❖ Job Reset Time in Adding Original
Defines whether or not to set a
waiting time for inserting another
original after all originals in the
ADF or on the exposure glass have
been scanned. Settings will be ef-
fective when [SADF] is selected.
• If [Off] is selected, the count-

down does not occur and the
machine enters the waiting state
when all originals in the ADF or
on the exposure glass have been
scanned, until another original
is inserted or the {{{{#}}}} key is
pressed.

• If set to [On], enter the number
of seconds (3 - 900) for the Job
Reset Time in Adding Original
with the number keys. When
the original is placed within this
time, it is scanned as one docu-
ment.

❖❖❖❖ Original Setting
Set the initial value for original
type and orientation. When the
original is always similar, selecting
this as the default makes operation
easier. You can select “1 Sided
Original”, “2 sided orig.: T to T”
(Top to Top), “2 sided orig.: T to B”
(Top to Bottom).

Reference
⇒ p.47 “Original Orientation
and Scan Area Setting”

❖❖❖❖ Original Orientation Priority
Select the initial value for original
placement orientation. When the
original is always positioned in the
same way, selecting this as the de-
fault makes operation easier.

Reference
⇒ p.47 “Original Orientation
and Scan Area Setting”

❖❖❖❖ Mixed Original Sizes Priority
This setting determines whether
the original size is to be automati-
cally detected when originals of
the same width and different
length are inserted in the ADF.
You can select [On] or [Off].

Note
❒ If the original size is specified

when scanning, this setting is
discarded.
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❒ When [OFF] is selected and the
originals of the same width and
different length are set to ADF,
the size of the first page is de-
tected as the max. size and the
whole originals are scanned ac-
cordingly to the end.

❖❖❖❖ Switch to Batch
When placing additional originals
in the ADF, select whether to add
sheets individually or to add
batches.

Note
❒ Even if [On] is selected for [Job

Reset Time in Adding Original], the
countdown to scan another
original stops when scanning
conditions are changed, the ex-
posure glass is used to scan, or
the function is switched to an-
other function such as copying
or faxing. Press the {{{{Start}}}} key
to restart scanning.

❖❖❖❖ File Type Priority
Select whether data of scanned
originals is delivered in a single
page or multiple pages.
When delivered in multiple pages,
select either TIFF or PDF.

Note
❒ When data stored in a JPEG for-

mat is designated as TIFF for
multiple pages, it is automati-
cally changed to a PDF format.

❖❖❖❖ Print & Delete Scanner Journal
Select whether Scanner Journal is
automatically printed or not when
the number of delivered mails
reaches 50.

Note
❒ When printed, all records are

deleted after printing. When not
printed, records are automati-
cally deleted in succession from
the oldest record.

❒ While records are being printed,
e-mail sending is in a [Waiting]
state.

❖❖❖❖ Select Title
Select a Title with destinations in-
cluding destinations of e-mail. The
selected Title is displayed on the
screen as an at-a-glance chart of
destinations, which allows easy re-
trieval. Select either [Title 1](for 10
classifications), [Title 2](for 10 clas-
sifications), or [Title 3](for 5 classifi-
cations).

Setting Procedure

AAAA Press the {{{{User Tools/Counter}}}} key.

The User Tools/Counter/Inquiry
screen is displayed.

BBBB Press [Scanner Features].

The Scanner Features screen is dis-
played.

ZGJS002N
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CCCC Press the [Scanner Settings] tab.

DDDD Press the item to be set.

The screen for changing the item
setting is displayed.

EEEE Change the setting.

Example: “Send/Store Connection
Timeout” setting

• To select an item, touch its key
on the screen. The item is high-
lighted.

• To enter numerals, use the
number keys.

Note
❒ To cancel a setting, press [Can-

cel]. The value is not changed
and the screen returns to the
previous  condit ion before
pressing [OK].

FFFF Press [OK].

GGGG Repeat steps DDDD to FFFF to make other
settings.

HHHH Press [Exit].

The screen returns to the User
Tools/Counter/Inquiry .

IIII Press [Exit].
The main menu is shown again.

Making Scan Data Subject 
Settings

Subject information can be added to
the scan data files. This information is
added to the data to be delivered.
When the file is sent by the e-mail
with optional ScanRouter V2 Profes-
sional, the subject is automatically en-
tered as the title in the subject of the e-
mail. If you often send files with sim-
ilar content, storing subject names
will allow you to easily select a sub-
ject at the time of delivery.
The subject can be up to 20 characters
long. Up to 12 subjects can be stored.

Setting Procedure

This section describes the steps for
making subject settings.

AAAA Press the {{{{User Tools/Counter}}}} key.

The User Tools/Counter/Inquiry
screen is displayed.

BBBB Press [Scanner Features].

The Scanner Features screen ap-
pears.

ZGJS002N
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CCCC Press the [Subject Settings] tab.

DDDD Verify that [Program/Change] is se-
lected, and select the subject you
want to program.

The soft keyboard is displayed for
entering a subject.

EEEE Enter the subject string.

Reference
For information about how to
enter characters, see the General
Settings Guide.

Note
❒ If an item is selected for which a

subject is already programmed,
the subject can be edited.

FFFF Press [OK].

GGGG To program more subjects, repeat
steps DDDD to FFFF.

HHHH Press [Exit].
The screen returns to the User
Tools/Counter/Inquiry .

IIII Press [Exit].

The main menu is shown again.

Deleting programmed subject settings

AAAA Press the {{{{User Tools/Counter}}}} key.

The User Tools/Counter/Inquiry
screen is displayed.

BBBB Press [Scanner Features].

The Scanner Features screen is dis-
played.

CCCC Press the [Subject Settings] tab.

DDDD Press [Delete].

EEEE Select the subject you want to de-
lete.

A confirmation message is dis-
played.

ZGJS002N
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FFFF Press [Yes].

The selected subject is deleted.

GGGG To delete more subjects, repeat
steps EEEE to FFFF.

HHHH Press [Exit].

The screen returns to the User
Tools/Counter/Inquiry .

IIII Press [Exit].
The main menu is shown again.
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Making E-mail Settings

This section explains how to set all re-
quired items for sending e-mail from
a computer’s browser.
Consult with your network manager
about make settings for necessary
items.
The password is set to “password”
before shipment from the factory.
It is recommended that the password
be changed for actual operation.

❖❖❖❖ DNS Server 1, DNS Server 2, and DNS
Server 3
Enter the DNS Server’s IP address
used in the network.
When more than one DNS Server
is installed, enter the IP address for
each DNS Server.

❖❖❖❖ SMTP Server Name
Enter the SMTP Server Name or an
IP address to be used for sending
e-mail.

❖❖❖❖ SMTP Port Number
Enter the Port Number to be used
when connected for SMTP send-
ing.

Setting Procedure

AAAA Start up a Web browser.

BBBB Enter “http://(IP Address of this
machine)” in the address bar of
the Web browser.

The status of connected equipment
is shown in the Web browser.

CCCC Click [Configuration].

A dialog box for entering a user
name and password is displayed.

DDDD Enter the password, and then
press [OK].

The factory setting for the user
name is blank, and the factory set-
ting for the password is “pass-
word”.
The items to be set are shown.

EEEE Register the IP address of the
DNS Server.

A Click [TCP/IP].

The screen for the TCP/IP set-
ting is displayed.

B Enter the IP address of the
DNS Server in [DNS Server 1].

Enter an IP address in DNS
Server 2 and Server 3, if neces-
sary.

C Scroll down the browser, and
click [Apply].

The IP address is registered.

FFFF Register the SMTP Server Name
and SMTP Port Number.

A Click [SMTP].
The screen for the SMTP setting
is displayed.
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B Enter the host name of the
SMTP Server in [SMTP Server
Name].

C Enter the port number in [SMTP
Port No.].

D Scroll down the browser, and
click [Apply].
The SMTP Server Name and
Port Number are registered.

Verification of Settings

AAAA Start up a Web browser.

BBBB Enter “http://(IP Address of this
machine)” in the address bar of
the Web browser.

The status of connected equipment
is shown in the Web browser.

CCCC Click [Config. Reference].

The items that can be checked are
shown.

DDDD Verify the IP address of the DNS
Server.

A Click [TCP/IP].
The setting reference screen for
TCP/IP is displayed.

EEEE Verify the SMTP Server Name
and SMTP Port Number.
A Click [SMTP].

The setting reference screen for
SMTP is displayed.
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Installing Software

The machine comes with two CD-ROMs containing various software.
The CD-ROM labeled “Scanner Driver & Document Management Utilities” con-
tains the necessary software to use the machine as a network scanner. The CD-
ROM labeled “Printer Driver & Utilities” contains the necessary software to use
the machine as a printer.
This section explains the software contained on the “Scanner Driver & Docu-
ment Management Utilities” CD-ROM.

Reference
For information about the software contained on the “Printer Driver & Utili-
ties” CD-ROM, see the Printer Reference manual.

Auto Run Program

When the CD-ROM is inserted into a computer in Windows 95/98/Me, Win-
dows XP, Windows 2000, or Windows NT 4.0, the installer starts automatically
(Auto Run) to install the TWAIN driver and various software.

Note
❒ Auto Run might not automatically work with certain OS settings. In this case,

launch “Set up.exe” located on the CD-ROM root directory.
❒ If you want to install without using Auto Run, hold down the Shift key while

inserting the CD-ROM. Keep the Shift key held down until the computer has
finished accessing the CD-ROM.

❒ If [Cancel] is pressed during installation, the installation will be stopped and
all the remaining scanner drivers and utilities will not be installed. If [Cancel]
has been pressed, reinstall the remaining scanner drivers and utilities after re-
starting the computer.

Limitation
❒ For installation in Windows 2000, Windows XP or Windows NT 4.0, log on as

a member of administrators permission.
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The installing sequence using Auto Run is as follows:

For information about the outline of the software that can be installed by Auto
Run, see p.38 “Software Supplied on CD-ROM”.

Installation Sequence

The installer 
starts up.

The 
installation 
complete 
message is 
displayed.

Select 
the software.

Insert the 
CD-ROM.

Restart 
your PC.

     TWAIN 
      Driver

TWAIN Driver Ver.3

ScanRouter
V2 Lite

ScanRouter V2 Lite

DeskTopBinder
V2 Lite

DeskTopBinder V2 Lite

Install all at once, or select and install individually.

ScanRouter V2
Administration
Utility

ZHSY070N

Acrobat Reader

Acrobat
Reader
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Software for using a Network TWAIN Scanner function

To use the machine as a network TWAIN scanner, it is essential to install the
TWAIN driver.
If you do not have applications that work with TWAIN, it is necessary to also
install the DeskTopBinder V2 Lite. For information about the installation of
DeskTopBinder V2 Lite, see p.37 “DeskTopBinder V2 Lite”.

Preparation
Before installing, check the operating environment for the TWAIN driver.⇒
p.38 “Type1232 TWAIN Driver”

Using Windows 95/98/Me, Windows XP, Windows 2000, or Windows NT 4.0

Install the TWAIN driver using Auto Run. 

AAAA Verify that Windows is running. Insert the supplied CD-ROM labeled
“Scanner Driver & Document Management Utilities” into the CD-ROM
drive of the computer.

The choose setup language screen is displayed.

Reference
If the installer does not start automatically, see p.33 “Auto Run Program”.

BBBB Select a setup language, and then click [OK].
The CD-ROM Launcher screen is displayed.

CCCC Click [TWAIN Driver].

The software setup screen is displayed.

DDDD The installer of the TWAIN driver starts. Follow the instructions on the
screen.

Note
❒ When the installation is complete, a message to prompt you to restart the

computer may appear. In this case, restart the computer, and continue the
operation.

❒ After the installation is complete, “Type1232 TWAIN V3” folder is created
in the “Program” folder of the Start menu. Help can be displayed from
here. Notes on using the network TWAIN scanner are provided in “Re-
adme.txt”. Be sure to read them before use.
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Software for using a Network Delivery Scanner function

To use the machine as a network delivery scanner, it is essential to install Scan-
Router V2 Lite on the delivery server. To check an in-tray or retrieved the docu-
ments, it is necessary to install DeskTopBinder V2 Lite on the client computer. 
Use Auto Run for installation.

Preparation
Before installation, check the operating environment for each software.⇒
p.38 “Software Supplied on CD-ROM”

AAAA Verify that Windows is running. Insert the supplied CD-ROM labeled
“Scanner Driver & Document Management Utilities” into the CD-ROM
drive of the computer.
The choose setup language screen is displayed.

BBBB Select a setup language, and then click [OK].

The CD-ROM Launcher screen is displayed.

CCCC Click the key of the software to be installed.

• The ScanRouter V2 Lite installer starts by clicking [ScanRouter V2 Lite].
• The DeskTopBinder V2 Lite installer starts by clicking [DeskTopBinder V2

Lite].
The change the language screen is displayed. 

Reference
For information about the subsequent installation procedure, see the Setup
Guide that can be displayed from the Setup screen of the respective soft-
ware.

DDDD Select a language used by this component, and then click [OK].

The software setup screen is displayed.
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DeskTopBinder V2 Lite

Use Auto Run for installation.

Preparation
Before installing, check the operating environment for DeskTopBinder V2
Lite. ⇒ p.39 “DeskTopBinder V2 Lite”

AAAA Verify that Windows is running. Insert the supplied CD-ROM labeled
“Scanner Driver & Document Management Utilities” into the CD-ROM
drive of the computer.

The choose setup language screen is displayed.

BBBB Select a language, and then click [OK].
The CD-ROM Launcher screen is displayed.

CCCC Click [DeskTopBinder V2 Lite].

The change the language screen is displayed.

Reference
For information about the subsequent installation procedure, see the Setup
Guide that can be displayed from the Setup screen of DeskTopBinder V2
Lite.

DDDD Select a language, and then click [OK].

The software setup screen is displayed.
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Software Supplied on CD-ROM

List of Files

Type1232 TWAIN Driver

This driver is required to scan an original on the machine.
To use the machine as a network TWAIN scanner, the driver must be installed.

❖❖❖❖ File storage folder
The files are stored in the following folder on the CD-ROM provided with this
machine.
\DRIVERS\TWAIN

❖❖❖❖ System requirements
• Hardware

PC/AT compatible

Limitation
❒ Under Windows NT, RISC-based processors (MIPS R series, Alpha

AXP, PowerPC), this driver is not available.
• CPU

Pentium or faster (Pentium 150MHz or faster recommended)
• Operating system

Microsoft Windows 95
Microsoft Windows 98
Microsoft Windows Millennium Edition
Microsoft Windows XP Professional
Microsoft Windows XP Home Edition
Microsoft Windows 2000 Server
Microsoft Windows 2000 Professional
Microsoft Windows NT Server 4.0 (Service Pack 5 or later)
Microsoft Windows NT Workstation 4.0 (Service Pack 5 or later)

• Memory
OS min. Operation Memory + 8 MB (64 MB or more recommended)

CD-
ROM 
Drive

Wizard for the TWAIN driver and utilities

Drivers Twain TWAIN driver for Windows 95/98/Me, Windows XP, Win-
dows 2000, Windows NT 4.0

Utility RouterV2 ScanRouter V2 Lite  ScanRouter V2 Administration Utility

DeskV2 DeskTopBinder V2 Lite 

Acroread Acrobat Reader
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• Hard disk space
100 MB or more

• Display resolution
800×600 pixels, 256 colors or higher

• Network protocol
TCP/IP

DeskTopBinder V2 Lite

DeskTopBinder V2 Lite is to be installed on the client computers for integration
and management of various kinds of data such as scanned image data, files cre-
ated with applications, and existing image files. The software allows you to use
view documents in in-trays of the delivery server. This software can be used to
the machine as a network TWAIN scanner. Also, the documents stored in the
document server can be viewed.
For more information, see the manuals for DeskTopBinder V2 Lite or DeskTop-
Binder V2 Lite Help file.

❖❖❖❖ File storage folder
The files are stored in the following folder on the CD-ROM provided with this
machine.
\UTILITY\DESKV2

❖❖❖❖ System requirements
• Hardware

PC/AT compatible
• CPU

Pentium 133 MHz or faster (Pentium II 266 MHz or faster recommended)
• Operating system

Microsoft Windows 95 (OSR 2 or later)
Microsoft Windows 98
Microsoft Windows Millennium Edition
Microsoft Windows XP Professional
Microsoft Windows XP Home Edition
Microsoft Windows 2000 Server (Service Pack 1 or later)
Microsoft Windows 2000 Professional (Service Pack 1 or later)
Microsoft Windows NT Server 4.0 (Service Pack 5 or later)
Microsoft Windows NT Workstation 4.0 (Service Pack 5 or later)

• Memory
48 MB or more (128 MB or more recommended)

• Hard disk space
50 MB or more (200 MB or more recommended)

• Display resolution
800×600 pixels, 64K colors or higher

• Network protocol
TCP/IP
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❖❖❖❖ Software installed with DeskTopBinder V2 Lite
• Auto Document Link

Auto Document Link on the client computer monitors in-trays of the deliv-
ery server regularly. In addition, the documents delivered to in-trays can
be retrieved or a notification of document arrival can be received at the cli-
ent computer with this software.

ScanRouter V2 Lite

ScanRouter V2 Lite is to be installed on the delivery server. The data scanned by
the machine can be sorted on the delivery server, stored in specified in-trays, or
saved in folders of client computers on the same network.
For more information, see the manuals for ScanRouter V2 Lite or ScanRouter V2
Lite Help file.

❖❖❖❖ File storage folder
The files are stored in the following folder on the CD-ROM provided with this
machine.
\UTILITY\ROUTERV2

❖❖❖❖ System requirements
The following system requirements must be met to use ScanRouter V2 Lite.

Limitation
❒ If you install this software in OS in which a client server, such as Windows

NT Workstation and Windows 2000 Professional, cannot be permitted to
use in a network, you may violate the license agreement of Microsoft Cor-
poration.

Note
❒ Install the software on a stand-alone server running Windows NT Server

or Windows 2000 Server. It must not be installed on the primary domain
controller or backup domain controller.

• Hardware
PC/AT compatible

• CPU
Pentium 200 MHz or faster (Pentium II 350 MHz or faster recommended)

• Operating system
Microsoft Windows 95 (OSR 2 or later)
Microsoft Windows 98
Microsoft Windows Millennium Edition
Microsoft Windows XP Professional
Microsoft Windows XP Home Edition
Microsoft Windows 2000 Server (Service Pack 1 or later)
Microsoft Windows 2000 Professional (Service Pack 1 or later)
Microsoft Windows NT Server 4.0 (Service Pack 5 or later)
Microsoft Windows NT Workstation 4.0 (Service Pack 5 or later)



Installing Software

2

• Memory
64 MB or more (128 MB or more recommended)

• Hard disk space
Minimum free space required for installing: 200 MB

Note
❒ In addition to the space required for installation, the hard disk should

have at least 500 MB of free space for files.
• Network protocol

TCP/IP

❖❖❖❖ Software installed with ScanRouter V2 Lite
• ScanRouter V2 Administration Utility

ScanRouter V2 Administration Utility manages the delivery system run by
ScanRouter V2 Lite.
You can register destination and sender information about the scanned
documents in the delivery server. In addition, this utility can monitor free
disk space, record error logs, and maintain the delivery server.

Note
❒ ScanRouter V2 Administration Utility can be installed not only on the

delivery server but also on client computers. To install it, click [Scan-
Router V2 Administration Utility] on the ScanRouter V2 Lite Setup screen.
41
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3. Setting Originals
43
This chapter explains the procedure for placing the original on the exposure
glass and in the automatic document feeder (ADF), and setting original scan
area and orientation according to the placement method.
To correctly display the top/bottom orientation of the scanned original on a
computer, the correct placement must be chosen by setup on the control panel
and scanner driver.
There are two orientations for placing the original. See the table below.

Note
❒ Normally, the original size is  or , but in the table below, a square original

is used to make the original orientation easy to understand. If the actual orig-
inal size changes, a combination of original orientation and the orientation
specified on the control panel or scanner driver does not change.

*1 When sending a gray-scale image file in the TIFF (single or multi-page) or JPEG for-
mat, the image may not appear in the same orientation as it was scanned in.

Scanned original

Select the placement method.

Place the original on the ex-
posure glass.

Place the original in the auto-
matic document feeder 
(ADF).

Place the original.

(There are two original orienta-
tions.)

Place the origi-
nal so that the 
top edge 
touches the top 
left of the expo-
sure glass.

Place the 
original so 
that top edge 
touches the 
rear of the ex-
posure glass.

Place the top 
edge of the 
original first.

 

Place the 
original so 
that the top 
edge is set 
into the ADF.

Speci-
fy the 
orien-
tation.

When scanned by the 
delivery scanner, e-mail 
or document server

(Specified on the con-
trol panel screen)

When scanned by the 
TWAIN scanner

(Specified by the Scan-
ner Control dialog box)

Original displayed on a compu-
ter *1 
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Placing the Original on the Exposure Glass

Originals which do not fit into the
ADF, such as sheets with glued-on
parts, books, etc., can be placed di-
rectly on the exposure glass for scan-
ning.

Note
❒ For information about the origi-

nals which can be placed on the ex-
p o s ur e  g l a ss ,  se e  t he  C o p y
Reference manual.

AAAA Lift the exposure glass cover or
the ADF.

Note
❒ Raise the exposure glass cover

or ADF fully (more than 30 de-
grees). The opening/closing ac-
tion triggers the automatic
original size detection process.

BBBB Place the original on the exposure
glass with the side to be scanned
facing down. Align the far left
edge of the original with the
mark.

There are two original orienta-
tions.
A Place the original so that the

top edge touches the rear of the
exposure glass.

B Place the original so that the
top edge touches the top left of
the exposure glass.

When using the machine as a
network TWAIN scanner, this
orientation is standard setting
in the TWAIN driver. Normal-
ly, use this orientation for set-
ting.

CCCC Close the exposure glass cover or
the ADF.

DDDD Select the original orientation ac-
cording to the setting orientation.

Reference
⇒ p.47 “Original Orientation
and Scan Area Setting”

ZHFY050N

ZHFY060N
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Placing the Original in the Automatic 
Document Feeder (ADF)

The ADF allows you to place several
originals at one time. Originals placed
in the ADF can be scanned on one
side or both sides.

❖❖❖❖ Originals that can and cannot be
placed in the ADF
For information about the origi-
nals that can and cannot be placed
in the ADF, see the Copy Reference
manual.
Attempting to use unsuitable orig-
inals in the ADF can lead to mis-
feed and damage to the originals.
Place such originals directly on the
exposure glass.

Important
❒ For information about which

original sizes can be detected
automatically and notes on
placing originals in the ADF,
see the Copy Reference manual.

AAAA Align the original guide with the
original size.

BBBB Insert the originals with the side
to be scanned facing up. (For orig-
inals which are to be scanned on
both sides, the first side should
face up.)

There are two orientations.

Note
❒ When using the network deliv-

ery scanner and the document
server, or the network TWAIN
scanner, originals with the same
width and different length can
be placed at the same time.
Place the originals as shown in
the figure below.

❒ Originals are scanned in the in-
serted order, starting with the
topmost page.

A Place the original so that the
top edge is in the ADF tray.

ZHFY070N
45



Setting Originals

46

3

B Place the top edge of the origi-
nals first.

When using the machine as a
network TWAIN scanner, this
orientation is the standard set-
ting in the TWAIN driver. Nor-
mally, use this orientation for
placement.

CCCC Select the appropriate orientation
so that it matches the orientation
of originals placed.

Reference
⇒ p.47 “Original Orientation
and Scan Area Setting”

ZHFY080N



Original Orientation and Scan Area Setting

47

3

Original Orientation and Scan Area 
Setting

To correctly display the top/bottom
orientation of the scanned original on
a computer, original orientation and
page flow must be set when placing
the original.
When using the network delivery
scanner and document server, set-
tings are made on the control panel of
the machine. When using the ma-
chine as a network TWAIN scanner,
settings are made on the TWAIN
driver.

Note
❒ The difference between scanning

with the TWAIN scanner and the
network delivery scanner/e-mail
is shown in the following table.

For a Network Delivery 
Scanner and E-mail

AAAA On the scanner function screen,
press [Original Settings].

BBBB Make settings for original orien-
tation, 1 sided/2 sided combina-
tion, SADF/Batch and mixed
original sizes.

Note
❒ The defaults can be changed un-

der [Original Settings], [Original
Orientation Priority], [Switch to
Batch], and [Mixed Original Sizes
Priority] in the Scanner Initial
Setup. ⇒ p.24 “Making Scanner
Settings”

TWAIN 
Scanner

Network 
Delivery 
Scanner
/E-mail

Auto Detect 
Non-Mixed 
Original Sizes

A whole 
batch of 
originals 
is 
scanned 
using the 
size of the 
first origi-
nal.

A whole 
batch of 
originals 
is 
scanned 
using the 
max. size 
set for the 
ADF.

Auto Detect 
Mixed Original 
Sizes

Auto de-
tection is 
used to 
deter-
mine the 
size of 
each orig-
inal.

Aut de-
tection is 
used to 
deter-
mine the 
size of 
each orig-
inal 
placed on 
the expo-
sure 
glass.

Size Specifica-
tion

When an 
original is 
smaller 
than the 
specified 
size, a 
margin 
appears.

When an 
original is 
smaller 
than the 
specified 
size, a 
margin 
appears.

TWAIN 
Scanner

Network 
Delivery 
Scanner
/E-mail
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1-sided original/2-sided original 
selection

A When scanning one-sided orig-
inals, make sure that [2 Sided
Original] is not highlighted.

B When scanning two-sided
originals, press [2 Sided Original]
to select [T to T] or [T to B] ac-
cording to the binding orienta-
tion of the original.

When the last side of a batch of
two-sided originals is blank, se-
lect [1 Sided Original] to skip that
side and finish scanning,or se-
lect [2 Sided Original] to scan that
side as a blank page.

Note
❒ When scanning originals on

the exposure glass with the [2
Sided Original] setting, set [1
Sided Original] for the last
original.

Orientation selection

A Press the key for the same ori-
entation as the actual orienta-
tion of the original  or .

Note
❒ When sending a gray

scale/full color image file in
the TIFF (single or multiple
page) or JPEG format, the im-
age may not appear with the
same orientation as it was
scanned in.

SADF/Batch selection

A When scanning a large number
of originals using the ADF by
dividing the originals and
scanning the individually or in
batches., check that [SADF] or
[Batch] is selected.

Note
❒ Select [SADF] for adding orig-

inals one by one, or select
[Batch] for adding the origi-
nals in batches.

❒ Select whether [SADF] or
[Batch] is displayed using the
initial scanner setting [Switch
to Batch].

Mixed size selection

A When originals of the same
width and different length are
placed, make sure that [Mixed
size] is highlighted.

Note
❒ If [Mixed size] is not set, the

scan size is set as the maxi-
mum size detected. Blank
space is inserted in smaller
originals.

CCCC Press [OK].

Note
❒ The current settings are dis-

played with characters and
icons.

Top to top 
original:

Top to bot-
tom original:

R SR S

R

S S
R
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For a Network TWAIN Scanner

AAAA Open the Scanner Control dialog
box.

Reference
⇒ p.52 “Scanning Originals”

BBBB Select the position from the drop-
down menu of the [Document:] box
in the [Document] group.

CCCC Select [ / ] or [ / ] from
the drop-down menu of the [Orien-
tation:].

Reference
⇒ p.43 “Setting Originals”

DDDD When the original is placed in the
ADF, select [Simplex] or [Duplex]
from the drop-down menu of the
[Side:] box.

Note
❒ If originals of the same width

and different lengths are placed
in the ADF, specify the docu-
ment size in the [Size:] box. If
[Auto detection (Uni-Size)] is se-
lected, all originals are scanned
as the size of the first page.

Scanning Originals in Several 
Times

A large number of originals can be
scanned as a single document by di-
viding them and scanning the indi-
vidually or in batches using the
exposure glass or the ADF. Select
[Yes] in [Job Reset Time in Adding Origi-
nal], and then specify a job reset time.
If another original or batch originals
is placed within this time after all pre-
viously placed originals have been
scanned, it is possible to scan all of
these originals as a single document.

Reference
p.26 “Job Reset Time in Adding
Original”

AAAA Select [Yes] in [Job Reset Time in
Adding Original], and then specify a
job reset time in seconds.

Reference
p.26 “Job Reset Time in Adding
Original”

BBBB Place the originals.

Reference
p.43 “Setting Originals”

CCCC Make settings for scanning area
and original orientation.

Reference
p.47 “Original Orientation and
Scan Area Setting”

Note
❒ When placing originals on the

exposure glass, if [On] is select-
ed in [Job Reset Time in Adding
Original], it is not necessary to se-
lect SADF or Batch.
49
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DDDD Make settings for delivering,
sending by e-mail, or storing.

Reference
p.57 “Delivery Procedure”
p.68 “Procedure for Sending E-
mails”
p.80 “Storage Procedure”

When the {{{{Start}}}} key is pressed,
the originals are scanned.
After the originals are scanned, the
remaining time for accepting the
next original is displayed.

EEEE If you want to change the basic
settings, the scanning area, or the
original orientation, change the
settings before placing the next
original.

Note
❒ While settings are being changed,

the countdown until originals are
no longer accepted stops.

FFFF When there are other originals to
scan, place them within the speci-
fied time.

When placed, the originals are fed
and scanned automatically.

GGGG Repeat from stepFFFF until all origi-
nals are scanned.

HHHH If there are no more originals,
press the {{{{#}}}} key.

Note
❒ Originals are scanned in order.

Place them from the first page.
❒ Press the {{{{Start}}}} key if you want

to restart before the countdown
stops.

❒ When [SADF] is selected and
originals are being scanned by
dividing them and scanning
them consecutively using the
ADF, the next original to be
added can be placed on the ex-
posure glass to be scanned. In
this case, the {{{{Start}}}} key must be
pressed to begin scanning.



4. Scanning Originals Using
Network TWAIN Scanner
This chapter describes the operations for scanning originals with the network
TWAIN scanner using DeskTopBinder V2 Lite. In addition, the preparation se-
quence for using TWAIN scanner and some functions of the TWAIN driver are
introduced.

Flow of Operations

When using DeskTopBinder V2 Lite for scanning, the basic flow of operations is
as follows:

Start up DeskTopBinder V2 Lite and select the scanner.

Place the originals in the scanner.

Make the required scan settings, using the TWAIN driver.

Scan and save the originals.

The scanned image can be edited and printed by DeskTopBinder 
V2 Lite.

1
Select Scanner

2
Place Originals

3
Make Scanner 
Settings

4
Start to Scan
51
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Scanning Originals

This section explains the method for scanning a single original following p.51
“Flow of Operations”.

AAAA Start up DeskTopBinder V2 Lite and select the driver of the scanner.

A Click [Start], point to [Program], and then [DeskTopBinder V2] from [DeskTop-
Binder V2].

DeskTopBinder V2 Lite starts up.
B Click [Scanner Settings] from the [Tools] menu.

The [Scanner Settings] dialog box is displayed.
If the scanner is already selected, no scanner settings are necessary. Check
the settings in the [File format for scanned image(s)] area and then go to step
E.

C Click [Select Scanner Driver].

The [Select Source] dialog box is displayed.
D Click the machine name you want to use in the list, and then click [Se-

lect].

E Click [OK].
The [Scanner Settings] dialog box closes.

BBBB Place the original in the scanner.

Reference
⇒ p.43 “Setting Originals”

CCCC Make the scan settings.

A From the [File] menu, point to [Add Document], and then click [Scan].
The TWAIN driver starts up.
After a short while, the dialog box of the TWAIN driver that operates the
scanner is displayed. This dialog box is called the Scanner Control dialog
box.

Note
❒ The title bar displays the scanner currently being used. When multiple

machines are connected, confirm that the indicated machine name is the
machine to be used. If the intended machine is different, click [Select
Source] to select the scanner again.

❒ If the machine to be used does not appear in the list, make sure that the
IP address is configured and that the machine is correctly connected to
the network. If the driver is still not displayed in the list after the above
operations, consult with your network administrator.



Scanning Originals

4

B Depending on the type of original or the objective for scanning, select
the icon in [Mode]. 

• [Standard] is suitable for scanning standard originals that comprise
mainly of text.

• [Photo] is suitable for scanning originals that include photos, shaded il-
lustrations, etc.

• [OCR] is suitable for conversion processing with an OCR (Optical Char-
acter Reading) application after scanning the original.

• [Filing] is suitable for use with filing applications, etc.

Note
❒ For advanced settings, click [Detail] to display “Detail Window”. For

more information about the “Detail Window”, see TWAIN Driver Help.
C According to the original scan area and orientation, change the setting of

the [Document] group.

Reference
⇒ p.47 “Original Orientation and Scan Area Setting”
For information about the setting of the [Document] group, see Help.

When you want to configure the scanning area

When you do not configure the scanning area, the area is scanned with the
size specified in the [Size:] box.
A Click [Preview].

The original that was placed is scanned and the [Preview] dialog box ap-
pears. The scanning area in the preview appears within the broken lines.

B Configure the scanning area by dragging a border or the top line.

When reconfiguring the area, click  and drag one corner of the area to-
wards its opposite corner.

Note
❒ Depending on the scanning resolution, the area to be scanned may pos-

sibly be subject to restrictions.
C Click [Close].

The [Preview] dialog box closes.

Note
❒ When the original placed in the ADF is previewed, place the original

scanned during preview again.
53
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DDDD Click [Scan].

The original is scanned. A message asking whether there is another original
is displayed.
When there is another original to scan, place the original, and then click [Con-
tinue].
When there are no more originals, click [Complete].

EEEE Save the scanned image in DeskTopBinder V2 Lite. 

A Click [Exit] from the [File] menu.

The [Input Document Information] dialog box is displayed.
B Enter the file name and click [OK].

The image is stored in DeskTopBinder V2 Lite, and the DeskTopBinder
viewer closes.

----Editing and printing scanned data
With DeskTopBinder V2 Lite, it is possible to edit and print scanned data. For
more information about how to edit and print, see DeskTopBinder V2 Lite Help.

Functions of the TWAIN Driver

The following is an introduction to the various functions of the TWAIN driver.

Reference
For more information about these functions or other functions, see Help.

❖❖❖❖ Automatic Tilt Correction 
This function automatically corrects character strings that were scanned
slanted.

❖❖❖❖ Printing to the Image 
This function allows you to imprint dates, page numbers, or your favorite
characters to a scanned image. You can also change the fonts of the imprints
as well as the numerical order of the scanned images to ascending or descend-
ing order.

❖❖❖❖ Scanning Mode Registration 
This function allows you to register other scanning configurations that are of-
ten used as scanning modes besides the already pre-installed ones. After reg-
istration, you can quickly scan with these scanning configurations.



5. Delivering Stored Scan Data
by the Network Delivery Scanner
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Stored scan data can be sent to a specified destination using the network deliv-
ery scanner function. This chapter explains the preparation sequence, various
display screens, delivery procedures, and how to check the delivery result when
this function is used.

Note
❒ A delivery server in which ScanRouter V2 Lite/Professional is installed is

necessary to use the network delivery server function. Information about de-
livery destinations and senders must be registered first into the delivery serv-
er. Also, program a connected device in [Set I/O Device] of ScanRouter V2
Administration Utility. For more information, see ScanRouter V2 Adminis-
tration Utility Help.

List Displays of Destinations and Senders

The screen configuration when using the machine as network delivery scanner
is as shown:

1. [ ] Network Delivery Scanner
Icon
This icon shows that the screen for net-
work delivery scanner is displayed.

2. Destination Display
The selected destination is shown here. If
several destinations are selected, the des-
tinations are displayed in the order they
were selected by pressing [UUUUPrev.] or
[TTTTNext].

Note
❒ Pressing the {{{{Check Modes}}}} key lets

you verify the selected destinations.

3. [Registration No.]
Press this to specify a destination using a
5-digit short ID number.

4. [Manual Input]
When specifying a destination that is not
listed, press [Manual Input] and enter the
destination with the soft keyboard that
appears. For information about sending
e-mail from the delivery server, see p.3
“Manuals for This Machine”.

5. [Attach Sender’s Name] [Attach Sub-
ject]
Set the sender and subject of the deliv-
ered document.

5

6

1

7
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6. [ ]  S w i tc h  D e st i n a t i o n
List/Search
Press this button to switch a destination
list of the delivery server to the destina-
tion list of this machine or to search by
destination.

7. Destination List
Displays the destinations list  pro-
grammed in the delivery server.

Note
❒ When the entire list does not fit on one

screen, [UUUU] or [TTTT] can be used to scroll
the display.

❒ Group destinations are denoted by
this symbol ( ).

❒ A bar above a title indicates that a des-
tination that belongs to it has been se-
lected.
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Delivery Procedure

Data is delivered after specifying scan
settings and destination. If necessary,
you can select a sender and a subject.

AAAA Press the {{{{Scanner}}}} key.

BBBB If user codes are set, enter a user
code with the number keys, and
then press the {{{{#}}}} key.

The scanner function screen is dis-
played.

Reference
For information about the user
codes, see the General Settings
Guide.

Note
❒ If the network TWAIN scanner

screen is displayed, press [Can-
cel].

CCCC Make sure that no previous set-
tings remain.

Note
❒ If a previous setting remains,

press the {{{{Clear Modes}}}} key.

DDDD Place the original in the machine,
and adjust the settings for origi-
nal size and orientation if re-
quired.

Reference
⇒ p.43 “Setting Originals”

EEEE If the e-mail screen appears,
switch to the screen for network
delivery scanner.
A Press [ ].

The Search/Switch List screen
is displayed.

B Press [Switch Destination List].

The switch destination screen is
displayed.

C Press [Delivery Server].

D Press [Exit].

The network delivery scanner
screen is displayed.

Reference
⇒ p.24 “Making Scanner Set-
tings”.

ZHFS013N
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FFFF Make the scan settings.

To make the scan settings, call up
stored settings or make the settings
individually.

Reference
⇒ p.20 “Setting Scanner Fea-
tures”

Calling up stored scan settings

A Press [Recall Program].

The Recall Program screen is
displayed.

B Select a user program of scan
settings.

C Press [OK].

The selected user program set-
tings are applied.

Making the settings individually

A Press [Scan Settings].
The screen for making scan set-
tings is displayed.

B Select resolution, original size,
and other items to change the
corresponding setting.

Scan settings are made in the
s a m e  w a y  t h e y  a r e  p r o -
grammed. See p.20 “Setting
Scanner Features”.

C Press [OK].
The scan settings are applied.

GGGG Select the destination.

Four methods are available for
specifying a destination: selecting
it from the list by specifying a short
ID number by searching it or by di-
rectly typing the e-mail address.

Note
❒ When using ScanRouter V2 Pro-

fessional, the destination list is
updated automatically.

When selecting a destination 
from the list

A Press the title for the desired
destination. The destinations
for that title are displayed.
If the desired destination is not
displayed, press [UUUU] or [TTTT] to
display the destination.

Note
❒ The destination titles are pro-

grammed in the delivery
server.
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B Select the destination to which
the scan data is to delivered.

The selected destination is high-
lighted and also appears in the
destination field at the top of the
screen.

Note
❒ To deselect a destination,

press the destination once
more, or press [UUUUPrev.] or
[TTTTNext] to bring up the desti-
nation in the destination
field, and then press the
{{{{Clear/Stop}}}} key.

C To select more destinations, re-
peat step BBBB.

Using a short ID number to select 
a destination

A Press [Registration No.].

B Use the number keys to enter
the 5-digit ID number that has
been assigned to a destination.

If the entered number is less
than 5 digits long, press the {{{{#}}}}
key after the last number.
Example for entering 00009:
Press the {{{{9}}}} key and then the
{{{{#}}}} key using the number keys.

The destination corresponding
to the short ID number appears
in the destination field at the top
of the screen.

Note
❒ To deselect a destination,

press [UUUUPrev.] or [TTTTNext] to
display the destination in the
destination field, and then
press the {{{{Clear/Stop}}}} key.

C To select more destinations, re-
peat step BBBB.

Searching for a destination to 
select

A Press [ ].

The Destination Search/Switch
List screen is displayed.

B Press [Search].

C Press [Search by User Name].
The soft keyboard is displayed
for searching by user name.

Note
❒ When using ScanRouter V2

Professional, it is possible to
search by comments.

D Enter part of the destination
name.

Note
❒ Enter the first character or

characters of the destination
name.

E Press [OK].
A list of destination names
found is displayed.
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F Select a destination.

G Press [Exit].

H Press [OK].

The destination name appears
in the destination field at the top
of the screen.

Manual input of a destination

Note
❒ When using ScanRouter V2 Pro-

fessional, it is possible to enter
the destination e-mail address
directly.

A Press [Manual Input].

The soft keyboard is displayed
to enter a destination.

B Enter the destination with the
soft keyboard.

Note
❒ Enter the e-mail address of

the destination when send-
ing via the delivery server.

❒ It is possible to use alphabets,
numbers and periods. The
symbols ()\,;:”  cannot be
used.

For more information to enter
an e-mail address, see the Gen-
eral Settings Guide.

C Press [OK].

The name of the destination ap-
pears in the destination display
area on the upper side of the
screen.

Note
❒ Press [UUUUPrev.] or [TTTTNext] to

select the destination.
❒ Pressing the {{{{Check Modes}}}}

key lets you verify the select-
ed destinations.

D To enter more than one desti-
nation, repeat steps AAAA to CCCC.

Checking selected destinations

A Use the destination field at the
top of the screen to check which
destinations are selected.

Note
❒ When multiple destinations

are selected, the selected des-
tinations are displayed in or-
der they were selected by
pressing [UUUUPrev.] or [TTTTNext].

❒ Pressing the {{{{Check Modes}}}}
key on the control panel lets
you verify the list of selected
destination(s).

HHHH Specify the sender (scan data de-
livery source).

Note
❒ When a sender has been speci-

fied, this information is added
to the scan data file. Select a
sender from the senders pro-
grammed in the delivery server.

Three methods are available for se-
lecting a sender:select the sender
from the list, enter the 5-digit short
ID number of the sender with the
number keys, and search for the
sender and select it.
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When selecting a sender from the 
list

A Press [Attach Sender’s Name].

A list of senders registered in
the delivery server is displayed.

B Select the sender.

The selected sender and it’s
short ID number is displayed.

Note
❒ When using ScanRouter V2

Professional, [Return Receipt]
appears when a sender is se-
lected.

To verify receipt for delivering,
press [Return Receipt].

C Press [OK].

The sender is displayed above
[Attach Sender’s Name].

Using a short ID number to 
specify a sender’s name

A Press [Attach Sender’s Name]

A list of senders registered in
the delivery server is displayed.

B Use the number keys to enter
the 5-digit ID number that has
been assigned to a sender.

Example for entering 00006:
Press the {{{{6}}}} key and then the
{{{{#}}}} key using the number keys.

Note
❒ When using ScanRouter V2

Professional, [Return Receipt]
appears when a sender is se-
lected.

To verify receipt, press [Return
Receipt].

C Press [OK].

The sender is displayed above
[Attach Sender’s Name].
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Searching for a sender to select

A Press [Attach Sender’s Name].

A list of senders registered in
the delivery server is displayed.

B Press [ ].

The Search by Sender's Name
screen is displayed.

C Press [Search by User Name].

The soft keyboard is displayed
to search for a sender.

D Enter part of the sender name.

Note
❒ Enter the first character or

characters  of  the sender
name.

E Press [OK].

A list of senders is displayed ac-
cording to the user name search.

F Select the sender.

G Press [Exit].
H Press [OK].

The sender is displayed above
[Attach Sender’s Name].

IIII If required, select a subject.

Select a subject from the registered
ones. ⇒ p.28 “Making Scan Data
Subject Settings”

Note
❒ When a subject has been speci-

fied, this information is added
to the scan data file.

❒ When ScanRouter V2 Profes-
sional is used to send docu-
ments using e-mail, the subject
is automatically entered the
message subject.

Two methods are available for se-
lecting a subject, selecting it from
the list or entering it directly.

When selecting a subject from 
the list

A Press [Attach Subject].

B Select a subject.

C Press [OK].

The name of the subject is dis-
played above [Attach Subject].
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Manual input of the subject

A Press [Attach Subject].
A list of registered subject is dis-
played.

B Press [Manual Input]

The soft keyboard is displayed
to enter a subject.

C Enter the subject with the soft
keyboard.

D Press [OK].
The name of the subject is dis-
played above [Attach Subject].

JJJJ Press the {{{{Start}}}} key.
The original is scanned and deliv-
ered to the specified destination.
Place the original and press the
{{{{Start}}}} key.

Note
❒ To interrupt the scanning, press

the {{{{Clear/Stop}}}} key or [Stop] in
the screen.

❒ To use the SADF function,
divede originals. place the next
original. ⇒  p.49 “Scanning
Originals in Several Times”
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Checking the Status of Delivery

The status of the last 50 deliveries can
be checked. For every new delivery
record after 50, the oldest record is
deleted.

❖❖❖❖ Items that can be checked
• Date/Time

The time when the delivery re-
quest was received from this
machine is displayed.

• Destination
When multiple destinations
were selected, the first selected
destination is displayed.

• Sender
• File Name
• Status

I nfo rm at io n  i s  reg is te red
whether the delivery has been
properly completed, an error
has occurred, or if the delivery
is in waiting or has stopped.

AAAA Press [Scanned Files Status] on the
network delivery scanner screen.

The delivery status is displayed.

BBBB Check the displayed records.

Note
❒ One screen shows the records

for five delivery operations. Use
[UUUUPrev.] or [TTTTNext] to scroll
through the screen.

❒ When [Print & Delete Scanner Jour-
nal] is set to [Print], the whole
journal is printed when the
number of delivery operations
reaches 50. 

❒ When the status of a document
is [Waiting], the delivery can be
stopped by selecting that docu-
ment and pressing [Cancel].

CCCC Press [Exit].

The display returns to the network
delivery scanner screen.
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Using the Network Delivery Scanner with 
the Document Server

You can use the network delivery
scanner with the document server.

Simultaneous Delivery and 
Storage

Scanned data is stored in the docu-
ment server at the same time the data
is delivered.

Note
❒ This section explains mainly the

operation for simultaneous deliv-
ery and storage. For more informa-
t io n ,  se e  p . 57  “D e l i v e r y
Procedure”.

AAAA Place the original and then adjust
the settings for original size and
orientation if required.

Reference
⇒ p.43 “Setting Originals”

BBBB Make the scan settings.

CCCC Select the destination.

DDDD If required, specify the sender
(scan data delivery source) and a
subject.

EEEE Press [Store File].

The screen for setting storage pa-
rameters for scanned data is dis-
played.

FFFF Make sure [Send & Store] is select-
ed.

GGGG Press [File Information] to set file in-
formation.

Reference
For more information, see p.81
“Specifying file information”.

HHHH Press [OK].

IIII Press the {{{{Start}}}} key.

The original is scanned, and the
file is delivered to the destination
and stored in the document server.
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Delivering Stored Files

Files stored in the document server
can be delivered.

Note
❒ This section explains mainly how

to select files to be delivered. For
more information about the deliv-
ery procedure, see p.57 “Delivery
Procedure”.

❒ When the stored files are deliv-
ered, scan settings cannot be made.
The files are delivered with the
specified scan settings when they
are stored in the document server.

AAAA Display the list of stored files.

Reference
⇒  p.84 “Viewing a List  of
Stored Files”

BBBB Select a file to be delivered.

Note
❒ When you select a password

protected file, the password
screen is displayed. After you
have entered the correct pass-
word and pressed [OK], the file
will be selected.

CCCC To select multiple files, repeat
step BBBB.

Note
❒ You can select up to 30 files for

one operation.
❒ If you select multiple files, the

files will be delivered in the or-
der they were selected.

❒ If you press [Display Selection],
the selected files will be shown
in the order of delivery.

DDDD Press [OK].
The screen for specifying a destina-
tion is displayed.

EEEE Specify a destination.

FFFF If required, select the sender (scan
data delivery source) and a sub-
ject.

GGGG Press the {{{{Start}}}} key.
The selected stored files are deliv-
ered.
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Stored scan data can be sent to a specified destination using e-mail. This chapter
explains the preparation sequence for sending by e-mail, various display
screens, delivery procedures, and how to check the sending result when this
function is used.

List Displays of Destinations and Senders

The screen configuration when using the machine as e-mail is as shown:

1. Destination Display
The selected destination is shown here. If
several destinations are selected, the des-
tinations are displayed in the order there
were selected by pressing [UUUUPrev.] or
[TTTTNext].

Note
❒ Pressing the {{{{Check Modes}}}} key lets

you verify the selected destinations.

2. [ ] E-mail Icon
This icon shows that the screen for send a
e-mail is displayed.

3. [Registration No.]
Press this to specify a destination using a
5-digit short ID number.

4. [Manual Input]
When specifying a destination that is not
listed, press [Manual Input] and enter the
destination with the soft keyboard.

5. [Attach Sender’s Name] [Attach Sub-
ject] [File Type]
Set the sender and the subject of the de-
livered document.
If necessary, select the file type of the im-
age file attached to the e-mail.

6. [ ]  S wi t c h  D e st i n at i o n
List/Search
Press this button to switch a destination
from the delivery server list to the desti-
nation list of this machine or to search us-
ing the e-mail destination.

7. Destination List
Displays the destinations programmed
in the delivery server or this machine.

Note
❒ When the entire list does not fit on one

screen, [UUUU] or [TTTT] can be used to scroll
the display.

❒ Group destinations are denoted by
this symbol ( ).

❒ A bar above a title indicates that a des-
tination that belongs to it has been se-
lected.

5

6

7

2 3 41
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Procedure for Sending E-mails

Data is sent after specifying scan set-
tings and destination.

AAAA Press the {{{{Scanner}}}} key.

BBBB If user codes are set, enter a user
code (consisting of up to eight
characters) with the number keys,
and then press the {{{{#}}}} key.

The Scanner Function screen is dis-
played.

Reference
For information about the user
code, see the General settings
Guide.

Note
❒ If the network TWAIN scanner

screen is displayed, press [Can-
cel].

CCCC Make sure that no previous set-
tings remain.

Note
❒ If a previous setting remains,

press the {{{{Clear Modes}}}} key.

DDDD Place the original in the machine,
and adjust the settings for origi-
nal size and orientation if re-
quired.

Reference
⇒ p.43 “Setting Originals”

EEEE If the network delivery scanner
screen appears, switch to the
screen for sending e-mail.
A Press [ ].

The Search/Switch List screen
is displayed.

B Press [Switch Destination List].

The Switch Destination screen
is displayed.

C Press [E-mail].

D Press [Exit].

The send e-mail screen is dis-
played.

Reference
⇒ p.24 “Making Scanner Set-
tings”.

ZHFS013N
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FFFF Make the scan settings.

To make the scan settings, call up
stored settings or make the settings
individually.

Reference
⇒ p.20 “Setting Scanner Fea-
tures”

Calling up stored scan settings

A Press [Recall Program].

The Recall Program screen is
displayed.

B Select a user program of scan
settings.

C Press [OK].

The selected user program set-
tings are applied.

Making the settings individually

A Press [Scan Settings].
The screen for making scan set-
tings is displayed.

B Select resolution, original size,
and other items to change the
corresponding setting.

Scan settings are made in the
s a m e  w a y  t h e y  a r e  p r o -
grammed. See p.20 “Setting
Scanner Features”.

C Press [OK].
The scan settings are applied.

GGGG Select the file type if necessary.

A Press [File Type].
B Select the file type of the file to

be attached to the e-mail from
the displayed types.

The selected file type is dis-
played under [File Type].

HHHH Select the destination.

Four methods are available for se-
lecting a destination: selecting it
from the list by specifying a short
ID number by directly typing the
e-mail address or by searching it.

Note
❒ Before selecting the destination,

make sure to select [To]. When
necessary, select [Cc] or [Bcc]
and the respective destinations.
It cannot specify more than 100
destinations including [To], [Cc]
and [Bcc].
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When selecting a destination 
from the list

A Press the title for the desired
destination. The destinations
for that title are displayed.

If the desired destination is not
displayed, press [UUUU] or [TTTT] to
display the destination.

Note
❒ The destination titles are pro-

grammed in the delivery
server.

B Select the destination to which
the scan data is to be sent.

The selected destination is high-
lighted and also appears in the
destination field at the top of the
screen. A line appears over the
title of the category to which the
destination belongs.

Note
❒ To deselect a destination,

press the destination once
more, or press [UUUUPrev.] or
[TTTTNext] to bring up the desti-
nation in the destination
field, and then press the
{{{{Clear/Stop}}}} key.

C To select more destinations, re-
peat step BBBB.

Using a short ID number to select 
a destination

A Press [Registration No.].

B Use the number keys to enter
the 5-digit ID number that has
been assigned to a destination.
If the entered number is less
than 5 digits long, press the {{{{#}}}}
key after the last number.
Example:
To enter 00003
Press the {{{{3}}}} key and then the
{{{{#}}}} key using the number keys.

The destination corresponding
to the short ID number appears
in the destination field at the top
of the screen.

Note
❒ To deselect a destination,

press [UUUUPrev.] or [TTTTNext] to
display the destination in the
destination field, and then
press the {{{{Clear/Stop}}}} key.

C To select more destinations, re-
peat step BBBB.
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Manual input of the e-mail address

A Press [Manual Input].
The soft keyboard appears to
enter the e-mail address.

B Enter the e-mail address with
the soft keyboard.
It is possible to use alphabets,
numbers and periods. The sym-
bols ()\,;:” cannot be used.
For more information to enter
the e-mail address, see the Gen-
eral Settings Guide.

C Press [OK].

The name of the destination ap-
pears in the destination display
area on the upper side of the
screen.

Note
❒ Press [UUUUPrev.] or [TTTTNext] to

select the destination.
❒ For changing an e-mail ad-

dress that has been entered,
press [Change] located on the
left side of the destination list
field. A software keyboard
for entering the e-mail ad-
dress is displayed. Enter any
e-mail address, and then
press [OK].

❒ Pressing the {{{{Check Modes}}}}
key lets you verify the select-
ed destinations.

D To enter more than one desti-
nation, repeat steps AAAA to CCCC.

Searching for a destination to 
select

A Press [ ].

The destination Search/Switch
list screen is displayed.

B Press [Search].

C Press [Search by User Name].

Note
❒ To search using e-mail ad-

dresses, press [Search by Ad-
dress].

The soft keyboard is displayed
for searching by destination
name.

D Enter part of the destination
name.

Note
❒ Enter the first character or

characters of the destination
name.

❒ It is also possible to perform
a combined search using
[Search by User Name] and
[Search by address].

E Press [OK].

A list of destinations is dis-
played according to the user
name search.
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F Select a destination.

G Press [Exit].

H Press [OK].

The destination name appears
in the destination field at the top
of the screen.

Checking selected destinations

A Use the destination field at the
top of the screen to check which
destinations are selected.

Note
❒ When multiple destinations

are selected, the selected des-
tinations are displayed in the
order they were selected by
pressing [UUUUPrev.] or [TTTTNext].

❒ Pressing the {{{{Check Modes}}}}
key on the control panel lets
you verify the list of selected
destination(s).

IIII Specify the e-mail sender.

Note
❒ When a sender is selected, the

sender name is automatically
placed in the “From” field of the
e-mail so that the sender can be
identified when the e-mail is re-
ceived.

❒ An example of “E-mail Informa-
tion Language” is shown below.
This e-mail has been sent from
[XXX]. The scanning time was
YYYY:MM :DD HH:MM :SS
(+0900). The administrator’s e-
mail address is sent for refer-
ence. ⇒ p.26 “E-mail Informa-
tion Language”

❒ To prevent misuse of a sender
name, we recommend you set
up a password for the sender.

❒ Be sure to select or enter a send-
er's name. Otherwise [Key Opera-
tor's E-mail Address] is used as a
sender’s name. For more infor-
mation, see the General Settings
Guide.

Three methods are available for se-
lecting a sender: select the sender
from the list, enter the 5-digit short
ID number of the sender with the
number keys, and search for the
sender and select it.

When selecting a sender from the 
list

A Press [Attach Sender’s Name].

The list of senders registered in
this machine is displayed.

B Select the sender.

Note
❒ If a password has been set, a

screen for entering the pass-
word appears after selecting
the sender.

Enter the password, and then
press [OK].
After verification of the pass-
word, the sender name is dis-
played.
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C To verify receipt, press [Return
Receipt].

[Return Receipt] is highlighted.
D Press [OK].

The sender is displayed above
[Attach Sender’s Name].

Using a short ID number to 
specify a sender’s name

A Press [Attach Sender’s Name].

The list of senders registered in
this machine is displayed.

B Use the number keys to enter
the 5-digit short ID number
that has been assigned to a
sender.

If the entered number is less
than 5 digits long, press the {{{{#}}}}
key after the last number.
Example for entering 00006:
Press the {{{{6}}}} key and then the
{{{{#}}}} key using the number keys.

Note
❒ If a password has been set, a

screen for entering the pass-
word is displayed after se-
lecting the sender.

Enter the password, and then
press [OK].
After verification of the pass-
word, the sender name is dis-
played.

C To verify receipt, press [Return
Receipt].

[Return Receipt] is highlighted.
D Press [OK].

The sender appears above [At-
tach Sender’s Name].

Searching for a sender to select

A Press [Attach Sender’s Name].

The list of senders registered in
this machine is displayed.

B Press [ ].

The sender search screen ap-
pears.
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C Press [Search by User Name].

Note
❒ To search using e-mail ad-

dresses, press [Search by Ad-
dress].

The soft keyboard is displayed
to search a sender.

D Enter part of the sender name.

Note
❒ Enter the first character or

characters  of  the sender
name.

❒ It is also possible to perform
a combined search using
[Search by User Name] and
[Search by Address].

E Press [OK].

A list of senders is displayed ac-
cording to the user name search.

F Select the sender.

Note
❒ If a password has been set, a

screen for entering the pass-
word appears after selecting
the sender.

Enter the password, and then
press [OK].
After verification of the pass-
word, the sender name is dis-
played.

G Press [Exit].

H To verify receipt, press [Return
Receipt].

[Return Receipt] is highlighted.
I Press [OK].

The sender is displayed above
[Attach Sender’s Name].

JJJJ If required, select a subject.

Select a subject from the registered
ones. ⇒ p.28 “Making Scan Data
Subject Settings”

Note
❒ The selected subject name is au-

tomatically placed in the Subject
field of the mailing soft.

Two methods are available for se-
lecting a subject, selecting it from
the list or entering it directly.

When selecting a subject from 
the list

A Press [Attach Subject].

The list of subjects registered is
displayed.

B Select a subject.
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C Press [OK].

The selected subject is dis-
played above [Attach Subject].

Manual input of the subject 
directly

A Press [Attach Subject].

The list of registered subject is
displayed.

B Press [Manual Input].

The soft keyboard appears to
enter a subject.

C Enter the subject with the soft
keyboard.

D Press [OK].

The name of the subject is dis-
played above [Attach Subject].

KKKK Press the {{{{Start}}}} key.

The original is scanned and the
scan data file is sent to the destina-
tion(s).

Note
❒ To abort the scan process, press

the {{{{Clear/Stop}}}} key or press
[Stop] on the screen.

❒ To use the SADF function, place
the next original. ⇒ p.49 “Scan-
n ing  Or ig in a ls  in  S ev er a l
Times”

❒ Regardless of the divide e-mail
size setting, it is not possible to
send e-mail containing over
725.3MB per document. It is
also not possible to send more
than 2,000 pages.
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Checking the Status of E-mail

The status of the last 50 e-mails can be
checked. For every new e-mail record
after 50, the oldest record is deleted.

❖❖❖❖ Items that can be checked
• Date/Time

The date and time when the de-
livery request was received
from this machine is displayed.

• Destination
When multiple destinations
were selected, the first selected
destination is displayed.

• Sender
• File Name
• Status

Indicates whether delivery was
successful or resulted in an er-
ror.

AAAA Press [Scanned Files Status] on the
screen for sending e-mail.

The delivery status of e-mail is dis-
played.

BBBB Check the displayed records.

Note
❒ One screen shows the records

for five sending operations. Use
[UUUUPrev.] or [TTTTNext] to scroll
through the screen.

❒ When [Print & Delete Scanner Jour-
nal] is set to [Print], all records
are printed when the number of
records reaches 50.

❒ When the status of a document
is [Waiting], the sending e-mail
can be stopped by selecting that
document and pressing [Can-
cel].

CCCC Press [Exit].

The display returns to the screen
for sending e-mail.
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Using E-mail with the Document Server

You can use the e-mail delivery with
the document server.
This section explains mainly the oper-
ation for simultaneous e-mail sending
and storage. For more information,
see p.57 “Delivery Procedure”.

Simultaneous E-mail and 
Storage

Scanned data is stored in the docu-
ment server at the same time the data
is sent by e-mail.

AAAA Place the original, and then adjust
the settings for original size and
orientation if required.

Reference
⇒ p.43 “Setting Originals”

BBBB Make the scan settings.

CCCC Select the destination.

DDDD If required, specify the sender
(scan data delivery source) and a
subject.

EEEE Press [Store File].

The screen for setting storage pa-
rameters for scanned data is dis-
played.

FFFF Make sure [Send & Store] is select-
ed.

GGGG Press [File Information] to set file in-
formation.

Reference
For more information, see p.81
“Specifying file information”.

HHHH Press [OK].

IIII Press the {{{{Start}}}} key.

The original is scanned, and the
file is delivered to the destination
and stored in the document server.
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Sending Stored Files

Files stored in the document server
can be sent by e-mail.
When the stored files are delivered,
scan settings cannot be made. The
files are delivered with the scan set-
tings specified when they were stored
in the document server.

AAAA Display the list of stored files.

Reference
⇒  p.84 “Viewing a List  of
Stored Files”

BBBB Select a file to be delivered.

Note
❒ When you select a password

protected file, the password
screen is displayed. After you
have entered the correct pass-
word and pressed [OK], the file
will be selected.

CCCC To select multiple files, repeat
step BBBB.

Note
❒ You can select up to 30 files for

one operation.
❒ If you select multiple files, the

files will be sent in the order
they were selected.

❒ If you press [Display Selection],
the selected files will be shown
in the order of delivery.

DDDD Press [OK].

The screen for specifying a destina-
tion is displayed.

EEEE Specify a destination.

FFFF If required, select the sender (scan
data delivery source) and a sub-
ject.

GGGG Press the {{{{Start}}}} key.
The selected stored files are sent.



7. Using the Document Server
Data obtained by scanning originals can be stored in the hard disk of the ma-
chine using the document server function, and the stored data can be used later.
Using DeskTopBinder V2 Lite/Professional, stored data can be viewed or re-
trieved with a client computer.

Important
❒ There are no special security settings for document server. When a dial-up

connection is used, there is a risk that document server will be accessed by an
external DeskTopBinder user. We recommend using a security system such
as a firewall.

❒ Data stored in the machine night be lost if some kind of failure occurs. The su-
plier shall not be responsible for any damage that might result from the loss
of data. For long-term storarge of data, we recommended the use of DeskTop-
Binder V2 Lite or DeskTopBinder V2 Professional (option). For more informa-
tion, please contact your local dealer.

Note
❒ When a delivery server is added to the network, data stored in the document

server can be delivered. You can store scanned data in the document server
and deliver it with the network delivery scanner or send it by e-mail simulta-
neously.⇒ p.65 “Using the Network Delivery Scanner with the Document
Server”

Storing Data

This section describes how to store data in the document server and how to as-
sign file information to stored data.

Note
❒ The data stored making in the document server is deleted automatically after

certain days passed. For information about settings and changes, see the Gen-
eral Settings Guide.

❒ The theoretical maximum number of files that can be stored is 1,000(or 1,000
pages per file). However, the actual maximum may be less, depending on the
space used by the copy function and other functions of the machine.

❒ Documents scanned in the scanner function cannot be printed from the con-
trol panel. Print the documents using DeskTopBinder V2 Lite/Professional
after receiving.
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Storage Procedure

Scan and store the document in the
document server.

AAAA Press the {{{{Scanner}}}} key.

BBBB If the user codes are set, enter the
user code with the number keys,
and then press {{{{#}}}}.

The scanner function screen ap-
pears.

Note
❒ If the network TWAIN scanner

screen is displayed, press [Can-
cel].

CCCC Make sure that no previous set-
ting remains.

Note
❒ If the previous setting remains,

press the {{{{Clear Modes}}}} key.

DDDD Place the original in the machine,
and adjust the settings for origi-
nal size and orientation if re-
quired.

Reference
⇒ p.43 “Setting Originals”

EEEE Make the scan settings.

To make the scan settings, recall
the stored settings or make the set-
tings individually.

Reference
⇒ p.20 “Setting Scanner Fea-
tures”

Calling up stored scan settings

A Press [Recall Program].

The Recall Program screen is
displayed.

B Select a user program of scan
settings.

C Press [OK].

The selected user program set-
tings are applied.

Making settings individually

A Press [Scan Settings].
The screen for making scan set-
tings is displayed.

ZHFS013N
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B Select the desired resolution,
original size, and other items
to change the settings.

Scan settings are made in the
same way there are programed.
See p.20 “Setting Scanner Fea-
tures”.

C Press [OK].
The scan settings are applied.

FFFF Make the settings for storing
scanned data files.

A Press [Store File].

The screen for setting storage
parameters for scanned data is
displayed.

B Press [Store Only].

Note
❒ To store and deliver scanned

data, press [Send & Store]. ⇒
p.65 “Using the Network De-
livery Scanner with the Doc-
ument Server”

❒ [Store Only] cannot be pressed
if even a single destination is
selected.

C Press [OK].

GGGG Specify file information.

Specify a user name, file name, and
password for the file to be stored.

Reference
For more information about
how to specify file information,
see p.81 “Specifying file infor-
mation”.

HHHH Press the {{{{Start}}}} key.
The original is scanned and the re-
sulting data is stored as a file in the
document server.

Note
❒ To abort the scanning process,

press the {{{{Clear/Stop}}}} key or
press [Stop] in the screen.

❒ When originals are being
scanned using the SADF, load
the next original. ⇒ p.49 “Scan-
n i ng  O r i g ina ls  in  Sev era l
Times”

Specifying file information

You can specify a user name, file
name, and password for a stored scan
data file.
When this function is used, you can
search for files by user name or file
name, and you can prevent unauthor-
ized persons from accessing the files.

Note
❒ The file name can be up to 64 char-

acters long, The user name can be
up to 20 characters long. The first
16 characters are shown on the
control panel. With DeskTopBind-
er V2 Lite/Professional installed
on a client computer, you can view
the entire string.
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AAAA Display the File Information screen.

A Press [Store File].

B Press [File Information].

The File Information screen is
displayed.
The following screen appears
when the network delivery
scanner function is used.

The following screen appears
when the e-mail function is
used.

BBBB Specify file information.

Specifying a user name

A Press [User Name].

The User Name screen is dis-
played.

Note
❒ If no user name is pro-

grammed in System Settings
under the Administrator tab,
the User Name screen does
not appear. Instead, the Non-
programed Name screen ap-
pears. Enter the user name.

B Select the desired user name.

Note
❒ The user names shown here

are names that were pro-
grammed in System Settings
under the Administrator tab.
To enter a name not shown
here, press [Non-programed
Name], and then enter the
user name.

C Press [OK].

The user name is set.

Specifying a file name

Scanned data files are automatical-
ly named SCAN0001, SCAN0002,
etc. If desired, you can change the
file name.
A Press [File Name].

The soft keyboard is displayed
for entering a file name.
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B Enter the desired file name.

Reference
For information about how
to enter characters, see the
General Settings Guide.

C Press [OK].

The new file name is applied.

Specifying a password

By specifying a password, only a
person who knows the password
can view the data.
A Press [Password].

The Password screen appears.
B Enter a password consisting of

four numbers.

C Press [OK].

The password is applied.

Important
❒ Do not forget the password.

If you forget it, contact the
key operators in charge of
this machine.

CCCC Press [OK] twice to return to the
original screen.
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Viewing a List of Stored Files

From the displayed list of stored files,
you can delete the files stored in the
document server or change the file in-
formation. To show the displayed list
of stored files, perform the following
steps.

AAAA Press the {{{{Scanner}}}} key.

The scanner function screen is dis-
played.

Note
❒ If the network TWAIN scanner

screen is displayed, press [Can-
cel].

BBBB The displayed list of stored files
is displayed.

A Press [Select Stored File].

B Press [Manage/Delete File].

Viewing the List

The list of stored files has the following elements.

❖❖❖❖ When using the network delivery scanner or the e-mail

ZHFS013N
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❖❖❖❖ When using the document server only

❖❖❖❖ When displaying information of a selected stored file

1. Keys for searching files
Switch to the screens for searching for
a file by user name or file name, or to
the screen for displaying all files.

2. Keys to switch to the information
display

Use to switch between the stored file
list and the detailed information of the
selected file.

3. Keys for sorting files
Sorts the files using the selected item.
Select the same item once more for a
reverse sort. However, the delivery
order cannot be sorted in descending
order.

4. Keys for changing file informa-
tion

Use for deleting, changing the user
name, file, or password of the selected
file, or for checking file information.

5. A list of stored files
A list of stored files is displayed.

Note
❒ Stored files cannot be shown when

a function other than the scanning
function is used.

❒ If the desired file is not visible, use
[UUUUPrev.] or [TTTTNext] to scroll through
the screen.

❒ For files which are password pro-
tected, a key symbol( ) is shown to
the left of the file name.

6. [Manage/Delete File]
Press to manage or delete the files
stored in the document server or
change the file information.

7. [Send]
Press to deliver or send the files stored
in the document server. For more in-
formation, see p.66 “Delivering Stored
Files” or p.78 “Sending Stored Files”.
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8. Information of a selected stored
file

Press [Information] to display the infor-
mation of a file after selecting the file
from the file list.

----Viewing a list of stored files in DeskTopBinder V2 Lite
The files stored in the document server are shown below using DeskTopBinder
V2 Lite.

1. Connected device name
Displays the files stored in the connected
device on the desk tree by dividing into
User name and All uses folders.

2. User name
Displays only the files stored with the
same user name specified in the connect-
ed device properties. The files stored
from the scanner are shown in the “Scan-
ner” folder.

3. All users
Displays all files stored in the connected
device.

4. Folder contents display
Displays the files in the selected folder.

2
1

3
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Searching for Files

You can search for desired files from
the stored files, using the user name
or file name as a key.

Searching by user name

AAAA On the list of displayed files,
press [Search by User Name].

The Search by User Name screen is
displayed.

BBBB Select the user name to be used
for the search.

The user names shown here are
names that were registered in Sys-
tem Settings under the Adminis-
trator tab. To enter user name not
shown here, press [Non-programed
Name], and then enter the name.

CCCC Press [OK].
The search starts, and files whose
user name starts with the entered
string are displayed.

Searching by file name

AAAA On the list of displayed files,
press [Search by File Name].

The Search by File Name screen is
displayed.

BBBB Enter the file name to search for.

Reference
For information about how to
input characters, see the Gener-
al Settings Guide.

CCCC Press [OK].

The search starts, and file whose
name starts with the entered string
are displayed.
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Deleting Stored Files

You can delete files that are no longer
needed.

Limitation
❒ Delivery waiting files cannot be

deleted.

AAAA Display the list of stored files.

Reference
⇒  p.84 “Viewing a List  of
Stored Files”

BBBB Press [Manage/Delete File].
The Manage/Delete File screen is
displayed.

CCCC Select the file to be deleted.

Note
❒ Up to 30 files can be selected.
❒ When you select a password

protected file, the password
screen is displayed. Enter the
correct password, and then
press [OK]. When more than one
file are selected, the password
screen is displayed for each file.

DDDD Press [Delete File].

A confirmation message for delet-
ing file is displayed.

EEEE Press [Delete].

The file is deleted.

FFFF Press [Exit].
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Changing File Information

The information about files stored in
the document server (user name, file
name, password) can be changed.

Limitation
❒ Information about delivery wait-

ing files cannot be changed.

AAAA Display the list of stored files.

Reference
⇒  p.84 “Viewing a List  of
Stored Files”

BBBB Press [Manage/Delete File]

The manage and delete file screen
is displayed.

CCCC Select the file for which you want
to change the file information.

Note
❒ When you select a password

protected file, the password
screen is displayed. Enter the
correct password, and then
press [OK].

DDDD Change the file information.

Changing the user name

A Press [Change User Name].

The Change User Name screen
is displayed.

B Select the new user name.

The user names shown here are
names that were registered in
System Settings under the Ad-
ministrator tab. To enter a user
name not shown here, press
[Non-programed Name], and then
enter the user name.

C Press [OK].

The user name is changed.

Changing the file name

A Press [Change File Name].

The changing file name screen is
displayed.

B Enter the new file name.

Reference
For information about how
to enter characters, see the
General Settings Guide.

C Press [OK].

The file name is changed.
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Changing a password

A Press [Change Password].

B Enter the new password con-
sisting of four numbers.

C Press [OK].
The new password is stored.

Important
❒ Do not forget the password.

If you forget it, consult the
administrator in charge of
this machine.

EEEE Verify that the file information
change was made as desired, and
press [Exit].



8. Appendix
The Relationship between the Resolution 
and the Data Size

The relationship between the resolution and the data size is mutually contradictory.
When the resolution (dpi) is set to a high value, the scanning area becomes smaller.
Inversely, when the scanning area is set larger, the resolution becomes lower.
When the network delivery scanner, e-mail and document server are used, the
relationship between the scanning resolution and the data size is shown below.
If the data size is too large, the message “Exceeded max. data capacity. Check the
scanning resolution.” appears on the control panel of the machine. Specify the
scan size and resolution again.

Limitation
❒ Depending on the image compression level, the maximum image size will be

limited.

❖❖❖❖ When the “Text”, “Text/Photo”, or “Photo” is selected as the Scan Type
All combinations up to A3/11”x17” (297mm×432mm) and 600 dpi are possible.

❖❖❖❖ When “Gray Scale” is selected as the Scan Type
The possible scanning combinations corresponding to the amount of memory
installed are shown below.
❍: When equipped with 256MB total memory
✩: When equipped with 384MB total memory

100dpi 200dpi 300dpi 400dpi 600dpi

A3 ❍ ❍ ❍ ❍ ✩

B4 ❍ ❍ ❍ ❍ ✩

A4 ❍ ❍ ❍ ❍ ❍

B5 ❍ ❍ ❍ ❍ ❍

A5 ❍ ❍ ❍ ❍ ❍

B6 ❍ ❍ ❍ ❍ ❍

A6 ❍ ❍ ❍ ❍ ❍

A7 ❍ ❍ ❍ ❍ ❍

11x17 ❍ ❍ ❍ ❍ ✩

Legal(81/2x14) ❍ ❍ ❍ ❍ ❍

81/2x13 ❍ ❍ ❍ ❍ ❍

Letter(81/2x11) ❍ ❍ ❍ ❍ ❍

51/2x81/2 ❍ ❍ ❍ ❍ ❍
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❖❖❖❖ When Full Color “Text” or “Photo” is selected as the Scan Type
The possible scanning combinations corresponding to the amount of memory
installed are shown below.
❍: When equipped with 256MB total memory
✩: When equipped with 384MB total memory

100dpi 200dpi 300dpi 400dpi 600dpi

A3 ❍ ❍ ✩ ✩

B4 ❍ ❍ ❍ ✩

A4 ❍ ❍ ❍ ❍ ✩

B5 ❍ ❍ ❍ ❍ ✩

A5 ❍ ❍ ❍ ❍ ✩

B6 ❍ ❍ ❍ ❍ ❍

A6 ❍ ❍ ❍ ❍ ❍

A7 ❍ ❍ ❍ ❍ ❍

11x17 ❍ ❍ ✩ ✩

Legal (81/2x14) ❍ ❍ ❍ ✩

81/2x13 ❍ ❍ ❍ ✩

Letter (81/2x11) ❍ ❍ ❍ ❍ ✩

51/2x81/2 ❍ ❍ ❍ ❍ ✩
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Troubleshooting

This section contains advice on what to do if you have problems scanning an
original or if the network delivery scanner e-mail function do not work. Various
messages that may appear on the control panel or computer are listed, along
with causes and suitable countermeasures.

When Scanning Is Not Performed as Expected

Delivery Function Does Not Work

Status Possible Cause and Action

No image results from the scanning. The original was placed with the front and 
back reversed. Make sure that the original ori-
entation is correct. When placed directly on 
the exposure glass, the side to be scanned 
must face down. When fed via the ADF, the 
side to be scanned must face up. ⇒ p.43 “Set-
ting Originals”

The image is distorted or out of position. • The original was moved during scanning. 
Do not move the original during scanning.

• The original was not pressed flat against 
the exposure glass. Make sure that the 
original is pressed flat against the exposure 
glass.

The image is scanned upside down. The original was placed upside down. Place 
the original in the correct orientation.

The scanned image is dirty. The exposure glass or the exposure glass cover 
is dirty. Clean these parts. ⇒Copy Reference

Status Possible Cause and Action

The Delivery Scanner Function screen is not 
displayed.

• If the network TWAIN scanner screen ap-
pears when the machine is switched to 
scanner operation, press [Cancel] to switch 
to the network delivery scanner screen.

• If the display does not switch from net-
work TWAIN scanner to network delivery 
scanner, the network delivery Scanner Set-
tings are not correct. See p.18 “Default Set-
tings” and make the appropriate settings.
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When an Error Message Is Displayed on the Control Panel

Note
❒ If an error message that is not contained in this section appears, turn off the

main power switch of the machine, and then turn it on again. If the message
is still shown, note the content of the message and the error number (if listed
in the table), and contact your service representative. For information about
how to turn off the main power switch, see the General Settings Guide.

Message Possible Cause and Action

Cannot cancel sending certain file(s).

To confirm the result, check [Scanned 
Files Status].

Only files in waiting can be cancelled. Files with a deliv-
ery status of successful or resulted cannot be cancelled.

Cannot communicate with the deliv-
ery server. 

Check the server status.

No response from the delivery server. Possible causes 
are as follows:

• The delivery server is not running or has not started 
delivery service.

• “Delivery Server IP Address” is not set correctly in 
System Settings.

• The delivery server does not recognize the connect-
ed device. Register a connected device in “Set I/O 
Device” of ScanRouter V2 Administration Utility. 
⇒ScanRouter V2 Administration Utility Help

• The machine may not be correctly connected to the 
network. Check the LED indicators of the Ethernet 
board. ⇒General Settings Guide

Cannot communicate with SMTP 
server. Check the server status.

• Check whether this machine and the SMTP server 
are correctly connected to the network.

• The SMTP server is not running or is not in service.

• Check whether the setting of “Network” at the initial 
state is correct.

Cannot detect original size.

Select scan size.

Note
❒ These messages are shown alter-

nately

• Place the original correctly.

• Specify the scan size.

• When placing an original directly on the exposure 
glass, the opening/closing action of the ADF triggers 
the automatic original size detection process. Raise 
the ADF by more than 30 degrees.

Cannot find SMTP server. Check 
DNS or SMTP.

• Check whether this machine and the mail server are 
correctly connected to the network.

• The mail server is not running or is not in service.

• Check whether the “Network” setting for the initial 
system setup is correct.

Cannot select over 30 files at the 
same time.

To deliver more than 30 stored files, divide the files and 
perform the operation several times.

Cannot specify more than 100 desti-
nations.

When there are 100 or more destinations, split the desti-
nations into 2 or more groups for delivery.
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E-mail address entered is not correct. 
Please reenter.

Make sure the e-mail address is correct, and then enter 
it again.

Exceeded max. data capacity.

Check the scanning resolution then 
reset % original(s).

Specify the scan size and resolution again. Note that it 
may not be possible to scan very large originals. ⇒ p.91 
“The Relationship between the Resolution and the Data 
Size”

Exceeded max. E-mail size. Com-
plete scan has not been made.

Press [Send] to send the current 
scanned data, or press [Cancel & De-
lete].

The size of the e-mail exceeded the maximum size pos-
sible.

Reduce the volume of images and send it again.

Exceeded max. E-mail size. Sending 
E-mail has been cancelled.

Check [Max. E-mail Size] in Scanner 
Features.

• Increase the size of [Max. E-mail Size].

• Set [Divide & Send E-mail] to “On”.

Exceeded max. file capacity.

Delete the unnecessary stored files.

The maximum number of files that can be stored is 3000. 
Delete unneeded files.

Exceeded max. number of pages per 
file.

Do you want to store the scanned 
pages as 1 file?

The maximum number of pages per file is 500. Specify 
whether to use the data or not. Scan the pages that wer-
en’t scanned, and store them as a new file.

Exceeded max. number of search re-
sults which can be displayed.

Search again after changing the search conditions.

Exceeded max. page capacity per 
file.

The current scanned data will be 
sent.

Because the number of pages has reached the maximum 
number that can be sent,the data up to this point is sent. 
Scan the remaining pages after transmission.

Load paper of the following sizes.

Required: A3 B4 JIS A4 A4...

Load paper of the sizes listed in the message.

Load the following paper in Load paper in the tray indicated.

Memory is full.

Cannot scan.

Because of insufficient hard disk space, the first page 
could not be scanned. Try one of the following meas-
ures.

• Wait for a while and retry the scan operation.

• Reduce the scan area.

• Delete unneeded stored files.

Memory is full.

Delete the unnecessary stored files.

Note
❒ These messages are shown alter-

nately.

There is not enough free hard disk space. Delete un-
needed files.

Message Possible Cause and Action
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Memory is full. Scanning has been 
cancelled.

Do you want to store the scanned data?

Note
❒ These messages are shown alter-

nately.

Because there is not enough hard disk capacity in the 
machine, the page could only be partially scanned. 
Specify whether to use the data or not.

Memory is full.

Press [Send] to send the current 
scanned data, or press [Cancel] to de-
lete.

Because there is not enough free hard disk space in the 
machine, the page could only be partially scanned. 
Specify whether to use this data or not.

No HDD is available for this function. 
Cannot store. Set original and select 
the TWAIN settings from the PC.

Files can be scanned with TWAIN by switching to the 
network TWAIN scanner.

No sender is programmed for this 
number.

The short ID number that can be assigned to each sender 
is not programmed in the delivery server. Assign a cor-
rect number to each sender.

Output buffer is full. Sending the 
data has been cancelled. Please try 
again later.

Too many files are waiting to be delivered. Please try 
again after they have been delivered.

Password entered is not correct.

Try again.

Enter the password again.

Scanner is currently in use for anoth-
er function.

Cannot scan.

Note
❒ These messages are shown alter-

nately.

The machine is currently using the scanner for another 
function, such as copying. Retry the operation after the 
other function is completed.

Selected file is currently in use.

Cannot change file name.

The name of a file that is being edited with DeskTop-
Binder V2 Lite/Professional or that is in a waiting queue 
cannot be changed. Try the operation again after editing 
is finished or waiting is cancelled.

Selected file is currently in use.

Cannot change password.

The password of a file that is being edited with Desk-
TopBinder V2 Lite/Professional or that is in a waiting 
queue cannot be changed. Try the operation again after 
editing is finished or waiting is cancelled.

Selected file is currently in use.

Cannot change user name.

The user name of a file that is being edited with Desk-
TopBinder V2 Lite/Professional or that is in a waiting 
queue cannot be changed. Try the operation again after 
editing is finished or waiting is cancelled.

Selected file is currently in use.

Cannot delete it.

A file that is being edited with DeskTopBinder V2 
Lite/Professional or that is in a waiting queue cannot be 
deleted. Try the operation again after editing is finished 
or waiting is cancelled.

Message Possible Cause and Action
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Sender’s name is not selected.

Sending E-mail has been cancelled.

A sender’s name should be specified before sending e-
mail. Send e-mail after specifying the sender’s name.

Sending the data has been cancelled 
due to containing some deleted 
file(s).

Try again after checking the stored 
files.

Before sending the files, some files were deleted with 
DeskTopBinder V2 Lite/Professional. Perform the se-
lection process again and resend the files.

Sending the data has failed. Insuffi-
cient memory in the delivery server.

There is not enough free space on the hard disk of the 
delivery server. Free up the required amount.

Sending the data to SMTP server has 
failed. The data will be resent later.

A network error has occurred and a file was not sent 
correctly to the SMTP server. Wait until delivery is re-
tried automatically after the preset interval. If the deliv-
ery fails again, notify the network administrator.

Sending the data to SMTP server has 
failed.

To confirm the result, check [Scanned 
Files Status].

While sending a file to the SMTP server, a network error 
has occurred and the file could not be sent correctly. Try 
the operation once more.

If the message is still shown, the network may be crowd-
ed. Notify the network administrator.

If multiple files were sent, use the Delivery Files Status 
screen to check for which file the problem occurred. ⇒ 
p.64 “Checking the Status of Delivery”

⇒ p.76 “Checking the Status of E-mail”

Sending the data to the delivery serv-
er has failed.

To confirm the result, check [Scanned 
Files Status].

While sending a file to the delivery server, a network er-
ror has occurred and the file could not be sent correctly. 
Try the operation once more.

If the message is still shown, the network may be crowd-
ed. Notify the network administrator.

If multiple files were sent, use the Delivery Files Status 
screen to check for which file the problem occurred. ⇒ 
p.64 “Checking the Status of Delivery”

Sending the data to the delivery serv-
er has failed.

The data will be resent later.

A network error has occurred and a file was not sent 
correctly to the delivery server. Wait until delivery is re-
tried automatically after the preset interval. If the deliv-
ery fails again, notify the network administrator.

Specified SMTP server is not set cor-
rectly. Sending E-mail has been can-
celled.

Check whether the “Network” setting for the initial sys-
tem setup is correct.

The destination list has been updat-
ed.

Specified destination(s) or sender’s 
name has been cleared.

A specified destination or sender’s name was cleared 
when the destination list in the delivery server was up-
dated.

Specify the destination or sender’s name again.

The specified group contains some 
invalid destination(s).

Are you sure you want to select only 
valid destination(s)?

The group contains members whose e-mail addresses 
are not registered. Please check the e-mail addresses of 
the group and repeat the selection.

Message Possible Cause and Action
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When an Error Message Is Displayed on the Computer

This section describes main possible causes and actions for error messages dis-
played on the computer when the TWAIN driver is used.

Note
❒ If an error message that is not contained in this section appears, turn off the

main power switch of the machine, and then turn it on again. If the message
is still shown after scanning is executed again, note the content of the message
and the error number (if listed in the table), and contact your service repre-
sentative. For information about how to turn off the main power switch, see
“General Settings Guide”.

Updating the destination list. Please 
wait.

Specified destination(s) or sender’s 
name has been cleared.

If a destination or sender’s name was already selected, 
re-select it after this display is cleared.

Updating the destination list has failed.

Try again?

Check whether the delivery server has started opera-
tion.

Message Cause and Action

[Cannot connect to the scanner. Check the network 
Access Mask settings in User Tools.]

The access mask is set. Notify the network or 
scanner administrator.

[Cannot detect the paper size of the original. Specify 
the scanning size.]

• Place the original correctly.

• Specify the scan size.

• When placing an original directly on the 
exposure glass, the opening/closing action 
of the ADF triggers the automatic original 
size detection process. Raise the ADF by 
more than 30 degrees.

[Cannot find the scanner. Check if the scanner main 
power is on.]

Check whether the main power switch of the 
machine is turned off.

[Cannot find the scanner used for the previous scan. 
Another scanner will be used instead.]

Check whether the power switch of the previ-
ously used scanner is turned on. Reselect the 
scanner.

[Error has occurred in the scanner.] Check whether the scanning settings made 
with the application exceed the setting range 
of the machine.

[Error has occurred in the scanner driver.] • Check whether the network cable is con-
nected correctly to the computer.

• Check whether the Ethernet board of the 
computer is recognized correctly by Win-
dows.

• Check whether your computer can use the 
TCP/IP protocol.

Message Possible Cause and Action
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[Insufficient memory. Close all applications, then re-
start scanning.]

Close unnecessary applications running on 
the computer.

[Insufficient memory. Reduce the scanning area.] • Reset the scan size.

• Lower the resolution.

• Set with no compression. ⇒ p.24 “Making 
Scanner Settings”

Note
❒ The “The Relationship between the Reso-

lution and the Scanning Area” chart in 
Help for halftone scanning might not al-
ways apply. Scanning cannot be per-
formed if large values are set for brightness 
when using halftone or high resolution.

❒ When a paper misfeed occurs in the ma-
chine during printing, scanning cannot be 
performed. In this case, after the misfed pa-
per has been removed, proceed with scan-
ning.

[No response from the scanner.] • Check whether the machine is connected to 
the network correctly.

• The network is crowded. Reconnect after a 
while.

[No User Code is registered. Consult your system 
administrator.]

Access is restricted with user codes. Consult 
the system administrator of the machine.

[Please call your service representative.] An unrecoverable error has occurred in the 
machine. Call your service representative.

[Please wait] The machine is in warming up. Please wait. 
Automatic scanning will start soon.

[Scanner is in use for other function. Please wait.] A function of the machine other than the scan-
ner function is being used such as the copy 
function. Wait for a while and reconnect.

[Scanner is in use by other user. Please wait.] Another user is using the machine to scan 
originals. Wait for a while and reconnect.

[Scanner is not available. Check the scanner connec-
tion status.]

Check whether the machine is connected to 
the network correctly.

[Scanner is not ready. Check the scanner and the op-
tions.]

Check whether the ADF cover is closed.

[The name is already in use. Check the registered 
names]

You tried to register a name that is already in 
use. Use another name.

[The scanner power is off.] • Check whether the main power switch of 
the machine is turned on.

• Check whether the machine is connected to 
the network correctly.

Message Cause and Action
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Settings for SMTP Authentication and POP 
Authentication

This section explains all required settings for using SMTP Authentication and
POP Authentication.
• POP Authentication (POP before SMTP)

This function prevents others from connecting to the SMTP server inappro-
priately by connecting to the POP server to authenticate the user before e-mail
is sent.

• SMTP Authentication (PLAIN, LOGIN, CRAM-MD5 *1 )
This function prevents others from connecting to the SMTP server inappro-
priately by requiring that the SMTP User Name and SMTP Password be en-
tered to authenticate the user when e-mail is sent.

❖❖❖❖ Setting item using the control panel
For information about this item and how to make settings for this item, see
General Settings Guide.

❖❖❖❖ Setting items using the Web browser
For information about making settings from a Web browser, see p.31 “Mak-
ing E-mail Settings” .

Items Explanation Default

System Settings Key Operator 
Tools

Key Operator's E-
mail Address

• This e-mail 
address is 
used for 
SMTP Au-
thentication. 
When using 
SMTP Au-
thentication, 
you must 
register this 
e-mail ad-
dress.

-

Items Explanation Defaut

Configura-
tion

SMTP E-mail 
Transmission

SMTP Server 
Name

• Up to 127 letters or digits 
can be used. Spaces can-
not be used.

-

SMTP Port 
No.

• Numbers from 1 to 65535 
are available. 25

SMTP Au-
thentication

• When using SMTP Au-
thentication, set to [Ena-
ble].

Disable
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SMTP User 
Name

• Enter the name which is 
registered in Key Opera-
tor’s E-mail Address for 
SMTP sending.

• Up to 191 letters or digits 
can be used. Spaces can-
not be used.

• Some SMTP servers re-
quire the specification of a 
realm. In this case, enter 
the user name like this: 
”SMTP User Name @ 
realm”.

-

SMTP Pass-
word

• Enter the password which 
is registered in Key Oper-
ator’ E-mail Address for 
SMTP sending.

• Up to 63 letters or digits 
can be used. Spaces can-
not be used.

-

SMTP Auth. 
Encryption

• [Auto Select]: Authentica-
tion by PLAIN, LOGIN, 
or CRAM-MD5 *1 

• [Disable]: Authentication 
by PLAIN or LOGIN.

• [Enable]: Authentication 
by CRAM-MD5 *1 

Auto Select

POP before 
SMTP

• When using POP Authen-
tication, set to [Enable].

Disable

POP Server 
Name

• Up to 127 letters or digits 
can be used. Spaces can-
not be used.

-

POP Port No. • Numbers from 1 to 65535 
are available.

110

POP User 
Name

• Up to 63 letters or digits 
can be used. Spaces can-
not be used.

-

POP Pass-
word

• Up to 63 letters or digits 
can be used. Spaces can-
not be used.

-

Items Explanation Defaut
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Note
❒ When the message “Cannot communicate with SMTP server. Check the serv-

er status.“ is displayed, check whether SMTP User Name and SMTP Pass-
word are correct and whether PLAIN, LOGIN, or CRAM-MD5 *1  is selected
as the method of authentication.

❒ Even when you specify a sender name with SMTP authentication, a the Key
Operator’s name will appear in the “from“ field of the e-mail when the e-mail
is received.

❒ When you specify a sender name with SMTP authentication, a reply mail
from the receiver will be sent to the sender. If an error has occurred in the mail
server because of entering wrong addresses etc., a reply mail notifying of the
error will be sent to the address set in Key Operator’s E-mail Address.

*1 RSA Data Security, Inc. MD5 Message-Digest Algorithm
Copyright© 1991-2, RSA Data Security, Inc. Created 1991. All rights reserved.
License to copy and use this software is granted provided that it is identified as
the “RSA Data Security, Inc. MD5 Message-Digest Algorithm“ in all material
mentioning or referencing this software or this function.
License is also granted to make and use derivative works provided that such
works are identified as “derived from the RSA Data Security, Inc. MD5 Message-
Digest Algorithm“ in all material mentioning or referencing the derived work.
RSA Data Security, Inc. makes no representations concerning either the mer-
chantability of this software or the suitability of this software for any particular
purpose. It is provided “as is“ without express or implied warranty of any kind.
These notices must be retained in any copies of any part of this documentation
and/or software.

POP Auth. 
Encryption

• [Auto Select]:Automatical-
ly decides whether or not 
to encrypt POP Password 
according to POP server 
settings.

• [Disable]: POP Password is 
not encrypted.

• [Enable]: POP Password is 
encrypted.

Auto Select

Timeout set-
ting after 
POP Auth.

• Values from 0 to 10000 
milli-seconds are availa-
ble.

300

Items Explanation Defaut
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Specifications

Scan method Flat bed scanning

Image sensor type CCD Image Sensor

Scan type Sheet, book

Interface Ethernet interface (10BASE-T or 100BASE-
TX), IEEE 1394(option), Wireless LAN(option)

Maximum scan size A3/11”x17” (297mm×432mm)

Scan density 600dpi

Variable range of scan resolution • When used as a network TWAIN scanner
Setting range: 100dpi - 1200dpi

• When used as a network delivery scanner 
or for sending e-mail
Setting range: 100dpi, 200dpi, 300dpi, 
400dpi, 600dpi
103
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Automatic tilt correction,   54
Auto Run program,   33

C

Checking the Status of Delivery,   64
Compression (Black & White),   25
Compression (Gray Scale/Full Color),   25

D

Default settings,   18
DeskTopBinder V2 Lite,   37, 39, 51
Destination List Priority,   25
Display,   11
Display Contents

E-mail,   13
Network Delivery Scanner,   13
Network TWAIN Scanner,   13

Divide & Send Scan to E-mail,   25
Document Server,   10

E

E-mail,   9
E-mail Information Language,   26

F

File Type Priority,   27
Function keys,   12

I

Image density,   21
Initial scanner setup,   18
Installing Software,   33

J

Job Reset Time in Adding Original,   26

L

List displays
Delivery,   55
Stored,   84

M

Main power indicator, power indicator,   11
Making E-mail Settings,   31
Max. E-mail Size,   25
Mixed original sizes priority,   26
Mode,   53

N

Network delivery scanner,   8
network TWAIN scanner,   7
Number keys,   12

O

Operation switch,   11
Original orientation and scan area setting,   47
Original orientation priority,   26
Original setting,   26

P

Placing the original in the Automatic 
Document Feeder (ADF),   45

Placing the original on the exposure glass,   44
Preparations

E-mail,   17
Network Delivery Scanner,   16
Network TWAIN Scanner,   15

Preview,   53
Print & Delete Scanner Journal,   27
Printing to the image,   54

R

Resolution,   21



S

Save,   54
Scanning mode registration,   54
Scanning originals,   52
ScanRouter V2 Lite,   40
Scan size,   21
Scan type,   20
Selecting a custom size,   22
Select Title,   27
Senders Name Default,   25
Send/Store connection timeout,   24
Setting Scanner Features,   20
Software supplied on CD-ROM,   38
Status indicators,   12
Store data,   79
Stored files

Changing file information,   89
Delete,   88
Delivering,   66
Search,   87
Sending,   78

Switch to Batch,   27

T

The {Check Modes}}}} key,   11
The {Clear Modes}}}} key,   11
The {Clear/Stop}}}} key,   12
The {Energy Saver}}}} key,   11
The {#}}}} Enter key,   12
The relationship between the resolution 

and the data size,   91
The {Start}}}} key,   12
The {User Tools/Counter}}}} key,   11
Troubleshooting,   93
Type1232 TWAIN Driver,   38

U

Update Delivery Scanner Destination List,   25

V

Viewing a list of stored files in 
DeskTopBinder V2 Lite,   86
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In accordance with IEC 60417, this machine uses the following symbols for the main power switch:

aaaa means POWER ON.

bbbb means POWER OFF.

cccc means STAND BY.

Note to users in the United States of America

 

Notice:

This equipment has been tested and found to comply with the limits for a Class A digital devices, pur-
suant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance
with the instruction manual, might cause harmful interference to radio communications. Operation of
this equipment in a residential area is likely to cause harmful interference in which case the user will be
required to correct the interference at his own expense.

Warning

Changes or modifications not expressly approved by the party responsible for compliance could void
the user’s authority to operate the equipment.

Note to users in Canada

 

Warning:

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equip-
ment Regulations.

Remarque concernant les utilisateurs au Canada

 

Avertissement:

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel
brouilleur du Canada.

Caution (in case of 100BASE-TX environment):

Network interface cable with ferrite core must be used for RF interference suppression.

Declaration of Conformity

Product Name: Printer/Scanner Kit

Model Number: Type 1232

Responsible party: Ricoh Corporation

Address: 5 Dedrick Place, West Caldwell, NJ 07006

Telephone number: 973-882-2000

This device complies with part 15 of FCC Rules.

Operation is subject to the following two conditions:

1. This device may not cause harmful interference, and

2. this device must accept any interference received,

including interference that may cause undesired operation.
Copyright © 2002
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FAX Option Type 1232

Operating Instructions

Facsimile Reference (option)
<Basic Features>

Getting Started

Faxing

Registering

Troubleshooting
For safe and correct use of this machine, please be sure to read the Safety Information in the
General Settings Guide before you use it.



Introduction

This manual describes detailed instructions on the operation and notes about the use of this machine.
To get maximum versatility from this machine all operators are requested to read this manual carefully
and follow the instructions. Please keep this manual in a handy place near the machine.

Notes

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.

Two kinds of size notation are employed in this manual. With this machine refer to the inch version.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.
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NOTICE

Note to users in the United States of America

----Notice:
This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential in-
stallation. This equipment generates, uses and can radiate radio frequency ener-
gy and, if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no guarantee
that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be deter-
mined by turning the equipment off and on, the user is encouraged to try to cor-
rect the interference by one more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which

the receiver is connected.
• Consult the dealer or an experienced radio /TV technician for help.

----Warning
Changes or modifications not expressly approved by the party responsible for
compliance could void the user's authority to operate the equipment.
1



2

----Notice about the Telephone Consumer Protection Act (Valid in USA 
only).

The Telephone Consumer Protection Act of 1991 among other things makes it
unlawful for any person to send any message via a telephone fax machine unless
such message clearly contains in a margin at the top or bottom of each transmit-
ted page or on the first page of the transmission, the date and time it is sent and
an identification of the business, other entity, or other individual sending the
message and the telephone number of the sending machine or such business,
other entity or individual. This information is transmitted with your document
by the TTI (Transmit Terminal Identification) feature. In order for you to meet
the requirement, your machine must be programmed by following the instruc-
tions in the accompanying Operation Manual. In particular, please refer to the
chapter of Installation. Also refer to the TTI (Transmit Terminal Identification)
programming procedure to enter the business identification and telephone
number of the terminal or business. Do not forget to set the date and time.
Thank you.

Note to users in Canada

----Note:
This Class B digital apparatus complies with Canadian ICES-003.

Remarque concernant les utilisateurs au Canada

----Avertissement:
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Can-
ada.

----Notice:
This equipment meets the applicable Industry Canada Terminal Equipment
Technical Specifications. This is confirmed by the registration number. The ab-
breviation, IC, before the registration number signifies that registration was per-
formed based on a Declaration of Conformity indicating that Industry Canada
technical specifications were met. It dose not imply that Industry Canada ap-
proved the equipment.



Important Safety Instructions

Caution

When using your telephone equipment, basic safety precautions should always
be followed to reduce the risk of fire, electric shock and injury to persons, includ-
ing the following: 
• Do not use this product near water, for example, near a bathtub, wash bowl,

kitchen sink or laundry tub, in a wet basement or near a swimming pool.
• Avoid using a telephone during an electrical storm. There may be a remote

risk of electric shock from lightning.
• Do not use a telephone in the vicinity of a gas leak to report the leak.
• Use only the power cord and batteries indicated in this manual. Do not dis-

pose of batteries in a fire. They may explode. Check with local codes for pos-
sible special disposal instructions.

Save these instructions.
 
IMPORTANTES MESURES DE SÉCURITÉ
Certalnes mesures de sécurité doivent être prises pendant l’utilisation de matéri-
al téléphonique afin de réduire les risques d’incendle, de choc électrique et de
blessures. En voici quelquesunes: 
• Ne pas utiliser l’appareil près de l’eau, p.ex., près d’une balgnoire, d’un lava-

bo, d’un évier de cuisine, d’un bac à laver, dans un sous-sol humide ou près
d’une piscine.

• Éviter d’utiliser le téléphone (sauf s’il s’agit d’un apparell sans fil) pendant un
orage électrique. Ceci peut présenter un risque de choc électrique causé par la
foudre.

• Ne pas utiliser l’appareil téléphonique pour signaler une fulte de gaz s’il est
situé près de la fuite.

• Utiliser seulement le cordon d’alimentation et le type de piles indiqués dans
ce manual. Ne pas jeter les piles dans le feu: elles peuvent exploser. Se con-
former aux ègrlements pertinents quant à l’élimination des piles.

Conserver ces instructions.
3
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:
This symbol indicates a potentially hazardous situation that might result in
death or serious injury when you misuse the machine without following the in-
structions under this symbol. Be sure to read the instructions, all of which are in-
cluded in “Safety Information” in the General Settings Guide.

R CAUTION:
This symbol indicates a potentially hazardous situation that might result in mi-
nor or moderate injury or property damage that does not involve personal injury
when you misuse the machine without following the instructions under this
symbol. Be sure to read the instructions, all of which are included in “Safety In-
formation” in the General Settings Guide.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates information or preparations required prior to operating.

Note
This symbol indicates precautions for operation, or actions to take after abnor-
mal operation.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys that appear on the machine's panel display.

[ ]
Keys and buttons that appear on the computer's display.

{ }
Keys built into the machine's control panel.



Notice

B4 JISKL, B5 JISKL, B6 JISL are referred to as B4KL, B5KL, B6L in this
manual.
5
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Manuals for Facsimile Mode

Two Facsimile Reference manuals are provided, the Basic Features manual and
the Advanced Features manual. Please refer to the manual that suits your needs.

Basic Features (this manual)

The Basic Features manual explains the most frequently used fax functions and
operations.

Advanced Features

The Advanced Features manual describes more advanced functions and also ex-
plains settings for key operators.

❖❖❖❖ Chapter 1 Transmission Mode
Explains how to send a fax at a specific time without being by the machine
and also take advantage of off-peak telephone line charges.

❖❖❖❖ Chapter 2 Checking and Canceling Transmission Files
Explains how to cancel a transmission and resend a message when it fails to
be transmitted.

❖❖❖❖ Chapter 3 Communication Information
Explains how to erase a fax message programmed in memory and check the
contents of any file in memory.

❖❖❖❖ Chapter 4 Other Transmission Features
Explains the useful transmission functions. Learn how to dial numbers easily.

❖❖❖❖ Chapter 5 Reception Features
Explains how to receive fax messages. You can learn the various functions for
easily receiving faxes, as well as functions for accurately receiving faxes, such
as printing received two page originals onto one sheet, and automatically
switching between facsimile and telephone when a call comes in.

❖❖❖❖ Chapter 6 Simplifying the Operation
Explains how to specify a Program and use the Document Server.

❖❖❖❖ Chapter 7 Facsimile Features
Explains functions for printing lists and various types of reports, as well as set
functions when sending and receiving faxes.

Instructions for the optional ISDN Unit (ISDN Option Type 1232) and the Extra G3 Interface 
Unit (G3 Interface Unit Type 1232) are included in the Basic Features and Advanced Features 
manuals.



❖❖❖❖ Chapter 8 Key Operator Setting
Explains functions which the key operator handles. Learn how to setup the
phone line type and how to store the Memory Locked ID and the Confidential
ID.

❖❖❖❖ Chapter 9 LAN FAX Features
Explains how to fax directly from a computer and make necessary settings.

❖❖❖❖ Chapter 10 Solving Operation Problems
Explains what to do when toner runs out and when power is turned off or
fails.

❖❖❖❖ Chapter 11 Appendix
You can check the consumables and options for facsimile functions.
7
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1. Getting Started
Control Panel

The illustration of the control panel will differ depending on the installed op-
tional unit. The following illustration has all the options installed.

1. {{{{User Tools/Counter/Inquiry}}}} key
User Tools:
Press to enter User Tools mode. These
tools allow you to customize the default
settings. See p.92 “Accessing the User
Tools”, Facsimile Reference (option) <Ad-
vanced Features> .
Counter:
Displays and prints the total number of
copied or printed pages.
Inquiry:
Gives your service representative infor-
mation when the machine needs servic-
ing or a new toner cartridge.

2. Receive File Indicator
Lights when a message other than a Con-
fidential Reception or Memory Lock file
has been received. See p.64 “Substitute
Reception”, Facsimile Reference (option)
<Advanced Features> .

3. Communicating Indicator
Lights during transmission or reception.

4. Confidential File Indicator
Lights when a message has been received
into memory with Confidential Recep-
tion. See p.24 “Printing a Confidential
Message”, Facsimile Reference (option)
<Advanced Features> .
Blinks when a Memory Lock file has been
received into memory. See p.26 “Printing
a File Received with Memory Lock”, Fac-
simile Reference (option) <Advanced Fea-
tures> .

5. LCD display
This guides you through tasks and in-
forms you of the machine status. Messag-
es appear here. 

6. {{{{Start Manual RX}}}} key
Press when using fax-on-demand servic-
es, or when Reception Mode is set to
Manual Reception.

7. {{{{Check Modes}}}} key
Press this key before pressing the {{{{Start}}}}
key to check the settings selected for the
fax about to be sent.
9
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8. {{{{Program}}}} key
Enables you to program frequently used
settings and recall the programmed set-
tings. See p.81 “Simplifying the Opera-
t ion” ,  Facs imi l e  Re f erence  (op t ion )
<Advanced Features> .

9. {{{{Clear Modes}}}} key
Press to cancel the current settings.

10. Operation Switch
Press this switch to turn the power on
(the On indicator lights up). To turn the
power off, press this switch again (the On
indicator goes off). See p.149 “Power Fail-
ure Report”, Facsimile Reference (option)
<Advanced Features> .

11. Main Power indicator
This indicator goes on when the main
power switch is turned on.

12. On indicator
This indicator goes on when the opera-
tion switch is turned on.

13. {{{{Facsimile}}}} key
Press to switch to the Facsimile mode.

• Lights up in yellow
Facsimile mode has been selected.

• Lights up in green
Facsimile mode has been printing.

• Lights up in red
Lights up whenever any facsimile er-
ror occurs. Press the {{{{Facsimile}}}} key to
display the error message and take the
appropriate action.

14. {{{{On Hook Dial}}}} key
Press when the manual facsimile recep-
tion is set, or using the facsimile informa-
tion services.

15. {{{{Pause/Redial}}}} key
Pause:
Insert a pause when you are dialing or
storing a fax number. A pause cannot be
inserted as the first digit.
Redial:
Press to redial one of the last ten num-
bers. See p.33 “Redial”, Facsimile Refer-
ence (option) <Advanced Features> .

16. {{{{Tone}}}} key
Press to send tonal signals down a pulse
dialing line.

17. Number keys
Use to dial fax numbers or enter the
number of copies.

18. {{{{#}}}} key (Enter key)
Registers entered numbers or settings.

19. {{{{Clear/Stop}}}} key
Clear:
Cancels entered numbers.
Stop:
Interrupts the current operation (trans-
mission, scanning, copying or printing).

20. {{{{Start}}}} key
Press to start faxing, scanning, copying or
printing.
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Reading the Display

The display tells you the machine status, messages and guides you through op-
erations.

Note
❒ Functions that have been selected are highlighted (for example ).

Keys that you cannot select are shown with a dashed outline (for example
).

❒ All procedures in this manual assume you are in Facsimile mode. If the ma-
chine is not in Facsimile mode, press the {{{{Facsimile}}}} key to change to Facsim-
ile mode. You can have the machine start in Facsimile mode. See “General
Features“ in the General Settings Guide.

❒ This machine automatically returns to the standby mode if you do not use the
machine for a certain period of time. You can select the period in Fax Reset
Timer. See “Timer Setting“ in the General Settings Guide.

Reading the Display Panel and Using Keys

The display contents will be different depending on the installed optional unit.

1. Displays the scanning conditions
and sizes you can choose.

2. Displays the date and time, the
name and facsimile number of a des-
tination when transmitting, and the
size of the original.

3. Displays the entered number of a
destination. When adding destina-
tions with the number keys, press
[Add].

4. Displays messages and the ma-
chine status.
11
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5. Press to display various informa-
tion about transmission.

6. Appears when a destination is en-
tered. Press [Clear] or the {{{{Clear/Stop}}}}
key to erase characters or numbers
one by one.

7. Switches the transmission mode
between Memory Transmission and
Immediate Transmission.

8. Displays Quick Operation Keys
set for often used functions. [TX sta-
tus display] and [Dest. Management] are
preset.

9. Displays various functions for
transmitting.

10. Displays the Quick Dial Table
of programmed destinations.

Standby Display

While the machine is in standby mode (immediately after the {{{{Facsimile}}}} key is
pressed or after the {{{{Clear Modes}}}} key is pressed), the following display is
shown. 

❖❖❖❖ Initial display

Note
❒ To return the machine to standby mode, do one of the following:

• If you have placed the original on the optional Document Feeder (ADF)
and have not pressed the {{{{Start}}}} key, remove the original.

• If you have not placed an original, press the {{{{Clear Modes}}}} key.
• If you are in User Tools mode, press the {{{{User Tools/Counter/Inquiry}}}} key.
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Communication Display

While the machine is communicating, the status is displayed.

❖❖❖❖ Memory Transmission

❖❖❖❖ Reception

Note
❒ Even when the machine is using memory to fax a message or receive a mes-

sage, you can still scan the next original into memory. See p.59 “Dual Access”,
Facsimile Reference (option) <Advanced Features> .

❒ Even when the machine is being used as a copier, printer or scanner, the send-
er's name or number will be displayed for received faxes.

❖❖❖❖ Immediate Transmission
13
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2. Faxing
Placing Originals

You can place your originals either in
the optional Document Feeder (ADF)
or on the exposure glass. Some types
of originals are unsuitable for the op-
tional Document Feeder (ADF) so
they must be placed on the exposure
glass.
Which way you place your original
depends on its size and whether you
are using the optional Document
Feeder (ADF) or the exposure glass.
See p.20 “Original sizes difficult to
detect”.

Limitation
❒ If you place A5 size documents on

the exposure glass, they will not be
detected.  A5 size documents
placed in the optional Document
Feeder (ADF) are sent as A4 size.

Note
❒ When sending a fax, the image

output at the other end depends on
the size and direction of paper
used in the destination's terminal.
If the destination does not use pa-
per of the same size and direction
as that of the original, the fax im-
age may be  reduced in  s ize ,
trimmed at both edges, or divided
into two or more sheets. When
sending an important original, we
recommend that you ask the re-
ceiver about the size and direction
of the paper used in their terminal.

❒ When sending an original of an ir-
regular (i.e. non-standard) size or
part of a large original, you can
specify the scan area precisely. See
p.18 “Setting a Scan Area”.

❒ You can scan non-standard sized
documents as standard sized doc-
uments with the Irregular Scan
Area function. When you turn on
this function, the area scanned will
be in the specified range regardless
of the actual document size. A
blank margin will appear or the
image will be cut at the receiving
end.

❒ If you place an A4 size original in
the portrait direction, the machine
rotates the image by 90 degrees be-
fore sending it. See p.59 “Trans-
mission with Image Rotation”,
Facsimile Reference (option) <Ad-
vanced Features> .

❒ You can send the first pages from
the exposure glass then the re-
maining pages from the optional
Document Feeder (ADF). After
you have removed the last page
from the exposure glass, insert the
remaining pages in the optional
Document Feeder (ADF), then
press the {{{{Start}}}} key.

Reference
For how to place 2-sided documents,
see p.46 “2-Sided Transmission
(Double-Sided Transmission)”,
Facsimile Reference (option) <Ad-
vanced Features> .
15



Faxing

16

2

----How to place A4, B4, A3, 8 1/2" 
x 11", 11" x 14", and 11" x 17" 
size originals

Note
❒ When you place originals in the

optional Document Feeder (ADF)
as shown in the above illustration,
the Fax Header will be printed on
the received faxes at the destina-
tion as follows:
• *1 On the top of the fax
• *2 On the left side of the fax

----How to place A4, A5 and B5 
size originals

Limitation
❒ A5 size documents are not detect-

ed on the exposure glass. Place A5
size documents in the optional
Document Feeder (ADF).

Note
❒ When you place originals on the

optional Document Feeder (ADF)
as shown in the above illustration,
the Fax Header will be printed on
the received faxes at the destina-
tion as follows:
• *1 On the top of the fax
• *2 On the left side of the fax
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Placing a Single Original on 
the Exposure Glass

Place originals that cannot be placed
in the optional Document Feeder
(ADF), such as a book, on the expo-
sure glass one page at a time.

AAAA Lift the exposure glass cover or
the optional Document Feeder
(ADF) by at least 30 degrees. Place
the original face down on the ex-
posure glass. The original should
be aligned to the left scale.

1. Reference mark

2. Scale

BBBB Close the optional Document
Feeder (ADF). 

Note
❒ When setting a bound original,

the received image may contain
some black areas. To reduce this
effect, hold down the original to
prevent its bound part from ris-
ing. 

Bound original page order

When setting bound originals (books,
magazines, etc.), you can choose to
have either the left page or right page
sent first. See p.45 “Book Fax”, Fac-
simile Reference (option) <Advanced
Features> .

Note
❒ You can choose whether the left

page or right page is sent first. See
p.113 “Changing the User Parame-
ters”, Facsimile Reference (option)
<Advanced Features>  (Swich14,
Bit1).

Placing Originals in the 
Optional Document Feeder 
(ADF)

Use the optional Document Feeder
(ADF) to scan in a stack of originals in
one operation. The optional Docu-
ment Feeder (ADF) can handle both
single-sided and double-sided origi-
nals.

Limitation
❒ Place all the originals to be sent in

a single stack. 
❒ You cannot place originals in the

optional Document Feeder (ADF)
one page at a time or in sheaves.

Note
❒ The maximum document length is

1200 mm (47").
❒ If you send documents longer than

420 mm (17"), select Long Docu-
ment mode with the User Parame-
ters. If a jam occurs, the document
might be damaged because scan-
ning will not stop. See p.18 “Set-
t ing a Scan Area” .  See p.113
“Changing the User Parameters”,
Facsimile Reference (option) <Ad-
vanced Features>  (Swich14, Bit1).

❒ Documents longer than 432 mm
(17") must be sent by memory
transmission (immediate transmis-
sion is not possible).

❒ If an original jams, press the
{{{{Clear/Stop}}}} key then remove the
original carefully. 
17
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❒ Place thin originals on the expo-
sure glass. 

❒ You can check information about
the sizes and number of originals
that can be placed in the optional
Document Feeder (ADF) with “Ac-
ceptable types of Originals“. See
p.161 “Optional Document Feeder
(ADF)”, Facsimile Reference (option)
<Advanced Features> .

AAAA Adjust the document guide to
match the size of your originals.
Align the edges of your originals
and stack them in the optional
Document Feeder (ADF) face up.

1. Limit mark

2. Document guide

Originals unsuitable for the Optional 
Document Feeder (ADF)

Do not place the following types of
originals in the optional Document
Feeder (ADF) because they may be
damaged. Place them on the exposure
glass instead.
• Originals containing staples or clips
• Perforated or torn originals
• Curled, folded, or creased originals
• Pasted originals
• Originals with any kind of coating,

such as thermosensitive paper, art
paper, aluminum foil, carbon pa-
per, or conductive paper

• Originals with index tabs, tags, or
other projecting parts 

• Sticky originals, such as translu-
cent paper

• Thin and soft originals
• Originals of inappropriate weight
• Originals in bound form, such as

books
• Transparent originals, such as OHP

transparencies or translucent paper

Setting a Scan Area

Normally, the area of a placed docu-
ment is scanned automatically. If a
scan area is specified, the document is
scanned accordingly. Thus, docu-
ments can be sent without extra space
or blank margins. 

❖❖❖❖ Auto Detect
The area of a placed document is
scanned automatically.

Note
❒ If the machine cannot detect the

original size, the confirmation dis-
play is shown. Replace the origi-
nal and make the copy again.

❖❖❖❖ Regular
The placed document is scanned
according to the specified size re-
gardless of its actual size.
The sizes that can be specified are
A4KL, B4L , A3L, 8 1/2" x
11"KL, 11" x 14"L, and 11" x
17"L.

❖❖❖❖ Area
Enter the area to be scanned. The
placed document is scanned ac-
cording to the entered size regard-
less of its actual size. See p.99
“Programming and Changing a
Scan Size”, Facsimile Reference (op-
tion) <Advanced Features> .
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AAAA Place the originals, and select any
scan settings you require.

Note
❒ When placing different size

originals into the optional Doc-
ument Feeder (ADF), adjust the
document guide to the largest
original.

❒ Small originals may be sent at a
slight slant since they do not
match the document guide.

BBBB Press [Scan Area].

The Scan Area menu is shown.

CCCC Select the scan area.

Specifying standard sizes

A Press [Regular].

B Press the size of the originals
to be sent, and then press [OK].

Note
❒ To cancel the specified stand-

ard size, press [Cancel]. The
display appears as in step B.

C Press [OK].
[Regular] is highlighted on the
display and the size is shown
above this.

Specifying programmed sizes

A Press [Area 1] or [Area 2], and
then press [OK].

 [Area 1] or [Area 2] is highlighted
on the display the scan area is
shown above this.

Note
❒ To cancel the set pro-

grammed size, press [Cancel].
The menu returns to that of
step B. 

DDDD Dial a destination and press the
{{{{Start}}}} key.
19
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Original sizes difficult to detect

The machine finds it difficult to detect the size of the following kinds of origi-
nals. If this happens, the receiving machine may not select print paper of the cor-
rect size.
• Documents placed on the exposure glass of sizes other than those listed in the

table below
• Originals with index tabs, tags, or projecting parts
• Transparent originals, such as OHP transparencies or translucent paper
• Dark originals with many characters or drawings
• Originals which partially contain solid printing
• Originals which have solid printing at their edges
• Slippery originals
• Originals in bound form of more than 10mm (0.3") thick such as books
The following paper sizes are automatically detected in Facsimile mode.

❖❖❖❖ Metric Version

❖❖❖❖ Inch Version

Ο - Auto detect
× - Unable to auto detect

Paper Size

Where Original is placed

A3LLLL 8 1/2"××××13" 
(F4)

B4LLLL A4KKKKLLLL B5KKKKLLLL A5KKKKLLLL

Exposure Glass Ο Ο Ο Ο Ο ×

Optional Document 
Feeder (ADF) Ο Ο Ο Ο Ο Ο

Paper Size

Where Original is Placed

11"××××17"LLLL 8 1/2"××××14"LLLL 8 1/2"××××11"KKKKLLLL 5 1/2"××××8 1/2"KKKKLLLL

Exposure Glass Ο Ο Ο ×

Optional Document 
Feeder (ADF)

Ο Ο Ο Ο



Memory Transmission

2

Memory Transmission

In Memory Transmission mode, after
you press the {{{{Start}}}} key, the machine
does not dial the destination until all
pages of your fax message have been
scanned into memory (in contrast
with Immediate Transmission, where
the number is dialed first and pages
are scanned and sent one by one). 
Memory Transmission is useful be-
cause:
• You can take your original away

from the machine without having
to wait too long.

• While your message is being sent,
other people can operate the ma-
chine.

• You can send the same message to
more than one place in a single op-
eration (Broadcasting).

Important
❒ If there is a power failure (main

power switch is off) or the plug is
pulled out for more than 1 hour, all
the documents programmed in
memory are deleted. As soon as
the main power switch is turned
on, the Power Failure Report is
printed to help you identify delet-
ed files. If you turn just the opera-
tion switch off, documents are not
deleted. See p.149 “Power Failure
Report”, Facsimile Reference (option)
<Advanced Features> .

Limitation
❒ If memory is full (0% appears on

the display), Memory Transmis-
sion is disabled. Use Immediate
Transmission instead.

Note
❒ Maximum number of destinations

per Memory Transmission: 500 
❒ Combined total number of desti-

nations that can be programmed:
500 (2,000 with the optional Fax
Function Upgrade Unit).

❒ The theoretical maximum number
of destinations you can enter with
the number keys is 100 (1,000 with
the optional Fax Function Upgrade
Unit), but this will depend on the
amount of memory currently
available. See p.33 “Restrictions
when dialing with the number
keys”.

❒ The number of pages that you can
store in memory depends on the
original images and the scan set-
tings. You can store up to 160
standard pages (ITU-T #1 chart,
Resolution: Standard, Original
Type: Text). 

❒ The maximum total number of
d o c u m e n t s  th a t  c an  b e  p r o -
grammed in memory is as follows:
• About 1,000 pages with only the

optional Expansion Memory in-
stalled 

• About 2,080 pages with both the
optional Expansion Memory
and Fax Function Upgrade Unit
installed

❒ The number of programs that you
can store is 400. You can store 800
programs with the optional Fax
Function Upgrade Unit.
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❒ You can set whether the machine
will return to the default transmis-
sion mode (Memory Transmission
or Immediate Transmission) after
every transmission.  You can
change this so that the desired set-
ting is maintained. See p.102 “Gen-
e r a l  S e t t i n g s / A d j u s t m e n t” ,
Facsimile Reference (option) <Ad-
vanced Features> .

AAAA Make sure that Memory Trans-
mission is selected. 

If it is not, press [Memory TX].

BBBB Place the original.

Note
❒ Note that you cannot place pag-

es on the exposure glass after
you have started using the op-
tional Document Feeder (ADF).

❒ You can send the first pages
from the exposure glass then the
remaining pages from the op-
tional Document Feeder (ADF).
After you remove the last page
from the exposure glass, you
have 60 seconds to insert the re-
maining pages in the optional
Document Feeder (ADF). 

❒ To store multiple page originals
from the exposure glass, place
them page by page.

❒ The original can be placed in ei-
ther the optional Document
Feeder (ADF) or exposure glass
until the {{{{Start}}}} key is pressed.

Reference
See p.15 “Placing Originals”.

CCCC Make the necessary settings you
require. 

Reference
See p.29 “Scan Settings”.

DDDD Dial a destination.

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key,
and then enter  the correct
number.

Reference
See p.33 “Dialing”.
See p.35 “Quick Dials”.
See p.36 “Groups”.
See p.33 “Chain Dial”, Facsimile
Reference (option) <Advanced Fea-
tures> .
See p.33 “Redial”, Facsimile Ref-
erence (option) <Advanced Fea-
tures> .
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EEEE When sending the same orignal to
several destinations (broadcast-
ing), press [Add] to specify the
destinations.

Note
❒ You do not have to press [Add]

when adding a destination to
the address list using Group Di-
al.

❒ If you do not want to do a
broadcast transmission, pro-
ceed to step F.

❒ Repeat this step to specify a dif-
ferent destination.

FFFF Press the {{{{Start}}}} key.

After scanning, the machine will
return to standby mode.

Sending originals from the 
exposure glass

A Place the first page of your
original on the exposure glass
face down.

B Dial a destination.
C Make any scan settings you re-

quire.
D Press the {{{{Start}}}} key.

The machine starts scanning the
original.

E Place the next original on the
exposure glass within 60 sec-
onds after the machine has fin-
i s h e d  s ca n n i n g  t h e  f i r s t
original.

Note
❒ Repeat steps C to E for all

originals.
F Place the last original, and then

press [####].

----Checking the transmission 
settings

You can check the transmission set-
tings (e.g. destination and transmis-
sion mode) on the display.
A Press the {{{{Check Modes}}}} key.

The following display appears.

B After checking the settings on the
display, press the {{{{Check Modes}}}}
key.
The display returns to the display
shown before pressing the {{{{Check
Modes}}}} key the first time.
23
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Canceling a Memory Transmission

Before the Original is Scanned

Canceling a transmission before
pressing the {{{{Start}}}} key. Use this pro-
cedure to cancel a transmission before
the original has been scanned.

AAAA Press the {{{{Clear Modes}}}} key.

Note
❒ When documents are placed in

the optional Document Feeder
(ADF), you can cancel the trans-
mission by just removing them.

While the Original is Being 
Scanned

Canceling a transmission after press-
ing the {{{{Start}}}} key. Use this proce-
dure to cancel a transmission after the
original has been scanned.

AAAA Press the {{{{Clear/Stop}}}} key.
The machine will stop scanning.

Note
❒ You can also cancel scanning by

pressing [Cancel].
❒ Originals might be scanned

while you are in the process of
canceling a transmission.

While the Message is Being 
Sent 

Use this procedure to cancel a trans-
mission after the original has been
scanned.

Canceling a transmission using 
[Change/Stop TX File] 

AAAA Press [Change/Stop TX File].

The list of programmed files being
transmitted or waiting for trans-
mission is displayed.

BBBB Select the file you want to cancel.

CCCC Press [Stop Transmission].

Note
❒ To cancel another file, repeat

steps B and C.

DDDD Press [Exit].

The machine will return to the
standby mode.
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Canceling a transmission using the 
{{{{Clear/Stop}}}} key

Note
❒ You cannot cancel the pages which

already have been sent to the desti-
nation even if you cancel a trans-
mission.

❒ If the transmission finishes while
you are carrying out this proce-
dure, it will not be canceled.

❒ If you cancel a message while it is
being sent, the transmission is halt-
ed as soon as you finish this proce-
dure. However, some pages of
your message may have already
been sent and may have been re-
ceived at the other end. 

AAAA Press the {{{{Clear/Stop}}}} key.

Note
❒ You can also cancel a Memory

Transmiss ion  by  press ing
[Change/Stop TX File].

BBBB Select the file you want to cancel.

CCCC Press [Stop Transmission].

Note
❒ To cancel another file, repeat

steps B and C.

DDDD Press [Exit].
The machine will return to standby
mode.
25
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Immediate Transmission

With Immediate Transmission, when
you press the {{{{Start}}}} key, the fax
number is dialed immediately. The
message is scanned and transmitted
page by page without being stored
into memory. This contrasts with
Memory Transmission which scans
all pages into memory before dialing
the destination.
Immediate Transmission is useful if
you want immediate confirmation
that the message is being sent to the
correct destination (just check for the
other terminal's Own Name or Own
Fax Number on the operation panel
during transmission). 

Note
❒ You cannot send the same message

to multiple destinations (Broad-
casting). The Memory Transmis-
sion allows for this purpose.

❒ Place the original on the exposure
glass or in the optional Document
Feeder (ADF). To send two or
more pages from the exposure
glass, set them one page at a time.

❒ You can scan some pages of your
original from the exposure glass
and the remainder from the op-
tional Document Feeder (ADF).
When you have finished scanning
from the exposure glass, place the
remainder of the pages in the op-
tional Document Feeder (ADF)
and press the {{{{Start}}}} key within
ten seconds.

❒ You can set whether the machine is
in Memory Transmission mode or
Immediate transmission mode
right after the power is turned on.
See p.102 “General Settings/Ad-
justment”, Facsimile Reference (op-
tion) <Advanced Features> .

AAAA Make sure that Immediate Trans-
mission is selected.

Note
❒ If it is not selected, press [Immed.

TX].

BBBB Place the original.

Note
❒ The original can be placed when-

ever until the {{{{Start}}}} key is
pressed.

❒ Do not open the optional Docu-
ment Feeder (ADF) while it is
scanning the originals. This can
cause originals to jam.

Reference
See p.15 “Placing Originals”.
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CCCC Select any scan settings you re-
quire.

Reference
See p.29 “Scan Settings”.

DDDD Dial a destination.

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key
and enter the correct number.

Reference
See p.33 “Dialing”.
See p.33 “Chain Dial”, Facsimile
Reference (option) <Advanced Fea-
tures> .
See p.33 “Redial”, Facsimile Ref-
erence (option) <Advanced Fea-
tures> .

EEEE Press the {{{{Start}}}} key.

After transmission, the machine
will return to standby mode.

Sending originals from the 
exposure glass

A Place the first page face down
on the exposure glass.

B Dial a destination.

C Make any scan settings you re-
quire.

D Press the {{{{Start}}}} key.
The machine starts scanning the
original.

E Place the next original on the
exposure glass within 10 sec-
onds after the machine has fin-
i s h e d  s ca n n i n g  t h e  f i r s t
original.

Note
❒ Repeat steps C to E for all

originals.
F Place the last original, and then

press [####].
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Canceling an Immediate Transmission

Before You Have Pressed the 
Start Key

AAAA Press the {{{{Clear Modes}}}} key. 

Note
❒ When the original is placed in

the optional Document Feeder
(ADF), you can also cancel an
Immediate Transmission by re-
moving the original from the
machine.

After You Have Pressed the 
Start Key

AAAA Press the {{{{Clear/Stop}}}} key, and
then remove the original.

Note
❒ You can also cancel an Immedi-

ate Transmission by pressing
[Stop Transmission].

❒ If the transmission finishes while
you are carrying out this proce-
dure, it will not be canceled.
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Scan Settings

You may wish to send many different
types of fax messages. Some of these
may be difficult to reproduce at the
other end. However, your machine
has three settings that you can adjust
to help you transmit your document
with the best possible image quality. 

❖❖❖❖ Resolution:
Standard, Detail, Super Fine (op-
tion)

❖❖❖❖ Original Type:
Text, Text/Photo, Photo

❖❖❖❖ Image Density (Contrast):
Auto Image Density, Manual Im-
age Density (7 levels)

Resolution

Images and text are scanned into the
machine by converting them to se-
quences of dots. The frequency of
dots determines the quality of the im-
age and how long it takes to transmit.
Therefore, images scanned at high
resolution (Super Fine) have high
quality but transmission takes longer.
Conversely, low resolution (Stand-
ard) scanning results in lower quality
but your original is sent more quick-
ly. Choose the setting that matches
your needs based upon this trade off
between speed and image clarity.

❖❖❖❖ Standard 
Select for originals containing nor-
mal sized characters. 

❖❖❖❖ Detail 
Select for originals containing
small characters or when you re-
quire greater clarity. This resolu-
tion is twice as fine as Standard. 

❖❖❖❖ Super Fine (optional Expansion Mem-
ory required)
Select for originals with very fine
details or when you require the
best possible image clarity. This
resolution is eight times as fine as
Standard.

Limitation
❒ If the other party's machine does

not support the resolution at
which you are sending, this ma-
chine automatically switches to a
resolution which is supported.

❒ Sending with Super Fine resolu-
tion requires that your machine
has the optional Expansion Memo-
ry and the other party's machine
has the capability to receive fax
messages at Super Fine resolution. 

Note
❒ Note that even if the option is in-

stalled on your machine, transmis-
sion and reception may take place
using Detail resolution if the other
party's machine does not support
this function.

❒ You can select the resolution type
that is selected right after the ma-
chine is turned on or modes are
cleared with [Gen. Settings/Adjust].
See p.102 “General Settings/Ad-
justment”, Facsimile Reference (op-
tion) <Advanced Features> .

❒ You can set whether the machine
returns to the resolution default
setting after every transmission
with [Gen. Settings/Adjust]. See
p.102 “General Settings/Adjust-
ment”, Facsimile Reference (option)
<Advanced Features> .
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AAAA Press [Resolution].

BBBB Select the resolution you require,
and then press [OK].

Note
❒ If you install the optional Ex-

pansion Memory, “Super Fine”
will be displayed in the Resolu-
tion box.

Original Type

If your original contains photo-
graphs, illustrations or diagrams with
complex shading patterns or grays,
select the appropriate original type to
optimize image clarity. 

❖❖❖❖ Text 
Select Text to send an original con-
taining a high-contrast black-and-
white image. Use this setting even
if your original contains text and
photographs or if you only want to
send clearer text. 

❖❖❖❖ Text/Photo 
Select Text/Photo to send an origi-
nal containing both a high-contrast
black-and-white image, such as
text, and a halftone image such as a
photograph. 

❖❖❖❖ Photo 
Select Photo to send an original
containing a halftone image such
as a photograph or a color original.

Note
❒ If you select Text/Photo or Photo,

the transmission will take longer
than when Text is selected. 

❒ If you send a fax message with
Text/Photo or Photo and the back-
ground of the received image is
dirty, reduce the density setting
and re-send the fax. See p.31 “Im-
age Density (Contrast)”.

❒ You can select the original type
that is selected right after the ma-
chine is turned on or modes are
cleared with [Gen. Settings/Adjust].
See p.102 “General Settings/Ad-
justment”, Facsimile Reference (op-
tion) <Advanced Features> .

❒ You can set whether the machine
returns to the original type default
setting after every transmission
with [Gen. Settings/Adjust]. See
p.102 “General Settings/Adjust-
ment”, Facsimile Reference (option)
<Advanced Features> .

AAAA Press [Original Type].
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BBBB Select the original type you re-
quire, and then press [OK].

Image Density (Contrast)

The text and diagrams in your origi-
nal should stand out clearly from the
paper they are written on. If your
original has a darker background
than normal (for example, a newspa-
per clipping), or if the writing is faint,
adjust the image density.

❖❖❖❖ Auto Image Density
The appropriate density setting for
the original is automatically select-
ed.

❖❖❖❖ Manual Image Density
Use manual image density to set
image density yourself.

❖❖❖❖ Combined Auto and Manual Image
Density
You can adjust image density for
only photographs, illustrations or
diagrams when the original has a
dark background.

Note
❒ You can select the image density

that is selected right after the ma-
chine is turned on or modes are
cleared with [Gen. Settings/Adjust].
See p.102 “General Settings/Ad-
justment”, Facsimile Reference (op-
tion) <Advanced Features> .

❒ You can set whether the machine
returns to the image density de-
fault setting after every transmis-
sion with [Gen. Settings/Adjust]. See
p.102 “General Settings/Adjust-
ment”, Facsimile Reference (option)
<Advanced Features> .

AAAA Selecting the type of image densi-
ty.

Auto Image Density

A Make sure that [Auto Image Den-
sity] is selected.

Note
❒ If [Auto Image Density] is not

selected, press [Auto Image
Density].

Manual Image Density

A Make sure that [Auto Image Den-
sity] is not selected. If it is se-
lected, press [Auto Image Density]
to turn it off.

Note
❒ If [Auto Image Density] is not

selected, go to step B.
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B Press [iiiiLighter] or [Darkerjjjj] to
change the density.

Note
❒ You can select one of seven

density levels.

Combined Auto and Manual 
Image Density

A Make sure that [Auto Image Den-
sity] is selected.

Note
❒ If [Auto Image Density] is not

selected, press [Auto Image
Density].

B Press [iiiiLighter] or [Darkerjjjj] to
change the density.

Note
❒ You can select one of seven

density levels.

Mixing Scan Settings for a 
Multiple Page Original

When sending an original consisting
of several pages, you can select differ-
ent image density, resolution and
original type settings for each page.
Place your original, select the scan
settings for the first page, dial and
press the {{{{Start}}}} key as you would
normally. Then follow one of the fol-
lowing two procedures.

Note
❒ While the machine is beeping, you

have about 60 seconds (10 for Im-
mediate Transmission) to select
density, resolution and original
type. The remaining time is shown
on the display.

AAAA Check which pages you wish to
scan with different settings. 

BBBB Remove the previous page and
place the next page. 

CCCC Select the image density, resolu-
tion and original type. 

Note
❒ Adjust settings for each page

before you press the {{{{Start}}}} key.
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Dialing

There are three main ways to dial a
number:

❖❖❖❖ Number Keys
See p.33 “Number Keys”.

❖❖❖❖ Quick Dials
See p.35 “Quick Dials”.

❖❖❖❖ Groups
See p.36 “Groups”.

This section covers these function and
others in more detail. 

Number Keys

Enter numbers directly using the key
pad on the right side of the operation
panel.

Note
❒ Maximum length of a fax number:

254 digits.
❒ You can insert pauses and tones in

a fax number. See p.34 “Pause”,
p.34 “Tone”.

❒ If the optional ISDN Unit is in-
stalled, you may need to enter a
sub-address and UUI. See p.39
“Sub-address”, Facsimile Reference
(option) <Advanced Features> . See
p.40 “UUI”, Facsimile Reference (op-
tion) <Advanced Features> .

Restrictions when dialing with the 
number keys

Fax numbers  entered with the
number keys are programmed in the
internal memory (separate from
memory for storing original data).

AAAA Enter the fax number with the
number keys.
The digits appear on the display as
you enter them.

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key
and enter again.

❒ If the optional ISDN Unit is in-
stalled, select G3 or G4 before
you go to the next step. See p.43
“Changing the Line Type”, Fac-
simile Reference (option) <Ad-
vanced Features> .

Therefore, using the number keys,
you cannot program more than 100
numbers in total for the following:
• Destinations specified in a

Memory Transmission (includ-
ing Confidential Transmission
and Polling Reception)

• Transfer Stations and End Re-
ceivers specified in a Transfer
Request

• Destinations and Transfer Sta-
tions specified in a Group 

• Destinations specified in pro-
gram registration
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For example, when 90 destinations
are programmed in a Group with
the number keys, only 10 destina-
tions can be dialed for Memory
Transmission from the number
keys.

Note
❒ When this machine is requested

to transfer a call (i.e. become a
Transfer Station), 2 fax numbers
are automatically programmed.
Therefore, the number of desti-
nations that can be dialed from
the number keys decreases by
two whenever this machine is
requested to transfer a call. 

❒ When a total of 100 fax numbers
(1,000 with the optional Fax
Function Upgrade Unit) is pro-
grammed, only Immediate
Transmission is allowed.

❒ If a memory file is awaiting
transmission and the “Memory
is full. Cannot scan more.
Transmitting only scanned
pages.” message is displayed
when dialing with the number
keys, you cannot dial any more
numbers. This is because fax
numbers have been dialed with
the number keys for some of the
files awaiting transmission.
When these files have been sent
and their fax numbers are delet-
ed from memory, additional fax
numbers can be dialed.

❒ The display shows the percent-
age of free memory space for
storing originals. Since fax
numbers are programmed in
separate memory, dialing fax
numbers with the number keys
does not change the percentage
on the display.

Pause

Press the {{{{Pause/Redial}}}} key, when di-
aling or storing a number to insert a
pause of about two seconds.

Note
❒ You cannot insert a pause before

the first digit of a fax number. If
you press the {{{{Pause/Redial}}}} key at
the first digit, a redial takes place.
See p.33 “Redial”, Facsimile Refer-
ence (option) <Advanced Features> .

❒ A pause is shown as a “-” on the
display. 

❒ You can insert pauses in numbers
programmed in Quick Dials.

Tone

This function allows a machine con-
nected to a pulse dialing line to send
tonal signals (for example if you want
to use a special service on a tone dial-
ing line). When you press the {{{{Tone}}}}
key, the machine dials the number us-
ing tonal signals. 

Limitation
❒ You cannot place a tone before the

first digit of a fax number.
❒ Some services may not be available

when using the {{{{Tone}}}} key.

Note
❒ A tone is shown as a “•” on the dis-

play. 
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----Using the {{{{Tone}}}} key with On 
Hook Dial

A Press the {{{{On Hook Dial}}}} key.
B Enter the fax number with the

number keys.
C Press the {{{{Tone}}}} key.
D Enter the ID number with the

number keys.

----Sending tonal signals by ISDN 
(Optional ISDN unit required)

You can still send tonal signals to a G3
user even if the machine is only con-
nected to an ISDN line.

Note
❒ This function can only be used for

Memory or Immediate Transmis-
sion. You cannot dial through
ISDN using On Hook Dial or Man-
ual Dial.

❒ When G4 is selected, the display
shows UUI after a tone indication
“•”.

❒ When G3 is selected on ISDN line,
you can set the indication after a
tone indication “•” in the User Pa-
rameters: BP (tone) or UUI. See
p.113 “Changing the User Parame-
ters”, Facsimile Reference (option)
<Advanced Features>  (Switch11,
Bit1).

Quick Dials

When you have programmed a desti-
nation's number in a Quick Dial Ta-
ble, you can dial the number by just
selecting the destination from the
Quick Dial Table.
Additionally, you can store a name
that will appear on the display when-
ever you press that Quick Dial.

Preparation
You must program the fax number
of a destination for the Quick Dial
Table prior to using Quick Dials.
See p.42 “Quick Dial”.

Note
❒ When you press the title key above

the destination keys, the destina-
tion keys programmed in that title
key appear.

❒ A stored name can be printed out
on the first page of a received fax at
the other end. See p.53 “Transmis-
sion Options”, Facsimile Reference
(option) <Advanced Features> .

Reference
 See p.33 “Dialing”.

AAAA Place your original, and then se-
lect any scan settings you require.

BBBB Press the title key for the table
with the desired Quick Dial key.
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Note
❒ There are three types of title in

the Quick Dial Table: “Title 1”,
“Title 2”, and “Title 3”

❒ Use [Dest. Management] to switch
the titles of the Quick Dial Ta-
ble.

CCCC Press the Quick Dial key.

Note
❒ To cancel a selected destination,

press that destination again.
❒ If you wish to dial another des-

tination, repeat from step B.

DDDD Press the {{{{Start}}}} key.

Groups

If you frequently send the same mes-
sage to more than one place, program
these numbers into a Group. Then
you can send messages to all the des-
tinations in that Group with just a few
keystrokes. You can also program a
name for the Group (for example,
“Branch Offices”) which will be dis-
played before you press the {{{{Start}}}}
key.

Preparation
You need to program the Groups.
See p.46 “Groups”.

Limitation
❒ Group Dial can be used only for

Memory Transmission; it cannot
be used for Immediate Transmis-
sion. The machine automatically
changes to Memory Transmission
when you use Group Dial.

Note
❒ A total of 500 destinations can be

programmed for Group Dial.

AAAA Place your original and select any
scan settings you require.

BBBB Press [Group].
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CCCC Press the Group key for the de-
sired group.

A programmed destination and
the total number of destinations is
displayed. Press [UUUU] and [TTTT] to see
the other destinations.

Note
❒ If the destination is not dis-

played, press [UUUU Prev.] or [TTTT
Next] to find it.

❒ To cancel a setting, press once
more the selected Quick Dial
key. You can also change the
settings by pressing [Clear] or
the {{{{Clear / Stop}}}} key. 

❒ To set more groups, repeat from
step C.

DDDD Press the {{{{Start}}}} key.
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Reception

Selecting the Reception Mode

There are two ways you can set up
your machine to handle incoming
calls:
• Manual Reception (the optional

handset or an external telephone
required)

• Auto Reception
You can change the reception mode
only when the standard G3 line is
used.
You cannot change the reception
mode when a line other than the
standard G3 line (G3-2, I-G3, or G4) is
used.

Manual Reception

When a telephone call comes in, the
machine rings. If the call is a fax mes-
sage, you must manually change to
facsimile mode.

Auto Reception

When a telephone call comes in, the
machine automatically receives it as a
fax message. Use this setting for a
dedicated fax line.

Note
❒ The optional handset is required to

use this machine as a telephone.

----Receiving a fax in Manual 
Reception mode

A When the machine rings, pick up
the optional handset or a handset
of an external telephone.

B If you hear beeps, press the {{{{Start}}}}
key or the {{{{Start Manual RX}}}} key.
(The {{{{Start}}}} key is available in the
facsimile mode when an original is
not placed only.)

C Replace the optional handset or a
handset of an external telephone.
The machine will start receiving.

Limitation
❒ When printing the stored docu-

ments in the Document Server,
the {{{{Start Manual RX}}}} key or the
{{{{Start}}}} key cannot be used to
switch to Fax Mode. Press the
{{{{2}}}} key of the optional handset
or an external telephone.



3. Registering
Initial Settings and Adjustments

You can send information to the other
party when transmitting or receiving
a fax message. This information is
shown on the display of the other ma-
chine and printed as a report. The fol-
lowing information can be sent.

Important
❒ You can confirm the programmed

settings from Parameter Setting
List. We recommend that you print
and keep the Parameter List when
you program or change settings.
See p.116 “Printing the User Pa-
rameter List”, Facsimile Reference
(option) <Advanced Features> .

❖❖❖❖ Fax Header
The Fax Header is printed as the
header of every fax you send. You
should include your name in Fax
Header.
You can program characters, sym-
bols, number, and spaces.

Note
❒ You can program up to 32 char-

acters in Fax Header. See p.102
“General  Sett ings/Adjust-
ment”, Facsimile Reference (op-
tion) <Advanced Features> .

❖❖❖❖ Own Name
The Own Name is sent to the other
party when you send or receive a
fax. This name should include
your name. The Own Name is
shown on the display of the other
machine and printed in a report.
You can program characters, sym-
bols, number, and spaces.

Limitation
❒ Own Name works only when

the other machine is the same
make and has the Own Name
function.

Note
❒ You can program up to 20 char-

acters in Own Name.

❖❖❖❖ Own Fax Number (Facsimile number
of sender)
The Own Fax Number of the send-
er is sent to the other party when
sending a fax using a G3 line. The
received facsimile number is
shown on the display of the other
machine and printed in a report.
This function is available regard-
less of the make of the other party's
machine.

Note
❒ You can program up to 20 char-

acters in Own Fax Number.

❖❖❖❖ G4 Terminal ID
The optional ISDN Unit is required. 

G4 Terminal ID is available when
the machine is connected to an
ISDN line. This information is
printed by the other party's ma-
chine when a fax is transmitted.
You can program characters, sym-
bols, number, and spaces.

Note
❒ You can program up to 22 char-

acters that include Country
Codes, Facsimile No., and Ter-
minal Names in G4 Terminal ID.
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Programming

Press the {{{{User Tools/Counter/Inquiry}}}}
key (See p.9), then [Facsimile Features]
⇒ [Gen. Settings/Adjust] ⇒ [Program Fax
Information].

Note
❒ If “Program Fax Information” is

not shown, press [UUUU Prev.] or [TTTT
Next].

AAAA Program the name and facsimile
number.

Programming a Fax Header

A Press [First Name] or [Second
Name].

B Enter a fax header, and then
press [OK].

Reference
See “Entering Text“ in the
General Settings Guide.

Programming an Own Name

A Press [Own Name].

B Press [Own Name].

C Enter an own name, and then
press [OK] 

Reference
See “Entering Text“ in the
General Settings Guide.

Programming an Own Fax 
Number

A Press [Own Fax Number].

B Select line type to Program.

When the optional Extra G3 or
G4 Interface Unit is installed, a
different display appears.

C Enter the own facsimile number
using the number keys, and
then press [OK].

Note
❒ To enter a + sign or a space,

press [+ ] or [Space].
❒ If you make a mistake, press

[Clear] or the {{{{Clear / Stop}}}}
key, and then program the
facsimile number again.
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Programming G4 Terminal ID

Note
❒ The display appears as below

when the optional ISDN Unit is
installed.

A Press [G4 Terminal ID].

B Press [Country Code].

C Enter the country code using
the number keys, and then
press [OK].

D Press [Facsimile No.].

E Enter the facsimile number us-
ing the number keys, and then
press [OK].

F Press [Terminal Name].

G Enter the terminal name (ab-
breviated), and then press [OK].

Reference
See “Entering Text“ in the
General Settings Guide.

BBBB Press [Exit].

After programming is completed,
return to the initial display.

Editing

Refer to Step A to B in “Program-
ming” ⇒ p.40 to edit an existing fax
header, own name and/or own fac-
simile number. Press [Backspace] or
[Delete All] to delete names but press
[Clear] or the {{{{Clear/Stop}}}} key to delete
facsimile numbers.

Deleting

Refer to Step A to B in “Program-
ming” ⇒ p.40 to delete an existing fax
header, own name and/or own fac-
simile number. Press [Backspace] or
[Delete All] to delete names but press
[Clear] or the {{{{Clear/Stop}}}} key to delete
facsimile numbers.
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Quick Dial

To save time, you can program a fax
number that you use often into a
Quick Dial key. Then, whenever you
are sending a message to that loca-
tion, just press that Quick Dial key to
dial.
You can also program a destination
into the Quick Dial Table using
[Prog./Change/Delete] in Facsimile Fea-
t u r e s  m e nu .  S e e  p . 9 4  “ P r o -
g r a m / Ch a n g e / D e l e t e  M e nu ” ,
Facsimile Reference (option) <Advanced
Features> .

Important
❒ We recommend that you print and

keep the Quick Dial list when you
program or change fax numbers.
See p.101 “Reports/Lists”, Facsimi-
le Reference (option) <Advanced Fea-
tures> .

You can program the following items
in each key:

❖❖❖❖ Destination Fax Number (up to 254
digits)
You can select a line type for each
destination when the optional
ISDN Unit or the optional Extra G3
Interface Unit is installed. Settings
can also be made for SUB, SID,
SEP, PWD (up to 20 characters),
sub-address (optional ISDN Unit is
required), UUI, pause, and tonal
signals. See p.34 “Tone”. See p.35
“Advanced Features”, Facsimile
Reference (option) <Advanced Fea-
tures> .

❖❖❖❖ Destination Name (up to 20 charac-
ters)
You should enter the destination
name when programming Quick
Dials.

❖❖❖❖ Key Display
You can program the Key Display
shown on the display (up to 16
characters). The Group name (up
to 16 characters of the Group
name) will be programmed as the
Key Display automatically if you
do not program a Key Display.

❖❖❖❖ Select Title
You can select a title for pro-
grammed destinations. If no spe-
cific title is selected, only “Quick
Dial List” will be shown.

❖❖❖❖ Fax Header (which Fax Header is
printed on faxes sent to this number) 
See p.53 “Transmission Options”,
Facsimile Reference (option) <Ad-
vanced Features> .

❖❖❖❖ Label Insertion (whether to print the
destination name on faxes sent to this
number)
You can program your own mes-
sages to be used as standard mes-
sages. See p.96 “Programming and
Changing Standard Messages”,
Facsimile Reference (option) <Ad-
vanced Features> .

❖❖❖❖ International Transmission Mode
When setting the International
Transmission Mode to “ON”, the
machine transmits reliably by low-
ering the transmission speed.
However, the communication time
will become longer.
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Programming

If a destination is programmed in the
Quick Dial Table, you can just press
that Quick Dial key to dial.

Note
❒ Up to 400 destinations can be pro-

grammed. You can program up to
1,200 destinations when Fax Func-
tion Upgrade Unit is installed.

❒ The maximum number of digits
for a fax number may be less than
254 due to the settings for SUB,
SID, SEP, PWD, Space and Sub-ad-
dress.

Reference
See p.94 “Program/Change/De-
lete Menu”, Facsimile Reference (op-
tion) <Advanced Features> .

Press [Dest. Management] ⇒ [Pro-
gram/Change/Delete Quick Dial].

AAAA Select the Quick Dial key you
want to program.

Note
❒ If the key has been programmed

already, the contents are shown.
❒ Press [Change Title] to display

another title.

BBBB Enter the receiver's name, and
then press [OK].

The name has been programmed.

Note
❒ You should program the name

of the receiver.

CCCC Enter the facsimile numbers you
want to program with the number
keys or software keys.

Note
❒ You should program a facsimile

number.
❒ Press the {{{{Pause/Redial}}}} key for

"-" when you are entering the
facsimile numbers with the
number keys.

❒ If you make a mistake, press
[Clear] or the {{{{Clear/Stop}}}} key
and start again.

❒ Press [Adv. Features] to edit SUB,
SID, SEP, PWD, sub-address or
UUI. See p.35 “Advanced Fea-
tures”, Facsimile Reference (op-
tion) <Advanced Features> .
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❒ You can select a line type for
each destination when the op-
tional ISDN Unit or the optional
Extra G3 Interface Unit is in-
stalled. Press [Select Line] to se-
l e c t  a  l i n e  t y p e .  S e e  p . 4 3
“Changing the Line Type”, Fac-
simile Reference (option) <Ad-
vanced Features> .

DDDD When programming each item,
select its key.

Programming/Changing Key 
Display

A Press [Key Display].
B Enter a Key Display, and then

press [OK].

The Key Display which you
programmed is shown.

Reference
See “Entering Text“ in the
General Settings Guide.

Selecting a title

A Press [Select Title].
B Select the title you want to pro-

gram, and then press [OK].

Note
❒ You can program the same

destination in [Title 1] , [Title 2]
and [Title 3].

❒ When [Freq.] is selected for
one title, [Freq.] is selected for
all titles. See p.95 “Program-
ming Title of the Quick Dial
Table”, Facsimile Reference
(option) <Advanced Features> .

Selecting a Fax Header

A Press [Select Fax Header].

B Select [1st Name] or [2nd Name] ,
and then press [OK].

Programming Label Insertion

A Press [Label Insertion].
B Select [ON] or [OFF].

Note
❒ If you select [OFF] or if you

want to insert only the re-
ceiver name, go to step E.

C Press [Change] at the right side
of the second or third line.

D Select the standard message to
be stamped at the second or
third line, and then press [OK].

E Press [OK].

Programming the International 
Transmission Mode

A Press [International TX Mode].

B Select [ON] or [OFF], and then
press [OK].

EEEE Press [OK].

Note
❒ If you press [Cancel], no changes

are made. The display appears
as in step A.

FFFF Press [Exit] twice.

The machine will return to standby
mode.
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Editing

Refer to Step A to F in “Program-
ming” ⇒ p.43 to display each pro-
gramming display, and reprogram.
Press [Backspace] or [Delete All] to de-
lete existing names but press [Clear] or
the {{{{Clear/Stop}}}} key to delete facsimi-
le numbers.

Note
❒ You cannot change destinations

for the Quick Dial which is being
used for a Memory Transmission
on standby.

Deleting

This procedure describes how to find
a programmed Quick Dial and delete
it.

Note
❒ You cannot delete destinations for

the Quick Dial which is being used
for a Memory Transmission on
standby.

Press [Dest. Management] ⇒ [Pro-
gram/Change/Delete Quick Dial].

AAAA Press [Delete].

BBBB Select a Quick Dial key to be de-
leted.

The information for the Quick Dial
key is shown.

Note
❒ Press [Change Title] to display

another title.

CCCC Press [Delete].

The destination has been deleted.

Note
❒ If you press [Do not Delete], the

destination is not deleted. The
display appears as in step B.

DDDD Press [Exit] twice.

The machine will return to standby
mode.
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Groups

If you send the same message to sev-
eral destinations at the same time on a
regular basis, program these destina-
tion numbers as a Group. This allows
you to dial these destinations with a
single key press.
You can program the group destina-
tion using [Prog./Change/Delete] in Fac-
simile Features menu.

Important
❒ It is recommended that you print

and keep the Group Dial list when
you program or change destina-
tions. See p.101 “Reports/Lists”,
Facsimile Reference (option) <Ad-
vanced Features> .

You can program the following items
in a Group:

❖❖❖❖ Destination fax numbers (up to 500
numbers for each group or 2,200 num-
bers with optional Fax Function Up-
grade Unit, up to 254 digits for each
number)
 

❖❖❖❖ Group name (up to 20 characters)
You should program the Group
name.

❖❖❖❖ Key Display
You can program the Key Display
shown on the display (up to 16
characters). The Group name (up
to 16 characters of the group name)
will be programmed as the Key
Display automatically if you do
not program a Key Display.

You can edit destinations which are
programmed in a Group.

Programming

Preparation
All destinations to be programmed
should be selected using the Quick
Dial table or entered using the
number keys. You can use a combi-
nation of the Quick Dial table and
number keys.

Note
❒ The maximum number of groups

that can be programmed is 64.
❒ The maximum number of destina-

tions that can be programmed in
one group is 500. (400 with the
Quick Dial Table and 100 with the
number keys)

❒ The combined maximum number
of destinations that can be pro-
grammed in all groups is 500 (400
with the Quick Dial Table and 100
with the number keys). When the
optional Fax Function Upgrade
Unit is installed, it is 2,200 (1,200
with the Quick Dial Table and
1,000 with the number keys).

❒ The programmed number can be
counted as 1, when the same desti-
nation is specified in various
groups. For example, if the same
destination is found in one group of
500 programmed destinations, it is
possible to register it other groups.
If programming 200 destinations in
one group, when programming
completely different destinations,
number of destinations that can be
programmed in the remaining
groups is 300. The procedure is also
similar when the optional Fax
Function Upgrade Unit is installed. 
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❒ How to count numbers

Press [Dest. Management] ⇒ [Pro-
gram/Change/Delete Group]. 

AAAA Select the Group key you want to
program.

Note
❒ If the key has been programmed

already, the contents are shown.

BBBB Enter the name of the group, and
then press [OK].

Note
❒ You should program the Group

name.

Reference
See “Entering Text“ in the Gen-
eral Settings Guide.

CCCC Specify the destinations to be
programmed in the Group.

Note
❒ You should program facsimile

numbers using the number keys
or Quick Dial Table.

❒ Press the {{{{Pause/Redial}}}} key for
"-" when you are entering the
facsimile numbers with the
number keys.

❒ If you make a mistake, press
[Clear] or the {{{{Clear/Stop}}}} key
and enter again.

❒ Press [Change Title] to display
another title.

❒ When you specify multiple des-
tinations using the number
keys, press [Add].

Group 1 Group 2 Total 
Numbers

Quick Dial

[0001]

Quick Dial

[0001]

8 numbers

Quick Dial

[0003]

Quick Dial

[0005]

Quick Dial

[0005]

Quick Dial

[0010]

Quick Dial

[0015]

Quick Dial

[0015]

Quick Dial

[0020]

Quick Dial

[0020]

number key

0312345678

number key

0312345678

number key

0451119999

number key

0451119999
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❒ When you add the destination
using the number keys, press
[Adv. Features] to program SUB,
SID, SEP, PWD, sub-address or
UUI. See p.35 “Advanced Fea-
tures”, Facsimile Reference (op-
tion) <Advanced Features> .

❒ Press [Dest. List] to confirm the
destinations programmed in the
Group.

DDDD Press [OK].

Note
❒ If you press [Cancel], the Group

is not programmed. The display
appears as in step A.

EEEE Press [Exit] twice.

The machine will return to standby
mode.

----Programming the Group as a 
Transfer Station of a multi-step 
transfer

A group can be programmed as a
Transfer Station. You should program
the receiving stations when you pro-
gram the Group as a Transfer Station.
For more information, contact your
service representative.

Note
❒ If you want to program a group

which has been programmed as a
Transfer Station as a normal group,
delete the group and program again.

❒ Only one destination can be pro-
grammed as a Transfer Station in a
group.

❒ Before you program the group as a
Transfer Station, you must pro-
gram the Polling ID and your own
fax number. See p.131 “Transfer
Report”, Facsimile Reference (option)
<Advanced Features> , and “p.133
“Programming a Polling ID”, Fac-
simile Reference (option) <Advanced
Features> .

A Follow steps A to C in “Program-
ming”.

B Press [Adv. Features].
C Press [Transfer Req.].
D Press [Receiving Station].
E Specify the receiving station.

Note
❒ When you specify the receiving

station with Quick Dial, press
[Quick Dial] and enter the Group
Dial number using the number
keys.

❒ When you specify the receiving
station with Group Dial, press
[Group Dial] and enter the Group
Dial number using the number
keys.

F After specifying all of the receiving
stations, press [OK].

G Press [OK].
H Press [Exit].

Reference
See p.37 “Transfer Request”, Fac-
simile Reference (option) <Advanced
Features> . 
See p.67 “Transfer Station”, Fac-
simile Reference (option) <Advanced
Features> .
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Editing

Use this procedure to change the
Groups already programmed.

Note
❒ You cannot change destinations

for the group which is being used
for a Memory Transmission on
standby.

Press [Dest. Management] ⇒ [Pro-
gram/Change/Delete Group]. 

AAAA Select the key for the group you
want to change.

BBBB Change the contents of the group.

Editing a Group Name

A Press [Group Name].

B Press [Backspace] or [Delete All],
reenter the Group name, and
then press [OK].

Reference
See “Entering Text“ in the
General Settings Guide.

The display appears as in step
B.

Editing Key Display

A Press [Key Display].
B Press [Backspace] or [Delete All],

reenter the Key Display, and
then press [OK].

Reference
See “Entering Text“ in the
General Settings Guide.

The display appears as in step
B.

Editing a destination 
programmed in a Group

A Press [Change] for the destina-
tion you want to edit.
The name of the destination is
displayed under the fax number
i f  t h e  d e s t in a t i o n  i s  p r o -
grammed with the Quick Dial
Table.

B Edit the destination using the
number keys or destination
key.

Note
❒ If the destination is pro-

grammed with the number
keys, press [Clear] or the
{{{{Clear/Stop}}}} key and enter
the fax number of the desti-
nation.
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❒ If the destination is pro-
grammed with the Quick
Dial Table, press [Clear] or
the {{{{Clear/Stop}}}} key to cancel
programming, and then pro-
gram with the destination
key again. You can cancel
programming also by press-
ing the destination key.

❒ Press [Adv. Features] to edit
SUB, SID, SEP, PWD, sub-ad-
dress or UUI. See p.35 “Ad-
vanced Features”, Facsimile
Reference (option) <Advanced
Features> .

❒ You can select a line type for
each destination when the
optional ISDN Unit or the
optional Extra G3 Interface
Unit is installed. Press [Select
Line] to select a line type. See
p.43 “Changing the Line
Type”, Facsimile Reference (op-
tion) <Advanced Features> .

❒ To edit another destination,
press [Dest. List] and proceed
from step A.

Adding destinations

A Press [Add].

B Add the destination using the
number keys or a Quick Dial
key.

Note
❒ To add another destination,

press [Dest. List] and proceed
from step A.

❒ You also can cancel program-
ming by pressing the Quick
Dial key of the destination to
be added.

❒ When you add the destina-
tion using the number keys,
press [Adv. Features] to pro-
gram SUB, SID, SEP, PWD,
sub-address or UUI. See p.35
“Advanced Features”, Fac-
simile Reference (option) <Ad-
vanced Features> .

❒ You can select a line type for
each destination when the
optional ISDN Unit or the
optional Extra G3 Interface
Unit is installed. Press [Select
Line] to select a line type. See
p.43 “Changing the Line
Type”, Facsimile Reference (op-
tion) <Advanced Features> .

CCCC Press [OK].

If you press [Cancel], the group is
not changed. The display appears
as in step A.

DDDD Press [Exit] twice.

The machine will return to standby
mode.
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Deleting

Note
❒ You cannot delete destinations for

the group which is being used for a
Memory Transmission on Stand-
by.

Deleting a destination programmed in a 
Group

Press [Dest. Management] ⇒ [Pro-
gram/Change/Delete Group]. 

AAAA Select the Group key which con-
tains the destination you want to
delete.

BBBB Press [Change] for the destination
you want to delete.

CCCC Press [Clear] or the {{{{Clear/Stop}}}} key
to delete the facsimile number.

If you programmed the destina-
tion with the number keys, the
number will clear one digit at a
time. If you programmed it with
the Quick Dial Table, the number
will clear all at once.

Note
❒ You can also delete the destina-

tion programmed with the
Quick Dial Table by highlight-
ing the destination key.

The programmed group is shown
on the display.

DDDD Press [OK].

Note
❒ If you press [Cancel], the desti-

nation is not changed. The dis-
play appears as in step A.

EEEE Press [Exit] twice.

The machine will return to standby
mode.
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Deleting Groups

Press [Dest. Management] ⇒ [Pro-
gram/Change/Delete Group]. 

AAAA Press [Delete].

BBBB Select the key for the group you
want to delete.

Note
❒ If the Group key has been pro-

grammed, the group name or
Key Display is shown.

CCCC Press [Delete].

The Group is deleted.

Note
❒ If you press [Do not Delete], the

display appears as in step B.

DDDD Press [Exit] twice.

The machine will return to standby
mode.



4. Troubleshooting
Adjusting Volume

You can change the volume of the fol-
lowing sounds the machine makes.

❖❖❖❖ On Hook Mode
Sounds when the {{{{On Hook Dial}}}}
key is pressed.

❖❖❖❖ At Transmission
Sounds when the machine sends a
message.

❖❖❖❖ At Reception
Sounds when the machine receives
a message.

❖❖❖❖ At Dialing
Sounds after pressing the {{{{Start}}}}
key until the line connects to the
destination.

❖❖❖❖ At Printing
Sounds when a received message
has been printed. See p.70 “Print
Completion Beep”, Facsimile Refer-
ence (option) <Advanced Features> .

Limitation
❒ Adjusting Volume is not available

with the optional G4 line or the op-
tional Extra G3 line. 

Note
❒ You can adjust the On Hook vol-

ume when you press the {{{{On Hook
Dial}}}} key. See p.41 “On Hook Dial”,
Facsimile Reference (option) <Ad-
vanced Features> .

❒ You can adjust the handset ringer
volume. See p.155 “Connecting the
Telephone Line”, Facsimile Refer-
ence (option) <Advanced Features> .

Press the {{{{User Tools/Counter/Inquiry}}}}
key (See p.9), then [Facsimile Features]
⇒ [Gen. Settings/Adjust] ⇒ [Adjust
Sound Volume].

AAAA Press [Lower] or [Louder] for each
item.

Note
❒ You can hear the actual volume

by pressing [Check].

BBBB Press [OK].

After adjusting is completed, re-
turn to the initial display.

Note
❒ If you press [Cancel], the volume

setting is canceled.
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When the {{{{Facsimile}}}} Key is Lit in Red

If this key is lit, refer to the table below and take the appropriate action.

Problem Solution

Paper has run out. Add paper. 

See “Loading Paper” in the General Settings 
Guide.

Note
❒ When the {{{{Facsimile}}}} key is lit in red even 

papers are loaded, [Thick paper] or [OHP] 
might be selected for paper type for the 
tray. If [Thick paper] or [OHP] is set for the 
tray, papers in the tray will not be used for 
facsimile function such as printing re-
ceived documents, lists or reports. Confirm 
the paper type setting in System Settings. 
See "Tray Paper Settings" in the General 
Settings Guide. 

The paper output tray is full. Remove the paper from the tray. 

The machine is in RDS (Remote Diagnostic 
System) mode.

Wait with the main power switch on. The ma-
chine will enter the standby mode after it exits 
from the RDS mode. 

A facsimile error has occurred. The facsimile has a problem. Contact a service 
representative. The copier will still function 
normally. 
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Error Messages and Their Meanings

If there is an error, one of the following messages may appear on the display. It
might just flash briefly, so if you are watching for errors, stay by the machine and
check the display.

Message Problem and Solution

Put original back, check it and press the {{{{Start}}}} 
key.

Original jammed during Memory Transmis-
sion. Place originals that have not been 
scanned again. 

Error occurred, and transmission was can-
celed. 

A document jam occurred during Immediate 
Transmission. Press [OK], and then re-send the 
page which has not been sent.

An error occurred during Immediate Trans-
mission. Press [OK], and then re-send the orig-
inal. 

Note
❒ There may be a problem with the machine 

or the telephone line (for example noise or 
cross talk). If the error re-occurs frequently, 
contact your service representative. 

Cannot detect original size. Place original 
again, then press [Start]. 

The machine failed to detect the size of the 
original. Place originals again, and then press 
the {{{{Start}}}} key.

L Call Service 

Functional problems with facsimile. Please call 
service. 

There is a problem with the fax function. 
Record the code number shown in the display 
and contact your service representative. The 
copier function will still work normally. 

Memory is full. Cannot scan more. Transmit-
ting only scanned pages. 

If you press [OK], the machine returns to the 
standby mode and starts transmitting pages 
which have been scanned.

Following output tray is full. Remove paper. The paper output tray is full. Remove paper 
from the tray shown in the display.

Cannot scan to send fax message as scanner is 
in use for other function.

The Copy or Document Server function is in 
use. To cancel the job in process, do the follow-
ing, and then try faxing again.

Press [Exit], and then press the {{{{Copy}}}} or {{{{Doc-
ument Server}}}} key. Next press the {{{{Clear/Stop}}}} 
key. When the message “[Stop] key was 
pressed. Stop printing? or “[Stop] key was 
pressed. Stop storing?” appears, press [Stop].
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----Out of paper display message
If the paper tray runs out of paper, you can have a message “No paper. Load it,
then press [Exit].” appear on the display asking you to add more paper.

Note
❒ You can turn this function on or off with the User Parameters. See p.113

“Changing the User Parameters”, Facsimile Reference (option) <Advanced Fea-
tures> (Switch05, Bit7).

❒ If there is paper left in the other paper trays, you can receive messages as usu-
al even if a message appears on the display.
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Solving Problems

This table lists some common problems and their solutions. 

Problem Solution Refer to

Image background appears 
dirty when received at the 
other end.

Adjust the scan density. See p.31 “Image Density (Con-
trast)”.

Printed or sent image contains 
spots.

The optional Document Feed-
er (ADF) or exposure glass is 
dirty. Clean them. 

Make sure that ink or correc-
tion fluid is dry before placing 
the original.

See “Maintaining Your Ma-
chine“ in the General Settings 
Guide.

Received image is too light. Request the sender to increase 
the image density. 

---

When using moist, rough or 
processed paper, the printed 
image may be partly invisible. 
Only use recommended pa-
per. 

See “Copy Paper“ in the Gen-
eral Settings Guide.

When D appears on the dis-
play, toner is beginning to run 
out. Replace the toner car-
tridge soon.

See “DAdding Toner“ in the 
General Settings Guide.

Message appears blank at the 
other end. 

The original was placed up-
side down. Place it properly.

See p.15 “Placing Originals”.

You want to cancel a Memory 
Transmission. 

If the original is being 
scanned, press [Cancel] or the 
{{{{Clear/Stop}}}} key. 

See p.24 “Canceling a Memo-
ry Transmission”.

If the original is being sent or 
if it is in standby, press 
[Change/Stop TX File] or the 
{{{{Clear/Stop}}}} key. 

See p.24 “Canceling a Memo-
ry Transmission”.

See p.13 “Checking and Can-
celing Transmission Files”, 
Facsimile Reference (option) 
<Advanced Features> .

You want to cancel an Imme-
diate Transmission. 

Press the {{{{Clear/Stop}}}} key. See p.28 “Canceling an Imme-
diate Transmission”.

You cannot add any destina-
tions to a Group although the 
number of destinations has 
not reached the maximum.

100 destinations have been 
programmed with the 
number keys (1,000 with the 
optional Fax Function Up-
grade Unit). Program more 
numbers with Quick Dials. 

See p.33 “Dialing”.
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Both transmission and receiv-
ing are impossible.

Make sure that the modular 
cord is correctly connected.

---

Setting of the Terminal Adap-
tor is incorrect. Check the set-
ting.

---

Transmission is possible, 
though receiving is impossi-
ble.

Setting of the optional Termi-
nal Adaptor is incorrect. 
Check the setting.

---

Receiving is possible, though 
transmission is impossible.

Setting of the optional Termi-
nal Adaptor is incorrect. 
Check the setting.

---

Problem Solution Refer to
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❖❖❖❖ FCC Requirements
1. This equipment complies with Part 68 of the FCC rules. On the cover of this equipment is a label

that contains, among other information, the ACTA product labeling number or the FCC registra-
tion number, and ringer equivalence number (REN) for this equipment. If requested, this infor-
mation must be provided to the telephone company.

2. The following is applicable only for an equipment using an analog G3 line.
This equipment uses the RJ11C USOC jack.
An FCC compliant telephone cord and modular plug is provided with this equipment. This equip-
ment is designed to be connected to the telephone network or premises wiring using a compat-
ible modular jack that is Part 68 compliant. See the Operating Instructions for details.

3. The REN is used to determine the quantity of devices which may be connected to the telephone
line. Excessive REN's on the telephone line may result in the devices not ringing in response to
an incoming call. Typically, the sum of the REN's should not exceed five (5.0). Contact the tel-
ephone company to determine the maximum REN for the calling area.

4. If this equipment causes harm to the telephone network, the telephone company will notify you
in advance that temporary discontinuance of service may be required. But if advance notice is
not practical, the telephone company will notify the customer as soon as possible. Also, you will
be advised of your right to file a complaint with the FCC if you believe it is necessary.

5. The telephone company may make changes to its facilities, equipment, operations, or proce-
dures that could affect the operation of the equipment. If this happens, the telephone company
will provide advance notice so that you can make the necessary modifications to maintain unin-
terrupted service.

6. In the event of operation problems (document jam, copy jam, communication error indication),
refer to the solving problems section in this manual.

7. If you cannot correct the problem, please contact the RICOH CORP. CUSTOMER SUPPORT
DEPT. at 1-800-FASTFIX for repair or warranty information. If the equipment is causing harm
to the telephone network, the telephone company may request you to disconnect the equipment
from the network until the problem is resolved.

8. This equipment cannot be used with telephone company-provided coin service. Connection to
Party Line Service is subject to state tariffs.

❖❖❖❖ WHEN PROGRAMMING EMERGENCY NUMBERS AND/OR MAKING TEST CALLS TO
EMERGENCY NUMBERS:
1. Remain on the line and briefly explain to the dispatcher the reason for the call before hanging up.
2. Perform such activities in the off-peak hours, such as early morning hours or late evenings.

CANADA

The Industry Canada label identifies certified equipment. This certification means that the equipment
meets telecommunications network protective, operational, and safety requirements as prescribed in
the appropriate Terminal Equipment Technical Requirements document(s). The department does not
guarantee the equipment will operate to the user's satisfaction.
Before installing this equipment, users should ensure that it is permissible to be connected to the facil-
ities of the local telecommunications company. The equipment must also be installed using an accept-
able method of connection. The customer should be aware that compliance with the above conditions
may not prevent degradation of service in some situations.

Repairs to certified equipment should be coordinated by a representative designated by the supplier.
Any repairs or alterations made by the user to this equipment, or equipment malfunctions, may give the
telecommunications company cause to request the user to disconnect the equipment.

User should ensure for their own protection that the electrical ground connections of the power utility,
telephone lines, and internal metallic water pipe system, if present, are connected together. This pre-
caution may be particularly important in rural areas.

Caution: Users should not attempt to make such connections themselves, but should contact the ap-
propriate electric inspection authority, or electrician, as appropriate.
The Ringer Equivalence Number (REN) for this terminal equipment is 0.2. The REN assigned to each
terminal equipment provides an indication of the maximum number of terminals allowed to be connect-
ed to a telephone interface. The termination on an interface may consist of any combination of devices
subject only to the requirement that the sum of the Ringer Equivalence Numbers of all the devices does
not exceed five.

Copyright © 2002
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Introduction

This manual describes detailed instructions on the operation and notes about the use of this machine.
To get maximum versatility from this machine all operators are requested to read this manual carefully
and follow the instructions. Please keep this manual in a handy place near the machine.

Notes

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.

Two kinds of size notation are employed in this manual. With this machine refer to the inch version.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

Note

The proper names of the Windows operating systems are as follows:

• Microsoft® Windows® 95 operating system

• Microsoft® Windows® 98 operating system

• Microsoft® Windows® Millennium Edition (Windows Me)

• Microsoft® Windows® 2000 Professional

• Microsoft® Windows® XP Professional

• Microsoft® Windows® XP Home Edition

• Microsoft® Windows® 2000 Server

• Microsoft® Windows NT® Server operating system Version 4.0

• Microsoft® Windows NT® Workstation operating system Version 4.0
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:
This symbol indicates a potentially hazardous situation that might result in
death or serious injury when you misuse the machine without following the in-
structions under this symbol. Be sure to read the instructions, all of which are in-
cluded in “Safety Information” in the General Settings Guide.

R CAUTION:
This symbol indicates a potentially hazardous situation that might result in mi-
nor or moderate injury or property damage that does not involve personal injury
when you misuse the machine without following the instructions under this
symbol. Be sure to read the instructions, all of which are included in “Safety In-
formation” in the General Settings Guide.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates information or preparations required prior to operating.

Note
This symbol indicates precautions for operation, or actions to take after abnor-
mal operation.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys that appear on the machine's panel display.

[ ]
Keys and buttons that appear on the computer's display.

{ }
Keys built into the machine's control panel.
1
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Notice

B4 JISKL, B5 JISKL, B6 JISL are referred to as B4KL, B5KL, B6L in this
manual.



Manuals for This Machine

There are the Basic Features manual and the Advanced Features manual for this
machine. Please consult the manual that suits your needs.

Advanced Features (this manual)

The Advanced Features manual describes more advanced functions and also ex-
plains settings for key operators.

Basic Features

The Basic Features manual explains the most frequently used fax functions and
operations.

❖❖❖❖ Chapter 1 Getting Started
Describes the parts of the machine and control panel.

❖❖❖❖ Chapter 2 Faxing
Explains about basic transmission. You can also learn about other types of
transmissions and how to switch the Reception Modes.

❖❖❖❖ Chapter 3 Registering
Explains how to store, edit and erase names and fax numbers. Quick Dials
and Groups are also explained. These functions store numbers and save time
when dialing. Also contains information on how to enter letters and symbols.

❖❖❖❖ Chapter 4 Troubleshooting
Explains how to adjust the volume of sounds generated by the machine and
how to interpret error messages.

Instructions for the optional ISDN Unit (ISDN Option Type 1232) and the Extra G3 Interface 
Unit (G3 Interface Unit Type 1232) are included in the Basic Features and Advanced Features 
manuals.
3
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1. Transmission Mode
Extending Function Transmission

To use Extending Function Transmis-
sion, follow the directions below. To
understand each function, read their
operating description.

AAAA Place your original, and then se-
lect any scan settings you require.

Note
❒ It is not necessary to place your

original for Polling Reception.

BBBB Press [Transmission Mode].

The Extending Function Transmis-
sion Mode menu appears.

CCCC Select the function you want to
extend and set each function.

• ⇒ p.5 “Sending at a Specific
Time (Send Later)” 

• ⇒ p.6 “Priority Transmission” 
• ⇒ p.7 “Confidential Transmis-

sion” 
• ⇒ p.8 “Polling Transmission” 
• ⇒ p.11 “Polling Reception” 

DDDD Specify the destination, and then
press the {{{{Start}}}} key.

Note
❒ It is not necessary to specify the

destination for Polling Trans-
mission.

Sending at a Specific Time 
(Send Later)

Using this function, you can instruct
the machine to delay transmission of
your fax message until a later time
which you specify. This allows you to
take advantage of off-peak telephone
charges without having to be by the
machine at the time.

Then if you have a non-urgent fax, just
select Send Later with Economy Trans-
mission when you scan it. Faxes will be
queued in memory and will be sent
during Economy Transmission Time.

Note
❒ You can specify a time less than 24

hours.
❒ This function is only available with

Memory Transmission.
❒ If the current time shown on the

display is not correct, change it.
See “Timer Setting” in the General
Settings Guide.

❒ For convenience, you can program
the time when your phone charges
become cheaper as the Economy
Transmission Time.
5
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Press [Transmission Mode] ⇒ [Send Lat-
er].

AAAA Enter the time with the number
keys, and press [AM] or [PM] to
change AM/PM and press [OK].

Note
❒ Press [Economy Time] to specify

the economy time.
❒ When entering numbers small-

er than 10, add a zero at the be-
ginning. 

❒ If you make a mistake, press
[Clear] or the {{{{Clear/Stop}}}} key
and try again.

BBBB Press [OK].

The initial display is shown.

Note
❒ To check settings, press [Trans-

mission Mode].
❒ To cancel Send Later after press-

ing the {{{{Start}}}} key, see p.14
“Canceling a Transmission”. 

Priority Transmission

Documents you send with Memory
Transmission are sent in the order
they are scanned. Therefore, if several
messages are queued in memory, the
next document you send will not be
sent immediately. However, by using
this function you can have your mes-
sage sent before any other queued
messages. 
For Priority Transmission, press
[Transmission Mode] ⇒ [Priority TX],
and then press [OK].

Limitation
❒ This function is not available with

Immediate Transmission. If this
function is selected, the machine
automatically switches to Memory
Transmission. 

Note
❒ If there is already a message stored

with this function or a transmis-
sion is in progress, your message
will be sent after that message has
been transmitted.

❒ Press [Change/Stop TX File] after
pressing the {{{{Start}}}} key to cancel
the priority transmission.
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Confidential Transmission

If you want to limit into who views
your message, use this function. The
message will be stored in memory at
the other end and will not be printed
until an ID is entered.

There are two types of Confidential
Transmission:

❖❖❖❖ Default ID
It is not necessary to enter an ID
when transmitting.
The other party can print the mes-
sage by entering the Confidential
ID programmed in their machine.

❖❖❖❖ ID Override
Should you wish to send a Confi-
dential Message to a particular
person at the other end, you can
specify the Confidential ID that
person has to enter to see that mes-
sage. Before you send the message,
do not forget to tell the intended
receiver the ID that must be en-
tered to print the message.

Limitation
❒ The destination machine must be

of the same make and have the
Confidential Reception function.

❒ The destination machine must
have enough memory available. 

Note
❒ We recommend that you program

the Confidential ID beforehand.
See p.132 “Programming a Confi-
dential ID”.

❒ An ID can be any 4 digit number
except 0000.

❒ When the machine is not the same
make, you can use Confidential
Transmission using “SUB Code”.
See p.35 “SUB Code”.

Press [Transmission Mode] ⇒ [Confiden-
tial TX].

AAAA Depending on the Confidential
Transmission type, use one of the
following procedures:

Default ID

A Check [Default ID] is selected,
and then press [OK].

Note
❒ If [Default ID] is not selected,

press [Default ID].

Override ID

A Press [ID Override].
7
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B Enter the Confidential ID (4
digit number) with the number
keys, and then press [OK].

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key
and try again.

BBBB Press [OK].

Note
❒ To check settings, press [Trans-

mission Mode].
❒ You can cancel Confidential

Transmission see ⇒ p.14 “Can-
celing a Transmission”, after
pressing the {{{{Start}}}} key.

Polling Transmission

Use Polling Transmission when you
want to leave an original in the ma-
chine's memory for others to pick up.
The message will be sent when the
other party calls you up.

There are three types of Polling
Transmission.

❖❖❖❖ Free Polling Transmission
It is not necessary to enter the Poll-
ing ID during the procedure.
Anybody can poll the message
from your machine. The machine
sends it regardless of whether Poll-
ing ID's match.

❖❖❖❖ Default ID Transmission
It is not necessary to enter the Poll-
ing ID during the procedure.
The message will only be sent if the
Polling ID of the machine trying to
poll your message is the same as
the Polling ID stored in your ma-
chine. Make sure that both ma-
chines' Polling IDs are identical in
advance.
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❖❖❖❖ ID Override Transmission
You must enter an Override Poll-
ing ID unique to this transmission.
This ID overrides that stored in the
Polling ID. The user must supply
this ID when they poll your ma-
chine. If the IDs match, the mes-
sage is sent. Make sure the other
end knows the ID you are using in
advance.

Limitation
❒ Polling Transmission is allowed

only if the receiver's machine has
the Polling Reception feature.

❒ Usually, only machines of the
same make that support Polling
Reception can perform ID Polling
Transmission. However, when the
Information Box File functions is
used, and the other party's fax ma-
chine supports Polling Transmis-
sion and the “SEP” feature, you
can still carry out a Polling Trans-
mission with an ID. See p.29 “In-
formation Boxes”.

Note
❒ Free Polling and Default ID Trans-

mission allow only one file to be
stored in memory.

❒ ID Override Polling Transmission
allows a file to be stored in memo-
ry for each ID; a total of up to 400
files (800 with the optional Fax
Function Upgrade unit) for vary-
ing ID's can be stored.

❒ Before using “Default ID Trans-
mission”, you need to program the
Polling ID. See p.133 “Program-
ming a Polling ID”.

❒ You can set whether a Polling
Transmission file is deleted after
transmitting in “User Parameters”.
To save the file to transmit repeat-
edly, set to “Standby (Save)”. See
p.113 “Changing the User Parame-
ters” (Switch 11, Bit7).

❒ The communication fee is charged
to the receiver.

Press [Transmission Mode] ⇒ [Polling
TX].

AAAA Depending on the Polling Trans-
mission mode, use one of the fol-
lowing procedures:

Free Polling TX

A Check that [Free Polling TX] is se-
lected.

Note
❒ If [Free Polling TX] is not se-

lected, press [Free Polling TX].

Default ID TX

A Select [Default ID TX].

ID Override Transmission

A Select [ID Override Transmission].
9
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B Specify a 4 digit ID Code with
the number keys and [A], [B],
[C], [D], [E] and [F].

Note
❒ A Polling ID may be any

string of four numbers (0 to
9) and characters (A to F) ex-
cept 0000 and FFFF.

❒ If you make a mistake, press
[Clear] or the {{{{Clear/Stop}}}} key
and try again.

BBBB Press [Only Once] or [Save] to delete
or save the file after transmission.

Note
❒ To delete the original immedi-

ately after transmission, select
[Only Once].

❒ To repeatedly send the original,
select [Save].

CCCC Press [OK].
The Transmission Mode menu is
shown.

DDDD Press [OK].

Return to the initial display.
After pressing the {{{{Start}}}} key,
scanning begins and the originals
are stored in memory.

Polling Transmission Clear Report

This report allows you to verify
whether Polling Transmission has
taken place.

Limitation
❒ This report is not printed if the

User Parameters are set to allow
the stored originals to be repeated-
ly sent (Save). See p.113 “Changing
the User Parameters” (Switch11,
Bit7).

Note
❒ You can turn this function on or off

with the User Parameters. See
p.113 “Changing the User Parame-
ters” (Switch03, Bit6).

❒ You can set whether a portion of
the sent image is printed on the re-
port with the User Parameters. See
p.113 “Changing the User Parame-
ters” (Switch04, Bit7).

❒ You can check the result of Polling
Transmission with the Journal.
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Polling Reception

Use this function if you want to poll a
message from another terminal. You
can also poll documents from many
terminals with only one operation
(use Groups and Keystroke Programs
to fully exploit this feature).

There are two types of Polling Recep-
tion.

❖❖❖❖ Default ID/Free Polling Reception
Use this method for Free Polling or
Default ID Polling. If the Polling ID
is programmed in your machine,
any messages waiting in the trans-
mitting machine with the same ID
are received. If the other machine
does not have any messages wait-
ing with the same Polling ID, any
messages that do not require ID
are received (Free Polling).

❖❖❖❖ ID Override Polling Reception
You must enter an Override Poll-
ing ID unique to this transmission.
This ID overrides that stored in the
Polling ID.
Your machine will receive any
messages waiting in the transmit-
ting machine with matching ID's.
If no ID's match, any messages that
do not require ID are received
(Free Polling).

Limitation
❒ Polling Reception requires that the

other machine can perform Polling
Transmission.

❒ To receive a message sent by any
Default ID Polling Transmission or
ID Override Polling Transmission,
it is necessary to specify the same
Polling ID as the sender's.

❒ Usually, you can only receive docu-
ments with a Polling ID from ma-
chines of the same make that
support the polling function. How-
ever, if the other party's fax machine
supports Polling Transmissions and
the “SEP” function, and also has
stored IDs. You can still perform
Polling Reception. See p.36 “SEP
Code”.

❒ To receive a message sent by any
Free Polling Transmission, it is not
necessary to specify the same Poll-
ing ID as the sender's.

Note
❒ For ID Polling Reception, program

a Polling ID in advance. See p.133
“Programming a Polling ID”.

Press [Transmission Mode] ⇒ [Polling
RX]. 

AAAA Depending on which method you
are using, choose one of the fol-
lowing procedures:
11
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Default ID/Free Polling RX

A Check that [Default ID/Free Polling
RX] is selected.

Note
❒ If [Default ID/Free Polling RX] is

not selected, press [Default
ID/Free Polling RX].

ID Override Polling Reception

A Press [ID Override Polling Recep-
tion].

B Specify a 4 digit ID Code with
the number keys and [A], [B],
[C], [D], [E] and [F].

Note
❒ A Polling ID may be any four

numbers (0 to 9) and charac-
ters (A to F) except 0000 and
FFFF.

❒ If you make a mistake, press
[Clear] or the {{{{Clear/Stop}}}} key
and try again.

BBBB Press [OK].

The Transmission Mode menu is
shown.

CCCC Press [OK].
The initial display is shown.

Polling Reserve Report

This report is printed after Polling Re-
ception has been set up.

Note
❒ You can turn this function on or off

with the User Parameters. See
p.113 “Changing the User Parame-
ters” (Switch03, Bit3).

Polling Result Report

This report is printed after a Polling
Reception has been completed and
shows its result.

Note
❒ You can also check the result of a

Polling Reception with the Journal.
See p.19 “Printing the Journal”.

❒ You can turn this function on or off
with the User Parameters. See
p.113 “Changing the User Parame-
ters” (Switch03, Bit4).



2. Checking and Canceling
Transmission Files
After you have pressed the {{{{Start}}}} key (after scanning originals), you can check
and edit the destination or settings of Memory Transmission. You can also can-
cel a transmission, change the settings of a transmission, print a stored file, print
a list of stored files and resend a file which failed to transmit.
This function is available for Memory Transmission, Confidential Transmission,
Transfer Request, Polling Reception and Polling Transmission.

Note
❒ There is no file being sent, received or stored by Memory Transmission, if

[Change/Stop TX File] does not appear on the display.
❒ You cannot check or edit a file being sent or received. Also a Confidential

Transmission file or stored file to be printed as a report cannot be checked or
edited.

Displaying Confirmation of Transmission

AAAA Press [Change/Stop TX File].

BBBB Select [Check/Change Settings].

Scanning date/time, transmission
mode, destination, total number of
destinations, total number of origi-
nals, file number and Status are
displayed.

CCCC Select files to be changed or
checked.

Note
❒ If there are multiple destina-

tions for a file, only the destina-
tion selected first is displayed.

❒ If there are multiple destina-
tions for a file, only the number
of destinations that have not
been sent the file are displayed.

DDDD Check a file, and then press [Exit].

EEEE Press [Exit].
The initial display is shown.
13
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Canceling a Transmission

You can cancel a transmission of a file
when the file is being sent, stored in
memory or fails to transmit. All the
scanned data is deleted from memory.
You can cancel a file for Memory
Transmission. This function is useful
to cancel a transmission when you
notice a mistake in destination or
with the originals after storing origi-
nals in memory. To cancel Memory
Transmission, search for the file to be
canceled among the files stored in
memory, and delete it.

Note
❒ If you cancel a transmission while

the file is being sent, some pages of
your file may have already been
sent and will be received at the
other end.

❒ If the transmission finishes while
you are carrying out this procedure,
transmission cannot be canceled.

AAAA Press [Change/Stop TX File].

BBBB Select the files whose transmis-
sion you want to cancel.

Note
❒ To display only the files being

sent, press [Files under TX].
❒ If there are multiple destina-

tions for a file, only the number
of destinations that have not
been sent the file are displayed.

❒ If there are multiple destina-
tions for a file, only one destina-
t ion  can  be  d isplayed.  To
display all destinations, press
[Check/Change Settings].

CCCC Press [Stop Transmission].

The file you selected to stop trans-
mitting is deleted.

Note
❒ To not cancel Transmission,

press [Save].
❒ To cancel another transmission,

repeat from step B.

DDDD Press [Exit].

The initial display is shown.

Deleting a Destination

You can delete destinations.

Note
❒ If you delete a destination that is

the only destination for a transmis-
sion, the transmission is canceled.

AAAA Press [Change/Stop TX File].

BBBB Press [Check/Change Settings].

CCCC Select the file from which you
want to delete a destination.

Note
❒ To display only the files being

sent, press [Files under TX].
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DDDD Press [Change] for the destination
you want to delete.

EEEE Press [Clear] to delete the destina-
tion.

FFFF Press [Exit].

Note
❒ To delete another destination,

repeat from step C.

GGGG Press [Exit].

The initial display is shown.

Adding a Destination

AAAA Press [Change/Stop TX File].

BBBB Press [Check/Change Settings].

CCCC Select the file to which you want
to add a destination.

Note
❒ To display only the files being

sent, press [Files under TX].

DDDD Press [Add].

EEEE Specify the destination.

Note
❒ You can specify the destination

using the number keys or soft-
ware keys.

❒ You can also program SUB
Code and Sub-address by press-
ing [Adv. Features].

FFFF Press [Exit].

Note
❒ Repeat steps D and E, if you

want to add another destina-
tion.

GGGG Press [Exit].
The initial display is shown.
15
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Changing the Transmission 
Time

You can change the transmission time
which has been specified with Send
Later. See p.5 “Sending at a Specific
Time (Send Later)”.
You can also delete the transmission
time. When the transmission time is
deleted, the file is transmitted imme-
diately.

AAAA Press [Change/Stop TX File].

BBBB Press [Check/Change Settings].

CCCC Select the file for which you want
to change or cancel the transmis-
sion time.

Note
❒ To display only the files being

sent, press [Files under TX].

DDDD Press [Change TX time].

EEEE Press [Clear], and then reenter the
transmission time using the
number keys or select [Economy
Time].

Note
❒ If you select [Economy Time], the

economy time already specified
is entered. See p.102 “General
Settings/Adjustment”.

❒ If you press [Transmit Now], the
file is transmitted immediately.
However, if there is a file on
standby that file is sent first.

FFFF Press [OK].

GGGG Press [Exit].

Note
❒ Repeat from step C, if you want

to change another transmission
time.

HHHH Press [Exit].
The initial display is shown.
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Printing a File

If you wish to check the contents of a
file that is stored in memory and has
not been sent yet, use this procedure
to print it out.

Note
❒ Polling Transmission files are not

displayed in the list. Confidential
Transmission files are displayed,
but cannot be printed.

AAAA Press [Change/Stop TX File].

BBBB Press [Print File].

CCCC Select the file you want to print.

Note
❒ If there are multiple destina-

tions for a file, only the number
of destinations that have not
been sent the file are displayed.

❒ If you want two sided printing
(option), press [Print 2 Sides].

DDDD Press the {{{{Start}}}} key.

Note
❒ To cancel a file from printing,

press [Stop Printing]. The display
will return to step C.

EEEE Press [Exit].
The initial display is shown.

Note
❒ Repeat from step C, if you want

to print another file.

Re-sending a File

This function is valid when the ma-
chine is set up with the User Parame-
ters to save messages that could not
be sent in memory.

Preparation
You should select “Store for 24
hours” for “Store a message that
could not be transmitted” in User
Parameters. See p.113 “Changing
the User Parameters” (Switch24,
Bit0).

Note
❒ If you select the failed transmis-

sion file, you can resend it. This
function allows you to transmit a
fax message again. These files will
be kept for either 24 or 72 hours de-
pending on how you program this
function. See p.113 “Changing the
User Parameters”  (Switch24,
Bit1,0).

AAAA Press [Change/Stop TX File].

BBBB Press [Transmit Failed File].
17
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CCCC Select a file you want to resend.

Note
❒ “TX failed” is displayed for files

that could not be sent.
❒ If there are multiple destina-

tions for a file, only the destina-
tion selected first is displayed.

❒ If there are multiple destina-
tions for a file, only the number
of destinations that have not
been sent the file are displayed.

DDDD Press [OK].

Note
❒ To add destinations, press [Add]

and specify the destinations.
❒ Repeat from step C to resend

another file.

EEEE Press [Exit].

The initial display is shown.
Transmission starts.

Printing a List of Files in 
Memory (Print TX File List)

Print this list if you wish to find out
which files are stored in memory and
what their file numbers are. Knowing
the file number can be useful (for ex-
ample when erasing files).

Note
❒ The contents of a file stored in

memory can also be printed. See
p.17 “Printing a File”.

AAAA Press [Change/Stop TX File].

BBBB Press [Print List].

CCCC Press the {{{{Start}}}} key.

Note
❒ To cancel printing, press [Stop

Printing]. The display will return
to step B.

DDDD Press [Exit].

The initial display is shown.



3. Communication
Information
Printing the Journal

The Journal contains information
about maximum of the last 50 commu-
nications made by your machine. It is
printed automatically after every 50
communications (receptions+trans-
missions).
If the machine is installed with the
optional ISDN Unit or the optional
Extra G3 Interface Unit, you can print
the Journal of each line type.
You can also print a copy of the Jour-
nal at any time by following the pro-
cedure below.

Important
❒ The contents of a Journal printed

automatically are deleted after
printing. If you administer the his-
tory of transmissions and recep-
tions, we recommend that you
keep the Journal. You can check a
total of 200 communications (1,000
with the optional Fax Function Up-
grade unit) (receptions+transmis-
sions) on the display.

❖❖❖❖ All
Prints the results of communi-
cations in the order made.

❖❖❖❖ Print per File No.
Prints only the results of com-
munications specified by file
number.

❖❖❖❖ Print per User Code
Prints only the results of com-
munications for a specified User
Code. See p.11 “Reading the
Display Panel and Using Keys”,
Facsimile Reference (option) <Ba-
sic Features>.

Note
❒ The sender's name column of the

Journal is useful when you need to
program a special sender. See
p.117 “Special Senders to Treat
Differently”.

❒ If you do not want the Journal
printed, you can turn it off. See
p.113 “Changing the User Parame-
ters” (Switch03, Bit7).

❒ You can set whether the Journal is
automatically printed after every
50 communications in User Param-
eters. See p.113 “Changing the
User Parameters” (Switch03, Bit7).

❒ You can set whether you print the
Journal by line type. See p.113
“Changing the User Parameters”
(Switch19, Bit1).

Press [Information] ⇒ [Print Journal].

AAAA Select a printing mode.

Selecting [All] 

A Press [All].
19
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Selecting [Print per File No.] 

A Press [Print per File No.].
B Enter a 4 digit file number.

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key
and try again.

Selecting [Print per User Code] 

A Press [Print per User Code].
B Specify an 8 digit User Code

with the number keys.

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key
and try again.

C Press [####].

D Check the User Code shown on
the display.

BBBB Press the {{{{Start}}}} key.

Note
❒ To cancel a file printing, press

[Stop Printing] and the display
will return to step A.

CCCC Press [Exit].

Return to the initial display.
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Checking the Transmission Result (TX File 
Status)

You can browse a part of the Trans-
mission Result Report on the display.

Note
❒ Only the transmission result of the

last  200 communicat ions are
shown.

❒ If a transmission is completed while
you are using this function, the re-
sult will not be shown until you exit
TX File Status and start it again.

Press [Information] ⇒ [TX File Status].

AAAA Check the transmission results.

Transmission results are displayed
from the latest result in groups of
six.
Scanning date/time, destination,
originals quantity, file number and
status are displayed.

Note
❒ “Destination” shows the Own

Fax Number or Fax Header in-
formation of a receiver. For a
transmission from a computer,
“-- LANFAX -->” is shown.

BBBB Press [Exit].
Return to the initial display.
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Checking the Reception Result (RX File 
Status)

You can browse a part of the Recep-
tion Result Report on the display.

Note
❒ Only the reception result of the last

200 communications are shown.
❒ If a message is received while you

are using this function, the result
will not be shown until you exit RX
File Status and start it again. 

Press [Information] ⇒ [RX File Status].

AAAA Check the reception results.

Reception results are displayed
from the latest result in groups of
six.
Scanning date/time, Transmission
Station, originals quantity, file
number and Status are displayed.

Note
❒ TX Station shows the fax number

of a sender or Fax Header infor-
mation.

BBBB Press [Exit].
Return to the initial display.
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Displaying the Memory Status

Use this function to display a summa-
ry of current memory usage. Items
shown are the percentage of free
memory space, the number of re-
ceived Confidential Messages, the
number of files to be sent, the number
of Memory Lock files and the number
of received messages to be printed.
Press [Information] ⇒ [Memory Status].

AAAA Check the memory status.

Note
❒ “Others” will be displayed:

• When storing attachment
files. See p.97 “Storing and
Changing an Auto Docu-
ment”.

• When storing Transfer Re-
quest files. See p.37 “Transfer
Request”.

• When storing originals in the
Information Boxes. See p.29
“Information Boxes”.

• When sending to the Person-
al Box. See p.27 “Personal
Boxes”.

BBBB Press [Exit].
Return to the initial display.
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Printing a Confidential Message

This function is designed to prevent
unauthorized users from reading
your messages. If someone sends you
a message using Confidential Trans-
mission, it is stored in memory and
not automatically printed. To print
the message you have to enter the
Confidential ID Code. When your
machine has received a Confidential
Message, the Confidential File (i)
indicator lights.

Preparation
Before using this function, pro-
gram your Confidential ID. See
p.132 “Programming a Confiden-
tial ID”.

Important
❒ If the main power switch is off

more than 1 hour, all Confidential
Messages are deleted. In that case,
use the Power Failure Report to
identify which messages have
been deleted. See p.149 “Power
Failure Report”.

Limitation
❒ You must program the Confiden-

tial ID for Confidential Reception
to work.

Confirm that the Confidential File in-
dicator is lit, and then press [Informa-
tion] ⇒ [Print Confidential RX File].

Note
❒ If the machine received a message

with SUB Code, the Confidential
File indicator also lights.

❒ Print a message with SUB Code us-
ing the [Print Personal Box File] func-
tion. See p.28 “Printing Personal
Box Messages”.

❒ If no Confidential Messages have
been received, the message “No
reception file.”  is shown.
Press [Exit].

AAAA Enter a 4 digit Confidential ID
with number keys.

The Confidential ID is not shown
on the display.

Note
❒ You must enter the Confidential

ID programmed in this machine
when the received file has no
Confidential ID.

❒ You must enter the Confidential
ID programmed by the sender.
Confirm the sender's Confiden-
tial ID in advance.
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❒ If the Confidential IDs or Per-
sonal Confidential IDs do not
match, the message “No recep-
tion file under specified
Confidential ID.”  is dis-
played. Press [Exit] to cancel the
operation, and then check the
Confidential ID or Personal
Confidential ID with the other
party and try again.

BBBB Press the {{{{Start}}}} key.
Return to the initial display.

----If you cannot print confidential 
files even if the Confidential 
File (iiii) indicator is lit.

The Confidential File indicator also
lights if the machine received a mes-
sage with a SUB Code. Check the Per-
sonal Boxes.

Note
❒ Print from the Personal Box, when

a file has been sent from another
party with a SUB Code attached.
See p.27 “Personal Boxes”.

Confidential File Report

When this function is turned on, this
report is printed whenever your ma-
chine receives a Confidential Mes-
sage.

Note
❒ You can turn this function on or off

with the User Parameters. See
p.113 “Changing the User Parame-
ters” (Switch04, Bit0).
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Printing a File Received with Memory Lock

This is a security function designed to
prevent unauthorized users from
reading your messages. If Memory
Lock is switched on, all received mes-
sages are stored in memory and are
not automatically printed. To print
the messages, you have to enter the
Memory Lock ID Code. When your
machine has received a message with
Memory Lock, the Confidential File
(i) indicator blinks.

Preparation
Before using this function, pro-
gram your Memory Lock ID. See
p.133 “Programming a Memory
Lock ID”.
Before using this function, set Con-
fidential Transmissions to On.

Important
❒ If the main power switch is turned

off for more than an hour, all mes-
sages protected by Memory Lock
will be deleted. In that case, the
Power Failure Report will be print-
ed so you can confirm which mes-
sages have been deleted. See p.149
“Power Failure Report”.

Note
❒ If free memory space is low, mes-

sages may not be received.
❒ You can also apply a Memory Lock

to messages that come only from
certain senders. See p.117 “Special
Senders to Treat Differently”.

❒ Messages received by Polling Re-
ception are automatically printed
even if this function is switched on.

Confirm that the Confidential File in-
dicator is lit, and press [Information] ⇒
[Print Memory Lock].

Note
❒ If no messages were received

while Memory Lock was switched
on, the message “No reception
file.” is shown. Press [Exit] 

AAAA Enter a 4 digit Memory Lock ID
with the number keys.

The Memory Lock ID is not shown
on the display.

Note
❒ If the Memory Lock ID does not

match, the message “Speci-
fied code does not corre-
spond to programed  Memory
Lock ID.” is shown. Press [Exit]
and retry after checking the
Memory Lock ID.

BBBB Press the {{{{Start}}}} key.

When the printing is completed,
return to the initial display.
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Personal Boxes

Personal Boxes

This function lets you set up the ma-
chine so that incoming messages ad-
dressed to certain users are stored in
memory instead of being printed out
immediately. Each user must be as-
signed a SUB Code (Personal Code)
that has been designated as a Person-
al Box beforehand. When the other
party sends their message, they spec-
ify the SUB Code of the user to which
they are sending the message. When
the message is received, it is stored in
the Personal Box with the matching
SUB Code. In order to print a message
received into a Personal Box, you
must enter the SUB Code assigned to
that Personal Box. This enables sever-
al individuals or departments to
share a single fax machine yet be able
to differentiate between messages.
Furthermore, if you specify a receiver
for the Personal Box, instead of being
stored in memory, incoming messag-
es with this SUB Code appended are
forwarded directly to the destination
you specify.

Note
❒ To be able to receive messages into

a Personal Box you must inform
the sender of the SUB Code regis-
tered for that Personal Box and ask
them to send the message using
SUB Code Transmission with that
SUB Code. See p.35 “SUB Code”.

❒ When messages have been re-
ceived into Personal Boxes, the
Confidential Reception/Memory
Lock indicator lights and the Con-
fidential File Report is printed. See
p.25 “Confidential File Report”.

❒ If a Personal Box is assigned a re-
ceiver, incoming messages are
transferred to that receiver with a
Forwarding Mark stamped on
them. See p.109 “Forwarding”.

❒ If a receiver is not assigned, print
these messages. See p.28 “Printing
Personal Box Messages”.
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Printing Personal Box Messages

Follow these steps to print a message
that has been received into a Personal
Box.

Preparation
Before using this function, set the
Personal Box in advance. See p.124
“Programming/Editing Personal
Boxes”.

Note
❒ If you print a Personal Box mes-

sage, it is deleted.
Press [Information] ⇒ [Print Personal
Box File].

AAAA Select the box with the message
you want to print.

When a password is required

The screen is displayed, when the
selected Personal Box password is
set in advance. The password is
regis tered in  “Key Operator
Tools” .  See  p .124 “Program-
ming/Editing Personal Boxes”.

A Enter the password, and then
press [OK].

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key
and try again.

BBBB Press the {{{{Start}}}} key.
The received messages are printed.

Note
❒ To stop printing, press [Stop

Printing]. The display will return
to step A.

CCCC Press [Exit].
Return to the initial display.

Note
❒ If there are messages in other

Personal Boxes, the display will
return to step A. Repeat from
step A to print another file.
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Information Boxes

Information Boxes

Use the Information Box function to
set up the machine as a Fax Informa-
tion service or Document Server. By
scanning documents into Information
Boxes, other parties can receive these
messages whenever they request
them.

• You can program documents for
this function with “Storing Mes-
sages in Information Boxes”. See
p.29 “Storing Messages in Infor-
mation Boxes” .

• For other parties to be able to re-
trieve a message programmed in
an Information Box, you need to
inform them of the SEP Code as-
signed to that Information Box.

• When a SEP Code Polling Reception
request is made by another party,
the SEP Code they specify is com-
pared with the SEP Codes pro-
grammed in that Information Boxes.
If a code matches, the message
stored in the Information Box is sent
to the other party automatically.

• You can check on the contents of
Information Boxes with “Printing
Information Box Messages”. See
p.30 “Printing Information Box
Messages”.

• You can set a password for Infor-
mation Boxes in advance. A pass-
word can be set in “Key Operator
Setting”.  See p.126 “Program-
ming/Editing Information Boxes”.

Storing Messages in 
Information Boxes

Follow these steps to store a message
in an Information Box.

Preparation
Before using this function, set the
Information Box in advance. See
p.126 “Programming/Editing In-
formation Boxes”.

Note
❒ One Information Box stores one

file.
❒ The stored file is not deleted auto-

matically. If you want to delete a
stored file. See p.31 “Deleting In-
formation Box Messages”.

Press [Information] ⇒ [Store/Delete/Print
Information Box File].

AAAA Select the box in which you want
to store the file.

Note
❒ When there are pre-registered

files, a file mark is displayed at
the end of the Box Name.
29
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❒ A message is displayed, when
selecting a box with a file stored
in it. Press [Register], when
changing the file name. The
originally stored file will be
overwritten.

❒ If the password is already set,
enter it into the Confirmation
Display.

BBBB Place the original, and then select
any scan settings you require.

Note
❒ You can also select the follow-

ing settings.
• Book Fax
• 2 Sided Original (Optional

Document Feeder (ADF) is
required)

• Stamp (Optional Document
Feeder (ADF) is required)

CCCC Press the {{{{Start}}}} key.

The machine starts to scan the orig-
inal.
To stop scanning, press [Stop Scan-
ning]. The display will return to
step A.

DDDD Press [Exit].

Return to the initial display.

Note
❒ To store a message in another

Information Box continuously,
return to step A.

Printing Information Box 
Messages

Follow these steps to print the mes-
sage stored in an Information Box.
Press [Information] ⇒ [Store/Delete/Print
Information Box File].

AAAA Press [Print File], and select the box
that contains the stored file you
want to print.

The SEP Code and Box Name are
displayed.

Note
❒ You cannot select a box which

has no stored file.
❒ If the password is already set,

enter it into the Confirmation
Display.

BBBB Press the {{{{Start}}}} key.
The machine starts to print.

Note
❒ If you want 2 sided printing

(option), press [Print 2 Sides] be-
fore pressing the {{{{Start}}}} key.

❒ To stop printing, press [Cancel]
and the display will return to
step A.

❒ To stop printing, press [Stop
Printing] and the display will re-
turn to step A.
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CCCC Press [Exit].

Return to the initial display.

Note
❒ Repeat from step A to print an-

other stored file in the box.

Deleting Information Box 
Messages

Follow these steps to delete a file
stored in an Information Box.
Press [Information] ⇒ [Store/Delete/Print
Information Box File].

AAAA Press [Delete File], and select the
box that contains the stored file
you want to delete.

The SEP Code and Box Name are
displayed.

Note
❒ You cannot select a box which

has no stored file.
❒ If the password is already set,

enter it into the Confirmation
Display.

BBBB Press the {{{{Start}}}} key.

The machine starts to print.

Note
❒ If you want 2 sided printing

(option), press [Print 2 Sides] be-
fore pressing the {{{{Start}}}} key.

❒ To stop printing, press [Stop
Printing] and the display will re-
turn to step A.

CCCC Press [Exit].

Return to the initial display.

Note
❒ Repeat from step A to delete an-

other stored file in another box.
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4. Other Transmission Features
Handy Dialing Functions

Chain Dial

This allows you to compose a tele-
phone number from various parts,
some of which may be stored in
Quick Dials and some of which may
be entered using the number keys.

Note
❒ Maximum length of a telephone or

fax number: 254 digits
❒ For Memory Transmission and Im-

mediate Transmission, insert a
pause between parts of a number.
For On Hook Dial and Manual Di-
al, no pause is needed. 

----(Example) 01133-1-555333
Assume that 01133 is stored in Quick
Dial key.
A Place the original, and then select

any scan settings you require.
B Press the Quick Dial key which is

programmed “01133”.
C Press the {{{{Pause/Redial}}}} key.
D Enter {{{{1}}}}, {{{{5}}}}, {{{{5}}}}, {{{{5}}}}, {{{{3}}}}, {{{{3}}}},

{{{{3}}}} with the number keys.
E Press the {{{{Start}}}} key.

Redial

The machine memorizes the last 10
destinations that have been dialed. If
you wish to send a message to a des-
tination which you sent faxes recent-
ly, the Redial function saves you time
by finding and entering the number
again.

Limitation
❒ The following kinds of destina-

tions are not memorized:
• Quick Dials
• Group Dials
• Destinations dialed by a Pro-

gram
• Destinations dialed as End Re-

ceivers for Transfer Request 
• Forwarding terminal of the Sub-

stitute Reception
• Destinations dialed using the

external telephone or optional
handset keypad

• Destinations dialed by Redial
(regarded as already stored in
memory)

• Second and later destinations
broadcasted

❒ Do not dial any numbers before
you press the {{{{Pause/Redial}}}} key. If
you press the {{{{Pause/Redial}}}} key af-
ter entering numbers using the
number keys, a pause will be en-
tered instead.
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AAAA Press the {{{{Pause/Redial}}}} key.

BBBB Select a destination you want to
redial.

Note
❒ As the date and time of the

reading of the original has be-
come a key, select it by pressing
on it.

❒ If the receiver uses a fax ma-
chine of the same manufacturer
that is capable of programming
the Own Name, that name may
be shown on the display instead
of the fax number. See p.39 “In-
itial Settings and Adjustments”,
Facsimile Reference (option) <Ba-
sic Features>.
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Advanced Features

SUB Code

Normally you can only use Confiden-
tial Transmission to send messages to
fax machines of the same make that
have the Confidential Reception func-
tion. See p.7 “Confidential Transmis-
sion”. However, if the other machine
supports a similar function called
“SUB Code”, you can send fax mes-
sages to the other party using this
method instead.

Limitation
❒ You cannot use this function with

G4.

Note
❒ The ID can be up to 20 digits long

and consist of numbers, spaces, *
and #.

❒ You can store IDs in Quick Dials,
Groups and Programs. See p.81
“Registering and Changing Key-
stroke Programs”. See p.42 “Quick
Dial”, Facsimile Reference (option)
< B a s i c  F e a t u r e s > .  S e e  p . 4 6
“Groups”, Facsimile Reference (op-
tion) <Basic Features>.

❒ You cannot select this function
when carrying out standard Confi-
dential Transmission.

Dial the facsimile number using the
number keys, and then press [Adv.
Features] ⇒ [SUB Code].

AAAA Press [TX SUB Code].

BBBB Enter a SUB Code with the
number keys, and then press [OK].

Note
❒ If you make a mistake, press

[Cancel] or the {{{{Clear/Stop}}}} key
and try again.

CCCC To enter a password, press [Pass-
word (SID)].

DDDD Enter the password with the
number keys, and then press [OK].

EEEE Press [Exit].

Note
❒ If you use Immediate Transmis-

sion and the destination fax ma-
chine does not support the SUB
Code function, a message will
appear on the display to inform
you of this. In this case, press
[OK] to cancel the transmission.
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SID Code

There are times when you may wish
to use a “SID” (Sender ID) when
sending confidential faxes with the
SUB Code function.

Note
❒ You can enter a SID using up to 20

digits.
❒ You can store IDs in Quick Dials,

Groups and Programs. See p.81
“Registering and Changing Key-
stroke Programs”. See p.42 “Quick
Dial”, Facsimile Reference (option)
< B a s i c  F e a t u r e s > .  S e e  p . 4 6
“Groups”, Facsimile Reference (op-
tion) <Basic Features>.

SEP Code

Normally you can only use Polling
Reception to receive faxes from ma-
chines that have the Polling Recep-
tion function of the same make.
However, if a machine of another
make supports a Polling Reception,
you can receive fax messages from
the other party using this method in-
stead. 
Poll the other machine. You can re-
ceive messages that have the same
SEP Code as the SEP Code you en-
tered.

Limitation
❒ You cannot use this function with

G4.

Note
❒ The ID can be up to 20 digits long.

❒ You can store IDs in Quick Dials,
Groups and Programs with the
number keys, and consist of space,
* and #. See p.42 “Quick Dial”, Fac-
simile Reference (option) <Basic Fea-
t u r e s > .  S e e  p . 4 6  “ G r o u p s” ,
Facsimile Reference (option) <Basic
Features>. See p.81 “Registering
and Changing Keystroke Pro-
grams”.

Dial the facsimile number using the
number keys, and then press [Adv.
Features] ⇒ [SEP Code].

AAAA Press [RX SEP Code].

BBBB Enter a SUB Code with the
number keys, and then press [OK].

Note
❒ If you make a mistake, press

[Cancel] or the {{{{Clear/Stop}}}} key
and try again.

CCCC To enter a password, press [Pass-
word (PWD)].

DDDD Enter the password with the
number keys, and then press [OK].

EEEE Press [Exit].
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FFFF Press [Transmission Mode].

GGGG Select [Polling RX].

HHHH Press [Default ID/Free Polling RX] and
[OK].

Note
❒ To cancel Polling RX, press [Can-

cel]. The display will return to
step G.

IIII Press [OK].

The initial display is shown.
If you press the {{{{Start}}}} key, Polling
Reception will start.

PWD Code

There are times you may wish to use
a password when receiving faxes by
polling with the SEP Code function.

Note
❒ You can enter a password up to 20

digits long.
❒ You can store IDs in Quick Dials,

Groups and Programs. See p.42
“Quick Dial”, Facsimile Reference
(option) <Basic Features>. See p.46
“Groups”, Facsimile Reference (op-
tion) <Basic Features>. See p.81
“Registering and Changing Key-
stroke Programs”.

Transfer Request

Transfer Request allows fax machines
that have this function to automati-
cally distribute incoming messages to
multiple fax destinations. This func-
tion helps you save costs when you
send the same message to more than
one place in a distant area, and saves
time since many messages can be sent
in a single operation.
The diagram below may make the
concept clearer.
The Transfer Stations you specify
must be machines of the same make
as this machine and have the Transfer
Station function.
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The following terminology is used in
this section. 

❖❖❖❖ Requesting Party
The machine where the message
originates from.

❖❖❖❖ Transfer Station
The machine that forwards the in-
coming message to another desti-
nation.

❖❖❖❖ End Receiver
The final destination of the mes-
sage or the machine to which the
Transfer Station sends to. End Re-
ceivers must be programmed into
Quick Dials or Groups in the
Transfer Station.

Preparation
Before you can use this function,
you must program the Polling ID
and your own fax number. See
p.133 “Programming a Polling
ID”, p.131 “Transfer Report”.

Limitation
❒ The Transfer Stations you specify

must be machines of the same
make as this machine and have the
Transfer Station function.

❒ You cannot use Transfer Request
without programming the fax
number of the Requesting Party in
Quick Dial or Speed Dial.

Note
❒ Polling ID's of the Requesting Par-

ty (this machine) and Transfer Sta-
tions must be identical.

❒ You can specify up to 500 Transfer
Stations in a Transfer Request.
However, you can only specify up
to 50 Transfer Stations from the
number keys.

❒ You can have up to 30 End Receiv-
ers per Transfer Station. If you
specify a Transfer Station Group,
the Group counts as a single re-
ceiver. 

❒ The combined total of End Receiv-
ers and Transfer Stations you spec-
ify with the number keys cannot
exceed 100. See p.33 “Number
Keys”, Facsimile Reference (option)
<Basic Features>.

Specify the Transfer Station with ei-
ther Quick Dials or the number keys,
and then press [Adv. Features] ⇒
[Transfer Req.].

AAAA Press [Receiving Station].

BBBB Dial an End Receiver.

Note
❒ You cannot enter the numbers

of the End Receivers directly.
The numbers must be stored in
Quick Dials or Groups in the
Transfer Station(s). To specify
an End Receiver, use the special
format described below.

❒ To cancel the Transfer Request,
press [Cancel].
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Quick Dial

A Press [qqqq Quick Dial].
B Enter the number (2 or 3 digits)

of the Quick Dial where the
End Receiver is stored.

For example, to choose the
number stored in Quick Dial 01
in the Transfer Station, enter:
{{{{0}}}} {{{{1}}}}.

Speed Dial

A Press [qqqqpppp Speed Dial].

B Enter the number (2 or 3 digits)
of the Speed Dial code.

For example, to choose the
number stored in Speed Dial 12
in the Transfer Station, enter:
{{{{1}}}} {{{{2}}}}.

Group Dial

A Press [qqqqpppppppp Group Dial].

B Enter the number (2 digits) of
the Group number.

For example, to choose the
number stored in Group Dial 04
in the Transfer station, enter:
{{{{0}}}} {{{{4}}}}.
To cancel the Transfer Request,
press [Cancel].

CCCC Press [Add].

Repeat step B to enter more End
Receivers.

Note
❒ Press [UUUU Prev.] or [TTTT Next] to see

the End Receivers already en-
tered. You can select an End Re-
ceiver from this list and remove
it by pressing [Clear] or the
{{{{Clear/Stop}}}} key.

❒ When you have specified all the
End Receivers, go to step D.

DDDD Press [OK].

EEEE Press [Exit].

Note
❒ The Transfer Stations and End

Receivers are displayed.

Sub-address

The optional ISDN Unit is required.

ISDN allows two or more terminals
(such as a fax machine and digital tel-
ephone) to be connected to a single
line. These terminals are identified by
their sub-address numbers. If the ter-
minals connected to the line at a des-
tination are assigned sub-addresses,
dialing a sub-address allows you to
direct your fax message to a particu-
lar terminal at the destination.

Limitation
❒ Sub-addresses can only be used

with ISDN.

Note
❒ You can program a sub-address in

Quick Dial.
To send using Sub-address, first, se-
lect either G4 or G3 (ISDN). Second,
dial the fax number with the number
keys and then press [Adv. Features] ⇒
[Sub-add./UUI].
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Note
❒ When the optional ISDN Unit is in-

stalled, the line used for G3 is set to
ISDN.

Reference
See p.43 “Changing the Line
Type”.

AAAA Select [Sub-address].

BBBB Enter the destination sub-address
with the number keys, and then
press [OK].

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key
and try again.

CCCC Press [Exit].

UUI

The optional ISDN Unit is required.

Limitation
❒ UUI can only be used with ISDN.

Note
❒ You can program a UUI in Quick

Dial.
To send using UUI, first, select either
G4 or G3 (ISDN). Second, dial the fax
number with the number keys and
then press [Adv. Features] ⇒ [Sub-
add./UUI].

Note
❒ When the optional ISDN Unit is in-

stalled, the line used for G3 is set to
ISDN.

AAAA Select [UUI].

BBBB Enter the destination UUI with
the number keys, and then press
[OK].

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key
and try again.

CCCC Press [Exit].
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On Hook Dial

This is just like using the external tel-
ephone, except you do not have to
pick up the external telephone before
dialing. Just press the {{{{On Hook Dial}}}}
key and dial the number. If you hear
a voice, you can pick up the external
telephone and speak with the other
party.

Limitation
❒ This function is not available for

the optional Extra G3 Interface
Unit.

Note
❒ This function is not available in

some countries.
❒ On Hook Dial does not work with

ISDN lines.

AAAA Place your original, and then se-
lect any scan settings you require.

BBBB Press the {{{{On Hook Dial}}}} key.

You will hear a low tone from the
internal speaker. If you wish to
cancel this operation, press the {{{{On
Hook Dial}}}} key again.

CCCC Dial.

The machine immediately dials the
destination.

Note
❒ You can adjust the volume of

On-hook sound by pressing
[Higher] or [Lower] in the upper
right-hand corner of the screen.
The volume can also be prepro-
grammed in “Initial Settings
and Adjustments”. See p.53
“Adjusting Volume”, Facsimile
Reference (option) <Basic Fea-
tures>.

❒ If you make a mistake, press the
{{{{On Hook Dial}}}} or {{{{Clear Modes}}}}
key and return to step B.

DDDD When the line is connected and
you hear a high-pitched tone,
press the {{{{Start}}}} key.

Note
❒ If you hear a voice, pick up the

external telephone before you
press the {{{{Start}}}} key and notify
the destination that you want to
send a fax message (ask them to
switch to Facsimile mode).

❒ After transmission, the machine
will return to standby mode. 

❒ If you want to cancel a transmis-
sion, press the {{{{Clear/Stop}}}} key
and remove the originals.
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Manual Dial

The external telephone or optional Handset is required.

Pick up the handset of the external
telephone and dial. When the line is
connected and you hear a high-
pitched tone, press the {{{{Start}}}} key to
send your fax message. If, on the oth-
er hand, you hear a voice at the other
end, continue your conversation as
you would normally over the tele-
phone.

Limitation
❒ Manual Dial does not work with

ISDN lines.
❒ This function is not available for

the optional Extra G3 Interface
Unit.

❒ The result of a transmission with
Manual Dial is not mentioned in
the Transmission Result Report
(Immediate Transmission).

❒ Set originals on the exposure glass.
The optional Document Feeder
(ADF) cannot be used.

AAAA Place your original, and then se-
lect any scan settings you require. 

BBBB Pick up the external telephone.

You will hear a tone.

CCCC Dial.
The machine immediately dials the
destination.

Note
❒ If you make a mistake, replace

the external telephone and try
again from step B. 

DDDD When the line is connected and
you hear a high-pitched tone,
press the {{{{Start}}}} key to send your
fax message.

Note
❒ If you hear a voice, notify the

destination that you want to
send a fax message (ask them to
switch to Facsimile mode).

EEEE Replace the handset of the exter-
nal telephone.

After transmission, the machine
will return to standby mode. 

Note
❒ If you want to cancel transmis-

sion, press the {{{{Clear/Stop}}}} key
and remove the originals.
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Changing the Line Type

The optional ISDN Unit or Extra G3 Interface Unit is required.

When the optional ISDN Unit and Ex-
tra G3 Interface Unit are installed,
you can connect to up to a maximum
of 3 lines.

Note
❒ When you install the optional

ISDN Unit or Extra G3 Interface
Unit, you can specify the line type
home position from “Gen. Set-
tings/Adjust”. See p.102 “General
Settings/Adjustment”.

❒ When sending a fax, you can select
the line type if dialing with the
number keys or Chain Dial.

❖❖❖❖ G3
G3 is selected after power up or
when the machine is reset. If you
install Extra G3 Interface Unit, you
can select “G3-1” or “G3-2” de-
pending on the number of the in-
stalled unit.

❖❖❖❖ G4
ISDN line is selected.

Limitation
❒ If you select the G4 mode, JBIG

compression is not available.

❖❖❖❖ Which line is used for G3 transmis-
sions?
ISDN lines can be used for G3 com-
munication as well as G4 commu-
n i c a t i o n .  I f  t h e  m a c hi n e  i s
connected with an ISDN and ana-
log (PSTN) line, each line can be
available by selecting “G3 Auto”.
Select “I-G3” when the ISDN line is
connected to G3.

Note
❒ If you wish to use an analog

(PSTN) line for G3 transmis-
sion, contact your service repre-
sentative.

❒ If you use ISDN for G3, you can
use Sub-address and UUI.
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----Auto Identification
This function is used when G4 is se-
lected. The machine first tries a G4
communication and if it cannot con-
nect because the receiver is not a G4
terminal, it automatically switches to
G3 and redials.

Note
❒ If the G3 line at the destination is

connected to the ISDN via a TA
(Terminal Adapter) or a PABX,
since the called number is on IS-
DN, it is regarded as G4 and the
Auto Identification function may
not automatically switch this ma-
chine to G3.

❒ When you use G3 with ISDN, you
can set the sub-address.

AAAA Press [Select Line].

BBBB Select the line you want to use.

When an optional ISDN Unit is in-
stalled.

When an optional Extra G3 Inter-
face Unit is installed.

Note
❒ If you select “G3 Auto”, the ma-

chine will use any available line.
This increases efficiency.

CCCC Press [Exit].

The initial display is shown.
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Sub Transmission Mode

Book Fax

Use to send book originals from the
exposure glass. Pages are scanned in
the order shown below.

Limitation
❒ The Original Position and Page

Opening Orientation
❒ Depending on the paper sizes

available on the destination ma-
chine, the message may be reduced
when printed at the other end.

Note
❒ You can have bound originals

scanned in left page first or right
page first. You can set which page
(left or right) the machine scans
first by default with the User Pa-
rameters. See p.113 “Changing the
User Parameters” (Switch06, Bit6).

Press [Sub TX Mode] ⇒ [Book Fax].

AAAA Select the size of the original.

Note
❒ If you choose A3, the original

will be sent using Image Rota-
tion Transmission. See p.59
“Transmission with Image Ro-
tation”.

BBBB Select [From first Page] or [From sec-
ond Page].

Note
❒ Select “From first Page” to send

a book original from the first
page.

❒ Select “From second Page” if
you want to send a cover letter
as the first page.

CCCC Press [OK].

DDDD Press [OK].
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2-Sided Transmission 
(Double-Sided Transmission)

The optional Document Feeder (ADF) is
required.

Use this function to send 2-sided orig-
inals.

Note
❒ Originals placed on the exposure

glass cannot be sent.
❒ The front and back of the scanned

original will be printed in order on
separate sheets at the other end.
The orientation of alternate sheets
may be reversed at the other end. If
you want to print the original with
the same orientation at the other
end, specify the “Original Posi-
tion” and “Page Opening Orienta-
tion”.

❒ This function is only available with
Memory Transmission.

❒ This function is only available us-
ing the optional Document Feeder
(ADF).

❒ You can confirm whether both
sides were properly scanned in
with the Stamp function. See p.53
“Stamp”.

Press [Sub TX Mode] ⇒ [2 Sided Origi-
nal].

AAAA Specify “Original Position”.

Note
❒ Make sure that the specified

“Original Position” matches the
orientation of originals loaded
in the optional Document Feed-
er (ADF).

BBBB Specify Page Opening Orienta-
tion from [Top to Top] or [Top to Bot-
tom].

CCCC Specify the Transmission Mode
from [2 Sided from 1st Page] or [1 Sid-
ed for 1st Page].

Note
❒ Select “2 Sided from 1st Page”

to send a 2 Sided Original from
the first page.

❒ Select “1 Sided for 1st Page” if
you want to send a cover letter
as the first page.

DDDD Press [OK].

EEEE Press [OK].
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Standard Message Stamp

Use this function to stamp a standard
message at the top of the first original
sent.
There are four types of standard mes-
sages: “Confidential”, “Urgent”,
“Please phone” and “Copy to corres.
section”
You can also program other messages.

Note
❒ While this function is in use, the

second and third lines of the “La-
bel Insertion” are not printed. See
p.55 “Programming the Label In-
sertion”.

❒ When there is an image around the
area where the standard message
is to be stamped, that image is de-
leted.

❒ To program a standard message,
use the “Program/Change/Delete
Standard Message” function. See
p.96 “Programming and Changing
Standard Messages”. See p.97 “De-
leting Standard Messages”.

Press [Sub TX Mode] ⇒ [Std. Message].

AAAA Select the standard message to be
stamped, and then press [OK].

Note
❒ The machine cannot stamp mul-

tiple standard messages.

BBBB Press [OK].

Sending an Auto Document

If you often have to send a particular
page to people (for example a map, a
standard attachment or a set of in-
structions), store that page in the
memory as an Auto Document. This
saves rescanning the document every
time you want to send it.
You can fax an Auto Document by itself,
or attach it to a normal fax message.

Preparation
You need to program an Auto Doc-
ument. See p.97 “Storing and
Changing an Auto Document”.

Important
❒ Whenever you store or change an

Auto Document, we recommend
that you print the Auto Document
list for reference. See p.101 “Re-
ports/Lists”.

Note
❒ You can attach one Auto Docu-

ment to each transmission. 
❒ You can store up to 6 Auto Docu-

ments (up to 18 with optional Ex-
pansion Memory installed). See
p.97 “Storing and Changing an
Auto Document”.

❒ Files with Auto Documents are
sent by Memory Transmission. 

❒ When sending an Auto Document
with another files, the Auto Docu-
ment is sent first.

❒ Storing Auto Documents reduces
the amount of free memory slightly.
Unless you delete the document,
free memory will not return to 100%.

❒ You can print an Auto Document
currently stored in memory. See
p.48 “Printing documents stored
as Auto Documents”.
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Press [Sub TX Mode] ⇒ [Auto Docu-
ment].

AAAA Select Auto Document file, and
then press [OK].

When you fax an Auto Document
by itself, press then [TX Stored
File(AD) Only].

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key
and try again.

BBBB Press [OK].

Printing documents stored as Auto 
Documents

This function is used for printing doc-
uments stored as Auto Documents.
This function is very convenient as it
can be used for confirming the con-
tents of stored files.
Press [Sub TX Mode] ⇒ [Auto Docu-
ment].

AAAA Select Auto Document file to be
printed.
When you fax an Auto Document
by itself, press [TX Stored File(AD)
Only].

BBBB Press [Print File].

CCCC Press the {{{{Start}}}} key.
Once the printing has been com-
pleted, the display will return to
step A.

Note
❒ To cancel printing, press [Can-

cel]. The display will return to
step A.

DDDD Press [Cancel].

Return to the initial display.

Note
❒ You can also send Auto Docu-

ments. See p.47 “Sending an
Auto Document”.
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Sending a Stored File

Use this function to send documents
that are stored in the Document Serv-
er. You can specify and send multiple
documents, and also send them with
scanned originals all at once.
You can also print the stored originals
with [Print File]. See p.51 “Printing
stored documents”.

Preparation
Store the documents to be sent in
advance. See p.84 “Using the Doc-
ument Server”.

Sending stored documents

The machine sends documents that
are stored in the Document Server.
The documents stored in the Docu-
ment Server can be sent again and
again until they are deleted. Once
sent, documents are stored into the
Document Server. Therefore, you can
send them in just one operation with-
out having to set your originals again.

Limitation
❒ You cannot use the following

transmission methods.
• Free Polling Transmission
• Default ID Transmission
• ID Override Transmission
• Immediate Transmission
• Parallel Memory Transmission

See p.57 “Parallel Memory
Transmission”.

• On Hook Dial
• Manual Dial

Note
❒ Only documents stored using the

fax feature can be sent. Documents
stored using the copy feature,
printer feature or scanner feature
cannot be sent.

❒ You can specify a maximum of 30
documents at one time.

❒ The machine can send a total of 400
pages in one operation. With the
optional Expansion Memory, it can
send a maximum of 1,000 pages.

❒ The specified documents are sent
with the scan settings made when
they were stored.

❒ Received messages cannot be spec-
ified as stored documents.

Press [Sub TX Mode] ⇒ [Select Stored File].

AAAA Select the documents to be sent.

Note
❒ When multiple documents are

selected, they are sent in the or-
der of selection.

❒ Press [TX Order] to arrange the
order of the documents to be
sent.

❒ Press [File Name] to place the doc-
uments in alphabetical order.

❒ Press [User Name] to place the
documents in order by the pro-
grammed User Name.

❒ Press [Date] to place the docu-
ments in order by the pro-
grammed date.
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Specifying documents from the 
“File List”

A Press [UUUU Prev.] or [TTTT Next] to dis-
play the documents to be sent.

B Select the file name.

Specifying documents from the 
“User Name”

A Press [Search by User Name].

B When the User Code is pro-
grammed, press the User Name
of the registered document,
and then go to step DDDD.

Note
❒ These User Names are pro-

grammed in the User Code in
the “System Settings”.

❒ To search by entering the
User Name, press [Non-pro-
gramed Name], and then go to
step C. Partial matching is
used to search for the User
Name.

C When the User Code is not pro-
g r am m ed ,  e n te r  th e  U se r
Name.

D Press [OK].

E Select the file name to be sent.

Specifying documents from the 
“File Name”

A Press [Search by File Name].

B Select the file name to be sent,
and press [OK].

Note
❒ Partial matching is used to

search for the file name.
C Select the file name to be sent.

BBBB If you select a document with a
password, enter the password.

If the document does not have a
password, proceed to step D.

CCCC Press [OK].

DDDD When you want to add your origi-
nals to the stored documents and
send them all at once, press [RRRR
Origi. + Stored File] or [Stored file + RRRR
Origi.].

When sending only the stored doc-
uments, go to step E.
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Note
❒ When [RRRR Origi. + Stored File] is

pressed, the machine sends the
“Originals” and then “Stored
Files”. When [Stored file + RRRR  Ori-
gi.] is pressed, the machine
sends the “Stored Files” and
then “Originals”.

❒ The added originals are not
stored.

EEEE Press [OK].

Note
❒ To add an original to the stored

documents, place the original,
and then select any scan settings
you require.

FFFF Press [OK].

Specify the destination, and then
press the {{{{Start}}}} key.

Printing stored documents

Use this function to print the docu-
ments stored in the Document Server.

Note
❒ Only documents stored using the

fax feature can be printed. Docu-
ments stored using the fax feature
are prefixed with an “F” in front.

❒ You can print the documents
saved from the copy or the printer
function with the Document Serv-
er. You cannot print the docu-
ments saved from the scanner
function with this mode.

❒ Received messages cannot be spec-
ified as stored documents.

❒ You can also print the first page
only to check the content of the
original.

❒ You can specify and print multiple
documents.

❒ When specifying and printing
multiple documents, page num-
bers are put on all the files. You can
specify whether to put page num-
bers on your files in “User Param-
eters”. See p.113 “Changing the
User Parameters” (Switch18, Bit3).

Press [Sub TX Mode] ⇒ [Select Stored
File].

AAAA Select the document to be printed.

Note
❒ Press [File Name] to place the

documents in alphabetical or-
der.

❒ Press [User Name] to place the
documents in order by the pro-
grammed User Name.

❒ Press [Date] to place the docu-
ments in order by the pro-
grammed date.

❒ To see details of the selected
document, press [Detail]. To re-
turn to the standby menu, press
[File List].
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Selecting a document from “File 
List”

A Press [UUUU Prev.] or [TTTT Next] to dis-
play the document to be sent.

B Select the file name.

Specifying a document from the 
“File Name”

A Press [Search by File Name].

B Enter the file name to be print-
ed, and then press [OK].

Note
❒ Partial matching is used to

search for the file name.

Reference
See “Entering Text” in the
General Settings Guide.

C Select the file name.

Specifying a document from the 
“User Name”

A Press [Search by User Name].

B Press the User Name of the
document to be sent.

Note
❒ To search by entering the

User Name, press [Non-pro-
gramed Name] , and then enter
the User Name. The User
Name is searched by partial
matching.

Reference
See “Entering Text” in the
General Settings Guide.

C Press [OK].

D Select the file name.

BBBB Press [Print File] or [Print 1st Page].

When [Print File] is pressed, the ma-
chine prints all the pages. When
[Print 1st Page] is pressed, the ma-
chine prints only the first page.

Limitation
❒ When “Print 1st Page” is select-

ed, originals larger than size A4
are printed after they are re-
duced to A4 size.

❒ The machine can print up to 30
files using the “Print 1st Page”
function.

Note
❒ To print both sides, press [Print 2

Sides].

CCCC Press the {{{{Start}}}} key.

Note
❒ When only the first page is

printed, the file name is printed
at the top of the paper.

❒ To cancel printing, press [Can-
cel].
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Stamp

The optional Document Feeder (ADF) is
required.

When sending a fax message using
the optional Document Feeder (ADF),
the machine can stamp a circle mark
at the bottom of the original. When
sending a 2-sided document, the doc-
ument is marked at the bottom of the
front page and top of the rear page.
This stamp indicates that the original
has been successfully stored in mem-
ory for Memory Transmission, or that
it has been successfully sent for Im-
mediate Transmission.

Note
❒ Do not open the optional Docu-

ment Feeder (ADF) while scanning
a document. A document jam
could occur.

❒ Stamp only works when scanning
from the optional Document Feed-
er (ADF).

❒ When the stamp starts getting
lighter, replace the cartridge. See
p.153 “Replacing the Stamp Car-
tridge”.

❒ If a page was not stamped even
though the Stamp function is
turned on, you need to resend that
page.

❒ If you use this function often, you
can set the default in “General Set-
tings/Adjustment” so that this
function is always on. In this case,
Stamp can easily be turned off for
any single transmission by press-
ing [Stamp]. See p.102 “General Set-
tings/Adjustment”.

To set the stamp, press [Sub TX Mode]
⇒ [Stamp] and [OK].

Note
❒ To cancel the stamp, press [Stamp]

again before pressing [OK].

Transmission Options

This section describes various func-
tions that you can switch on and off
for any particular transmission by fol-
lowing the procedure at the end of
this section.
In addition, if you frequently use a
certain option configuration, you can
change the default home position (on
or off) of each option.

Fax Header Print

The stored name is printed on the re-
ceiver's paper.
You can store two Fax Headers: “First
Name” and “Second Name”.
For example, if you store your depart-
ment name in one and your organiza-
tion name in the other, you could use
the first when sending internal faxes
and the second for external faxes.

Important
❒ In the USA, this must contain the

telephone number of the line your
machine is connected to. It will be
printed on the header of every
page you send. Required in the
USA.
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Note
❒ In the USA, law requires that your

fax number be included in the fax
Header. Register the fax number
and switch on Fax Header Print
with the User Parameters. See
p.113 “Changing the User Parame-
ters”.

❒ If you used the number keys to
specify the receiver, the first head-
er name will be printed on the re-
ceiver's paper.

Label Insertion

With this function you can have the
receiver's name printed on the mes-
sage when it is received at the other
end. The name will be printed at the
top of the page and will be preceded
by “To”. See p.96 “Programming and
Changing Standard Messages”.

Note
❒ You can switch this function on and

off with “Gen. Settings/Adjust”.
See p.102 “General Settings/Ad-
justment”. It is convenient to set
frequently used settings in the Gen-
eral Settings/Adjustment and use
“Transmission Options” for occa-
sionally used settings.

❒ When there is an image around the
area where the Label is to be print-
ed, that image is deleted.

Sender Stamp

When there is data, such as the User
Name and department name, pro-
grammed into the User Code, you can
have the machine print a sender
stamp on the right edge of your pa-
per.

Note
❒ Enter the User Name in System

Settings.
❒ You can switch this function on

and off with “Gen. Settings/Ad-
just”.

Reduced Image Transmission

Using this function, your message is
sent at a reduced size (93%) with a
blank margin on the left. 

Note
❒ You can switch this function on and

off with “Gen. Settings/Adjust”.
See p.102 “General Settings/Ad-
justment”. It is convenient to set
frequently used settings in the
General Settings/Adjustment and
use “Transmission Options” for
occasionally used settings.

❒ This function is not available with
Immediate Transmission or a spec-
ified transmission of a stored doc-
ument. 

❒ Image Rotation is not available
with this function.

Auto Reduce

When this function is turned on, if the
receiver's paper is smaller than the
paper you are sending on, the mes-
sage is automatically reduced to fit
onto the paper available at the other
end.
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Important
❒ If you turn this function off, the

scale of the original is maintained
and some parts of the image may
be deleted when printed at the oth-
er end.

Note
❒ You can switch this function on and

off with “Gen. Settings/Adjust”.
See p.102 “General Settings/Ad-
justment”. It is convenient to set
frequently used settings in the
General Settings/Adjustment and
use “Transmission Options” for
occasionally used settings.

Default ID Transmission

If you turn this function on, transmis-
sion will only take place if the desti-
nation's Polling ID is the same as
yours. This function can stop you
from accidentally sending informa-
tion to the wrong place (you need to
coordinate Polling ID's with the other
party).

Note
❒ You can switch this function on and

off with “Gen. Settings/Adjust”.
See p.102 “General Settings/Ad-
justment”. It is convenient to set
frequently used settings in the
General Settings/Adjustment and
use “Transmission Options” for
occasionally used settings.

Selecting transmission options for a 
single transmission 

Press [Sub TX Mode] ⇒ [Options].

AAAA Select options to be set up.

Programming the Fax Header 
Print

A Press [ON] to specify “Fax
Header Print”.

Note
❒ To close the option settings,

go to step B.

Programming the Label Insertion

A Press [Programed Name] in “La-
bel Insertion”.

Note
❒ To close the option settings,

go to step B.
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Programming the stamp sender 
name

A Press [Change].

B Press the name of the user to be
stamped.

Note
❒ The set User Name is dis-

played, when the User Code
has been stored. See “User
Code” in the General Set-
tings Guide.

❒ You can switch titles when
you press on the Title key.

❒ To stamp a non-registered
User Name, press [Non-pro-
gramed Name], and then enter
the User Name.

❒ If you do not want to stamp
the sender's stamp, press [No
Stamp].

C Press [OK].

Note
❒ To close the option settings,

go to step B.

Programming the Reduced 
Image TX

A Press [ON] in “Reduced Image
TX”.

Note
❒ To close the option settings,

go to step B.

Programming the Auto Reduce

A Press [ON] in “Auto Reduce”. 

Note
❒ To close the option settings,

go to step B.

Programming the Default ID TX

A Press [ON] in “Default ID TX”.

Note
❒ To close the option settings,

go to step B.

BBBB Press [OK].
The screen returns to the Sending
menu screen.

Note
❒ When changing the settings,

[Option Settings] will be high-
lighted in dark.

CCCC Press [OK].

DDDD Set the destination, and then
press the {{{{Start}}}} key.

EEEE Press [OK].

Note
❒ The Sub Transmission menu is

shown.

FFFF Press [OK].

GGGG Dial, and then press the {{{{Start}}}}
key.
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More Transmission Functions

If Memory Runs Out While 
Storing an Original

If you run out of memory while stor-
ing an original (free space reaches
0%), “Memory is full. Cannot
scan more. Transmission will be
stopped.” is displayed.
Press [Exit] to transmit the stored pag-
es only.

Note
❒ In default, scanned pages are sent.

To change the settings to delete
scanned pages, contact your serv-
ice representative.

Parallel Memory Transmission

This function dials while the original
is being scanned. Standard Memory
Transmission stores the original in
memory, then dials the destination.
Parallel Memory Transmission al-
lows you to  quickly determine
whether a connection was made. In
addition, this function scans the orig-
inal faster than Immediate Transmis-
sion. This is useful when you are in a
hurry and need to use the original for
another purpose.

Limitation
❒ Standard Memory Transmission is

used instead of Parallel Memory
Transmission in the following cas-
es.
• When the line is busy and could

not be connected to
• With Send Later

• When you store an original for
Memory Transmission while
another communication is in
progress

• When two or more destinations
are specified

• When you send only an Auto
Document

• When the first page of an origi-
nal is placed on the exposure
glass

• When you send messages
stored in the Document Server

Note
❒ You can turn this function on or off

with the User Parameters. See
p.113 “Changing the User Parame-
ters” (Switch07, Bit2).

❒ Standard Memory Transmission
may be used instead of Parallel
Memory Transmission depending
the optional equipment installed if
there is not enough free memory
left.

❒ If you use this function, the Memo-
ry Storage Report will not be print-
ed.

❒ If the {{{{Clear/Stop}}}} key is pressed,
an original is jammed or memory
runs out during Parallel Memory
Transmission stops. The Transmis-
sion Result Report is printed and
files are deleted.

❒ When Parallel Memory Transmis-
sion is used, the total number of
originals in “Fax Header Print” is
not automatically printed.
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Checking the Transmission 
Result

• Turn the Transmission Result Re-
port on if you want a report to be
printed after every successful
transmission. See p.21 “Memory
Transmission”, Facsimile Reference
(option) <Basic Features>.

• If you leave the Transmission Re-
sult Report off, the report will not
be printed after every transmis-
sion. However, if a transmission
fails, a Communication Failure Re-
port will be printed instead. See
p.61 “Communication Failure Re-
port”.

• You can also check the transmis-
sion result by examining the Jour-
n a l .  S ee  p . 1 9  “P r i n t i n g  t h e
Journal”.

• You can either print or scroll
through the Journal on the display.
See p.21 “Checking the Transmis-
sion Result (TX File Status)”.

Automatic Redial

If a fax message could not be trans-
mitted because the line was busy or
an error occurred during transmis-
sion, redialing is done 5 times in 5
minutes intervals (these figures vary
according to which country you are
in).
If redialing fails after four redials, the
machine cancels the transmission and
prints a Transmission Result Report
or Communication Failure Report.

Batch Transmission

If you send a fax message by Memory
Transmission and there is another fax
message waiting in memory to be
sent to the same destination, that
message is sent along with your orig-
inal. Several fax messages can be sent
with a single call, thus eliminating the
need for several separate calls. This
helps save communication costs and
reduce transmission time.
Fax messages for which the transmis-
sion time has been set in advance are
sent by batch transmission when that
time is reached.

Note
❒ You can turn this function on or off

with the User Parameters. See
p.113 “Changing the User Parame-
ters” (Switch14, Bit2).

❒ The originals to be transmitted at a
specific time will be sent at time.

❒ If the line is busy because originals
are under stand-by. It may not be
transmitted in turn once scanning
has been carried out. 

ECM (Error Correction Mode)

This function automatically sends
data that was not transmitted suc-
cessfully using a system that complies
with international standards.
ECM requires that the destination
machine has the same function. 

Note
❒ You can turn this function on or off

with the Key Operator Settings.
See p.112 “ECM”.
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Broadcasting Sequence

If you dial several destinations for the
same message (Broadcasting), the
messages are sent in the order in
which they were dialed. If the fax
message could not be transmitted, the
machine redials that destination after
the last destination specified for
Broadcasting. For example, if you
specify four destinations A through D
for broadcasting, and if the lines to
destinations A and C are busy, the
machine dials the destinations in the
following order: A, B, C, D, A, and C. 

Checking the Transmission 
Progress

To check which destinations the fax
message has been sent to so far, print
the TX file list.

Dual Access

The machine can scan other messages
into memory even while sending a
fax message from memory, receiving
a message into memory, or automati-
cally printing a report. Since the ma-
chine starts sending the second
message immediately after the cur-
rent transmission terminates, the line
will be used efficiently. 

Note
❒ Note that during Immediate

Transmission or when in User
Tools mode, the machine cannot
scan an original.

Transmission with Image 
Rotation

F or  mo st  purpo ses ,  p la ce  A 4 ,
81/2"×11" originals in the landscape
direction (L). If you place an A4,
81/2"×11" original in the portrait di-
rection (K), the image will be sent ro-
tated by 90°. Providing the receiver
has A4, 81/2"×11" landscape paper
(L), the message will be printed the
same size as the original.

Note
❒ This function is not available with

Immediate Transmission.
❒ When Image Rotation is used, all

messages are sent by normal Mem-
ory Transmission.

Simultaneous Broadcast

The optional ISDN Unit or Extra G3 In-
terface Unit is required.

The Standard Broadcast function
sends faxes one at a time to multiple
destinations in the order of specified
destination numbers.
The Simultaneous Broadcast func-
tion, however, can send faxes three at
a time to multiple destinations by
transmitting simultaneously over dif-
ferent lines.
This results in a shorter overall trans-
mission time.

Note
❒ This function can use a maximum

of 3 lines simultaneously.
❒ When using the optional Extra G3

Interface Unit, if you set the line se-
lection as “G3 Auto Select” before-
h a nd ,  t he  m a c hi n e  w i l l  us e
whichever G3 line is not busy. This
increases efficiency.
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JBIG Transmission

The optional Fax Function Upgrade Unit
is required.

If you use JBIG (Joint Bi-level Image
Experts Group) compression, you can
send photographic originals faster
than the other compression method.
You can only use this function with
G3/I-G3 line type.

Limitation
❒ This function requires that the oth-

er party's fax machine has both the
JBIG function and ECM function
(G3 communication only).

Note
❒ When the optional Extra G3 Inter-

face Unit is installed, JBIG recep-
tions of “G3-2” lines are standard.

❒ If ECM is turned off, JBIG Trans-
mission is not available. See p.112
“ECM”.
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Printed Report

Memory Storage Report

This report is printed after an original
is stored in memory. It helps you re-
view the contents and the destina-
tions of stored originals. Even if the
machine is set up not to print this re-
port, it is still printed if an original
could not be stored.

Note
❒ You can turn this report on and off.

See p.113 “Changing the User Pa-
rameters” (Switch03, Bit2).

❒ You can choose whether to include
part of the original image on the re-
port. See p.113 “Changing the User
Parameters” (Switch04, Bit7).

❒ If you use Parallel Memory Trans-
mission, the Memory Storage Re-
port will not be printed.

Transmission Result Report 
(Memory Transmission)

This report is printed when a Memo-
ry Transmission is completed so you
can check the result of the transmis-
sion. If two or more destinations are
specified, this report is printed after
the fax message has been sent to all
the destinations. If the machine is set
up not to print this report and the fax
message could not be successfully
transmitted, a Communication Fail-
ure Report is printed. See p.61 “Com-
munication Failure Report”.

Note
❒ You can turn this function on or off

with the User Parameters. See
p.113 “Changing the User Parame-
ters” (Switch03, Bit0).

❒ You can choose whether to include
part of the original image on the re-
port. See p.113 “Changing the User
Parameters” (Switch04, Bit7).

❒ The “Page” column gives the total
number of pages. The “Not Sent”
column gives the number of pages
that could not be sent successfully.

Communication Failure Report

This report is only printed if the
Transmission Result Report is turned
off and a message could not be suc-
cessfully transmitted with Memory
Transmission. Use it to keep a record
of failed transmissions so you can
send them again.

Note
❒ You can choose whether to include

part of the original image on the re-
port. See p.113 “Changing the User
Parameters” (Switch04, Bit7).

❒ The “Page” column gives the total
number of pages. The “Not Sent”
column gives the number of pages
that could not be sent successfully.
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Transmission Result Report 
(Immediate Transmission)

If you turn this report on, a report will
be printed after every Immediate
Transmission so you have a record of
whether the transmission was suc-
cessful or not. If the machine is set up
not to print this report and the fax
message could not be successfully
transmitted, the Error Report is print-
ed instead.

Note
❒ You can switch this report on or off

in the User Parameters. See p.113
“Changing the User Parameters”
(Switch03, Bit5).

❒ If the page was sent successfully,
the “Page” column gives the total
number of pages that was sent suc-
cessfully.



5. Reception Features
Reception

Immediate Reception

Each page of a fax message is printed
as soon as it is received. This method
is used for standard fax messages.

Normally this machine receives mes-
sages by Immediate Transmission.
But Memory Reception is used when
“Combine 2 Originals”, “Multi-copy
reception”, “Reverse Order Printing
reception” or “2-sided Printing” is set
to “ON”. See p.70 “Printing Options”.
If the conditions are that Substitute
Reception should be used, a fax mes-
sage is not printed. It will be stored in
memory. See p.63 “Memory Recep-
tion”. See p.64 “Substitute Recep-
tion”.

Note
❒ The machine may not be able to re-

ceive fax messages when the free
memory space is low.

❒ If free memory reaches 0% during
Immediate Reception, any further
reception becomes impossible and
the current communication is ter-
minated.

----Reception resolution 
This machine supports Standard, De-
tail and Super fine resolutions for re-
ception. If  you do not have the
optional Fax Function Upgrade Unit,
faxes sent at Super fine resolution
will be printed on your machine at
Detail resolution. This may differ
from the sender's intention.
Reception will not take place if there
is not enough free memory left. If free
memory reaches 0% during Immedi-
ate Reception, any further reception
becomes impossible and the current
communication is terminated.

Memory Reception

The machine waits until all pages of
the message have been received into
memory before printing the message.

This method is used with the follow-
ing functions:
• Combine 2 originals

See p.73 “Combine 2 Originals”.
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• Multi-copy when set to multiple
copies
See p.72 “Multi-copy Reception”.

• Reverse Order Printing
See p.74 “Reverse Order Printing”.

• Substitute Reception
See p.64 “Substitute Reception”.

• 2-sided Printing
See p.71 “2-Sided Printing”.

Important
❒ All the messages stored in memory

are deleted if the main power
switch is turned off for more than
one hour.

❒ The machine may not be able to re-
ceive large numbers of messages
or messages with a high data con-
tent. In such cases, we recommend
you switch the above functions off
or add a memory card.

Limitation
❒ The machine may not be able to re-

ceive fax messages when the free
memory space is low.

Note
❒ If the free memory space reaches

0% during Memory Reception, the
machine can no longer receive the
current fax message and stops
communicating. 

Substitute Reception

In Substitute Reception, a received fax message is stored in memory instead of
being printed. Substitute Reception gets used when the machine cannot prints
any fax messages. Fax messages received using Substitute Reception are auto-
matically printed when the condition which caused the machine to use Substi-
tute Reception is rectified.
Depending on why the machine cannot print, Substitute Reception might get
used for all fax messages received or for only those messages that match a spec-
ified condition.
The Receive File indicator lights to let you know when fax message(s) have been
received using Substitute Reception.

Note
❒ Reception may not take place if there is not enough free memory.
❒ If free memory reaches 0% during Substitute Reception, any further reception

becomes impossible and the current communication is terminated.
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Receiving messages unconditionally

If one of the conditions listed below occurs, the machine receives all fax messag-
es using Substitute Reception.

Receiving messages according to parameter-specified settings

If one of the conditions listed below occurs, the machine receives only those mes-
sages that match the conditions specified in the User Parameters. See p.113
“Changing the User Parameters” (Switch05, Bit1,2).

You can specify the following conditions with the User Parameters. See p.113
“Changing the User Parameters” (Switch05, Bit1,2).

Why Substitute Reception 
Occurred 

Indication/Status Solution

Paper is jammed. x is lit. Remove the jammed paper.

See “xCleaning Misfeeds” in the 
General Settings Guide.

Machine is busy printing 
with other function.

The machine is printing 
with other function.

The message will be printed after the 
current job finishes automatically. 

Output tray is full. The message “Follow-
ing output tray is 
full. Remove pa-
per.” appears.

Remove paper from output tray.

Cover is open. M is lit. Close the cover shown in the display.

Why Substitute Reception 
Occurred

Indication/Status Solution

All trays out of paper. B is lit. Add paper. See “BLoading Paper” 
in the General Settings Guide.

Toner is empty. D is lit. Replace the toner cartridge. See 
“DAdding Toner” in the General 
Settings Guide.

Note
❒ As a quicker solution, use anoth-

er color of toner by changing the 
color in “2nd Color Choice”. See 
p.75 “2nd Color Choice”.

All trays out of action. The message “This 
tray is out of or-
der.” appears.

Call your service representative.
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❖❖❖❖ When Own Name or Own Fax Number is received
The machine switches to Substitute Reception only when the sender has pro-
grammed their Own Name or Own Fax Number. If the power is switched off
for more than an hour, all the messages received into memory are deleted. In
that case, the Power Failure Report or the Journal can be used to identify
which messages are lost so you can ask the senders to transmit them again.

Important
❒ If a sender has not programmed their Own Name or Own Fax Number, the

machine may reject an important fax message. We recommend that you
ask important senders to program an Own Name or Own Fax Number in
advance.

❖❖❖❖ Free
The machine switches to Substitute Reception regardless of whether or not
the sender has programmed their Own Name or Own Fax Number.

❖❖❖❖ Polling ID match
The machine switches to Substitute Reception only when the programmed
Polling ID's of the other end and this machine are identical.

❖❖❖❖ Disable
The machine does not receive any messages.
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Reception Functions

Transfer Station

Transfer Stations allow you to expand
the standard functions of your fax
machine to set up complex networks.
Transfer Stations must be machines of
the same make.
The diagram below may make the
concept clearer.

The following terminology is used in
this section.

❖❖❖❖ Requesting Party
The machine where the message
originates from.

❖❖❖❖ Transfer Station (this machine)
The machine that forwards the in-
coming message to another desti-
nation.

❖❖❖❖ End Receiver
The final destination of the mes-
sage, that is the machine the Trans-
fer Station sends to. End Receivers
must be programmed into Quick
Dial or Groups in the Transfer Sta-
tion.

Limitation
❒ Polling ID's of the Requesting Par-

ty and Transfer Station must be
identical for this function to work.

❒ A Transfer Request cannot be sent,
if the fax number of the transfer
station (this machine) is not pro-
grammed in Quick Dial.

❒ If your line number is not pro-
grammed at the Transfer Station,
reception will not take place. See
p.131 “Transfer Report”.

❒ This machine will not receive a
Transfer Request unless it has
enough free memory to store two
or more destinations dialed from
the number keys. See p.33 “Restric-
t ions  when dial ing  with  the
number keys”, Facsimile Reference
(option) <Basic Features>.

❒ If the Requesting Party specifies a
Group for the End Receivers and
the total number of End Receivers
exceeds 500, the Transfer Station
cannot transfer the message and
sends a Transfer Result Report to
the Requesting Party.
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----Multistep Transfer
The principles of Transfer Stations
can be used to build up a multi-step
facsimile network where messages
are passed through several Transfer
Stations. By programming the End
Receivers in a Transfer Station Group,
you can enable this machine to trans-
fer messages onto other Transfer Sta-
tions.
For more information, contact your
service representative. 
This function can only be used if the
machines are made by the same mak-
er.

Reference
See p.46 “Groups”, Facsimile Refer-
ence (option) <Basic Features>.

----Sending the Transfer Result 
Report

This machine compares the fax
number of the Requesting Party with
the Requesting Party's number pro-
grammed in Quick Dial or Speed Di-
al. If the lower five digits of the two
numbers match, it sends the Transfer
Result Report to the Requesting Par-
ty.
For example:
• Requesting Party's own dial number:

001813-11112222

• Transfer Station's Quick Dial:
03-11112222

Transfer Result Report

This reports whether transmission to
the End Receivers was successful or
not.

Preparation
Program the Requesting Party fax
number into a Quick Dial key in
advance. See p.42 “Quick Dial”,
Facsimile Reference (option) <Basic
Features>.
Program your own fax number.
See p.131 “Transfer Report”.
Program the Polling ID. See p.133
“Programming a Polling ID”.

When the Transfer Station has trans-
ferred the message to all End Receiv-
ers, it sends the Transfer Result
Report back to the Requesting Party.
The machine prints the report if it
cannot be sent back to the Requesting
Party. You must program the fax
number of the Requesting Party in
Quick Dial in the Transfer Station.

Note
❒ You can set whether a portion of

the original image is printed on the
report with the User Parameters.
See p.113 “Changing the User Pa-
rameters” (Switch04, Bit7).
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JBIG Reception

The optional Fax Function Upgrade Unit
is required.

It allows you to receive messages sent
in the JBIG format. 

Limitation
❒ If ECM is turned off, JBIG Recep-

tion is not available. 
❒ This function is not available with

G4 communication.

Note
❒ When the optional Extra G3 Inter-

face Unit is installed, JBIG recep-
tions of “G3-2” lines are standard.

Auto Fax Reception Power-up

This machine can be set to shut down
automatically if no one has used it for
a while. In these situations, even
though the operation switch is off, the
machine can still receive incoming
messages as long as the main power
switch is on.

Important
❒ Reception is not possible if both

the operation switch and main
power switch are turned off.

Note
❒ You can set whether messages are

printed as soon as they are re-
ceived (Immediate Reception)
with the User Parameters. See
p.113 “Changing the User Parame-
ters” (Switch14, Bit0).

❒ You can also set that fax messages
received by Memory Reception
(Substitute Reception) will be
printed after the machine is turned
on.
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Printing Options

Print Completion Beep

When this function is turned on, the
machine beeps to let you know when
a received message has been printed.

Note
❒ You can alter the volume of the

beep or turn it off completely (set
the volume to the minimum level).
See p.53 “Adjusting Volume”, Fac-
simile Reference (option) <Basic Fea-
tures>.

Checkered Mark

When this function is turned on, a
Checkered Mark is printed on the
first page of fax messages to help you
separate them.

Note
❒ You can turn this function on or off

with the Reception Mode. See
p.104 “Reception Mode”.

Center Mark

When this function is turned on,
marks are printed halfway down the
left side and at the top center of each
page received. This makes it easy for
you to position a hole puncher cor-
rectly when you file received messag-
es.

Note
❒ The Center Mark may deviate a lit-

tle from the exact center of the
edge.

❒ You can turn this function on or off
with the Reception Mode. See
p.104 “Reception Mode”.
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Reception Time

You can have the date and time print-
ed at the bottom of the message when
it is received. You can turn this func-
tion on or off with the Reception
Mode. See p.104 “Reception Mode”.

Note
❒ When a received message is print-

ed on two or more sheets, the date
and time is printed on the last
page.

❒ The date and time when the mes-
sage was printed can also be re-
corded on the message. If you need
this function, please contact your
service representative.

2-Sided Printing

You can have a received message
printed on both sides of the paper.
You can turn this function on or off
with the Reception Mode. See p.104
“Reception Mode”.

Limitation
❒ To use this function, all pages of the

received document must be of the
same size—inform the sending party
of this beforehand if necessary. You
must also have paper set in your ma-
chine of the same size as that sent by
the sending party. In 2–Sided Print-
ing, this machine will correctly re-
ceive in A3L , B4L , A4KL ,
B5KL ,  A5KL (11"×17"L ,
81/2"×14"L, 81/2"×11"KL ,
81/2"×51/2"L). The following table
shows the results that can be
achieved when receiving with this
machine.

❒ This function works only when all
pages are of the same width and
are received into memory.

❒ This function cannot be used with
Combine 2 originals.

Note
❒ The machine will use Memory Re-

ception for 2-Sided Printing.
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❒ Printouts may vary depending on
how the sender set the originals.

❒ You can choose to have messages
only from selected senders printed
in this way. See p.117 “Special
Senders to Treat Differently”.

180 Degree Rotation Printing

When printing on both sides of the
paper, this machine rotates images as
shown in the diagram.

Multi-copy Reception

If you switch this function on, multi-
ple copies of each incoming fax mes-
sage will be printed. You can also
choose to have multiple copies made
of messages from particular senders.
See p.117 “Special Senders to Treat
Differently”. See p.104 “Reception
Mode”.

Note
❒ The maximum number of copies

that can be made for each message
is 10. If you are using Multi-copy
with Specified Senders, the maxi-
mum number is 10.

❒ You can turn this function on or off
with the Reception Mode. See
p.104 “Reception Mode”.

❒ The machine will use Memory Re-
ception for Multi-copy Reception.

Image Rotation

If you have set paper in the standard
tray K, incoming fax messages will
be rotated automatically to fit on the
paper.

Note
❒ You can choose to have received

messages printed from a specified
tray. See p.104 “Reception Mode”.

CP2B02E0

1 2 1 2
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Combine 2 Originals

When two messages of the same size
and direction are received consecu-
tively, they are printed on a single
sheet when you turn this function on.
This can help you economize on pa-
per.
• Two A5K messages are printed

side by side on a sheet of A4L. 
• Two B5K messages are printed

side by side on a sheet of B4L. 
• Two A4K messages are printed

side by side on a sheet of A3L. 
• Two 81/2"×51/2"K messages are

printed side by side on a sheet of
81/2"×11"L. 

• Two 81/2"×11"K messages are
printed side by side on a sheet of
11"×17"L. 

Limitation
❒ This function does not work with

messages larger than A5K, B5K,
A4K, 81/2" × 11"K or 81/2" ×
51/2"K. When A5K, B5K, A4K,
81/2" × 11"K or 81/2" × 51/2"K size
paper is loaded in the machine,
each page of the received message
is printed on a single sheet.

❒ If paper matching the size and di-
rection of a received document is
not available, “Combine 2 origi-
nals” is not possible.

❒ When “Combine 2 originals” and
“2-Sided Printing” are selected at
the same time, combine 2 originals
takes priority and 2-sided printing
is canceled.

Note
❒ You can turn this function on or off

with the User Parameters. See
p.113 “Changing the User Parame-
ters” (Switch10, Bit1).

❒  This function uses Memory Recep-
tion.

Page Separation and Length 
Reduction 

When the size of a received message
is longer than the paper loaded in the
machine, each page of the message
can be split and printed on several
sheets, or reduced and printed on a
single sheet. For example, this func-
tion splits the message if the message
length is 20mm (0.79") or longer than
the paper used. The message is re-
duced if it is less than 20mm (0.79")
longer. When a message is split, the
split mark (*) is inserted at the split
position and about 10mm (0.39") of
the split area is duplicated on the top
of the second sheet.
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Note
❒ Your service representative can

customize this function with the
following settings.
• Reduction
• Print split mark
• Overprinting
• Overprinting length
• Guideline for split

❒ You can adjust the overprinting
and reduction lengths within the
following ranges:
• Overprinting length: 4mm (0.16"),

10mm (0.39"), 20mm (0.79")
• Guideline for split: 0∼155mm

(5mm steps)/0∼6.1" (0.2" steps)

Reverse Order Printing

Normally, received pages are printed
and stacked on the tray in the order
they are received. If you turn this
function on, the machine will start
printing the message from the last
page received.

Note
❒ You can turn this function on or off

with the Reception Mode. See
p.104 “Reception Mode”.

❒ When this function is on, the first
page will be printed last.

❒ This function uses Memory Recep-
tion.

Page Reduction

If you receive a message that is longer
than the paper in the cassette, usually
the machine prints it on two pages. If
you turn this function on, the ma-
chine reduces the width and length of
the received image so that it will fit on
one page. If A4L paper size is loaded
and a message of B4L size is re-
ceived, the machine will reduce the
message to a single A4L sheet.

Note
❒ You can turn this function on or off

with the User Parameters. See
p.113 “Changing the User Parame-
ters” (Switch10, Bit3).

❒ When this function is used, the
printing quality may not be as
good as usual.

Reference
See p.73 “Page Separation and
Length Reduction”.
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TSI Print

Usually the sender's Fax Header is
printed on received messages. If the
sender has not programmed their Fax
Header, you will not be able to identi-
fy them. However, if you turn this
feature on, the sender's Own Name or
Own Fax Number is printed instead
so you can find out where the mes-
sage came from. See p.39 “Initial Set-
tings and Adjustments”, Facsimile
Reference (option) <Basic Features>.

Note
❒ You can turn this function on or off

in the User Parameters. See p.113
“Changing the User Parameters”
(Switch02, Bit3).

CIL/TID Print

The optional ISDN Unit is required.

Two functions are provided for iden-
tification of messages received by G4
(ISDN). If turned on, this information
will be printed on every page.
The CIL (Call Identification Line) re-
fers to the combination of the receiv-
er's Own Fax Number, name, the
sender's Own Fax Number and name,
time, and page number. The TID re-
fers to the name programmed by the
sender in their Fax Header.

Limitation
❒ These functions are available only

when receiving in G4 mode.
❒ If the sender's TID contains dou-

ble-byte characters (for example
Chinese characters), the TID will
not be printed even if TID Print is
turned on.

Note
❒ You can turn CIL and TID on or off

in the User Parameters. See p.113
“Changing the User Parameters”
(Switch02, Bit5 or Bit6).

FAX Print Color

You can specify a color for any re-
ceived message, list, report, stored
document, or auto document. You
can choose the color of toner from
Black, Cyan, Magenta.

Limitation
❒ The color specified for 2nd Color

Choice can not be used as a FAX
Print Color.

❒ This function is disabled in any
printing with the LAN FAX or
Document Server.

Note
❒ You can change the color with Re-

ception Mode. See p.104 “Recep-
tion Mode”.

2nd Color Choice

If this function is specified, the ma-
chine can print with 2nd Color when
the machine has run out of default
toner. It is useful that the 2nd toner
use as a reserve of toner.

Limitation
❒ The color specified for FAX Print

Color can not be used as a 2nd
Color Choice.

Note
❒ You can turn this function on and se-

lect the color with Reception Mode.
See p.104 “Reception Mode”.

❒ If the machine has run out of 2nd
Color, there is no additional substi-
tution.
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When There is No Paper of the 
Correct Size

If there is no paper in your machine
that matches the size of a received
message, the machine will choose a
paper size based upon the paper you
have available. For example, if your
machine has 81/2"×11"K and A3L
loaded and you receive a A4L size
message, check the A4L column of
the following table. The paper size at
the top has the highest priority. In this
case, since 81/2"×11"K is a higher pri-
ority than A3L, the message is print-
ed on 81/2"×11"K. 
If only B5L is loaded and you receive
an A3L message, the received mes-
sage is stored in memory and will not
be printed.

❖❖❖❖ Priority Table

• KK and LL indicate that the
message is split over two pages of
paper with the orientation and size
shown.

Note
❒ Paper placed in the bypass tray is

not usually selected for printing a
received message. However, you
can use this tray if you select the
bypass tray as the main paper tray
using Reception with Specified
Senders. See p.117 “Special Send-
ers to Treat Differently”.

❒ Widths that this machine can re-
ceive are A4, B4 and A3. Any mes-
sages narrower than A4 are sent as
A4 width with the length un-
changed.

❒ The paper size used to print a re-
ceived message may be different
from the size of the sent original.

❒ If the paper type is set to [Thick pa-
per] or [OHP], papers in the tray
will not be used for printing. See
p.78 “The trays that cannot be used
for printing fax documents”.

Reference
See p.73 “Page Separation and
Length Reduction”.
See p.74 “Page Reduction”.
See p.72 “Image Rotation”.

Page Reduction Disabled

Reduction in 
Sub-scan Direction 

Enabled

Page Separation 
Threshold

20mm (0.79")

Width or Length 
Priority

Width
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"Just Size" Printing

If you turn this function on and no pa-
per tray is stocked with paper of a
suitable size to print a received docu-
ment, a message will appear on the
display prompting you to load paper
of the required size. When you have
loaded the new paper, you can then
print the message.
Two messages can appear:
• Paper Cassette

• Bypass Tray

Limitation
❒ If the paper tray is pulled out, you

will not be able to print the mes-
sage. Be sure to return the paper
tray.

❒ The action that follows pressing
[Exit] varies depending on the sta-
tus of the machine when the mes-
sage occurred.
• If any received documents or re-

ports were being printed automat-
ically, the printer automatically
continues printing from where it
had left off. 

• If any documents or reports
were being printed manually,
the printer does not resume the
printing. Perform the opera-
tions from the beginning again. 

Note
❒ You can turn this function on or off

with the User Parameters. See
p.113 “Changing the User Parame-
ters” (Switch05, Bit5).

Having Incoming Messages 
Printed on Paper from the 
Bypass Tray

The optional Bypass Tray is required to
use this feafure.

You can have messages sent from
Specified Senders printed on paper
from the bypass tray. This is useful if
you need messages printed on a size
of paper not stocked in the paper cas-
sette(s).
You can set up to a maximum of 100
standard paper in the bypass tray.

Limitation
❒ You cannot output the received

paper into the optional Finisher
Unit, when using this function.
The paper will be delivered into
the machine's paper tray, even
when the optional Finisher Unit
has been set as the output tray. See
“Output Tray Settings” in the Gen-
eral Settings Guide.

Note
❒ The print area is determined by

optional Expansion Memory, Res-
olution, and the vertical length of
originals. 
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❒ If paper longer than 458mm is
used, the paper may get wrinkled,
it may not be sent, or a paper jam
may occur.

❒ Before you can use this function,
you need to turn on Authorized
Reception (Initial Setup Reception
Mode settings), program the Spec-
ified Senders (Key Operator Set-
tings) along with the Paper. See
p.104 “Reception Mode”. See p.117
“Special Senders to Treat Differ-
ently”.

❒ The machine can detect the paper
sizes of A4L, A3L(81/2"×11"L,
11"×13"L). When you load any
other size of paper, specify the pa-
per size. See p.122 “Programming
“Bypass Tray Paper Size””.

❒ If the specified paper size and the
size of paper set in the bypass tray
do not match, paper jams may oc-
cur or the image may be truncated. 

❒ If messages are printed on paper
smaller than A4, the image may be
truncated or split across sheets.

❒ If you use this function, Image Ro-
tation and 180 Degree Rotating
Printing are not possible.

Having Incoming Messages 
Printed on Paper from the 
Large Capacity Tray (LCT)

The optional Large Capacity Tray (LCT)
is required to use this function.

You can set the User Parameter so
that the priority is given to the Large
Capacity Tray (LCT) when printing
received messages. See p.113 “Chang-
ing the User Parameters” (Switch15,
Bit7).

Note
❒ The Large Capacity Tray (LCT)

takes priority when:
• “User Parameters” (Switch15,

Bit7) is set to “On”.
• “Paper Tray” is set to “Auto Se-

lect” .  See p.104 “Reception
Mode”.

• A4 KL has been selected ac-
cording to “Priority Table”.

• Paper is loaded in the Large Ca-
pacity Tray (LCT).

----The trays that cannot be used 
for printing fax documents

If the paper type is set to [Thick paper]
or [OHP], the paper in the tray will not
be used for facsimile functions such
as printing received documents, lists
or reports. Confirm the paper type
setting in System Settings. See "Tray
Paper Settings" in the General Set-
tings Guide.
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Where Incoming Messages are Delivered 
- Output Tray

G3/G4 Separate Tray

The optional Extra G3 Interface Unit or
optional ISDN Unit.

You can specify the document feed-
ing tray for each line. For example,
you can specify documents received
through the G3 line to be fed to the
“Standard Tray” and documents re-
ceived through the G4 line to be fed to
the “Upper Tray”, facilitating the sep-
aration of files.

Note
❒ To use this function, specify the

line and destination in “G3/G4
Separate Tray”. See p.104 “Recep-
tion Mode”.

Tray Shift

The optional Finisher or Shift Sort Tray
Unit is Required.

When the optional Finisher Unit is se-
lected for fax output, you can use the
Tray Shift function to have the inter-
nal delivery exit move to the left or
right whenever a fax or report is
printed.
This is useful for separating faxes
stacked in the finisher output tray.
For example, if the previous incoming
fax was output to the left, the next in-
coming fax will be output to the right
and vice-versa.

Note
❒ You can turn this function on or off

with the User Parameters. See
p.113 “Changing the User Parame-
ters” (Switch19, Bit0).
79



Reception Features

80

5



6. Simplifying the Operation
Programs

If you regularly send messages to a
particular destination or transmit us-
ing the same functions, you can save
a lot of repetitive keypad operations
by registering this information in a
Keystroke Program.

Registering and Changing 
Keystroke Programs

Keystroke Programs can be recalled
by just pressing a Quick Dial key. The
following procedure can be used to
program a new Keystroke Program or
overwrite an old one.
You can register the following items
in Keystroke Programs:
• Memory Transmission, Immediate

Transmission, destinations (up to
500 numbers), Resolution, Original
Type, G3 or G4 communication
mode (Only when a destination is
specified with the number keys),
Stamp, Send Later, Default ID,
Auto Document, Book Fax, Polling
Transmission, Polling Reception,
Transfer Request, 2-sided trans-
mission, optional functions

• Program name (up to 20 charac-
ters)

Important
❒ We recommend that you print the

Keystroke Program list and keep it
when you register or change a func-
tion. See p.101 “Reports/Lists”.

Limitation
❒ Transfer Request and broadcast

transmissions cannot be registered
at the same time.

Note
❒ You cannot change programs

which are being used for a Memo-
ry Transmission on standby.

❒ The maximum number of pro-
grams you can register is 100 (200
with the optional Fax Function Up-
grade Unit).

❒ Use the same procedure to regis-
tering and change programs. Fol-
low the procedure for the items
you want to change.

❒ The method to register or change
programs for Copy Function is dif-
ferent from that of Fax Function.

AAAA Prepare for registering the pro-
gram.

Note
❒ The procedure for program-

ming differs depending on the
items you want to register.

❒ Press the {{{{Clear Modes}}}} key to
cancel programming.

Example of registering a program 
using Send Later with the fax 
number “0123456789”.

A Press {{{{0}}}}, {{{{1}}}}, {{{{2}}}}, {{{{3}}}}, {{{{4}}}},
{{{{5}}}}, {{{{6}}}}, {{{{7}}}}, {{{{8}}}}, {{{{9}}}} with the
number keys.

B Press [Transmission Mode].

C Select [Send Later].
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D Enter the time to send.

Note
❒ If “Send Later” is already

specified, that time is shown.
Press the {{{{Clear Modes}}}} key to
change “Send Later”.

BBBB Press the {{{{Program}}}} key.

The program (Fax) is shown.

CCCC Select a program number in which
“*Not Programed” is shown.

Note
❒ If you make a mistake, press

[Cancel] and select a program
number again.

❒ When you change a Keystroke
Program, press [Store] after
pressing the program number
you want to change. If you
make a mistake, press [Do not
Store] and return to step C.

DDDD Enter the program name, and then
press [OK].
The program has been registered.

Note
❒ If you make a mistake, press

[Backspace] or [Delete All] and try
again.

❒ You should register the pro-
gram name.

EEEE Press [Exit]. 

The initial display is shown.

Using a program

Example of executing a program 
using Send Later with the fax 
number “0123456789”.

AAAA Make sure that the machine is in
Facsimile mode and the standby
display is shown.

Note
❒ If the standby display is not

shown, press the {{{{Facsimile}}}}
key.

BBBB Place your original.

Note
❒ If you have not a registered des-

tinations or scan settings as a
program, enter the fax number
for the destination and select
any scan settings you require.

CCCC Press the {{{{Program}}}} key.

DDDD Select a program number you reg-
istered.

The initial display is shown.
Then, the registered fax number
and time are shown. Transmission
Mode is selected.

EEEE Press the {{{{Start}}}} key.
The fax number and specified time
are shown on the display and the
machine starts to scan the original.
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Changing a program name

Limitation
❒ You cannot change the programs

names which are being used for
the Memory Transmission.

AAAA Make sure that the machine is in
Facsimile mode and the standby
display is shown.

Note
❒ If the standby display is not

shown, press the {{{{Facsimile}}}}
key.

BBBB Press the {{{{Program}}}} key.

CCCC Press [Change Name], and select the
program number for the name
you want to change.

DDDD Enter a new program name, and
press [OK].

The program name is changed.

EEEE Press [Exit].

The initial display is shown.

Deleting a Program

Note
❒ You cannot delete programs which

are being used for a Memory
Transmission.

❒ If you delete a program, the regis-
tered program name is also delet-
ed.

AAAA Make sure that the machine is in
Facsimile mode and the standby
display is shown.

Note
❒ If the standby display is not

shown, press the {{{{Facsimile}}}}
key.

BBBB Press the {{{{Program}}}} key.

CCCC Press [Delete], and then select the
program number you want to de-
lete.

The contents of the program are
shown on the display.

DDDD Press [Yes].

EEEE Press [Exit].
The initial display is shown.
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Using the Document Server

Use this function to store documents
in the Document Server of this ma-
chine.
The Document Server can store docu-
ments from various applications.
The documents that are stored using
a facsimile feature are available to
transmit by facsimile.
Storing in the Document Server ena-
bles the following:
• Once stored, a document can be

sent out as many times as you
want just by selecting it.

• Storing a document does not use
facsimile memory.

You can send and print multiple
stored documents as a single docu-
ment,  and also send them with
scanned originals at the same time.
Follow the instructions under [Select
Stored File] in [Sub TX Mode] when
sending or printing stored docu-
ments. See p.49 “Sending a Stored
File”.

Important
❒ Data stored in the machine might

be lost if some kind of failure oc-
curs. The supplier shall not be re-
sponsible for any damage that
might result from the loss of data.
For long-term storage of data, we
recommend the use of DeskTop-
Binder V2 Lite or DeskTopBinder
V2 Professional (option). For more
information, please contact your
local dealer.

Note
❒ The stored documents are not de-

leted even when there is a power
failure or the main power switch is
turned off.

❒ You can specify whether or not the
machine automatically deletes
documents from the Document
Server after a certain number of
days. The delete function is pre-
configured with the software and
automatically deletes any stored
document that is more than 3 days
(72 hours) old. You can change the
setting with “Key Operator Tools
— Auto Delete File”. See “Key Op-
erator Tools — Auto Delete File” in
the General Settings Guide.

❒ The fax feature has a memory ca-
pacity of approximately 1,000 doc-
uments.

❒ You can store approximately 2,000
pages (ITU-T No.1 chart) in the
Document Server, using the copy,
facsimile, printer, and scanner fea-
tures.

❒ You can store up to 400 pages
(1,000 pages with the optional Ex-
pansion Memory) per document.
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Storing a Document

You can send and store a document at
the same time. You can also just store
a document.

❖❖❖❖ File names
Files which have been read auto-
m a t i ca l l y  g e t  n a m e s  l i k e
“FAX0001” or “FAX0002”. See p.86
“Setting a File Name”.

❖❖❖❖ User Names
You can set this function if neces-
sary to know whom and what de-
pa r tments  a re  s tor ed  i n  the
machine. See p.85 “Programming a
User Name”.

❖❖❖❖ Password
You can set this function so as not
to send to unspecified people. See
p.86 “Setting a Password”.

Note
❒ The stored documents are given

“file names”, such as “FAX0001”
and “FAX0002”, automatically.
However, you can change the file
names. See p.87 “File Manage”.

❒ You can attach “User Names” to
the stored documents. See p.87
“File Manage”.

AAAA Make sure that the machine is in
Facsimile mode and the standby
display is shown.

If  the standby display is  not
shown, press the {{{{Facsimile}}}} key.

BBBB Place your original, and then se-
lect any scan settings you require.

CCCC Press [Store File].

DDDD Select [Store & Transmit] or [Store on-
ly].

Select [Store & Transmit] to send
documents after they are stored.

Select [Store only] to store docu-
ments.
When [Store only] is selected,
“pppppppppp”  is
shown.

EEEE Set the User Name, file name and
password if necessary.

Note
❒ If you are not going to set the

User Name, file name, or pass-
word, go to step F.

❒ You cannot change multiple
documents at once.

Programming a User Name

Note
❒ Set a User Name from those that

are programmed in the User
Code. See “User Code” in the
General Settings Guide.
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A Press [File Info. Setting].

B Press [User Name].

The User Name change menu is
shown.

C Press the User Name to be pro-
grammed, and then press [OK].
The specified User Name is
shown.

Note
❒ Press the title key to switch

between titles.
❒ To set an unprogrammed

User Name, press [Non-pro-
gramed Name], and then enter
the name. User Names that
are entered by pressing [Non-
programed Name] are not pro-
gra m me d  in t o  the  U ser
Code.

D Press [OK].

Setting a File Name

A Press [File Info. Setting].

B Press [File Name].

The File Name change menu is
shown.

C Enter the file name, and then
press [OK].

The  cha nged  f i l e  nam e i s
shown.

Reference
See “Entering Text” in the
General Settings Guide.

D Press [OK].

Setting a Password

A Press [File Info. Setting].

B Press [Password].

The Password setting menu is
shown.

C Enter a password using the
number keys, and then press
[OK].

pppp is shown.

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key,
and then reenter your pass-
word.

D Press [OK].

FFFF Press [OK].

GGGG If you have selected [Store & Trans-
mit], specify the receiver.

Note
❒ If you have selected [Store only],

go to step H.

HHHH Press the {{{{Start}}}} key.
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File Manage

You can change the file name, User
Name, and password of stored docu-
ments.
To change a stored document, delete
the document you no longer need,
and then reprogram the new docu-
ment. See p.88 “Delete File”.
Press [Sub TX Mode] ⇒ [Select Stored
File].

AAAA Press [Manage/Delete File], and then
s e l ec t  t h e  d o cu m e n t  t o  b e
changed.

Note
❒ You can specify multiple docu-

ments at one time.

BBBB If you select a document for
which a password is set, enter the
password. When a selected file
does not have a password, go to
step DDDD.

CCCC Press [OK].

DDDD Change the information of the
stored document. Change the de-
sired items.

Changing a User Name

A Press [Change User Name].

B Press [Clear].
The User Name is deleted.

C Enter the new User Name.

Note
❒ Press the title keys to switch

between titles.
❒ To set an unprogrammed

User Name, press [Non-pro-
gramed Name], and then enter
the name.

❒ User Names that are entered
by pressing [Non-programed
Name] are not programmed
into the User Code.

Reference
See “Entering Text” in the
General Settings Guide.

D Press [OK].

Changing a File Name

A Press [Change File Name].

B Press [Backspace] or [Delete All],
and then reenter the file name.

Reference
See “Entering Text” in the
General Settings Guide.

C Press [OK].
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Changing the Password

A Press [Change Password].
B Enter a new password using

the number keys, and press
[OK].

EEEE Press [Exit].
Return to the initial display.

Delete File

Use this function to delete your
stored documents.
Press [Sub TX Mode] ⇒ [Select Stored File].

AAAA Select [Manage/Delete File].

BBBB Select the document you want to
delete.

Note
❒ You can also delete multiple

documents at once.
❒ Enter the password when the

Password se tt ing  menu is
shown.

CCCC Press [Delete File].

DDDD Press [Delete].

EEEE Press [Exit].
Return to the initial display.

----Controlling documents saved 
in the Document Server from a 
computer

The fax documents saved in the Doc-
ument Server can be viewed and con-
trolled from a network computer
with DesktopBinder V2 Lite or Desk-
topBinder V2 Professional installed. 
The following operations are availa-
ble from the computer: 
• Displaying documents (Easy View-

er)
• Displaying document properties

(Properties)
• Deleting documents (Delete)
• Copying documents to a computer

(Copy)
• Printing documents (Print from

Document Server)
• Sending documents by fax (Fax

from Document Server)
• Exporting documents as files (Ex-

port Document) 
For more information, see the Desk-
topBinder V2 operating instructions
and Help.

Note
❒ Settings made in System Settings

enable you to send documents to
the delivery server. See “Configur-
ing the Network” in the General
Settings Guide.



7. Facsimile Features
Function List

Function name Description Reference
Prog./Change/Delete 
Program/Change/Delete 
Quick Dial 

When you register a destina-
tion in a Quick Dial, you can 
specify the destination by just 
pressing the Quick Dial key. 

See p.42 “Quick Dial”, Facsim-
ile Reference (option) <Basic Fea-
tures>.

Program/Change/Delete 
Group 

If you program several desti-
nations into a Group, you can 
dial with just a few key-
strokes.

See p.46 “Groups”, Facsimile 
Reference (option) <Basic Fea-
tures>.

Change Order of Quick Dial 
Table 

Use this function to change 
the order of the registered 
Quick Dial Table. It would be 
convenient to list the receivers 
that you fax to frequently on 
the first page of the Quick Dial 
Table.

See p.94 “Changing the Order 
of the Quick Dial Table”.

Program Title of Quick Dial 
Table 

Use this function to add a 
name to the title of the Quick 
Dial Table in order to facilitate 
finding the desired registered 
destination.

See p.95 “Programming Title 
of the Quick Dial Table”.

Program/Change/Delete 
Standard Message 

Use this function to program 
standard messages to be 
printed at the top of the first 
page of the original.

See p.96 “Programming and 
Changing Standard Messag-
es”.

Store/Change/Delete Auto 
Document 

Allows you to store a fre-
quently used original in the 
machine's memory. You can 
print or send the original di-
rectly as necessary. 

See p.97 “Storing and Chang-
ing an Auto Document”.

Program/Change/Delete 
Scan Size 

Register a frequently used 
original size in advance when 
you send a message with the 
Irregular Scan Area function. 

See p.18 “Setting a Scan Ar-
ea”, Facsimile Reference (option) 
<Basic Features>.
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Print List/Report This function allows you to 
print various reports and lists 
manually. You can print the 
following reports and lists:

• Journal 
See p.19 “Printing the 
Journal”.

• Quick Dial list 
See p.101 “Quick Dial list”.

• Group Dial list 
See p.101 “Group Dial 
list”.

• Label Insertion list 
See p.101 “Label Insertion 
list”.

• Program list 
See p.101 “Reports/Lists”.

• Auto Document list 
See p.101 “Reports/Lists”.

See p.101 “Reports/Lists”.

Gen. Settings/Adjust Default Transmission Mode 
and scan settings. When the 
power is turned on, settings 
specified here are selected:

• Memory/Immediate 
Transmission Switch

• Text Size Priority

• Original Type Priority

• Auto Image Density

• Adjust Scan Density

• Switch Title of Quick Dial 
Table

• Switch Display

• Adjust Sound Volume

• Program Fax Information

• Fax Header Print Setting

• Label Insertion Priority 
Setting

• Reduced Image TX Setting

• Auto Reduced Image Setting

• Closed Network Priority 
Setting

• Scan End Reset

• Transmission Stamp Priority

• Line Priority Setting

• On hook Mode Release Time

• Program Economy Time

• Quick Operation Key

See p.102 “General Set-
tings/Adjustment”. 

See p.39 “Initial Settings and 
Adjustments”, Facsimile Refer-
ence (option) <Basic Features>.

See p.53 “Adjusting Volume”, 
Facsimile Reference (option) 
<Basic Features>.

Function name Description Reference
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Reception Mode Allows you to switch the fol-
lowing reception functions to 
on or off:

• Switch Reception Mode
See p.38 “Selecting the Re-
ception Mode”, Facsimile 
Reference (option) <Basic 
Features>.

• Authorized Reception 
See p.120 “Authorized 
RX”.

• Forwarding 
See p.120 “Forwarding”.

• Reception File Print Quan-
tity 
See p.121 “Reception File 
Print Qty”.

• 2-Sided Print 
See p.71 “2-Sided Print-
ing”.

• Reception Reverse Print-
ing 
See p.74 “Reverse Order 
Printing”.

• Paper Tray 
See p.121 “Paper Tray”.

• G3/G4 Separate Tray 
See p.79 “G3/G4 Separate 
Tray”.

• Checkered Mark 
See p.70 “Checkered 
Mark”.

• Center Mark 
See p.70 “Center Mark”.

• Print Reception Time 
See p.71 “Reception 
Time”.

• FAX Print Color 
See p.75 “FAX Print 
Color”.

• 2nd Color Choice 
See p.75 “2nd Color 
Choice”.

See p.104 “Reception Mode”.

See p.38 “Selecting the Recep-
tion Mode”, Facsimile Reference 
(option) <Basic Features>.

Function name Description Reference
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Accessing the User Tools

The User Tools allow you to program
the machine with your identification,
to store frequently used numbers and
settings, and customize the default
settings to match your needs.
So you can find the User Tool you
want quickly and easily, they are
grouped by function.

❖❖❖❖ Prog./Change/Delete
Use to program, change or delete:
Quick Dial, Group Dial, Title of
Quick Dial Table, Order of Quick
Dial Table, Auto Documents,
Standard Message, Scan Size
See See p.42 “Quick Dial”, Facsimi-
le Reference (option) <Basic Fea-
t u r e s > .  S e e  p . 4 6  “ G r o u p s” ,
Facsimile Reference (option) <Basic
Features>.
See p.94 “Program/Change/De-
lete Menu”.

❖❖❖❖ Print List/Report
Use to print: the Journal, Group Dial
list, Program list, Auto Document
list, Quick Dial list, Label Insertion
list. See p.101 “Reports/Lists”.

❖❖❖❖ General Settings/Adjustment
Use to set defaults for: Transmis-
sion Mode (Memory / Immediate),
Scan Conditions (Resolution /
Auto Image Density / Original
Type), Fax Information, Adjust
Sound Volume. See p.102 “General
Settings/Adjustment”. See p.39
“Ini t ia l  Sett ings and Adjust-
ments”, Facsimile Reference (option)
<Basic Features>. See p.53 “Adjust-
ing Volume”, Facsimile Reference
(option) <Basic Features>.

❖❖❖❖ Reception Mode
Use to turn on or off: Reverse Or-
der,  Checkered Mark, Center
Mark, Print RX Time, Multi-copy
Reception, Authorized Reception,
Special RX Nos., 2-sided printing,
Forwarding, Paper Tray Settings,
FAX Print Color, and 2nd Color
Choice. See p.104 “Reception
Mode”.

❖❖❖❖ Key Operator Tools
Use to program/check:  your
name, your fax number, line type,
various ID Codes, number of
transmitted/received documents.
See p.109 “Using Key Operator
Settings”.

Note
❒ Each menu appears in the each tab.
❒ You can switch the display by

pressing [UUUU Prev.] or [TTTT Next].
❒ The selected item is highlighted.
❒ When you specify all the settings,

press [OK]. If [OK] is not pressed,
the settings you made might be
canceled.

❒ Press [Cancel] to cancel specified
settings. The previous display is
shown.
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----Key Operator Code
When Key Operator Code is pro-
grammed and turned on, users have
to enter a programmed Key Operator
Code (maximum 8 digits) to operate
the User Tools and Key Operator
Tools. This prevents unauthorized
people from changing registrations.

Note
❒ You can turn the Key Operator

Code on or off in the “System Set-
tings”.

❒ When you set the Key Operator
Code active, enter a code (maxi-
mum 8 digits) with the number
keys and select [Partial] or [All Initial
Settings] to limit access.
• When [Partial] is selected:

Only the Key Operator Tools
are protected with a Key Opera-
tor Code.

• When [All Initial Settings] is se-
lected:
The Key Operator Tools and
User Tools are protected with a
Key Operator Code.

A Press the {{{{User Tools/Counter/In-
quiry}}}} key.
If you have selected [All Initial Set-
tings], go to step C.

B Press [Facsimile Features].
C Select [Key Operator Tools].
D Enter a maximum 8 digit Key Op-

erator Code with the number keys.

E Press [OK].

Note
❒ If you enter a Key Operator

Code that is not registered, the
display will return to step C.
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Program/Change/Delete Menu

Changing the Order of the 
Quick Dial Table

Use this function to change the order
of the programmed Quick Dial Table.
It is convenient if you list the receiv-
ers that you fax to frequently on the
first page of the Quick Dial Table.

Note
❒ You can only change the order

within “Title 1”, “Title 2”, and “Ti-
tle 3”. You cannot change the order
within “Destination List”.

Pressing an arrow key will move the
selection in the direction of the arrow.

Start in the menu above. By pressing
[→→→→], the destination key moves to the
right.

By pressing [↓↓↓↓] from the top menu,
the destination key moves down.

Reference
See p.42 “Quick Dial”, Facsimile
Reference (option) <Basic Features>.

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Prog./Change/Delete] ⇒ [Change Order
of Quick Dial Table].

AAAA Select the destination key for
which you want to change the or-
der.

Note
❒ If the destination key is under a

different title, press [Change Ti-
tle] to switch between titles.

BBBB Press the arrow keys to move the
destination key.

CCCC Press [OK].
Return to the initial display.
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Programming Title of the 
Quick Dial Table

Use this function to add a name to the
title of the Quick Dial Table in order
to facilitate finding the desired pro-
grammed destination.
As in a telephone directory, there are
titles in the Quick Dial Table to facili-
tate finding the desired receiver from
among many destinations.

In the menu above, the [CD] page
(menu) of the Quick Dial Table is se-
lected. The titles are [Freq.], [AB], [CD],
[EF], [GH], [IJK], [LMN], [OPQ], [RST],
[UVW], and [XYZ]. For an example,
press [EF] to select that page.
On this machine, you can create a
Quick Dial Table according to your
needs. In creating a Quick Dial Table,
you should program titles to facilitate
your search process. You can change
the type of classification.
Create and use your own titles ac-
cording to your needs, for example,
“Business” and “Private”.

Note
❒ The machine can make four types

of Quick Dial Tables. To display a
Quick Dial Table different from the
one being shown, press [Change Ti-
tle]. See p.95 “Switching Titles”.

❒ You can program up to four char-
acters for the “Title 1” and “Title 2”
keys.

❒ You can program up to eight char-
acters for the “Title 3” key.

❒ Use the same procedure program
and change the titles.

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Prog./Change/Delete] ⇒ [Program Title
of Quick Dial Table].

AAAA Select the title key to program.

Note
❒ You cannot make any changes

to “Destination List” or “Freq.”.

BBBB Enter the name for the title key,
and press [OK].
Return to the initial display.

Reference
See “Entering Text” in the Gen-
eral Settings Guide.

Note
❒ To program another title key,

repeat from step A.

----Switching Titles
To specify a fax receiver on the Quick
Dial Table, select the title where that
receiver is programmed.
You can specify all programmed re-
ceivers on the Destination List.
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To display the Quick Dial Table in al-
phabetical order, select “Title 1”. To
display the Quick Dial Table that is
programmed by user, select “Title 2”.
A Press [Dest. Management].
B Select [Change Title].
C Press the title key to be displayed.
D Press [OK].

The selected title is shown above
the “Change Title” menu.

Note
❒ To cancel changing the title,

press [Cancel]. The display will
return to step B.

E Press [Exit].
The initial display is shown.

Programming and Changing 
Standard Messages

Use this function to program stand-
ard messages to be printed at the top
of the first page of the original. It is
convenient if you program message
such as your own greetings.

Note
❒ You can program your own mes-

sages into [Prog. Messge 1], [Prog.
Messge 2] and [Prog. Messge 3] only.
You cannot change the “Confiden-
tial”, “Urgent”, “Please phone”, or
“Copy to corres ...” messages.

❒ Use the same procedure to pro-
gram and change your messages.

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Prog./Change/Delete] ⇒ [Program/Change/
Delete Standard Message].

AAAA Select a key in which “*Not Pro-
gramed” is displayed.

Note
❒ To change a message, press the

programmed message that you
want to change.

BBBB Enter your message, and press
[OK].

Return to the initial display.

Reference
See “Entering Text” in the Gen-
eral Settings Guide.

Note
❒ To program another message,

repeat from step A.



Program/Change/Delete Menu

7

Deleting Standard Messages

Use this function to delete pro-
grammed messages that you no long-
er need.
Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Prog./Change/Delete] ⇒ [Program/Change/
Delete Standard Message].

AAAA Press [Delete], and then select the
message that you want to delete.

BBBB Press [Delete].

Note
❒ To delete another message, re-

peat from step A.

CCCC Press [Exit].

Return to the initial display.

Storing and Changing an Auto 
Document

If you often have to send a particular
page to people (for example, a map, a
standard attachment, or a set of in-
structions), you can store that page in
memory as an Auto Document. This
saves rescanning the original every
time you wish to send it.
Use the following procedure to pro-
gram a new Auto Document or over-
write an existing one.
You can store the following items in
an Auto Document:
• You can store up to 6 Auto Docu-

ments (18 with the optional Expan-
sion Memory installed). Each Auto
Document can contain one page.

• Originals (Max 6 Documents; when
the optional Fax Function Upgrade
Unit is installed, maximum 18 doc-
uments, only one page per file).

• Scan settings (Resolution, Original
Type, and Image Density) 

• Irregular Scan Area
• Document name (up to 16 charac-

ters)

Important
❒ We recommend that you print the

Auto Document list and keep it
when you program or change an
Auto Document. See p.101 “Re-
ports/Lists”.
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Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Prog./Change/Delete] ⇒ [Store/Change/De-
lete Auto Document].

AAAA Select the file you want to store or
change.

Note
❒ If there are stored files, the file

names are shown.

Storing a file

A Select [*Not programed].
B Enter a file name, and then

press [OK].

Note
❒ You should program the file

name.

Reference
See “Entering Text” in the
General Settings Guide.

Changing a file

A Select a file you want to change.
The message “A file is already
stored. If another file is stored,
previous one will be deleted. Is
it OK? ”is shown.

B Press [Store].

Changing only a file name

A Press [Change Name].
B Select a file you want to change.

C Enter a file name, and then
press [OK].

Go to step D.

Reference
See “Entering Text” in the
General Settings Guide.

BBBB Place your original on the Docu-
ment Feeder or the Exposure
Glass and select any scan settings
you require.

Note
❒ You can also specify a Scan Size.

See p.18 “Setting a Scan Area”,
Facsimile Reference (option) <Ba-
sic Features>.

CCCC Press the {{{{Start}}}} key.

The machine starts to scan.

Note
❒ To cancel scanning, press [Stop

Scanning].

DDDD Press [Exit] after scanning is fin-
ished.

Return to the initial display.
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Deleting an Auto Document

Note
❒ You cannot delete an Auto Docu-

ment waiting to be transmitted.
Delete it after the transmission or
cancel the transmission, and then
delete the Auto Document.

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Prog./Change/Delete] ⇒ [Store/Change/De-
lete Auto Document].

AAAA Press [Delete], and select the mes-
sage you want to delete.

BBBB Press [Delete].

CCCC Press [Exit].

The initial display is shown.

Programming and Changing a 
Scan Size

When you select a Scan Size to scan a
non-standard size original, two cus-
tom sizes of original are available (
Program Size 1 and Program Size 2).
Use these functions to program a cus-
tom size in advance.
To change an existing Scan Size, just
use the same procedure.

Important
❒ When programming or changing a

Scan Size, we recommend that you
make a memo of the new size.

Note
❒ You can specify a horizontal length

from 128 to 1,200mm or from 5.5 to
47 inches.

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Prog./Change/Delete]  ⇒  [Program/
Change/Delete Scan Size].

AAAA After confirming [Register/Change]
is selected, press [Program Size 1] or
[Program Size 2].
99



Facsimile Features

100

7

BBBB Enter a horizontal size with the
number keys.

Note
❒ You can specify a horizontal

length from 128 to 1,200mm or
from 5.5 to 47 inches. You can-
not specify a length shorter than
128mm or longer than 1,200
mm.

❒ Each time you press [mm] or
[inch], the units change between
“mm” and “inch” alternately. If
you enter a length and change
the unit by pressing [mm] or
[inch], the length is converted
automatically according to the
unit (fractions are rounded off).
For Example, When you enter
{{{{2}}}}, {{{{5}}}} and {{{{0}}}} in millimeters
and change to “inch”, the length
“9.8inch” is shown on the dis-
play. If you press [mm] or [inch]
again, “249mm” is displayed.

❒ If you make a mistake, press
[Clear] or the {{{{Clear/Stop}}}} key
and try again.

CCCC Select a vertical size.

Note
❒ A displayed vertical size differs

depending on the selected unit.
When [mm] is selected, [Auto De-
tect], [210mm (A4)], [257mm(B4
JIS)], [297mm (A3)], [216mm (8 1/2)]
and [279mm (11)] are shown.
When [inch] is selected, [Auto De-
tect], [8.3inch (A4)], [10.1inch(B4
JIS)], [11.7inch (A3)], [8.5inch] and
[11.0inch] are shown.

DDDD Press [OK].

EEEE Press [Exit].
Return to the initial display.

Deleting a Scan Size

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Prog./Change/Delete]  ⇒  [Program/
Change/Delete Scan Size].

AAAA Press [Delete], and select [Program
Size 1] or [Program Size 2].

BBBB Press [Yes].

CCCC Press [Exit].
Return to the initial display.
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Reports/Lists

This function allows you to print the
following reports and lists manually.
Select a report or list as needed.
• Journal 

See p.19 “Printing the Journal”.
• Quick Dial list

See p.42 “Quick Dial”, Facsimile
Reference (option) <Basic Features>.

• Label Insertion list
See p.42 “Quick Dial”, Facsimile
Reference (option) <Basic Features>.

• Group Dial list
See p.46 “Groups”, Facsimile Refer-
ence (option) <Basic Features>.

• Program list
See p.81 “Programs”.

• Auto Document list
See p.97 “Storing and Changing an
Auto Document”.

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Print List/Report].

AAAA Select a list or report you want to
print.

Note
❒ When printing the Journal, you

can select a printing mode from
[All], [Print per File No.], or [Print
per User Code].

❒ When printing the Quick Dial
list, you can select from [Print per
Programing No.], [Print Title 1],
[Print Title 2] or [Print Title 3].

BBBB Press the {{{{Start}}}} key.

Return to the initial display.

Note
❒ To cancel printing, press [Can-

cel]. The display will return to
step A.
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General Settings/Adjustment

Make the settings for the following
items. The set items are highlighted
on the Facsimile Features menu when
the power is turned on.

❖❖❖❖ Switch Memory/Immed. Transmission
Use this function for specifying the
Transmission Mode for document
transmission.

❖❖❖❖ Text Size Priority
Use this function to specify the
character size of your originals for
scanning.

❖❖❖❖ Original Type Priority
Use this function for specifying the
type of originals for scanning.

❖❖❖❖ Auto Image Density
Use this function for specifying
whether to prioritize automatic
Image Density for scanning your
originals.

❖❖❖❖ Adjust Scan Density
Use this function for specifying the
scan density of your originals.

❖❖❖❖ Switch Title of Quick Dial Table
Use this function for selecting the
title to be shown on the Quick Dial
Table.

❖❖❖❖ Switch Display
Use this function for displaying
the number keys instead of the
Quick Dial Table.

❖❖❖❖ Adjust Sound Volume
See p.53 “Adjusting Volume”, Fac-
simile Reference (option) <Basic Fea-
tures>.

❖❖❖❖ Program Fax Information
See p.39 “Initial Settings and Ad-
justments”, Facsimile Reference (op-
tion) <Basic Features>.

❖❖❖❖ Fax Header Print Setting
Use this function for specifying
whether to print the Fax Header.

❖❖❖❖ Label Insertion Priority Setting
Use this function for specifying
whether to use the Label Insertion
function.

❖❖❖❖ Reduced Image TX Setting
Use this function for specifying
whether to use reduced image
transmission. See p.53 “Transmis-
sion Options”.

❖❖❖❖ Auto Reduced Image Setting
Use this function for specifying
whether to transmit an automati-
cally reduced image. See p.53
“Transmission Options”.

❖❖❖❖ Closed Network Priority Setting
Use this function for specifying
whether to execute ID transmis-
sion. See p.53 “Transmission Op-
tions”.

❖❖❖❖ Scan End Reset
Use this function for specifying
whether to return to the initial set-
tings each time an original is
scanned.

❖❖❖❖ TX Stamp Priority
Use this function for specifying
whether to press a TX stamp.

❖❖❖❖ Line Priority Setting
Use this function for specifying the
line of usage.
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Note
❒ The display may differ depend-

ing on the line type you have.

❖❖❖❖ Program Economy Time
Use this function for specifying a
time for transmission when the tel-
ecommunication rates are low. See
p.5 “Sending at a Specific Time
(Send Later)”.

Limitation
❒ You can program only one

Economy Time.

❖❖❖❖ On Hook Mode Release Time
Use this function for specifying the
time to cancel the On Hook mode
after you transmit with On Hook
dialing. It is convenient to use this
when the Fax Information service
disconnects your On Hook dialing.

❖❖❖❖ Quick Operation Key
Frequently used functions that are
programmed as Quick Operation
Keys are shown on the menu im-
mediate ly after  the power is
turned on.
The Quick Operation Keys can be
programmed with the following
functions.
Journal, TX File Status, Print Conf.
RX, Print Memory Lock, Stored
File, Send Later, Auto Document, 2
Sided Original, Closed Network,
Polling TX, Polling RX, Fax Header
Print, Label Insertion, Dest. Man-
agement, Forwarding, Transfer
Request
Up to three functions can be pro-
grammed in Quick Operation
Keys.

Note
❒ The functions that are dimmed

have already been set.

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Gen. Settings/Adjust].

AAAA Select a function you want to
specify.

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key
and try again.

BBBB Press [OK] after making any func-
tion settings.

After the settings/adjustment are
finished, return to the initial dis-
play.
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Reception Mode

Make settings for the following recep-
tion functions.
• Switch Reception Mode

See p.67 “Reception Functions”.
See p.38 “Selecting the Reception
Mode”, Facsimile Reference (option)
<Basic Features>.

• Authorized RX
See p.118 “Authorized Reception”.

• Forwarding
See p.118 “Forwarding”.

• RX File Print Qty
See p.72 “Multi-copy Reception”.

• 2-Sided Print
See p.71 “2-Sided Printing”.

• RX Reverse Printing
See p.74 “Reverse Order Printing”.

• Paper Tray
• G3/G4 Separate Tray

See p.79 “G3/G4 Separate Tray”.
• Checkered Mark

See p.70 “Checkered Mark”.
• Center Mark

See p.70 “Center Mark”.
• Print Reception Time

See p.71 “Reception Time”.
• FAX Print Color

See p.75 “FAX Print Color”.
• 2nd Color Choice

See p.75 “2nd Color Choice”.

Note
❒ In the "RX File Print Qty" setting,

the range of available print quanti-
ties is 1 to 10.

❒ When no tray is specified for "Pa-
per Tray" setting, "Auto Select"
will be selected.

❒ If you want to select the bypass
tray for "Paper Tray" setting, spec-
ify it with "Special Sender" by
"Special Senders to Treat Different-
ly". See p.117 “Special Senders to
Treat Differently”.

❒ If the paper type is set to [Thick pa-
per] or [OHP] for "Paper Tray" set-
ting, papers in the tray will not be
used for printing. See p.78 “The
trays that cannot be used for print-
ing fax documents”.

❒ If you select " OFF " for the "G3/G4
Separate Tray" setting, the re-
ceived faxes are delivered to the
default tray.

❒ In the "2nd Color Choice" setting,
the color specified for FAX Print
Color can not be used as a 2nd
Color Choice.

❒ If the machine has run out of the
color that selected as the 2nd Color,
there is no additional substitution.

Press the {{{{User Tools/Counter/Inquiry}}}}
keys. See p.9 “Control Panel”, Facsim-
ile Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Reception Mode].

AAAA Select a function you want to
specify.

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key
and try again.
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BBBB Press [OK] after making any func-
tion setting.

After the settings are finished, re-
turn to the initial display.
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8. Key Operator Setting
Function List

Function name Description Reference

Transmission Page Count Check the transmission and 
reception, and totals on the 
display. 

See p.109 “Counters”.

Forwarding Transfers received messages 
to a registered receiver (for-
warding destination). 

See p.109 “Forwarding”.

Memory Lock Reception Switch the Memory Lock to on 
or off. To use it, register an ID 
for printing a message re-
ceived in Memory Lock mode. 

See p.111 “Memory Lock”.

ECM If a part of the transmission 
fails due to a telephone line 
fault, this function resends the 
failed part automatically. 

See p.112 “ECM”.

Parameter Setting Allows you to change and 
print the function settings to 
meet your needs.

See p.113 “Changing the User 
Parameters”.

Program Special Sender By programming particular 
receivers as Special Sender in 
advance, you can have the 
Special Senders to treated dif-
ferently.

See p.120 “Programming / 
Changing Special Senders”.

Box Setting By using SUB and SEP Codes 
with these functions, you can 
send messages to another par-
ty's box and retrieve messages 
stored in boxes.

See p.124 “Box Settings”.

Transfer Report Before using Transfer Re-
quest, you need this Transfer 
Report setting.

See p.131 “Transfer Report”.

Program Confidential ID Register an ID required for 
Confidential communication.

See p.132 “Programming a 
Confidential ID”.

Program Polling ID Register an ID required for 
Polling communication.

See p.133 “Programming a 
Polling ID”.

Program Memory Lock ID Register an ID required for 
Memory Lock reception.

See p.133 “Programming a 
Memory Lock ID”.
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Select Dial/Push Phone Select a line type when you 
connect the machine to G3 an-
alog line.

Note
❒ This function is not availa-

ble in some areas.

See p.134 “Selecting Di-
al/Push Phone”.

Program ISDN-G3 Line Program Own Fax Numbers, 
and sub-addresses when you 
connect the machine to ISDN.

See p.134 “Programming 
ISDN G3 Line”.

Program ISDN-G4 Line Program your Own Fax 
Number, TID (Terminal ID) 
and sub-address when you 
connect the machine to a G4 
digital line.

See p.135 “Programming 
ISDN G4 Line”.

Function name Description Reference
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Using Key Operator Settings

Counters

This function allows you to check the
total number of pages transmitted
and received on the display.
• Transmissions:

Total number of transmitted pages
• Receptions:

Total number of received pages
Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Transmission
Page Count]. After checking the dis-
play, press [Exit].

Forwarding

Using this function, you can select
messages from Specified Senders to
be printed on your machine, and then
sent on to another fax machine. 
This is useful if, for example, you are
visiting another office and would like
a copy of your messages sent to that
office so you can read them.

Preparation
To use this function, set the For-
warding function in “Reception
Mode” to “ON (enable).”

Limitation
❒ The Forwarding function does not

forward messages received with
Confidential Reception, Memory
Lock, Polling Reception mode, or
messages received by Transfer Re-
quest.

❒ You can program senders with
Quick Dial Table and Groups. You
cannot program a sender with a
Group that has destinations speci-
fied as Transfer Stations.

Reference
See p.42 “Quick Dial”, Facsimile
Reference (option) <Basic Features>.
See p.46 “Groups”, Facsimile Refer-
ence (option) <Basic Features>.

Note
❒ If you don't program a forwarding

station when setting the Forward-
ing function in the “Reception
Mode”  to “ON” ,  the machine
prints only received messages
without forwarding.
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❒ If you want to change end receiv-
ers separately according to send-
ers, specify end receivers for each
special sender in “Special Senders
to Treat Differently.” Received
messages from unspecified send-
ers will be forwarded to the end re-
ceiver specified here. See p.117
“Special Senders to Treat Differ-
ently”.

❒ One receiver can be specified with
this function. For multiple receiv-
ers, use Group Dial.  See p.46
“Groups”, Facsimile Reference (op-
tion) <Basic Features>.

❒ You can print a Forwarding Mark
on messages that are forwarded.
See p.113 “Changing the User Pa-
rameters” (Switch02, Bit0).

❒ You can specify whether or not to
print forwarded messages. See
p.113 “Changing the User Parame-
ters” (Switch11, Bit6).

❒ You can change a Forwarding Sta-
tion in the same way as you pro-
gram it. 

Programming Forwarding Stations

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Forwarding].

AAAA Press [ON].

Note
❒ If there is a Forwarding Station

already programmed, a receiver
name is shown. If you want to
change the receiver, press [Re-
ceiver] and go to step B.

BBBB Specify the senders with Quick
Dial Table, and press [OK].

If you make a mistake, press [Clear]
or the {{{{Clear/Stop}}}} key and try
again.

CCCC Press [OK].
Return to the initial display.

Deleting a Forwarding Station

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Forwarding].

AAAA Press [OFF].

BBBB Press [OK].
Return to the initial display.
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Forwarding Mark

You can print a Forwarding Mark on
the receiver's messages which have
been forwarded.
The receiver can distinguish between
forwarded messages and usual recep-
tions.

Note
❒ You can specify whether or not to

print a Forwarding Mark in the
U se r  P a ra m e t e rs .  S ee  p . 1 13
“Changing the User Parameters”
(Switch02, Bit0).

Memory Lock

When you switch Memory Lock on,
received messages are stored in mem-
ory and are not printed automatical-
ly. When a message is received in the
Memory Lock mode, the Confidential
File (i) indicator blinks. To print this
message, enter the Memory Lock ID.
A user without the ID cannot print
the message. This prevents an unau-
thorized person from seeing the mes-
sage.

Preparation
To use Memory Lock, program the
Memory Lock ID and then switch
Memory Lock on. See p.133 “Pro-
gramming a Memory Lock ID”.

Note
❒ To store incoming documents

from Special Senders only in Mem-
ory Lock, program each sender
with “Special Senders to Treat Dif-
ferently”. See p.117 “Special Send-
ers to Treat Differently”.

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Memory Lock
RX].

AAAA Select [ON] or [OFF].

BBBB Press [OK].

Return to the initial display.
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ECM

If a part of a transmission fails be-
cause of a line problem, the lost data
is automatically resent. For this func-
tion to work, the other machine must
have ECM. You can turn this function
on or off with the following proce-
dure.

Note
❒ If you turn ECM off, you cannot

use the following functions: 
• JBIG Transmission
• Super G3 Communication

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [ECM].

AAAA Select [ON] or [OFF].

BBBB Press [OK].
Return to the initial display.
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Changing the User Parameters

The User Parameters allow you to customize various settings to suit your needs.
To change the function settings, set the User Parameter Switches.

Preparation
Access to some User Parameter Settings requires the installation of optional
equipment or that other settings be made beforehand.

----Switches and Bits
User Parameters are divided into switches and each switch is divided into eight
bits. The right most bit is bit 0 and the left most is bit 7.

----User Parameter List
The User Parameter Switches are outlined below.

Switch 02 0 0 1 1 1 0 1 1

↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓

7 6 5 4 3 2 1 0

Switch Bit Item 0 1

02 0 Forwarding Mark Off On

3 TSI Print Off On

5 CIL Print Off On

6 TID Print Off On

03 0 Automatic printing of the 
Memory TX Result Report

Off On

2 Automatic printing of the 
Memory Storage Report

Off On

3 Automatic printing of the Poll-
ing RX Reserve Report

Off On

4 Automatic printing of the Poll-
ing RX Result Report

Off On

5 Automatic printing of the Im-
mediate TX Result Report

Off On

6 Automatic printing of the Poll-
ing TX Clear Report

Off On

7 Automatic printing of the Jour-
nal 

Off On
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04 0 Automatic printing of the Con-
fidential File Report

Off On

7 Include a portion of the image 
on the Transmission Result Re-
port (Memory Transmission), 
Memory Storage Report, Com-
munication Failure Report, or 
Transfer Result Report (Inclu-
sion of part of image)

Off On

05 0 Receive Service Call (SC) Con-
dition (Substitute Reception 
during service call)

Possible (Substi-
tute RX)

Not possible (Re-
ception off) 

2, 1  Substitute the reception when the machine cannot print (Because all the pa-
per trays have run out of paper, toner is empty, or all the paper trays are out 
of commission)

00: Enabled unconditionally (Free)

01: Enabled when Own Name/Own Fax Number is received

10: Enabled for Polling ID match

11: Disabled (Reception off)

5 Just Size Printing Off On

7 Empty cassette alert (Paper 
Empty Warning indication)

Off On

06 6 First page scanned for book 
originals

From the left page From the right page

07 2 Parallel Memory Transmission Off On

08 2 Authorized Reception type Only receive from 
specified senders

Receive all messag-
es except those from 
specified senders

10 1 Combine 2 Originals Off On

3 Page Reduction when printing Off On

11 1 Send PB/UUI to ISDN UUI PB

6 Local Print when Forwarding Off On

7 Polling file after sending (Poll-
ing transmission standby time)

Delete (Use Once) Standby (Save)

14 0 Print documents received with 
Auto Power-On Reception 
(Night Printing mode)

Immediate print-
ing (Off)

When turning on 
the operation 
switch (On)

1 Long Document Transmission 
(Well Log)

Off On

2 Batch Transmission Off On

3 Reset when function changed Off On

7 System Parameter List TX Off On

Switch Bit Item 0 1
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15 7 Give priority in paper feed 
from the Large Capacity Tray 
(LCT)

Off On

17 2 Whether you need to press 
Add after entering a Quick Di-
al/Group Dial when broad-
casting

Not Necessary Necessary

7 Receive messages by pressing 
the {{{{Start}}}} key when originals 
are not set

Off (The machine 
does not receive 
messages by press-
ing the {{{{Start}}}} key.)

On (The machine 
receives messages 
by pressing the 
{{{{Start}}}} key.)

18 0 Print data with Fax Header Off On

1 Print transmitter origin with 
Fax Header

Off On

2 Print file number with Fax 
Header

Off On

3 Print page number with Fax 
Header

Off On

19 0 Use paper delivery shift func-
tion (Offset Print)

Off On

1 Sort Journal by line type Off On

20 0 Automatic printing of the PC 
FAX (LAN FAX) Error Report

Off On

1 Reprint the documents that fail 
to print from LAN FAX driver

Off On

5, 4, 3, 2 Store the documents in memory that could not be printed from the LAN 
FAX driver

0000: 0 minute / 0001: 1 minutes / 0010: 2 minutes / 0011: 3 minutes / 0100: 
4 minutes / 0101: 5 minutes / 0110: 6 minutes / 0111: 7 minutes / 1000: 8 
minutes / 1001: 9 minutes / 1010: 10 minutes / 1011: 11 minutes / 1100: 12 
minutes / 1101: 13 minutes / 1110: 14 minutes / 1111: 15 minutes

24 1, 0  Store a message in memory that could not be transmitted

00: Off, 01: Store for 24 hours, 11: Store for 72 hours

25 4 RDS Off On

Switch Bit Item 0 1
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Changing the User Parameters

Important
❒ We recommend that you print and

keep User Parameter list when you
program or change a User Parame-
ter. See p.116 “Printing the User
Parameter List”.

❒ Do not change any bit switches
other than those shown on the pre-
vious pages.

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Parameter Set-
ting].

AAAA Select the Switch number you
want to change.

BBBB Select the Bit number you want to
change.

When the Bit number is pressed,
the current value switches be-
tween 1 and 0.

Note
❒ Repeat from step B to change

another Bit number for the same
Switch.

CCCC Press [OK].

DDDD Repeat steps AAAA and BBBB to change
the Switch settings.

EEEE After all the settings are finished,
press [Exit].
Return to the initial display.

Printing the User Parameter List

Print this list to see the current User
Parameter settings. 
Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools].

AAAA Press [Print List] next to [Parameter
Setting].

BBBB Press the {{{{Start}}}} key.

Return to the initial display.

Note
❒ To cancel printing a list, press

[Cancel]. The display will return
to step A.
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Special Senders to Treat 
Differently

By programming particular receivers
in advance, you can set the following
function for each receiver.
• Authorized RX
• Forwarding
• Reception File Print Qty
• Print 2 sided
• Memory Lock
• RX Reverse Printing
• Paper Tray
Use the Own Name or Own Fax
Number to program your receivers. If
the receiver has the same machine
make, program an Own Name that is
already programmed as a receiver. If
the machine is not the same make, use
Own Fax Number. To transmit with
G4 line, program the information
about the destination with G4 lines.
For convenience you can specify a
function for all programmed num-
bers. Use the Special Sender registra-
tion function to custom set functions
for a particular individual.
The following items can be pro-
grammed.
• Special Senders (Up to 30. A maxi-

mum of 50 when the optional Fax
Function Upgrade Unit  is  in-
stalled. A maximum of 20 charac-
ters for each name when using G3,
and a maximum of 24 characters
for each name when using G4.)

• Full/ Partial agreement 
When you program Own Names
and Facsimile Names for multiple
destinations, you can program a
common sequence of characters to
identify destinations using Partial
agreement.

❖❖❖❖ Using a Full agreement

❖❖❖❖ Using a Partial agreement

Note
❒ You can program up to 30 wild

cards (50 with the optional Fax
Function Upgrade unit).

❒ Ignore spaces when comparing
identifications.

❒ You can use wild cards for the
following functions:
• See p.120 “Programming /

Changing Special Senders”.
• See p.120 “Authorized RX”.
• See p.120 “Forwarding”.

Limitation
❒ You cannot program senders as

Special Senders if they do not have
Own Name or Own Fax Number
programmed.

❒ The machine cannot differentiate
between Polling Reception and
Free Polling documents from Spe-
cial Senders.

Note
❒ You can program up to 24 charac-

ters for the sender.

Destination to be 
registered 
(Own Name)

Number of
 registered 
identifications 

NEW YORK 
BRANCH 

HONG KONG 
BRANCH

SYDNEY 
BRANCH 

3

Destination to be 
registered 
(Own Name)

Number of 
registered 
identifications 

BRANCH 1
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❒ You can check Own Name and
Own Fax Number with Journal.
You can check programmed Spe-
cial Senders with specified sender
list. See p.19 “Printing the Jour-
nal”. See p.124 “Printing the Spe-
cial Sender List”.

❒ If you select “OFF” for the Special
Sender function in “Initial Set Up”,
the settings will be the same as the
“Reception Mode” settings. See
p.104 “Reception Mode”.

❖❖❖❖ Authorized Reception
Use this function to limit incoming
senders. The machine only re-
ceives the faxes from programmed
Special Senders, and therefore, it
helps you screen out unwanted
messages, such as junk mail, and
save you from wasting fax paper.

Note
❒ To use this function, program the

Special Senders function, and
then select “ON” in “Authorized
RX” with “Reception Mode”. See
p.104 “Reception Mode”. See
p.113 “Changing the User Pa-
rameters” (Switch08, Bit2).

❒ Without programming Special
Senders, the Authorized RX
function will not work even if
you select “ON”.

❒ You can select whether to re-
ceive only from programmed
senders or receive only from
senders other than the ones pro-
grammed with “User Parame-
ters”. See p.113 “Changing the
User Parameters” (Switch08,
Bit2).

❒ If you select “OFF” for Author-
ized RX in “Initial Set Up”, the
settings will be the same as the
“Reception Mode” settings. See
p.104 “Reception Mode”.

❒ You can change Special Senders
in the same way as you pro-
gram them.

❖❖❖❖ Forwarding
Use this function to print received
messages, and then transfer them
t o  r e ce i v e r s  w hi c h  a r e  p r o -
grammed beforehand. Only faxes
sent by programmed senders (Spe-
cial Senders) will be received.
Thus, paper will not be wasted for
printing unnecessary faxes. 
Receiving faxes sent only by send-
ers not programmed as Special
Senders is also possible.

Note
❒ To use this function, program

your Special Senders, and then
select “ON” for “Forwarding”
in “Reception Mode”. See p.104
“Reception Mode”.

❒ If you specify “ON” in “For-
warding” and select “Same as
basic settings”, the fax message
will be forwarded to the other
ends programmed in “Specify
End Receiver”. See p.109 “For-
warding”.

❒ If you do not program any Spe-
cial Senders, the machine trans-
fers all incoming documents to
the other end that is specified in
“Specify end Receiver”.
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❖❖❖❖ Reception File Print Quantity
Use this function to print the spec-
ified number of copies of docu-
ments received from programmed
senders (Special Senders). If you
do not program any Special Send-
ers, the machine prints the Speci-
f ied number of copies for all
received documents.

Limitation
❒ You cannot use multi-copy

printing with Polling Reception,
Confidential Reception, or
Memory Lock.

Note
❒ You can specify 1 to 10 copies.

❖❖❖❖ Print 2 Sided
 The optional duplex unit is required. 
Use this function to print on both
sides of the paper.

Limitation
❒ If you select bypass tray for the

“Paper Tray”, duplex printing
is disabled.

❖❖❖❖ Memory Lock
Use this function to store incoming
documents from programmed
senders (Special Senders) in mem-
ory without printing them. People
who do not know the Memory
Lock ID cannot print the docu-
ments, and therefore this function
is useful for receiving confidential
documents. If you do not program
any senders, the machine receives
fax message from all senders using
Memory Lock reception.

Reference
See p.133 “Programming a
Memory Lock ID” .

Limitation
❒ If you program the same sender

in Memory Lock and Forward-
ing, Forwarding is disabled.

❖❖❖❖ Reception Reverse Printing
Use this function to print the pages
in Reverse Order. See p.74 “Re-
verse Order Printing”.

❖❖❖❖ Paper Tray
Use this function to print the docu-
ments received from programmed
senders (Special Senders) and the
documents from other senders on
different types of paper.
For example, if blue paper is in
tray 1 and white paper is in tray 2,
the machine prints the documents
from Special Senders on the blue
paper and prints the documents
from other senders on the white
paper, making it easy for you to
differentiate between the two.
If you do not program any Special
Senders, the machine outputs the
documents received from all send-
ers using the default paper tray.

Limitation
❒ For Polling Reception and Free

Polling, you cannot select the
paper tray.

❒ Paper in the bypass tray, speci-
fied as the paper tray, will be
delivered to the machine's out-
put tray, even if the optional
Finisher Unit has been set as the
output tray.

❒ If the paper type is set to [Thick
paper] or [OHP], papers in the
tray will not be used for print-
ing. See p.78 “The trays that
cannot be used for printing fax
documents”.
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Note
❒ If the machine receives a mes-

sage that is a different size from
the paper in the specified tray,
the machine prints the message
after splitting it or minimizing
its size. See p.73 “Page Separa-
tion and Length Reduction”.

❒ Selection of the bypass tray (op-
tional) enables you to specify
the paper size in “Scan Area”.

Programming / Changing Special Senders

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Program Special
Sender].

AAAA Select destination to program.
When programming a new desti-
nation, press “*Not Programed”.

BBBB Enter a destination, and then
press [OK].
Enter a destination using Own
Name or Own Fax Number.

Reference
See “Entering Text” in the Gen-
eral Settings Guide.

CCCC When programming the condi-
tion, press [Full agreement] or [Par-
tial agreement].

DDDD Select the item you want to pro-
gram.

Note
❒ You must select only the item

you want to program.
❒ If you select [Same as basic set-

tings], the settings will be the
same as [Reception Mode] (See
p.104 “Reception Mode”.), [For-
warding] (See p.109 “Forward-
ing”.) and [Memory Lock] (See
p.111 “Memory Lock”.).

❒ To cancel these settings, press
[Cancel]. The display will return
to step A.

Authorized RX

A Press [Authorized RX].
B Select [ON] or [OFF].

C Press [OK].

Forwarding

A Press [Forwarding].

B Select [ON] or [OFF].

If you select [OFF], go to step D.
C Specify an end receiver.
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D Press [OK].

If you select [Yes], the name of
the end receiver is shown on the
right of “Receiver :”.

Reception File Print Qty

A Press [Reception File Print Qty].
B Select [Number of Sets].

C Enter the print quantity with
the number keys.

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key
and try again.

D Press [OK].

Print 2 Sided

A Press [Print 2 Sided].

B Select [ON] or [OFF].

C Press [OK].

Memory Lock

A Press [Memory Lock].

B Select [ON] or [OFF].
C Press [OK].

RX Reverse Printing

A Press [RX Reverse Printing].
B Select [ON] or [OFF].

C Press [OK].

Paper Tray

A Press [Paper Tray].
B Select the tray you want to use.

Note
❒ You can select [Tray 1], [Tray

2], [Tray 3], [Bypass Tray] or
[Auto Select].

C Press [OK].

EEEE Press [OK].
A Special Sender has been pro-
grammed.
Return to the initial display.

Note
❒ To program another sender, re-

peat from step A.

Programming “Initial Set UP” of a 
Special Sender

Use this function to program “Initial
Set Up” of a Special Sender. You can
also specify the Bypass Tray Paper
Size.
Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Program Special
Sender].

AAAA Press [Initial Set Up].
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BBBB Select a function you want to pro-
gram.

Note
❒ In this feature, “Authorized

RX” has the same settings as
“Reception Mode”. See p.104
“Reception Mode”.

Programming “Authorized RX” 
and “Special RX Function”

A Select [ON] or [OFF].

B Press [OK].

Programming “Bypass Tray 
Paper Size”

A Select a size you want to pro-
gram.
You can select a size from [Auto
Detect], [Standard Size] or [Custom
Size].
If you select [Auto Detect], go to
steps A and H.
If you select [Standard Size], go to
steps A, B, and H.
If you select [Custom Size], go to
steps A , and C to H.

Note
❒ If you select [Auto Detect], the

machine shows a paper size
automatically.
• The machine will detect

the paper size for the by-
pass tray as the short edge
of the paper is inserted
into the machine. Even if
you placed a A4 paper
onK direction, the ma-
chine will detect it as a
A3L.

❒ If you select [Standard Size],
select a paper size displayed,
and then go to step H.

❒ If you select [Custom Size], go
to step C.

B Select a size you want to pro-
gram in the size being shown.

C Make sure that [Vertical] is se-
lected.

Note
❒ If [Vertical] is not selected,

press [Vertical].
D Enter the vertical size of the pa-

per with the number keys.

Note
❒ You can specify a vertical

size from 210 mm (8.3 inch)
to 305 mm (12.0 inch). You
cannot enter a size smaller
than 210 mm or larger than
305mm.

❒ Each time you press [mm] or
[inch], the units change be-
tween “mill imeter”  and
“inch” alternately. If you en-
ter a length and change the
unit by pressing [mm] or
[inch], the length is converted
automatically according to
the unit (fractions are round-
ed off).
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E Press [####].

The size you selected is shown.
F Enter the horizontal size of the

paper with the number keys.

Note
❒ The method to program or

change Bypass Tray Paper
Size for Copy Function is dif-
ferent from that of Fax Func-
tion.

❒ You can specify a horizontal
size from 148 mm (5.8 inch)
to 457 mm (18.0 inch). You
cannot enter a size smaller
than 148 mm or larger than
457 mm.

❒ Each time you press [mm] or
[inch], the units change be-
tween “mm” and “inch” al-
ternately.  I f  you enter a
length and change the unit
by pressing [mm] or [inch],
the length is converted auto-
matically according to the
unit (fractions are rounded
off).

G Press [####].

The size you selected is shown.
H Press [OK].

CCCC Press [Exit].

Return to the initial display.

Deleting a Special Sender

Use this function to program “Initial
Set Up” of a Special Sender. Also the
Bypass Tray Paper Size can be speci-
fied.
Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Program Special
Sender].

AAAA Press [Delete] and select a Special
Sender you want to delete.

BBBB Press [Delete].
A Special Sender is deleted and
“*Not Programed” is shown.
Return to the initial display.
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Printing the Special Sender List

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools].

AAAA Press [Print List] next to “Program
Special Sender”.

BBBB Press the {{{{Start}}}} key.
Return to the initial display.

Note
❒ To cancel printing a list, press

[Cancel]. The display will return
to step A.

Box Settings

The following functions are for deliv-
ery and transfer of messages:
• Personal Box
• Information Box
• Transfer Box
By using SUB and SEP Codes with
these functions, you can send mes-
sages to another party's box and re-
trieve messages stored in boxes.
For details about how to set up these
functions:
See p.124 “Programming/Editing
Personal Boxes”.
See p.126 “Programming/Editing In-
formation Boxes”.

See p.128 “Programming/Editing
Transfer Boxes”.
For details about how to print out and
delete messages stored in boxes:
See p.27 “Personal Boxes”.
See p.29 “Information Boxes”.

Note
❒ The combined total of items that

can be stored in the Personal Box,
Information Box and Transfer Box
functions is 150. Installing the op-
tional Fax Function Upgrade Unit
increases this capacity to 400 items.

❒ SUB and SEP Codes can be up to 20
digits long and contain numbers, spac-
es, pound signs (#), and asterisks (*).

Limitation
❒ You cannot set the same Box Code

on two different boxes.
❒ Transmission or programming may

not be used if there is not enough free
memory left. The amount of free
memory left is different depending
on the optional equipment installed.

Programming/Editing Personal Boxes

This section describes how to pro-
gram Personal Boxes.
You can store the following items:
• Box Name (required)

Up to 20 characters long
• SUB Code (required)

Up to 20 characters long and can be
composed of digits 0-9, “#”, “*”
and spaces (the first character can-
not be a space).

• Password (optional)
Up to 20 characters long and can be
composed of digits 0-9, “#”, “*”
and spaces (the first character can-
not be a space).
When registering a password, a
mark is displayed before the Box
Name.
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• Receiver (optional)
You can program one delivery des-
tination for each Personal Box.
Specify the Quick Dial the delivery
destination is stored in.

Note
❒ The Fax Header is not printed on

delivered messages.
❒ If a message cannot be delivered, a

Communication Failure Report is
printed and the message is saved
as a Confidential Reception docu-
ment.

❒ You can edit boxes in the same
way you program them. However,
to change the SUB Code itself, you
must delete the box, and then pro-
gram a new SUB Code.

Reference
See p.27 “Personal Boxes”.

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Box Setting].

AAAA Select a box to program.

When programming a new box,
press “*Not Programed”.

Note
❒ To change a box already pro-

grammed, press it and go to
step D.

BBBB Press [Personal Box].

CCCC Enter a Box Name, and press [OK].

Reference
See “Entering Text” in the Gen-
eral Settings Guide.

DDDD Enter a SUB Code.

Note
❒ To change the SUB Code, press

[Clear] or the {{{{Clear/Stop}}}} key
and try again. To change Box
Name, press [Box Name], and
then repeat from step C. 

❒ If you make a mistake, press
[Clear] or the {{{{Clear/Stop}}}} key
and try again.

EEEE Specify any settings you require.

If you do not program [Password]
or [Receiver], go to step F.

Programming a Password

A Press [Password].
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B Enter a password, and then
press [OK].

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key
and try again.

Programming a Receiver

A Press [Receiver].

B Select a destination with the
Quick Dial Table.

C Press [OK].

FFFF Press [OK].

A box mode is shown next to the
box.

GGGG Press [Exit].
Return to the initial display.

Deleting Personal Boxes

This section describes how to delete
Personal Boxes.

Limitation
❒ If messages are programmed in the

box, you cannot delete the box.
Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Box Setting].

AAAA Press [Delete] and select a box you
want to delete.

Note
❒ When selecting a file set with a

password, the password input
screen is displayed. Enter the
password using the number
keys and press [OK]. If you enter
an incorrect number, press
[Clear] or the {{{{Clear/Stop}}}} key to
delete the entered numbers.
Press [Cancel] to cancel file se-
lection.

BBBB Press [Delete].

The box is deleted and “*Not Pro-
gramed” is shown.
Return to the initial display.

Programming/Editing Information Boxes

This section describes how to set up
an Information Box.
You can store the following items:
• Box Name (required)

Up to 20 characters long
• SEP Code (required)

Up to 20 characters long and can be
composed of digits 0-9, “#”, “*”
and spaces (the first character can-
not be a space).

• Password (optional)
Up to 20 characters long and can be
composed of digits 0-9, “#”, “*”
and spaces (the first character can-
not be a space).
When registering a password, a
mark is displayed before the Box
Name.

Note
❒ You can edit boxes in the same

way you program them. However,
to change the SEP Code itself, you
must delete the box, and then pro-
gram a new SEP Code.

Reference
See p.29 “Information Boxes”.
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Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Box Setting].

AAAA Select a box to program.

When programming a new box,
press “*Not Programed”.

Note
❒ To change a box already pro-

grammed, press it, and then go
to step D.

BBBB Press [Information Box].

CCCC Enter a Box Name, and then press
[OK].

Reference
See “Entering Text” in the Gen-
eral Settings Guide.

DDDD Enter a SEP Code.

Note
❒ To change SEP Code, press

[Clear] or the {{{{Clear/Stop}}}} key
and try again. To change Box
Name, press [Box Name], and
then repeat from step C. 

❒ If you make a mistake, press
[Clear] or the {{{{Clear/Stop}}}} key
and try again.

EEEE Press [Password].

Note
❒ If you do not want to program a

password, go to step G.

FFFF Enter a password, and then press
[OK].

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key
and try again.

GGGG Press [OK].

A box mode is shown next to the
box.

HHHH Press [Exit].

Return to the initial display.
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Deleting Information Boxes

This section describes how to delete
Information Boxes.

Limitation
❒ If messages are programmed in the

Information Box, you cannot de-
lete the box.

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Box Setting].

AAAA Press [Delete] and select a box you
want to delete.

Note
❒ When selecting a file set with a

password, the password input
screen is displayed. Enter the
password using the number
keys and press [OK]. If you enter
an incorrect number, press
[Clear] to delete the entered
numbers. Press [Cancel] to can-
cel file selection.

BBBB Press [Delete].

The box is deleted and “*Not Pro-
gramed” is shown.
Return to the initial display.

Programming/Editing Transfer Boxes

This function turns your machine into
a fax relay station. Documents sent
with a SUB Code that matches the
SUB Code programmed as a Transfer
Box are received, and then relayed to
the programmed receiver. 
Since documents can be sent to multi-
ple destinations in a single Transfer
Request, you can economize on com-
munication costs when sending to re-
mote destinations.

Note
❒ Inform the Requesting Party of the

SUB Code assigned to the Transfer
Box. When they wish to have a
message transferred by your ma-
chine, ask them to send the mes-
sage using SUB Code Transmission
and specifying this SUB Code. If a
password is also programmed, in-
form them of this too and ask them
to enter it for the SID Code.

You can store the following items:
• Box Name (required)

Up to 20 characters long
• SUB (required)

Up to 20 characters long and can be
composed of digits 0-9, “#”, “*”
and spaces (the first character can-
not be a space).
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• Password (optional)
Up to 20 characters long and can be
composed of digits 0-9, “#”, “*”
and spaces (the first character can-
not be a space).
When registering a password, a
mark is displayed before the Box
Name.

• Receiving Station (required)
You can store 5 Receiving Stations
(destinations to which messages
will be forwarded) for each box.
Specify Receiving Stations with
Quick Dials or Groups assigned to
Quick Dials that have been pro-
grammed beforehand.

Limitation
❒ After messages are transferred, a

Transfer Result Report is not sent
back to the sender.

Note
❒ After messages are transferred,

they are deleted.
❒ When this function is turned on,

the machine prints out received
messages that it transfers and the
Transfer Result Report after the
transfer has finished. If you want
to turn this function off, please
contact your service representa-
tive.

❒ When the programmed receiver is
a Multi-step Transfer Group Dial,
Multi-step Transfer takes place.

❒ You can edit boxes in the same
way you program them. However,
to change the SUB Code itself, you
must delete the box, and then pro-
gram a new SUB Code.

❒ You can edit boxes in the same
way you program them.

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Box Setting].

AAAA Select a box to program.

When programming a new box,
press “*Not Programed”.

Note
❒ To change a box already pro-

grammed, press it, and then go
to step D.

BBBB Press [Transfer Box] .

CCCC Enter a Box Name, and then press
[OK].

Reference
See “Entering Text” in the Gen-
eral Settings Guide.
129



Key Operator Setting

130

8

DDDD Enter a SUB Code.

Note
❒ To change SUB Code, press

[Clear] or the {{{{Clear/Stop}}}} key
and try again. To change Box
Name, press [Box Name], and
then repeat from step C. 

❒ If you make a mistake, press
[Clear] or the {{{{Clear/Stop}}}} key
and try again.

EEEE Specify the condition of registra-
tion.

Programming Receiving Stations

A Select Receiving Station.

Note
❒ You can store 5 Receiving

Stations.
B Specify Receiving Stations

with Quick Dials.

Note
❒ You can also specify Receiv-

ing Stations with Group Di-
als.

C Press [OK].

Repeat from step A to specify
another Receiving Station.

Programming a Password

If you do not want to program a
password, go to step F.
A Press [Password].
B Enter a password, and then

press [OK].

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key
and try again.

FFFF Press [OK].

A box mode is shown next to the
box.
Return to the initial display.

Deleting Transfer Boxes

Limitation
❒ If the specified SUB Code is not

programmed as a Transfer Box, or
messages are programmed in the
box, you cannot delete the box.

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Box Setting].

AAAA Press [Delete] and select a box you
want to delete.
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Note
❒ When selecting a file set with a

password, the password input
screen is displayed. Enter the
password using the number
keys and press [OK]. If you enter
an incorrect number, press
[Clear] to delete the entered
numbers. Press [Cancel] to can-
cel file selection.

BBBB Press [Delete].
The box is deleted and “*Not Pro-
gramed” is shown.

CCCC Press [Exit].

Return to the initial display.

Printing the Box List

Follow the procedure below to print a
l ist  showing the  currently  pro-
grammed Personal Boxes, Informa-
tion Boxes and Transfer Boxes.
Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools].

AAAA Press [Print List] next to “Box Set-
ting”.

BBBB Press the {{{{Start}}}} key.

Return to the initial display.

Note
❒ To cancel printing a list, press

[Cancel] before pressing the
{{{{Start}}}} key. The display will re-
turn to step A.

Transfer Report

For the Requesting Party to be able to
receive Transfer Result Reports from
the Transfer Station, the Requesting
Party must program the number of
the telephone line their machine is
connected to in their own machine.
See p.37 “Transfer Request”.
Be sure to insert a pause after the area
code.
For example, if you are in the United
States and your fax number is 212-
1234567, program the following:
• 1212-1234567

You can program the fax number for
each line (G3, G4).

Limitation
❒ You cannot program or edit Trans-

fer Report when using a line (dur-
ing communication). Program or
edit after communication.

Note
❒ You cannot use Transfer Request if

the telephone number of their ma-
chine is not programmed in that
machine.

❒ Up to 16 digits are available for G3.
❒ Up to 29 digits are available for G4.
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Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Transfer Re-
port].

AAAA Specify the fax number for each
line.

Programming a G3 Fax Number

A Press [G3 Fax No.(Dir.)].

B Enter your facsimile number
with the number keys, and
press [OK].

Programming a G4 Fax Number

 The optional ISDN Unit is required. 
A Press [G4 Fax No.].
B Enter your facsimile number

with the number keys, and
press [OK].

BBBB Press [Exit].
Return to the initial display.

Programming a Confidential ID

Program a Confidential ID to print
Confidential Reception. See p.24
“Printing a Confidential Message”.

Note
❒ If you do not program a Confiden-

tial ID, you cannot receive a Confi-
dential Transmission.

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Program Confi-
dential ID].

AAAA Enter an ID with the number
keys.

Note
❒ A Confidential ID can be any 4

digit numeric code except for
0000.

❒ If you make a mistake, press
[Clear] or the {{{{Clear/Stop}}}} key
and try again.

BBBB Press [OK].

Return to the initial display.
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Programming a Polling ID

Program a Polling ID to use the
Transfer Request, Transfer Station,
Default ID Polling Transmission and
Default ID Polling Reception. When
you use ID Transmission, program
the same ID as that programmed on
the sender's machine.

Reference
See p.8 “Polling Transmission”.
See p.11 “Polling Reception”.
See p.55 “Selecting transmission
options for a single transmission”.
See p.37 “Transfer Request”.

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Program Polling
ID].

AAAA Enter an ID with the number keys
and [A] to [F].

Note
❒ A Polling ID can be any combi-

nation of digits (0-9) and letters
(A-F) except for 0000 and FFFF.

❒ If you make a mistake, press
[Clear] or the {{{{Clear/Stop}}}} key
and try again.

BBBB Press [OK].

Return to the initial display.

Programming a Memory Lock 
ID

Program a Memory Lock ID to print
Memory Lock reception.
A Memory Lock ID can be any 4 digit
numeric code except for 0000.
Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Program Memo-
ry Lock ID].

AAAA Enter an ID with number keys.

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key
and try again.

BBBB Press [OK].

Return to the initial display.
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Selecting Dial/Push Phone

Use this function to select a line type
when the machine is connected to a
G3 analog line.
A Dial and Push line are available for
selection.

Note
❒ “G3-2” is shown on the display,

depending on the number of Extra
G3 Interface Units installed.

❒ When the optional G3 expansion
unit is installed, “G3-2” is dis-
played.

❒ Use the same procedure to pro-
gram and change this function.

❒ This function is not available in
some areas.

Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Select Dial/Push
Phone].

AAAA Press [Push Button Phone] or [Dial
Phone (10PPS)] to select the line.

Note
❒ If you make a mistake, press

[Clear] or the {{{{Clear/Stop}}}} key
and try again.

Reference
See p.156 “Selecting the Line
Type”.

BBBB Press [OK].

Return to the initial display.

Programming ISDN G3 Line

The optional ISDN Unit is required.

This function must be set when you
connect the machine to an ISDN G3
digital line.
You can program the following items.
• Own Fax Number 1
• Own Fax Number 2
• Sub-address 

See p.39 “Sub-address”.

Note
❒ Program Own Fax Number 1 as

your own digital number. Pro-
gram Own Fax Number 2 as anoth-
er digital number which occupies a
single line.

❒ You should program the Own Fax
Number 1.

❒ ISDN allows two or more termi-
nals (such as a fax machine and
digital telephone) to be connected
to a single line. These terminals are
identified by their sub-address
numbers. If the terminals connect-
ed to the line at a destination are
assigned sub-addresses, dialing a
sub-address allows you to direct
your fax message to a particular
terminal at the destination.

❒ Up to 4 digits (0 to 9999) are avail-
able for a sub-address.
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Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Program ISDN-
G3 Line].

AAAA Select an item you want to pro-
gram.

Programming Own Number 1 
and Own Number 2

A Select [Own Number 1] or [Own
Number 2].

B Enter your facsimile number
with the number keys, and
press [OK].

Programming a Sub-address

A Select [Sub-address].

B Enter a sub-address with the
number keys, and press [OK].

BBBB Press [Exit].
Return to the initial display.

Programming ISDN G4 Line

The optional ISDN Unit is required.

This function must be set when you
connect the machine to an ISDN G4
digital line.
You can program the following items.
• Own Fax Number 1
• Own Fax Number 2
• Sub-address 

See p.39 “Sub-address”.

Note
❒ Program Own Fax Number 1 as

your own digital number. Pro-
gram Own Fax Number 2 as anoth-
er digital number which occupies a
single line.

❒ You should program Own Fax
Number 1.

❒ ISDN allows two or more termi-
nals (such as a fax machine and
digital telephone) to be connected
to a single line. These terminals are
identified by their sub-address
numbers. If the terminals connect-
ed to the line at a destination are
assigned sub-addresses, dialing a
sub-address allows you to direct
your fax message to a particular
terminal at the destination.

❒ Up to 4 digits (0 to 9999) are avail-
able for a sub-address.
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Press the {{{{User Tools/Counter/Inquiry}}}}
key. See p.9 “Control Panel”, Facsimile
Reference (option) <Basic Features>.
And then press [Facsimile Features] ⇒
[Key Operator Tools] ⇒ [Program ISDN-
G4 Line].

AAAA Select an item you want to pro-
gram.

Programming Own Number 1 
and Own Number 2

A Select [Own Number 1] or [Own
Number 2].

B Enter your facsimile number
with the number keys, and
press [OK].

Programming a Sub-address

A Select [Sub-address].

B Enter a sub-address with the
number keys, and press [OK].

BBBB Press [Exit].

Return to the initial display.



9. LAN FAX Features
Sending Fax Documents from PC

The optional Printer Unit is required to use this feature.
• With a LAN FAX connected to a LAN or Parallel Port, you can use a tele-

phone line to send a fax created using a Windows application to another fax
machine.

• To send a fax, simply select [Print] from the Windows application, then select
LAN FAX as the printer and specify a destination.

• In addition to sending faxes, the LAN FAX driver allows this machine to be
used for printing out documents prepared on a PC for proof checking. 

• To use the LAN FAX driver, connect this machine to a LAN and make the nec-
essary network settings, and then install the LAN FAX driver and related util-
ities on your PC.

Important
❒ If errors occur on the machine when used as a LAN FAX, they are not dis-

played on the PC.
137



LAN FAX Features

138

9

Installing the Software

You need to install the LAN FAX Driver on your computer before using the LAN
FAX features. The LAN FAX Driver is on the CD-ROM included with the printer
unit.

Note
❒ The following explanation assumes that you are familiar with general Win-

dows procedures and practices. If you are not, see the documentation that
comes with Windows for details.

Auto Run Program

With Windows 95/98/Me, Windows 2000/XP, and Windows NT4.0, the install-
ers for various drivers and utilities launch automatically as Auto Run programs
when you insert the CD-ROM.

Note
❒ If the “plug and play” function starts, click [Cancel] in the [New Hardware

Found], [Device Driver Wizard] or [Found New Hardware Wizard] dialog box, and
then insert the CD-ROM. The [New Hardware Found], or [Found New Hardware
Wizard] dialog box appears depending on the system version of Windows
95/98/Me Windows 2000/XP.

❒ Auto Run might not automatically work with certain OS settings. In this case,
launch “Setup.exe” located on the CD-ROM root directory.

❒ If you want to cancel Auto Run, hold down the {{{{SHIFT}}}} key (when your sys-
tem is Windows 2000/Windows XP, hold down the left {{{{SHIFT}}}} key) while
inserting the CD-ROM. Keep the {{{{SHIFT}}}} key held down until the computer
has finished accessing the CD-ROM.

❒ Clicking [Cancel] during the installation of software aborts the installation. If
you cancel the installation, restart your computer and install the rest of the
software or printer driver you want to install.

The LAN FAX Driver and Address Book can be installed by Auto Run.

❖❖❖❖ Location of the file
The following folders are stored in the CD-ROM:
• LAN FAX Driver for Windows 95/98/Me

\DRIVERS\LAN-FAX\WIN9X_Me
• LAN FAX Driver for Windows 2000/XP

\DRIVERS\LAN-FAX\WIN2000
• LAN FAX Driver for Windows NT4.0

\DRIVERS\LAN-FAX\NT4
• Address Book

\UTILITY\ADDRESS
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❖❖❖❖ Operating Environment
• Computer

PC/AT Compatible
• Operating Systems

Microsoft Windows 95/98/Me
Microsoft Windows 2000/XP
Microsoft Windows NT4.0

• Display
VGA 640×480 dots or more

Limitation
❒ All operations cannot be guaranteed depending on the system environment.
❒ When you use Windows NT, the LAN FAX Driver will not work under an

RISC base processor (MIPS R series, Alpha AXP, PowerPC) environment.

Note
❒ To install the driver on Windows 2000/XP or Windows NT4.0, log on using

an account that has Administrator permissions.
❒ Before beginning installation, exit all other applications.

Installing the LAN FAX Driver and the Address Book

Note
❒ The LAN FAX Driver and Address Book are available when the machine is

equipped with Fax Function Upgrade Unit.

AAAA Quit all running applications.

BBBB Insert the CD-ROM included with this machine into the CD-ROM drive of
your computer.
The installer launches automatically and the Select Language dialog box ap-
pears.

Note
❒ Depending on your operating system settings, the installer may not launch

automatically. If it does not, double-click “SETUP.EXE” in the CD-ROM
root directory to launch the installer.

CCCC Select the interface language of the software you are installing, and then
click [OK].

The Printer Drivers and Utilities screen appears.

DDDD Click [LAN-FAX/Address Book].
The Add Printer and Utility wizard launches.
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EEEE Read all of the terms and, if you agree, select the [I accept the agreement.]
check box and click [Next].

Note
❒ If you select the [I don't accept the agreement.] check box, you cannot install

the software.

FFFF Select the [Address Book] and [LAN-Fax Driver] check boxes, and then click
[Next].
The Welcome dialog box appears.

GGGG Click [Next].

HHHH Double-click [Printer Name : <LAN-Fax M2>].

IIII Click [Port : <LPT1>] and then click [Add].

JJJJ Add a port.

Reference
You can check information about the procedure for adding a port with
“Printer Drivers and Utilities”. See “Installation Method” in the Printer
Reference 1.

KKKK After adding a port, click [Finish].
The Installation Completion dialog box appears.

LLLL Click [Finish].
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Setting LAN FAX Properties

This section describes how to make
settings such as document size, reso-
lution, and options.
For details, see the Help file.

Note
❒ If the options on this machine are

not configured as instructed, the
function may fail to work as in-
tended.

❒ If your operating system is Win-
dows 2000/XP or Windows NT4.0,
log on using an account that has
Administrator permissions.

AAAA On the [Start] menu, point to [Set-
tings] and then [Printers]. 

Note
❒ With Windows XP, select [Print-

ers and Faxes] from the [Start]
menu.

BBBB Click to select “LAN-Fax M2”,
and then select [Properties] from
the [File] menu. 

Note
❒ With Windows NT, select [Docu-

ment Default] from the [File]
menu.

CCCC Click the [Paper] tab. 

Note
❒ With Windows 2000/XP, click

the [Advanced] tab, and then
click [Printing Defaults...].

DDDD Make the paper settings. 

Note
❒ The “Gray Scale” box does not

appear in Windows NT or Win-
dows 2000/XP. 

❖❖❖❖ Accessories
A Click [Accessories...].
B Select the appropriate check

boxes.

Note
❒ When the optional Expan-

sion Memory is installed,
select the [Memory Exten-
sion] check box.

❒ Be sure to check the [Hard
Disk Unit] check box is se-
lected.

❒ The optional ISDN Unit is
required in order to use a
G4 line.

Limitation
❒ The lines that can be se-

lected when the optional
unit has been installed in
this machine are:
• G3-1
• G3-2
• G4

❒ The G3-3 cannot be select-
ed even when the optional
unit has been installed in
this machine.

C Click [OK].

EEEE Click [OK]. 
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Basic Transmission

This section describes how to send fax
documents created using Windows
applications. 
To send a fax, simply select [Print]
from the Windows application, then
select LAN FAX as the printer and
specify a destination in the LAN FAX
dialog box.
Open the application document you
want to send or create a new docu-
ment, and then perform the following
procedure. 
For details, see the Help file.

AAAA On the [File] menu, click [Print...]. 

BBBB Click “LAN-Fax M2” in “Printer
Name”, and then click [OK]. 

Note
❒ The setting method may differ

depending on the application
you are using. In all cases, select
[LAN-Fax M2] for the printer. 

CCCC Specify the destination.

Enter [qqqq] and the registered
number when using Quick Dials.
Enter [qqqq] [pppp] [pppp] and the regis-
tered number when using Group
Dials.

Note
❒ You can specify a destination

using the Quick Dials, Group
Dials, or Address Book.

❒ You can directly enter the fax
number.

❒ You can specify up to 100 desti-
nations (200 with the optional
Fax Function Upgrade Unit in-
stalled and 500 with the optional
Expansion Memory installed).

DDDD Specify options. 

Reference
See p.142 “Attaching a Cover
Sheet”.
See p.142 “Specifying options”.

If you do not want to specify op-
tions, go to step E.

Attaching a Cover Sheet 

A Select the [Attach a Cover Sheet]
check box. 

Note
❒ To edit this setting, click

[Cover Sheet...]. For details,
see the Help file. 

Specifying options

You can specify the following op-
tions: 
For details, see the Help file.
• Sending at Specific Time

See p.5 “Sending at a Specific
Time (Send Later)”.

• User Code
See p.11 “Reading the Display
Panel and Using Keys”, Facsimi-
le Reference (option) <Basic Fea-
tures>.

• User ID
Required to identify docu-
ments. The User ID lets you
browse a log of the jobs on
SmartNetMonitor for Client.

• Print Fax Header
See p.102 “Fax Header Print Set-
ting”.

• Document Server
See p.84 “Using the Document
Server”.
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A Click [Option...]. 

B Specify options you want to
use.

Note
❒ The User Code you specified

for this machine must be the
same as the one entered in
this  machine.  See  “User
Code” in the General Set-
tings Guide.

C Click [OK]. 

EEEE Click [Send]. 

Note
❒ When you click [Print & Send], a

fax will be transmitted to the
destination and a copy of the
document you send will be
printed from your machine.

❒ Click [Print...] to print a copy of
the document you specified
without sending it to the desti-
nation.

----Transmission result notification
After you have sent faxes from your
computer, this function informs your
computer whether the fax was suc-
cessfully transmitted to its destina-
tion or not.
When you store documents in the
Document Server or use this machine
just as a printer, this function also in-
forms your computer whether data
was successfully transmitted to this
machine or not.

Note
❒ You cannot refer to any informa-

tion when using version 5.0 or ear-
lier of SmartNetMonitor for Client.

Printing

You can print documents created us-
ing Windows applications. 
Open the application document you
want to print or create a new docu-
ment, and then perform the following
procedure. 
For details, see the Help file.
This function always prints pages in
black and white even if a color other
than black is specified in “FAX Print
Color” of “Reception Mode”.

AAAA On the [File] menu, click [Print...]. 

BBBB Click “LAN-Fax M2” in “Printer
Name”, and then click [OK]. 

Note
❒ The setting method may differ

depending on the application
you are using. In all cases, select
“LAN-Fax M2” for the printer. 

CCCC Click [Print]. 

Address Book

You can program and edit destina-
tions in the Address List using the
Address Book.
For details, see the Help file.

AAAA On the [Start] menu, point to [Pro-
grams], and then [Address Book]. 

BBBB Edit an existing destination or
program a new one. 

Note
❒ You can divide programmed

destinations into groups by
clicking [Group...]. For details,
see the Help file. 

❒ For “Line”, select the appropri-
ate line type: G3, G4 or G3-2.
143



LAN FAX Features

144

9

❖❖❖❖ Programming New Destinations
A Enter the destination.
B Click [Add]. 

❖❖❖❖ Editing Programmed Destinations
A Select the destination you

want to edit from the list.
The name of the company
should appear in gray.

B Edit the data.
C Click [Update]. 

❖❖❖❖ Deleting Programmed Destinations
A Select the destination you

want to edit from the list.
The name of the company
should appear in gray.

B Click [Delete]. 
C Click [Yes].

CCCC Click [Close].

DDDD If you made changes to a destina-
tion, a confirmation dialog box
appears. To save the changes you
made, click [Yes]. 
If you do not want to save the
changes and want to quit editing,
click [No]. 
To return to the editing screen,
click [Cancel].

LAN FAX Operation Messages

Message Causes and Recommended Actions

Cannot access the printer. Click [re-
try] to send the data again.

Check the network connection.

Check that the power of this machine is turned on.

The number of entries in Destina-
tions exceeds the limit. 

Up to 100 entries can be entered.

The number of destinations specified exceeds the maxi-
mum possible. The maximum number of destinations 
that can be specified at one time is 100 (Up to 200 with 
optional Fax Function Upgrade Unit, up to 500 with op-
tional Expansion Memory.).

“LAN FAX” has already been 
launched. Connot launch it again.

The LAN FAX dialog box is already open. Exit LAN 
FAX once, then start it up again.

Failed to allocate memory. Available memory is insufficient.
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View Received Messages on a PC

Separately sold ScanRouter V2 Pro-
fessional is also required as a delivery
server. Separately sold DesktopBind-
er V2 Professional Lite or Desktop-
Binder V2 Professional software is
must be installed on your PC.

Note
❒ This manual uses the name Desk-

topBinder V2 Professional/Lite to
refer to both DesktopBinder V2
Professional Lite and Desktop-
Binder V2 Professional.

Delivering Received Messages

Messages received by the machine
can be viewed on or downloaded to a
PC with the networked delivery serv-
er ScanRouter V2 Professional. This is
a useful function enabling you to
view and store messages on your PC
without printing them.
Using the delivery server, you can
eliminate the extra work of retrieving
received messages from the machine
and delivering them to each ad-
dressed person.

❖❖❖❖ Functions
Delivery server provides the fol-
lowing functions:
• Use the delivery server to asso-

ciate incoming messages (Con-
fidential ID, SUB Code, Own
Name and Own Fax Number)
with receivers so that received
messages are delivered to the
associated receivers.

• You can choose the delivery
method for incoming messages:
"Save in the delivery server in-
box," "Send as an email attach-
m e nt , "  o r  "S av e  i n  t h e
designated PC folder." Incom-
ing messages with no Confiden-
tial ID, SUB Code, Own Name
or Own Fax Number are saved
in the delivery server inbox.

• You can check or download re-
ceived messages stored in the
delivery server inbox using
"DesktopBinder V2 Professional
Lite" or "DesktopBinder V2 Pro-
fessional" software.

Limitation
❒ Confidential messages are

also forwarded to the deliv-
ery server.

Note
❒ To view or download mes-

sages stored in the inbox of
the delivery server, you need
to install the included "Desk-
topBinder V2 Professional
Lite" software or the sepa-
rately sold "DesktopBinder
V2 Professional" on your PC. 

❒ To send received messages to
your PC as email attach-
ments, you need to have a
ScanRouter V2 Professional-
compatible email program
on your PC.

❒ To create a network with the
delivery server,  settings
must be specified in the User
Tools of the machine. Set-
tings must also be specified
on the delivery server. See
“Configuring the Network ”
in General Settings Guide
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❒ See the instructions or Help
on the ScanRouter V2 Profes-
sional for more information
on the delivery server (Scan-
Router V2 Professional).

❒ For information on the Desk-
topBinder V2 Profession-
al/Lite software, see the
instructions or Help in Desk-
topBinder V2 Profession-
al/Lite.
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Administering the Fax Information on a PC

The optional SmartNetMonitor for
Admin is required in order to use this
feature.

Note
❒ SmartNetMonitor for Admin and

SmartNetMonitor for Client are on
the CD-ROM included with this
machine.

Remote Administration

Remote Administration is a function
of “SmartNetMonitor for Admin”. In-
cluded are Quick Dial Table Manage-
ment functions and Data Report
Import functions to administer the
Quick Dial Table and transmission re-
ports stored in this machine. With the
Quick Dial Table Management func-
tions, you can edit and register/mod-
ify the Quick Dial Table and Group
Dial list stored in the machine. Using
the Data Report Import functions,
you can download the transmission
history list and view each item of the
fax transmission.

Reference
You can check more information
about “SmartNetMonitor for Ad-
min” and the installation proce-
dure with “Printer Drivers and
Utili ties” .  See “Installing the
SmartNetMonitor for Client/Ad-
min” in the Printer Reference 1.

❖❖❖❖ Functions
Remote Administration provides
the following functions.
• Quick Dial Table Management

functions

• You can edit and manage the
Quick Dial Table and Group
Dial list stored in this ma-
chine.

• You can register the same
Quick Dial Table and Group
Dial list on multiple ma-
chines.

• Report Management functions
• You can view and print the

fax transmission history list
stored in the machine. You
can also save the list in CSV
format.

• The contents of the list are
s e p a r a t e d  b y  t a b s  in t o
[Transmission], [Reception]
and [PC FAX] (LAN FAX).

• You can change items to be
listed (start date, destination,
transmission time, number of
pages, transmission results,
User Code, file number, com-
munication charges  and
transmission type) and their
order in the list.

• You can also update the file
to view the latest informa-
tion.

❖❖❖❖ Starting Remote Administration
A Start “SmartNetMonitor for Ad-

min”.
B Select the name of this machine.
C Click [Tools].
D From the menu, select [Import

Destination Data], [Register
Destinations] or [Import Jour-
nal].

Reference
For details, see the Help file.
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----Administer transmission using 
the LAN FAX driver

From “SmartNetMonitor for Admin”
or “SmartNetMonitor for Client”, you
can administer transmissions using
the LAN FAX driver. You can view
the following information on trans-
mitted files using the LAN FAX driv-
er.
• User ID
• Status
• Number of pages
• Start time
• File No.

Reference
For details, see the Help file.
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Reading Reports

Error Report 

An Error Report is printed when a
message could not be successfully
sent or received.
Possible causes include a problem
with your machine or noise on the tel-
ephone line. If an error occurs during
transmission, re-send the original. If
an error occurs during reception, ask
the sender to re-send the message.

Note
❒ If the error happens frequently,

contact your service representa-
tive.

❒ The “Page” column gives the total
number of pages. The “Page Not
Sent” column gives the number of
pages that were not sent or re-
ceived successfully.

Power Failure Report

R CAUTION:

Even if the main power switch is
turned off, the contents of the ma-
chine's memory (for example, pro-
grammed numbers) will not be lost.
However, if power is lost for about 1
hour through the main power switch
being turned off, a power cut or the
power cable being removed, contents
of the Fax memory will be lost. Lost
items will include any fax messages
stored in memory using Memory
Transmission or Reception.

If a file has been deleted from memo-
ry, a Power Failure Report is auto-
matically printed as soon as power is
restored. This report can be used to
identify lost files. If a memory stored
for Memory Transmission was lost,
re-send it. If a message received by
Memory Reception or Substitute Re-
ception was lost, ask the sender to re-
send it.

Important
❒ Do not turn off the main power

switch while the power indicator is
lit or blinking. If you do, failure
and/or damage may cause to the
hard disk and the memory.

❒ Turn off the main power switch be-
fore pulling out the plug. If you
pull out the plug with the switch
on, the hard disk or memory may
be damaged. It may also cause
complete failure of the hard disk or
memory.

❒ Make sure that 100% is shown on
the display before you unplug the
machine. If a lower value is shown,
some data is currently stored in
memory.

❒ Right after a power failure, the in-
ternal battery needs to be suffi-
ciently recharged to guard against
future data loss. Please keep the
machine plugged in and the main
power switch on for about one
week after the power loss occurs.

• When you disconnect the power 
plug from the wall outlet, always 
pull the plug (not the cable).
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----RDS (Remote Diagnostic 
System)

If your machine has a problem, a
service representative can perform
various diagnostic tasks over the tele-
phone line from the service station to
try to find out what is wrong with
your machine. The service represent-
ative can also use RDS to change
some of your machine's settings if
you request it.
If you wish to use this function,
change the User Parameter. See p.113
“Changing the User Parameters”
(Switch25, Bit4).
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When Toner Runs Out

When the machine has run out of ton-
er the symbol appears on the display.
Note that even if there is no toner left,
you can still send fax messages.

Important
❒ If you continue receiving and

sending faxes after toner runs out,
communication will not be possi-
ble after 200 communications
(1,000 with the optional Expansion
Memory).

Note
❒ The Memory Storage Report, Poll-

ing Reserve Report and Confiden-
tial File Report are not printed.

AAAA Make sure that the machine is in
Facsimile mode and the standby
display is shown.

Note
❒ If the standby display is not

shown, press the {{{{Facsimile}}}}
key.

BBBB Press [Exit].

The error display closes.

Reference
See p.21 “Memory Transmis-
sion”, Facsimile Reference (option)
<Basic Features>.
See p.26 “Immediate Transmis-
sion”, Facsimile Reference (option)
<Basic Features>.
151



Solving Operation Problems

152

10



11. Appendix
Replacing the Stamp Cartridge

The optional Document Feeder (ADF) is required.

When the stamp becomes lighter, re-
place the cartridge.

Note
❒ Use the cartridge specified for this

machine.

AAAA Lift the optional Document Feed-
er (ADF).

BBBB Open the stamp cover.

CCCC Pull out the cartridge.

DDDD Set a new cartridge while holding
down the lock lever.

Insert the cartridge until its metal
parts are not visible.

1. New Cartridge
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EEEE Replace the stamp cover until it
clicks.

FFFF Close the optional Document
Feeder (ADF).
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Connecting the Machine to a Telephone 
Line and Telephone

Connecting the Telephone Line

To connect the machine to a telephone line, use a snap-in modular type connec-
tor.

Important
❒ By law in the United States, you must program your phone number identifi-

cation (your FAX NUMBER) into your machine before you can connect the
public phone system. See Chapter 3, "Initial Settings (Function 61)" in the Ba-
sic Features manual.

❒ Make sure the connector is the correct type before you start.

❖❖❖❖ Where to connect the machine

1. G4 Interface Unit Connector

2. Extra G3 Interface Unit Connector

3. G3 Interface Unit Connector

4. Optional Handset or External Tel-
ephone Connector

Important
❒ Do not connect the G3 line into the G4 Interface Unit Connector.
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Connecting the Machine to ISDN 

The optional ISDN Unit is required.

For details about how to install the optional ISDN Unit, please contact your serv-
ice representative.
Connect the machine to the ISDN with a modular type connector. 

Selecting the Line Type

Select the line type to which the machine is connected. There are two types: tone
and pulse dial.
Select the line type using in “Key Operator Settings”. See p.134 “Selecting Di-
al/Push Phone”.
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Connecting the Optional Handset or an External Telephone

You can connect the handset and an external telephone to the machine. You can
use them for telephone calls.

Note
❒ Some telephone may not be connected or may suffer reduced functionality.

Limitation
❒ When you use the handset or an optional external telephone with the {{{{On

Hook Dial}}}} key for telephone calls, you can not talk with the other party with-
out pressing the {{{{On Hook Dial}}}} key after taking off the receiver.

❖❖❖❖ Specifying the handset line type

The switch on the handset should be in the appropriate position-TT (Tone Di-
aling) or DP (Pulse Dialing).

❖❖❖❖ Adjusting the handset bell volume

Adjust the handset ringer volume using the volume switch.
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Multi-port

When the optional ISDN Unit or optional Extra G3 Interface Unit is installed,
communications can take place simultaneously through two lines at once.

Note
❒ A maximum of three communications can take place simultaneously.
❒ You cannot perform three Immediate Transmissions simultaneously.
❒ If three fax messages are received simultaneously, they cannot be printed out

at the same time.
❒ If three communications are in progress, the display shows the first commu-

nication that was initiated.

Option Available Line Types Available Protocol Combinations

Without option PSTN G3

Extra G3 Interface Unit PSTN+PSTN G3+G3

ISDN Unit PSTN+ISDN G3+G4

or

G3 (ISDN)+G4

ISDN G3 (ISDN)+G4

Extra G3 Interface Unit+G4 
Interface Unit

PSTN+PSTN+ISDN G3+G3+G4

or

G3 (ISDN)+G4

PSTN+ISDN G3+G3(ISDN)+G4

or

G3 (ISDN)+G3(ISDN)
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Optional Equipment

Fax Function Upgrade Unit

JBIG compression for transmission/reception becomes possible.
You can increase the maximum programmable numbers of the following func-
tions. See p.164 “Maximum Values”.
• Quick Dial
• Memory Transmission file
• Auto Document
• Specific Sender
• Program
• Transmission Result

Expansion Memory (32MB: DIMM)

This allows you to send and receive fax messages at high resolution (Fine or Su-
per Fine). If you need this option, please consult your service representative. See
p.164 “Maximum Values”.

ISDN Unit

This allows you to send and receive messages via ISDN (Integrated Service Dig-
ital Network).
You can use the following functions.

Extra G3 Interface Unit 

This option provides one Extra G3 line connection.

Handset

You can use the following functions.

Function Reference

Sub-address See p.39 “Sub-address”.

UUI See p.40 “UUI”.

Function Reference

On Hook Dial See p.41 “On Hook Dial”.

Manual Dial See p.42 “Manual Dial”.



Appendix

160

11
Specifications

❖❖❖❖ Power Consumption

Standard G3, G4 (option)

Resolution G3: 

8×3.85/mm•200×100dpi (Standard), 
8×7.7/mm•200×200dpi (Detail), 
8×15.4/mm•200×400dpi (Fine), 
16×15.4/mm•400×400dpi (Super Fine: optional 
Expansion Memory required) 

G4: 

200×100dpi (Standard), 200×200dpi (Detail), 
400×400dpi (Super Fine: optional Expansion Mem-
ory required) 

Transmission Time G3: 3 seconds at 28,800bps, Standard resolution

G4: 3 seconds, Detail resolution 

Data Compression Method MH, MR, MMR, JBIG (optional Fax Function Up-
grade Unit required)

Maximum Original Size Standard size: A3, 11"×17" 
Irregular size: 304×432mm 

Maximum Scanning Size 297×1,200mm/11"×47" 

Print Process Printing on standard paper using a laser

Transmission Speed G3: 

33,600/31,200/28,800/26,400/24,000/21,600/19,2
00/16,800/14,400/12,000/9,600/7,200/4,800/2,40
0bps (auto shift down system)

G4: 

64/56kbps (auto speed matching)

I G3: 

Max 26,400bps

Standby Mode 200W

Transmission 200W

Reception 200W

Maximum Power Consumption 1,500W

Auto Off Mode 40W or less
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Acceptable Types of Originals

Make sure your originals are completely dry before setting them in the machine.
Originals containing wet ink or correcting fluid will mark the exposure glass and
the resulting image will be affected.

Acceptable Original Sizes

Paper Size and Scanned Area

❖❖❖❖ Exposure Glass

❖❖❖❖ Optional Document Feeder (ADF)

Where Original is Set Acceptable Original Size Maximum 
Number of 
Sheets

Paper Thickness

Exposure Glass Maximum A3 (297×420mm), 
11"×17" (279×432mm)

 1 ----

Optional Document 
Feeder (ADF), single-
sided document

Fax transmission: A5 L to A3 
L (up to 1,200mm long) 
8"×51/2" L to 11"×17"L

50 sheets 
(80g/m2, 20lb)

40 -128g/m2 
(11-34lb)

Optional Document 
Feeder (ADF), dou-
ble-sided document

Fax transmission: A5 L to A3 
L (up to 432mm long) 8"×51/2" 
L to 11"×17"L

50 sheets 
(80g/m2, 20lb)

52-105g/m2 
(14-28lb)
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Limitation
❒ There may be a difference in the size of the image when it is printed at the des-

tination.
❒ If you place an original larger than A3, 11"×17" on the exposure glass, only an

are a of A3, 11"×17" is scanned.

Note
❒ Even if an original is correctly placed on the exposure glass or in the optional

Document Feeder (ADF), a margin of 3mm (0.1") around each edge of the
original may not be sent.

❒ If the receiver uses paper of smaller width than the original, the image will be
reduced to fit the paper. See p.54 “Auto Reduce”.

❒ The machine detects paper sizes in the following ways:
• When you place an original in the optional Document Feeder (ADF), an

original wider than about 268mm (10.5") is scanned as A3, 11"×17" size. 
An original narrower than about 235mm (9.2") will be sent as 81/2"×11" or
81/2"×14" size.
Originals up to 1,260mm (49") in length can be scanned. 

• Refer to the table below for the sizes the machine can detect when you
place an original on the exposure glass. Because the machine scans in non-
standard size documents as one of the standard sizes, parts of the image
may be truncated depending on the length of the document. For details
about how to set non-standard size documents. See p.18 “Setting a Scan
Area”, Facsimile Reference (option) <Basic Features>.

❖❖❖❖ Metric Version

❖❖❖❖ Inch Version

× - Unable to auto detect
*1 Normally a length of about 420mm (16.5") can be scanned, however, it is only possi-

ble to specify a scanning size up to 432mm (17").

Length *1 

∼245mm 245mm∼270mm 270mm∼318mm 318mm∼

Width ∼242mm × B5L A4L 81/2"×13"L

242mm∼
272mm

B5K × × B4L

272mm∼ A4K × × A3L

Length *1 

∼9.6" 9.6"∼10.6" 10.6"∼12.5" 12.5"∼

Width ∼9.5" × × 81/2"×11"L 81/2"×14"L

9.5"∼10.7" × × × ×

10.7"∼ 81/2"×11"K × × 11"×17"L
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----Maximum scan area
The Maximum Scan Area is shown below.
• Memory Transmission: 297×1,260mm/11"×49" (W×L) from the optional Doc-

ument Feeder (ADF)
• Immediate Transmission: 297×1,260mm/11"×49" (W×L) from the optional

Document Feeder (ADF)

Note
❒ During Immediate Transmission, the length of the scanning range can be-

come narrower than 1,260 mm (49"), depending on the character size as
well as the settings on the destination machine.

• 297×432mm/11"×17" (W×L) (From the exposure glass)
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Maximum Values

The following list contains the maximum value for each item. 

Item Standard With optional unit

Fax Function 
Upgrade Unit

Expansion 
Memory

Expansion Memory 
+ Fax Function 
Upgrade Unit

Memory 2MB 2MB 26MB 26MB

The number of pages 
that you can store in 
memory (Using A4 size 
Standard <ITU-T 
#1Chart> ) 

160 160 1,000 2,080

Total number of all files 400 800 400 800

The number of pages 
per file

400 400 1,000 1,000

The number of pages 
for all files

400 400 1,000 3,000

The number of destina-
tions you can specify 
for one file

500 500 500 500

The number of destina-
tions you can specify 
for all files

500 2,000 500 2,000

The number of Quick 
Dials you can register 

400 1,200 400 1,200

The number of Group 
Dials you can register

64 64 64 64

The number of destina-
tions you can specify 
by the number keys

100 1,000 100 1,000

The number of destina-
tions you can register 
in a group *1 

500 500 500 500

The number of destina-
tions you can register 
in all groups *1 

500 2,200 500 2,200

The number of digits 
for Dials

254 254 254 254

The number of Pro-
grams you can register

100 200 100 200
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*1 You can register 400 destinations in the Quick Dials and 100 destinations in the
number keys as a Group. When the optional Fax Function Upgrade Unit is installed:
1,200 destinations in the Quick Dials/1,000 destinations in the number keys.

The number of Auto 
Documents you can 
register

6 18 6 18

The number of Stand-
ard Message Stamps 
you can register

3 3 3 3

The number of trans-
mission results the ma-
chine can store

200 1,000 200 1,000

The number of stored 
documents you can 
specify at one time

400 400 1,000 1,000

The number of stored 
documents you can 
send at one time

30 30 30 30

The number of pages 
that you can store in 
Document Server (Us-
ing ITU-T #4Chart ) 

2000 2,000 2,000 2,000

The number of pages 
you can store in Docu-
ment Server for one 
document

400 400 1,000 1,000

Item Standard With optional unit

Fax Function 
Upgrade Unit

Expansion 
Memory

Expansion Memory 
+ Fax Function 
Upgrade Unit
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180 Degree Rotation Printing,   72
2-Sided Printing,   64, 71
2-Sided Transmission,   46

A

Acceptable Types of Originals,   161
Accessories,   141
Address Book,   143
Attaching a Cover Sheet,   142
Authorized Reception,   118
Auto Document,   47, 97

Changing,   97
Deleting,   99
Sending,   47
Storing,   97

Auto Fax Reception Power-up,   69
Auto Identification,   44
Automatic Redial,   58
Auto Reduce,   54

B

Basic Transmission,   142
Batch Transmission,   58
Book Fax,   45
Box Setting,   107, 124
Broadcasting Sequence,   59

C

Canceling
Transmission,   14
Transmission Files,   13

Center Mark,   70
Chain Dial,   33
Changing

Line Type,   43
Transmission Time,   16

Checkered Mark,   70
Checking

Reception Result (RX File Status),   22
Transmission Files,   13
Transmission Result (TX File Status),   21

CIL,   75
CIL/TID Print,   75
Combine 2 originals,   63, 73
Communication Failure Report,   61
Communication Information,   19
Confidential File Report,   25
Confidential ID,   132
Confidential Message,   24
Confidential Transmission,   7
Counters,   107, 109
CSI→Own Fax Number,   66

D

Default ID/Free Polling Reception,   11
Default ID Transmission,   8, 55
Default ID TX,   9
Deleting

Information Box Messages,   31
Programmed Destinations,   144

Destination
Adding,   15
Checking,   13
Deleting,   14

Displaying the Memory Status,   23
Document Server,   84

Delete File,   88
File Manage,   87
Storing a Document,   85

Dual Access,   59
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ECM (Error Correction Mode),   58, 107, 112
Economy Transmission Time,   5
Editing Programmed Destinations,   144
End Receiver,   38, 67
Error Report,   149
Expansion Memory,   159
Extra G3 Interface Unit,   159

F

Fax Function Upgrade Unit,   159
Fax Header Print,   53
File

Printing,   17
Printing a List of Files in Memory 

(Print TX File List),   18
Re-sending,   17

Forwarding,   107, 109, 118
Forwarding Station,   110
Free Polling Transmission,   8
Free Polling TX,   9
Full/Partial agreement,   117
Function List,   107

G

G3/G4 Separate Tray,   79
General Settings/Adjustment,   92, 102

H

Handset,   159
Handy Dialing Functions,   33

I

ID Override Polling Reception,   11
ID Override Transmission,   9
Image Rotation,   59, 72
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For safe and correct use of this machine, please be sure to read the Safety Information in the
“General Settings Guide” before you use it.



Introduction

This manual describes detailed instructions on the operation and notes about the use of this machine.
To get maximum versatility from this machine all operators are requested to read this manual carefully
and follow the instructions. Please keep this manual in a handy place near the machine.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Software Version Conventions Used in this Manual

• NetWare 3.x means NetWare 3.12 and 3.2.

• NetWare 4.x means NetWare 4.1, 4.11 and IntranetWare.

Trademarks

Apple, AppleTalk, EtherTalk, LaserWriter, Macintosh and Mac are registered trademarks of Apple
Computer, Inc.

Ethernet is a registered trademark of Xerox Corporation.

Microsoft, Windows and Windows NT are registered trademarks of Microsoft Corporation in the United
States and/or other countries.

Netscape and Netscape Navigator are registered trademarks of Netscape Communications Corpora-
tion.

Novell, NetWare and NDS are registered trademarks of Novell, Inc.

PostScript is a registered trademark of Adobe Systems, Incorporated.

Sun is a registered trademark of Sun Microsystems, Inc.

SunOS is a trademark of Sun Microsystems, Inc.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

The proper names of the Windows operating systems are as follows:

• The product name of Windows® 95 is Microsoft® Windows 95.

• The product name of Windows® 98 is Microsoft® Windows 98.

• The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).

• The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

• The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

• The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Server 4.0

• Microsoft® Windows NT® Workstation 4.0
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Manuals for This Machine

The following manuals describe the operational procedures and maintenance of
this machine.
To enhance safe and efficient operation of this machine, all users should read
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 is installed
and follow the instructions carefully.

❖❖❖❖ General Settings Guide
Provides an overview of the machine. This manual introduces th
of the machine. It also introduces the options that allow you to use
functions and describes how to access the system user tools to ma
chine easier to use.

❖❖❖❖ Copy Reference
Describes procedures and functions for using this machine as a co

❖❖❖❖ Printer/Scanner Kit Type 1232 Printer Reference 1
Describes system settings, procedures and functions for using this 
a printer.

❖❖❖❖ Printer/Scanner Kit Type 1232 Printer Reference 2
Describes procedures and provides information about using this 
a printer. This manual is included as a PDF file on the CD-ROM la
erating Instructions”.

❖❖❖❖ Network Printing Guide Operating Instructions
Describes procedures and provides information about setting up
the machine as a printer in a network environment. We recommen
this manual first. It is included as a PDF file on the CD-ROM labe
ating Instructions” (this manual).

❖❖❖❖ PostScript 3 Board Type 1232 Operating Instructions Supplement
Describes menus and features you can set using the PostScript 3 p
er. This manual is provided as a PDF file on the CD-ROM labeled “
Instructions”.

Note
❒ Printing with the PostScript 3 printer driver is available whe

Script 3 board option is installed on your machine.

❖❖❖❖ UNIX Supplement
Provides information about setting up and using the machine as 
a UNIX environment. For UNIX printing information, please vis
site or consult your authorized dealer.

❖❖❖❖ Scanner Reference
Describes system settings, procedures and functions for using this 
a scanner.

Note
❒ Scanner function is available when the Printer/Scanner option

on your machine.
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

R CAUTION:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates the prior knowledge or preparations required before op-
erating.

Note
This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys that appear on the machine's panel display.
Keys and buttons that appear on the computer's display.

{ }
Keys built into the machine's control panel.
Keys on the computer's keyboard.



Introduction

This manual contains detailed instructions on configuring the machine as a net-
work printer. Read the section appropriate to your network environment on
how to configure the machine correctly.

Important
❒ The procedures written in this manual assume that you are a network admin-

istrator. If you are not, be sure to consult your network administrator before
configuration.

Reference
For more information about configuring the Network Interface Board with
the control panel, see the General Settings Guide.

❖❖❖❖ Features
• Support for 100BASE-TX, 10BASE-T, IEEE 1394 (IP over 1394) and IEEE

802.11b.
• The Network Interface Board is compatible with NetWare *1  (IPX/SPX,

TCP/IP), Windows NT 4.0 (TCP/IP, NetBEUI *2 , IPP *3 ), Windows 2000
(TCP/IP, NetBEUI *2 , IPP *3 ), Windows XP (TCP/IP, IPP *3 ), Windows
95/98/Me (TCP/IP, NetBEUI *2 , IPP *3 ), UNIX (TCP/IP) and Macintosh
(AppleTalk) *4  protocols. This allows you to use the machine in a network
that uses different protocols and operating systems.

• A computer used as a dedicated print server is not required because the
Network Interface Board can be configured as a NetWare print server.

NetWare (Server)

Windows NT (Server)
Windows 2000/XP or

Windows 2000/XP

Windows 95/98/Me

Macintosh

Windows NT

         NetWare
          (Client)

UNIX
3
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• The Network Interface Board can connect the machine to the network
without requiring its own power supply because the Network Interface
Board is installed inside the machine.

*1 If the optional 802.11b Interface Kit has been installed, you cannot use the ad hoc
mode.

*2 To use NetBEUI, use the SmartNetMonitor for Client port.
*3 IPP (Internet Printing Protocol) is a protocol for printing via the Internet.
*4 An optional PS3 module is necessary.

❖❖❖❖ Interface supported protocols

❍ means that the protocol is supported.
× means that the protocol is not supported.
*1 If the optional 802.11b Interface Kit has been installed, you cannot use the ad hoc

mode.

Interface

Ethernet IEEE 802.11b IEEE 1394 
(IP over 1394)

Protocol

TCP/IP ❍ ❍ ❍

NetBEUI ❍ ❍ ×

NetWare ❍ ❍ *1 ×

AppleTalk ❍ ❍ ×



Setting Up the Machine on a Network

Windows 95/98/Me, Windows 2000/XP, Windows NT 4.0

For setting up the machine as a network printer in Windows 95/98/Me, Win-
dows 2000/XP and Windows NT 4.0 environment;
See p.11 “Windows 95/98/Me Configuration”.
See p.23 “Windows 2000 Configuration”.
See p.35 “Windows XP Configuration”.
See p.47 “Windows NT 4.0 Configuration”.

TCP/IP
NetBEUI
IPP

TCP/IP
NetBEUI
IPP
LPR

❖ Printing Without a Print Server

Windows 95/98/Me Windows 2000

TCP/IP
IPP
LPR

TCP/IP
NetBEUI
IPP
LPR

Windows XP Windows NT 4.0

Windows 2000/XP or
Windows NT Server (or Workstation)
Print Server

Windows 95/98/Me Windows 2000/XP Windows NT 4.0

❖ Printing With a Windows 2000/XP or Windows NT Print Server
5
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NetWare

For setting up the machine as a network printer in a NetWare environment, see
p.59 “NetWare Configuration”. The Network Interface Board allows you to use
the machine as either a print server or a remote printer.
For more information about setting up the clients, see the following pages.
• See p.78 “Windows 95/98/Me” .
• See p.79 “Windows 2000/XP, Windows NT 4.0” .

Configuring the machine as a print server

A dedicated NetWare print server is not required because the machine can be
configured as a print server.

Actual procedures for configuring the machine depend on the NetWare version.
• NetWare 3.x, 4.x, 5/5.1

See p.65 “Setting Up as a Print Server”.

NetWare
File Server

Print Server

Windows 95/98/Me Windows 2000/XP Windows NT 4.0



Configuring the machine as a remote printer

If a dedicated NetWare print server is being used, the machine should be config-
ured as a remote printer.

The actual procedures for configuring the machine depend on the NetWare ver-
sion, see p.72 “Setting Up as a Remote Printer”.

Macintosh

For setting up the machine as a network printer in a Macintosh environment, see
p.81 “Macintosh Configuration”.

NetWare
Print Server

NetWare
File Server

Remote Printer

Windows 95/98/Me Windows 2000/XP Windows NT 4.0

AppleTalk

Macintosh
7
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UNIX

For UNIX printing information, please visit our web site or consult your author-
ized dealer.

Printing using the IEEE 802.11b Interface

This section describes how to print after installing the optional 802.11b Interface
Kit.
There are two methods of using this machine as a network printer with IEEE
802.11b.

Note
❒ IEEE 802.11b (wireless LAN) is unavailable in some countries, or its use may

be limited.

❖❖❖❖ ad hoc mode (802.11 ad hoc mode/ad hoc mode)
This is the mode for transmitting between each wireless LAN client. You
must make the channels the same for each wireless LAN client to transmit us-
ing this basic transmitting method which does not require an access point.
When using “802.11b ad hoc mode”, the SSID must be set. The ad hoc mode
settings can be made from telnet or a Web Browser. See p.100 “Using in Ad
hoc Mode”.

TCP/IP

UNIX



❖❖❖❖ infrastructure mode
This is the mode for transmitting via an access point. The SSID *1  must be the
same as the access point. When setting WEP *2  , you must set the same values
as an access point. By connecting the access point to Ethernet, you can trans-
mit the current network environment. See p.100 “Using in Infrastructure
Mode”.
*1 This is called a Service Set ID and is used in the connection between the wireless

LAN client and the access point. Only a wireless LAN client and an access point
that have the same SSID can transmit to each other. (The character strings to be set
are in the range ASCII 0x20-0x7e and the SSID is case-sensitive to 32 bytes.)

*2 This is used to protect coded wireless data transmission. When both the wireless
LAN client and the transmission access point are coded using a 64-bit key, you
must set the same WEP key as the printer. (You can set only 10 hexadecimal char-
acters when using 64-bit or 26 hexadecimal characters when using 128-bit.)

❖ad hoc mode

access point

❖infrastructure mode
9



10
Printing using the IEEE 1394 Interface

This section describes how to print via the IEEE 1394 interface after installing the
1394 Interface Unit.
There are two methods of using the machine as a network printer with IEEE
1394.

❖❖❖❖ SCSI print
You can print using the SCSI print device provided by Windows 2000 and
Windows XP. For more information, see “Printing with SCSI Print”, Printer
Reference 1 and p.91 “Configuring the Network Interface Board Settings”.

❖❖❖❖ IP over 1394
You can print by setting the IP address for this machine and the computer on
which Windows Me or Windows XP is installed. For more information, see
“Printing with IP over 1394”, Printer Reference 1 and p.35 “Printing with a
Standard TCP/IP Port” in the Windows XP Configuration.

SCSI print
IP over 1394



1. Windows 95/98/Me
Configuration
Configuring Windows 95/98/Me

Note
❒ Windows 95/98 does not support IP over 1394.

Printing without a Print Server

The following procedure describes how to configure Windows 95/98/Me to use
the machine on a network without a Windows 2000 Server, Windows 2000 Pro-
fessional, Windows XP Server, Windows NT Server, Windows NT Workstation,
or NetWare based print server.

AAAA Specify the protocol to use.

Consult your network administrator about which of the three protocols is ap-
propriate.
• TCP/IP
• IPP
• NetBEUI

BBBB Configure the chosen protocol.

• See p.12 “Configuring TCP/IP and IPP for Printing”.
• See p.13 “Configuring NetBEUI for Printing”.

CCCC Install the software and set the printer driver port.

• Install SmartNetMonitor for Client from the CD-ROM labeled “Printer
Drivers and Utilities”. For more information about how to install the soft-
ware and how to specify the printer driver port, see the Printer Reference 1.

Printing with a Windows 2000/XP or Windows NT Print Server

See p.20 “Setting Up a Client Computer” for configuring Windows 95/98/Me
with a Windows 2000/XP or Windows NT print server.
11
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Configuring Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows 95/98/Me to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
• Make sure that the TCP/IP protocol is set to active. (The default is active.)
• Assign an IP address and make other settings required for using the TCP/IP

protocol.

Reference
For more information about how to make the above settings, see the General
Settings Guide.
If DHCP is used to assign IP addresses, see p.134 “Using DHCP”.

Note
❒ After setting the IP address, use the ping command to make sure that it has

been set correctly.
A Enable the use of the command prompt as follows:

• On Windows 95 or Windows 98
Click [Start], point to [Programs], and then click [MS-DOS Prompt].

• On Windows Me
Click [Start], point to [Programs], point to [Accessories], and then click
[MS-DOS Prompt].

B Type the following: (Example IP address is 192.168.15.16)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.



Configuring Protocols

1

Configuring a Windows 95/98/Me computer

These steps are for configuring a Windows 95/98/Me computer to use the
TCP/IP protocol.

AAAA Open [Control Panel] and then double-click the [Network] icon. Make sure that
“TCP/IP” is listed in the [The following network components are installed] box on
the [Configuration] tab.

Note
❒ If the TCP/IP protocol is not installed, click [Add] on the [Configuration] tab

to install it. For more information about installing the TCP/IP protocol, see
Windows 95/98/Me Help.

BBBB Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 95/98/Me to use the NetBEUI protocol.

Preparation
To use NetBEUI, use the SmartNetMonitor for Client port.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
• Make sure that the NetBEUI protocol is set to active. (The default is active.)

Reference
For more information about how to make the above settings, see the General
Settings Guide.
13
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Configuring a Windows 95/98/Me computer

Install the NetBEUI protocol on the Windows 95/98/Me computer and set it as
the default protocol.

AAAA Open [Control Panel], and then double-click the [Network] icon. Make sure
that “NetBEUI” is listed in the [The following network components are installed]
box on the [Configuration] tab.

Note
❒ If the NetBEUI protocol is not installed, click [Add] on the [Configuration] tab

to install it. For more information about installing the NetBEUI protocol,
see Windows 95/98/Me Help.

❒ If “NetBEUI →Dial-Up Adaptor” is listed in the [The following network com-
ponents are installed] box, select it and click [Remove] to remove the binding.

BBBB Click [OK] to close the [Network] dialog box.



Using SmartNetMonitor for Client
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Using SmartNetMonitor for Client 

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

❖❖❖❖  SmartNetMonitor for Client features
• Sends a print job directly to the network printers without using a print

server.
• Notifies when a printing error occurs.
• Prints documents using other printers in the printer group when the spec-

ified printer is busy (Recovery Printing).
• Notifies on print job (data sent) completion.
• Equally divides the number of copies to be printed among the selected

printers in the printer group (Parallel Printing).

Important
❒ The following must be the same for the specified printer and the print-

ers selected for Recovery Printing or Parallel Printing.
• Printer models (for Parallel Printing only)
• Installed options (e.g. Paper tray unit)
• Size and orientation of paper in each paper tray unit
• Total memory
• Installed fonts (including the downloaded fonts)

Note
❒ Failure to meet any of the conditions above may result in unexpected

print results.
15
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Installing SmartNetMonitor for Client 

Install SmartNetMonitor for Client from the CD-ROM labeled “Printer Drivers
and Utilities”. For more information about how to install, see the Printer Refer-
ence 1.
After the installation is complete, configure the printer port with SmartNetMon-
itor for Client. See p.17 “Setting Up the Printer Driver”.

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, and then delete it. For more information about SmartNetMonitor for
Client, see SmartNetMonitor for Client Help.

AAAA From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

BBBB Click the [Details] tab, and then make sure that the SmartNetMonitor for
Client port is shown in the [Print to the following port] box.
Remember the port name because this port should be deleted later.

CCCC From the [Print to the following port] box, select [FILE].

DDDD Click [Delete Port].

EEEE Click the SmartNetMonitor for Client port name as in step BBBB, and then click
[OK]. 
The port is deleted.

FFFF Click [OK] to close the printer properties.

Uninstalling SmartNetMonitor for Client 

Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:
• The SmartNetMonitor for Client settings dialog box is closed.
• No printer is using the SmartNetMonitor for Client port as a printer port.

AAAA Open [Control Panel], and then double-click the [Add/Remove Programs] icon.

BBBB On the [Install/Uninstall] tab, click [SmartNetMonitor for Client], and then click
[Add/Remove].

CCCC After the confirmation message appears, click [Yes].
UninstallShield removes all of the components of SmartNetMonitor for Cli-
ent.
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DDDD After the confirmation message, click [Yes].

EEEE Acknowledge the [Question] dialog box.

FFFF When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

Preparation
The target printer must be turned on before starting the installation process.

AAAA Install the printer driver for the printer you want to use.

BBBB From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

CCCC Click the [Details] tab and click [Add Port].

DDDD Click [Other], click [SmartNetMonitor] from the list, and then click [OK].

The [Add Port] dialog box appears.
The displayed items are as follows:
Model Name: The model name of the printer. 
Name: The name of the Network Interface Board.
Comment: Additional information about the Network Interface Board.
Address: The IP address of the printer.

EEEE Select the printer.

TCP/IP

A Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

❒ You cannot add an address partially similar to that already used. For ex-
ample, when “192.168.0.2” is already used, “192.168.0.2xx” cannot be
used. Similarly, when “192.168.0.20” is already used, “192.168.0.2” can-
not be used. 
17
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NetBEUI

A Click [NetBEUI].
A list of printers that can be printed to by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to a broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address], and
then type the NetBEUI address. Make sure that the NetBEUI address is
on the configuration page. For more information about the printing of
the configuration page, see “Printing a Configuration Page”, Printer Ref-
erence 2. The NetBEUI address appears as “\\RNPxxxx\xxx” on the
configuration page. Type the printer's network path name in the form
of “%%Computer name\Share name”. Do not type “\\” as head char-
acters but “%%”.

❒ You cannot print to printers beyond routers.

IPP

A Click [IPP].

The IPP setting dialog box appears.
B To specify the IP address of the printer, type “http://(printer's-ip-ad-

dress)/printer” or “ipp://(printer's-ip-address)/printer” in the [Printer
URL] field.

(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

ipp://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name different from any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.

D If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Note
❒ For more information about these settings, see SmartNetMonitor for

Client Help.

FFFF Click [OK].

GGGG Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port] box, and then click [OK].

This completes the settings.
To print, select the specified printer. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.
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Changing Port Settings

Follow these steps to change SmartNetMonitor for Client settings, such as Par-
allel Printing, Recovery Printing, TCP/IP, the proxy server and IPP URL.

Note
❒ There are no settings for the NetBEUI protocol.
❒ You can configure Timeout Settings for the TCP/IP protocol.

AAAA From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

BBBB Click the [Details] tab, and then click [Port Settings].

The [Port Settings] dialog box appears.
• For IPP, you can configure User Settings, Proxy Settings and Timeout Set-

tings.

Note
❒ For more information about these settings, see SmartNetMonitor for Client

Help.
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Setting Up a Client Computer

This section describes the procedures for setting up a client on a network that
uses Windows 2000/XP, Windows NT Server or Windows NT Workstation as a
print server.
When using a Windows 2000/XP or Windows NT print server, select a shared
printer on Windows 2000/XP or Windows NT.

Limitation
❒ When using a print server connected to the machine with SmartNetMonitor

for Client, you cannot use Recovery Printing and Parallel Printing.
❒ When using Windows XP as a print server, the client computer cannot receive

notification of print job completion.

Note
❒ This section assumes that the client has already been configured to communi-

cate with a Windows 2000/XP or Windows NT print server. Do not begin the
following procedure until the client has been set up and configured correctly.

AAAA Install the printer driver as a local printer.

Reference
For more information about installing the printer driver, see the Printer
Reference 1.

Note
❒ Any port can be selected during the installation, however, LPT1 is recom-

mended.

BBBB Click [Start], point to [Settings], and then click [Printers].

Windows 2000/XP or 
Windows NT Print Server

Windows 95/98/Me
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CCCC Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

DDDD Click the [Details] tab, and then click [Add Port].

EEEE Click [Network], and then click [Browse].

FFFF On the network tree, double-click the name of a computer used as the print
server.
The printers connected to the network are displayed.

GGGG Click the name of the printer you want to use, and then click [OK].

HHHH Click [OK].

IIII Make sure that the port name is displayed in the [Print to the following port]
box, and then click [OK].
21
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2. Windows 2000 Configuration
Configuring Windows 2000

Printing without a Print Server

The following procedure describes how to configure Windows 2000 to use the
machine on a network without a Windows 2000 Server, Windows 2000 Profes-
sional, Windows XP, Windows NT Server, Windows NT Workstation or Net-
Ware based print server.

AAAA Specify the protocol to use.

Consult your network administrator about which of the three protocols is ap-
propriate.
• TCP/IP
• IPP
• NetBEUI

BBBB Configure the chosen protocol.

• See p.25 “Configuring TCP/IP and IPP for Printing”.
• See p.26 “Configuring NetBEUI for Printing”.

CCCC Install the software and set the printer driver port.

• Install SmartNetMonitor for Client from the CD-ROM labeled “Printer
Drivers and Utilities”. For more information about how to install the soft-
ware and how to specify the printer driver port, see the Printer Reference 1.

Printing with a Standard TCP/IP Port

The Standard TCP/IP port is standard to Windows 2000, enabling Peer-to-Peer
printing in a network environment.
For more information about Standard TCP/IP port settings, see Windows 2000
Help.

Note
❒ If a device model selection dialog box appears during the procedure to add

the standard TCP/IP port, select “RICOH Network Printer C Model”.
23
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Printing with a LPR Port

See p.32 “Configuring LPR Port Printing” for configuring a LPR port in Win-
dows 2000.

Printing with a Windows 2000/XP or Windows NT Print Server

See p.33 “Setting Up a Client Computer” for configuring Windows 2000 with a
Windows 2000/XP or Windows NT print server.
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Configuring Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows 2000 to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
• Make sure that the TCP/IP protocol is set to active. (The default is active.)
• Assign an IP address and make other settings required for using the TCP/IP

protocol.

Reference
For more information about how to make the above settings, see the General
Settings Guide.
If DHCP is used to assign IP addresses, see p.134 “Using DHCP”.
To use the IP over 1394, see the General Settings Guide.

Note
❒ After setting the IP address, use the ping command to make sure that it has

been set correctly.
A Click [Start], point to [Programs], point to [Accessories], and then click [Com-

mand Prompt].
B Type the following: (Example IP address is 192.168.15.16)

C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.

Configuring a Windows 2000 computer

These steps are for configuring a Windows 2000 computer to use the TCP/IP
protocol.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

BBBB Double-click [Local Area Connection]. On the [General] tab, click [Properties].
25
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CCCC Make sure that the “Internet Protocol (TCP/IP)” is selected in the [Compo-
nents checked are used by this connection] box on the [General] tab.

Note
❒ Select the TCP/IP protocol if it is not already selected.
❒ If the TCP/IP protocol is not installed, click [Install] on the [General] tab to

install it. For more information about installing the TCP/IP protocol, see
Windows 2000 Help.

DDDD Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.
Check with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 2000 to use the NetBEUI protocol.

Preparation
To use NetBEUI, use the SmartNetMonitor for Client port.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
• Make sure that the NetBEUI protocol is set to active. (The default is active.)

Reference
For more information about how to make the above settings, see the General
Settings Guide.

Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the NetBEUI
protocol.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

BBBB Double-click [Local Area Connection]. On the [General] tab, click [Properties].

CCCC Make sure that the“NetBEUI Protocol” is selected in the [Components
checked are used by this connection] box on the [General] tab.

Note
❒ Select the NetBEUI protocol if it is not already selected.
❒ If the NetBEUI protocol is not installed, click [Install] on the [General] tab

and install it. For more information about installing the NetBEUI protocol,
see Windows 2000 Help.
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Using SmartNetMonitor for Client 

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

❖❖❖❖  SmartNetMonitor for Client features
• Sends a print job directly to the network printers without using a print

server.
• Notifies when a printing error occurs.
• Prints documents using other printers in the printer group when the spec-

ified printer is busy (Recovery Printing).
• Notifies on print job (data sent) completion.
• Equally divides the number of copies to be printed among the selected

printers in the printer group (Parallel Printing).

Important
❒ The following must be the same for the specified printer and the print-

ers selected for Recovery Printing or Parallel Printing.
• Printer models (for Parallel Printing only)
• Installed options (e.g. Paper tray unit)
• Size and orientation of paper in each paper tray unit
• Total memory
• Installed fonts (including the downloaded fonts)

Limitation
❒ When using a computer as a print server, do not use the notification of

print completion function. For more information about how to set this
function to off, see SmartNetMonitor for Client Help.

Note
❒ Failure to meet any of the conditions above may result in unexpected

print results.
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Installing SmartNetMonitor for Client 

Install SmartNetMonitor for Client from the CD-ROM labeled “Printer Drivers
and Utilities”. For more information about how to install, see the Printer Refer-
ence 1.
After the installation is complete, configure the printer port with SmartNetMon-
itor for Client. See p.29 “Setting Up the Printer Driver”.

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, and then delete it. For more information about SmartNetMonitor for
Client, see SmartNetMonitor for Client Help.

AAAA From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

BBBB Click the [Ports] tab, and then make sure that the SmartNetMonitor for Cli-
ent port is shown in the [Print to the following port(s)] box.
Remember the port name because this port should be deleted later.

CCCC Select the [FILE] check box in the [Port] column.

DDDD Click [OK] to close the Printer Properties.
The port which is currently in use is changed.

EEEE Open the Printer Properties of the same printer.

FFFF Select the [Ports] tab.

GGGG At the [Port] column in the [Print to the following port(s)] box, click the Smart-
NetMonitor for Client port name as in step BBBB. 

HHHH Click [Delete Port].

IIII After the confirmation message appears, click [Yes].

The port is deleted.

JJJJ Click [Close] to close the Printer Properties.
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Uninstalling SmartNetMonitor for Client 

Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:
• The port settings dialog box is closed.
• No printer is using the SmartNetMonitor for Client port as a printer port.
• You logged in with the same user authority as that used to install Smart-

NetMonitor for Client.

AAAA Open [Control Panel], and then double-click the [Add/Remove Programs] icon.

BBBB Click the [Change or Remove Programs] tab, click [SmartNetMonitor for Client],
and then click [Change/Remove].

CCCC After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartNetMonitor for Client.

DDDD After the confirmation message appears, click [Yes].

EEEE Acknowledge the [Remove Shared File?] dialog box.

FFFF When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

Preparation
The target printer must be turned on before starting the installation process.

AAAA Install the printer driver for the printer you want to use.

BBBB From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

CCCC Click the [Ports] tab and click [Add Port].

DDDD Click [SmartNetMonitor for Client] in the [Available port types] box, and then click
[New Port].

The [Select Printer] dialog box appears and printers on the network are
browsed. 
The displayed items are as follows: 
Model Name: The model name of the printer.
Name: The name of the Network Interface Board.
Comment: Additional information about the Network Interface Board.
Address: The IP address of the printer.
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EEEE Select the printer.

TCP/IP

A Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

NetBEUI

A Click [NetBEUI].
A list of printers that can be printed by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to a broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address], and
then type the NetBEUI address. Make sure that the NetBEUI address is
on the configuration page. For more information about the printing of
the configuration page, see “Printing a Configuration Page”, Printer Ref-
erence 2. The NetBEUI address appears as “\\RNPxxxx\xxx” on the
configuration page. Type the printer's network path name in the form
of “%%Computer name\Share name”. Do not type “\\” as head char-
acters but “%%”.

❒ You cannot print to printers beyond routers.

IPP

A Click [IPP].
The IPP setting dialog box appears.

B To specify the IP address of the printer, type “http://(printer's-ip-ad-
dress)/printer” or “ipp://(printer's-ip-address)/printer” in the [Printer
URL] field.
(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

ipp://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name different from any existing port names.
If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.



Using SmartNetMonitor for Client

2

D If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Note
❒ For more information about these settings, see SmartNetMonitor for

Client Help.

FFFF Click [OK].

GGGG Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port(s)] box, and then click [Close].

This completes the settings.
To print, select the specified printer. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.

Changing Port Settings

Follow these steps to change SmartNetMonitor for Client settings, such as Par-
allel Printing, Recovery Printing, TCP/IP, the proxy server and IPP URL.

Note
❒ There are no settings for the NetBEUI protocol.

AAAA From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

BBBB Click the [Ports] tab, and then click [Configure Port].

The [Port Settings] dialog box appears.
• For TCP/IP protocol, you can configure Parallel Printing, Recovery Print-

ing and Timeout Settings.
• For IPP, you can configure User Settings, Proxy Settings and Timeout Set-

tings.

Note
❒ For more information about these settings, see SmartNetMonitor for Client

Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
2000.

Note
❒ The TCP/IP protocols must be installed and configured correctly. For more

information about configuring the protocols, see p.25 “Configuring TCP/IP
and IPP for Printing”.

AAAA Click [Start], point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

CCCC Click the [Ports] tab and click [Add Port].

DDDD In the [Available port types] box, click “LPR Port”, and then click [New Port].

Note
❒ If “LPR Port” does not appear, “Print Services for Unix” has not been in-

stalled. For more information about how to install “Print Services for Un-
ix”, see Windows 2000 Help.

EEEE Type the IP address of the Network Interface Board into the [Name or address
of server providing lpd] box.

FFFF Type “lp” into the [Name of printer or print queue on that server box], and then
click [OK].

GGGG Click [Close].

HHHH Make sure that the port name is displayed in the [Print to the following port(s)]
box and the check box is selected, and then click [OK].
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Setting Up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000/XP, Windows NT Server or Windows NT Workstation as a
print server.
When using a Windows 2000/XP or Windows NT print server, select a shared
printer on Windows 2000/XP or Windows NT.

Limitation
❒ When using a print server connected to the machine with SmartNetMonitor

for Client, you cannot use Recovery Printing and Parallel Printing.

Note
❒ This section assumes that the client has already been configured to communi-

cate with a Windows 2000/XP or Windows NT print server. Do not begin the
following procedure until the client has been set up and configured correctly.

❒ When using Windows NT 4.0 as the print server, make sure to install the Win-
dows NT 4.0 printer driver before connecting the print server. There is a Win-
dows NT 4.0 printer driver on the CD-ROM labeled “Printer Drivers and
Utilities”.

Use the [Printers] window to set up the printer.

AAAA Click [Start], point to [Settings], and then click [Printers].

BBBB Double-click the [Add Printer] icon.

This launches the Add Printer Wizard.

CCCC Click [Next >].

DDDD Click [Network printer], and then click [Next >].

Windows 2000

Windows 2000/XP or 
Windows NT Print Server
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EEEE Click [Next >].

FFFF In the [Shared printers] box, double-click the name of the computer used as
the print server.

The printers attached to the network are displayed.

GGGG Click the printer you want to use, and then click [Next >].

HHHH Select if you want to use this printer as the default printer, and then click
[Next >].

IIII After the installation is complete, click [Finish].

The icon of the newly installed printer appears in the [Printers] window.



3. Windows XP Configuration
Configuring Windows XP

Printing without a Print Server

The following procedure describes how to configure Windows XP to use the ma-
chine on a network without a Windows 2000 Server, Windows 2000 Profession-
al, Windows XP Server, Windows NT Server, Windows NT Workstation or
NetWare based print server.

AAAA Specify the protocol to use.

Consult your network administrator about which of the two protocols is ap-
propriate.
• TCP/IP
• IPP

BBBB Configure the protocol.

• See p.37 “Configuring TCP/IP and IPP for Printing”.

CCCC Install the software and set the printer driver port.
• Install SmartNetMonitor for Client from the CD-ROM labeled “Printer

Drivers and Utilities”. For more information about how to install the soft-
ware and how to specify the printer driver port, see the Printer Reference 1.

Printing with a Standard TCP/IP Port

The Standard TCP/IP port is standard to Windows XP, enabling Peer-to-Peer
printing in a network environment.
For more information about Standard TCP/IP port settings, see Windows XP
Help.

Note
❒ If a device model selection dialog box appears during the procedure to add

the standard TCP/IP port, select “RICOH Network Printer C Model”.
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Printing with a LPR Port

See p.44 “Configuring LPR Port Printing” for configuring a LPR port in Win-
dows XP.

Printing with a Windows 2000/XP or Windows NT Print Server

See p.45 “Setting Up a Client Computer” for configuring Windows XP with a
Windows 2000/XP or Windows NT print server.
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Configuring Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows XP to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
• Make sure that the TCP/IP protocol is set to active. (The default is active.)
• Assign an IP address and make other settings required for using the TCP/IP

protocol.

Reference
For more information about how to make the above settings, see the General
Settings Guide.
If DHCP is used to assign IP addresses, see p.134 “Using DHCP”.
To use the IP over 1394, see the General Settings Guide.

Note
❒ After setting the IP address, use the ping command to make sure that it has

been set correctly.
A Click [Start], point to [All Programs], point to [Accessories], and then click

[Command Prompt].
B Type the following: (Example IP address is 192.168.15.16)

C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.
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Configuring a Windows XP computer

These steps are for configuring a Windows XP computer to use the TCP/IP pro-
tocol.

AAAA Click [Start] on the taskbar, click [Control Panel], and then click [Network and
Internet Connections].

BBBB Click [Network Connections], and then double-click [Local Area Connection]. 

CCCC On the [General] tab, click [Properties].

Note
❒ With the IP over 1394, click [1394 Connection].

DDDD Make sure that the “Internet Protocol (TCP/IP)” is selected in the [This con-
nection uses the following items] box on the [General] tab.

Note
❒ Select the TCP/IP protocol if it is not already selected.
❒ If the TCP/IP protocol is not installed, click [Install] on the [General] tab to

install it. For more information about installing the TCP/IP protocol, see
Windows XP Help.

EEEE Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.
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Using SmartNetMonitor for Client 

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

❖❖❖❖  SmartNetMonitor for Client features
• Sends a print job directly to the network printers without using a print

server.
• Notifies when a printing error occurs.
• Prints documents using other printers in the printer group when the spec-

ified printer is busy (Recovery Printing).
• Notifies on print job (data sent) completion.
• Equally divides the number of copies to be printed among the selected

printers in the printer group (Parallel Printing).

Important
❒ The following must be the same for the specified printer and the print-

ers selected for Recovery Printing or Parallel Printing.
• Printer models (for Parallel Printing only)
• Installed options (e.g. Paper tray unit)
• Size and orientation of paper in each paper tray unit
• Total memory
• Installed fonts (including the downloaded fonts)

Limitation
❒ When using a computer as a print server, do not use the notification of

print completion function. For more information about how to set this
function to off, see SmartNetMonitor for Client Help.

Note
❒ Failure to meet any of the conditions above may result in unexpected

print results.
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Installing SmartNetMonitor for Client 

Install SmartNetMonitor for Client from the CD-ROM labeled “Printer Drivers
and Utilities”. For more information about how to install, see the Printer Refer-
ence 1.
After the installation is complete, configure the printer port with SmartNetMon-
itor for Client. See p.41 “Setting Up the Printer Driver”.

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, and then delete it. For more information about SmartNetMonitor for
Client, see SmartNetMonitor for Client Help.

AAAA From the [Printers and Faxes] window, click the icon of the printer which uses
SmartNetMonitor for Client to print. On the [File] menu, click [Properties].

BBBB Click the [Ports] tab, and then make sure that the SmartNetMonitor for Cli-
ent port is shown in the [Print to the following port(s)] box.
Remember the port name because this port should be deleted later.

CCCC Select the [FILE] check box in the [Port] column.

DDDD Click [OK] to close the Printer Properties.
The port which is currently in use is changed.

EEEE Open the Printer Properties of the same printer.

FFFF Select the [Ports] tab.

GGGG At the [Port] column in the [Print to the following port(s)] box, click the Smart-
NetMonitor for Client port name as in step BBBB. 

HHHH Click [Delete Port].

IIII After the confirmation message appears, click [Yes].

The port is deleted.

JJJJ Click [Close] to close the Printer Properties.
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Uninstalling SmartNetMonitor for Client 

Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:
• The port settings dialog box is closed.
• No printer is using the SmartNetMonitor for Client port as a printer port.
• You logged in with the same user authority as that used to install Smart-

NetMonitor for Client.

AAAA Open [Control Panel], and then double-click the [Add or Remove Programs]
icon.

BBBB Click the [Change or Remove Programs] category, click [SmartNetMonitor for Cli-
ent], and then click [Change/Remove].

CCCC After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartNetMonitor for Client.

DDDD After the confirmation message appears, click [Yes].

EEEE Acknowledge the [Remove Shared File?] dialog box.

FFFF When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

Preparation
The target printer must be turned on before starting the installation process.

AAAA Install the printer driver for the printer you want to use.

BBBB From the [Printers and Faxes] window, click the icon of the printer. On the
[File] menu, click [Properties].

CCCC Click the [Ports] tab and click [Add Port].

DDDD Click [SmartNetMonitor for Client] in the [Available port types] box, and then click
[New Port].
The [Select Printer] dialog box appears and printers on the network are
browsed. 
The displayed items are as follows: 
Model Name: The model name of the printer.
Name: The name of the Network Interface Board.
Comment: Additional information about the Network Interface Board.
Address: The IP address of the printer.



Windows XP Configuration

42

3

EEEE Select the printer.

TCP/IP

A Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

IPP

A Click [IPP].
The IPP setting dialog box appears.

B To specify the IP address of the printer, type “http://(printer's-ip-ad-
dress)/printer” or “ipp://(printer's-ip-address)/printer” in the [Printer
URL] field.
(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

ipp://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name different from any existing port names.
If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.

D If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Note
❒ For more information about these settings, see SmartNetMonitor for

Client Help.

FFFF Click [OK].

GGGG Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port(s)] box, and then click [Close].
This completes the settings.
To print, select the specified printer. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.
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Changing Port Settings

Follow these steps to change SmartNetMonitor for Client settings, such as Par-
allel Printing, Recovery Printing, TCP/IP, the proxy server and IPP URL.

Note
❒ There are no settings for the NetBEUI protocol.

AAAA Access the [Printers and Faxes] window from [Start] on the taskbar.

Windows XP Professional

A Click [Start], and then click [Printers and Faxes].

Windows XP Home Edition

A Click [Start], and then click [Control Panel].

B Click [Printers and Other Hardware].

C Click [Printers and Faxes].

BBBB Click the icon of the printer. On the [file] menu, click [Properties].

CCCC Click the [Ports] tab, and then click [Configure Port].

The [Port Settings] dialog box appears.
• For TCP/IP protocol, you can configure Parallel Printing, Recovery Print-

ing and Timeout Settings.
• For IPP, you can configure User Settings, Proxy Settings and Timeout Set-

tings.

Note
❒ For more information about these settings, see SmartNetMonitor for Client

Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
XP.

Note
❒ The TCP/IP protocols must be installed and configured correctly. For more

information about configuring the protocols, see p.37 “Configuring TCP/IP
and IPP for Printing”.

AAAA Access the [Printers and Faxes] window from [Start] on the taskbar.

Windows XP Professional

A Click [Start], and then click [Printers and Faxes].

Windows XP Home Edition

A Click [Start], and then click [Control Panel].

B Click [Printers and Other Hardware].
C Click [Printers and Faxes].

BBBB Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

CCCC Click the [Ports] tab and click [Add Port].

DDDD In the [Available port types] box, click “LPR Port”, and then click [New Port].

Note
❒ If “LPR Port” does not appear, “Print Services for Unix” has not been in-

stalled. For more information about how to install “Print Services for Un-
ix”, see Windows XP Help.

EEEE Type the IP address of the Network Interface Board into the [Name or address
of server providing lpd] box.

FFFF Type “lp” into the [Name of printer or print queue on that server] box, and then
click [OK].

GGGG Click [Close].

HHHH Make sure that the port name is displayed in the [Print to the following port(s)]
box and the check box is selected, click [Apply] and then click [OK].
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Setting Up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000/XP, Windows NT Server or Windows NT Workstation as a
print server.
When using a Windows 2000/XP or Windows NT print server, select a shared
printer on Windows 2000/XP or Windows NT.

Limitation
❒ When using a print server connected to the machine with SmartNetMonitor

for Client, you cannot use Recovery Printing and Parallel Printing.

Note
❒ This section assumes that the client has already been configured to communi-

cate with a Windows 2000/XP or Windows NT print server. Do not begin the
following procedure until the client has been set up and configured correctly.

❒ When using Windows NT 4.0 as the print server, make sure to install the Win-
dows NT 4.0 printer driver before connecting the print server. There is a Win-
dows NT 4.0 printer driver on the CD-ROM labeled “Printer Drivers and
Utilities”.

Use the [Printers and faxes] window to set up the printer.

Windows XP

Windows 2000/XP or 
Windows NT Print Server
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AAAA Access the [Printers and Faxes] window from [Start] on the taskbar.

Windows XP Professional

A Click [Start], and then click [Printers and Faxes].

Windows XP Home Edition

A Click [Start], and then click [Control Panel].

B Click [Printers and Other Hardware].
C Click [Printers and Faxes].

BBBB Click [Add a printer] in the Printer Tasks category.

This launches the Add Printer Wizard.

CCCC Click [Next >].

DDDD Click [A network printer, or a printer attached to another computer], and then click
[Next >].

EEEE Click [Next >].

FFFF In the [Shared printers:] box, double-click the name of the computer used as
the print server.

The printers attached to the network are displayed.

GGGG Click the printer you want to use, and then click [Next >].

HHHH Select if you want to use this printer as the default printer, and then click
[Next >].

IIII After the installation is complete, click [Finish].

The icon of the newly installed printer appears in the [Printers] window.



4. Windows NT 4.0 Configuration
Configuring Windows NT 4.0

Note
❒ Windows NT 4.0 does not support IP over 1394.

Printing without a Print Server

The following procedure describes how to configure Windows NT 4.0 to use the
machine on a network without a Windows 2000 Server, Windows 2000 Profes-
sional, Windows XP Server, Windows NT Server, Windows NT Workstation or
NetWare based print server.

AAAA Specify the protocol to use.

Consult your network administrator about which of the three protocols is ap-
propriate.
• TCP/IP
• IPP
• NetBEUI

BBBB Configure the chosen protocol.

• See p.48 “Configuring TCP/IP and IPP for Printing”.
• See p.49 “Configuring NetBEUI for Printing”.

CCCC Install the software and set the printer driver port.

• Install SmartNetMonitor for Client from the CD-ROM labeled “Printer
Drivers and Utilities”. For more information about how to install the soft-
ware and how to specify the printer driver port, see the Printer Reference 1.

Printing with a LPR Port

See p.56 “Configuring LPR Port Printing” for how to configure a LPR port in
Windows NT 4.0.

Printing with a Windows 2000/XP or Windows NT Print Server

See p.57 “Setting Up a Client Computer” for configuring Windows NT 4.0 with
a Windows 2000/XP or Windows NT print server.
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Configuring Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows NT to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
• Make sure that the TCP/IP protocol is set to active. (The default is active.)
• Assign an IP address and make other settings required for using the TCP/IP

protocol.

Reference
For more information about how to make the above settings, see the General
Settings Guide.
If DHCP is used to assign IP addresses, see p.134 “Using DHCP”.

Note
❒ After setting the IP address, use the ping command to make sure that it has

been correctly set.
A Click [Start], point to [Programs], and then click [Command Prompt].
B Type the following: (Example IP address is 192.168.15.16)

C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.
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Configuring a Windows NT computer

These steps are for configuring a Windows NT computer to use the TCP/IP pro-
tocol.

AAAA Open [Control Panel], and then double-click the [Network] icon. Make sure
that “TCP/IP Protocol” is listed in the [Network protocols] box on the [Proto-
cols] tab.

Note
❒ If the TCP/IP protocol is not installed, click [Add] on the [Protocols] tab to

install it. For more information about installing the TCP/IP protocol, see
Windows NT Help.

BBBB Configure the TCP/IP protocols with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows NT to use the NetBEUI protocol.

Preparation
To use NetBEUI, use the SmartNetMonitor for Client port.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
• Make sure that the NetBEUI protocol is set to active. (The default is active.)

Reference
For more information about how to make the above settings, see the General
Settings Guide.
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Configuring a Windows NT computer

Install the NetBEUI protocol on the Windows NT computer, and then change the
LAN adapter number (Lana Number).

AAAA Open [Control Panel], and then double-click the [Network] icon. Make sure
that “NetBEUI Protocol” is listed in the [Network Protocols] box on the [Proto-
cols] tab.

Note
❒ If the NetBEUI protocol is not installed, click [Add] on the [Protocols] tab to

install it. For more information about installing the NetBEUI protocol, see
Windows NT Help.

BBBB Change the Lana Number. Click the [Services] tab, click “NetBIOS Inter-
face” in the [Services] tab, and then click [Properties].

CCCC Click the Lana Number corresponding the Nbf protocol of the [Network
Route] headline, and then click [Edit].

DDDD Type “0” as the Lana Number.

Note
❒ If the other protocol's Lana Number is configured with “0”, you must

change the Lana Number a number other than “0”.

EEEE Click [OK].

FFFF Click [Close], and then close the [Network] dialog box.

GGGG After checking the message to restart, click [Yes].

Note
❒ After you change the Lana Number, you must restart the computer.
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Using SmartNetMonitor for Client 

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

❖❖❖❖  SmartNetMonitor for Client features
• Sends a print job directly to the network printers without using a print

server.
• Notifies when a printing error occurs.
• Prints documents using other printers in the printer group when the spec-

ified printer is busy (Recovery Printing).
• Notifies on print job (data sent) completion.
• Equally divides the number of copies to be printed among the selected

printers in the printer group (Parallel Printing).

Important
❒ The following must be the same for the specified printer and the print-

ers selected for Recovery Printing or Parallel Printing.
• Printer models (for Parallel Printing only)
• Installed options (e.g. Paper tray unit)
• Size and orientation of paper in each paper tray unit
• Total memory
• Installed fonts (including the downloaded fonts)

Limitation
❒ When using a computer as a print server, do not use the notification of

print completion function. For more information about how to set this
function to off, see SmartNetMonitor for Client Help.

❒ On a computer that is used as a print server, do not use the features such
as Parallel Printing, Recovery Printing and Notify. For more informa-
tion about turning off these features, see SmartNetMonitor for Client
Help.

Note
❒ Failure to meet any of the conditions above may result in unexpected

print results.
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Installing SmartNetMonitor for Client 

Install SmartNetMonitor for Client from the CD-ROM labeled “Printer Drivers
and Utilities”. For more information about how to install, see the Printer Refer-
ence 1.
After the installation is complete, configure the printer port with SmartNetMon-
itor for Client. See p.53 “Setting Up the Printer Driver”.

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, and then delete it. For more information about SmartNetMonitor for
Client, see SmartNetMonitor for Client Help.

AAAA From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

BBBB Click the [Ports] tab, and then make sure that the SmartNetMonitor for Cli-
ent port is shown in the [Print to the following port] box.
Remember the port name because this port should be deleted later.

CCCC From the [Print to the following port] box, select [FILE].

DDDD Click [Apply].
The port which is currently in use is changed.

EEEE Click [Delete Port].

FFFF After the confirmation message appears, click [Yes].
The port is deleted.

GGGG Click [OK] to close the printer properties.
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Uninstalling SmartNetMonitor for Client 

Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:
• The port settings dialog box is closed.
• No printer is using the SmartNetMonitor for Client port as a printer port.
• You have performed login with the same user authority as that used to in-

stall SmartNetMonitor for Client.

AAAA Open [Control Panel], and then double-click the [Add/Remove Programs] icon.

BBBB On the [Install/Uninstall] tab, click [SmartNetMonitor for Client], and then click
[Add/Remove].

CCCC After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartNetMonitor for Cli-
ent.

DDDD After a confirmation message appears, click [Yes].

EEEE Acknowledge the [Remove Shared File?] dialog box.

FFFF When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

Preparation
The target printer must be turned on before starting the installation process.

AAAA Install the printer driver for the printer you want to use.

BBBB From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

CCCC Click the [Ports] tab and click [Add Port].

DDDD Click [SmartNetMonitor] from the list, and then click [New Port].

The [Select Printer] dialog box appears .
The displayed items are as follows:
Model Name: The model name of the printer. 
Name: The name of the Network Interface Board.
Comment: Additional information about the Network Interface Board.
Address: The IP address of the printer.
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EEEE Select the printer.

TCP/IP

A Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

NetBEUI

A Click [NetBEUI].
A list of printers that can be printed by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to a broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address], and
then type the NetBEUI address. Make sure that the NetBEUI address is
on the configuration page. For more information about the printing of
the configuration page, see “Printing a Configuration Page”, Printer Ref-
erence 2. The NetBEUI address appears as “\\RNPxxxx\xxx” on the
configuration page. Type the printer's network path name in the form
of “%%Computer name\Share name”. Do not type “\\” as head char-
acters but “%%”.

❒ You cannot print to printers beyond routers.

IPP

A Click [IPP].
The IPP setting dialog box appears.

B To specify the IP address of the printer, type “http://(printer's-ip-ad-
dress)/printer” or “ipp://(printer's-ip-address)/printer” in the [Printer
URL] field.
(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

ipp://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name different from any existing port names.
If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.
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D If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Note
❒ For more information about these settings, see SmartNetMonitor for

Client Help.

FFFF Click [OK].

GGGG Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port] box, and then click [OK].

This completes the settings.
To print, select the specified printer. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.

Changing Port Settings

Follow these steps to change SmartNetMonitor for Client settings, such as Par-
allel Printing, Recovery Printing, TCP/IP, the proxy server and IPP URL.

Note
❒ There are no settings for the NetBEUI protocol.

AAAA From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

BBBB Click the [Ports] tab, and then click [Port Configuration].

The [Port Settings] dialog box appears.
• For TCP/IP protocol, you can configure Parallel Printing, Recovery Print-

ing and Timeout Settings.
• For IPP, you can configure User Settings, Proxy Settings and Timeout Set-

tings.

Note
❒ For more information about these settings, see SmartNetMonitor for Client

Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
NT.

Note
❒ The following procedure assumes that the printer drivers have already been

installed. This is the procedure to change the printer port to LPR.
❒ TCP/IP protocols must be installed and configured correctly. After setting

(p.48 “Configuring TCP/IP and IPP for Printing”), follow the procedure be-
low.

AAAA Click the [Services] tab, and then make sure that “Microsoft TCP/IP Print-
ing” is installed.

If “Microsoft TCP/IP Printing” is not installed, click [Add] on the [Services]
tab, to install it. For more information about installing and configuring net-
work services, see Windows NT Help.

BBBB Click [Start], point to [Settings], and then click [Printers].

CCCC Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

DDDD Click the [Ports] tab and click [Add Port].

EEEE In the [Available Printer Ports] box, click “LPR Port”, and then click [New Port].

Note
❒ If “LPR Port” does not appear, “Microsoft TCP/IP Printing” has not been

installed.

FFFF Type the IP address of the Network Interface Board into the [Name or address
of server providing lpd] box.

GGGG Type “lp” into the [Name of printer or print queue on that server] box, and then
click [OK].

HHHH Click [Close].

IIII Make sure that the port name is displayed in the [Print to the following port(s)]
box and the check box is selected, and then click [OK].
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Setting Up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000/XP, Windows NT Server or Windows NT Workstation as a
print server.
When using a Windows 2000/XP or Windows NT print server, select a shared
printer on Windows 2000/XP or Windows NT.

Limitation
❒ When using a print server connected to the machine with SmartNetMonitor

for Client, you cannot use Recovery Printing and Parallel Printing.
❒ When using Windows XP as a print server, the client computer cannot receive

notification of print job completion.

Note
❒ This section assumes that the client has already been configured to communi-

cate with a Windows 2000/XP or Windows NT print server. Do not begin the
following procedure until the client has been set up and configured correctly.

Use the [Printers] window to set up the printer.

AAAA Click [Start], point to [Settings], and then click [Printers].

BBBB Double-click the [Add Printer] icon.

This launches the Add Printer Wizard.

CCCC Click [Network printer server] and click [Next >].

DDDD In the [Shared Printers] box, double-click the name of the computer used as
the print server.

The printers attached to the network are displayed.

Windows NT 4.0

Windows 2000/XP or 
Windows NT Print Server
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EEEE Click the printer you want to use, and then click [OK].

FFFF Select if you want to use this printer as the default printer, and then click
[Next >].

GGGG After the installation is complete, click [Finish].
The icon of the newly installed printer appears in the [Printers] window.



5. NetWare Configuration
This chapter describes how to configure the machine to use as a print server or
a remote printer in a NetWare environment.

Note
❒ NetWare must be set to active using the machine's control panel. For more in-

formation about how to set it, see the General Settings Guide.

Installing the NIB Setup Tool 

A utility called the NIB Setup Tool is provided to configure the machine to work
in a network environment. This section describes how to install the SmartNet-
Monitor for Admin, and how to run the NIB Setup Tool.

Limitation
❒ The NIB Setup Tool is supported to work with the following operating sys-

tems.
• Microsoft Windows 95/98/Me
• Microsoft Windows 2000/XP
• Microsoft Windows NT 4.0

❖❖❖❖ SmartNetMonitor for Admin
Using a printer in a NetWare environment, configure the NetWare printing
environment by using SmartNetMonitor for Admin.

Note
❒ If you configure the NetWare printing environment by using SmartNet-

Monitor for Admin under the following environments, NetWare Client
provided by Novell is required.
• NDS mode in Windows 95/98/Me
• NDS or Bindery mode in Windows 2000/Windows NT 4.0
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Installing SmartNetMonitor for Admin 

Install SmartNetMonitor for Admin on your computer. For the installation pro-
cedure, see “Installing the SmartNetMonitor for Client/Admin”, Printer Refer-
ence 1.
After installing SmartNetMonitor for Admin, see one of the following sections:
• To configure the Network Interface Board as a NetWare print server for the

first time, see p.61 “Quick Setup Using the NIB Setup Tool Wizard”.
• To use this computer with NetWare 3.x, 4.x, 5/5.1 as a print server, see p.64

“NetWare 3.x, 4.x, 5/5.1- Advanced Settings”.
• To use this computer with NetWare 3.x, 4.x, 5/5.1 as a remote printer, see p.64

“NetWare 3.x, 4.x, 5/5.1- Advanced Settings”.

Running the NIB Setup Tool 

AAAA Click [Start], point to [Programs], and then click [NIB Setup Tool] in the [Smart-
NetMonitor for Admin] program folder.
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Quick Setup Using the NIB Setup Tool 
Wizard

With the NIB Setup Tool, you can easily set up a NetWare printing environment. 

Reference
For more information about installing the NIB Setup Tool, see p.59 “Installing
the NIB Setup Tool”.

You can select [Wizard] or [Property Sheet] as an installation method.
When you configure the Network Interface Board for the first time, use the Wiz-
ard method.
If you want to use the Property Sheet method, see p.64 “NetWare 3.x, 4.x, 5/5.1-
Advanced Settings”.

Note
❒ This section assumes that NetWare is functional and that the necessary envi-

ronment for NetWare Print Services is available.
❒ If you configure the Network Interface Board in a NetWare environment us-

ing the NIB Setup Tool, you should install the client software released from
Novell in the following cases.
• Windows 95/98/Me in NDS mode configuration
• Windows NT 4.0 in NDS mode configuration
• Windows NT 4.0 in Bindery mode configuration
• Windows 2000 in NDS mode configuration
• Windows 2000 in Bindery mode configuration

AAAA Log on to the Netware file server or the NDS tree as an administrator or ad-
ministrator equivalent.

BBBB Run the NIB Setup Tool.

Reference
See p.60 “Running the NIB Setup Tool” .

CCCC Click [Wizard] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

DDDD Click [IPX protocol].
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EEEE Click the IPX address of the Network Interface Board you are configuring,
and then click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

print a network configuration page to check the MAC address (Network
address).

FFFF Make sure that the MAC address and IPX address are correct, and then click
[Finish].

GGGG Type the print server name into the [Device Name] box, and then click [Next >].
The default setting is “RDP_” followed by the 6-digit serial number. We rec-
ommend that you change it to something that is easier to remember or some-
thing based on the structure of the network.

HHHH In a dialog box for selecting a network environment, click the [NetWare]
check box and click to clear the [TCP/IP] check box.

IIII Click [Next >].
A dialog box for configuring the NetWare environment appears.

JJJJ Select [Bindery] when printing under Bindery mode, or select [NDS] when
printing under NDS mode.

When you are using NetWare version 4.x, you should select [NDS].

KKKK If you selected [Bindery], type into the [File Server Name:] box the name of the
file server in which a print server is to be created.

After clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

LLLL If you selected [NDS], type into the [Tree:] box the name of the NDS tree in
which the print server is created, and then type the context into the [Con-
text:] box.
Clicking [Browse], you can select an NDS tree and an NDS context among
those listed in the [Browse] dialog boxes.
As a context, object names are typed from a lower object and divided by a pe-
riod. For example, if you want to create a print server into NET under DS,
type “NET.DS”.

MMMM Click [Next >].



Quick Setup Using the NIB Setup Tool Wizard

5

NNNN Type the name of the printer into the [Printer Name] box, and the name of the
print queue into the [Print Queue Name] box.

The default setting for Printer Name is “Print Server Name” followed by “_1”
and for Print Queue Name is “Print Server Name” followed by “_Q” (quota-
tion marks are not included). You can change them if necessary.

OOOO If you have selected the NDS mode, type the volume of the print queue into
the [Queue Volume] box. 
Clicking [Browse], you can select one of those shown in the [Browse] dialog
box.

PPPP Click [Next >].

A dialog box to acknowledge the printing environment appears.

QQQQ After checking the environment, click [Next >].
If you want to change the settings, click [< Back], and then make the settings
again.
Clicking [Next >], the NIB Setup Tool automatically creates the Print Server,
the Printer, and the Print Queue in the NetWare network.

RRRR After the confirmation dialog box appears, select [Quit] and click [Finish] to
exit the NIB Setup Tool.
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NetWare 3.x, 4.x, 5/5.1- Advanced 
Settings

The actual procedures for configuring the machine vary depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure the machine in the NetWare 3.x, 4.x,
5/5.1 environment.

Preparation
The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a
NetWare print server for the first time, we recommend you use the Wizard
method. See p.61 “Quick Setup Using the NIB Setup Tool Wizard” .

Install the NIB Setup Tool

Print Server Remote Printer

NetWare 3.x Basic Procedure

Configure the Network Interface Board

Configure the NetWare

Start the print server

Restart the printer

Install the NIB Setup Tool

Print Server Remote Printer

NetWare 4.x, 5/5.1 Basic Procedure

Configure the Network Interface Board

Configure the NetWare

Start the print serverRestart the printer
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Note
❒ This section assumes NetWare is functional and that the necessary environ-

ment for the NetWare Print Service is available.
❒ When using NetWare 4.x, 5/5.1, you should install the client software re-

leased from Novell in Windows, before running the NIB Setup Tool for con-
figuring in NDS mode or using Windows NT 4.0.

❖❖❖❖ To use NetWare 5/5.1
• Use the printer as a print server. Do not use as a remote printer.
• If you use Pure IP, configure the machine to use the TCP/IP protocol. For more

information about how to make the settings, see the General Settings Guide.

Setting Up as a Print Server

Important
❒ You can set up the print server using NDS or Bindery mode in NetWare 4.x,

5/5.1. The following procedure is for NetWare 3.x and for setting up the print
server using NDS mode in NetWare 4.1. When you set up the print server us-
ing Bindery mode, use the NIB Setup Tool Wizard. See p.61 “Quick Setup Us-
ing the NIB Setup Tool Wizard”.

Note
❒ If you use Pure IP in NetWare 5/5.1, follow the procedure on p.70 “Using

Pure IP in the NetWare 5/5.1 Environment”.

AAAA Log on to the file server as a Supervisor or a Supervisor equivalent.

Note
❒ When using NetWare 4.x, 5/5.1, log on the file server as an administrator

or an administrator equivalent.

BBBB Run the NIB Setup Tool.

Reference
See p.60 “Running the NIB Setup Tool” .

CCCC Click [Property Sheet] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

DDDD Click [IPX protocol].

EEEE Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

see the network configuration page to check the MAC address (Network
Address).
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FFFF Make sure that the MAC address and IPX address are correct, and then click
[Finish].

The [NIB Setup Tool] window appears.

GGGG Click [Configure].
The property sheet appears.

HHHH Click the [General] tab, and then type the name of the print server into the
[Device Name] box.

IIII Click the [NetWare] tab, and then make the following settings.

NetWare 3.x

A Select [Bindery].

B In the [File Server Name] box, type the name of the file server in which a
print server is to be created.
Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

C Click [OK] to close the property sheet.

D After the confirmation dialog box appears, click [OK].

NetWare 4.1

A In the [Print Server Name] box, type the name of the print server.

B In the [File Server Name] box, type the name of the file server in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

C In the [NDS Context] box, type the context in which the print server is to
be created.

Clicking [Browse], you can select a context among those listed in the
[Browse] dialog box.
As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type “NET.DS”.

D Click [OK] to close the property sheet.

E After the confirmation dialog box appears, click [OK].
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JJJJ On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

NetWare 3.x

A Type “PCONSOLE” from the command prompt.

F:> PCONSOLE

NetWare 4.1

A From Windows, run NWAdmin.

Reference
For more information about NWAdmin, see the documentation that
comes with the NetWare.

KKKK Create a print queue as follows:

Note
❒ If you use a currently defined print queue, go to step L.

NetWare 3.x

A From the [Available Options] menu, select [Print Queue Information], and then
press the {{{{ENTER}}}} key.

B Press the {{{{INSERT}}}} key, and then type a print queue name.

C Press the {{{{ESC}}}} key to return to the [Available Options] menu.

NetWare 4.1

A Select the container object the print queue is located in among those in
the directory tree, and then click [Create] on the [Object] menu.

B In the [Class of new object] box, click “Print Queue”, and then click [OK].

C In the [Print Queue name] box, type the name of the print queue.
D In the [Print Queue volume] box, click [Browse].

E In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

F After checking the settings, click [Create].
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LLLL Create a printer as follows:

NetWare 3.x

A From the [Available Options] menu, select [Print Server Information] , and then
press the {{{{ENTER}}}} key.

B To create a new print server, press the {{{{INSERT}}}} key, and then type a
print server name.
If you use a currently defined print server, select one of the print servers
shown in the [Print Server] list.

Important
❒ Use the same name as that specified in the NIB Setup Tool. (Step H).

C From the [Print Server Information] menu, select [Print Server Configuration].
D From the [Print Server Configuration] menu, select [Printer Configuration].

E Select the printer which is indicated as “Not Installed”.

F If you want to change the name of the printer, type a new name.
A name “Printer x” is assigned to the printer. “x” stands for the number of
the selected printer.

G For type, select [Remote Other/Unknown].

The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

H Press the {{{{ESC}}}} key, and then click [Yes] in the confirmation dialog box.

I Press the {{{{ESC}}}} key to return to the [Print Server Configuration] menu.

NetWare 4.1

A Select the container object the printer is located in, and then click [Create]
on the [Object] menu.

B In the [Class of new object] box, click “Printer”, and then click [OK]. When
you are using NetWare 5/5.1, click “Printer (Non NDPS)”.

C In the [Printer name] box, type the name of the printer.

D Select the [Define additional properties] check box, and then click [Create].
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MMMM Assign print queues to the created printer as follows:

NetWare 3.x

A From the [Print Server Configuration] menu, select [Queues Serviced By Printer].

B Select the printer created in step LLLL.

C Press the {{{{INSERT}}}} key to select a queue serviced by the printer. 

Note
❒ You can select more than one queue at a time.

D Follow the instructions on the screen to make other necessary settings.

When you have finished the above steps, make sure that the queues are as-
signed.

E Press the {{{{ESC}}}} key until “Exit?” appears, and then select [Yes] to exit
PCONSOLE.

Note
❒ To make sure that the printer is correctly configured, type the following

from the command prompt.
F:> USERLIST

❒ If the printer works as configured, the name of the print server appears
as an attached user.

❒ NetWare 3.x ends here.

NetWare 4.1

A Click [Assignments], and then click [Add] in the [Assignments] group.
B In the [Available objects] box, click the queue created in step KKKK, and then

click [OK].
C Click [Configuration], and in the [Printer type] box, select [Parallel] using the

drop-down menu, and then click [Communication]. 
D Click [Manual load] in the [Communication type] group, and then click [OK].

E After checking the settings, click [OK].

NNNN Create a print server as follows:
A Select the context specified using the NIB Setup Tool (step IIII-AAAA), and on

the [Object] menu, click [Create].
B In the [Class of new object] box, click “Print Server”, and then click [OK].

When you are using NetWare 5/5.1, click “Print Server (Non NDPS)”.
C In the [Print Server name] box, type the name of the print server.

Important
❒ Use the same name as that specified using the NIB Setup Tool. (Step H)

D Select the [Define additional properties] check box, and then click [Create].
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OOOO Assign the printer to the created print server as follows.

A Click [Assignments], and then click [Add] in the [Assignments] group.
B In the [Available objects] box, click the printer created in step LLLL, and then

click [OK].
C After checking the settings, click [OK].

Note
❒ If the printer works as configured, the name of the print server appears

as an attached user.

Using Pure IP in the NetWare 5/5.1 Environment

AAAA Log on to the file server as an Administrator or an administrator equivalent.

BBBB Run the NIB Setup Tool.

Reference
See p.60 “Running the NIB Setup Tool” .

CCCC Click [Property Sheet] and click [OK].

The [Network board list] dialog box appears.

DDDD Click [TCP/IP protocol].

EEEE Click the IP address of the Network Interface Board which is to be config-
ured, and then click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

see the network configuration page to check the MAC address (Network
Address).

FFFF Make sure that the MAC address and IP address are correct, and then click
[Finish].

The [NIB Setup Tool] window appears.

GGGG Click [Configure].
The property sheet appears.

HHHH Click the [General] tab, and then type the name of the print server into the
[Device Name] box.
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IIII Click the [NetWare] tab, and then make the following settings.

A In the [Print Server Name] box, type the name of the print server.
B In the [File Server Name] box, type the name of the file server in which a

print server is to be created.
Clicking [Browse], you can select a file server among those listed in the
[Browse File Server] dialog box.

C In the [NDS Context] box, type the context of the print server.

Clicking [Browse], you can select an NDS tree and an NDS context among
those listed in the [Browse Context] dialog box.
As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type “NET.DS”.

D In the [Print Server Operation Mode] group, click [As Print Server].

E Click [OK] to close the property sheet.

F After the confirmation dialog box appears, click [OK].

JJJJ On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

After this step, go to step J on p.65 “Setting Up as a Print Server”.

Note
❒ When not using IPX, it is recommended that you change the print server

protocol in the Web Browser from [TCP/IP+IPX] to [TCP/IP].
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Setting Up as a Remote Printer

AAAA Log on to the file server as a Supervisor or a Supervisor equivalent.

Note
❒ When using NetWare 4.x, 5/5.1, log on to the file server as an administra-

tor or administrator equivalent.

BBBB Run the NIB Setup Tool.

Reference
See p.60 “Running the NIB Setup Tool” .

CCCC Click [Property Sheet] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

DDDD Click [IPX protocol].

EEEE Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

see the network configuration page to check the MAC address (Network
Address).

FFFF Make sure that the MAC address and IPX address are correct, and then click
[Finish].
The [NIB Setup Tool] window appears.

GGGG Click [Configure].

The property sheet appears.

HHHH Click the [General] tab, and then type the name of the print server into the
[Device Name] box.

IIII Click the [NetWare] tab, and then make the following settings.

NetWare 3.x

A In the [Print Server Name] box, type the name of the print server.

B In the [File Server Name] box, type the name of the file server in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.
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C In the [Print Server Operation Mode] group, click [As Remote Printer].

D In the [Remote Printer No.] box, type the printer number.

Important
❒ Use the same printer number as that to be created in the printer server.

E Click [OK] to close the property sheet.

F After the confirmation dialog box appears, click [OK].

NetWare 4.x, 5/5.1

A In the [Print Server Name] box, type the name of the print server.

B In the [File Server Name] box, type the name of the file server in which a
print server is to be created.
Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

C In the [NDS Context] box, type the context in which the print server is to
be created.
Clicking [Browse], you can select a context among those listed in the
[Browse] dialog box.
As a context, object names are typed from a lower level object and divided
by a period. For example, if you want to create a print server into NET un-
der DS, type “NET.DS”.

D In the [Print Server Operation Mode] group, click [As Remote Printer].

E In the [Remote Printer No.] box, type the number of the printer.

Important
❒ Use the same number as that of the printer to be created in the print

server.
F Click [OK] to close the property sheet.

G After the confirmation dialog box appears, click [OK].
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JJJJ On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

NetWare 3.x

A Type “PCONSOLE” from the command prompt.

F:> PCONSOLE

NetWare 4.x, 5/5.1

A From Windows, run NWAdmin.

Reference
For more information about NWAdmin, see the documentation that
comes with the NetWare.

KKKK Create a print queue as follows:

Note
❒ If you use a currently defined print queue, go to step L.

NetWare 3.x

A From the [Available Options] menu, select [Print Queue Information], and then
press the {{{{ENTER}}}} key.

B Press the {{{{INSERT}}}} key, and then type a print queue name.

C Press the {{{{ESC}}}} key to return to the [Available Options] menu.

NetWare 4.x, 5/5.1

A Select the container object the print queue is located in among those in
the directory tree, and then click [Create] on the [Object] menu.

B In the [Class of new object] box, click “Print Queue”, and then click [OK].

C In the [Print Queue name] box, type the name of the print queue.
D In the [Print Queue Volume] box, click [Browse].

E In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

F After checking the settings, click [Create].
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LLLL Create a printer as follows:

NetWare 3.x

A From the [Available Options] menu, select [Print Server Information], and then
press the {{{{ENTER}}}} key.

B To create a new print server, press the {{{{INSERT}}}} key, and then type a
print server name.
If you use a currently defined print server, select one of the print servers
shown in the [Print Server] list.

Important
❒ Use the same name as that specified in the NIB Setup Tool. (Step H).

C From the [Print Server Information] menu, select [Print Server Configuration].
D From the [Print Server Configuration] menu, select [Printer Configuration].

E Select the printer which is indicated as “Not Installed”.

Important
❒ Use the same number as that specified as Remote Printer No. using the

NIB Setup Tool. (Step I-D).
F If you want to change the name of the printer, type a new name. 

A name “Printer x” is assigned to the printer. x stands for the number of
the selected printer.

G Select [Remote Parallel, LPT1] as printer type.
The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

H Press the {{{{ESC}}}} key, and then click [Yes] in the confirmation dialog box.

I Press the {{{{ESC}}}} key to return to [Print Server Configuration Menu].

NetWare 4.x, 5/5.1

A Select the container object the printer is located in, and then click [Create]
in the [Object] menu.

B In the [Class of new object] box, click “Printer”, and then click [OK]. When
you are using NetWare 5/5.1, click “Printer (Non NDPS)”.

C In the [Printer name] box, type the name of the printer.

D Select the [Define additional properties] check box, and then click [Create].
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MMMM Assign print queues to the created printer as follows:

NetWare 3.x

A From [Print Server Configuration Menu], select [Queues Serviced By Printer].

B Select the printer created in step LLLL.

C Press the {{{{INSERT}}}} key to select a queue serviced by the printer. 

Note
❒ You can select more than one queue at a time.

D Follow the instructions on the screen to make other necessary settings.

When you have finished the above steps, make sure that the queues are as-
signed.

E Press the {{{{ESC}}}} key until “Exit?” appears, and then select [Yes] to exit
PCONSOLE.

F Start the print server by typing the following from the console of the
NetWare Server.
 If it is running, restart it after exiting it.

❖❖❖❖ To exit
CAREE: unload pserver

❖❖❖❖ To start
CAREE: load pserver print_server_name

Note
❒ If the printer works as configured, “Waiting for job” appears.
❒ NetWare 3.x ends here.

NetWare 4.x, 5/5.1

A Click [Assignments], and then click [Add] in the [Assignments] group.
B In the [Available objects] box, click the queue created in step KKKK, and then

click [OK].
C Click [Configuration], and in the [Printer type] box, select [Parallel] using the

drop-down menu, and then click [Communication]. 
D Click [Manual load] in the [Communication type] group, and then click [OK].

E After checking the settings, click [OK].
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NNNN Create a print server as follows:

A Select the context specified using the NIB Setup Tool (Step IIII-AAAA), and on
the [Object] menu, click [Create].

B In the [Class of new object] box, click “Print Server”, and then click [OK].
When you are using NetWare 5/5.1, click “Print Server (Non NDPS)”.

C In the [Print Server name] box, type the name of the print server.

Important
❒ Use the same name as that specified using the NIB Setup Tool. (Step H).

D Select the [Define additional properties] check box, and then click [Create].

OOOO Assign the printer to the created print server as follows.

A Click [Assignments], and then click [Add] in the [Assignments] group.
B In the [Available objects] box, click the queue created in the step KKKK, and

then click [OK].
C In the [Printers] group, click the printer assigned in step BBBB , and then click

[Printer Number].
D Type the printer number and click [OK].

Important
❒ Specify the same printer No. as used with the NIB Setup Tool. (Step I-

E).
E After checking the settings, click [OK].

PPPP Start the print server by typing the following from the console of the Net-
Ware Server.
If it is running, restart it after exiting it.

❖❖❖❖ To exit
CAREE: unload pserver

❖❖❖❖ To start
CAREE: load pserver print_server_name
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Setting Up a Client Computer

This section describes how to set up a client computer when using a NetWare
print server.

Note
❒ Use the version of Novell Client provided with your operating system or the

latest version.
❒ This section assumes that the client has NetWare client applications installed

and is correctly configured to communicate with a NetWare print server. If
not, install the necessary applications before starting the setting up proce-
dure.

Windows 95/98/Me

Follow the procedure to set up a Windows 95/98/Me client. 

Preparation
Log on to the NetWare file server before starting the following procedure.

AAAA Install the printer driver you want to use as “Local printer”.

Reference
For more information about installing the printer driver, see the Printer
Reference 1.

Note
❒ Any port can be selected during the installation, however, LPT1 is recom-

mended.

BBBB Click [Start], point to [Settings], and then click [Printers].

CCCC In the [Printers] window, click the icon of the printer you want to use. 

DDDD On the [File] menu, click [Properties].

EEEE Click the [Details] tab, and then click [Add Port].

FFFF Click [Network] and click [Browse].

GGGG On the network tree, double-click the name of the file server.

The queues are displayed.

HHHH Click the queue you want to print, and then click [OK].

IIII Click [OK].

In the [Print to the following port] box, a network path to the printer appears.

JJJJ Click [OK] to close the Printer Properties, and again, open it.
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KKKK Click the [Printer Settings] tab.

LLLL Select to clear the [Form feed] and [Enable banner] check boxes.

Note
❒ You should not select these boxes because they should be specified in the

printer driver. If they are selected, the printer might not print correctly.

When using the PostScript printer driver

Follow these steps to set up for the PostScript printer driver.
A Click the [PostScript] tab. 

B Click [Advanced].

C Click to clear the [Send CTRL+D before job] and [Send CTRL+D after job] check
boxes.

MMMM Click [OK] to close the Printer Properties.

Windows 2000/XP, Windows NT 4.0

Follow the procedure to set up a Windows 2000/XP, Windows NT 4.0 client.

Preparation
Log on to the NetWare file server before starting the following procedure.

AAAA Double-click the [My Network Places] icon on the desktop and navigate to the
queue you want to use, and then double-click it.
The [printers] dialog box appears.

Note
❒ When using Windows NT 4.0, the [Network Neighborhood] icon appears on

the desktop instead of the [My Network Places] icon.

BBBB Click [No].

CCCC Close all the applications that are currently running.

DDDD Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

If the setup menu starts automatically, you can go to the next step. If not, see
the Printer Reference 1.

EEEE The [Printer Installation] dialog box appears.

FFFF From the [Port] list, select the queue you selected in step AAAA, and then click
[Next >].

GGGG Follow the instructions on the screen to complete the installation of the
printer driver.
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6. Macintosh Configuration
Configuring Macintosh

This section describes how to configure a Macintosh computer to use EtherTalk.
The actual procedures to configure a Macintosh may vary depending on the ver-
sion of the Mac OS. The following procedure describes how to configure Mac OS
9.1. If you are not using Mac OS 9.1, see the manual that comes with your version
of Mac OS for more information.

Limitation
❒ The required version of Mac OS is 8.6 or later. (Mac OS X Classic environment

is supported.)

Note
❒ To print from a Macintosh, the optional module that includes PostScript 3

must be expanded.
❒ To use a Macintosh, you need to install Adobe PS Printer Driver from the CD-

ROM with the module that includes PostScript 3.

Change to EtherTalk

Basic Procedure

Configure the printer

Change the printer name

Change the zone
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Changing to EtherTalk

The following procedure is for configuring a Macintosh computer to use
EtherTalk.

Reference
For more information about installing the software required for EtherTalk,
see the Macintosh manuals.

AAAA Open [Control Panel], and then double-click the [AppleTalk] icon.

BBBB From the [Connect via] pop-up menu, select “Ethernet”.

CCCC If you change zones, select a name from the [Current zone] pop-up menu.

DDDD Close the [AppleTalk] control panels.

EEEE Restart the Macintosh.

Configuring the Printer

Use the control panel to activate the EtherTalk protocol. (The default is active.)

Reference
For more information about configuration, see the General Settings Guide.

Changing the Printer Name

If the network has several similar model printers, the names will be the same.
Printers that have the same name will have their names slightly changed in the
Chooser. For example, three printers named “printer” will appear in the chooser
as “printer0”, “printer1” and “printer2”. 
To change the printer name in the Macintosh EtherTalk environment, use the
Printer Utility for Mac included on the CD-ROM labeled “Printer Drivers and
Utilities”.

Changing the Zone

To change the zone configuration in the Macintosh EtherTalk environment, use
the Printer Utility for Mac included on the CD-ROM labeled “Printer Drivers
and Utilities”.

Reference
For more information about using Printer Utilities for Mac, see PostScript 3
Supplement provided as a PDF file on the CD-ROM labeled “Operating In-
structions”.



7. Appendix
Using SmartNetMonitor for Admin

Using SmartNetMonitor for Admin, you can not only monitor the status of net-
work printers, but also change the configurations of the Network Interface
Board using the TCP/IP protocol or IPX/SPX protocol.
SmartNetMonitor for Admin is equipped with the following functions.
• Limits the settings to be done from the control panel, and disables changes to

be made to some of the items.
• Enables the selection of paper type loaded in the printer.
• Switches to the Energy Saver mode, and wakes up from the Energy Saver

mode.
• Checks the information on printing, paper exhaustion, and such, on the com-

puter.
• Monitors multiple printers at the same time. When there are many printers,

you can create groups and classify the printers to facilitate management.
• Checks the printer's network settings and detailed information of devices.
• Enables you to change the printer's network settings.
• Checks the number of pages printed for each computer, using the user codes.

Note
❒ Select the appropriate protocol stack for your operating system.

OS Protocol Stack

Microsoft Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX/SPX provided with Windows 95/98/Me

NetWare network client provided with Windows 95/98

Novell Client for Windows 95/98

Microsoft Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client for Windows NT/2000

Microsoft Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

Microsoft Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

Client Service for NetWare provided with Windows NT

Novell Client for Windows NT/2000
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Changing the Network Interface Board Configuration

Limitation
❒ To use NIB Setup Tool, Internet Explorer 4.01 or a later version is required.

AAAA Run SmartNetMonitor for Admin.

BBBB Click the [Group] menu, point to [Search Device], and then select [TCP/IP] or
[IPX/SPX].
 A list of printers appears.

Note
❒ Select the protocol of the printer you want to change its configuration.

CCCC On the list, Select a printer you want to change its configuration.

DDDD From the [Tools] menu, select [NIB Setup Tool].
The NIB Setup Tool starts up.

EEEE Select [Wizard] or [Property Sheet], and then click [OK].

• When configuring the Network Interface Board for the first time, select
[Wizard].

• When changing the configuration of the Network Interface Board or con-
figuring it in detail, select [Property Sheet].

Selecting [Wizard]

A Fill in the necessary items, and then click [Next].

Selecting [Property Sheet]

A A configuration list appears on the dialog box.

For more information about each item on the dialog box, see Help.
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Locking the Operation Panel Menu

Limitation
❒ If you use User Code Maintenance Tool, you need a computer and devices

that communicate with TCP/IP (HTTP).

AAAA Run SmartNetMonitor for Admin.

BBBB Click the [Group] menu, point to [Search Device], and then select [TCP/IP] or
[IPX/SPX].

A list of printer appears.

Note
❒ Select the protocol of the printer you want to change its configuration.

CCCC On the list, select a printer whose statistics information you want to man-
age.

DDDD From the [Tools] menu, point to [Device Settings], and then click [Lock Opera-
tion Panel Menu].
The screen that prompts you to type a password appears.

EEEE Type the password, and then click [OK].

Note
❒ The factory default password is “password”.
The Web Status Monitor starts up.
For more information about using the Device Settings, see SmartNetMonitor
for Admin Help.

Selecting the Paper Type

Limitation
❒ If you use User Code Maintenance Tool, you need a computer and devices

that communicate with TCP/IP (HTTP).

AAAA Run SmartNetMonitor for Admin.

BBBB Click the [Group] menu, point to [Search Device], and then select [TCP/IP] or
[IPX/SPX].

A list of printer appears.

Note
❒ Select the protocol of the printer you want to change its configuration.
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CCCC On the list, select a printer whose statistics information you want to man-
age.

DDDD From the [Tools] menu, point to [Device Settings], and then click [Select Paper
Type].

The screen that prompts you to type a password appears.

EEEE Type the password, and then click [OK].

Note
❒ The factory default password is “password”.
The Web Status Monitor starts up.
For more information about using the Device Settings, see SmartNetMonitor
for Admin Help.

Managing the User Information

Limitation
❒ If you use User Code Maintenance Tool, you need a computer and devices

that communicate with TCP/IP (HTTP).

AAAA Run SmartNetMonitor for Admin.

BBBB Click the [Group] menu, point to [Search Device], and then select [TCP/IP] or
[IPX/SPX].

A list of printer appears.

Note
❒ Select the protocol of the printer you want to change its configuration.

CCCC On the list, Select a printer whose statistics information you want to man-
age.

DDDD From the [Tools] menu, select [User Management Tool].

The screen that prompts you to type a password appears.

EEEE Type the password, and then click [OK].

Note
❒ The factory default password is “password”.
The User Code Maintenance Tool starts up.
For more information about using the User Management Tool, see SmartNet-
Monitor for Admin Help.
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Managing the E-mail Information

Limitation
❒ If you use E-mail Management Tool, you need a computer and devices that

communicate with TCP/IP (HTTP).

AAAA Run SmartNetMonitor for Admin.

BBBB Click the [Group] menu, point to [Search Device], and then select [TCP/IP] or
[IPX/SPX].

A list of printer appears.

Note
❒ Select the protocol of the printer you want to change its configuration.

CCCC On the list, select a printer whose statistics information you want to man-
age.

DDDD From the [Tools] menu, select [E-mail Management Tool].

The screen that prompts you to type a password appears.

EEEE Type the password, and then click [OK].

Note
❒ The factory default password is “password”.
The E-mail Management Tool starts up.
For more information about using the User Management Tool, see SmartNet-
Monitor for Admin Help.

Configuring the Energy Save Mode

AAAA Run SmartNetMonitor for Admin.

BBBB Click the [Group] menu, point to [Search Device], and then select [TCP/IP] or
[IPX/SPX].
A list of printer appears.

Note
❒ Select the protocol of the printer you want to change its configuration.

CCCC Click [Group], point to [Energy Save Mode], and select any energy saver mode
from the menu that appears.

For more information about settings, see SmartNetMonitor for Admin Help.

Note
❒ When you point to [Set Individually], [Timer Settings] is not displayed.
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Configuring the Network Interface Board 
with a Web Browser

The Network Interface Board functions as a Web server in addition to allowing
a printer to function as a network printer. You can use a Web Browser to view
the printer status and configure the Network Interface Board.

Note
❒ When using the proxy server, you must set up the Web Browser.

❖❖❖❖ Configuring the machine
This requires the TCP/IP protocol to be installed. After the machine has been
configured to use the TCP/IP protocol, it will be possible to adjust the settings
using a Web Browser.

Reference
For more information about configuring the machine to use the TCP/IP
protocol, see the General Settings Guide.

❖❖❖❖ Operating system browser requirements

Limitation
❒ Sometimes after clicking [Back] , the previous page may not appear. In this

case, click [Refresh] or [Reload] .
❒ The text on the screen may disappear or be aligned incorrectly if the font

size settings of the browser are too large. It is recommended that you use
a font size equal to or smaller than “10 point” with Netscape Navigator,
and “Medium” or smaller with Internet Explorer.

❒ This machine information cannot reload automatically. Click [Reload] or
[Refresh] on the Web Browser when you want to reload this machine infor-
mation.

OS Browser

Windows 95/98/Me

Microsoft Internet Explorer 4.01 or later

Netscape Navigator 4.06 or later

Windows 2000/XP

Windows NT 4.0

Mac OS 8.6 ∼ 9.1

Solaris 2.5/2.6/2.7/7/8
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Going to the Top Page

After launching the Web Browser, type the IP address of the machine. See the
example below. This example is for the English version.
http://192.168.15.16/

(In this example, the IP address of the Network Interface Board is 192.168.15.16.)

Note
❒ If a DNS server is used on the network, you can type the host name as a URL.

For example, http://webmonitor.netprinter.com/. In order to do this, you
must register the IP address and the host name of the Network Interface
Board with the DNS server. Consult the network administrator for informa-
tion about how to do this.

❒ Make sure to set the appropriate proxy server settings in the Web Browser
you are using. Otherwise you may not be able to connect to the local network
printer. Consult the network administrator for information about how to set
the proxy server.

1. Header Buttons
You can register favorite URLs with
[URL]. To view the Help section, click
[Help].

Important
❒ When connecting via a dial-up

connection, please be aware that
there will be a communication
charge as you are logging onto the
Internet.

Note
❒ The Help files are stored on the CD-

ROM labeled “Operating Instruc-
tions” in HTML format.

2. Menu Buttons
These Buttons are to configure the Net-
work Interface Board and for checking
the status of the machine.

Note
❒ When you click [Configuration], a dia-

log box appears requesting the user
name and password. Type only the
password in this dialog box. The de-
fault password is “password”.

❒ The password is the same as that used
for remote maintenance and that used
in the NIB Setup Tool. If you change a
password with the Web Browser, the
other passwords are also changed.

3. Status
Displays the name and comments of the
Network Interface Board, and the printer
status.

3

1
2
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Verifying the Network Interface Board Settings

AAAA Start the Web Browser.

BBBB Point your browser at the URL or IP address of the printer (e.g. ht-
tp://XXX.XXX.XXX.XXX where the Xs are the number of the IP address).
The status of the printer you chose appears on the Web Browser.

CCCC Click [Config. Reference].

The dialog box for entering the password and user name is displayed.

DDDD Click the item you want to check.

The following items can be checked:

❖❖❖❖ [General]
Shows general settings for the machine.

❖❖❖❖ [IEEE 802.11b (Wireless LAN)]
Shows 802.11b Interface Kit settings related to communication.

❖❖❖❖ [TCP/IP]
Shows TCP/IP-related settings for Network Interface Board, 802.11b Inter-
face Kit, and 1394 Interface Unit.

❖❖❖❖ [NetWare]
Shows Network Interface Board or 802.11b Interface Kit settings related to
a NetWare environment.

❖❖❖❖ [AppleTalk]
Shows Network Interface Board or 802.11b Interface Kit settings related to
the AppleTalk protocol.

❖❖❖❖ [NetBEUI]
Shows Network Interface Board or 802.11b Interface Kit settings related to
the NetBEUI protocol.

❖❖❖❖ [IEEE 1394]
Shows 1394 Interface Unit settings related to IP over 1394 and SCSI print
(SBP-2).

❖❖❖❖ [SMTP]
Shows SMTP settings.
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----Linking the address (URL) to the [Help] button
You can link the address (URL) of the [Help] button to the Help files on the com-
puter or on a Web server.
A Copy the Help files on the CD-ROM to the desired location. The Help files are

located in folders labeled with abbreviated language names; for example,
English Help files are in the [EN] folder. Make sure to copy the entire [EN] fold-
er to the new location.

B Using a Web Browser, navigate to the Top Page and click [Network config].
C Type your password, (it is not necessary to type a user name) and click [OK].
D Type the path to the Help files in the [Help URL] box.

If you copied the Help files to “C:\HELP\EN”, type “file ://C:/HELP/”. For
example, if you copied the files to a Web server and the index URL is “ht-
tp://a.b.c.d/HELP/EN/index.html”, type “http://a.b.c.d/HELP/”.

E Click [Apply].
When a warning message appears, select to continue configuration.

Configuring the Network Interface Board Settings

AAAA Start the Web Browser.

BBBB Point your browser at the URL or IP address of the printer (e.g. ht-
tp://XXX.XXX.XXX.XXX where the Xs are the number of the IP address).

The status of the printer you chose appears on the Web Browser.

CCCC Click [Configuration].
The dialog box for entering the password and user name is displayed.

DDDD Enter your user name and password, and then click [OK].

To use the factory default account, enter no user name and type “password”
for the password.

EEEE Click the item you want to configure, and then make all the settings.
The following items can be configured:

❖❖❖❖ [General]
Configure the general settings for the machine here.

❖❖❖❖ [IEEE 802.11b (Wireless LAN)]
Configure 802.11b Interface Kit settings related to communication.

Limitation
❒ This page is displayed when the 802.11b Interface Kit is installed.
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❖❖❖❖ [TCP/IP]
Configure TCP/IP-related settings for Network Interface Board, 802.11b
Interface Kit, and 1394 Interface Unit.

❖❖❖❖ [SNMP]
Configure the appropriate community settings here. Up to 10 types of
community names can be registered.

❖❖❖❖ [NetWare]
Configure Network Interface Board or 802.11b Interface Kit settings relat-
ed to a NetWare environment.

❖❖❖❖ [AppleTalk]
Configure Network Interface Board or 802.11b Interface Kit settings relat-
ed to the AppleTalk protocol.

❖❖❖❖ [NetBEUI]
Configure Network Interface Board or 802.11b Interface Kit settings relat-
ed to the NetBEUI protocol.

❖❖❖❖ [IEEE 1394]
Configure 1394 Interface Unit settings related to IP over 1394 and SCSI
print (SBP-2).

Limitation
❒ This page is displayed when 1394 Interface Unit is installed.

❖❖❖❖ [SMTP]
Configure SMTP settings.

❖❖❖❖ [IPP Authentication]
If using IPP protocol, configure the authentication settings for printing
here.

❖❖❖❖ [Paper Type]
Select the paper type loaded in the machine from the drop-down menu.

❖❖❖❖ [Password]
Follow the procedure below to change the password.
Enter the password to change the network and machine settings or delete
spooled print jobs.
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Monitoring and Configuring the Printer

Changing Names and Comments

You can change printer names and make a comment on printers to easily iden-
tify the printers listed on SmartNetMonitor for Client.
The following utilities are used to change printer names and comments.

❖❖❖❖ SmartNetMonitor for Admin
Allows you to change names and comments when the TCP/IP protocol or
IPX/SPX protocol is available. You can install SmartNetMonitor for Admin
from the CD-ROM that comes with the printer. For more information about
installing SmartNetMonitor for Admin, see p.60 “Installing SmartNetMoni-
tor for Admin”.

❖❖❖❖ Web Browser
Allows you to change names and comments when the TCP/IP protocol is
available.

Note
❒ Each of the names, in a TCP/IP protocol form (printer name) and in a Net-

BEUI protocol form, is changed individually. Comments are, however,
common to both of them.

❒ The factory default name consists of “RNP” and the last 3 bytes of the
MAC address on the Network Interface Board. For example, when the
MAC address is 00:00:74:62:7D:D5, the factory default name is
“RNP627DD5”. Comments are not configured.

SmartNetMonitor for Admin

AAAA Run SmartNetMonitor for Admin.

BBBB Click the [Group] menu, point to [Search Device], and select [TCP/IP] or
[IPX/SPX].

 A list of printers appears.

Note
❒ Select the protocol of the printer you want to change its configuration.

CCCC On the list, Select a printer whose Network Interface Board you want to
change its configuration.

DDDD From the [Tools] menu, select [NIB Setup Tool].

The NIB Setup Tool starts up.
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EEEE Select [Property Sheet], and then click [OK].

TCP/IP

A Click the [General] tab, and then type the device name into the [Device
Name] box and comment into the [Comment] box.
• In the [Device Name] box, type the name of the printer in under 13 char-

acters. The factory default name consists of “RNP” and the last 3 bytes
of the MAC address on the Network Interface Board. For example,
when the MAC address is 00:00:74:62:7D:D5, the factory default name is
“RNP627DD5”. No name of 9 characters is permitted if the prefix is
“RNP”. Also, when DHCP is selected as an IP address setting, the
number of characters is limited to 13 characters.

• In the [Comment] box, type any comment on printers in under 31 charac-
ters.

NetBEUI

A Click the [General] tab, and then type the comment into the [Comment]
box.

In the [Comment] box, type any comment on printers in under 31 characters.
B Click the [NetBEUI] tab.
C Type the computer name into the [Computer Name] box.

• In the [Computer Name] box, type the name that helps you to identify
printers using the NetBEUI protocol. The factory default name consists
of “RNP” and the last 3 bytes of the MAC address on the Network In-
t e r f a c e  B o a r d .  F o r  e x am p le ,  w h en  t h e  M A C  a d d r e s s  i s
00:00:74:62:7D:D5, the factory default name is “RNP627DD5”. A maxi-
mum of 13 characters consisting of uppercase English letters, numeric,
or symbols (except "*+,/:;<=>?[\]|. and space) can be used. No name is
permitted if the prefix is “RNP”. You must avoid the duplication of the
same name on a network.

FFFF When the configuration message appears, click [OK].

The NIB Setup Tool exits, and the setting is transmitted to the printer.

GGGG Exit SmartNetMonitor for Admin.
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Web Browser

AAAA Run the Web Browser.

BBBB Type the address “http:// (IP address of the printer you want to change the
settings)”.
The status of the selected printer is displayed on the Web Browser.

CCCC Click [Configuration].

A dialog box that prompts you to type the user name and a password ap-
pears.

DDDD Type the user name and the password, and then click [OK].
Type only the password in this dialog box. The factory default password is
“password”.

EEEE Change names and comments.

TCP/IP

A Click [General], and then type the name into the [Device Name] box and
comment into the [Comment] box.

• In the [Device Name] box, enter the name of the printer in under 13 char-
acters. The factory default name consists of “RNP” and the last 3 bytes
of the MAC address on the Network Interface Board. For example,
when the MAC address is 00:00:74:62:7D:D5, the factory default name is
“RNP627DD5”. No name of 9 characters is permitted if the prefix is
“RNP”. Also, when DHCP is selected as an IP address setting, the
number of characters is limited to in under 13 characters.

• In the [Comment] box, type any comment on printers in under 31 charac-
ters.

B Click the [IEEE 1394], and then type the name into the [Device Name] box
when you change the device name for IEEE 1394 (IP over 1394) interface.

• In the [Device Name] box, enter the name of the printer in under 13 char-
acters. The factory default name consists of “RNP” and the last 5 bytes
of the EUI-64 on the IEEE 1394 (IP over 1394) Interface. For example,
when the EUI-64 is 00:00:74:00:02:01:0A:66, the factory default name is
“RNP0002010A66”. No name of 13 characters is permitted if the prefix
is “RNP”.
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NetBEUI

A Click [NetBEUI].
B Type the name into the [Computer Name] box and comment into the [Com-

ment] box.
• In the [Computer Name] box, type the name that helps you to identify

printers using the NetBEUI protocol. The factory default name consists
of “RNP” and the last 3 bytes of the MAC address on the Network In-
t e r f a c e  B o a r d .  F o r  e x am p le ,  w h en  t h e  M A C  a d d r e s s  i s
00:00:74:62:7D:D5, the factory default name is “RNP627DD5”. A maxi-
mum of 13 characters consisting of uppercase English letters, numeric,
or symbols (except "*+,/:;<=>?[\]|. and space) can be used. No name is
permitted if the prefix is “RNP”. You must avoid the duplication of the
same name on a network.

• In the [Comment] box, type any comment on printers in under 31 charac-
ters.

FFFF Click [Apply].

The setting is transmitted to the printer.

GGGG Exit the Web Browser.

Displaying the Status of Printer

You can view the status of printers using SmartNetMonitor for Admin, Smart-
NetMonitor for Client, or Web Browser.

SmartNetMonitor for Admin

AAAA Run SmartNetMonitor for Admin.

BBBB Click the [Group] menu, point to [Search Device], and then select [TCP/IP] or
[IPX/SPX].

The status of printers is indicated with an icon in the list.

Note
❒ For more information about the status icons, see SmartNetMonitor for Ad-

min Help.

CCCC Getting further information, click the desired printer to select from the list,
and then click [Open] on the [Device] menu.

The status of the printer is displayed on the dialog box.

Note
❒ For more information about each item on the dialog box, see Help.
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SmartNetMonitor for Client

Viewing the status of printers using SmartNetMonitor for Client, you must, in
advance, configure SmartNetMonitor for Client so it monitors the printer whose
status you want to view.

Monitoring Printers

AAAA Run SmartNetMonitor for Client.

The SmartNetMonitor for Client icon appears at the right end of the taskbar.

BBBB Right-click the SmartNetMonitor for Client icon, and check if the desired
printer is configured on the pop-up menu that appears.
If it is configured, see SmartNetMonitor for Client Help.

CCCC If the desired printer is not configured, click [Options] on the pop-up menu.

The [SmartNetMonitor for Client - Options] dialog box appears.

DDDD Click the printer to be monitored, and select the [To be Monitored] check box
from the [Monitoring Information Settings] group.

Note
❒ Selecting the [Displayed on Task Bar] check box will bring up the status of a

printer with an icon on the SmartNetMonitor for Client icon on the task
tray.

EEEE Click [OK].

The dialog box closes and the configured printer is monitored.

Displaying the Status of Printers

AAAA Run SmartNetMonitor for Client.

BBBB The status of printers is displayed on the SmartNetMonitor for Client icon
on the task tray.

Note
❒ For more information about the status icons, see SmartNetMonitor for Cli-

ent Help.

CCCC Getting further information on the status, right-click the SmartNetMonitor
for Client icon, and then click the desired printer.

The status of the printer is displayed on the dialog box.

Note
❒ For more information about each item on the dialog box, see Help.
97



Appendix

98

7

Web Browser

AAAA Run the Web Browser.

BBBB Type the address “http:// (IP address of the printer whose status you want
to view)”.
The status of the selected printer is displayed on the Web Browser.

CCCC Click [Status] and you can check the status of the printer.

Note
❒ For more information about each item, see Help.
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Using the IEEE 802.11b (Wireless LAN)

Preparation
Make sure to configure the IP address and Subnet mask of this machine. To
make settings from the control panel of this machine, see the General Settings
Guide.
Use the WiFi authorized card for an access point and the IEEE 802.11b card in
the computer.

Setting IEEE 802.11b (Wireless LAN)

Note
❒ When using Windows XP standard Driver or Utilities to communicate with

Windows XP wireless LAN clients, select “802.11 ad hoc mode”.
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Using in Infrastructure Mode

Infrastructure mode is for transmitting data to the network via an access point.
The infrastructure mode settings can be made on the machine control panel;
however, they can also be made from telnet or a Web Browser.

Reference
For more information about how to make settings from the control panel of
the printer, see the General Settings Guide.
For more information about how to use telnet and a Web Browser, see p.88
“Configuring the Network Interface Board with a Web Browser” or p.102
“Remote Maintenance by telnet”.

Important
❒ If you cannot connect after making SSID and WEP key settings, press [System

Settings] then [Interface Settings] then [IEEE 802.11b], and then [Return to Defaults]
to return to the default settings.

❒ With some products, depending on the access point or IEEE 802.11b card in
use, it is possible to set more than one WEP key. In this case, make the first
key the same as the WEP key set in the printer.

Using in Ad hoc Mode

Ad hoc mode is for transmitting data between wireless LAN clients without us-
ing an access point. Depending on the client's operating environment, make sure
to select “802.11 ad hoc mode” which need a SSID or “ad hoc mode” which does
not need a SSID. The ad hoc mode settings can be made on the machine control
panel; however, they can also be made from telnet or a Web Browser.

Reference
For more information about how to make settings from the control panel of
the machine, see the General Settings Guide.
For more information about how to use telnet and a Web Browser, see p.88
“Configuring the Network Interface Board with a Web Browser” or p.102
“Remote Maintenance by telnet”.
For more information about how to make setting for the IEEE 802.11b card in-
stalled in the computer and the computer in use, see the appropriate operat-
ing instructions or consult your network administrator.

Note
❒ Depending on the client software of the IEEE 802.11b card installed in the

computer, the channels might not be able to be set. In this case, set the printer
channel to the channel specified by the computer.

❒ When there are multiple ad hoc mode clients using different communication
modes, communications may not work correctly.
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Confirming the Connection

AAAA Make sure the LED of the IEEE
802.11b card is lit.

❖❖❖❖ When using in Infrastracture Mode

1. If the IEEE 802.11b card is work-
ing, it is lit in orange. If the IEEE
802.11b (wireless LAN) is not select-
ed, it does not light, even if the print-
er power is on.

2. If it is connected properly to a net-
work, the LED is green in infrastruc-
ture mode. When the LED is blinking,
the machine is searching for devices.

❖❖❖❖ When using in Ad hoc Mode/802.11
Ad hoc Mode

1. If the IEEE 802.11b card is work-
ing, it is lit in orange.

2. If it is connected properly to a net-
work, the LED is in green in ad hoc
mode or 802.11 ad hoc mode. When
the LED is blinking, the machine is
searching for devices. The LED will
light after a few seconds.

BBBB Use a Web Browser to check the
printer is connected properly. See
p.88 “Configuring the Network
Interface Board with a Web
Browser”.

CCCC Print the configuration page to
verify settings.

For information about how to print
the configuration page, see the
Printer Reference 2.

Infrastructure Mode

You can check the Wireless LAN Sig-
nal using the machine's control panel.

AAAA Press the {{{{User Tools/Counter/In-
quiry}}}} key.

BBBB Press [System Settings].

CCCC Press [Interface Settings].

DDDD Press [IEEE 802.11b].

EEEE Press [Wireless LAN Signal].

FFFF Make sure that settings are com-
plete, and then press [Exit].

ZGDH600J

1
2

ZGDH600J

1
2
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Remote Maintenance by telnet

You can view the printer status and configure the Network Interface Board us-
ing telnet.

Note
❒ You should specify a password so that only the network administrator, or a

person having network administrator privileges, can use remote mainte-
nance. 

❒ The password is the same as that used for configuring the Network Interface
Board with a Web Browser.

❒ If you change a password with remote maintenance, the other passwords are
also changed.

Using telnet

The following is a sample procedure using telnet.

Limitation
❒ Only one person at a time can be logged on to do remote maintenance.

AAAA Using the IP address or host name of the machine, start telnet.

% telnet IP_address

Note
❒ In order to use the host name instead of the IP address, you must write it

to the hosts file.

BBBB Type the password.

Note
❒ The default is “password”.

CCCC Type a command.

Reference
For more information about telnet commands, see p.103 “Commands
List”.

DDDD Exit telnet.
msh> logout

When the configuration is changed, a message requests whether the changes
should be saved or not.

EEEE Type “yes” to save the changes, and then press the {{{{ENTER}}}} key.

If you do not want to save the changes, type “no”, and then press the {{{{ENTER}}}}
key. If you want to make additional changes, type “return” at the command
line, and then press the {{{{ENTER}}}} key.
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Note
❒ If the “Cannot write NVRAM information” message appears, the changes

are not saved. Repeat the steps above.
❒ The Network Interface Board is reset automatically when the settings are

changed.
❒ When the Network Interface Board is reset, the active print job which has

already been sent to the machine will finish printing. However, jobs that
have not been sent yet will be canceled.

Commands List

Use this command to display remote maintenance use.

Note
❒ Type “help” to see a list of commands that can be used.

msh> help

❒ Type “help command_name” to display information about the syntax of that
command.
msh> help command_name

TCP/IP address

Use the ifconfig command to configure the Ethernet interface, the IEEE 1394 in-
terface/IEEE 802.11b, and the TCP/IP (IP address, subnet mask, broadcast ad-
dress, default gateway address) for the machine.

❖❖❖❖ Reference
msh> ifconfig

❖❖❖❖ Configuration
msh> ifconfig interface_name parameter address

*1 If you did not enter the interface name, it will be automatically set to the Ethernet
interface.

*2 Available when the 1394 Interface Unit is installed. 
*3 You can specify an interface when installing the optional 802.11b Interface Kit.

Interface name Interface to be configured

ether
sie0

Ethernet Interface *1 

ip1394 *2 

fwip0 *2 
IEEE 1394 Interface

wlan *3 

wi0 *3 
IEEE 802.11b Interface

Parameter Meaning

(no parameter) IP address

netmask subnet mask

broadcast broadcast address
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❖❖❖❖ Changing the Interface
You can specify either the Ethernet interface or IEEE 802.11b interface when
using the optional 802.11b Interface Kit. 
msh> ifconfig interface up

Note
❒ You cannot specify the optional IEEE 1394 Interface Unit (ip1394 or fwip0).

The following is an example for configuring an IP address of 192.168.15.16 on
Ethernet interface.
msh> ifconfig ether 192.168.15.16

The following is an example for configuring a subnet mask of 255.255.255.0 on
Ethernet interface.
msh> ifconfig ether netmask 255.255.255.0

Note
❒ This affects the configuration of the Network Interface Board of the IP ad-

dress used.
❒ The TCP/IP setting is the same as that for the Ethernet interface and IEEE

802.11b interface.
❒ To type an address using hexadecimal, prefix it by “0x”.
❒ When using IEEE 802.11b, see p.112 “Setting IEEE 802.11b” for settings.

----Address

❖❖❖❖ Subnet Mask
A number used to mathematically “mask” or hide the IP address on the net-
work by eliminating those parts of the address that are alike for all the ma-
chines on the network.

❖❖❖❖ Broadcast address
A specified address for sending data to specific devices on the network.

Note
❒ To get the above addresses, contact your network administrator.
❒ If you don't know the address to configure, use the machine's default settings.
❒ The subnet mask is the same as that for the Ethernet interface and IEEE

802.11b interface. When changing interface, the settings of the former are
used.

❒ When installing the optional 1394 Interface Unit, set the subnet so that it does
not overlap with the Ethernet interface or the 1394 interface.
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Access Control

Use the access command to view and configure access control. You can also
specify two or more access ranges.

❖❖❖❖ Reference
msh> access

❖❖❖❖ Configuration
msh> access ✩ range start-address end-address

• ✩ represents a target number between 1 and 5. (Up to five access ranges
can be registered and selected.)

Example: To specify accessible IP addresses between 192.168.0.10 and
192.168.0.20:
msh> access 1 range 192.168.0.10 192.168.0.20

Note
❒ The access range restricts the workstations from which printing is possible

by means of an address. If you do not need to restrict printing, make the
setting “0.0.0.0”.

❒ The entry is invalid if the start address is greater than the end address.
❒ Up to five access ranges can be specified. The entry is invalid if the target

number is omitted.
❒ When using a Web Browser, telnet or SmartNetMonitor for Client/Admin,

you can use an IP address that has not been restricted by access control.
However, you cannot print from SmartNetMonitor for Client.

❖❖❖❖ Access Control Initialization 
msh> access flush

Note
❒ This restores the factory-default settings so that all access ranges become

“0.0.0.0”.

Network Boot

Use the set command to configure the boot method.
msh> set parameter {on | off}

•  “on” means active and “off” means inactive.

Note
❒ When you use DHCP, the server also needs to be configured.
❒ DHCP takes precedence over all other settings.

Parameter Meaning

dhcp DHCP (Dynamic Host Configuration 
Protocol)
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Protocol

Use the set command to allow/prevent remote access for each protocol.
msh> set protocol {up | down}

*1 Available when the 1394 Interface Unit is installed.

Note
❒ If you prohibit remote access using TCP/IP and then log out, you cannot use

remote access. If this was a mistake, you can use the control panel to allow ac-
cess by TCP/IP.

❒ When you prevent access via TCP/IP, you are also prevented from using
ip1394, lpr, ftp, rsh, diprint, web, snmp and ipp.

Printer status

The following commands can be used to get information about the current status
of the printer.
msh> command

Note
❒ More information about any print job is displayed when the ID number is

added after the prnlog command.

Protocol

appletalk 

tcpip

netware

netbeui

scsiprint *1 

ip1394 *1 

lpr

ftp

rsh

diprint

web

snmp

ipp

“up” means active and “down” means 
inactive.

Command Information that is displayed

 status Status of printer.

Information about the print jobs.

 info Information about the paper tray, output tray, 
printer language of printer.

 prnlog [ID] Lists the last 16 print jobs.
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Reference
For more information about the meaning of the data returned with these com-
mands, see p.121 “Understanding the Displayed Information”.

Network Interface Board configuration settings information

Use the show command to display the Network Interface Board configuration
settings.
msh> show [-p]

Note
❒ Add “-p” to the show command to have the information displayed one screen

at a time.

Reference
For more information about the meaning of the data returned with this com-
mand, see p.122 “Configuring the Network Interface Board”.

System log information

Use the syslog command to display information stored in the machine's system
log. 
msh> syslog

Reference
For more information about the displayed information, see p.125 “System
Log Information”.

SNMP

Use the snmp command to display and edit SNMP configuration settings such
as the community name.

Note
❒ The 1394 Interface Unit supports TCP/IP only.
❒ You can configure from ten SNMP access settings numbered 1–10.
❒ Default access settings 1 and 2 are as follows.

Number 1 2

Community name  public admin

IP address 0.0.0.0 0.0.0.0

Access type read-only 

trap off

read-write 

trap off
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❖❖❖❖ Display
Shows the SNMP information and available protocols.
msh> snmp ?
msh> snmp [-p] [registered_number]

Note
❒ If the -p option is added, you can view the settings one by one.
❒ Omitting the number displays all access settings.

❖❖❖❖ Community name configuration
You can set the community name of the registered number.
msh> snmp number name community_name

Note
❒ The community name must consist of 15 characters or less.

❖❖❖❖ Access type configuration
You can select the access type from those listed below.
msh> snmp number type access_type

❖❖❖❖ Protocol configuration
You should use the following command to set the protocols to active or inac-
tive. If you set a protocol to inactive, all access settings set to use that protocol
will be disabled.
msh> snmp {ip | ipx} {on | off}

•  “on” means active and “off” means inactive.
To change the protocol of an access settings, use the following command.
However, if you disabled a protocol with the above command, making it ac-
tive here will have no effect.
msh> snmp number active {ip | ipx} {on | off}

❖❖❖❖ Access configuration
You can configure the address of a host depending on the protocols used. 
The Network Interface Board accepts requests only from hosts having ad-
dresses with access types of “read-only” or “read-write”. Type “0” to have the
Network Interface Board accept requests from any host without requiring a
specific type of access.

msh> snmp number {ip | ipx} address

Access type Type of access which is permitted

read Read only

write Read and write

trap User is notified of trap messages.

no All access is denied.
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Note
❒ To specify the TCP/IP protocol, type ip followed by a space, and then the

IP address.
❒ To specify the IPX/SPX protocol, type ipx followed by a space, and then

the IPX address followed by a decimal, and then the MAC address of the
Network Interface Board.

The following is an example of how to configure registration number 3 with
the IP address 192.168.15.16.
msh> snmp 3 ip 192.168.15.16
The following is an example of how to configure registration number 3 with
the IPX address 7390A448, and the MAC address 00:00:74:62:5C:65.
msh> snmp 3 ipx 7390A448:000074625C65

IPP

Use the ipp command to configure the IPP settings.

❖❖❖❖ Viewing setting
The following command displays the current IPP settings.
msh> ipp
Example output:
timeout=900(sec)
auth basic

• The “timeout” setting specifies how many seconds the computer keeps try-
ing to access the network printer to send print jobs when no connection can
be made.

• The “auth” setting indicates the user authorization mode.

❖❖❖❖ IPP timeout configuration 
Specify how many seconds to wait before canceling a print job if it has been
interrupted for some reason. The range of time can be changed between 30 to
65535 seconds.
msh> ipp timeout {30 - 65535}

❖❖❖❖ IPP user authorization configuration
Use the IPP user authorization to restrict users that can print with IPP. The de-
fault is “off” .
msh> ipp auth {basic|digest|off}

• “basic” and “digest” are user authorization setting.
• “off” removes the user's authorization.

Note
❒ If you select “basic” or “digest”, see next section “Configuring the IPP User

Authorization” for how to configure the user name. Up to ten user names
are available.
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❖❖❖❖ Configuring the IPP user authorization
Use the following command:
msh> ipp user
The following message appears.
Input user number (1 to 10):
Type the number, user name and password.
IPP user name:user1
IPP password:*******
After configuring the settings, the following message appears.
IPP configuration changed.

Direct Printing Port

The direct printing port allows printing directly from a computer, connected to
the network, to the printer.
Use the diprint command to change the direct printing port settings.

❖❖❖❖ View settings
The following command displays the current direct printing port settings.
msh> diprint
Example output:
port 9100
timeout=300(sec)
bidirect off

• The “Port” specifies the port number of the direct printing port.
• The “bidirect” setting indicates whether the direct printing port is bidirec-

tional.

❖❖❖❖ Setting timeout
You can specify the timeout interval to use when receiving data from the net-
work.
msh> diprint [0~65535]

Note
❒ The factory default is 300 seconds.
❒ If 0 is set, timeout is disabled.

❖❖❖❖ Bidirectional configuration for the direct printing port
Use this setting to configure whether the direct printing port is bidirectional.
The factory default is “off”.
msh> diprint bidirect {on|off}

Note
❒ If you select “on”, SmartNetMonitor for Client or Standard TCP/IP on

Windows 2000 might not work correctly.
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SPRINT

Use the sprint command to view and configure SCSI print (SBP-2) of the IEEE
1394.

Limitation
❒ You can use this function when the optional IEEE 1394 Board is installed.

❖❖❖❖ Viewing settings
The following command displays the current IEEE 1394 (SCSI print) settings.
msh> sprint

❖❖❖❖ Bidirectional configuration for the IEEE 1394 (SCSI print)
 
msh> sprint bidi {on|off}

Use this setting to configure whether the IEEE 1394 (SCSI print) is bidirectional.
The factory default is "on".

SMB

Use the smb command to configure or delete the computer name or workgroup
name for NetBEUI.
msh> smb parameter

Note
❒ You cannot use the computer name starting with RNP or rnp.

Parameter Settings

comp Your computer name consisting of up to 13 characters

group Workgroup name consisting of up to 15 characters

comment Comment consisting of up to 31 characters

clear comp Clears the computer name

clear group Clears the Workgroup name

clear comment Clears comment
111
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ROUTE

Use the route command to control the routing table.
This command allows you to configure and display routing information. You
can change the network configuration from remote PCs using this command.

Note
❒ The maximum number of routing tables are 16.

*1 IP address

SLP

Use this command to configure SLP settings.
You can search the NetWare server using SLP in the PureIP environment of
NetWare5/5.1. To use the slp command, you can configure the value of TTL
which can be used by the SLP multi-cast-packet.

Note
❒ The default value of TTL is “1”. A search is executed only within a local seg-

ment. If the router does not support multi-cast, the settings are not available
even if the TTL value is increased.

❒ The acceptable TTL value is 1 - 255.
msh> slp ttl {1 - 255}

Setting IEEE 802.11b

Use the wiconfig command to configure the IEEE 802.11b settings.

Limitation
❒ You can make settings when installing the optional 802.11b Interface Kit.

Commands Topics of setting

route add {host | net} desti-
nation *1  gateway *1 

Adds a host/network route to “destination”, and a gateway ad-
dress to “gateway” in the table. Host becomes the default setting.

route delete {host | net} 
destination *1 

Deletes a host/network route from the table. Host becomes the 
default setting.

route get {destination *1 } Displays only route information corresponding to a specified 
destination. When the destination is unspecified, all routing in-
formation is displayed.

route active {host | net} des-
tination *1  on/off

You can turn the specified destination on or off. Host becomes 
the default setting.

route add default gateway 
*1 

You can set the default gateway address.

route flush Deletes all routing information.
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❖❖❖❖ View settings
The following command displays the current IEEE 802.11b settings.
msh> wiconfig
The IEEE 802.11b card information is displayed.
msh> wiconfig cardinfo

Note
❒ If the IEEE 802.11b interface is not working correctly, the IEEE 802.11b card

information is not displayed.

❖❖❖❖ Configuration

Parameter Value to be configured

mode [ap|802.11adhoc|adhoc] You can set infrastructure mode (ap), 802.11 
ad hoc mode (802.11adhoc) or ad hoc mode 
(adhoc).

The default is 802.11 ad hoc mode.

ssid ID value You can set for SSID in infrastructure mode.

The characters that can be used are ASCII 
0x20-0x7e (32 bytes).

A SSID value is set automatically to the near-
est access point if the setting has not been 
made.

If the setting has not been made for ad hoc 
mode, the same value as for infrastructure 
mode or an “ASSID” value is set automati-
cally if the setting has not been made.

channel frequency channel no. You can set the channel.

You can specify from following channel.

• Metric Version :1-13

• Inch Version :1-11

Set the same channel for all the machines you 
are using.

enc [on|off] You can enable or disable the WEP function. 
To enable the WEP function, specify [on]; to 
disable it, specify [off].

To start the WEP function, enter the correct 
WEP key.

key [key value] 64-bit or 128-bit can be set.

Only 10 hexadecimal characters can be set 
when using 64-bit or 26 hexadecimal charac-
ters when using 128-bit.

Also, set 0x as prefix.

To use this function, set the same WEP key 
for all the ports that transmit to each other.
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Note
❒ When changing the Interface to IEEE 802.11b, see p.103 “TCP/IP address”
❒ When configuring the IEEE 802.11b TCP/IP, see p.103 “TCP/IP address”

Job Spool

Use this command to configure Job Spool settings.

Limitation
❒ You can only specify the LPR and IPP protocol.

Note
❒ This machine information cannot reload automatically when you confirm the

Job spool settings on the Web Browser. Click [Reload] or [Refresh] on the Web
Browser when you want to reload this machine information.

❖❖❖❖ Reference
The job spool setting appears.
msh> spoolsw

❖❖❖❖ Job Spool Setting
msh> spoolsw spool {on | off}

Note
❒ Specify “on” to enable the job spool function or “off” to disable it.

❖❖❖❖ Clearing Spool Job
If the machine is turned off accidentally during a spool job, you can specify
whether the job will be reprinted when the printer is turned back on.
msh> spoolsw clearjob {on |off}

auth [open|shared] You can set the authorized mode when using 
WEP. The specified value and the authorized 
mode are as follows:

open: Open system authorized (default)

shared: Shared key authorized

rate [auto|11m|5.5m|2m|1m] You can set the IEEE 802.11b transmitting 
speed.

The transmitting speed you specify here is 
the speed at which data is sent. You can re-
ceive data at any speed.

auto: automatically set (default)

11m: 11 Mbps fixed

5.5m: 5.5 Mbps fixed

2m: 2 Mbps fixed

1m: 1 Mbps fixed

Parameter Value to be configured
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❖❖❖❖ Protocol Configuration
To change the protocol settings, use the following command. You can specify
the setting for [lpr] or [ipp].
• lpr

msh> spoolsw lpr {on |off}

• ipp
msh> spoolsw ipp {on |off}

Changing the Host Name

Use the hostname command to change the printer name.
msh> hostname interface_name  printer_name

*1 If you did not enter the interface name, it will be automatically set to the Ethernet in-
terface.

*2 If you install the 802.11b Interface Kit, you can set the command.
*3 If you install the 1394 Interface Unit, you can set the command.

Note
❒ Enter the printer name using up to 13 characters.
❒ You cannot use a printer name starting with RNP or rnp.
❒ The Ethernet interface and IEEE 802.11b interface will have the same printer

name.

WINS

Use the wins command to configure the WINS server settings.
For more information about WINS server settings, see p.135 “Configuring a
WINS Server”.

❖❖❖❖ Viewing setting
The following command displays the WINS server IP address.
msh> wins
Example out put:
wins: primary server 0.0.0.0 secondary server 0.0.0.0
DHCP current config:
 primary server 192.168.10.1 secondary server
192.168.10.2
 hostname RNP620B47 ScopeID

interface name Interface to be configured

ether Ethernet interface *1 

wlan  *2 IEEE 802.11b interface

ip1394 *3 IEEE 1394 interface
115
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Note
❒ If DHCP is used to start from the network, the current WINS server ad-

dress is displayed. This address, however, is not displayed if DHCP is not
used.

❒ If the IP address obtained from DHCP differs from the WINS IP address,
the DHCP address is the valid address.

❖❖❖❖ Configuration
Use the set command to make WINS active or inactive.
msh> set wins {on|off}

• “on” means active and “off” means inactive.

❖❖❖❖ Address configuration
Use this command to configure a WINS server IP address.
msh> wins {primary|secondary} IP_address

Note
❒ Use the “primary” to configure a primary WINS server IP address.
❒ Use the “secondary” to configure a secondary WINS server IP address.

AutoNet

Use the set command to configure AutoNet.

Note
❒ For more information about AutoNet, see p.134 “Using AutoNet”.
msh> set autonet {on|off}

• “on” means active and “off” means inactive.

Changing the password

Use the passwd command to change the remote maintenance password.

Important
❒ Be sure not to forget or lose the password.

Note
❒ The default password is “password”.

AAAA Type “passwd”.

msh> passwd

BBBB Type the current password.
Old password:
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CCCC Type the new password.

New password:

Note
❒ The password must consist of 3 to 8 alphanumeric characters and symbols.

Upper and lower case characters are considered unique. For example, R is
different from r.

❒ The password is the same as that used in the configuration of the Network
Interface Board using a Web Browser and that used in the NIB Setup Tool.
If you change a password from telnet, the other passwords are also
changed.

DDDD Type the new password once again.
Retype new password:

SNTP

The printer clock can be synchronized with a NTP server clock using the Simple
Network Time Protocol (SNTP). To change the SNTP settings, use the sntp com-
mand. Confirm with the network administrator that the NTP server settings are
correct.

Limitation
❒ SNTP supports the NTP servers running xnptd V3 and V4.

❖❖❖❖ Reference
msh> sntp

❖❖❖❖ NTP Server Address Configuration
You can specify the IP address of the NTP server.
msh> sntp server IP_address

❖❖❖❖ Interval Configuration
You can specify the interval at which the printer synchronizes with the oper-
ator-specified NTP server.
msh> sntp interval polling_time

Note
❒ The factory default setting is 3600 seconds.
❒ You can set the interval from 16 to 16384 seconds.
❒ If you set 0, the printer synchronizes with the NTP server only when you

turn the printer on. After that, the printer does not synchronize with the
NTP server.
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❖❖❖❖ Time-zone Configuration
You can specify the time difference between the printer clock and the NTP
server clock.
msh> sntp timezone +/-hour_time
Example: To set the time-zone difference to +8 hours:
msh> sntp timezone +08:00

Note
❒ The time is in 24-hour notation.

SMTP

Use the smtp command to configure SMTP (Simple Mail Transfer Protocol) set-
tings.

❖❖❖❖ View setting
The following command displays the current SMTP settings.
msh> smtp

❖❖❖❖ SMTP server name configuration
The following command sets the SMTP server name.
msh> smtp server server name

Note
❒ You can configure the SMTP name using a Host name or IP address.
❒ A maximum of 127 alphanumeric or numeric characters can be used.

❖❖❖❖ SMTP port number configuration
The following command sets the SMTP port number.
msh> smtp port port number

Note
❒ The acceptable value is 1-65535.
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DNS

Use the dns command to configure or display the DNS (Domain Name System)
settings.

❖❖❖❖ View setting
The following command displays the current DNS settings.
msh> dns

❖❖❖❖ Using the DNS server obtained from the DHCP server
The following command sets the use of the DNS server obtained from the
DHCP server.
msh> dns dhcp {valid | invalid}

• If you use the DNS server obtained from the DHCP server, designate “val-
id”. If not, designate “invalid”.
If you set “valid”, the DNS server from the DHCP server is prioritized.

❖❖❖❖ DNS server configuration
The following command sets the DNS server address.
msh> dns number server address

• You can register up to 3 DNS server numbers.
• You cannot use “255.255.255.255” as the DNS server address.

Domainname

Use the domainname command to display or configure the domain name set-
tings.
You can configure the Ethernet interface, the IEEE 1394 interface or the IEEE
802.11b interface.

❖❖❖❖ View setting
The following command displays the current domain name.
msh> domainname

❖❖❖❖ Interface domain configuration
The following command displays or sets the Ethernet interface domain name,
the IEEE 1394 interface or the IEEE 802.11b interface.
msh> domainname interface name

*1 Available when the optional 1394 interface unit is installed.
*2 Available when the optional 802.11b interface kit is installed.

Interface Interface that can be set

ether Ethernet interface

ip1394 *1 IEEE 1394 interface

wlan *2 IEEE 802.11b interface
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SNMP

The Network Interface Board functions as an SNMP (Simple Network Manage-
ment Protocol) agent using the UDP and IPX protocols. Using the SNMP man-
ager you can get information about the printer.
The default community names are “public” and “admin”. You can get MIB in-
formation using these community names.

Reference
You can configure SNMP from the command line using telnet. See p.107
“SNMP”.
You can configure SNMP from SmartNetMonitor for Admin using the NIB
Setup Tool. See Help for SmartNetMonitor for Admin.
You can configure SNMP from your Web Browser. See Help on the CD-ROM.

Limitation
❒ The kinds of supported MIBs vary depending on the printer.
❒ The 1394 Interface Unit supports TCP/IP only.

❖❖❖❖ Supported MIBs
• MIB-II 
• PrinterMIB 
• HostResourceMIB 
• RicohPrivateMIB 
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Understanding the Displayed Information 

This section describes how to read the status information returned by the Net-
work Interface Board.

Print Job Information

The status of the print job can be viewed using the following commands.
• telnet : Use the status command. See p.106 “Printer status” .

Print Log Information

This is a record of the most recent 16 jobs that have been printed.
This log can be displayed with the following commands.
• telnet : Use the prnlog command. See p.106 “Printer status” .

*1 Appears the UserID and JobName information when entering the info command
with the ID.

Item name Meaning

Rank Print job status.

• Active
Printing or preparing for printing.

• Waiting
Waiting to be transferred to the printer.

Owner Print request user name.

Job Print request number.

Files The name of the document.

Total Size The size of the data (spooled).

The default is “0 bytes”.

Name Meaning

ID Print request ID.

User Print request user name.

Page The number of pages that is printed.

Result The result of the print request.

Time The time when the print request was received.

UserID *1 User ID that is to be configured in the printer driver.

JobName *1 The name of the document for printing.
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Configuring the Network Interface Board

The Network Interface Board settings can be displayed by using the commands
below.
• telnet : Use the show command. See p.107 “Network Interface Board config-

uration settings information” .

Item name Meaning

 Common 

 Mode 

 Protocol Up/Down 

AppleTalk 

TCP/IP 

NetWare 

NetBEUI 

IP over 1394 *1 

SCSI print *1 

Ethernet interface

Syslog priority

NVRAM version 

 Device name 

 Comment 

 Location 

 Contact 

 Soft switch 

 

 

Up means active, Down means inactive.

 

 

 

 

 

 

Internal version number.

 

Internal version number.

 AppleTalk 

 Mode 

 Net 

 Object 

 Type 

 Zone 

 

AppleTalk protocol in selection.

Network number.

Macintosh printer name.

The type of printer.

Name of the zone that the printer belongs to.
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 TCP/IP 

 Mode 

 ftp 

 lpr 

 rsh 

 telnet

 diprint 

 web 

 ftpc

 snmp

 ipp

 wins

 autonet

 EncapType 

 Network boot 

 Address 

 Netmask 

 Broadcast 

 Gateway 

Access Range[✩] *2 

Primary WINS

Secondary WINS

Time server

Time Zone

Time server polling time

 SYSLOG server

 Home page URL 

 Home page link name 

 Help page URL 

 SNMP protocol 

 

Up means active, Down means inactive. 

 

 

 

 

 

 

 

 

 

 

 

Frame type.

Network boot.

IP address.

Subnet mask.

Broadcast address.

Default gateway address.

Access Control Range.

Primary WINS server address.

Secondary WINS server address.

NTP server address.

NTP server time difference.

Synchronizes interval.

 

URL of homepage.

URL name of homepage.

URL of help page.

Protocol used with SNMP.

 NetWare 

 EncapType 

 RPRINTER number 

 Print server name 

 File server name

 Context name 

 Switch 

 Mode 

 NDS/Bindery 

 Packet negotiation 

 Print job timeout 

 

Frame type.

Remote printer number.

Print server name.

Name of the connect file server.

Context of print server.

 

Active mode.

(this value is fixed)

 

Time of the job timeout.

Item name Meaning
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*1 The 1394 interface Board supports TCP/IP only.
*2 ✩ represents a target number between 1 and 5.
*3 You can display the item names when installing the optional 802.11b Interface Kit.
*4 You can display the item names when installing the optional 1394 interface Board.
*5 ✩ represents a target number between 1 and 3.

 NetBEUI 

 Switch 

 Mode 

 Direct print

 Notification 

 Workgroup name 

 Computer name 

 Comment 

 Share name[1] 

 

 

(this value is fixed)

(this value is fixed)

Notification of print job completion.

Name of the workgroup.

Name of the computer.

Comment.

Share name (name of the printer type).

IEEE 802.11b *3 

SSID

Channel range

Channel

Communication mode

Rate

WEP encryption

Auth

 

Encryption key

 

SSID being used.

Channels available for use.

Channel being used.

IEEE 802.11b interface transmitting mode.

IEEE 802.11b interface speed.

Whether WEP is enabled or disabled.

Validity or invalidity of the authorized mode setting 
when using WEP.

64-bit WEP key/128-bit WEP key.

IP over 1394 *4 

Device name

Address

Netmask

Broadcast

 

Name of the machine.

IP address.

Subnet mask.

Broadcast address.

SCSI print *4 

Bidi. Bidirectional setting (on/off).

SMTP

Server name

Port number

 

SMTP server name.

SMTP port number.

DNS

Server [✩] *5 

Dhcp

 

DNS server address.

 

Domain name

ether

wlan *3 

ip1394 *4 

 

Ethernet interface domain name.

IEEE 802.11b interface domain name.

IEEE 1394 interface domain name.

 Shell mode Mode of the remote maintenance tool.

Item name Meaning
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Message List

This is a list of messages written to the machine's system log. The system log can
be viewed using the syslog command.

System Log Information

You can use the following methods to view the system log.
• telnet : Use the syslog command. See p.107 “System log information” .

Message Description and Solutions

Access to NetWare server <file server name> 
denied. Either there is no account for this print 
server on the NetWare server or the password 
was incorrect. 

(In print server mode) Cannot log in to the file 
server. Make sure that the print server is reg-
istered on the file server. If a password is spec-
ified for the print server, delete it.

add_sess: community<community name> al-
ready defined.

The same community name already exists. 
Use another community name.

add_sess: session<community name> not de-
fined.

A requested community name is not defined.

add_sess: bad trap addr:<IpAddress>, com-
munity:<community name>

The IP address (0.0.0.0.) is unavailable when 
the community access type is TRAP. Specify 
the host IP address for the TRAP destination.

add_sess_ipx: bad trap addr: <IPX address>, 
community:<community name>

The IPX address (00:00:00:00:00:00) is unavail-
able when the community access type is 
TRAP. Specify the host IPX address for the 
TRAP destination.

add_sess_ipx: community <community 
name> already defined.

The same community name already exists. 
Use another community name.

add_sess_ipx: session_ipx<community name> 
not defined.

A requested community name is not defined.

ANONYMOUS FTP LOGIN FROM <IP ad-
dress>, <password>

An anonymous login has been made with a 
password <password> from the host <IP ad-
dress>.

anpd start. (AppleTalk) An anpd (AppleTalk Network Package Dae-
mon) has started.

Attach FileServer =<file server name> Attached to the file server as a nearest server.

Attach to print queue <print queue name> (In print server mode) Attached to the print 
queue name.

Cannot create service connection (In remote printer mode) Cannot establish a 
connection with the file server. The number of 
file server users may exceed the maximum 
number that the file server can handle.
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Cannot find rprinter (<print server 
name>/<printer number>)

(In remote printer mode) The printer having 
the number displayed on the print server does 
not exist. Make sure that the number of the 
printer is registered in the print server.

Change IP address from DHCP Server. The IP address changes when DHCP LEASE is 
renewed. To always assign the same IP ad-
dress, set a static IP address to the DHCP serv-
er.

child process exec error! (process name) Failed to start the network service. Turn the 
printer off and then on. If this does not work, 
contact your service or sales representatives.

Connected DHCP Server(<DHCP server ad-
dress>).

The IP address was successfully received from 
the DHCP server.

connection from <IP address> Logged on from the host <IP address>.

Could not attach to FileServer<error number> (In remote printer mode) Cannot attach to the 
file server. For some reason, the file server 
refuses the connection. Check the file server 
configuration.

Could not attach to PServer<print server 
name>

(In remote printer mode) Cannot attach to the 
print server. For some reason, the print server 
refuses the connection. Check the print server 
configuration.

Current Interface Speed:xxxMbps The speed of the network (10 Mbps or 100 Mb-
ps).

Current IP address <current IP address> The IP address <current IP address> was re-
ceived from the DHCP server.

Current IPX address<IPX address> The current IPX address.

DHCP lease time expired. DHCP lease time has expired. The printer tries 
to discover the DHCP server again. The IP ad-
dress used up to now becomes invalid.

DHCP server not found. The DHCP server cannot be found. Make sure 
the DHCP server is running on the network.

dhcpcd start. A dhcpcd (DHCP client server) has started.

Duplicate IP=<IP address>(from <MAC ad-
dress>).

The same IP address is used. An IP address 
must be unique. Check the address of the de-
vice indicated in <MAC address>.

Established SPX Connection with PServer,

(RPSocket=<socket number>, connID=

<connection ID>)

(In remote printer mode) A connection with 
the print server has been established.

exiting lpd service has ended and the system is exit-
ing the process.

Message Description and Solutions
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Exit pserver (In print server mode) Exits the print server 
because the necessary print server settings 
have not been made.

Frametype =<frame type name> The <frame type name> is configured to be 
used on NetWare.

httpd start. An httpd has started.

IEEE 802.11b <Transmission mode> mode Transmission mode of the IEEE 802.11b.

(Example: Current mode is infrastructure 
mode.)

IEEE 802.11b [infrastructure] mode

(Example: Current mode is 802.11 ad hoc 
mode.)

IEEE 802.11b [802.11 ad hoc] mode

(Example: Current mode is ad hoc mode.)

IEEE 802.11b [ad hoc] mode

IEEE 802.11b current channel <Channel> The current channel is displayed.

The value chosen by the user is displayed in 
ad hoc mode.

The channel used in the access point is dis-
played in infrastructure mode.

(Example: Current channel is 11.)

IEEE 802.11b current channel 11

IEEE 802.11b Card Firmware REV. <Version> Wireless LAN Card Firmware version.

(Example: Current version is 0.8.3.)

IEEE 802.11b Card Firmware REV. 0.8.3

IEEE 802.11b MAC Address = <MAC Ad-
dress>

The IEEE 802.11b I/F MAC address is dis-
played.

(Example: Current MAC address is 
00:00:74:XX:XX:XX.)

IEEE 802.11b MAC Address = 

00:00:74:XX:XX:XX

IEEE 802.11b SSID <ssid> (AP MAC Address < 
MAC Address>)

The SSID of the access point used in infra-
structure mode and the MAC address of the 
access point are displayed.

(Example: Current MAC address is 
xx:xx:xx:xx:xx:xx and SSID value is “test-
ssid”.)

IEEE 802.11b SSID test-ssid (AP MAC Ad-
dress xx:xx:xx:xx:xx:xx)

IEEE 802.11b Tx Rate <Transfer Speed> The IEEE 802.11b transmitting speed (set 
speed) is displayed.

(Example: Current Tx Rate is 11Mbps.)

IEEE 802.11b Tx Rate 11Mbps

Message Description and Solutions
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inetd start. An inetd has started.

<interface> started with IP: <IP address> <IP address> has been set for <Interface> and 
<Interface> started.

<Interface>: Subnet overlap. Subnet from Netmask and the IP address you 
tried to set for <Interface> overlap the subnet 
for another interface.

Set Subnet so that it does not overlap with an-
other interface.

IPP cancel-job: permission denied. The printer could not authenticate the name of 
the user attempting to cancel a job.

ipp disable. Printing with ipp is disabled.

ipp enable. Printing with ipp is enabled.

IPP job canceled. jobid=%d. The spooled job has been canceled due to an 
error or by user request.

job canceled. jobid=%d. The spooled job has been canceled due to an 
error or by user request.

LeaseTime=<lease time>(sec), Renew-
Time=<renew time>(sec).

The resource lease time that was received 
from the DHCP server is <lease time> in sec-
onds. The renewal time is also <renew time> 
in seconds.

Login to fileserver <file server name> 
(<IPX|IP>,<NDS|BINDERY>) 

(In print server mode) Logged in to the file 
server with NDS or BINDERY mode.

multid start. Data transmission service for multiprotocols 
has started.

nbstart start. (NetBEUI) The service for NetBEUI protocol stack setting 
has started.

NBT Registration Broadcast(<NetBIOS 
name>)

Use a local broadcast to map <NetBIOS 
name> with the IP address.

nbtd start. A nbtd (NetBIOS over TCP/IP Daemon) has 
started. (Available only in DHCP mode)

NetBEUI Computer Name =<computer name> The NetBEUI Computer Name is defined as 
<computer name>.

nmsd start. (NetBEUI) A nmsd (Name Server Daemon) has started.

npriter start. (NetWare) (In remote printer mode) NetWare service has 
started.

nwstart start. (NetWare) The service for NetWare protocol stack setting 
has started.

Open log file <file name> (In print server mode) The specified log file 
has been opened.

papd start. (AppleTalk) AppleTalk print service has started.

Message Description and Solutions
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permission denied. Job cancellation was determined to be unau-
thorized after checking the user name and 
host address (except for ROOT authorization).

phy release file open failed. Replacing the Network Interface Board is re-
quired. Contact your sales or service repre-
sentatives.

Print queue <print queue name> cannot be 
serviced by printer 0, <print server name>

(In print server mode) The print queue name 
cannot be serviced. Make sure that print 
queue volume exists on the specified file serv-
er.

Print server <print server name> has no print-
er.

(In print server mode) The printer object is not 
assigned to the print server <print server 
name>. Using NWAdmin, assign the printer 
object, and then restart the printer device. 

Print session full Cannot accept the print session.

Printer <printer name> has no queue (In print server mode) The print queue is not 
assigned to the printer. Using NWAdmin, as-
sign the print queue to the printer, and then 
restart it.

pserver start. (NetWare) (In print server mode) NetWare service has 
started.

Required computer name (<Computer name>) 
is duplicated name 

The same computer name is detected on the 
network. The start job determines the compu-
ter name by adding the computer name to the 
suffix (0,1....). Configure a new computer 
name that is unique.

Required file server (<file server name>) not 
found 

Cannot find the required file server.

restarted. LPD has started.

sap enable, saptype=<SAP type>, sap-
name=<SAP name>

The SAP function has started. The SAP (SAP 
type and SAP name) packet is issued to adver-
tise the service on the SAP table on the Net-
Ware server.

Set context to <NDS context name> A <NDS context name> has been set. 

shutdown signal received. network service re-
booting...

Rebooting the network service.

smbd start. (NetBEUI) An smbd (SMB (Server Message Block) serv-
ice) has started.

Snmp over ip is ready. Communication over TCP/IP with SNMP is 
available.

Snmp over IP over 1394 is ready. Communication over IP over 1394 with SNMP 
is available.

Message Description and Solutions
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Snmp over ipx is ready. Communication over IPX with SNMP is avail-
able.

snmpd start. SNMP service has started.

started. Direct print service has started.

The print server received error <error 
number> during attempt to log in to the net-
work.Access to the network was denied.Verify 
that the print server name and password are 
correct. 

Cannot log in to the file server. The print serv-
er is not registered or the password is speci-
fied. Register the print server without 
specifying a password.

win2kspd protocol-DOWN (APPEXIT). NVRAM setting ioctl (SPIO CAPPEXIT) of de-
vice SBP2TSP was set by protocol-DOWN.

SCSI print is not receiving data.

win2kspd protocol-UP (APPENTRY). NVRAM setting ioctl (SPIO CAPPENTRY) of 
device SBP2TSP was set by protocol-UP.

SCSI print is not receiving data.

win2kspd started. SCSI print (SBP-2) service has started.

WINS name refresh :Server No Response There has been no response to the update re-
quest from the server. Confirm that the WINS 
server address is correct and the WINS server 
is working properly.

WINS name registration/refresh error 
code<error number>

Enter a different name. Confirm that the 
WINS server address is correct and the WINS 
server is working properly.

WINS name registration:Server No Response There has been no response to the registration 
request from the server. Confirm that the 
WINS server address is correct and the WINS 
server is working properly.

WINS server address0.0.0.0 The WINS server address has not been speci-
fied. Specify the WINS server address to 
match the printer name with WINS.

WINS Server=< WINS server address > NetBI-
OS Name=<NetBIOS name>

The printer name has been successfully regis-
tered in <WINS server address>.

WINS wrong scopeID The scope ID is wrong.

Specify the correct scope ID.

write error occurred. (diskfull) The hard disk became full while the spool file 
was being written.

Wait until enough HDD space becomes avail-
able as printing proceeds.

write error occurred. (fatal) A fatal error occurred while the spool file was 
being written.

Turn the printer off and then on. If this does 
not work, contact your service or sales repre-
sentative.

Message Description and Solutions
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failed to get smtp server ip-address. Failed to get SMTP server IP address. This is 
caused by the following.

• The DNS server could not be find.

• There is no connection to the network.

• The specified DNS server could not be con-
nected to.

• Incorrect DNS server specification.

• No specified SMTP server IP address in 
the DNS server.

failed to connect smtp server. timeout. Failed to connect the SMTP server because of 
timeout. This is caused by the following.

• The SMTP server name is incorrect.

• There is no connection to the network.

• The network configuration is incorrect, so 
there is no response from the SMTP server.

refused connect by smtp server. The connection to the SMTP server is denied. 
This is caused by the following.

• Another server other than the SMTP server 
has been designated.

• The SMTP server port number is incorrect.

no smtp server. connection close. No response from the SMTP protocol. Cannot 
connect to the SMTP server. This is caused by 
the following.

• Another server other than the SMTP server 
has been designated.

• The SMTP server port number is incorrect.

failed to connect smtp server. Failed to connect the SMTP server. This is 
caused by the following.

• Not connected to the network.

• The network configuration is incorrect, so 
there is no response from the SMTP server.

• The SMTP server name is incorrect.

• The specified SMTP server is incorrect.

• No specified SMTP server IP address in 
the DNS server.

• Another server other than the SMTP server 
has been designated.

• The SMTP server port number is incorrect.

Message Description and Solutions
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Precautions

Please pay attention to the following when using the Network Interface Board.
When configuration is necessary, follow the appropriate procedures below.

Connecting a Dial-Up Router to a Network

When the NetWare file server and the printer are on the opposite side of a router,
packets are continuously sent back and forth, possibly causing communications
charges to increase. Because the packet transmission is a specification of Net-
Ware, you need to change the configuration of the router. If the network you are
using does not allow you to configure the router, configure the machine.

Configuring the router

Filter the packets so that they do not pass over the dial-up router.

Note
❒ The MAC address of the printer doing the filtering is printed on the printer

configuration page. For more information about printing a configuration
page, see the Printer Reference 2.

❒ For more information about configuring the printer if the router cannot be
configured, see the instructions below.

Configuring the printer with NetWare

AAAA Following the setup method in this manual, configure the file server.

BBBB Set the frame type for a NetWare environment.

Reference
For more information about selecting a frame type, see the General Settings
Guide.

Configuring the printer without NetWare

AAAA While not printing, the Network Interface Board sends packets on the net-
work. Set the NetWare to inactive.

Reference
For more information about selecting a protocol, see the General Settings
Guide.
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PostScript Printing from Windows

When printing PostScript from Windows, see the PostScript 3 Operating Instruc-
tions Supplement provided as a PDF file on the CD-ROM labeled “Operating In-
structions”.

NetWare Printing

Form Feed

You should not configure the form feed on NetWare. The form feed is controlled
by the printer driver on Windows. If the NetWare form feed is configured, the
printer might not work properly. If you want to change the form feed setting, al-
ways configure it on Windows.
• With Windows 95/98/Me, clear the [Form feed] check box on the [Printer Set-

tings] tab in the printer properties dialog box.
• With Windows 2000/XP, clear the [Form feed] check box on the [NetWare Set-

tings] tab in the printer properties dialog box.
• With Windows NT 4.0, clear the [Form feed] check box on the [NetWare Settings]

tab in the printer properties dialog box.

Banner Page

You should not configure a banner page on NetWare. If you want to change the
banner page setting, always configure it on Windows. 
• With Windows 95/98/Me, clear the [Enable banner] check box on the [Printer

Settings] tab in the printer properties dialog box.
• With Windows 2000/XP, clear the [Enable banner] check box on the [NetWare

Settings] tab in the printer properties dialog box.
• With Windows NT 4.0, clear the [Enable banner] check box on the [NetWare Set-

tings] tab in the printer properties dialog box.

Printing after resetting the machine

After resetting the remote printer, the connection from the print server will be
cut off for about 30-40 seconds before re-connecting. Due to the NetWare speci-
fication, print jobs may be accepted, but they will not be printed during this in-
terval.
When using the machine as a remote printer, wait about 2 minutes after resetting
the printer before attempting to print. 
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Using DHCP

You can use the printer under a DHCP environment. You can also register the
printer NetBIOS name on a WINS server when it is running.

Limitation
❒ DHCP cannot be used with IEEE 1394 (IP over 1394). Set a fixed IP address

with the control panel, telnet or a Web Browser.
• See the General Settings Guide.
• See p.103 “TCP/IP address”.
• See p.91 “Configuring the Network Interface Board Settings”.

Note
❒ Printers that register the printer NetBIOS name on a WINS server must be

configured for the WINS server. See p.115 “WINS”.
❒ Supported DHCP server is Windows NT 4.0 Server Service Pack 4 or later,

Windows 2000, Windows XP Professional Server and NetWare 5/5.1.
❒ If you do not use the WINS server, reserve the printer's IP address in the

DHCP server so that the same IP address is assigned every time.
❒ DHCP relay-agent is not supported. If you use DHCP relay-agent on a net-

work via an ISDN line, it will result in expensive line charges. This is because
your computer connects to the ISDN line whenever a packet is transferred
from the printer.

Using AutoNet

If the printer IP address is not assigned by a DHCP server automatically, a tem-
porary IP address starting with 169.254 which is not used on the network can be
selected automatically by the printer.

Note
❒ The IP address assigned by the DHCP server is given priority to that selected

by AutoNet.
❒ You can confirm the current IP address on the configuration page. For more

information about the configuration page, see the Printer Reference 2.
❒ When AutoNet is running, the NetBIOS name is not registered on the WINS

server.
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Configuring a WINS Server

The printer can be configured to register its NetBIOS name with a WINS server
when power is turned on. This enables the NetBIOS name of the printer to be
specified from SmartNetMonitor for Admin even under a DHCP environment.
This section describes how to configure the WINS server.

Limitation
❒ IEEE 1394 (IP over 1394) is not supported by a WINS Server.

Note
❒ The WINS Server is supported with Windows NT 4.0 Server Service Pack 4 or

later, and Windows 2000 Servers WINS Manager.
❒ For more information about the WINS Server settings, see Windows Help.
❒ If there is no reply from the WINS Server, the NetBIOS name will be regis-

tered by broadcast.
❒ The NetBIOS name consists of up to 13 alphanumeric characters.

Using a WWW browser

AAAA Start the Web Browser.

BBBB Point your browser at the URL or IP address of the printer (e.g. ht-
tp://XXX.XXX.XXX.XXX where the Xs are the number of the IP address).

The status of the printer you chose appears on the Web Browser.

CCCC Click [Network Config].

The dialog box for entering the password and user name is displayed.

DDDD Enter your user name and password, and then click OK.
To use the factory default account, enter no user name and type “password”
for the password.

EEEE Click [TCP/IP].

FFFF Set WINS to active and enter the IP address of the WINS server in Primary
WINS Server and Secondary WINS Server.

GGGG Click [Refresh].

HHHH Exit the Web Browser.
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Using telnet

AAAA Connect to the remote printer using telnet.

BBBB Use the “set” command to make WINS active.

msh> set wins on

CCCC Specify the IP addresses (primary and secondary) using the following com-
mands.

msh> wins primary Ipaddress

msh> wins secondary Ipaddress

Note
❒ To confirm the current configuration, use the “show” command.

DDDD Log out from telnet.

When Using the NIB Setup Tool 

If the Network Interface Board cannot browse using the TCP/IP protocol, make
sure that the TCP/IP environment is correctly configured in your computer.

When Using IPP with SmartNetMonitor for Client 

When using IPP with SmartNetMonitor for Client, note the following:
• The network printer can only receive one print job from SmartNetMonitor for

Client at a time. While the network printer is printing a job, another user can-
not access the network printer until it completes the job. In this case, Smart-
NetMonitor for Client tries to access the network printer until the retry
interval expires.

• If SmartNetMonitor for Client cannot access the network printer and times
out, SmartNetMonitor for Client stops sending the print job. In this case, you
should cancel the paused status from the print queue window. SmartNet-
Monitor for Client will resume access to the network printer. You can delete
the print job from the print queue window, but canceling a print job that has
been printed by the network printer might cause the next print job sent from
another user to be incorrectly printed.

• If a print job that is sent from SmartNetMonitor for Client is interrupted and
the network printer cancels the job because something went wrong, launch
the print job again.

• Print jobs sent from another computer do not appear in the print queue win-
dow regardless of the protocol.

• If various users send print jobs using SmartNetMonitor for Client to network
printers, the printing order might not be in the order in which the jobs were sent.

• An IP address cannot be used for the IPP port name because the IP address is
used for the SmartNetMonitor for Client port name.
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Specifications

*1 The 1394 Interface Unit supports TCP/IP only.
*2 To use NetBEUI, use the SmartNetMonitor for Client port.

Interface 100BASE-TX, 10BASE-T, IEEE 1394 (IP over 1394) *1 , IEEE 802.11b

Frame type EthernetII, IEEE 802.2, IEEE 802.3, SNAP

Protocol • TCP/IP
Windows 95
Windows 98
Windows Me
Windows 2000
Windows XP
Windows NT 4.0
Netware 5/5.1

• IPX/SPX
NetWare 3.12, 3.2, 4.1, 4.11, 4.2, IntranetWare, 5, 5.1

• NetBEUI *2 

Windows 95
Windows 98
Windows Me
Windows 2000
Windows NT 4.0

• AppleTalk
Mac OS

SNMP MIB-II, PrinterMIB, HostResourceMIB, RicohPrivateMIB
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Access Control,   105
access type,   108
Ad hoc mode,   100
AutoNet,   116, 134

B

Boot,   105
broadcast address,   104

C

Changing Names and Comments
SmartNetMonitor for Admin,   93
Web Browser,   95

client computer, setup
Windows 2000,   33
Windows 95/98/Me,   20
Windows NT 4.0,   57
Windows XP,   45

community name,   108
configuration

access type,   108
community name,   108
LPR port printing, Windows 2000,   32
LPR port printing, Windows NT 4.0,   56
LPR port printing, Windows XP,   44
Macintosh,   81
NetWare,   59
NetWare 3.x,   64
NetWare 4.x, 5/5.1,   64
Network Interface Board,   122
Web Browser,   88
Windows 2000,   23
Windows 95/98/Me,   11
Windows NT 4.0,   47
Windows XP,   35
WINS server,   135

D

DHCP,   105, 134
dial-up router,   132
Direct Printing Port,   110
Displaying the Status of Printer

SmartNetMonitor for Admin,   96
DNS,   119
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